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Welcome to This Guide

This guide describes how to configure, administer, and use Operations 
Management to do the following:

➤ Monitor the events that occur in your organization’s IT environment.

➤ Correlate the events and events across multiple domains.

➤ Compile and display a detailed overview of the health of your systems.

This chapter includes:

➤ How This Guide Is Organized on page 14

➤ Who Should Read This Guide on page 14

➤ How Do I Find the Information That I Need? on page 15

➤ Additional Online Resources on page 17

➤ Documentation Updates on page 18
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How This Guide Is Organized

This part of the guide contains the following chapters:

 Part I Working with Operations Management

Explains how to use Operations Management to monitor and manage the 
events that occur in your IT environment and resolve the underlying 
problems.

 Part II Configuring Operations Management

Describes the concepts and tasks required to configure and maintain 
Operations Management. The information provided helps you configure 
Operations Management for users to monitor and manage the IT 
environment efficiently.

 Part III Content Packs

Describes the content packs delivered with Operations Management. The 
information provided helps you configure Operations Management to 
manage specific areas such as infrastructure elements, databases, and 
applications.

Who Should Read This Guide

This guide is intended for the following users of HP Business Service 
Management:

➤ Operations Management software administrators.

➤ Domain (subject matter) experts, for example, database experts, and 
Exchange administrators.

➤ Operations Management operators and domain operators.

Users of this guide should be knowledgeable about navigating and using 
enterprise applications. Users should also be familiar with the concepts 
underlying enterprise monitoring and management.
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How Do I Find the Information That I Need?

This guide is part of the HP Business Service Management Documentation 
Library. This Documentation Library provides a single-point of access for all 
Business Service Management documentation.

You can access the Documentation Library by doing the following:

➤ In Business Service Management, select Help > Documentation Library.

➤ From a Business Service Management Gateway Server system, select Start 
> Programs > HP Business Service Management > Documentation.

Topic Types
Within this guide, each subject area is organized into topics. A topic 
contains a distinct module of information for a subject. The topics are 
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by 
dividing the documentation into the different types of information you 
may need at different times. 
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Three main topic types are in use: Concepts, Tasks, and Reference. The topic 
types are differentiated visually using icons.

Topic Type Description Usage

Concepts Background, descriptive, or 
conceptual information. 

Learn general information 
about what a feature does.

Tasks Instructional Tasks. 
Step-by-step guidance to help 
you work with the application 
and accomplish your goals. 
Some task steps include 
examples, using sample data. 

Task steps can be with or 
without numbering:

➤ Numbered steps. Tasks that 
are performed by following 
each step in consecutive 
order.

➤ Non-numbered steps. A list 
of self-contained operations 
that you can perform in any 
order.

➤ Learn about the overall 
workflow of a task.

➤ Follow the steps listed in 
a numbered task to 
complete a task.

➤ Perform independent 
operations by 
completing steps in a 
non-numbered task.

Use-case Scenario Tasks. 
Examples of how to perform a 
task for a specific situation.

Learn how a task could be 
performed in a realistic 
scenario.
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

Reference General Reference. Detailed 
lists and explanations of 
reference-oriented material.

Look up a specific piece of 
reference information 
relevant to a particular 
context.

User Interface Reference. 
Specialized reference topics 
that describe a particular user 
interface in detail. Selecting 
Help on this page from the 
Help menu in the product 
generally open the user 
interface topics.

Look up specific 
information about what to 
enter or how to use one or 
more specific user interface 
elements, such as a 
window, dialog box, or 
wizard.

Troubleshooting 
and Limitations

Troubleshooting and 
Limitations. Specialized 
reference topics that describe 
commonly encountered 
problems and their solutions, 
and list limitations of a feature 
or product area.

Increase your awareness of 
important issues before 
working with a feature, or 
if you encounter usability 
problems in the software. 

Topic Type Description Usage
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Documentation Updates

HP Software is continually updating its product documentation with new 
information.

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to the HP Software Product Manuals Web site 
(http://h20230.www2.hp.com/selfsolve/manuals).
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1
Introduction and Overview

The information in this section helps Operations Management operators to 
monitor the events that occur in your organization’s IT environment, 
correlate events, and, as a result, compile and display a detailed overview of 
the health of your CIs.

This chapter includes:

➤ How This Section Is Organized on page 21

How This Section Is Organized

Chapter 1 Introduction and Overview

This chapter introduces you to chapters describing the basic use of 
Operations Management.

Chapter 2 Event Management

This chapter introduces the concepts of managing events, and describes 
how to work with events to help solve the problems that they represent.

Chapter 3 Health Perspective

This chapter introduces the Health Perspective used to manage events from 
the point of view of the health of the CIs associated with event received 
from your monitored objects.
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Chapter 4 Performance Graphs

This chapter describes the main concepts of performance graphing, which 
enables you to generate and view performance graphs and graphs for the 
objects and events that you are monitoring.

Chapter 5 Actions Pane

This chapter introduces the Actions pane used to manage running actions 
on events or their related CIs and nodes.

Chapter 6 User Tools

This chapter describes how to use tools configured in Operations 
Management to help manage solving the problems identified by events.

Chapter 7 Filtering Events

This chapter describes the main concepts of event filters and how you can 
use filters to focus on the information that you want to see and, as a result, 
locate and fix problems more quickly and easily.

Chapter 8 Views for Operations Management

This chapter describes the main concepts of views and how you can use 
views to reduce and refine the configuration items you see in the Model 
Explorer. The contents of the Event Browser are filtered by the selected 
configuration item.
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2
Event Management

This chapter includes:

Concepts

➤ Operations Management Orientation on page 25

➤ Event Browser and the Event Perspective on page 26

➤ Health Perspective on page 40

➤ Performance Graphs on page 42

➤ Filters on page 42

➤ Event Priority on page 43

➤ Event Sources on page 44

➤ Relating Events and Automatically Creating Correlation Rules on page 45

➤ Event Correlation on page 45

➤ Tools on page 47

➤ Exporting Event Data on page 47

➤ Event Closing and Archiving Database Tools on page 47

➤ Operations Manager Actions on page 49

➤ Launching Operations Orchestration Run Books on page 50

Tasks

➤ How to Configure the Event Browser on page 51

➤ How to Export the Contents of the Event Browser on page 53

➤ How to Relate Events Manually on page 54

➤ How to Recalculate Event Priorities on page 55
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➤ How to Set Priorities Manually on page 55

➤ How to Create Correlation Rules from Manually-Related Events 
on page 56

➤ How to Transfer Control to an External Manager on page 58

➤ How to Add Annotations to an Event on page 60

➤ How to Add Custom Attributes to an Event on page 60

➤ How to Assign an Event to a User or User Group on page 61

➤ How to Run an HPOM Action on page 62

➤ How to Launch a Custom Action on page 63

➤ How to Launch an HP Operations Orchestration Run Book on page 63

➤ How to Display Events from EUM in the Event Browser on page 64

➤ How to View All Closed Events on page 65

➤ How to View the Closed Event History of a CI on page 66

Reference

➤ Event Perspective User Interface on page 68

➤ opr-archive-events Command-Line Interface on page 117

➤ opr-close-events Command-Line Interface on page 119

Troubleshooting and Limitations on page 121



Chapter 2 • Event Management

25

Concepts

Operations Management Orientation

Managing events with Operations Management helps you to restore services 
and minimize service disruptions. Events are managed using the Operations 
Management application. The application is configured using the 
Operations Management Administration areas.

You can find the Operations Management Application pages using the 
following menu option:

Applications > Operations Management

The Operations Management Application area includes the following tabs:

➤ Event Perspective

Display, monitor, and manage the events that occur in your IT 
environment. For details, see "Event Browser and the Event Perspective" 
on page 26.

➤ Health Perspective

Display alternative perspectives of the events you are monitoring. For 
details, see "Health Perspective" on page 40.

➤ Performance Perspective

Configure, generate, and view graphs and tables that can help you 
understand and manage the performance of the systems in the 
environment you are managing with Operations Management. For 
details, see "Performance Graphs" on page 42.
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Event Browser and the Event Perspective

This section includes the features and functionality of the Event Perspective. 
The information you find here covers the following main panes:

➤ Model Explorer

Displays the contents of the configuration item database and enables you 
to configure filters that determine how you view the contents of the 
database.

➤ Event Browser

Displays a detailed summary of all the events that occur in the operating 
environment you are monitoring.

➤ Event Details

Contains more detailed information about the selected event. Event 
details can be displayed as a pane below the Event Browser or as a popup 
window.

➤ Actions Pane

Display, and execute tools, HPOM actions, and Run Books that can be 
executed on the selected events in the Event Browser. For details, see 
"Tools" on page 47, "Operations Manager Actions" on page 49, and 
"Launching Operations Orchestration Run Books" on page 50.

The size of all Operations Management Application panes can be manually 
modified. You can also use the Expand and Collapse buttons to alter the 
display formats to predefined settings. The Restore button reverts the 
associated pane to the default size.

Model Explorer 
The Model Explorer displays the CIs and relationships from the Run-time 
Service Model database (RTSM). It enables you to select views that filter the 
contents of the RTSM before presenting it in a CI tree in the Browse Views 
tab to simplify navigation.

When you select one or more configuration items in the CI Tree, a filter is 
automatically applied to the Event Browser so that only those events that 
are related to the selected configuration items are displayed.
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The selected view also limits the events displayed to those related to CIs 
contained by the view. The Model Explorer selections can also be cleared 
using the Clear All button.

Note: The behavior of the Event Browser depends on the type of the CI 
selected: CI Group type, Node type, or Other types.

Event Browser
The Event Browser displays a summary of all the events that occurred in the 
environment you are monitoring. The details include:

➤ Date and time when the event occurred.

➤ Host system (node) where the event occurred.

➤ Application that caused the event.

➤ Severity of the event.

➤ The user responsible for solving the problem that caused the event, if 
assigned.

Note: The time zone that is configured for a user in BSM is not considered 
for displaying the time and date in the Event Browser. The time zone set on 
the client system displaying the Event Browser is used.

You can also use the Event Browser to display information about the status 
of a selected event. The event states are Open, In Progress, Resolved or 
Closed. The information displayed by default is a small selection of the total 
information available about an event.
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Note: Tooltips are available and provide a brief explanation of the 
functionality of the associated button.

You can configure the contents of the Event Browser to show the 
information that is most important to you and play sound on receipt of an 
event using the Browser Options dialog box, accessed using the  button.

All changes you make to the Event Browser layout are automatically saved 
to your user account. The next time you logon, the Event Browser displays 
the latest events in accordance with the way you configured the Event 
Browser. For example, when you relogon, the last selected view and Event 
Browser tab are selected and reopened.

Selecting an event in the Event Browser displays the event’s properties in the 
details pane, as long as the details pane is not hidden (toggle Details pane 
using the  button). The details pane contains tabs that enable you to view 
and modify some aspects of the selected event (for example, event 
properties, annotations, custom attributes, and priority).

Note: It is not possible to edit an event with the state Closed, except for 
adding annotations. To edit a closed event, you must first reopen it.
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General Event Details
The General tab in the Event Details pane displays the most commonly 
required information associated with a selected event. General event 
information includes the following details:

➤ Severity: Indication of the level of the problem assigned to the selected 
event. Usually, this is the same as the severity status of the original event 
received from HPOM.

➤ Lifecycle State: Point in the event lifecycle that the selected event has 
reached (Open, In Progress, Resolved or Closed). 

➤ Priority: Importance assigned to the selected event (for example, Low, 
Medium, or High).

➤ Location in the network where the original problem occurred (read-only).

➤ User who is responsible for solving the problem.

➤ Message text in the Title field. This type of text field also supports URLs 
and hyperlinks.

The available information displayed in the General tab summarizes the most 
important information contained in the original event. A blank field 
indicates that no information is available. If you know that a particular type 
of required information is not automatically available, you can use custom 
attributes to provide this information.

Additional Info 
The Additional Info tab in the Event Details pane displays more detailed 
information associated with a selected event. Additional event information 
includes the following details:

➤ Application name

➤ Object

➤ Key

➤ Close events with key

➤ Suppress deduplication flag

➤ Received during Downtime flag
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➤ Description of the event

➤ Solution information for the event

Actions 
HP Operations Manager actions can be started manually from any events 
which have actions associated with them. The actions can be used to help 
solve the problem that caused the event or inform about the existence of a 
problem, for example, by a notification.

The Event Browser displays an icon in the A column to indicate that an 
automatic action is available for the selected event. An icon in the U column 
indicates that a user action is available for the selected event. For more 
information about the icons used in the Event Browser, see "Event Browser 
Overview" on page 69.

Annotations 
An annotation is a free-text attachment to the description of an event used 
to provide information that may be useful to solve the cause of this event. 
You can use the Annotations tab in the Event Details pane to add, view, and 
manage the annotations associated with an event. The annotations text 
field also supports URLs and hyperlinks.

The Event Browser displays icons in the annotations column N to indicate 
that annotations exist for a selected event. For more information about the 
icons used in the Event Browser, see "Event Browser Overview" on page 69.

Assignment of Events to Users   
The Event Browser shows you to which user and group an event is assigned 
for investigation and resolution. If the event is not yet assigned, you can 
assign it from the General tab in the Event Details pane.
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You can also configure rules to automatically assign incoming events to 
available user groups. Automatic assigning of events to user groups 
responsible for solving these events significantly improves the efficiency of 
event management. Each event is assigned to an appropriate user group as 
soon as it is received. All operators in a user group are permitted to work on 
those events assigned to that user group. For detailed information, see 
"Event Assignment" on page 621. See also "Event Categories" on page 32.

Note: To display the contents of the Event Browser according to the user 
assigned to the event, select the User or Group column header. To define 
users and user groups, choose the following menu option:

Admin > Platform > Users and Permissions > User Management

Closed Events
You can view the history of closed events over a specified time period. This 
information can help you to derive a better understanding of long-standing 
problems. From the Closed Events Browser, you can change the lifecycle 
state of any displayed events, for example, to Open.

The Closed Events Browser shows only a snapshot of closed events available 
at the time of opening the Closed Events Browser. Reopened events are 
automatically removed from the Closed Events Browser window. However, 
events that are closed after the opening of the Closed Events Browser are not 
automatically added to the current Closed Events Browser window. A refresh 
is required. The timestamp when the snapshot was taken is displayed in the 
Closed Events Browser window.

You can create filters to help you identify specific events, for example, to 
select a particular CI. 

For details about using the Closed Events Browser, see "How to View All 
Closed Events" on page 65.
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Closed events are not automatically removed from the database. Use the 
opr-archive-events tool to delete closed events from the database and add 
them to an archive file. For details, see "opr-archive-events Command-Line 
Interface" on page 117.

Custom Actions
Custom actions are script-based actions that can be executed on the selected 
event. You configure custom actions from the Custom Actions manager, 
where you set up scripts to run custom actions on events. For example, you 
can add a text string to certain events to make them easier to identify in the 
Event Browser. Available custom actions for an event are executed from the 
context menu.

For more information about creating and managing custom actions, see 
"Custom Actions" on page 565.

Custom Attributes
Custom attributes are additional information included in the original event 
forwarded by a monitoring application such as HP Operations Manager. For 
example, you can define custom attributes to attach the location of the 
problem element or contact details for the team assigned to troubleshoot 
the problem.

You can use the Custom Attributes tab in the Event Details pane to view and 
manage the custom attributes available for an event.

You can also add custom attributes as columns to the Event Browser. 

Event Categories 
Event categories are logical groups of events with some similarities (for 
example, belonging to the same problem area). Event categories help 
simplify the process of deciding to which user or user group an event type 
should be assigned for investigation.

The Event Browser displays the category to which a selected event belongs 
(for example, Storage, Database (DB), System, or WebApp (Web 
Application)). 
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Note: To display the contents of the Event Browser according to event 
category, include Category as an Event Browser column option and then 
select the Category column header to sort alphabetically.

You can restrict user access to events on the basis of event categories. For 
example, some users can be restricted to view and work on events belonging 
to the category Database only. Other users are given access to events that 
belong to the category System only.

For more information about event assignment, see "Assignment of Events to 
Users" on page 30.

Event History   
Event history is a log of information about who or which component has 
changed values of an Operations Management event. This feature enables 
an operator to see how event attribute values changed during the life of an 
event, for example, the sequence of severity changes. Event history 
information is available in a separate tab in the Event Details pane and can 
be viewed by any user with access to that event.

History Tab

The information available in the History tab if an event is manually 
modified in the event console, or automatically modified by closed related 
events (closing all existing related events to a new incoming event) or 
duplicate event suppression (retain and update the original event and close 
newer duplicates) includes the following:

➤ The server’s timestamp of the modification.

➤ The old and the new value of the modified attributes.

➤ Information is also available about the modifier of the event. One of the 
following types of information is available:

➤ User name, if an Operations Management user has modified the event 
or if an external user has made the modification.
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➤ Title line which summarizes an change resulting from automatic 
closing of related events or an automatic suppression of duplicate 
events.

➤ Integration user name of the HPOM synchronization, if the event is 
modified by a data synchronization from HPOM.

➤ For annotations and custom attributes, the executed action, such as 
delete, or modify, is displayed in the history line entry.

Event History Creation

An event history entry is created for the following cases:

➤ User changes an attribute of an event using the Event Browser.

➤ An external user or application changes event attributes using the 
Northbound Interface.

➤ HPOM or another Operations Management instance synchronizes an 
attribute change to Operations Management.

➤ Duplicate suppression changes an existing event.

➤ Automatic closing of related events.

➤ Control is transferred, cancelled, or returned.

➤ Server is added to the event forwarding list.

An event history entry is not created in the following cases:

➤ A pipeline step (for example, CI resolution, or ETI resolution) changes an 
event which is not marked as received because it is still being processed by 
the pipeline.

➤ Events which are modified by the opr-close-events.bat tool.

Event History Characteristics

The following list summarizes the main technical characteristics of event 
history information:

➤ User cannot modify existing history information.
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➤ Closing, deleting, and archiving events using the opr-archive-events tool 
deletes history, but history is included as part of the XML output 
produced by the opr-archive-events tool.

➤ There is no limit to the number of history entries per event.

History is created if one or more of the following properties of an event are 
modified:

➤ Cause (cause/symptom relationship)

➤ Duplicate Count

➤ Correlation Rule

➤ Description

➤ Severity

➤ HPOM user

➤ AssignedGroup

➤ Custom Attributes

➤ Time Received

➤ Title

➤ Lifecycle state

➤ Priority

➤ Assigned User

In addition, changes to event annotations are also tracked as changes in the 
event history.

Filters   
The Event Browser enables you to display events according to filters that 
you define. For example, you can filter the events displayed according to 
severity, assigned user, event category, or lifecycle state. For details, see 
"Filtering Events" on page 211.
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Note: When you select a configuration item in the CI Tree, Operations 
Management automatically applies a filter to the Event Browser so that only 
those events are displayed that are related to the selected configuration 
item.

Instructions   

Operators working with the HPOM message browser can see additional 
instructions, when available, for this message. It is equally helpful for 
Operations Management operators to be able to access this information 
when using HPOM servers to forward events to Operations Management. 
This information is displayed in the Instructions tab of the Event Browser.

HPOM instructions are not contained within the event but are dynamically 
retrieved from the HP Operations Manager either from the corresponding 
policy or an external instruction provider when you select the Instructions 
tab.

Note: In MOM environments where events can come from multiple servers, 
you must connect to a server with the policy installed as only these have the 
instructions available. Originating servers must be configured as a 
Connected server. For details, see "Connecting Servers" on page 407.



Chapter 2 • Event Management

37

Lifecycle Management   
The Event Browser enables you to display and track the position of an event 
in a defined lifecycle. A lifecycle is a complete series of predefined states that 
summarizes the event’s life. The lifecycle states are as follows:

➤ Open: Event is identified for investigation of the problems that caused 
the event. It is either not assigned to a user or assigned but not yet being 
worked on.

➤ In Progress: Assigned user has started working on the investigation of the 
event’s underlying problems. The name of the assigned user appears in 
the User column.

➤ Resolved: Investigation into the selected event’s underlying problem is 
found and fixed.

➤ Closed: Event is removed from the list of active events displayed in the 
Event Browser.

Note: Lifecycle states are linked to authorizations granted to users. For 
example, the user to whom an event is assigned can change the assigned 
event’s state from Open to In Progress and Resolved but not to Closed. Only 
users with higher authority can assign events to other users or change the 
event lifecycle state from Resolved to Closed. 

Although the lifecycle states occur in a consecutive manner, you can set an 
event’s lifecycle state at any time. For example, you can assign an event to 
an alternative user, or reopen an investigation by changing the event state 
from Closed to In Progress.

Note: You can change the lifecycle state of an event by selecting the event 
and selecting the appropriate button (for example, the Open  or Work On 

 button). For more information about event lifecycle buttons and the 
actions they perform, see "Event Browser Overview" on page 69. 
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Notifications
Notifications are Emails, SMSs and Pager messages that can be sent on 
receipt of preconfigured types of events. You configure notifications from 
the Notifications manager, where you set up rules to notify people when 
events with predefined characteristics are received.

For example, if critical events for the most important business-relevant 
services are received by Operations Management during any weekend 
period, the engineer responsible for these services is immediately informed 
by an email, SMS or pager message, or any combination of these. Recipients 
configured in BSM are available to the Notifications manager. You use 
templates to define how events are translated into emails, SMS messages, or 
pager messages.

For more information about creating and managing notifications, see 
"Notifications" on page 533.

Related Events
To reduce the problem of duplication and overload when managing 
information from multiple sources, you can set up topology-based rules. 
These rules correlate events by distinguishing between symptom and cause 
events and present a clearer picture of the state of the operational 
environment that you are monitoring.

Topology-based event correlation uses a combination of specified symptoms 
and a probable causes to determine the cause of an event, which it then 
flags in the Event Browser. An icon in the C column of the Event Browser 
indicates that the selected event is correlated. For details about correlated 
events, see "Related Events Tab" on page 96. For more information about 
event correlation in general, see "Event Correlation" on page 45.

Resolver Hints   
The Resolver Hints tab in the Event Details pane displays information 
associated relating to the identification of the node, source CI, related CI 
and the ETI of the received event.
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Severities Assigned to Events   
Each event can be assigned a severity to shows the importance of the 
underlying problem. The values are: critical, major, minor, warning, normal, 
and unknown. The Event Browser indicates an event’s severity with an icon.

Note: The Items bar at the bottom of the Event Browser indicates the 
number of active events by severity. An active event is one that is open and 
being worked on.

Source Info
The Source Info tab in the Event Details pane displays information 
associated relating to the identification of the source CI of the received 
event.

Synchronization of Events 
Event synchronization enables bidirectional communication between 
managers, for example, Operations Management and HPOM. Updates and 
modifications to events can be exchanged. For example, changes of 
ownership or modifications to the severity status of an event are 
synchronized between management servers.

Note: All messages forwarded from HPOM systems are treated as allowing 
read and write. Any changes made to these events result in a back 
synchronization to the originating HPOM server.
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Note: HPOM events are not updated when using the opr-close-events tool 
and the opr-archive-events tool to close, delete, and archive events. The 
events in HPOM remain unaffected. 

The opposite is also true when using the omwmsgutil (HPOM for Windows) 
tool and opcack and opchistdown (HPOM for UNIX) tools to close, delete, 
and archive events. The events in Operations Management remain 
unaffected.

All these tool operates directly on their respective databases and the changes 
do not go through the workflow process, resulting in the loss of 
synchronization between Operations Management and HPOM. 

If you use these tools to close, delete, and archive events from one system 
(for example, Operations Management), you must make the equivalent 
changes with the appropriate tools on the other system (for example, 
HPOM).

Health Perspective

This section describes how to display more information about events by 
changing the way you view them. It includes the following sections:

➤ "Health Perspective Basics" on page 40

➤ "Health Top View" on page 41

➤ "Health Indicators Pane" on page 41

Health Perspective Basics
The health perspective page displays topological information and health 
indicators related to the selected event. This display enables you to 
simultaneously see events from different perspectives and helps you to 
better understand complex relationships and dependencies.
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For example, you can view the following:

➤ List of active events.

➤ Topological view of the CI related to the selected event.

➤ Health indicators assigned to the objects, their state and value.

Health Top View 
The Health Top View displays the business availability of your system 
components. The CI bar icons in the Health Top View provide a visual 
indication of the health of the related CI of the selected event, based on the 
hierarchy tree structure defined for each view. The connecting lines between 
the bars define the relationships between the CIs.

For more information about KPIs, see "HI-Based KPI Calculations" on 
page 129. For more information about Health Top Views, see "Health Top 
Views" on page 125.

Health Indicators Pane 
The Health Indicators pane of an event shows a list of the health indicators 
used to calculate the health of the configuration item to which the selected 
event belongs. The information displayed includes the name and value of 
the health indicator, its current status, the last time it was updated, and 
whether the trend is up, down, or stable.

The Health Indicators pane displays a list of all the health indicators 
assigned to the KPIs that are attached to the selected configuration item. 
The list is divided according to health indicators contributing to KPIs.

For more information about health indicators, see "Health Indicators" on 
page 128.
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Performance Graphs 

You can generate graphs and tables to illustrate graphically how the 
monitored objects in the environment are performing. The graphs you 
generate show an overview of important performance metrics (for example, 
CPU and swap space utilization over time, memory page use, and 
availability).

You can choose from a variety of graph types and configure the details that 
you want to include in the graph, the time period to be used, and the 
display format (for example, graph, chart, or table). You can also display the 
same data in different forms using multiple tabs.

For details about the performance graphs, see "Graphing Overview" on 
page 142. For more information about how to refine the way in which the 
data is presented in graphs, see "Types of Graphs" on page 144. 

Filters 

You can limit the set of events displayed in the Event Browser using filters 
that you define to display a subset of the available events. For example, you 
can filter the events displayed according to severity, the assigned user, the 
event category, or the lifecycle state. You can also display the filtered events 
in different pages. The Event Browser is dynamically updated. Events that 
no longer match a relative time filter are removed from the Event Browser 
and new events that match are added.

Note: Filters are visible and available only to the user who created them.

For more information about filters in general, see "Event Filters" on 
page 215.
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Event Priority 

Event priorities can be automatically calculated from the Business Model 
and the Event's severity. Event Priority is assigned one of the following 
values Lowest, Low, Medium, High, or Highest. 

The Event Priority calculation is executed in the event pipeline on new 
events. It also can be started manually on multiple events from the console 
context menu.

Input parameters for the calculation are:

➤ Severity of the event 

➤ Business criticality of the related CI (if available) 

Note: If no CI is related to the selected event, the priority is None.

The business impact is provided by the Business Impact Service (BIS) and the 
severity is an attribute of the event.

The calculation of priority is based on the relationship in the following 
table.

Event Severity

Impact Unknown Normal Warning Minor Major Critical

NoImpact Lowest Lowest Low Low Medium Medium

Low Lowest Lowest Low Low Medium Medium

MediumLow Low Low Low Medium Medium High

Medium Medium Low Medium Medium High High

MediumHigh High Medium Medium High High Highest

High Highest Medium High High Highest Highest
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In event forwarding, the calculated priority is forwarded to the receiving 
application. If the CI related to the event is configured in the receiving 
application, the event priority is recalculated by each receiving application. 
If the CI related to the event is not configured in the receiving application, 
the event priority contained within the forwarded event is used.

Note: You can manually change the automatically-assigned priority of an 
event. You can also select two or more events and recalculate their priorities, 
for example to reflect a change in Business Criticality.

Event Sources 

Events originating from many different sources can be processed, for 
example:

➤ HP BSM components:

➤ HP Operations Manager for UNIX (HPOM for UNIX)

➤ HP Operations Manager for Windows (HPOM for Windows)

➤ HP Network Node Manager i (NNMi)

➤ HP End User Management (EUM): 

➤ Business Process Monitor (BPM) 

➤ Real User Monitor (RUM) 

➤ HP SiteScope

➤ HP Systems Insight Manager

➤ Third-party management software, normally used to monitor specific 
environments or special needs not monitored by other solution 
components:

➤ Microsoft Systems Center Operations Manager, Active Directory, 
Exchange

➤ BlackBerry Enterprise Server

➤ SAP
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Alerts, for example, from CI Status Alerts, SLA Alerts, and Event Based Alerts, 
can also generate events in Operations Management. For example, 
Operations Management operators can collect, view, correlate, and manage 
events generated from Event Based Alerts from EUM components. EUM 
components include BPM, or RUM.

Relating Events and Automatically Creating Correlation 
Rules 

You can manually relate events, assigning one event as a cause event and 
the other logically-related events as symptom events. For further 
information, see "How to Relate Events Manually" on page 54.

Manually-related events can also be used as the basis for creating new or 
enhancing existing correlation rules. For further information, see "How to 
Create Correlation Rules from Manually-Related Events" on page 56.

Event Correlation 

Topology-Based Event Correlation (TBEC) in Operations Management is 
used to automatically identify and display the real cause of problems. Events 
that are only symptoms of the cause event can be filtered out using the Top 
Level Items filter, resulting in a clearer overview of the actual problems that 
need to be solved. Event correlation relies on defining relationships between 
correlation rules, ETIs and ETI-values associated to events, and CIs and 
relations between these CIs.

Note: To use event correlation, the Event Management Foundation and 
Correlation licenses are required. For detailed information on licensing, see 
the HP Business Service Management Deployment Guide PDF.
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The topology-based event correlation process works as follows:

➤ Checks whether a relationship exists between the events being correlated.

➤ Monitors the CIs and ETI values assigned to events being correlated.

➤ Determines relationship between two events by checking if there is a 
relationship in the topology database between the CIs to which the 
events are related.

The correlation result is displayed in the Event Browser with an icon in the 
C column to indicate that it is the result of a correlation process.

 — Event is the cause of another event

 — Event is the cause of one event and a symptom of another event

 — Event is a symptom of another event

Note: You might not be authorized to open the Correlation Rules manager. 
For more information about user authorization, see "User Management" on 
page 629.

Events related as a result of correlation with the selected Event are displayed 
in the Related Events tab. The selected event can also be a symptom event 
and you can also see its cause in the Related Events tab.

For more information about the icons used in the Event Browser, see "Event 
Browser Overview" on page 69. For details about correlated events, see 
"Related Events Tab" on page 96. For more information about setting up 
correlation rules, see "Topology-Based Event Correlation" on page 370.
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Tools

You can specify tools, for example, to ping a system. These tools are 
launched from events or from the Actions panel and run on the associated 
CI. Tools are designed to help users solve common problems quickly and 
efficiently.

All available tools are displayed in the Select Tool window launched in the 
context of a configuration item. The selection of tools a particular user sees 
in context menus depends on the tools that are available for the 
configuration item affected by a particular event.

For information about running configured tools, see "Run Tools User 
Interface" on page 207.

Exporting Event Data

You can export the contents of the Event Browser to an external file. The 
supported formats include Microsoft Excel and comma-separated value 
(.csv) lists. It is possible to export the information selected for display in the 
Event Browser (default), a subset of this information or any combination of 
available attributes.

For information about exporting event data, see "How to Export the 
Contents of the Event Browser" on page 53.

Event Closing and Archiving Database Tools

You can use the following two database maintenance command-line tools to 
close and archive events:

➤ opr-close-events Command-Line Interface

➤ opr-archive-events Command-Line Interface

Both command-line tools are available only on Data Processing servers and 
are protected from unauthorized execution.
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Note: HPOM events are not updated when using the opr-close-events tool 
and the opr-archive-events tool to close, delete, and archive events. The 
events in HPOM remain unaffected. 

The opposite is also true when using the omwmsgutil (HPOM for Windows) 
tool and opcack and opchistdown (HPOM for UNIX) tools to close, delete, 
and archive events. The events in Operations Management remain 
unaffected. 

All these tool operates directly on their respective databases and the changes 
do not go through the workflow process, resulting in the loss of 
synchronization between Operations Management and HPOM. 

If you use these tools to close, delete, and archive events from one system 
(for example, Operations Management), you must make the equivalent 
changes with the appropriate tools on the other system (for example, 
HPOM).

opr-close-events Command-Line Interface
It is possible that a certain problem in the IT environment results in the 
generation of a very large number of similar events (event storm) which are 
received by Operations Management. Browsing through and filtering a large 
number of events can be time-consuming and can lead to time-out errors.

Time-outs may be experienced as a result of delays in processing a large 
number of events in the web application, for example, when you select all 
events in the browser and attempt to close them. The user interface server 
may take a long time to start up or may experience a memory bottleneck.

You can use the opr-close-events command-line interface tool to close a 
large number of events, including related events, as experienced during an 
event storm, even when the Operations Management user interface is not 
responding.

For a description of the opr-close-events command options, see 
"opr-close-events Command-Line Interface" on page 119.
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opr-archive-events Command-Line Interface
Closed events are not automatically removed from the database. The 
database maintenance command-line tool opr-archive-events enables you 
to archive closed events. The specified closed events are exported to an 
XML-format file. These events are deleted from the database on archiving.

Note: Importing closed events is not supported.

For a description of the opr-archive-events command options, see 
"opr-archive-events Command-Line Interface" on page 117.

Operations Manager Actions

You can run actions configured in HP Operations Manager from Operations 
Management. Events from HPOM received by Operations Management can 
contain event-related actions. If event-related actions exist, the following 
icons are displayed in the Event Browser in the A column and the U column:

 — Automatic action is available

 — User action is available

Operator-initiated actions and automatic actions are also displayed in the 
Actions tab of the Event Details pane.

Further icons indicate the status of the actions, including, starting, running, 
succeeded, and failed. For a complete overview of the icons and actions 
available, see "Event Browser Overview" on page 69.

You can execute these actions from either the Actions tab or the context 
menu of the event. The result of the action execution creates an entry in the 
History that is added to the event, if configured in the policy. It is also 
possible to stop an event-related action before execution completes.
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Event-related actions for assigned and unassigned events require 
authorization to run. If you are not authorized to execute event actions, you 
still see the configured commands but you are not permitted to execute 
them.

Note: Actions that contain the $OPC_GUI_CLIENT and 
$OPC_GUI_CLIENT_WEB variables are not supported and are filtered out.

For information about running actions, see "How to Run an HPOM Action" 
on page 62.

Launching Operations Orchestration Run Books

If you are using HP Operations Orchestration (OO) to automate operator 
tasks for analyzing or fixing problems, these OO Run Books can be mapped 
to CI Types within BSM.

Run Books can be started from events (shortcut menu). The CIs related to 
the event define which of the available flows are suitable. When you launch 
a Run Book from an event, appropriate flow parameters are automatically 
acquired from the CI or event itself.

Note: When integrating Run Books from OO, you must specify for which CI 
types each Run Book is valid (configured in the Platform) and define which 
event attributes can be used as Run Book input parameters.

If a Run Book input parameter is mapped to a CI attribute and an event 
attribute, the event attribute takes precedence (if launched from events).

For information about running actions, see "How to Launch an 
HP Operations Orchestration Run Book" on page 63.
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Tasks

How to Configure the Event Browser

This task describes how to configure the Event Browser to display only the 
details that you are interested in. For example, you can add and remove 
columns, customize additional tabs, and configure filters to change and 
improve the way in which data displays.

All changes you make to the Event Browser layout are automatically saved 
to your user account. The next time you log on, the Event Browser displays 
the latest events in accordance with the way you configured the Event 
Browser. For example, the last selected view is selected and reopened.

To configure the Event Browser:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, click the Browser Options  button.

 3 From the Columns tab, select the columns to display in the Event Browser 
and click the add  button to include them in the Display these fields 
box.

 4 Select from the Display these columns box any columns that you do not 
want to display and click the remove  button.

 5 Select column names and rearrange their display positions by use of the 
 and  buttons.

The first column item in the list is displayed as the first column in the 
Event Browser. Subsequent column items are placed progressively to the 
right in the order of their appearance in the Display these columns list.

Alternatively, to select the default columns for display in the Event 
Browser, click Reset.

 6 Select OK.
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Note: You can add custom attributes as columns by defining them under the 
corresponding infrastructure settings:

Admin > Platform > Setup and Maintenance > Infrastructure Settings > 
Operations Management > Custom Attributes Settings

Custom attributes defined there can then be selected as a column in the 
Event Browser.



Chapter 2 • Event Management

53

How to Export the Contents of the Event Browser

This task describes how to export the contents of the Event Browser to an 
external file. The supported formats include Microsoft Excel and 
comma-separated value (.csv) lists. It is possible to export the information 
selected for display in the Event Browser (default), a subset of this 
information or any combination of available attributes.

To export the contents of the Event Browser:

 1 Open the Events Perspective tab or the Health Perspective tab to display 
the list of known events:

Applications > Operations Management > <select a perspective>

 2 Optional: Filter the event browser to display only the events that you want 
to export.

 3 In the Event Browser, select the Export Events List  icon.

The Export Event List dialog box opens.

 4 From the Available Columns tab, select the attribute columns to export 
and click the add  button to include them in the Export these columns 
box.

Use the add all  button to include all columns in the Export these 
columns box.

 5 Select from the Export these columns box any columns that you do not 
want to export and click the remove  button.

Use the remove all  button to remove all columns from the Export 
these columns box.

 6 Select column names and rearrange their export order by use of the up  
and down  buttons.

The first column item in the list is displayed as the first column in the 
exported file. Subsequent column items are placed progressively to the 
right in the order of their appearance in the Export these columns list.

Alternatively, to select the default columns for export, click Reset.
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 7 From the File format list, select the format of the export file to be created:

➤ Comma-separated values (.csv)

➤ Microsoft Excel 2007 Workbook (.xlsx)

➤ Microsoft Excel 97-2003 Workbook (.xls)

 8 Select OK.

 9 Enter a name and select a location for the export file and click Save.

Note: If you export the contents of the Event Browser with non-ascii 
characters using the comma separated values (.csv) format and open it 
directly in Microsoft Excel, the characters may be unreadable.

As the file is UTF-8 encoded, it can be read by Microsoft Excel by using one 
of the following methods:

➤ Import the file into Excel with UTF-8 character set: 
Data > Import External Data > Import Data 
Text Files, 65001 encoding (UTF-8)

➤ Open the csv-format file with Notepad and save it with UTF-8 encoding.

How to Relate Events Manually

This task describes how to manually relate selected events in the Event 
Browser by assigning one event as a cause event. All other related events 
become symptom events.

To manually relate an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select the events that you want to relate.

 3 Right-click one of these events and select Relate Events from the context 
menu. The Relate Events dialog box opens.
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 4 Select one of the events as the cause event.

All other events are symptoms of the selected cause event.

 5 Optional: Manually related events can also be used as the basis for 
automatically generating a correlation rule. If you also want to create a 
correlation rule based on the current relationship, select the check box 
Open correlation rule wizard. For details about creating a correlation rule 
using the Correlation Rule Generator, see "How to Create Correlation 
Rules from Manually-Related Events" on page 56.

 6 Select OK.

How to Recalculate Event Priorities

This task describes how to manually recalculate the priorities for selected 
events in the Event Browser. This may be necessary when Business 
Criticality values changed in the underlying business model, and you want 
these changes reflected in your active events.

To manually recalculate the priority of an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select the events for which you want to recalculate 
the priority.

 3 Right-click one of these events and select Recalculate Priority from the 
context menu.

The priority value for the selected events is updated.

How to Set Priorities Manually

This task describes how to manually change the automatically-assigned 
priority of an event.

To manually change the priority of an event:

 1 Open the Event Browser to display the list of known events:
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Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select the event for which you want to change the 
priority value.

 3 Open the Event Details pane.

 4 Select the required priority from the Priority list.

 5 Select Save.

How to Create Correlation Rules from Manually-Related 
Events

This task describes how to create or enhance a correlation rule based on 
selected events. From the Event Browser, you need to identify related events, 
select a cause event, relate them manually, and choose to create a 
correlation rule to reflect this relationship.

The Correlation Rule Generator wizard requires that the events being used 
to generate a new rule include a Related CI.

Note: If related ETIs and their values are not available, you can define 
indicator mapping rules to set indicator states (see "How to Create and Edit 
Indicator Mapping Rules" on page 330), and create a correlation rule for this 
case. You must also modify and redeploy the event forwarding policy that 
created the event in HPOM to provide a suitable ETI and value for this type 
of event. Next time such an event is received, an ETI is included, and the 
associated correlation rule is triggered.

To create or edit a correlation rule from manually-related events:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select the events that you want to relate.
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Note: Generation of a correlation rule from selected events is limited to a 
maximum of 10 events.

 3 Right-click one of these events and select Relate Events from the context 
menu.

The Relate Events dialog box opens.

 4 Select one of the events as the cause event.

All other events are symptoms of the selected cause event.

 5 Select Open correlation rule wizard. 

 6 Select OK.

The Correlation Rule Generator dialog box opens.

 7 Select the cause event (Use as Cause  button).

All rules with the selected cause are displayed.

 8 From the Select Events for Creating or Enhancing a Correlation Rule 
section, select additional events that are to be included in the correlation 
rule.

Note: The list of possible rules that can be enhanced is dependent on the 
CI Type of the cause event selected.

 9 Select Create to create a correlation rule based on the specified cause and 
symptom events, or select an existing correlation rule and click Enhance.

The Rule Properties page opens.

 10 Specify the properties for a new correlation rule or make the appropriate 
changes to the existing correlation rule.
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 11 Optional: If you want the correlation rule to be enabled immediately, 
select Active.

 12 Optional: Select an alternative time window for this correlation rule. This 
defines time period used to correlate events with an existing event. An 
event received after the time period is past is not be correlated with the 
original event. An alternative time window overrides the global default 
set in the Infrastructure Settings Manager page for Operations 
Management. For details, see "Topology-Based Event Correlation Settings" 
on page 717.

 13 Select Next.

The Rule Details page opens.

 14 Optional: You can select nodes from a graph and can add additional ETIs 
to the rule.

 15 Select Finish to create the new correlation rule or modify the existing one.

For more information about correlation rules, see "Correlation Rules" on 
page 367.

How to Transfer Control to an External Manager

This task describes how to transfer control of events in the Event Browser to 
an external manager. 

Note: The external manager server must be specified as a target in the 
Connected Servers manager.
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For example, if your organization uses HP Service Manager as a central 
service desk, you can transfer control of events from the Event Browser to 
HP Service Manager. This is often the case when the Operations 
Management operator is not able to solve the problem and needs to assign 
the problem to an expert. HP Service Manager creates an incident returns 
the Incident ID to Operations Management. This is displayed in the External 
Info tab with additional information about the event available from the 
external manager.

Note: If you transfer control of an event:

➤ it is not possible to transfer control again and the option is not displayed.

➤ a message is sent to the target server to notify that control was 
transferred if the event was forwarded with the Synchronize option.

To manually transfer control of an event to an external manager:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select the events that you want to transfer control 
to an external manager.

 3 Right-click one of these events and from the context menu select:

Transfer Control to > <select a manager>

Note: If there is a problem connecting to the system to which you want to 
transfer control, the event forward request or event update synchronization 
request is held in a queue. If the request cannot be delivered to the target 
server within the specified time, it is automatically deleted from this queue.

To set the Event Forwarding Expiration time period, see "Event Forwarding 
Settings" on page 702. The default value is 2 hours and the minimum value 
is 1 hour.
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How to Add Annotations to an Event

This task describes how to add an annotation to an event. Annotations help 
the user understand the background of an event.

To add an annotation to an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select an event.

 3 From the Event Details pane, select the Annotations tab.

Click the Add Annotation  button from the Annotations toolbar to 
open the Add Annotation dialog box.

 4 Enter the information text.

Note: Annotations exceeding 100 000 characters are truncated and it is 
not possible to save annotation longer than 100 000 characters.

 5 Select OK.

How to Add Custom Attributes to an Event

This task describes how to add custom attributes to an event. Custom 
attributes provide extra information that can help the user understand the 
background to an event and, as a result, speed up the resolution of the 
event’s underlying problem.

Note: To add or modify custom attributes, you must be logged on as a user 
with permissions to modify the event.
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To add a custom attribute to an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Event Browser, select an event.

 3 From the Event Details pane, select the Custom Attributes tab.

 4 Click the Add Custom Attribute  button to open the Add Custom 
Attribute dialog box.

 5 Enter the custom attribute name and value.

 6 Select OK.

How to Assign an Event to a User or User Group

This task describes how to assign an event from the Event Browser to a user 
or user group.

To assign an event to a user or user group:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 From the Event Browser pane, select the event that you want to assign to 
a user.

 3 Open the Event Assignment dialog box in one of the following ways:

➤ In the Event Browser pane, click the Assign To  button.

➤ Right-click the event and select Operations > Assign To from the 
context menu.

 4 In the Assigned Group box, use the menu to select the user group to 
which you want to assign the selected event (for example, Database 
Experts or Application Server Operators).

 5 In the Assigned User box, use the menu to select the user to whom you 
want to assign the selected event. 

The users displayed in the menu are filtered according to the user group 
selected in the previous step.
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Note: Alternatively, in the General tab of the Event Details pane, select 
the user and group from the Assigned Group and the Assigned User boxes 
and click the Save  button.

 6 Select OK.

How to Run an HPOM Action 

In this task, learn how to run HPOM actions for an event containing 
event-related actions.

To run an action from an event with related actions:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 Select an event that includes event-related actions. 

Actions are identified by the following icons displayed in the Event 
Browser in the A column and the U column:

 — Automatic action is available

 — User action is available

Further icons indicate the status of the actions, including, starting, 
running, succeeded, and failed. For a complete overview of the icons and 
actions available, see "Run Tools User Interface" on page 207.

 3 Select the Actions tab.

The action specification, target node, and the status of the available 
actions are displayed. A maximum of one automatic action and one user 
action is available for an event.

 4 For the action that you want to run, select Start.

Alternatively, from the context menu for the event, select the appropriate 
action:
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Right-click > Actions > Start 

The action starts, the status changes to Running and the associated action 
icon in the Event Browser changes to reflect this status.

After the action execution has completed successfully, the status changes 
to Succeeded. If the action did not execute successfully, the status is 
changed to Failed.

 5 Select the Annotations tab for a summary of the executed action.

How to Launch a Custom Action

In this task, learn how to launch a custom action for an event.

To run a custom action from an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 Select the Custom Action that you want to run on an event: 

Right-click > Launch > Custom Actions > <select a custom action>

The selected custom action is launched in the context of the selected 
event.

How to Launch an HP Operations Orchestration Run 
Book 

In this task, learn how to launch an HP Operations Orchestration Run Book 
for an event.

To run a Run Book from an event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > Event Perspective

 2 Select the Run Book that you want to run on an event: 

Right-click > Launch > Run Books > <select a Run Book>
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The selected Run Book is launched in the context of the event or the CI 
associated with the selected event.

Note: The context menu item is only visible if the logged-on user has 
permissions to execute Run Books. Users can be configured in the 
Permissions tab under the Operations Orchestration Integration context. 
This available from:

Admin > Platform > User and Permissions

Tip: Run Books can also be run from the Actions pane.

How to Display Events from EUM in the Event Browser 

You can configure the automatic forwarding of events from End User 
Management (EUM) to the Operations Management Event Browser using 
the Event Channel to proactively alert the operator about a problem in the 
system. EUM alerts are mapped to events using the Event Template.

The possible configuration methods are:

➤ Configure HI status changes

➤ Configure EUM alerts

➤ Configure specific CI Status alerts

For task details, see the Solutions and Integrations guide.
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If configured, EUM events are displayed in the Event Browser. In addition to 
the regular Event Browser operations, you can drill down to EUM reports to 
complete your analysis. The drill down is available only for events which are 
generated by the EUM alerts.

How to View All Closed Events 

In this task, you display a Closed Events Browser window containing all 
closed events over a selected time period.

The Closed Events Browser shows only a snapshot of closed events available 
at the time of opening the Closed Events Browser. Events that are reopened 
are automatically removed from the Closed Events Browser. Events that are 
closed after the opening of the Closed Events Browser are not automatically 
added to the current Closed Events Browser window. A refresh is required. 
The timestamp when the snapshot was taken is displayed in the Closed 
Events Browser window.

The maximum number of events that can be displayed in the Closed Events 
Browser can be configured in the Settings Manager. For details, see "Closed 
Events Browser Settings" on page 693.

To show closed events history related to a current event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 Click the Show Closed Events  button.

 3 In the Closed Events Browser Configuration window, specify the time 
period for which you want to display history.

Select a predefined period, and the number of available related closed 
events is displayed in the Number of events field.

If you select Select a custom range, specify a custom time range, and 
select Apply. The number of available related closed events is displayed in 
the Number of events field.

 4 Select OK to display the Closed Events Browser window containing the 
available events.
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Actions can be executed on the selected event using the available buttons 
and context menus. For details, see "Closed Events Browser Configuration 
Dialog Box" on page 106.

How to View the Closed Event History of a CI 

In this task, you display a Closed Events Browser window containing all 
closed events related to the related CI of a current event over a selected time 
period.

The Closed Events Browser shows only a snapshot of closed events available 
at the time of opening the Closed Events Browser. Events that are closed 
after the opening of the Closed Events Browser are not added to the current 
Closed Events Browser window. The timestamp when the snapshot was 
taken is displayed in the Closed Events Browser window.

The maximum number of events that can be displayed in the Closed Events 
Browser can be configured in the Settings Manager. For details, see "Closed 
Events Browser Settings" on page 693.

To show closed events history related to a current event:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 Right-click the event for which you want to see the event history and 
select Show > Closed Events (Related CI) from the context menu.

 3 In the Closed Events Browser Configuration window, specify the time 
period for which you want to display history.

Select a predefined period, and the number of available related closed 
events is displayed in the Number of events field.

If you select Select a custom range, specify a custom time range, and 
select Apply. The number of available related closed events is displayed in 
the Number of events field.

 4 Select OK to display the Closed Events Browser window containing the 
available events.
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Actions can be executed on the selected event using the available buttons 
and context menus. For details, see "Closed Events Browser Configuration 
Dialog Box" on page 106.
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Reference

Event Perspective User Interface

This section aims to help you become familiar with the Event Perspective 
and understand how you can use it to better manage the events that occur 
in your IT environment. The Event Perspective page displays event-related 
information in separate panes, the contents of which are described in 
greater detail in the following topics:

➤ Model Explorer on page 69

➤ Event Browser Overview on page 69

➤ General Tab on page 84

➤ Additional Info Tab on page 88

➤ Source Info Tab on page 89

➤ Actions Tab on page 91

➤ Annotations Tab on page 92

➤ Custom Attributes Tab on page 93

➤ Related Events Tab on page 96

➤ History Tab on page 98

➤ Resolver Hints Tab on page 99

➤ Instructions Tab on page 102

➤ External Info Tab on page 103

➤ Browser Options Dialog Box on page 104

➤ Relate Events Dialog Box on page 108

➤ Correlation Rule Generator Dialog Box on page 110

➤ Export Event List Dialog Box on page 115

➤ Closed Events Browser Configuration Dialog Box on page 106
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➤ Correlation Rule Generator Dialog Box on page 110

➤ opr-archive-events Command-Line Interface on page 117

➤ opr-close-events Command-Line Interface on page 119

Model Explorer

The Model Explorer displays configuration items from the Run-time Service 
Model database (RTSM). The displayed selection can be filtered by applying 
a view. Views configure the Model Explorer to display only the 
configuration items specified in the view.

The contents of the Event Browser pane are filtered according to the selected 
view or configuration item type. The active filter is indicated in the Filter 
applied list.

Event Browser Overview

The Event Browser pane, available in the Event and Health Perspectives, 
displays an overview of the active events that exist in the IT environment 
you are monitoring. Events report important occurrences in the managed 
environment, and are generated by source managers. These are forwarded to 
Operations Management and are assigned to operators for resolution.

To access Select Applications > Operations Management > Event 
Perspective 

Important 
Information

Using the Modeling Studio (Admin > RTSM 
Administration > Modeling > Modeling Studio), you can 
configure new views or modify existing views to change, 
increase, or decrease the information displayed.
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Filtering the Event Browser content helps you to focus on the most useful 
information. You can configure new filters or modify existing filters to 
change, increase, or decrease the information displayed.

To access Select Applications > Operations Management > Event 
Perspective

Important 
information

The contents of the Event Browser pane in the Event 
Perspective and Health Perspective are filtered according 
to the selected view or configuration item. The active 
view or configuration item filter is indicated in the filter 
list enabled using the (View/CI) filter  button. The 
Active Event Filter is displayed in the filter selection field.

Relevant tasks For more information about configuring the Event 
Browser, see "How to Configure the Event Browser" on 
page 51.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.
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Closed Events Browser
You can view closed events history over a specified time period, either for all 
closed events of for a selected CI. From the Closed Events Browser, you can 
change the lifecycle state of any displayed events. For details, see "Closed 
Events" on page 31. All Event Browser actions relevant to closed events can 
be accessed from the Closed Events Browser.

Note: Reopened events are automatically removed from the Closed Events 
Browser window. However, events that are closed after the opening of the 
Closed Events Browser are not automatically added to the current Closed 
Events Browser window. A refresh is required. The timestamp when the 
snapshot was taken is displayed in the Closed Events Browser window. Only 
one Closed Events Browser can be opened at a time by each user.

Event Browser Icons, Buttons, and Context Menus

To access Select Applications > Operations Management > Event 
Perspective > click the Show Closed Events  button.

Important 
information

The maximum number of events that can be displayed in 
the Closed Events Browser can be configured in the 
Settings Manager. For details, see "Closed Events Browser 
Settings" on page 693.

Relevant tasks For more information about viewing closed events, see 
"How to View All Closed Events" on page 65.

To access Select Applications > Operations Management > Event 
Perspective > right-click an event. 
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The following table lists the buttons that enable you to perform actions in 
the Event Browser pane. For a short explanation of the action performed by 
a button in the Event Browser, check the tooltip. 

???

Important 
information

Some options and tools displayed in context menus 
require you to be logged on as a user with the 
authorization to start the selected tool.

Relevant tasks For more information about the actions that are available 
in context menus and tooltips displayed in the Event 
Browser page, see the Event Browser graphical user 
interface descriptions in "Event Browser Icons, Buttons, 
and Context Menus" on page 71.

UI Element (A-Z) Description

Reopen: Sets the lifecycle status for the selected events to 
Open. The events can now be assigned to users for 
investigation and resolution.

Work On: Sets the lifecycle status for the selected events 
to In Progress, indicating that the underlying problems 
of the events are under investigation.

Resolve: Sets the lifecycle status for the selected events to 
Resolved.

Close: Sets the lifecycle status for the selected events to 
Closed.

Assign To: Opens the Event Assignment dialog box, 
enabling you to assign the selected events to a specific 
user or user group.

Relate Events: Opens the Relate Events dialog box, 
enabling you to manually relate the selected events by 
assigning one event as a cause event. All other events 
become symptom events.

Manually related events can also be used as the basis for 
automatically generating a correlation rule. For details, 
see "Relating Events and Automatically Creating 
Correlation Rules" on page 45.
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Enables and disables CI filtering. Visible from the Event 
Perspective and the Health Perspectives.

 — Disable CI Filter: Display all events selected by the 
active filter for all CIs.

 — Enable CI Filter: Display all events selected by the 
active filter for the selected CI.

 — Enable CI Filter (include events for child CIs): 
Display all events selected by the active filter for the 
selected CI and all its child CIs.

Tip: Can be combined with the Search Events feature.

Event Filters: Opens the Select an Event Filter dialog box, 
enabling you to select the event filter that you want to 
apply.

From the Select an Event Filter dialog box, you can also 
open the Filter Configuration dialog box to create an 
event filter, test, edit or delete an existing event filter.

For more information about the event filters, see "Event 
Filters" on page 215.

Browser Options: Opens the Browser Options dialog box 
for the current Event Browser tab. You can modify and set 
display options (for example, to hide or display columns, 
or change the order in which the data appears, play 
sound on receipt of an event). 

Opens the Export Event List dialog box for the current 
Event Browser where you can specify which event 
attributes you want to export to the external file. 

Show/Hide Event Details Pane: Toggles between the 
Event browser view with and without the Event details 
pane. You can also open the event details for an event in 
a pop-up window using the Show > Event Details context 
menu item or double-click the event.

UI Element (A-Z) Description
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Refresh: Synchronizes the event data displayed in the 
user interface with the latest information available in the 
database on the server and forces a complete refresh.

For information on setting the automatic update interval, 
see "User Interface Settings" on page 720.

Show/Hide Closed Events: Displays the Closed Events 
Browser Configuration window used to specify the time 
period for the closed events to be displayed in the Closed 
Events Browser. Select OK and the Events Browser 
displays the closed events related to the related CI of a 
current event over a selected time period opens.

Click the Hide Closed Events  button to return to the 
Event Browser.

<Search Events> Entered text string is used to search the text displayed in 
the Event Browser and display only the events containing 
the specified string. Clearing the field displays all events 
again.

If you are also filtering by CIs, selecting a different CI 
clears the search field. 

Close and Reset 
Health Indicator

Sets the lifecycle status for the selected events to Closed 
and resets the associated HI values to the default values.

Configure > Event 
Type Indicators

Opens the Indicators manager. You need the appropriate 
authorization to access the Indicators manager and other 
Administration features.

Configure > 
Integration Policies

Opens the Policy Management UI in a new window.

Configure > 
Performance Graphs

Opens a new window and displays the graph Design 
Wizard. This wizard enables you to design a graph and 
specify its attributes and save it as a template for later use. 

Configure > Tools Opens the Tools manager. You need the appropriate 
authorization to access the Indicators manager and other 
Administration features.

UI Element (A-Z) Description
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Configure > View 
Mappings

Opens the View Mappings manager. You need the 
appropriate authorization to access Administration 
features.

UI Element (A-Z) Description
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Items Indicates the number of events by severity and 
assignment to individual users or user groups. The valid 
severities are critical, major, minor, warning, normal, and 
unknown.

The number of events displayed as a total of the number 
of available events before filtering is also displayed along 
with the number of selected events in brackets. For 
example, 25 of 40 (3) means that there are 40 possible 
events available for the current user of which 25 are 
displayed in the Event Browser (15 have been removed by 
filtering). 3 events are selected in the Event Browser.

The following icons indicate event severity status:

 — Critical

 — Major

 — Minor

 — Warning

 — Normal

 — Unknown

Usually, this is the same as the severity status of the 
original event received from HPOM.

Selecting a severity icon results in filtering out all other 
events and displays only the events with the selected 
severity. The filter is cleared by clicking the icon again.

The following icons indicate the event assignment status:

 — Event assigned to logged-on user

 — Event assigned to one of the groups that the 
logged-on user is a member of.

 — Events assigned to other users

 — Event assignment not known

Depending on the settings selected in the active filter, 
some items are displayed with a value of 0, for example, 
because they are excluded by a filter.

UI Element (A-Z) Description
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Launch > Custom 
Actions

Opens the Custom Actions menu from which you can 
select a custom action from a list of those configured for 
the CI type associated with the selected event.

Launch > Run Books Opens the Run Books menu from which you can select a 
Run Book from a list of those configured for the CI type 
associated with the selected event.

Launch > Tool Opens the Tool menu from which you can select a tool 
from a list of those configured for the CI type associated 
with the selected event.

Recalculate Priority Manually recalculates the priorities for selected events in 
the Event Browser.

If the Business Criticality was changed for one or more 
CIs related to events in the Event Browser, a recalculation 
assigns new priority values for these events.

Show > Application 
Summary Report

If available, the Application Summary report is displayed 
for the selected event created by BPM.

Show > BPM 
Performance Analysis 
Report

If available, the BPM Performance Analysis report is 
displayed for the selected event created by BPM.

Show > BPM Triage 
Report

If available, the BPM Triage report is displayed for the 
selected event created by BPM.

Show > Business 
Service Impact for 
Related CI

Opens a new window and displays the Business Service 
Impact for CI associated with the selected event.

Show > Changes for 
Related CI

Displays information about the most recent changes to 
the CI related to the selected event.

Data can also be displayed for the child CIs which have 
an Impact relationship with the selected CI. If you clear 
the Show data for child CIs check box, data is only shown 
for the selected CI. 

By default, actual changes and incidents are shown for 
the past week. The requests for change area shows the 
changes planned during the previous week, and those 
that are planned for the coming week.

UI Element (A-Z) Description
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Show > Closed 
Events (related CI)

Displays the Closed Events Browser with closed events 
that are associated with the CI related to the selected 
event. 

Click the Hide Closed Events  button to return to the 
Event Browser.

Show > Event Details Opens the event details for an event in a pop-up window 
and displays all available information about the event.

Show > Event in 
Source Manager

Opens the event in the source manager user interface 
connected using the Integration Adapter.

Show > External 
Details

Opens the event in the external application that is 
responsible for managing the event.

Show > Filtered 
Browser (Node)

Displays only events that concern the Node CI to which 
the selected event is related.

Show > Filtered 
Browser (Related CI)

Displays events that concern the selected configuration 
item only.

Show > Performance 
Graphs (CI)

Opens a new window and displays the performance 
graphs that are available for the selected CI.

Show > Performance 
Graphs 
(Neighborhood)

Opens a new window and displays the performance 
graphs that are available for the selected node or event.

Show > RUM Event 
Summary Report

If available, the RUM Event Summary report is displayed 
for the selected event created by RUM.

Show > RUM 
Performance Analysis 
Report

If available, the RUM Performance Analysis report is 
displayed for the selected event created by RUM.

Show > RUM Triage 
Report

If available, the RUM Triage report is displayed for the 
selected event created by RUM.

Show > Source 
Manager Policies

Opens the event in the Policy Management Integration 
Adapter user interface.

UI Element (A-Z) Description
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Event Browser Context Menus 

Most actions are also available from context menus, which provide quick 
and direct access to information about selected elements and actions that 
you can perform on them.

You open a context menu by right-clicking a user interface element. The 
information available and the actions that are possible from a context menu 
depend on the element and the context in which it exists.

Show > Related 
Events

Opens the Related Events tab of the Event Details dialog 
box which indicates the relationship of the selected event 
to other events. The information displayed is the same as 
that available in the event details pane.

Transfer Control to Forwards the selected event to a configured external 
manager application. Used when the operator is not able 
to solve the problem and needs to escalate the issue, for 
example, create a Service Manager incident. The external 
manager can be configured to return an incident ID to 
Operations Management as external information.

To access Select Applications > Operations Management > Event 
Perspective > right-click an event. 

Important 
information

Some options and tools displayed in context menus 
require you to be logged on as a user with the 
authorization to start the selected tool.

Relevant tasks For more information about the actions that are available 
in context menus and tooltips displayed in the Event 
Browser page, see the Event Browser graphical user 
interface descriptions in "Event Browser Icons, Buttons, 
and Context Menus" on page 71.

UI Element (A-Z) Description
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Event Browser Labels

The following table lists the elements that are included in the Event Browser 
pane. For a short explanation of the action performed by a button in the 
Event Browser, check the tooltip. 

UI Element (A-Z) Description

A-Automatic Action Indicates if an automatic action is attached to the event 
and describes its status using the following icons:

 — Not run automatic action available for event

 — Automatic action is running

 — Automatic action executed successfully

 — Automatic action failed to execute successfully

C-Correlation Indicates if the event has any related events that are 
hidden as a result of a correlation. The following icons 
indicate the event’s position in a chain of events:

 — Event is a cause in a correlation

 — Event is a cause in one correlation and a symptom 
in another

 — Event is a symptom in a correlation

For details about correlated events, see "Related Events 
Tab" on page 96. 

D-Duplicate Count Indicates how many duplicate events exist (for 
example, 2 or 3).

I-Instructions Indicates if the event contains any Instructions.

Operators working with the HPOM message browser 
can see additional instructions, when available, for this 
message. It is equally helpful for Operations 
Management operators to be able to access this 
information when using HPOM servers to forward 
events to Operations Management. This information is 
displayed in the Instructions tab of the Event Browser.
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N-Annotations Indicates if the event contains any annotations. 
Annotations are comments or observations relating to 
the associated (or a similar) event. The following icons 
indicate the presence of annotations:

 — Event has annotations

For more information about annotations, see 
"Annotations Tab" on page 92.

T-Control Transferred Indicates if the responsibility for the associated event 
was transferred to an external manager.

U-User Action Indicates if a user action is attached to the event and 
describes its status using the following icons:

 — Not run user action available for event

 — User action is running

 — User action executed successfully

 — User action failed to execute successfully

Application Application that caused the event to occur.

(Assigned) Group Name of the group to which the selected event is 
assigned.

(Assigned) User Name of the network user who is responsible for solving 
the event’s underlying problem. For example, if the 
event is owned by an Operations Management user, the 
user name is displayed. If the event is owned by an 
HPOM user, the user name is displayed with the prefix 
OM:, for example, OM:Database Operator. 

Category Name of the logical group to which the event belongs 
(for example, Database, Security, or Network). An event 
category is similar in concept to a message group in 
HPOM.

CI Hint Information that helps to resolve the related CI, for 
example, Service name in HPOM event.

CI Type Configuration item type associated with the event.

Core ID Host system where the event occurred.

UI Element (A-Z) Description



Chapter 2 • Event Management

82

Description Optional information about the event in addition to 
the event’s original title and the text captured from the 
event source.

Event Type Indicator 
(ETI)

Display name of the event type indicator (ETI) reported 
by the selected event and the current value, (for 
example, Web application state: Slow).

WebAppState is the name of the event type indicator. 
The corresponding label is Web application state, which 
is shown in the General tab. The level of the current ETI 
value is Slow.

If event type indicators are assigned (see the Source Info 
tab) but are not being resolved (event type indicator 
field in General tab is empty), the configuration must 
be corrected.

External ID ID of the event assigned by the external manager.

ID ID of the event. Same as the ID of the message in HPOM 
if it is forwarded to Operations Management.

(Lifecycle) State Point in the event lifecycle that the selected event has 
reached: 

 — Open

 — In Progress

 — Resolved

 — Closed

To change an event’s lifecycle status, select the event, 
and select one of the status buttons above the event list 
or use the context menu options. User authorizations 
control the permissions to change lifecycle states.

Node Hint Information used to identify node CI. For example, the 
hostname in HPOM used to find host in the RTSM:

➤ DNS name of the originating server.

➤ Node ID of the originating server.

Object Device such as a computer, printer, or modem.

UI Element (A-Z) Description



Chapter 2 • Event Management

83

Originating Server Management server that initially forwarded the original 
event along the chain of servers configured in a flexible 
management environment.

Owned in HP OM Indicates whether the event is owned by a user in 
HPOM (Y). If the event is owned by an HPOM user, the 
user name is displayed with the prefix OM:, for 
example, OM:Database Operator in the User field (Event 
Browser and General tab).

Priority Priority assigned to the selected event (for example, 
Low, Medium, or High).

Received during 
Downtime

Event received from a CI during a time period when the 
CI was in downtime (scheduled to not be available).

Related CI Name of the impaired configuration item where the 
event occurred.

If the Related CI includes a subcomponent, it is 
displayed as follows: Related CI: Subcomponent. For 
example, Server1: CPU1.

Sending Server Last server in the HPOM flexible management chain 
that forwarded the event to Operations Management.

Severity (Sev) Severity assigned to the selected event. Usually, this is 
the same as the severity status of the original event 
received from HPOM. The following icons indicate 
event severity status:

 — Critical

 — Major

 — Minor

 — Warning

 — Normal

 — Unknown

Solution Text field used to document solutions to help operators 
solve the problem indicated by the event.

Source CI Node where the monitoring agent or probe is running 
that generated the selected event.

UI Element (A-Z) Description
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General Tab

The General tab in the Event Details pane displays detailed information 
about the selected event including its origin, the time at which it was 
created, and who is responsible for resolving the problem to which it relates. 
The values for Severity, Lifecycle State, Priority, Assigned Group, and 
Assigned User can be changed using the associated lists.

Note: If a field is empty, no information exists for the selected item.

Source CI Hint Information used to identify the source CI.

Subcategory Name of the logical subgroup (category) to which the 
event belongs (for example, Oracle (database), Accounts 
(security), or Routers (network)).

Time Created Date and time when the event was created.

Time Lifecycle State 
Changed

Date and time when the last lifecycle state change took 
place.

Time Received Date and time when the event was received.

Title Brief summary of the event.

Type Type of message in HPOM. String used to organize 
different types of events within an event category or 
subcategory.

To access Select Applications > Operations Management > Event 
Perspective and select the General tab.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description
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The following table lists the elements that are included in the General tab of 
the Event Browser.

UI Element (A-Z) Description

Save: Saves the changed values.

Undo changes: Discards the changed values.

Assigned Group Name of the group to which the selected event’s 
assigned user belongs.

Assigned User Name of the user who is responsible for solving the 
event’s underlying problem. For example, if the event is 
owned by an Operations Management user, the user 
name is displayed. If the event is owned by an HPOM 
user, the user name is displayed with the prefix OM:, for 
example, OM:Database Operator. 

Category Name of the logical group to which the event belongs, 
(for example, Database, Security, or Network). The event 
category is similar in concept to the HPOM message 
group.

Control Transferred Indicates if the responsibility for the associated event is 
escalated to a higher-level manager.

Duplicate Count Number of duplicate events associated with the selected 
event.

Event Type Indicator Display name of the event type indicator (ETI) used to 
calculate the status reported by the selected event and 
the current value, (for example, 
Web application state:Slow).

WebAppState is the name of the event type indicator. 
The corresponding label is Web application state, which 
is shown in the General tab. The level of the current ETI 
value is Slow.

If event type indicators are assigned (see the Source Info 
tab) but are not being resolved (event type indicator 
field in General tab is empty), the configuration must 
be corrected.
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ID ID of the selected event. The event reports an event 
that occurred in the operational environment.

Lifecycle State Point in the event lifecycle that the selected event has 
reached: 

 — Open

 — In Progress

 — Resolved

 — Closed

To change an event’s lifecycle status, select a lifecycle 
state from the list and click Save. User authorizations 
control the permissions to change lifecycle states.

The following list shows correlation between the state 
used in the incoming message and the state used in 
Operations Management:

➤ Message = acknowledged; Lifecycle state = Resolved
➤ Message = owned; Lifecycle state = In Progress
➤ Message = neither acknowledged nor owned; Lifecycle 

state = Open

Node Host system where the event occurred. The link opens 
the CI properties in a pop up window.

The link opens the CI Properties dialog box of the CI.

Priority The priority assigned to the selected event (for 
example, for example, Low, Medium, or High).

To change an event’s priority, select a priority from the 
list and click Save. 

Related CI Name of the impaired configuration item where the 
event occurred. The link opens the CI properties in a 
pop up window.

If the Related CI includes a subcomponent, it is 
displayed as follows: Related CI[additional info]: 
Subcomponent. For example, Server1[Windows]: CPU1.

The link opens the CI Properties dialog box of the CI.

UI Element (A-Z) Description
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Severity Severity assigned to the selected event. Usually, this is 
the same as the severity status of the original event 
received from Operations Management. The following 
icons indicate event severity status:

 — Critical

 — Major

 — Minor

 — Warning

 — Normal

 — Unknown (Cannot change severity to Unknown).

Source CI Host system where the monitoring agent or probe is 
running that generated the selected event.

The link opens the CI Properties dialog box of the CI.

Subcategory Name of the logical subgroup (category) to which the 
event belongs (for example, Oracle (database), Accounts 
(security), or Routers (network)). 

Time Created Date and time when the selected event was created.

Time State Changed Date and time when the last lifecycle state change took 
place.

Time Received Date and time when the selected event was received.

Title Brief description of the nature of the selected event.

Type String used to organize different types of events within 
an event category or subcategory (for example, users or 
applications, accounts, and security).

UI Element (A-Z) Description
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Additional Info Tab 

The Additional Info tab in the Event Details pane displays more detailed 
information about the attributes of the selected event.

The following table lists the elements that are included in the Additional 
Info tab.

To access Select Applications > Operations Management > Event 
Perspective and select the Additional Info tab.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

Save: Saves the changed values.

Undo changes: Discards the changed values.

Application Application that caused the event to occur.

Unlike the Related CI attribute in Operations 
Management, which is a direct relationship to a CI in the 
RTSM, the application attribute is a simple string-type 
attributes from HPOM.

Examples of Application attributes are Oracle, and OS.

Close Events with 
Key

String used to automatically acknowledge duplicate 
events.

Description Optional information about the original event in 
addition to the event’s original title and the text captured 
from the event source.

Key Key associated with the original HPOM event. It is an 
identifier used to identify the message policy. Used for 
duplicates and for Close Events with Key.
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Source Info Tab

The Source Info tab of the Event Details pane displays an overview of the 
information available about the source of the selected event.

Object Device such as a computer, printer, or modem.

Unlike the Related CI attribute in Operations 
Management, which is a direct relationship to a CI in the 
RTSM, the object attribute is a simple string-type 
attribute from HPOM.

Examples of Object attributes include orainst, C:, /dev/
spool.

Received during 
Downtime

Indicates whether an event was received from a CI during 
a time period when the CI was in downtime (scheduled 
to not be available).

Solution Text field used to document solutions to help operators 
solve the problem indicated by the event.

Suppress 
Deduplication

Indicates whether deduplication is inactive. Stops 
automatic discarding of new events that are duplicates of 
the selected event. Attributes can be set to suppress 
deduplication of events. For details, see "Duplicate Events 
Suppression Settings" on page 695.

To access Select Applications > Operations Management > Event 
Perspective and select the Source Info tab.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description
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The following table lists the elements that are included in the Source Info 
tab.

UI Element (A-Z) Description

Match Information Displays details of the policy that the event matched:

➤ Policy Name

➤ Policy Type

➤ Condition

Original Event Displays details of the original event:

➤ Original ID — Unique ID assigned to the original 
HPOM message by the message policy that generated 
the message.

➤ Original Data — Original event text as captured from 
HPOM agents before being formatted into an HPOM 
message.

Contains information about the original input before 
being normalized by HPOM agent policies into a 
message. Typically, the information available includes 
node name, message group, application, object, 
severity, and message text.

Originating Server Management server that forwarded the original HPOM 
event along the chain of servers configured in a flexible 
management environment:

➤ DNS Name of the forwarding management server

➤ IP Address of the forwarding management server

Sending Server Last server in the HPOM flexible management chain that 
forwarded the event to Operations Management:

➤ DNS Name of the last HPOM management server

➤ IP Address of the HPOM management server
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Actions Tab 

Events from HPOM received by Operations Management may contain 
event-related actions. The Actions tab in the Event Details pane displays 
these actions available for an event. There are two types of possible actions: 
user actions and automatic action.

Click the Start button to run an action. The Stop button stops a running 
action from completing.

The following table lists the elements that are included in the Actions tab.

To access Select Applications > Operations Management > Event 
Perspective and select the Actions tab.

Relevant tasks To run actions, see "How to Run an HPOM Action" on 
page 62 and "How to Launch a Custom Action" on 
page 63.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

Action Action specification summary.

Node Target system where the action can be run.

Start Starts the action on the CI associated with the selected 
event.

State Describes the status of the available action. The following 
states are used:

 — Available

 — Running

 — Succeeded

 — Failed

Stop Stops the current action.
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Annotations Tab 

The Annotations tab in the Event Details pane displays a list of the 
annotations attached to the selected event. Annotations are comments and 
observations relating to the event that help the event owner understand 
what the underlying problems are and how to fix them. Click the Add 
button to add an annotation to the selected event.

Note: Annotations exceeding 100 000 characters are truncated and it is not 
possible to save annotation longer than 100 000 characters.

The following table lists the elements that are included in the Annotations 
tab of the Event details pane.

To access Select Applications > Operations Management > Event 
Perspective and select the Annotations tab.

Relevant tasks To add annotations, see "How to Add Annotations to an 
Event" on page 60.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

Opens the Add Annotation dialog box. You can add 
annotation text in the Text field. 

Click OK to save the annotation.

Opens the Modify Annotation dialog box. You can edit 
the annotation text in the Text field. 

Click OK to save the annotation.

Opens the Delete Annotation dialog box.

Click Yes to delete the annotation.

Text Content text of the annotation.
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Custom Attributes Tab

The Custom Attribute tab in the Event Details pane displays a list of the 
attributes that either an administrator or the responsible user manually 
configured and added to the selected event. Click the Add button to 
configure a custom attribute and add it to the selected event.

Note: To add or modify custom attributes, you must be logged on as a user 
with permissions to add, update, and delete custom attributes.

Time Created Date and time when the selected annotation was added 
to the event.

User Name of the user who added the selected annotation to 
the event.

UI Element (A-Z) Description
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Note: Policies configured in HP Operations Manager can set trouble ticket 
and notification flags. If these flags are set, the following custom attributes 
in Operations Management are generated:

➤ ForwardToTroubleTicket (value= true)

➤ NotifyUser (value= true)

Using appropriately configured event filters, events including these custom 
attributes with value of true can be automatically forwarded to an external 
manager using Forwarding Rules or notifications sent using Notification 
Rules.

The following table lists the elements that are included in the Custom 
Attributes of the Event Details tab.

To access Select Applications > Operations Management > Event 
Perspective and select the Custom Attributes tab.

Relevant tasks To add custom attributes, see "How to Add Custom 
Attributes to an Event" on page 60.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

Opens the Add Custom Attribute dialog box. You can add 
a name and value for the custom attribute. 

Click OK to save the custom attribute.

Opens the Modify Custom Attribute dialog box. You can 
edit the custom attribute. 

Click OK to save the custom attribute.

Opens the Delete Custom Attribute dialog box.

Click Yes to delete the custom attribute.
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Name Name of the selected custom attribute defined for the 
selected event.

Value Value assigned to the selected custom attribute.

UI Element (A-Z) Description
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Related Events Tab

The Related Events tab in the Event Details pane displays an overview of all 
the events that are related to the event selected in the Event Browser. The 
way the events are displayed indicates if the event is considered as a 
symptom or a cause in the correlation process. The event displayed in bold 
type in the Related Events tab is the event that is selected in the Event 
Browser pane.

To access Select Applications > Operations Management > Event 
Perspective and select the Related Events tab.

Important 
information

A plus sign (+) icon in the event text column indicates 
the presence of correlated events, which the related 
events tab does not by default display. Use the plus sign 
(+) or minus sign (-) icons to display or hide correlated 
events.

Relevant tasks To to relate events manually, see "How to Relate Events 
Manually" on page 54. 

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26. 
For information about correlating events, see 
"Correlation Rules" on page 367.
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The following table lists the elements that are included in the Related Events 
tab of the Event Details pane. Unlabeled elements are shown in angle 
brackets (<>).

UI Element (A-Z) Description

Removes the relationship between events. 

Useful if you think that Operations Management 
correlated the selected event by mistake. The Unrelate 
action has no effect on the correlation rule that initially 
established the event relation. If you want to avoid 
relating the events in future, modify the associated 
correlation rule.

<Severity> Severity assigned to the related event. Usually, this is the 
same as the severity status of the original event received 
from HPOM.

Tip: For a short explanation of the icons used to indicate 
event severity, check the tooltip.

Assigned User Name of the user who is responsible for solving the 
related event’s underlying problem.

Correlation Rule Link to the correlation rule used to create the 
relationship.

Related CI Name of the impaired configuration item where the 
event occurred.

State Point in the event lifecycle that the related event has 
reached (for example, Open, In Progress, or Resolved).

Time Received Date and time when the original message associated with 
the related event was received from Operations 
Management.

Title Text of the message sent from Operations Management. 
Click the plus sign (+) or minus sign (-) icons to expand 
or collapse any correlated messages. Bold text indicates 
the message that is selected in the Event Browser.
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History Tab

Event history is a log of information about who or which component has 
changed values of an Operations Management event. This feature enables 
an operator to see how event attribute values changed during the life of an 
event, for example, the sequence of severity changes. Event history 
information is available in a separate tab in the Event Details pane and can 
be viewed by any user with access to that event.

The following table lists the elements that are included in the History tab of 
the Event Details pane.

To access Select Applications > Operations Management > Event 
Perspective and select the History tab.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

<Search field> Text field used to search for strings within event history. 
The  button clears the search string and displays all 
history information.

Actions Descriptions of the changes made to the event.

Modification Time Date and time when the associated change was made to 
the event.

Modified By User who made the associated change to the event.
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Resolver Hints Tab

The Resolver Hints tab displays the information used to identify the node 
and CI associated with an event.

To access Select Applications > Operations Management > Event 
Perspective and select the Resolver Hints tab.

Important 
information

A plus sign (+) icon in the event text column indicates 
the presence of correlated events, which the related 
events tab does not by default display. Use the plus sign 
(+) or minus sign (-) icons to display or hide correlated 
events.

Relevant tasks To configure CI Resolution, see:

➤ "How to Configure CI Resolution Cache Usage" on 
page 599

➤ "How to Limit the Number of CIs Used by CI 
Resolution" on page 602

➤ "How to Modify TQLs Used by CI Resolution" on 
page 603

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26. 
For information about CI Resolution, see "CI Resolution" 
on page 579.
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The following table lists the elements that are included in the Resolver Hints 
tab of the Event Details pane.

UI Element (A-Z) Description

ETI Resolution ETI Resolution Hint: Original string provided by the 
external manager, for example, in a custom message 
attribute from HPOM. Can be used to associate the event 
with an ETI.

You must set an attribute in the event which can be 
mapped to this indicator. To do this, set a custom 
message attribute called EventTypeIndicator in the HPOM 
policy. Specify a namespace for the CMA that matches 
the Name of the indicator, for example, CPULoad. 
Specify an instance that matches an indicator state, for 
example, High. When an event with an 
EventTypeIndicator CMA value of CPULoad:High is 
received, and ETI and values exist, the event attribute 
Event Type Indicator is set.

Node Information used to identify the host system in the 
RTSM associated with the selected event:

➤ Node Hint: Hostname used to find a node in the 
RTSM

➤ DNS Name: DNS name of the originating system

➤ IP Address: IP address of the originating system

➤ Core ID: ID of the originating system

Related CI Name of the impaired configuration item where the 
event occurred.

➤ Related CI Hint: Event information used to identify 
the CI related to the event

➤ HPOM Service ID: Service ID used to identify the 
service related to the event
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Related CI Resolution 
Info

Information associated with the selected event:

➤ Matched Hints Count: Number of identified hints 
that matched the selected CI in the RTSM database. 
This value is presented as a proportion of the number 
of available identifiers extracted from the event. The 
available identifies are displayed in the following 
sections of the Resolver Hints tab:

➤ Related CI Hint — includes colon-separated list of 
CI hints and must include the host identifier.

➤ HPOM Service ID — Service ID, in conjunction with 
object and application, used to identify the service 
related to the event.

➤ ETI Hint — Used to identify the ETI for each CI. If 
ETI Resolution is successful, the ETI is assumed to 
be assigned to the CI, and this CI is given a higher 
match rating.

➤ Status: Provides information about the matches used 
for related CI resolution.

Displays information about the match:

➤ Success — Confirms a successful match and 
displays the hint used.

➤ Unsuccessful CI resolution — Displays the hint that 
could not be resolved or indicates that no hint was 
available to assess. confirms that a match was not 
possible and indicates the action taken, for 
example, Fallback to host.

Source CI Information used to identify the CI in the RTSM that is 
the source of the event associated with the selected 
event:

Source CI Hint: Description of an Operations 
Management event attribute used to find the CI in the 
RTSM

UI Element (A-Z) Description
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Instructions Tab

The Instructions tab in the Event Details pane displays instruction 
information from HPOM designed to help operators handle the associated 
event.

Operators working with the HPOM message browser can see additional 
instructions for this message. It is equally helpful for Operations 
Management operators to be able to access this information when using 
HPOM servers to forward events to Operations Management. This 
information is displayed in the Instructions tab of the Event Browser.

HPOM instructions are not contained within the event but are dynamically 
retrieved either from the corresponding policy or an external instruction 
provider when you select the Instructions tab.

The following table lists the elements that are included in the Instructions 
Text tab of the Event Details pane.

To access Select Applications > Operations Management > Event 
Perspective and select the Instructions tab.

Important 
information

The originating server must be specified as a connected 
server. For details, see "Connecting Servers" on page 407.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element Description

Instructions Instruction text available from the original event from 
HPOM.
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External Info Tab

The External Info tab is available for events for which ownership was 
transferred to an external manager, for example, HP Service Manager. The 
information displayed in this tab is dynamically loaded from the external 
manager when the tab is opened. To load the latest information available 
from the external manager, click the  button in the External Info tab.

The following table lists the elements that are included in the External Info 
tab of the Event Details pane.

To access Select Applications > Operations Management > Event 
Perspective and select the External Info tab.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description

Refreshes the contents of the External Info tab.

Opens the event in the external application that is 
responsible for managing the event. 

Deletes the transfer of control request for a pending 
transfer of control request. If the transfer request is 
complete, a cancel is no longer possible and the Cancel 
Transfer of Control is disabled.

Assigned Group Group assigned to the event by the external manager.

Assigned User User assigned to the event by the external manager.

External ID ID assigned to the event by the external manager.

External Server Node on which the external manager is hosted.

Lifecycle State Lifecycle state assigned to the event by the external 
manager.

Priority Priority assigned to the event by the external manager.
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Browser Options Dialog Box

The Browser Options dialog box is used to configure the Event Browser to 
display only the details that you are interested in and to set other browser 
behavior. For example, you can add and remove columns, customize 
additional tabs, configure filters to change and improve the way in which 
data displays, and play a sound on receipt of an event.

All changes you make to the Event Browser layout are automatically saved 
to your user account. The next time you log on, the Event Browser displays 
the latest events in accordance with the way you configured the Event 
Browser. For example, the last selected view is selected and reopened.

Alternatively, to select the default columns for display in the Event Browser, 
select Reset.

Severity Severity assigned to the event by the external manager.

Transfer Status Status of the Transfer Control request. The possible states 
are:

➤ Cancel Requested — For a transfer control request that 
is still in the queue for processing, a request was made 
to cancel the transfer of control.

➤ Forwarded — Control of the selected event was 
transferred to the selected external server.

➤ Queued — Request to transfer control of the selected 
event is in the queue for processing.

To access Select Applications > Operations Management > Event 
Perspective and click the Browser Options  button.

Relevant tasks To configure the Event Browser, see "How to Configure 
the Event Browser" on page 51.

See also For more information about the Event Browser, see 
"Event Browser and the Event Perspective" on page 26.

UI Element (A-Z) Description
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The following table lists the elements that are included in the Browser 
Options dialog box.

UI Element (A-Z) Description

Columns

Adds columns to the Display these columns list.

Removes columns from the Display these columns list.

Used to move the selected column items down in the list 
of columns to be displayed. Items at the top of the list 
appear on the left side of the Event Browser.

Used to move the selected column items up in the list of 
columns to be displayed. Items at the bottom of the list 
appear on the right side of the Event Browser.

Available columns Information columns available but not selected for 
display in the Event Browser.

Display these 
columns

Information columns selected for display in the Event 
Browser.

Other

Play sound 
notification for new 
events

Enables sound notification for new events.

Overrides the global Sound Notification for New Events 
setting in the Operations Management Settings Manager.

Reset to defaults Selects the default columns for display in the Event 
Browser.
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Closed Events Browser Configuration Dialog Box

The Closed Events Browser Configuration dialog box contains the time 
periods that you can apply to view the history of closed events.

The Closed Events Browser Configuration dialog box displays the UI 
elements listed in the following table.

 

To access Select Applications > Operations Management > Event 
Perspective > Right-click the event for which you want to 
see the event history and select Show > Closed Events 
(Related CI) from the context menu.

Relevant tasks To view closed events, see "How to View the Closed Event 
History of a CI" on page 66.

UI Element (A-Z) Description

<Date Range> Sets the filter to display events within the selected 
predefined time period. The available choices are:

➤ Last hour

➤ Last 24 hours

➤ Last 3 days

➤ Last 7 days

➤ Last 14 days

Apply Applies the custom time range.

Cancel Closes the Closed Events Browser Configuration dialog 
box without opening the Closed Events Browser.

End Time Sets a specific date and time to which point closed events 
should be selected.

Number of events in 
the selected range

Indicates the number of closed events to be displayed for 
the specified time range.

If no closed events can be found, it is not possible to 
display the Closed Events browser. If too many events are 
available, reduce the time period in an attempt to focus 
in more closely on the problem area.
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OK Opens the Closed Events Browser using the time range 
specified in the Closed Events Browser Configuration 
dialog box.

Select a custom 
range

Enables the custom time range fields.

Start Time Sets a specific date and time from which point closed 
events should be selected.

UI Element (A-Z) Description
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Relate Events Dialog Box

The Relate Events dialog box displays the selected events to be related.

To access Select Applications > Operations Management > Event 
Perspective. In the Event Browser, select the events that 
you want to relate and right-click one of these events and 
select Relate Events from the context menu.

Relevant tasks If you want to create a correlation rule to relate similar 
future events, select Open correlation rule wizard and 
specify the cause event. For details, see "How to Create 
Correlation Rules from Manually-Related Events" on 
page 56.

See also For more information about correlating event, see 
"Correlation Rules" on page 367.
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The Relate Events dialog box displays the UI elements listed in the following 
table.

 

UI Element (A-Z) Description

C-Correlation Indicates if the event has any related events that are 
hidden as a result of a correlation rule. The following 
icons indicate the event’s position in a chain of events:

 — Event is a cause in a correlation rule

 — Event is a cause in one correlation rule and a 
symptom in another

 — Event is a symptom in a correlation rule

For details about correlated events, see "Related Events 
Tab" on page 96. 

Event Type Indicator 
(ETI)

Display name of the event type indicator (ETI) used to 
calculate the status reported by the selected event and the 
current value, (for example, Web application state: Slow).

WebAppState is the name of the event type indicator. The 
corresponding label is Web application state, which is 
shown in the General tab. The level of the current ETI 
value is Slow.

If event type indicators are assigned (see the Source Info 
tab) but are not being resolved (event type indicator field 
in General tab is empty), the configuration must be 
corrected.

Related CI Name of the impaired configuration item where the 
event occurred.
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Correlation Rule Generator Dialog Box

The Correlation Rule Generator dialog box contains the Select Events/Select 
Rules, Rule Properties and the Rule Details pages that you use to create a 
correlation rule or enhance an existing correlation rule. 

Severity Severity assigned to the selected event. Usually, this is the 
same as the severity status of the original event received 
from Operations Management. The following icons 
indicate event severity status:

 — Critical

 — Major

 — Minor

 — Warning

 — Normal

 — Unknown

Time Received Date and time when the event was received.

Title Brief summary of the event.

To access Select Applications > Operations Management > Event 
Perspective. In the Event Browser, select the events that 
you want to relate and right-click one of these events and 
select Relate Events from the context menu. Select one of 
the events as the cause event and then select Open 
correlation rule wizard.

Relevant tasks If you want to create a correlation rule to relate similar 
future events, select Open correlation rule wizard and 
specify the cause event. For details, see "How to Create 
Correlation Rules from Manually-Related Events" on 
page 56.

See also For more information about correlating event, see 
"Correlation Rules" on page 367.

UI Element (A-Z) Description
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Selected Events / Select Rules Page
The Correlation Rule Generator dialog box displays the UI elements listed in 
the following table.

 

UI Element (A-Z) Description

Use as Cause: Selects the event to be used as the cause 
event.

Open Event Details: Opens the event details for the 
selected event in a pop-up window.

Select All Events: Selects all events in the Select Events 
pane.

Unselect All Event: Clears all events in the Select Events 
pane.

Create Enables the creation of a new correlation rule based on 
the selected events.

CI Type Configuration item type associated with the event.

Description Brief description of the correlation rule.

Enhance If valid, enables the selection of an existing correlation 
rule to be modified.

Event Title Title of the selected event.

Include Enables you to select or clear events from the available 
list.

Indicator Indicator associated with the event.

Indicator State State of the indicator associated with the event.

Name Internal name of the selected correlation rule. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten. 

Note: May be disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).
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Rule Properties Page
The Rule Properties page displays the UI elements listed in the following 
table.

 

Selected Events for 
Creating or 
Enhancing 

Events that you selected to be the symptoms of the cause 
event on which the correlation rule is based.

Use as Cause Event that you selected to be the cause event on which 
the correlation rule is to be based.

UI Element (A-Z) Description

Active Used to enable or disable the rule during runtime. By 
default it is disabled.

Description Brief description of the correlation rule.

Display Name Display name of the selected correlation rule used in the 
graphical user interface.

Name Internal name of the selected correlation rule. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten.

Note: May be disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).

Time Window Specifies a specific time period for the selected correlation 
rule. By default it is not enabled and the global value is 
used. 0 seconds also mean it is not enabled and the global 
setting is used.

The range is from 0 to 9999 seconds.

UI Element (A-Z) Description
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Rule Details Page
The Rule Details page displays the UI elements listed in the following table.

 

UI Element (A-Z) Description

Binds one or more symptoms to the cause by taking the 
shortest path. All other bindings are removed.

Displays details of the selected CI type, including 
indicators and values.

Rule Topology Pane

<Dark Blue 
background>

Symptom CI type.

<Light Blue 
background>

Not cause or symptom CI type, but CI type is part of rule 
topology.

<Orange 
background>

Cause CI type.

<Pink frame> Selected CI type.

<No background 
color>

CI type is not part of the rule.

Indicates that the configuration item type has an 
indicator state that is configured as a symptom in the 
selected correlation rule.

Indicates that the configuration item type has an 
indicator state that is configured as a cause in the selected 
correlation rule.

Adds the highlighted link (constraint) to the correlation 
rule. Adding a link enables the path between the linked 
objects in the context of the correlation rule, which is a 
requirement for topology-based event correlation. It does 
not change the RTSM view model in any way.
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Removes the highlighted link (constraint) from the 
correlation rule you are editing. The link between the two 
objects is no longer recognized in the context of the 
correlation rule, and any rule that relies on this link no 
longer works. Removing a link from a correlation rule 
does not change the RTSM view model in any way.

Layout Selects alternative ways of viewing the Rule Topology 
diagram. There are three options to chose from: 
Hierarchical, Circular, and Concentric Radial.

Levels Selects the depth of topology levels displayed in the Rule 
Topology diagram.

Zoom Controls the size of the displayed Rule Topology diagram.

Symptoms and Causes Pane

Delete Item: Deletes the selected indicator from the list of 
indicators included in the correlation rule as either a 
symptom or a cause.

CI Type Name of the configuration item type to which the listed 
indicator is assigned.

Indicator Name of the indicator referenced in the selected 
correlation rule.

Indicator State Name of the indicator state referenced in the selected 
correlation rule.

Type Indicates if the indicator is defined as a symptom or a 
cause in the selected correlation rule.

Indicators Pane

Refreshes the contents of the Indicators list. Use if new 
indicators becomes available while you are working.

Group Indicator by Type: Toggles between a list 
containing all indicators and a list divided into health 
indicators and event type indicators.

UI Element (A-Z) Description



Chapter 2 • Event Management

115

Export Event List Dialog Box

The Export Events List dialog box is used to configure the event attributes 
that you want to export to an external file. For example, you can add and 
remove columns, and specify the format of the export file.

Alternatively, to select the default columns for display in the Event Browser, 
select Reset.

The following table lists the elements that are included in the Export Events 
List dialog box.

Add as a Cause: Sets the selected indicator state as a cause 
for the configuration item type selected in the Rule 
Topology pane.

Add as a Symptom: Adds the selected indicator state as a 
symptom for the configuration item type selected in the 
Rule Topology pane.

To access Select Applications > Operations Management > Event 
Perspective. In the Event Browser, select the Export 
Events List  icon.

Relevant tasks For more information about exporting event data, see 
"How to Export the Contents of the Event Browser" on 
page 53.

UI Element (A-Z) Description

Adds columns to the Export these columns list.

Adds all columns to the Export these columns list.

Removes columns from the Export these columns list.

UI Element (A-Z) Description
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Removes all columns from the Display these columns list.

Used to move the selected column items down in the list 
of columns to be exported. Items at the top of the list 
appear on the left side of the exported list.

Used to move the selected column items up in the list of 
columns to be exported. Items at the bottom of the list 
appear on the right side of the exported list.

Available columns Information columns available but not selected for 
export.

Export these columns Information columns selected for export.

File format List for selecting the format of the export file. The 
supported formats are:

➤ Comma-separated values (.csv)

➤ Microsoft Excel 2007 Workbook (.xlsx)

➤ Microsoft Excel 97-2003 Workbook (.xls)

Reset to defaults Selects the default columns for export.

UI Element (A-Z) Description
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opr-archive-events Command-Line Interface 

This section describes the options and parameters available in the 
opr-archive-events command-line interface. Closed events are not 
automatically removed from the database. Use the opr-archive-events tool 
to delete closed events from the database and add them to an archive file.

Note: HPOM events are not updated when using the opr-close-events tool 
and the opr-archive-events tool to close, delete, and archive events. The 
events in HPOM remain unaffected.

The opposite is also true when using the omwmsgutil (HPOM for Windows) 
tool and opcack and opchistdown (HPOM for UNIX) tools to close, delete, 
and archive events. The events in Operations Management remain 
unaffected.

All these tool operates directly on their respective databases and the changes 
do not go through the workflow process, resulting in the loss of 
synchronization between Operations Management and HPOM.

If you use these tools to close, delete, and archive events from one system 
(for example, Operations Management), you must make the equivalent 
changes with the appropriate tools on the other system (for example, 
HPOM).

The opr-archive-events command-line interface is located in:

<HPBSM_Root_Directory>/bin 

Default:

Windows: C:\HPBSM\bin

Linux: /opt/HP/BSM/bin

The opr-archive-events command accepts the following options:
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opr-archive-events
-o <output path and file name> -u <date> [-a][-force]
-u <date> -d [-force]
-h

Note: You can combine the options that are given between square brackets. 
Otherwise, use the rest of the options separately.

For more information about the options recognized by the 
opr-archive-events command, see the following list:

-a,--archiveOnly <archive file>

Only archives events without deleting them from the database.

-d,--deleteOnly

Deletes only the events from the database without archiving.

-force

Archive events without asking user for confirmation.

-h,--help

Displays a summary of the command options and exits.

-o,--output <archive_file>

Path and name of XML file used to store archived events.

-u,--until <date>

Archives the events that where received before the specified time. The time 
must be specified in one of the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh
yyyy.mm.dd
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opr-close-events Command-Line Interface 

This section describes the options and parameters available in the 
opr-close-events command-line interface.

Note: HPOM events are not updated when using the opr-close-events tool 
and the opr-archive-events tool to close, delete, and archive events. The 
events in HPOM remain unaffected.

The opposite is also true when using the omwmsgutil (HPOM for Windows) 
tool and opcack and opchistdown (HPOM for UNIX) tools to close, delete, 
and archive events. The events in Operations Management remain 
unaffected. 

All these tool operates directly on their respective databases and the changes 
do not go through the workflow process, resulting in the loss of 
synchronization between Operations Management and HPOM.

If you use these tools to close, delete, and archive events from one system 
(for example, Operations Management), you must make the equivalent 
changes with the appropriate tools on the other system (for example, 
HPOM).

The opr-close-events command-line interface is located in:

<HPBSM_Root_Directory>/bin 

Default:

Windows: C:\HPBSM\bin

Linux: /opt/HP/BSM/bin

The opr-close-events command accepts the following options:

opr-close-events
[-u <date>] [-f <date>] [-s <severity>][-force] [-r]
-all [-force] [-r]
-h
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Note: You can combine the options that are given between square brackets. 
Otherwise, use the rest of the options separately.

For more information about the options recognized by the 
opr-archive-events command, see the following list:

-all

Closes all events.

-f,--from <date>

Closes events (including related events) received after the specified time. 
This option can be combined with severity and until time. The time must be 
specified in one of the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh
yyyy.mm.dd

-force

Closes events without asking user for confirmation.

-h,--help

Displays a summary of the command options and exits.

-r,--resetHIs

Resets health indicators after closing of events.

-s,--severity <severity>

Closes events of the specified severity. This option can be combined with 
from time and until time. The severity can be one of the following: 
NORMAL, WARNING, MINOR, MAJOR, CRITICAL.
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-u,--until <date>

Closes events received before the specified time. This option can be 
combined with severity and from time. The time must be specified in one of 
the following formats:

yyyy.mm.dd-hh:mm:ss
yyyy.mm.dd-hh:mm
yyyy.mm.dd-hh
yyyy.mm.dd

Troubleshooting and Limitations 

This section provides help in troubleshooting problems relating to event 
management.

➤ HPOM for Windows User Names are Truncated When Messages are 
Forwarded on page 121

➤ Correlations are Skipped in High Load Situations on page 121

➤ Data Collection Tool opr-checker.bat on page 122

HPOM for Windows User Names are Truncated When 
Messages are Forwarded 
By default HPOM for Windows has the OM for UNIX compatibility mode 
enabled (true) in the Server-based Flexible Management configuration. This 
leads to the truncating of the user names.

Change the OM for UNIX compatibility mode setting to false in the 
Server-based Flexible Management namespace in the Generic Server 
Configuration tab.

Correlations are Skipped in High Load Situations
If a high number of events with ETIs is forwarded to Operations 
Management over a long period of time (30 minutes or longer), the 
correlation engine only considers up to the specified number of most recent 
events. If this limit is exceeded, the oldest events are removed from the 
queue and no longer considered for correlation.
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This limit is set using the Max Waiting Queue Size attribute and is located 
in: 

Infrastructure Settings Manager > Operations Management > 
Topology-Based Event Correlation Settings 

The default value is 5000. The valid range is 100 to 20000.

If you are experiencing this problem, lower the incoming event rate or 
increase the Max Waiting Queue size limit. If the limit is increased, you 
should also monitor the memory consumption and, if necessary, increase 
the memory setting (parameter -Xmx) for the opr-backend process.

Data Collection Tool opr-checker.bat 
If you are having problems with your Operations Management installation 
and need to contact HP Software Support, use the opr-checker.bat tool to 
generate a summary of your installation.

 1 Run the opr-checker.bat tool from the following location and specify a 
target location for the output file:

<HPBSM_Root_Directory>/opr/support/opr-checker.bat -a -xml > 
<TempDir>/opr-checker.xml

 2  Send the resulting XML file to HP Software Support for analysis.
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3
Health Perspective

This chapter includes:

Concepts

➤ Health Status on page 124

➤ Health Top Views on page 125

➤ Event Type Indicators on page 127

➤ Health Indicators on page 128

➤ HI-Based KPI Calculations on page 129

Tasks

➤ How to View Event Type Indicators on page 132

➤ How to Reset Health Indicators on page 132

➤ How to View HI-based Key Performance Indicator Details on page 133

➤ How to View HI Details on page 133

➤ How to View KPI Business Rule Settings on page 134

Reference

➤ Health Perspective User Interface on page 135

Troubleshooting and Limitations on page 140



Chapter 3 • Health Perspective

124

Concepts

Health Status 

The Health Perspective tab is used to display the health of related CIs in the 
context of events. The event selected in the Event browser determines what 
is displayed in the Health Top View and the selected CI in the Health Top 
View determines what is displayed in the Health Indicators pane.

In the Health Perspective tab, the following panes help you understand the   
health status of an object, show you which business rules and KPIs are being 
used, and how the health status of the selected object affects the health of 
related objects:

➤ Model Explorer

Displays a list of all the objects in your monitored environment. For more 
information, see "Model Explorer" on page 26.

➤ Event Browser

Displays a list of the active events in your environment. For more 
information, see "Event Browser" on page 27. 

➤ Health Top View

Displays a hierarchical overview of the relationships between the different 
objects that make up the monitored environment and indicates the 
current health of the displayed objects. For more information, see "Health 
Top Views" on page 125. 

➤ Health Indicators

Displays a list of the KPIs and health indicators for the selected CI, used to 
calculate health-related information such as availability and performance 
of the selected configuration item. For more information, see "Health 
Indicators" on page 128.
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➤ Actions Pane

Display, and execute the tools, HPOM actions and Run Books that can be 
executed on the selected events in the Event Browser. For details, see 
"Tools" on page 47, "Operations Manager Actions" on page 49, and 
"Launching Operations Orchestration Run Books" on page 50.

Health indicators (HI) and key performance indicators (KPI) are used to 
determine the health of an object. Operations Management calculates how 
severe the problems directly associated with the selected object are and 
combines this information with any additional information available about 
dependent objects. The combined data is passed to calculation rules that 
evaluate and set the KPIs that indicate the overall health of an object.

The color of an object displayed in the Health Top View is used to indicate 
its health, and the most critical status of any contributing objects. For 
example, green can be set to represent normal and red to represent critical. 
The color used depends on the view settings. Whatever you specify in the 
view settings contributes to the color of the CI.

Note: The Health Perspective panes display data related to the configuration 
item associated with the selected event. The Health Top View is designed to 
help investigate problems that require root cause analysis.

For more information about HIs and KPIs, see "Health Indicators" on 
page 128 and "HI-Based KPI Calculations" on page 129.

Health Top Views 

The Health Top View in the Health Perspective tab shows the related CI 
from the event in the CI neighborhood of the configured view. The view 
shows the relationships between the configuration items that represent the 
monitored objects and indicates their current health status. The Health Top 
View is designed to help investigate problems that require root cause 
analysis.
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It shows the related CI from the event in the CI neighborhood of the 
configured view. So there could be sibling CIs, children, an so on.

Note: You can refine the contents of the Health Top View pane by applying 
an alternative view. If no event is selected in the Event Browser pane, the 
Health Top View pane remains empty.

You can use the View Mappings manager to map views to individual 
configuration item types. A list of mapped views appears in the Selected 
Views list in the Health Top View pane. The contents of the Selected Views 
list are determined by the configuration item type associated with the event 
selected in the Event Browser. For more information about view mapping, 
see "View Mapping" on page 257. 

The Health Indicators pane shows you the HIs used to calculate and set the 
current severity status of the highlighted configuration item in the Health 
Top View.

For more information about HIs and KPIs, see "Health Indicators" on 
page 128 and "HI-Based KPI Calculations" on page 129.

Health Top View Displays Guidance Messages
The following guidance information is available in the Health Top View 
pane:

➤ If no event is selected, a message is displayed prompting you to select an 
event.

➤ If an event without any related CI is selected, a message is displayed 
informing you that there is no CI information.

➤ If an event with a related CI but without an associated view mapping is 
selected, a message is displayed informing you that there is no view 
mapping. A link the View Mappings manager where you can configure a 
suitable view mapping is also provided.
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➤ If an event with a related CI and with a view mapping is selected, the list 
of mapped views is shown in the drop-down box and the selected view is 
shown.

Event Type Indicators

Event type indicators (ETIs) are attributes of Operations Management events 
used to categorize events according to the type of occurrence in the 
managed IT environment. An Operations Management event is created as a 
result of receiving a message from a manager, such as HPOM or Network 
Node Manager. In HPOM, you can configure events to include the custom 
attribute EventTypeIndicator, which is used to set event type attributes. If the 
custom attribute is not configured, event type attributes can be set by the 
applicable mapping rules. If adequate information is not available, no ETI is 
set.

Any occurrence on the monitored system of a given type causing an 
Operations Management event must be assigned the same ETI. After 
defining appropriate correlation rules, events are correlated based on the 
ETIs. The correlation rules relate types of events that can occur on the CI.

ETIs are characterized by the following:

➤ Categorize type of event to abstract multiple event sources.

➤ At least one value is required. This value is used to describe the event 
occurrence in the environment, for example, an ETI could read: 
System restart:Occurred. Usually, you do not need to set any values for 
such ETIs because, as a convenience, one value is created that is called 
Occurred.

➤ Events contain an ETI attribute. ETIs do not exist as instances in their 
own right.

➤ ETIs without a corresponding HI are not shown within the Health 
Indicators pane.

➤ No manual reset necessary. An ETI is just an event attribute.
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A configuration item inherits ETI assignments, including HIs, from its 
parent configuration item type. For example, ETIs assigned to the 
configuration item type Database also apply to the configuration item type 
Oracle and are applied to any Oracle Database configuration items.

Health Indicators 

Health indicators (HI) determine and display the health of specified aspects 
of a monitored CI. An HI is an event-specific monitor that uses one value to 
represent the normal state of the CI, for example, System:Running. One or 
more additional values are used to represent any abnormal states, such as 
System:Stopped. In this way, health indicators are used to show if a 
hardware resource is available and responding.

Health indicators can also display the state of a software application. For 
example, the possible states of a database server could be specified as: 
Available, Starting or Stopping. Health indicators can also be used to show the 
usage of a software application, for example, whether the load is Normal, 
High, or Max. Exceeded. 

Only events that provide CI state information can set an HI. Health 
indicators are assigned to a specific configuration item type through the 
associated ETI.

Note: Operations Management sets indicators automatically using event 
attributes or mapping rules.

Mapping rules can be used to match attributes of incoming events to 
defined health indicator values, such as Low or High, for a given 
configuration type. For example, you can define an HI to monitor events 
related to the CPU load on Unix systems (CI type: Infrastructure Element > 
Node > Computer > Unix). When an event reporting Low or High CPU load 
is received, the appropriate health indicator value is set.
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HIs provide the data that a KPI needs to calculate the availability and 
performance of monitored resources. The KPIs use calculation rules to 
collate the values from multiple health indicators and set a severity level, 
such as: Critical, Major, Minor, or Normal. For example, a KPI for a database 
can include multiple health indicators concerning the run state (Up, Down), 
the cache-hit ratio (0, 50, 00%), the length of query queues (Empty, Full), and 
response times (#ms) to determine overall health.

For more information about KPIs, see "HI-Based KPI Calculations" on 
page 129.

HI-Based KPI Calculations   

Key performance indicators (KPI) apply calculation rules to the data 
provided by health indicators to determine the availability and performance 
of the objects to which the health indicators are assigned. The value that 
results from the calculation is used to set a severity level, for example, 
normal, warning, minor, major, or critical.

KPIs related to the selected event are displayed in the Health Indicators pane 
of the Health Perspective tab. Their color reflects the assigned severity. In 
the Health Top View, KPIs appear under the monitored object to which they 
belong.

The color of each KPI reflects the KPI’s current severity status. The severity 
status is determined by a business rule, which specifies how and when 
severity status propagates up a relationship chain. One resource with a 
critical problem does not mean that all dependent resources are, by 
definition, also critical. KPIs can use data from multiple sources to 
determine the overall affects up and down dependency chains and 
determine the severity status accordingly.
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Note: The type of source determines the importance of the information 
provided. For example, live data from a monitor running directly on a node 
is considered more important than data resulting from business rules, which 
base calculations on KPI relationships and dependencies. This means that 
KPI states propagated by a business rule may be overridden by live data 
directly from the CI.

KPIs exist for Operations Management in two high-level areas covering 
health-based and event-based data. The following KPIs use health-based 
data:

➤ System and Application Performance KPI

Performance-related data from health indicators can include values for 
the hit ratio in the database cache, server connection speeds, queue 
lengths, or database query processing times. This example describes 
health indicators that are specific to the database configuration item type. 
Other configuration item types have different health indicators. 

➤ System and Application Availability KPI

Availability-related data can include server run states (up, down, starting, 
stopping) or process activity (refusing, accepting connections, not 
responding).

There are two additional KPI types that use event data for Unassigned or 
Unresolved events and are attached by default to every configuration item. 
Unassigned KPIs concern events with an underlying problem that has not 
yet been allocated to any user for investigation. Unresolved KPIs concern 
events with underlying problems that are not yet fixed.

Note: Unassigned, event-based KPIs are, by definition, also unresolved.



Chapter 3 • Health Perspective

131

If an unassigned or unresolved KPI references data from more than one 
event, the color of the KPI reflects the severity status set by a business rule. 
The business rule associated by default with unassigned and unresolved KPIs 
is the Operations Event Lifecycle Group Rule, which sets the status of the 
KPI to the highest severity of any events associated with the related 
configuration item. For example, if a KPI for an unassigned event refers to 
one critical and four normal events, the KPI appears red to reflect the critical 
event.

Note: There is no propagation from child CIs.
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Tasks

How to View Event Type Indicators 

In this task, you learn how to list and view event type indicators (ETI).

To view HIs:

 1 Open the Indicators manager:

Admin > Operations Management > Design Operations Content > 
Indicators

or 

Select an event in the Event Browser, open the context menu and select:

Configure > Event Type Indicators

 2 In the CI Types pane, select a CI type.

 3 In the Indicators pane, select an indicator.

Details of the selected indicator are displayed in the Details pane.

How to Reset Health Indicators   

In this task, you learn how to reset an HI. Resetting an HI is a way of 
returning an object’s severity status to a defined default value such as 
Normal.

Note: Resetting an HI is not usually necessary and should be performed in 
exceptional circumstances only, for example, when Operations 
Management does not reset it automatically.

To reset an HI:

 1 Open the Event Browser from Operations Management:
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Applications > Operations Management > <select a perspective> 

 2 In the Event Browser pane, right-click the event you want to close and for 
which you want to reset the health indicator.

 3 In the context menu that displays, select Close and Reset Health 
Indicator.

How to View HI-based Key Performance Indicator Details   

In this task, you learn how to list and view the details of a KPI. KPIs use the 
data provided by one or more health indicators to set a severity level 
(normal, warning, or critical) for the monitored object.

To view details of KPIs:

 1 Open the Health Perspective tab from Operations Management:

Applications > Operations Management > Health Perspective 

 2 In the Event Browser pane, select the event for which you want to view 
KPI details.

 3 In the Health Indicators pane, point to the status icon of the KPI for 
which you want to display details. Details of the KPI, such as Status, 
Business Rule name, Held Status Since date, are displayed in a pop up 
dialog box.

How to View HI Details    

In this task, you learn how to list and view health indicator details.

To view the health indicator details:

 1 Open the Health Perspective tab from Operations Management:

Applications > Operations Management > Health Perspective 

 2 In the Event Browser pane, select the event for which you want to view 
Health Indicator State details.

 3 In the Health Indicators pane, point to the state icon, for example , for 
the health indicator for which you want to display details.
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Details of the selected KPI are displayed in a pop-up window. The 
background color reflects the status of the KPI.

The details include:

➤ Status of the KPI

➤ Business Rule applied to the KPI

➤ Severity of the health indicator

➤ Message 

➤ Value

How to View KPI Business Rule Settings    

In this task, you learn how to find out which business rule Operations 
Management applies to set the severity of a KPI. KPIs use the data provided 
by one or more health indicators to set a specific severity level for a 
monitored object. A KPI business rule specifies how the status of dependent 
KPIs is combined and the result used in the calculation of a parent KPI’s 
severity.

To view the applied KPI business rule:

 1 Open the Health Perspective tab from Operations Management:

Applications > Operations Management > Health Perspective 

 2 In the Event Browser pane, select an event.

The CI related to the event and its direct neighborhood CIs are displayed 
in the Health Top View.

 3 In the Health Top View pane, point to the object for which you want to 
view the KPI business rule.

In the pop-up window that opens, check the value of the entry Business 
Rule to see which business rule was used to set the severity status, for 
example, Worst Child Rule.
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Reference

Health Perspective User Interface 

This section describes the health related information displayed in the 
Health Perspective tab. The information in this sections aims to help you 
understand how you can use health perspectives to better understand the 
overall health of your IT environment. In this section, you can find 
information about the following topics:

➤ "Health Top View" on page 135

➤ "Health Indicators Pane" on page 138

For information about the other panes, see "Model Explorer" on page 69 and 
"Event Browser Overview" on page 69.

Health Top View 

The Health Top View pane in the Health Perspective tab displays a 
topological view of the configuration items affected by the event selected in 
the Event Browser pane. The view shows the relationships between the 
configuration items that represent the monitored objects and indicates their 
current health status. You can also use the Health Top View to see what 
affects the health of individual objects has on the health of other objects.

To access Select Applications > Operations Management > Health 
Perspective

Relevant tasks For more information about configuring the Health 
Browser, see "How to View Event Type Indicators" on 
page 132 and "How to View Event Type Indicators" on 
page 132.

See also For more information about the Health Browser, see 
"Health Status" on page 124 and "Health Top Views" on 
page 125.
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The information displayed in the Health Top View includes the following 
details:

When you hover the cursor over any configuration item displayed in the 
Health Top View pane except the root configuration item in the tree or any 
item that is colored grey, Operations Management displays details of the 
factors that contribute to the status of a configuration item, as described in 
the following table.

UI Element (A-Z) Description

<Selected View> List of the views mapped to the configuration item type 
(and any parents) referenced by the event selected in the 
Event Browser, which contain the CI, and, if configured, 
filtered by event category.

Select the view you want to apply to the contents of the 
Health Top View pane. A view enables you to refine the 
type and amount of configuration items displayed. The 
selected view can also affect the severity status of 
configuration items, since views can exclude or include 
additional (related) items which have an affect on the 
displayed topology.

You can map views to configuration item types. For more 
information about mapping views, see "View Mapping" 
on page 257.

Last Updated Date when the Health Top View information was last 
refreshed.
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Note: If you set up other monitors, for example, from BPM or Sitescope, you 
also see other KPIs listed.

For descriptions of the context menu items available in the Health Top View 
pane, see "Event Browser Icons, Buttons, and Context Menus" on page 71.

UI Element (A-Z) Description

Business Rule Business rule used to determine the availability and 
performance of the selected configuration item.

Class Type The CI type of the selected CI.

CI Name Name of the selected configuration item, for example, 
DB_Server.example.com.

Held status since Date and time since when the current status was applied 
to the selected configuration item.

Hidden Child CIs Indicates that the selected CI has child CIs that are not 
displayed in the Health Top View.

KPI Name Display name of the key performance indicator to which 
the displayed health indicator is assigned, for example, 
System Availability KPI.

Status Severity assigned to the selected CI.

Unassigned Events KPI associated with events that are either not assigned to 
any user or remain unresolved. The information includes, 
in addition to the details shown for performance and 
availability KPIs, the number of duplicate or related (and 
unassigned) events associated with the selected object. 
The background color indicates the highest severity of 
the KPIs associated with the selected object.

Unresolved Events 
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Health Indicators Pane

The Health Indicators pane lists the KPIs and health indicators for the 
configuration item associated with the event you select in the Event 
Browser. For details, see the Service Health online help.

The Health Indicators pane displays the UI elements listed in the following 
table. In the table, unlabeled UI elements are shown in angle brackets (<>).

To access Select Applications > Operations Management > Health 
Perspective

Relevant tasks For more information about configuring the Health 
Indicators, see "How to Reset Health Indicators" on 
page 132.

See also For more information about the Health Browser, see 
"Health Status" on page 124 and "Health Top Views" on 
page 125.

UI Element (A-Z) Description

<Selected View> List of the views mapped to the configuration item type 
(and any parents) referenced by the event selected in the 
Event Browser, which contain the CI, and, if configured, 
filtered by event category.

Select the view you want to apply to the contents of the 
Health Top View pane. A view enables you to refine the 
type and amount of configuration items displayed. The 
selected view can also affect the severity status of 
configuration items, since views can exclude or include 
additional (related) items which have an affect on the 
displayed topology.

You can map views to configuration item types. For more 
information about mapping views, see "View Mapping" 
on page 257.

<CI Name> Name of the selected configuration item, for example, 
DB_Server.example.com.
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<CI Type> Name of the configuration item type to which the 
configuration item displayed in the Selected CI field 
belongs.

Health Indicator Display name of the health indicator used to set the 
severity of the selected event.

Health Indicators 
Contributing to KPIs

Lists any health indicators that are associated with the 
selected CI and are assigned to a KPI.

Health Indicators Not 
Contributing to KPIs

Lists any health indicators that are associated with the 
selected CI but are not assigned to any KPI.

KPI Display name of the key performance indicator to which 
the displayed health indicator is assigned, for example, 
Operations Availability KPI.

Last Status Change Time stamp indicating the last time the current status 
was updated.

Last Updated Date when the Health Top View information was last 
refreshed.

Selected CI Name of the configuration item to which the displayed 
health indicator is assigned.

State Current value set for the health indicator specified in the 
Name field, for example, Success or Failed. The value is 
also associated with a severity. 

An icon reflecting the severity assigned to the selected 
health indicator value is displayed, for example:

 — Critical

 — Warning

 — Normal

Trend Arrows pointing up, down, or up and down to indicate 
the overall trend of the selected KPI since the last update:

 — Positive 

 — Negative

Value Value of the health indicator used to set the severity of 
the selected event.

UI Element (A-Z) Description
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Troubleshooting and Limitations   

This section provides help in troubleshooting problems relating to health 
indicators, including listing, viewing, and enabling.

➤ "Event Browser is Empty" on page 140

➤ "Health Top View is Empty" on page 140

➤ "Health Indicators Display Incorrectly" on page 140

Event Browser is Empty

➤ No events are available

➤ Incorrect filter is applied

➤ No connection is available to the Operations Management application

Health Top View is Empty

➤ No event is selected in the Event Browser

➤ No view is mapped to the related CI of the selected event

➤ No CI is related to the selected event

➤ Java applet did not start or is not running correctly

Health Indicators Display Incorrectly
Health indicators are used to assign a severity to a state, for example, Critical 
severity to the state Unavailable. The state and the assignment are indicated 
in the Health Indicators pane. However, calculation rules for a KPI may use 
several health indicators to set a new severity level for the object in the 
Health Top View.

➤ No event is selected in the Event Browser

➤ The configuration item highlighted in the Health Top View pane does not 
have any assigned health indicators

➤ You selected an event in the Event Browser pane and a different 
configuration item in the Health Top View pane
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4
Performance Graphs

This chapter includes:

Concepts

➤ Graphing Overview on page 142

➤ Types of Graphs on page 144

➤ Overview of Graph Templates on page 146

➤ Data Sources on page 147

➤ Metrics on page 148

Tasks

➤ How to Manage Graphs - Workflow on page 149

➤ How to Draw Graphs in MyBSM Workspace on page 150

➤ How to Draw Graphs from Operations Management on page 150

➤ How to Draw Graphs from the Performance Perspective on page 152

➤ How to Design Graphs on page 154

➤ How to Edit Graphs on page 154

➤ How to Delete Graphs on page 156

Reference

➤ Performance Graphs User Interface on page 156

Troubleshooting and Limitations on page 192
Concepts
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Graphing Overview 

Graphing enables you to draw graphs and design custom graphs for 
configuration item types that you are monitoring. You can also compare 
multiple instances of a resource or an application on one or more 
configuration items (CIs). 

The preformatted graphs and reports help you:

➤ Evaluate application and system performance

➤ Analyze usage trends

➤ Correlate usage

➤ Compare application and system performance

The following sections enable you to understand the different graphing 
functions:

Drawing Graphs 
Graphing enables you to draw graphs from pre-defined templates or create 
your own graphs for a selected CI. You can launch a performance graph 
from one of the following areas:

➤  MyBSM Page

You can add performance graphs to MyBSM workspace. To view graphs, 
drag and drop a graphing component while creating your MyBSM 
workspace. You can choose to draw predefined graphs using the 
Performance Graphs component. You can also create ad hoc graphs for a 
selected CI using the Performance Graphs with Details component. For 
details, see "How to Draw Graphs in MyBSM Workspace" on page 150.

➤ Performance Perspective Page

Performance Perspective enables you to draw graphs from templates and 
also helps you draw ad hoc graphs by selecting required metrics for a 
selected CI. For details, see "How to Draw Graphs from the Performance 
Perspective" on page 152.
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➤ Event Browser Pane

You can draw graphs from the Event Browser pane using Show option 
from the context menu. You can launch graphs that are available for a 
selected node, event, or the selected CI. For details, see "How to Draw 
Graphs from Operations Management" on page 150.

➤ Model Explorer

You can draw graphs for a selected CI from the Model Explorer pane using 
the available context menu. For details, see "How to Draw Graphs from 
Operations Management" on page 150.

Designing Graphs 
Graphing enables you to design customized graphs using the design wizard. 
The Design wizard takes you through a series of steps and helps you create 
different types of graphs. You can design a graph from the following areas:

➤ Performance Perspective Page

Performance Perspective enables you to design a graph by selecting 
Configure from the Options menu of a drawn graph window. The Design 
Wizard window opens. For details, see "How to Edit Graphs" on page 154.

➤ Event Browser Pane

You can draw graphs from the Event Browser pane using Configure 
option from the context menu. The Design Wizard window opens. For 
details, see "How to Design Graphs" on page 154.

➤ Model Explorer

You can design a graph for a selected CI from the Model Explore pane 
using the Configure option from the context menu. The Design Wizard 
window opens. For details, see "How to Design Graphs" on page 154.

➤ Operations Management Administration

You can design a new graph template for a selected CI instance using the 
Performance Graph Designer. For more information on designing a new 
graph template, see "How to Launch the Performance Graph Designer" on 
page 306.
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Note: For more information, see "Performance Graphs Pane" on page 311.

Managing Graphs 
Graphing enables you to perform the following management-related 
functions.

➤ Editing Graphs

You can also edit out-of-box graph templates and save them as 
user-defined templates. For details, see "How to Edit Graphs" on page 154.

➤ Assigning Graphs

You can assign a graph family to a CI type. For details, see "How to Map CI 
Types to Graph Families" on page 305.

➤ Deleting Graphs

You can also delete any graph that you have created. For details, see "How 
to Delete Graphs" on page 156.

Types of Graphs

While designing or editing a graph, you can select the type of graph. The 
following list contains the available output types:

➤ Line

Displays each metric as a line. Only Line Styles are valid for this graph 
type.

➤ Bar

Displays vertical bars for each metric.

➤ Area

Displays each metric as a line with data below the line filled with the 
same color. All metrics in this graph must have the same unit. This graph 
is also known as a filled line graph.
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➤ Mixed

Displays metrics that can be individually set as a line, area, or bar.

➤ Horiz Bar

Displays horizontal bars for each metric.

➤ Pie

Displays each metric as a portion of a circular pie chart.

➤ Gauge

Displays a single automotive-type dial gauge for each metric.

➤ Table

Displays the data in a table with columns for each metric, and rows for 
each record.

➤ Horiz Table

Displays a table with columns for each record and rows for each metric.

➤ Baseline

A baseline graph displays the average values for a single metric for a 
typical week. All available data from the data source is used to generate 
this baseline. To calculate the baseline for a typical week, you must have 
more than seven days of data for the selected system. If there is a large 
volume of historical data, it may take a few minutes to calculate.

Note: You cannot select the graph type as baseline when drawing or 
editing a graph from the Graph Design Wizard.

A baseline graph is useful in identifying patterns in system and 
application activities.
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When you specify a baseline graph, eight graphs are drawn. The first 
graph in the series is a Typical Week graph that displays the average values 
of a metric, organized by days of the week, and by hours of the day. In 
addition, there are seven graphs, one for each day of the week. Each of 
these displays the expected daily high and low values for the metric as 
opposed to the actual metric value. In the daily graphs, the blue line 
indicates the range of the values that are expected at any particular hour 
of that day. The expected values are determined by examining all past 
data for the system and calculating statistics for every hour of every day of 
the week. The blue lines typically display the range where 80% of the data 
points are expected to fall. The red line displays the actual data for each 
hour of the day.

Overview of Graph Templates 

For drawing graphs for the most common scenarios, Operations 
Management provides a set of standard templates.

A graph template contains information such as:

➤ Source of the data

➤ Metric or a set of metrics

➤ Instances of a metric

➤ Type of graph

➤ Graph attributes

You can also design your own graph templates or customize an existing 
template by using the Design Wizard. You cannot save changes made to 
standard templates, but you can save them as user-defined templates using a 
different name.

Graphing is organized using a graph family tree, which consists of:

➤ Family

Refers to the group that organizes graphs
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➤ Category

Refers to the sub-groups of graphs that are logically grouped within the 
family

➤ Name

Uniquely identifies a graph definition

Default Graphs
A default graph in a graph family contains the most important metrics to 
measure the performance of any resource or application. You can map graph 
families or categories to a CI. When you launch a graph for a CI or an event 
that has a graph family or category associated with it, the default graph 
from the graph family or category is drawn. A graph family can have one or 
more default graphs. If a graph family does not have a default graph, the 
first graph in the family or category is selected.

You can also configure a graph as a default graph when designing or editing 
a graph using the Graph Design Wizard. For instructions on designing a 
graph, see "How to Design Graphs" on page 154.

Note: You cannot launch a default graph for Real-Time Measurement (RTM) 
data sources. However, you can use the ad hoc graphing function available 
in the Performance Perspective tab to draw graphs for RTM data sources.

Data Sources 

A data source is an agent or an agent component that monitors an entity or 
an element on which it is deployed. However, HP SiteScope enables data 
collection without the deployment of an agent.

The data sources continuously collect data about the monitored elements 
and store it in the data store for future use. Graphing enables you to 
visualize this historical data stored in the persistent data stores.

Graphing supports the following data sources:



Chapter 4 • Performance Graphs

148

➤ HP Performance Agent

➤ HP Operations agent

➤ SiteScope (agentless)

➤ Business Process Monitor (BPM)

➤ Real User Monitor (RUM)

Note: The Real-Time Metric Access component of the HP Operations agent 
(11.00) provides you with real-time access to performance data for a 
monitored element.

Metrics 

A metric gives an indication of the operational health and performance of a 
system or application. It is a parameter or a set of parameters that can be 
used to monitor and measure the health, performance, and availability of a 
monitored resource.

Graphing enables you to visualize this data in the graphical or tabular 
format. A drawn graph consists of metrics and data points available for the 
selected metrics. A metric class is a set of related metrics grouped together 
based on the type of data it reports.

The metric values collected by the HP Operations agent and HP Performance 
Agent provide information about the monitored systems: processes, 
applications, transactions, CPU, file system, disk, network interface, and 
logical systems. These details indicate operational efficiency and health of 
the monitored system. In addition, various Smart Plug-ins (SPIs) supplement 
these agents to provide in-depth information about different applications 
running on these managed systems.



Chapter 4 • Performance Graphs

149

SiteScope collects metrics from different systems without the help of the 
agent software. Metric values collected by HP SiteScope provides 
information on the server health, availability of a URL, Web service, 
database, or application servers. These collected parameters indicate the 
availability and performance of the IT infrastructure.

HP Real User Monitor monitors user and system initiated network traffic. 
Metric values collected by HP Real User Monitor provide real-time 
information on the availability and performance of the network and servers.

HP Business Process Monitor collects metrics from various points 
throughout your infrastructure by running transactions that are included in 
a business transaction flow or application.

Tasks

How to Manage Graphs - Workflow

Along with out-of-box graph templates, you can also design custom graphs. 
Using the Design Wizard, you can create your own graph templates to 
display the required data. You can also edit the existing graph definition of a 
standard template and save it as a user-defined template. It enables you to 
map graph families or categories to configuration item types. For more 
information, see "Performance Graphs Manager" on page 300.

You can use the Performance Graphs component to draw graphs from the 
templates. The Performance Graphs component also enables you to draw 
graphs by making changes to the selected CIs or views. For more 
information, see "How to Draw Graphs in MyBSM Workspace" on page 150.

You can also draw ad hoc graphs from the graphing perspective view. For 
more information, see "How to Draw Graphs from the Performance 
Perspective" on page 152.

Only users with the appropriate access permissions can use Operations 
Management Administration tools. For more information about user 
management, see "Operations Management Users" on page 630.
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How to Draw Graphs in MyBSM Workspace 

You can add Performance Graphs as a component while creating your 
MyBSM workspace. You can use the Performance Graphs component to 
draw graphs from templates for a selected CI. You can also create your own 
graphs by selecting the required metrics for a CI.

To add performance graphs to your MyBSM workspace:

➤ Click the New Page button in the Page Management toolbar.

➤ Click the Split button. You can split the layout area into a number of 
vertical or horizontal panes.

➤ Click the Add Component icon. Double-click Performance Graphs or 
Performance Graphs with Details from the Component Gallery window, 
to place it in one of the panes.

Alternatively, click the Component button in the Page Management 
toolbar. Select Performance Graphs or Performance Graphs with Details 
from the component gallery and drag it to any area on the page.

➤ Select View Explorer from the component gallery and drag it to any area 
on the page.

You can use the Performance Graphs component to draw graphs from the 
templates. The Performance Graph with Details component enables you to 
launch the Performance pane, and draw graphs from templates or create 
your own ad hoc graphs. For more information on drawing graphs, see 
"How to Draw Graphs from the Performance Perspective" on page 152.

How to Draw Graphs from Operations Management 

You can draw graphs from a set of predefined templates or design your own 
graph templates. You can draw a graph in one of the following ways.

To draw a graph from the Model Explorer pane:

 1 Right-click the CI for which you want to draw a graph.

 2 From the menu options, select Show > Performance Graphs (CI) to draw a 
graph for the selected CI.
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Select Show > Performance Graphs (Neighborhood) to draw graphs for 
the selected CI and the neighborhood CIs.

To draw a graph from the Event Perspective tab:

 1 Right-click the event for which you want to draw a graph in the Event 
Browser pane.

 2 From the menu options, select Show > Performance Graphs 
(Neighborhood) or Performance Graphs (CI).

You can launch graphs for the events originating from following BSM 
components:

➤ HP End User Management (EUM):

➤ Business Process Monitor

➤ Real User Monitor

➤ HP Operations agent

Note: If you are drawing a graph for a CI with multiple instances, make 
sure the value of the parameter Maximum Instances is configured 
accordingly. While drawing a graph, only as many instances as the value 
specified for this parameter are displayed. If the number of instances are 
more than the value of this parameter, the extra instances are excluded 
from the graph. For more information, see "Graphing Settings" on 
page 708.

When you launch a graph for an event, the default graph of each family/
category is displayed in a new browser window. If a graph family/category 
does not have a default graph, the first graph in the family/category is 
selected. There are a multiple options that you can use to perform a more 
detailed analysis on the drawn graph. For more information, see "Options 
for Drawn Graphs" on page 157.
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The number of graphs drawn depends on the attributes which is a part of 
the graph template such as the value of Metrics per graph, the graph type 
configured in the graph templates and number of CIs. See "Graph Attributes 
- List and Description" on page 187 and keywords (as they appear in the 
graph template).

You can also draw graphs from the Performance Perspective tab. For 
information see "How to Draw Graphs from the Performance Perspective" 
on page 152.

To modify your selection of graph for a selected CI:

 1 Click  after you draw a graph. The selected CI along with a list of 
predefined graphs is displayed in the left pane. 

 2 Select a graph type from the list of predefined graphs.

 3 Click the Draw Graphs  button. The selected graph is displayed.

 4 Click the Clear Selections  button, to cancel all the previous selections.

How to Draw Graphs from the Performance Perspective

Performance Perspective tab enables you to launch graphs from predefined 
graph templates or create ad hoc graphs by selecting the required metrics for 
a selected CI. You can draw a graph from the Performance Perspective in one 
of the following ways.

To draw graphs from templates:

 1 From the Model Explorer pane, select the CI, for which you want to draw 
graphs.

 2 From the Performance pane, select Predefined Graphs tab. This tab 
displays a list of predefined graphs based on the CI that you select. 
Depending on the CI that you select, the default graphs are preselected.

 3 Select a graph type from the list of predefined graphs.

 4 Click the Draw Graphs  button. The selected graph is drawn.
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To draw ad hoc graphs:

 1 From the Model Explorer pane, select the CI, for which you want to draw 
graphs. Based on the CI you select, the Data Sources pane on the 
Performance pane lists the available nodes and data sources. The Metrics 
tab on the Performance pane displays the following:

➤ Data Sources pane - Contains the list of data sources. The data source is 
displayed in the format:
<monitored_entity>::<data_source_name>

➤  Metric Classes pane - Displays the list of classes based on the data 
source that you selected. The PROCESS class metric is not displayed in 
the metric classes pane. PROCESS class data can be viewed only as 
table graphs. You can design a process table graph using the Graph 
Design Wizard.

➤ Instances pane - Instances pane is displayed only when you select a 
multi-instance metric class. It lists all the available instances for a 
metric class.

➤ Metrics pane - Metrics pane displays the list of metrics when you select 
a metric class.

 2 Select the data source required from the Data Sources pane. The Metric 
Classes pane populates the list of metric classes based on the data source 
you select.

 3 Select the required metric class. The Metrics pane displays the list of 
numeric metrics belonging to that class.

Note: In addition, the Data Sources pane displays the Instances pane 
when you select a multi-instance class of metrics. For example, If you 
select Application class of metrics, the Instances pane displays all the 
instances of the application.

 4 Drag and drop a metric from the metric list. The graph is drawn for the 
selected metrics.

You can drag and drop any number of metrics and draw graphs.
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How to Design Graphs

You can design graphs using the Graph Design Wizard, and save them as 
customized templates. You can use these customized templates to draw 
graphs. You can also draw ad hoc graphs using the Graph Design Wizard. 
You can launch the Graph Design Wizard in one of the following ways.

 To design a graph from the Model Explorer pane:

 1 Right-click the CI, for which you want to design a graph.

 2 From the menu options, select Configure > Performance Graphs. The 
Design Wizard window opens.

To design a graph from the Event Perspective tab:

 1  Right-click the event, for which you want to design a graph. 

 2 From the menu options, select Configure > Performance Graphs. The 
Graph Design Window opens.

You can also launch the Graph Design Wizard from the following areas:

➤ From a drawn graph: Click Options > Configure from a drawn graph. The 
Design Wizard window opens.

➤ From a table graph: Click Configure  icon on the table graph. The 
Design Wizard window opens.

The Graph Design Wizard takes you through a series of steps required to 
design a graph. For detailed information about the individual panes, see the 
appropriate reference pages, such as "Graph Attributes Page" on page 166.

How to Edit Graphs

Graphing enables you to edit a graph that you have created. You can also 
edit out-of-the-box graph templates and save them as user-defined graph 
templates with different names.

To edit a graph template:

 1 Open the Performance Graphs Manager:

Admin > Operations Management > Performance Graphs.
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 2 From the Available Graph Families pane, select the graph that you want to 
edit.

 3 Click the Edit  button or right-click the graph and select Edit Graph 
Template: Launch Designer from the menu options. The Launch 
Performance Graph Designer window opens.

 4 Select a CI Instance from the list and click Next >. Launch Parameters 
displays the list of parameters available for the CI instance you selected.

 5 Click Finish. The Graph Attributes Page opens.

 6 The Graph Design Wizard takes you through a series of steps required to 
edit a graph. For detailed information about the individual panes, see the 
appropriate reference pages, such as "Graph Attributes Page" on page 166.

To edit a drawn graph:

 1 Select Configure from the Options menu of the drawn graph window. The 
Graph Design Wizard window opens.

 2 The Graph Design Wizard takes you through a series of steps required to 
edit a graph. For detailed information about the individual panes, see the 
appropriate reference pages, such as "Special Attributes Page" on page 180.

 3 Click Preview to view the modified graph.

 4 Click Back to Design button to view the design wizard of the graph. If you 
have modified the graph by adding or removing metrics, launch the 
design wizard again by selecting Configure from the Options menu of the 
graph window.

Note: If you have more than one drawn graph appearing in the 
Performance pane, the Configure option of each drawn graph will invoke 
a Graph Design Wizard for the selected graph.
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How to Delete Graphs

You can delete any graph that you have created. However, the 
out-of-the-box graphs cannot be deleted.

To delete a graph:

 1 Open the Performance Graphs Manager:

Admin > Operations Management > Performance Graphs.

 2 From the Available Graph Families pane, select the graph that you want to 
delete.

 3 Click the Delete Item   button. The graph is deleted.

Note: A graph family without any graphs is deleted.

Reference

Performance Graphs User Interface 

This section includes:

➤ Options for Drawn Graphs on page 157

➤ Performance Perspective Graphical User Interface on page 161

➤ Table Graph Window Button on page 164

➤ Graph Export Dialog Box on page 165

➤ Graph Design Wizard on page 165

➤ Graph Attributes Page on page 166

➤ Metric Selection Page on page 172

➤ Metric Selection Window on page 173

➤ Metric Properties Window on page 174

➤ Special Attributes Page on page 180
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➤ Save Graphs Dialog Box on page 186

➤ Graph Attributes - List and Description on page 187

➤ Date Range Panel on page 191

Options for Drawn Graphs 

The information in this section aims to help you understand how to 
interpret the contents of graphs and use the available features and 
functionality to change the contents of graphs.

➤ "CI and Graph Selection Icons" on page 158

➤ "Performance Pane Options Menu" on page 158

➤ "Drawn Graph Window Options and Buttons" on page 159

➤ "Zoom-In and Zoom-Out Options" on page 160

To access Select Applications > Operations Management > 
Performance Perspective

Important 
information

The following additional options are available to perform 
a more detailed analysis after you draw a graph. 

Relevant tasks For instructions to draw a graph, see "How to Draw 
Graphs from Operations Management" on page 150.
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CI and Graph Selection Icons
The Performance pane displays a list of graphs, graph families, and 
categories associated with the drawn graph. The default graphs in the graph 
families or categories and the CIs used are selected by default.

The following elements are included:

Performance Pane Options Menu

The following table lists the elements available from the Options menu in 
the Title Bar of the Drawn Graph page:

UI Elements Description

Clear Selection. Resets the options selected.

Draw Graphs. Draws a graph for the selected CI.

Refresh Graph List. Refreshes the Predefined Graphs 
listed. 

UI Elements (A-Z) Description

Close All Graphs Closes all open graph windows.

Date Range Panel Use this option to drag and drop a metric and draw a 
reference graph. The reference graph helps you 
understand the correlation between different metrics. 
You can also customize the graph to view granular data 
for a selected unit of time.

Help Click this option to view the help content for the current 
page.
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Drawn Graph Window Options and Buttons
The following table lists the options and buttons available in the Drawn 
Graph window (unlabeled UI elements are shown in angle brackets).

Navigation Panel If enabled, the navigation panel is displayed in the drawn 
graph window. However, this option will be available 
only for graphs displaying near-real time data.

Tooltips If enabled, hovering the mouse on the graph area of a 
drawn graph opens a pop-up window displaying the 
actual value of the data point and the time interval of the 
selected data. If disabled, no pop-up window is displayed.

UI Elements (A-Z) Description

 Auto Refresh On/Off: If Auto Refresh option is enabled, 
the data in drawn graph is refreshed at a specific interval, 
depending on the value specified for refresh rate in the 
graph template.

Metric Legend Graphing provides Metric Legend buttons to hide or 
show the corresponding graphs of the metric. Select a 
Metric Legend to hide or show the corresponding metric 
in a graph.

To remove a metric from a graph, right-click the legend 
of the metric, and then select Remove. The 
corresponding graph and the legend are removed from 
the graph window.

Options > Configure Use this option to launch the design wizard. The Graph 
Design Wizard - Graph Attributes window opens.

Options > Export Use this option to export graphs to formats such as TSV, 
CSV, XLS, and XML. For more information, see "Graph 
Export Dialog Box" on page 165.

Options > Navigate Use this option to select the start date and end date from 
the Time Settings dialog box. The data in the drawn 
graph is refreshed to display the data for the selected 
period.

UI Elements (A-Z) Description
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Zoom-In and Zoom-Out Options
After you draw a graph, you can zoom-in to view a smaller set of data points 
and zoom-out to reset and view the original graph. Zooming-in or 
zooming-out enable you to adjust the summarization levels.

➤ To zoom-in on data, click and drag the mouse to a rectangular area on 
the graph from left to right.

➤ To zoom-out, click and drag on the graph from right to left. When you 
zoom-out a graph, the graph is reset to its previous state.

You can zoom-in on data up to multiple levels. Every zoom-out reverts to 
the graph’s previous state.

Note: This option is available only for image graphs. However, this option is 
not available for pie, gauge, table, and forecast graphs, and graphs drawn for 
Real-time Measurement data sources.

Options > View as 
Table

Use this option to view the data in the graph as a table.

 

 

Prepend/Append: Graphing provides the Append and 
Prepend buttons to append data for adjoining time 
intervals based on the value specified for points every 
while drawing a graph. For more information, see 
"Specifying Points Every Value" on page 169.

Prev/Next: Graphing provides the Prev and Next buttons 
to navigate to adjacent time intervals based on the value 
specified for “points every” while drawing a graph. For 
more information, see "Specifying Points Every Value" on 
page 169.

UI Elements (A-Z) Description
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Performance Perspective Graphical User Interface 

In this section you can find information about the following topics:

➤ Model Explorer on page 162

➤ Performance Pane on page 162

To access Select Applications > Operations Management > 
Performance Perspective

Important 
information

The section aims to help you become familiar with 
Performance Perspective tab. The Performance 
Perspective page enables you to draw graphs from 
templates and also create ad hoc graphs by selecting 
required metrics.

Relevant tasks "How to Manage Graphs - Workflow" on page 149.

See also "Graphing Overview" on page 142.
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Model Explorer
Displays a list of CIs in a tree. You can create your own views. For 
information, see "Model Explorer Pane" on page 259.

Performance Pane
Enables you to draw and view performance graphs for the selected CI. You 
can draw a pre-defined graph for a CI or design a graph from the list of 
available metrics.

The Performance pane provides a list of pre-defined graphs and metrics 
based on the CI you select.

It consists of two tabs:

All drawn graphs are displayed in the Performance pane. For more 
information on drawing graphs, see "How to Draw Graphs from the 
Performance Perspective" on page 152.

The drawn graph window displays the following:

➤ Legends for the metrics that enable you to hide or show the graphs for 
the metrics.

➤ Name of the node from which the data source is collecting data.

➤ Metric name, metric value and the timestamp of the metric.

UI Elements (A-Z) Description

Metrics This tab displays the following information: 

➤ Data sources - lists the data sources available for a 
selected CI

➤ Metric Classes - lists the metric classes available for the 
selected data source

➤ Instances - lists the instances available for the selected 
multi- instance metric class

➤ Metrics - lists the metrics available for the selected 
metric class

Predefined Graphs This tab displays a list of graph templates based on the 
configuration item that you select from Model Explorer.
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Listed below are the options available for drawn graphs:

Compare Metrics from Different CIs

 1 Select a CI. The selected metrics and predefined graphs for the chosen CI 
appears. Drag and drop a metric from the Metrics pane. The graph is 
drawn in the Performance pane.

 2 Select the second CI with which you want to compare. Select the same 
metric from the metrics pane. Drag and drop the metrics to the previously 
drawn graph to compare the data across CIs.

For example, select a metric BYCPU_TOTAL_UTIL from two CIs. You can 
now compare the total CPU utilization data from nodes associated with 
the two CIs.

Remove metric

Right-click the metric name from the legend and select remove. The 
corresponding line representing the metric is removed from the graph and 
will no longer appear in the legend.

Add metric

Drag and drop a metric into a drawn graph window. The new metric is 
displayed in the graph and will be listed in the legend.

Hide metric

Click the metric name from the legend in the graph window. The legend of 
the metric is disabled and the graph of the metric does not appear in the 
graph window.

Show metric

Click the disabled metric from the legend. The legend of the metric is 
enabled and the graph of the metric is displayed again on the graph 
window.

Copy metrics from one graph to another

You can drag a metric from one graph and add it to another. The target 
graph will display the newly added metric.



Chapter 4 • Performance Graphs

164

Pull out metric from a graph

You can drag a metric from one graph and drop it into the empty space in 
graph panel area. A new graph is drawn with the metric which you selected.

Table Graph Window Button 

The Table Graph window displays the following elements (unlabeled UI 
elements are shown in angle brackets):

To access After you draw a graph, select Options > View as Table 
from the graph window. 

Important 
information

A table graph enables you to view granular data in the 
numeric format. This section describes in detail the 
information displayed in the Table Graph window.

Relevant tasks "How to Manage Graphs - Workflow" on page 149.

UI Elements Description

Configure:  Use this option to launch the design wizard. 
The Graph Design Wizard - Graph Attributes window 
opens.

Export:  Use this option to export the data from table in 
CSV, TSV, XLS, and XML format.

Lock Column Select this option to lock one or more columns in the 
table graph. This option enables you view the locked 
columns as you navigate across columns using the 
horizontal scroll bar. 

Sort Metric Columns:  Use this option to sort the data in 
the metric columns in ascending or descending order.
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Graph Export Dialog Box

The Graph Export dialog box includes the following elements:

Note: If you are selecting a Microsoft Excel or a TSV graph, you must 
configure the browser settings to display Microsoft Excel and TSV files. For 
more information on browser settings, see "Unable to View Graph in Certain 
Formats (XLS/TSV)" on page 194.

Graph Design Wizard

To access After you draw a graph, select Options > Export from the 
graph window. The Export from a Graph window opens. 

Important 
information

You can export graphs to one of the following formats: 
TSV, CSV, XLS, and XML.

Relevant tasks "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description

Cancel Click Cancel to close the dialog box and return to the 
drawn graph page.

OK Click OK to export the data in the selected format.

Type Select the format in which you want to export the graph.

To access Click Options > Configure from a drawn graph.

Important 
information

Graphing enables you to design custom graphs using the 
Design Wizard feature. You can create your own graph 
templates to display the required data. You can also edit 
the existing graph definition of an out-of-the-box 
template and save it as a user-defined template.
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The design wizard consists of the following:

➤ Graph Attributes Page

➤ Metric Selection Page

➤ Special Attributes Page

Graph Attributes Page

Relevant tasks "How to Design Graphs" on page 154

See also "How to Manage Graphs - Workflow" on page 149

To access From the menu options, select Configure > Performance 
Graphs > <Graph Attributes page>

Important 
information

From the Graph Attributes page, you can specify the 
graph attributes while designing a graph and save it as a 
template for later use.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.
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The following elements are included:

UI Elements (A-Z) Description

Date Range The default date range is: 7 days ending 'Now' and Points 
Every value is auto. You can also modify default settings 
for date and time.

Use Defaults - Clear Use Defaults check box to modify the 
default values.

Duration - Specify the time duration for which you want 
to design the graph. Enter the number and specify the 
unit of time. You can specify time duration in minutes, 
hours, days, and weeks. If you select “all”, all the data 
gathered by the data source and logged in the agent log 
files is included in the graph.

Points Every - Use the Points Every (POINTS EVERY) 
setting to control how much data is to be summarized in 
each point on the graph and hence determine the 
granularity (number of data points) of data on the graph. 
For more information, see Specifying Points Every 
Value.

Ending - Specify the end date for the graph. Select from 
one of the following options:

➤ Now - the current date and time on the server.

➤ Last - the date and time when data was last collected 
by the data source.

➤ Date/Time - When you select this option, the calendar 
button is enabled. Click the Calendar button to select 
the date. Select the time from the Time drop-down list.

Default Graph When you select the Default Graph check box, the graph 
which you design will be the default graph in the family 
or category to which it belongs.

Note: A graph family or category can have one or more 
default graphs.

Description Enter a general description of what the graph represents.

Note: A description of each graph appears as a tooltip 
when you mouse hover on the graph names in the 
Selection panel.
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Force Points Every Select this option to force control on the granularity 
(number of points) on the graph. This value overrides 
any Points Every value specified while drawing a graph.

Graph Type Select the type of graph you want to design from the 
drop-down list. Click here for a list of Types of Graphs 
with descriptions.

Help Click Help to view the help content for the current 
wizard page.

Limit Number of 
Points

Enter the number of records (table graph) or data points 
(for image graph) which you want to view on the graph 
at a time. The default value is 100. If the graph contains 
more data points, the Prev and Next buttons are enabled, 
so that you can navigate to view all the data points.

The number of points also depends on the graph type 
which you have selected:

➤ For a table graph, the default value for number of rows 
can be configured by the software administrator. 
However, the value specified while designing a graph 
template overrides the default value and the value is 
saved in the graph template.

➤ If you are designing a pie graph or a gauge graph,  
Limit Number of Points is set to one by default. You 
cannot change this value.

The recommended value for maximum number of points 
is 1000 for a graph. If you select a value greater than this, 
it will take a long time for the graph to appear.

Next Click Next to go to the next page.

Preview Click Preview to preview the graph.

Save/Save As Click Save or Save As to save your graph, The Graph 
Design Wizard - Save Graphs page opens.

UI Elements (A-Z) Description
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Specifying Points Every Value
Use the Points Every (POINTSEVERY) option to control how much data is 
to be summarized in each point on the graph. You can use the Points Every 
option to determine the granularity (number of data points) on the graph. 
The default value is Auto. You can select from the following options:

➤ Auto

➤ 5 minutes

➤ 15 minutes

➤ 30 minutes

➤ hour

➤ 3 hours

➤ 6 hours

➤ 12 hours

➤ Day

➤ Unsummarized

SubTitle You can specify a subtitle for the graph. You can also use 
any of the substitution variables as subtitle. The actual 
values will replace these variables. For more information 
see Substitution Variables.

Note: Subtitle of a graph is visible only when you hover 
the mouse over the title bar of a drawn graph window.

Title Type a name for the graph. This name will be displayed 
in the title bar of the drawn graph. Alternatively, you can 
also use any of the Substitution Variables as a title.

UI Elements (A-Z) Description
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Auto

Selecting this option automatically selects the value to display the data 
points within the configured limit. If you select Auto, Graphing 
automatically summarizes the data based on the date range that you have 
specified to a level that would make the graph easy to read. If the 
combination of Date Range and Points Every settings results in too many 
points, the Points Every value is automatically adjusted to display all of the 
requested data in one page. In addition, Graphing also provides the Append 
and Prepend buttons to increase the data points that you can view on a 
single page.

➤ Click Append >> to view data for the next set of data points, in 
addition to the data you are currently viewing.

➤ Click Prepend << to view data for the previous set of data points, in 
addition to the data you are currently viewing.

If you click Append or Prepend, Graphing adds additional data to the graph 
which you are currently viewing. The number of points displayed is same as 
the data points which appear in the initial graph, but the duration is 
doubled. For example, if you are viewing data for the previous one month, 
and you click Prepend, you can view the data for the previous two months.          

All the data points are displayed in the same page. The Points Every setting 
is reset by Graphing to make the data readable. When all the data available 
is displayed, the Append and Prepend buttons are disabled.

Example for Append/Prepend:

When the combination of the date range and Points Every settings is one week of data 
from 1/1/2009 to 8/1/2009 with points every one hour, if you Click Append/Prepend 
additional one week of data is displayed in the same page. You can see two weeks of 
data with points every three hours.

Example for Auto: 

For example, if you have specified the Duration as 12 hours, the graph displays this 
data for 12 hours and the summarization is automatically set by Graphing to 
accommodate this data within one page.
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Note: In case of Image Graphs, based on the value set for limit number of 
points, summarization interval is decided by Graphing when 'points every' 
is selected as auto. The behavior of the Next/Prev button is different if 
'points every' is selected as auto, unlike the behavior when 'points every' is 
specified as any other value other than auto from the drop-down. When 
auto is selected, you can view data for the duration which you have 
specified, in the same graph, with summarization interval specified by the 
Graphing. The Next/Prev options displays the graph from the next and 
previous duration with the same points every (summarization) value.

5 minutes

Displays one data point for every five minutes of the specified duration.

15 minutes

Displays one data point for every fifteen minutes of the specified duration.

30 minutes

Displays one data point for every thirty minutes of the specified duration.

hour

Displays one data point for every one hour of the specified duration.

3 hours

Displays one data point for every three hours of the specified duration.

6 hours

Displays one data point for every six hours of the specified duration.

12 hours

Displays one data point for every twelve hours of the specified duration.

Day

Displays one data point for every day of the specified duration.
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Unsummarized

Data is not summarized. The raw data collected by the data source for the 
specified duration is displayed. Any value set in Graphing does not affect 
the summarization.

Note: If the points every value is anything other than auto, and if the data in 
the chosen time range cannot be fit into a single graph or table, the graph or 
table uses more than one page and Prev and Next buttons are enabled. Click 
Prev to move to the previous page and Next to go to the next page to view 
all the data. The Append/Prepend options are disabled when you set Points 
Every is set to anything other than auto.

Metric Selection Page

The following elements are included:

To access From the menu options, select Configure > Performance 
Graphs > <Metric Selection page>

Important 
information

The Metric Selection page enables you to design a graph 
and save it as a template for later use.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description

Add Metrics Opens the Metric Selection window. For details, see 
"Metric Selection Window" on page 173.

Help Click Help to view the help content for the current 
wizard page.

Move Down  Click Move Down to move a metric one level down from 
its current position in the Metric column.
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Metric Selection Window

Move Up Click Move Up to move a metric one level up from its 
current position in the Metric column.

Next Click Next to go to the next page.

Prev Click Prev to go to the previous page.

Preview Click Preview to preview the graph.

Properties Click Properties to open the Metric Properties Window. 
Use this option to change properties for a metric.

Remove Click Remove to remove a metric from the Metric 
column.

Remove All Click Remove All to remove all the metrics from the list.

Save/Save As Click Save or Save As to save your graph, the Save Graphs 
dialog box opens.

To access From the menu options, select Configure > Performance 
Graphs > <Metric Selection page> and click Add Metrics

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description
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It includes the following elements (unlabeled UI elements are shown in 
angle brackets):

Metric Properties Window

You can configure the way a particular metric appears on the graph.

UI Elements (A-Z) Description

<Metric classes tree> The metric classes tree displays a list of metric classes and 
metrics belonging to each class that are available on the 
data source. The list of metrics appears when you expand 
the metric class name.

Add Select one or more metrics for which you want to draw 
graph and click Add.

Close Click Close after you complete the selection. The list of 
selected metrics now appears in a tabular form on the 
metric selection page of the design wizard.

Data Sources Select a data source from the list to view the available 
metrics.

Help Click this option to view the help content for the current 
window.

To access From the menu options, select Configure > Performance 
Graphs > Metric Properties

Important 
information

To change the properties of a metric, perform the 
following tasks:

1  Select the metric from the table.

2  Click Properties, the Metric Properties window opens.

Note: You cannot specify a color for the metric.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.
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The following elements are included:

UI Elements (A-Z) Description

Cancel Click Cancel to exit without saving the changes.

Filter You can specify a condition to filter metrics:

➤ Metric name - Select the metric for which you want to 
apply the filter

➤ A comparison symbol - Select a comparison symbol. 
See list of Comparison Symbols.

➤ A value to compare - Type a value to compare

➤ Add - Click Add to apply the metric filter

➤ AND/OR - Use the logical operators AND or OR, to 
specify multiple filters.

➤ Update - To modify the condition you specified, select 
the filter condition, modify the conditions and click 
Update.

➤ Remove - To remove a filter condition, select the filter 
condition and click Remove.

➤ Remove All - Click Remove All to delete all the filter 
conditions.

Help Click Help to view the help content for the current 
wizard page.
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Label Enter a label for the metric. The label identifies this 
metric on the graph or table. The label can be modified 
for one metric at a time. The label can be a literal string, 
or it can contain references to special substitution 
variables.

➤ @@[LABEL] - The metric label is specified by the data 
source. For example, (CPU %). If a label is not specified 
by the data source, then the metric name is used.

➤ @@[METRIC] - The metric name. For example, 
(GBL_CPU_TOTAL_UTIL)

➤ @@[CLASS] - The metric class. For example: (GLOBAL)

➤ @@[SYSTEM] - The node name supplying the metric. 
For example: (mysys.net.com)

➤ @@[DATASOURCE] - The data source for this metric. 
For example: (PA, EPC)

➤ @@metric - The value of the metric from the same 
data source and class. For example: 
@@BYDSK_DEVNAME will label the metric with the 
value of the BYDSK_DEVNAME metric. If the 
BYDSK_DEVNAME metric value were “0”, Disk 
@@BYDSK_DEVNAME would produce a label of Disk 0.

Example:

@@[SYSTEM]:@@[CLASS]:@@[METRIC] might 
produce a label like 
"mysys.net.com:GLOBAL:GBL_CPU_TOTAL_UTIL"

Note: Graphs that contain only one metric will 
automatically display the system name for the metric 
label, when multiple nodes are selected. If you do not 
specify a label, Graphing uses the default metric label 
specification; that is, any label supplied by the data 
source for the metric, or the metric name.

UI Elements (A-Z) Description
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Line Style You can select a line style from the list. This option is 
available only if you select the graph type as Line.

You can choose from the following line styles:

➤ Solid 

➤ Dotted

➤ Dashed

➤ Dash-dotted

➤ Dash-dot-dotted

OK Click OK to save all the changes and exit from this 
window. The Graph Design Wizard - Metric Selection 
page opens.

Type Displays the type of graph that you selected while 
specifying graph attributes. If you have selected mixed 
graph, you can specify the graph type for the metric that 
you selected. The options available are Line, Area or Bar.

YAxis Specify whether you want the Y-axis of the graph to 
appear on the left hand side or right hand side from the 
drop-down list.

Note: This option is available only for graph types Line, 
Area and Mixed. For all other graph types, the option 
Right does not appear in the drop-down list.

UI Elements (A-Z) Description
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Comparison Symbols

The following elements are included (unlabeled UI elements are shown in 
angle brackets):

Note: While specifying strings or expressions for filters, use regular 
expressions. For example, .*C.* instead of *C*.

The like comparisons such as “~” and “!~” are textual comparisons that 
allow wild cards. When you select these symbols, specify a valid regular 
expression value; for example, specify APP_NAME~.*xyz.* to select data 
where the application name contains the text “xyz”.

Symbol Description

= Equal to

< Less than

> Greater than

~ Like (textual comparison with leading or trailing “.*” 
expressions)

!= Not Equal

!~ Not Like (textual comparison with leading or trailing “.*” 
expressions)

<= Less than or Equal to

>= Greater than or Equal to
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 Substitution Variables 
The following variables can be used for Graph titles or subtitles. The actual 
values will replace these variables in the drawn graphs:

Variable Description

@@[SYSTEM] Displays the name of the system for which the graph is 
drawn.

@@DATERANGE Displays the duration for which the graph is drawn. (For 
example, 7days).

@@POINTSEVERY Displays the time summarization for each data point. 
(For example, points every 10 minutes).

@@STARTTIME Displays the start time in a drawn graph.

@@STOPTIME Displays the end time in a drawn graph.

@@metric Displays the value of a metric. (For example, if you use 
@@APP_NAME, the title or subtitle will include the value 
of the metric, that is the name of the application.

Note: Use this parameter, only when a single instance of 
a metric is drawn in a graph. If there are multiple 
instances in a single graph, then all the instance names 
will be appended to the title or subtitle name.
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Special Attributes Page

Click the options below based on the graph type you selected:

➤ "Special Attributes for Image Graphs" on page 180

➤ "Special Attributes for Tables" on page 183

➤ "Comparison Symbols" on page 185

Special Attributes for Image Graphs

The following elements are available if you select the graph type as Line, 
Area or Bar graph (unlabeled UI elements are shown in angle brackets):

To access From the menu options, select Configure > Performance 
Graphs > Special Attributes

Important 
information

The Special Attributes page enables you to specify the 
special attributes while designing a graph.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description

Cancel Click Cancel to exit the design wizard.

Effects Stacked: If you are designing an area or bar graph, select 
the Stacked option to stack one metric on top of the 
other metrics in the graph. The “Stacked” effect makes it 
easier to view the overlapping data. 

Note: The Effects option is available only for the bar and 
area graphs.

Help Click Help to view the help content for the current 
wizard page.
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Left Y Axis ➤ Label - Specify a label for Y-axis appearing on the left 
side.

➤ Minimum - Specify minimum value for points on the 
left side Y-axis. If left blank, the initial scale of the axis 
will automatically be adjusted to accommodate the 
values in the graph.

➤ Maximum - Specify maximum value for points on the 
left side Y-axis. If left blank, the initial scale of the axis 
will automatically be adjusted to accommodate the 
values in the graph. 

Metric Display Order Specify the order in which you want the metrics to be 
displayed. The default value is 'User defined'. You can 
select from the following options: 

➤ User defined (See Metric Selection Window) - Select 
this option if you want the metrics to appear in the 
order of the sequence on the Metric Selection page. 

➤ Average Value - Select this option if you want the 
metrics to appear in the ascending order of the average 
value. When you select this option and draw a graph, 
the higher values appear at the top. You can use this 
feature in conjunction with the value specified in the 
Metrics Per Graph field. 

➤ Reverse Average Value - Select this option if you want 
the metrics to appear in the descending order of the 
average value. When you select this option and draw a 
graph, the lowest values appear at the top. 

UI Elements (A-Z) Description
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Metrics Per Graph Specify the number of metrics you want to see in a graph. 
The default value is eight.

➤ Single graph - Click Single Graph to limit the number 
of graphs to one graph when number of metrics or 
instances exceeds the value specified for “Metrics Per 
Graph.”

➤ Multiple graphs - Click Multiple Graphs, to display 
multiple graphs when number of metrics or instances 
exceeds the value specified for “Metrics Per Graph.” 
The number of metrics or instances in each graph is 
less than or equal to the value specified for “Metrics 
Per Graph.”

Next Click Next to go to the next page. 

Prev Click Prev to go to the previous page.

Preview Click Preview to preview the graph.

Right Y Axis Label - Specify a label for Y-axis appearing on the right 
side. This enables you to specify a label for the right side 
of the graph to identify the right hand Y-axis. This field 
does not appear unless at least one metric has the “Right 
Y-axis” selected from the Metric Properties Window.

Minimum - Specify minimum value for points on the 
right side Y-axis. If left blank, the initial scale of the axis 
is automatically be adjusted to accommodate the values 
in the graph.

Maximum - Specify maximum value for points on the 
right side Y-axis. If left blank, the initial scale of the axis 
is automatically adjusted to accommodate the values in 
the graph.

Save/Save As Click Save or Save As to save your graph, The Graph 
Design Wizard - Save Graphs page opens.

UI Elements (A-Z) Description
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Special Attributes for Tables

The following options are available when you select the graph type as table. 
It enables you to highlight a cell in a table based on its content so that the 
records can be accessed easily. You can also set conditions to filter the 
contents from a table based on the metric value. The following elements are 
included:

UI Elements (A-Z) Description

Add Click Add to include the table highlight condition that is 
specified in the list. 

AND/OR Select either AND or OR to apply multiple conditions:

➤ AND - filters the rows that satisfy the first condition 
you set and the row that satisfies the following 
condition as well. 

➤ OR - filters the rows that satisfy either the preceding or 
the following condition. 

Cancel Click Cancel to exit the design wizard.

Color Select a highlight condition from the list and click Color, 
to add a color to the cell. The Color Palette appears. 
Select a color, for example, blue from the color palette 
and click OK.

Help Click Help to view the help content for the current 
wizard page.

Next Click Next to go to the next page.

Prev Click Prev to go to the previous page.

Preview Click Preview to preview the graph.

Remove Select any table highlight or filter condition, and click 
Remove. The table highlight or filter condition is deleted 
and will no longer appear when you preview or draw the 
graph.

Remove All Click Remove All to delete all the filter conditions that is 
specified. 
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Example for Table Highlight:

If you select the metric GBL_CPU_TOTAL_UTIL and > (greater than) as the 
comparison symbol, and 4 as a value to compare against the metric and 
color as red from the color palette, when you preview or draw the graph, 
you can see the cells with records satisfying the condition you set; that is 
GBL_CPU_TOTAL_UTIL>4 highlighted in red. 

Save/Save As Click Save or Save As to save your graph, The Graph 
Design Wizard - Save Graphs page opens.

Table Filters Select the metric for which you want to set a filtering 
condition. Select a Comparison Symbols and enter 
value to compare against the metric. For example, 50. 

Note: The metrics added in The Graph Design Wizard - 
Metric Selection page are listed for filtering. If you want 
to add or remove a metric, click Previous to go back to 
the Metric Selection screen and add or remove a metric.

Table Highlights Select the metric for which you want to highlight from 
the drop-down list. Select a Comparison Symbols and 
enter value to compare against the metric. 

Note: The metrics added in the Graph Design Wizard - 
Metric Selection page are listed for filtering. If you want 
to add or remove a metric, click Previous to go back to 
the Metric Selection screen and add or remove a metric.

Update Select the filter condition that you want to edit. Update 
the filter condition as required. Click Update. The 
changes are effective next time you preview or draw the 
graph.

UI Elements (A-Z) Description
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Comparison Symbols
Listed below are the comparison symbols which you can use while 
specifying a condition to highlight or filter a table:

Note: When specifying interest reason for table filters and table highlights, 
do not use the wildcard expressions such as *C*. Use a regular expression, 
for example, .*C*.

Comparison Symbols Description

= Equal to

> Greater than

< Less than

>= Greater than or Equal to

<= Less than or Equal to

!= Not Equal to

!~ Not like
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Save Graphs Dialog Box

The following elements are included:

Tip: The name can be a combination of alphabets, numbers, and special 
characters and space. In case you use special characters other than #, -, or _, 
the following error message appears:
The name can only contain a combination of alphabets, numbers and 
the special characters: #, -, _ and space 
If the family name and category already exist, the Graphing automatically 
populates the Family, Category, and Name fields text boxes with the names 
when you type the first few alphabets.

To access From the menu options, select Configure > Performance 
Graphs

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description

Cancel Click Cancel to close the dialog box.

Category Enter the name of the graph category. (This is optional, 
graphs can be grouped directly under a family).

Help Click Help to view the help content for the current 
wizard page.

Family Enter the name of the graph family.

Name Enter a name for the graph.

OK Click OK and modify the graph name.

Save Click Save to save the graph.

Save As Click Save As to save the graph with a different name.
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Graph Attributes - List and Description

The following elements are included (unlabeled UI elements are shown in 
angle brackets):

To access Select Applications > Operations Management > 
Performance Perspective

Important 
information

The following table lists all graph attributes, keywords (as 
they appear in the graph template), and their 
descriptions. The table also details the way Graphing 
handles conflicting parameters defined in different 
default graph templates.

Note: A software administrator can configure parameters 
specific to Graphing. For more information, see 
"Graphing Settings" on page 708.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Elements (A-Z) Description

Auto-Refresh The interval at which the Graphing can refresh the 
drawn graphs automatically so that the graph is updated 
with the latest data. Graphing enables this option if any 
of the selected graph templates has the option enabled.

Date range Range of date and time to include in the graph. If you do 
not specify any values for DATERANGE: the default date 
value (that is, duration of 7 Days, ending Now) is used. If 
you specify “all” for date range, all the data collected in 
the data source will be used in graphing. 

Graphing chooses the value of date range as “ALL” if any 
of the selected graph templates contain the value “All”. 
However, if none of the default graphs templates contain 
the value ALL, the Graphing chooses the maximum 
value from all the graph templates.
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Graph type For a list of graph types supported by the Graphing, see 
"Types of Graphs" on page 144.

If the graph type is specified as table or Gauge in any of 
the graph templates then a separate graph is drawn for 
each of these graph types.

Left-axis and 
right-axis max

The maximum value on the right (optional) Y-axis. 

The maximum value on the left (default) Y-axis. For the 
Gauge graph type, the parameter will be the maximum 
value on the gauge scale. 

Graphing takes the maximum from all the values in the 
default graph template.

Left-axis and 
right-axis min

The minimum value on the left (default) Y-axis. For the 
Gauge graph type, this parameter is the minimum value 
on the gauge scale.

The minimum value on the right (optional) Y-axis.

Graphing takes the minimum values from all the values 
in the default graph template.

Left-axis title and 
right-axis title

Specifies the label for the left Y-axis.

Specifies the label for the right Y-axis.

Graphing combines all available values from the selected 
graph templates.

LineStyle This specification is valid only when the GRAPHTYPE is 
solid line. You can select from the following values:

➤ Solid

➤ Dotted

➤ Dashed

➤ Dashed-dotted

➤ Dash-dot-dotted

Graphing takes the value from the last metric.

UI Elements (A-Z) Description
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LineWidth The number of pixels wide to draw the line for this 
metric. This specification is valid only when the 
GRAPHTYPE is line and the LINESTYLE is solid. The 
default value is 2.

Graphing takes the value from the last metric.

Metrics filter A data filter that is applied to the data. Data records that 
do not meet the filter specifications will not be used in 
the final calculation. Graphing combines all available 
values based on classes from the selected graph 
templates.

Metrics per graph The maximum number of metrics on a single graph. The 
default is eight.

Graphing chooses the maximum value specified from all 
the selected graph templates. 

Example

If there are two graphs associated with the chosen CI, out 
of which one has metrics per graph as eight and other 
has twelve, the Graphing chooses the value as twelve.

Note: The metrics per graph in the resulting graphs also 
depends on the value configured by a software 
administrator for the parameter Metrics Per Graph. For 
more information, see "Graphing Settings" on page 708.

UI Elements (A-Z) Description
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Number of points The number of data points to be displayed on a graph. 
This value is used to summarize the data for each data 
point and to fit the graph in a single window, when 
POINTSEVERY value is set to auto. For other 
POINTSEVERY values, Graphing determines the number 
of (data points and time intervals) for each graph and 
provides options to view the next or previous set of data 
points or intervals. For line, area, and table graphs, the 
default value is 100. You are not required to specify a 
number for Pie and Gauge graph types.

It is recommended that you do not to set the value to 
more than 1000 as this might impact the performance of 
the application. Graphing chooses the maximum value 
available from all the selected graph templates.

Points every Determines the granularity (number of data points) on 
the graph. This value is used in conjunction with the 
NUMBEROFPOINTS value to determine the level of 
summarization to use. Graphing chooses the value Auto 
if any of the selected graph templates contain the value 
for points every as Auto. However, if none of the graph 
templates has the value Auto, the Graphing chooses the 
minimum value from all graph templates. For more 
information, see Specifying Points Every Value.

UI Elements (A-Z) Description
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Date Range Panel 

The following table lists all the options available to customize a graph 
(unlabeled UI elements are shown in angle brackets).

To access Select Options > Date Range Panel

Important 
information

The Date Range Panel option enables you to view the 
granular data for a specific period.

Relevant tasks "How to Design Graphs" on page 154.

See also "How to Manage Graphs - Workflow" on page 149.

UI Element (A-Z) Description

Adjust to a unit of time:  Use this option to move the 
slider to a unit of time you select from the list. For 
example, if you select an hour from the list, you can 
use adjust to an hour and the slider moves to show 
data for an hour 

Choose a time frame: Select a start date and end date 
from the Time Settings dialog box to view data for that 
period. The start date and end date values range 
between the earliest and the latest time stamps 
available in the data source.

Next: Select Next to view the data for the adjacent unit 
of time. For example, if you select last hour from the 
list you can use the Next Hour option to view data for 
that period.

In the same way, you can view adjacent data for any 
unit of time.

Previous: Select Previous to view the data for the 
adjacent unit of time. For example, if you select last 
hour from the list, you can use the Previous Hour 
option to view data for that period.

In the same way, you can view adjacent data for any 
unit of time.
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Troubleshooting and Limitations 

This section provides help in troubleshooting problems relating to 
performance graphs.

➤ "Unable to Draw a System Performance Graph" on page 193

➤ "Unable to Edit or Delete a Graph" on page 193

➤ "Graph Saved from Design Wizard but Not Mapped to Any CI Type" on 
page 193

➤ "Unable to View Graph in Certain Formats (XLS/TSV)" on page 194

<Unit of time> Select a unit of time from the list to view granular data 
for that period of time. The options available are:

➤ hour

➤ day

➤ week

➤ month

All Select this option to apply the changes made within 
the date range panel to all the drawn graphs. If you do 
not select this option, the changes apply to the selected 
graph only.

Range Select the time range from the list. The options 
available are:

➤ Months in Year

➤ Weeks in Month

➤ Days in Weeks

➤ Hours in Day

By default, a Range value is displayed based on the unit 
of time selected.

For example, if you select last hour from the list, the 
Range list displays hours in a day. 

UI Element (A-Z) Description
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➤ "Unable to Draw a Graph from a CI" on page 194

➤ "Some Instances of the CI Not Appearing in the Drawn Graph" on 
page 195

➤ "The Real-Time Graph Window Stops Receiving Updates" on page 195

➤ "Customized Graph Templates are Unavailable after Migrating from HP 
Operations Manager i 8.10 to BSM 9.10" on page 195

Unable to Draw a System Performance Graph
After launching a graph for a CI or a list of CIs, the following message 
appears:

You cannot draw a system performance graph without selecting a host CI. 
When you try to draw a system performance graph make sure you select at 
least one host CI.

Unable to Edit or Delete a Graph
You need to be a software administrator to edit or delete a graph. For 
information about the user roles, see "Operations Management Users" on 
page 630.

Graph Saved from Design Wizard but Not Mapped to Any 
CI Type
When you edit a graph from the design wizard or when you design a graph 
from the admin UI, you need to map the graph to a CI type. For 
instructions, see "How to Map CI Types to Graph Families" on page 305.
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Unable to View Graph in Certain Formats (XLS/TSV) 
You must check if the option to download files in the Microsoft Excel and 
TSV format is enabled in the browser security settings. To check the browser 
settings, perform the following tasks:

 1 Select Internet Options from the Tools menu of Internet Explorer. The 
Internet Options window opens.

 2 Click the Security tab. Check if the security level in your browser settings 
is set to high. Make sure the Internet icon is selected and click Custom 
Level. The Security Settings window opens.

 3 Scroll down to the Downloads section and select the Enable option under 
File Download.

 4 Click OK and close the Internet Options window.

 5 Open the Control Panel and double-click Folder Options.

 6 Click the File Types tab to display the registered file types.

 7 Select the XLS file format and TSV file format from the Registered file types 
list, and then click the Advanced button. The Edit File Type window 
opens.

 8 Click to clear the Confirm Open After Download check box.

 9 Click OK.

Unable to Draw a Graph from a CI
This can happen when CI is not mapped to a graph family or category. 
When you edit a graph from the design wizard or when you design a graph 
from the admin UI, you need to map the graph to a CI type. For 
instructions, see "How to Map CI Types to Graph Families" on page 305.
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Some Instances of the CI Not Appearing in the Drawn 
Graph
If you are drawing a graph for a CI with multiple instances, make sure the 
value of the parameter “Maximum Instances” is configured accordingly. 
While drawing a graph, graphing displays only as many instances as the 
value specified for this parameter. If the number of instances is more than 
the value of this parameter, graphing will not display those in the drawn 
graph. For more information, see "Graphing Settings" on page 708.

The Real-Time Graph Window Stops Receiving Updates
A graph drawn with metrics obtained from the RTM data source stops 
receiving updates if the HP Operations agent (or the RTM component of the 
agent) on the node that hosts the RTM data source stops running.

The graph window title bar shows the following message when the 
HP Operations agent or the RTM component stops working:

RTM data source is not responding

When the HP Operations agent (or the RTM component of the agent) starts 
running on the node again, the graph window starts showing the updated 
graph and restores the original window title.

Customized Graph Templates are Unavailable after 
Migrating from HP Operations Manager i 8.10 to BSM 
9.10
When you migrate from HP Business Availability Center (BAC) 8.10—with 
HP Operations Manager i 8.10—to BSM 9.10, only out-of-the-box graph 
templates are imported whereas the custom templates are not imported. You 
must manually recreate the custom templates.
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5
Actions Pane

This chapter includes:

Concepts

➤ Actions and the Actions Pane on page 198

Tasks

➤ How to Run an Action on page 199

Reference

➤ Actions Pane User Interface on page 201
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Concepts

Actions and the Actions Pane

The Actions pane is used to display the actions that are available for the 
selected event, its related CI, or the node that hosts the CI. Actions include 
Tools, Run Books, Custom Actions, and Performance Graphs. The Actions 
pane is used in the Event Perspective and the Health Perspective and can be 
added to custom perspectives.
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Tasks

How to Run an Action 

In this task, you learn how to run an action available for a selected event.

To run an action from an event with related actions:

 1 Open a perspective containing the Actions pane to display the list of 
known events and their associated actions:

Applications > Operations Management > <select a perspective>

 2 Select an event. 

The Actions pane displays the actions available for the selected event.

Action types are identified by the following icons:

 — Automatic action

 — Custom Actions

 — Performance Graphs

 — Run Books

 — Tools

 — User action

Note: The maximum script and executable command length for tools is 
limited to 2500 characters including resolved parameters.

If the script or command exceeds 2500 characters including parameters 
resolved during tool execution, an error message is displayed.

Review the possible custom parameter values or contact the tool designer 
to reduce the script or command length.
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 3 Select an action from the Actions pane.

If the action does not require any further data, it is run immediately. If 
further data is required, for example for a Tool or a Run Book, the 
associated user interface is launched and a wizard guides you through the 
action launch.

Optional: Enter the Action name or part of the Action name in the Search 
field to reduce the list of displayed Actions. Similarly, select CI or Node to 
limit the list of displayed Actions to those that are applicable to either the 
related CI or the host Node.

For further information on Performance Graphs, see "Performance Graphs" 
on page 141.

For further information on how to run Tools, see "How to Launch a Tool" on 
page 205.

For further information on how to run HPOM actions, see "How to Run an 
HPOM Action" on page 62.

For further information on how to launch a custom action, see "How to 
Launch a Custom Action" on page 63.

For further information on how to run Run Books, see "How to Launch an 
HP Operations Orchestration Run Book" on page 63.
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Actions Pane User Interface 

This section describes the information displayed in the Actions pane. The 
information in this section aims to help you to use actions.

The Actions pane displays a list of the Actions (Tools, Run Books, Custom 
Actions, and Performance Graphs) applicable to the selected event, its 
related CI, or the node that hosts the CI.

The Actions pane displays the UI elements listed in the following table:

To access Select Applications > Operations Management > Event 
Perspective

Relevant tasks For more information about running actions, see "How 
to Run an Action" on page 199.

See also For more information about the Actions Pane, see 
"Actions and the Actions Pane" on page 198.

UI Element (A-Z) Description

CI CI related to the selected event.

Clear Removes the currently applied search string and displays 
all applicable actions for the selected CI.

Event Title of the event that provides a brief summary of the 
event.
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Filter Used to reduce the number of actions displayed in the 
Actions pane by showing only those applicable to CIs or 
Nodes.

All — Shows all applicable actions for the selected event.

CI — Shows actions that can be run on the CI related to 
the selected event.

Node — Shows actions that can be run on the Node 
related to the selected event.

Source CI — Shows all actions that can be run on the 
source CI of the received event.

Node Host name to which the event is related.

Search Used to reduce the number of actions displayed in the 
Actions pane by showing only those that match the 
entered search string.

UI Element (A-Z) Description
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User Tools

This chapter includes:

Concepts

➤ User Tools Basics on page 204

Tasks

➤ How to Launch a Tool on page 205

Reference

➤ Run Tools User Interface on page 207

Troubleshooting and Limitations on page 209
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Concepts

User Tools Basics

You can specify tools in Operations Management, for example, to ping a 
system. These tools are run from events on the associated CI. Tools are 
designed to help you solve common problems quickly and efficiently.

In the context of an event, available tools are displayed in the Launch > 
Tools context menu.

In the context of a configuration item, available tools are displayed in the 
Launch Tools context menu and are also displayed in the Actions pane of a 
perspective. 

The selection of tools a particular user sees in context menus depends on the 
tools that are available for the configuration item affected by a particular 
event.

For more information about using the Tools manager to configure custom 
tools, see "Tool Creation" on page 273.

Note: Access to Administration features may be restricted. You must have 
corresponding permissions to launch the Tools manager.
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Tasks

How to Launch a Tool

In this task, you learn how to launch a tool that is configured for a particular 
configuration item type. Tools are displayed in the context menus.

Note: Tools, custom action, performance graphs, and OO Run Books 
available for a selected event are also displayed in the Actions pane of a 
perspective.

To launch a custom tool:

 1 Open the Event Browser to display the list of known events:

Applications > Operations Management > <select a perspective>

 2 In the Model Explorer pane, select a view containing the configuration 
item type with the tool you want to start. 

Note: Use the search feature if you are not sure of the name or location of 
the configuration item.

Alternatively, in the Event Browser, select an event that concerns the 
configuration item of the type that includes the tool you want to run.

 3 To open the Run Tool dialog box, make one of the following selections:

➤ Right-click an event in the Event Browser and select:

 Launch > Tool > <select a tool> 

➤ Right-click a configuration item in the Model Explorer and select

 Launch Tool > <select a tool> 
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The Run Tool dialog box opens for the selected tool configured for the 
configuration item type associated with the event.

 4 If the tool requires any additional information to resolve parameters, type 
the required information in the pages presented by the Run Tool wizard.

 5 To run the selected tool, select Run Tool.

For scripts and executable commands, the Execution Result window 
opens and displays the output of the tool execution.

Use the Word wrap for output option to make sure that all output text is 
displayed within the output pane.

Use the Refresh button to update the displayed output or select a refresh 
interval to regularly update the displayed output while the tool is 
executing.

For URL launches, the target is opened in a browser.

 6 For scripts and executable commands, after the tool is run, select Close.
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Run Tools User Interface

The Run Tool dialog box enables you to view the tool you want to run 
before running it. You can also browse any other tools that are displayed in 
the same tools context menu.

The Run Tools page displays the UI elements listed in the following table.

To access Select Applications > Operations Management > <select a 
perspective> Right-click an event in the Event Browser 
and select Launch > Tool > select a tool

Relevant tasks For more information about launching tools, see "How to 
Launch a Tool" on page 205.

See also For more information about the Tools, see "User Tools 
Basics" on page 204.

UI Element (A-Z) Description

Back Opens the previous page in the Run Tool Wizard, if 
available. The Back button is inactive (grey) if no 
previous page is exists.

Cancel Closes the Run Tool Wizard without running a tool.

Close Closes the Run Tool Wizard after a tool is run.

Next Opens the next page in the Run Tool Wizard, if available. 
The Next button is inactive (grey) if no other page exists.

Refresh Updates the displayed output of the active tool.

Refresh every Automatically updates the displayed output of the active 
tool using the refresh interval selected from the list.
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Run Tool Starts the tool that is selected in the Run Tool Wizard. If 
the tool requires additional information to resolve 
parameters, a wizard enables you to supply the required 
information before the tool starts.

Word wrap for 
output

Wraps tool output text so that it is displayed within the 
width of the output pane.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides help for those people who are troubleshooting 
problems concerning the launch and use of Operations Management tools. 
For more information about troubleshooting tool configuration and 
availability, see "Tools Management" on page 272.

➤ "No Tools Display" on page 209

➤ "Tool Does Not Run" on page 209

No Tools Display

➤ No tools are available for the selected type of configuration item or the 
configuration item associated with the selected event.

➤ The selected event does not contain Related CI or Node information.

Tool Does Not Run

➤ The tool is incorrectly configured.

Tools are not launched in the context of an event. They can be run on 
configuration items only. However, all tools contain event parameters.

➤ The tool depends on external resources such as network or internet 
connectivity that are not currently available.
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7
Filtering Events 

This chapter includes:

Concepts

➤ Filtering Methods on page 212

➤ Event Filters on page 215

Tasks

➤ How to Filter Events by Views on page 218

➤ How to Filter Events by Configuration Items on page 219

➤ How to View and Apply Event Filters on page 220

➤ How to Define Simple Event Filters on page 221

➤ How to Define Advanced Event Filters on page 224

Reference

➤ Filter Manager User Interface on page 228

Troubleshooting and Limitations on page 253
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Concepts

Filtering Methods

Large IT environments naturally create a large number of events. All active 
events are displayed in the Event Browser and maintaining a clear overview 
of the events that require attention becomes increasingly difficult as the 
number of received events increases.

You can filter the contents of the Event Browser, for example, in the Event 
and Health Perspectives (or perspective containing an Event Browser and 
the Model Explorer), according to a combination, where available, of the 
following selections:

➤ Views

Views are used to group configuration items into logical sets. Selecting a 
view, the Event Browser only displays events that are related to the CIs 
specified in the selected view.

➤ Configuration Items

Selecting one or more CI from the CI tree only displays events in the 
Event Browser that are related to the selected CIs. 

➤ Configuration Item Collection

Selecting a CI Collection from the CI tree only displays events in the 
Event Browser that are related to the CIs that are contained within the 
selected collection. 

➤ Event Filters

Applying an event filter enables you to limit the type of events displayed 
in the Event Browser by defining rules that filter events according to 
event criteria such as severity, lifecycle state, assignment (ownership), 
category, dates and times, custom attributes, resolution information and 
application name.
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Note: An Event Browser page without a Model Explorer pane can only be 
filtered using event filters.

By applying a combination of the available filtering methods, you can 
display just the most important events that you are responsible for. It is 
possible to create a view to display a CI tree list tailored to the 
responsibilities of an operator. Operators can then select a CI from the CI 
tree and be shown all related events. Alternatively, operators can define 
filters to, for example, show only events labelled as Critical and Major. 
Combining the selection of a CI and applying the same filter displays all 
events labelled as Critical and Major for the select CI.

Filter Selection
The contents of the Event Browser pane in the Event Perspective and Health 
Perspective can be filtered by the selected view or configuration item and by 
the selected event filter. 

The active view or configuration item used to filter the Event Browser 
content is indicated in the Event Browser title. For example, if a view with 
the name Host Resources is selected, The Event Browser title displays:

Event Browser for Host Resources

When you open the Event Browser for the first time, no filters are applied 
and Select an event filter is displayed in the Event Browser Filter applied list. 
After you select a filter, the name of the active event filter is displayed in the 
filter selection field. If you want to clear the selected filter, select No Filter. 
The effect of the filter on the Event browser is cleared, but can be reapplied 
as required.
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Note: By default, the contents of the Event Browser pane are filtered 
according to the selected configuration item or view. To disable filtering by 
configuration item or view use the Enable/Disable View Filtering  toggle 
button.
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Event Filters 

Event filters enable you to limit the type of events displayed in the Event 
Browser by defining rules that filter events according to criteria such as 
severity, origin, type, and ownership. The filters you define are available 
from the Select an Event Filter dialog box or the filter selection drop-down 
box of the Event Browser. The active filter remains on display in the filter 
selection drop-down box.

You define and edit filters using the Filter Configuration dialog box available 
from the Event Browser. Simple filtering information is grouped under the 
General, Dates, and Additional Event Properties tabs. A Simple Filter 
definition is the combination of all information specified in the three tabs.
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You can also use the Advanced Mode for defining more complex filters. An 
advanced filter definition is specified in the Filter Definition pane using 
combinations of properties and operators.

Note: When investigating closed events using the Closed Events Browser, 
you must first specify the time period of interest. Filters can then be applied 
to the available events.

Filters are specified by individual users for use locally in their own Event 
Browser. A user-configured filter is available only to the user under which it 
was configured.
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Filter Application
You can create filters for use in the Event Browser, the Closed Events 
Browser, and many Operations Management administration areas. Most 
filters are dedicated to the browser or manager for which they are 
configured. You can apply a different filter for each instance of a 
perspective. Filters defined for the Event Browser are also available in the 
Closed Events Browser and vice versa.
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Tasks

How to Filter Events by Views 

In this task, you learn how to filter the events displayed in the Event 
Browser according to a view. Only events related to configuration item 
included in the selected view appear in the Event Browser.

To filter events by Views:

 1 Start the Event Perspective or Health Perspective:

Applications > Operations Management > <select a perspective> 

 2 In the Browse Views tab of the Model Explorer, use the view list to select a 
view to apply.

The events displayed in the Event Browser are limited to events associated 
with the selected view. 

Note: The View filter is combined with the currently applied event filter.

To disable filtering by views, click the Enable/Disable View Filtering  
toggle button.
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How to Filter Events by Configuration Items 

In this task, you learn how to filter the events displayed in the Event 
Browser by configuration item. Only events related to the selected 
configuration item appear in the Event Browser.

To filter events by configuration item:

 1 Start a perspective containing an Event Browser and a Model Explorer, for 
example, the Event Perspective or the Health Perspective:

Applications > Operations Management > <select a perspective> 

In the Browse Views tab of the Model Explorer, use the view list to select 
a view to apply.

 2 Select one or more configuration items, CI collections, or a combination 
of both from the Model Explorer pane to use as an event filter.

 3 Enable CI Filtering . Displays all events selected by the active filter for 
the selected CI. The events displayed in the Event Browser are limited to 
events associated with the selected configuration item.

Alternatively, enable CI Filter (include events for child CIs) . Displays 
all events selected by the active filter for the selected CI and all its child 
CIs.

Note: The CI filter is combined with the currently applied event filter. 

To disable filtering by CIs, click the Disable CI Filter  button.
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How to View and Apply Event Filters   

In this task, you learn how to display a list of configured event filters and 
apply one to the Event Browser.

To view a list of configured event filters:

 1 Start a perspective containing an Event Browser and a Model Explorer, for 
example, the Event Perspective or the Health Perspective:

Applications > Operations Management > <select a perspective> 

Select a filter from the Filter list.

 2 Alternatively, in the Event Browser, click the Event Filter  button. The 
Select an Event Filter dialog box opens containing a list of available event 
filters.

Note: The contents of the list of event filters displayed in the Select an 
Event Filter are user specific. The list contains only event filters that the 
active user has configured.

 3 Select the event filter you want to apply.

 4 Optional: Open the Filter Configuration dialog box using the Edit Item  
button and modify the selected filter and click OK.

 5 Click OK to enable the selected event filter.

Enabling a filter updates the contents of the browser immediately.

 6 If the selected filter does not display the results you require, redefine the 
selected event filter or select an alternative event filter.

Note: If you want to clear the selected filter, select No Filter from the filter 
selection box. Deleting the filter selected in the Event Browser from the 
list of filters automatically applies no filter to the Event Browser.
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How to Define Simple Event Filters 

In this task, you learn how to set up a Simple Filter for the Event Browser or 
the Closed Event Browser using the Filter Configuration dialog box.

To define an event filter:

 1 From the Event Browser or the Closed Event Browser, open the Select an 
Event Filter dialog box using the Event Filter  button.

Note: The Select an Event Filter dialog box is also available using the 
Manage Event Filters (...) button in the New and Edit dialog boxes of the 
Administration managers.

 2 From the Select an Event Filter dialog box, open the Filter Configuration 
dialog box using the New Item  button and select Simple Filter.

The Filter Configuration dialog box opens.

 3 Enter a name and description for the new filter.

 4 Use the displayed tabs to configure the new filter (General, Dates, and 
Additional Event Properties).

In the Filter Configuration dialog box, if any one of the selected criteria 
within a frame is true, for example, Severity of the event is Critical, the 
event is selected by the filter.

All selections in the frames themselves and the other filter criteria, for 
example, Severity is Critical and Assigned to is Me, must be matched by 
the event for it to be selected by the filter.
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For example, if the severities Critical and Major are selected within the 
same pane, events exhibiting either severity are displayed. If the 
assignment Not assigned is also selected from another pane, only events 
not assigned to a user and exhibiting one of the selected severities are 
displayed.

 5 Optional: Select Convert to Advanced to switch to the advanced filter 
definition mode and further tailor your filter. For details, see "How to 
Define Advanced Event Filters" on page 224.



Chapter 7 • Filtering Events

223

Note: An Advanced Filter cannot be converted back to a Simple Filter.

 6 Select OK to save the changes.

The Filter Configuration dialog box closes and the new event filter is 
added to the list of filters in the Select an Event Filter dialog box.

 7 Optional: Select the newly created event filter and click the Find Matching 
Events  button. This opens a new Event Browser window, displaying 
the results of applying the newly defined filter. If the filter does not 
display the results you require, redefine the filter.

For details of the Filter Configuration dialog box, see "Simple Filter 
Configuration Dialog Box" on page 231.
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How to Define Advanced Event Filters 

In this task, you learn how to set up an advanced event filter for the Event 
Browser or the Closed Event Browser using the Filter Configuration dialog 
box.

To define an advanced event filter:

 1 From the Event Browser or the Closed Event Browser, open the Select an 
Event Filter dialog box using the Event Filter  button.

Note: The Select an Event Filter dialog box is also available using the 
Manage Event Filters (...) button in the New and Edit dialog boxes of the 
Administration managers.

 2 From the Select an Event Filter dialog box, open the Filter Configuration 
dialog box using the New Item  button and select Advanced Filter.

The Filter Configuration dialog box opens.

Note:  Alternatively, select Simple Filter and the Use the displayed tabs to 
make any suitable Simple configurations for the new filter (General, 
Dates, and Additional Event Properties). These configurations become the 
starting point for the advanced filter configuration after selecting Convert 
to Advanced and switching to the Advanced Filter definition mode. For 
details, see "How to Define Simple Event Filters" on page 221.

 3 Enter a name and description for the new filter.

 4 Optional: If you started with a Simple Filter, select Convert to Advanced to 
switch to the advanced filter definition mode.
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The Advanced Mode enables you to very precisely specify filters using a 
combination of operators, properties, and expressions.

Note: Advanced Filters cannot be displayed in the Simple Filter view and 
it is not possible to switch to the Simple Filter view form the Advanced 
Filter view.
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 5 Start assembling a filter by dragging properties and operators to the Filter 
Definition pane, for example, Description. Alternatively, select elements or 
operators and add them to the active filter specification using the Add  
button.

The Edit Expressions dialog box opens containing an editor specific to the 
selected property type.

 6 There are two basic types of Edit Expressions dialog boxes: string filters 
and pre-specified filters

➤ Defining a string filter:

Select a matching criteria for the selected property, for example, 
contains and specify a text string to search for.

The matching criteria matches and not matches are used for specifying 
regular expressions providing you with a very powerful filtering tool.

Note: Processing filters containing regular expressions requires higher 
resources than for filters without them and it is recommended that 
regular expressions are used only when a simpler alternative is not 
possible.

Optional: Select ignore case to make the expression case-insensitive.

➤ Defining a pre-specified filter:

Pre-specified filters are used to select attributes which have a known 
range of values, for example, severities, priorities, lifecycle states, and 
dates.

Select a matching criteria for the selected property, for example, 
equals, one of, is true, before, not older than, and, where appropriate, 
select one or more of the available options, for example, severity 
values, priority values, dates and times, or lifecyle states.

 7 Select OK to close the Edit Expression dialog box.

 8 Repeat steps 5 to 7 to specify additional filtering components to the filter 
specification.
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If you want to change an entry, double-click it. The Edit Expression 
window opens from which you can change the specification of the 
expression.

 9 Select OK to save the changes.

The Filter Configuration dialog box closes and the new event filter is 
added to the list of filters in the Select an Event Filter dialog box.

 10 Optional: Select the newly created event filter and click the Find Matching 
Events  button. This opens a new Event Browser window, displaying 
the results of applying the newly defined filter. If the filter does not 
display the results you require, redefine the filter.

For details of the Filter Configuration dialog box, see "Simple Filter 
Configuration Dialog Box" on page 231.
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Filter Manager User Interface

The Select an Event Filter and Manage Event Filters dialog boxes display a 
list of the filters that are configured by the active user for the current 
browser or manager. You can select a filter from the list of configured event 
filters and apply it, edit or delete an existing filter, or create and test a new 
filter.

Further filtering interface elements are described in detail in the following 
topics:

➤ Select an Event Filter and Manage Event Filters Dialog Boxes on page 229

➤ Simple Filter Configuration Dialog Box on page 231

➤ Advanced Filter Configuration Dialog Box on page 237

➤ Edit Expression Dialog Boxes for Advanced Filters on page 244

➤ Operators Used in Filter Configuration Dialog Boxes on page 250



Chapter 7 • Filtering Events

229

Select an Event Filter and Manage Event Filters Dialog 
Boxes

The Select an Event Filter and Manage Event Filters dialog boxes display the 
UI elements listed in the following table.

 

To access Select Applications > Operations Management > <select a 
perspective> and open the Select an Event Filter dialog 
box using the Event Filter  button.

Relevant tasks To filter events, see:

➤ "How to Filter Events by Views" on page 218.

➤ "How to Filter Events by Configuration Items" on 
page 219.

➤ "How to View and Apply Event Filters" on page 220.

➤ "How to Define Simple Event Filters" on page 221.

➤ "How to Define Advanced Event Filters" on page 224.

See also For more information about filtering events, see 
"Filtering Methods" on page 212 and "Event Filters" on 
page 215.

UI Element (A-Z) Description

Synchronizes the filter data displayed in the list of available 
filters with the latest information available in the database.

Opens the selection box from which you can select the type 
of filter that you want to specify: Simple Filter or Advanced 
Filter. The Filter Configuration dialog box opens, from 
which you can create and define a new event filter.

Click OK to save the new filter.

Creates a copy of the selected filter and opens the Filter 
Configuration dialog box.

Opens the Filter Configuration dialog box for the selected 
event filter from which you can modify the selected event 
filter.

Click OK to save the modifications to the selected event 
filter.
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Opens the Delete Event Filter dialog box for the selected 
event filter.

Click Yes to delete the selected filter annotation.

Displays events that match the selected filter in an Event 
Browser pop-up window. Useful for testing an event filter 
before applying it to the Event Browser.

UI Element (A-Z) Description
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Simple Filter Configuration Dialog Box

The Simple Filter Configuration dialog box displays the attributes that you 
can use either individually or in combination to filter events before 
displaying them.

For more information about the information displayed in the Filter 
Configuration tabs, see the following sections:

➤ "Common Buttons and Icons" on page 232

➤ "General Tab" on page 232

➤ "Dates Tab" on page 234

➤ "Additional Event Properties Tab" on page 235

To access Select Applications > Operations Management > <select a 
perspective> and open the Select an Event Filter dialog 
box using the Event Filter  button.

Relevant tasks To filter events, see:

➤ "How to Filter Events by Views" on page 218.

➤ "How to Filter Events by Configuration Items" on 
page 219.

➤ "How to View and Apply Event Filters" on page 220.

➤ "How to Define Simple Event Filters" on page 221.

➤ "How to Define Advanced Event Filters" on page 224.

See also For more information about filtering events, see 
"Filtering Methods" on page 212 and "Event Filters" on 
page 215.
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Common Buttons and Icons 
The Filter Configuration window includes the UI elements listed in the 
following table. 

General Tab 

The General tab in the Filter Configuration dialog box displays the UI 
elements listed in the following table.

UI Element (A-Z) Description

Convert to Advanced Opens the Advanced Mode used to define more 
comprehensive filters. For details, see "How to Define 
Advanced Event Filters" on page 224.

Note: Advanced filters cannot be displayed in the Simple 
Filter view.

UI Element (A-Z) Description

Assigned To User or user group to whom the events you want to find 
are assigned. Multiple assignments can be selected. For 
example, you can select Assigned To Me and Not 
Assigned.

Category Category of event that you want to use as a filter option, 
for example: DB, Storage, System, or WebApp.

Correlation Select the desired option to search for all events, only top 
level events, or only cause events:

All events: All events, which includes events correlated 
as symptoms of other events.

All top level events: All events that not classified as 
symptom of another event.

All cause events: All events that are root cause events. 
They cannot be symptoms of another cause event.

Description Description of an event as displayed in the contents of 
the original event’s description field.
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Lifecycle State Stage in the problem lifecycle that the events you are 
looking for have reached, for example: Open, In Progress, 
Resolved or Closed. Multiple lifecycle states can be 
selected.

Priority Searches for events that match the specified priorities, for 
example: None, Low, or Medium. Multiple priorities can 
be selected.

Severity Selects an event severity to use as a filter option. Multiple 
severities can be selected.

Subcategory Name of the event subcategory to which the events you 
are looking for belong.

Title Title of the events you are looking for.

Type Type of event you want to display with the filter.

UI Element (A-Z) Description
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Dates Tab 

The Dates tab in the Filter Configuration dialog box displays the UI 
elements listed in the following table.

UI Element (A-Z) Description

Absolute Time Specifies the date and time in absolute (calendar) terms. 
A time can be specified by entering a calendar date, and 
time values for hours and minutes.

Relative Time Specifies a point in time used to filter events. Events 
either before or after the specified time can be selected 
using operators such as:

➤ older than

➤ not older than

The time period can be specified in minutes, hours, days, 
or weeks. 

Note: The Event Browser is dynamically updated. Events 
that no longer match a relative time filter are removed 
from the Event Browser and new events that match are 
added.

Time Created Specifies the dates and times between which the events 
you are searching for occurred.

Time Lifecycle State 
Changed

Date and time when the last lifecycle state change took 
place.

Time Received Specifies the dates and times between which Operations 
Management first received notification of the events you 
are searching for.
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Additional Event Properties Tab 

The Additional Event Properties tab in the Filter Configuration dialog box 
displays the UI elements listed in the following table.

UI Element (A-Z) Description

Application Selects events linked to the named application.

CI Type Selects the option to search for events that are related to 
the specified CI type or are a child of the specified CI 
type. The dedicated operators for filtering CI types are:

➤ equals: Related CI matches a specified CI type 

➤ is derived from: Related CI is derived from the 
specified CI type

Custom Attribute Selects the Custom Attributes editor where you can 
specify a custom attribute, an operator, and a value for 
use in filtering.

You define a custom attribute filter by specifying the 
name of the custom attribute in the field on the left, 
selecting a filter matching criteria from the list, and 
specifying the value of the custom attribute in the field 
on the right.

Note: In the Advanced mode, You can add further 
custom attribute specifications. These can be related 
using any of the available operators.

Key Selects events that contain a reference to the named key.

Object Selects events that are related to a named object, as 
specified in the original HPOM message.
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Original Data Original event text as captured from HPOM agents before 
being formatted into an HPOM message.

Contains information about the original input before 
being normalized by HPOM agent policies into a 
message. Typically, the information available includes 
node name, message group, application, object, severity, 
and message text.

Solution A text field used to describe the solution steps taken to 
solve the problem identified by the event. 

Solution texts can be synchronized with external 
managers such as Service Manager.

UI Element (A-Z) Description
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Advanced Filter Configuration Dialog Box

The Advanced Filter Configuration dialog box displays the attributes that 
you can use either individually or in combination to filter events before 
displaying them.

For more information about the information displayed in the Filter 
Configuration tabs, see the following sections:

➤ "Advanced Filter Configuration" on page 238

➤ "General Filter Elements" on page 239

➤ "Dates Filter Elements" on page 240

➤ "Additional Event Properties Filter Elements" on page 241

➤ "Advanced Properties Filter Elements" on page 242

To access Select Applications > Operations Management > <select a 
perspective> and open the Select an Event Filter dialog 
box using the Event Filter  button.

Relevant tasks To filter events, see:

➤ "How to Filter Events by Views" on page 218.

➤ "How to Filter Events by Configuration Items" on 
page 219.

➤ "How to View and Apply Event Filters" on page 220.

➤ "How to Define Simple Event Filters" on page 221.

➤ "How to Define Advanced Event Filters" on page 224.

See also For more information about filtering events, see 
"Filtering Methods" on page 212 and "Event Filters" on 
page 215.
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Advanced Filter Configuration 

The filter matching criteria lists display the UI elements listed in the 
following table.

UI Element (A-Z) Description

Opens the Edit Expression dialog box for the selected 
event filter element from which you can modify the 
selected event filter element.

Click OK to save the modifications to the selected event 
filter element.

Deletes the selected event filter element from the selected 
event filter specification.

Toggles between full view and compact view of the filter 
specification.

Adds a new element and opens the Expression dialog box 
for the newly added element.

Edit Expression Dialog boxes used to specify filter component definitions 
that describes, for example, what values of a selected 
attribute is included in the filter definition. For examples 
of Edit Expression dialog boxes, see "Edit Expression 
Dialog Boxes for Advanced Filters" on page 244.

Filter Definition Contains the components chosen to define the filter. 
Properties are associated with a value and are connected 
using operators.

Filter Elements Contains the available operators and properties used to 
specify an advanced filter. Drag each required property or 
operator to the filter definition pane and drop it in its 
logical location in the filter. To edit and delete entries 
from the filter definition, use the buttons or double-click 
the expression that you want to change.
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General Filter Elements 

The General tab in the Filter Configuration dialog box displays the UI 
elements listed in the following table.

UI Element (A-Z) Description

Assigned To User or user group to whom the events you want to find 
are assigned. Multiple assignments can be selected. For 
example, you can select Assigned To Me and Not 
Assigned.

Category Category of event that you want to use as a filter option, 
for example: DB, Storage, System, or WebApp.

Correlation Select the desired option to search for all events, only top 
level events, or only cause events:

All events: includes events correlated as symptoms of 
other events.

All top level events: includes all events that do not have 
a cause assigned.

All cause events: includes all events that are root cause 
events. They cannot be symptoms of another cause 
event.

Description Description of an event as displayed in the contents of 
the original event’s description field.

Lifecycle State Stage in the problem lifecycle that the events you are 
looking for have reached, for example: Open, In Progress, 
Resolved or Closed. Multiple lifecycle states can be 
selected.

Priority Searches for events that match the specified priorities, for 
example: None, Low, or Medium. Multiple priorities can 
be selected.

Severity Selects an event severity to use as a filter option. Multiple 
severities can be selected.

Subcategory Name of the event subcategory to which the events you 
are looking for belong.
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Dates Filter Elements 

The Dates tab in the Filter Configuration dialog box displays the UI 
elements listed in the following table.

Title Title of the events you are looking for.

Type Type of event you want to display with the filter.

UI Element (A-Z) Description

<Absolute Time> Specifies the date and time in absolute (calendar) terms. 
A time can be specified by entering a calendar date, and 
time values for hours and minutes.

<Relative Time> Specifies a point in time used to filter events. Events 
either before or after the specified time can be selected 
using operators such as:

➤ older than

➤ not older than

The time period can be specified in minutes, hours, days, 
or weeks. 

Note: The Event Browser is dynamically updated. Events 
that no longer match a relative time filter are removed 
from the Event Browser and new events that match are 
added.

Time Created Specifies the dates and times between which the events 
you are searching for occurred.

Time Lifecycle State 
Changed

Date and time when the last lifecycle state change took 
place.

Time Received Specifies the dates and times between which Operations 
Management first received notification of the events you 
are searching for.

UI Element (A-Z) Description
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Additional Event Properties Filter Elements 

The Additional Event Properties tab in the Filter Configuration dialog box 
displays the UI elements listed in the following table.

UI Element (A-Z) Description

Application Selects events linked to the named application.

CI Type Selects the option to search for events that are related to 
the specified CI type or are a child of the specified CI 
type. The dedicated operators for filtering CI types are:

➤ equals: Related CI matches a specified CI type 

➤ is derived from: Related CI is derived from the 
specified CI type

Custom Attribute Selects the Custom Attributes editor where you can 
specify a custom attribute, an operator, and a value for 
use in filtering.

You define a custom attribute filter by specifying the 
name of the custom attribute in the field on the left, 
selecting a filter matching criteria from the list, and 
specifying the value of the custom attribute in the field 
on the right.

Note: In the Advanced mode, You can add further 
custom attribute specifications. These can be related 
using any of the available operators.

Key Selects events that contain a reference to the named key.

Object Selects events that are related to a named object, as 
specified in the original HPOM message.
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Advanced Properties Filter Elements 

The Additional Properties tab in the Filter Configuration dialog box displays 
the UI elements listed in the following table.

Original Data Original event text as captured from HPOM agents before 
being formatted into an HPOM message.

Contains information about the original input before 
being normalized by HPOM agent policies into a 
message. Typically, the information available includes 
node name, message group, application, object, severity, 
and message text.

Solution A text field used to describe the solution steps taken to 
solve the problem identified by the event. 

Solution texts can be synchronized with external 
managers such as Service Manager.

UI Element (A-Z) Description

Assigned User Selects events that are assigned or not assigned to a user, 
or assigned to the specified user.

Assigned Workgroup Selects events that are assigned or not assigned to a 
group, or assigned to the specified group.

Automatic Action 
State

Selects events that exhibit any of the specified Automatic 
Action States. The possible states are:

➤ Available

➤ Running

➤ Success

➤ Failed

➤ Not Available

CI Resolution Quality 
Measure

Selects events with the specified CI Resolution Quality 
Measure.

CI Resolution Success 
Status

Selects events with the specified CI Resolution Success 
Status.

UI Element (A-Z) Description
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Control Transferred Selects events for which control was transferred to an 
external server or not transferred to an external server.

ETI Resolution Hint Selects events with the specified ETI Resolution Hint.

External ID Selects events with the specified External ID.

Received During 
Downtime

Selects events which were received during downtime or 
not received during downtime.

Related CI Hint Selects events with the specified Related CI Hint.

User Action State Selects events that exhibit any of the specified User 
Action States. The possible states are:

➤ Available

➤ Running

➤ Success

➤ Failed

➤ Not Available

UI Element (A-Z) Description
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Edit Expression Dialog Boxes for Advanced Filters 

The Advanced Filter Configuration dialog box includes edit expression 
dialog boxes dedicated to types of expressions being specified. The follow 
sections describe these edit expression dialog boxes.

For more information about the edit expression dialog boxes, see the 
following sections:

➤ "Attributes Included in a Preconfigured List" on page 245

➤ "Attributes Identified by a Text String" on page 245

➤ "Custom Attributes" on page 246

➤ "Events Selected by Dates" on page 247

➤ "CI Type" on page 247

➤ "Attribute Selection from a List" on page 248

➤ "Numerical Values" on page 248

➤ "True or False" on page 249

To access Select Applications > Operations Management > <select a 
perspective> and open the Select an Event Filter dialog 
box using the Event Filter  button.

Relevant tasks To filter events, see:

➤ "How to Filter Events by Views" on page 218.

➤ "How to Filter Events by Configuration Items" on 
page 219.

➤ "How to View and Apply Event Filters" on page 220.

➤ "How to Define Simple Event Filters" on page 221.

➤ "How to Define Advanced Event Filters" on page 224.

See also For more information about filtering events, see 
"Filtering Methods" on page 212 and "Event Filters" on 
page 215.
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Attributes Included in a Preconfigured List 

This Edit Expression dialog box is used to typically select a combination of 
attributes, for example, events assigned to the current user and events not 
assigned to any user. 

Select one or more of the available event attributes that you want to include 
in your list of events.

Attributes Identified by a Text String

This Edit Expression dialog box is used to typically select an attribute with a 
specified relationship to its value, for example, events with the Category 
value equal to database, where the selection is insensitive to case. 
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For the selected attribute, enter a text string to search for and select an 
operator to establish the relationship between the attribute and its value. 
For a description of the available operators, see "Text Operators" on 
page 251.

Select ignore case to search for all forms of the specified text.

Custom Attributes

This Edit Expression dialog box is used to select an custom attributes with a 
specified relationship to its value, for example, events including the Custom 
Attribute ForwardToTroubleTicket with value equal to true, where the 
selection is insensitive to case. 

For the specified custom attribute, enter a text string for the attribute value 
to search for and select an operator to establish the relationship between the 
custom attribute and its value. For a description of the available operators, 
see "Text Operators" on page 251.

Select ignore case to search for all forms of the specified text.
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Events Selected by Dates

This Edit Expression dialog box is used to select events depending on when 
they were, created, received, or when their lifecycle state changed. In this 
example, events created longer than 4 hours ago are selected. 

For the selected attribute, enter a time and an operator to be used to identify 
the appropriate events. For a description of the available operators, see "Date 
Operators" on page 250.

CI Type

This Edit Expression dialog box is used to select events related to the 
specified CI type or related to a CI type derived from the specified CI type. 
In this example, events with a CI type derived from the CI type Computer 
are selected. 

Select a CI type from the Select a CI Type dialog box (...) and select an 
operator (equals or derived from).

➤ equals: Related CI matches a specified CI type 

➤ is derived from: Related CI is derived from the specified CI type
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Attribute Selection from a List

This Edit Expression dialog box is used to typically select one attribute from 
a predefined list, for example, events assigned to a specified workgroup. 

Select one event attributes that you want to include in your list of events, 
and, if necessary, specify the value of the attribute, for example, the 
workgroup called Administrators.

Numerical Values

This Edit Expression dialog box is used to typically select an attribute with a 
specified relationship to its numerical value, for example, events with the 
value of the CI Resolution Quality Measure equal to or greater than 3. 

Select a value for the event attributes and select an operator to establish the 
relationship between the event attribute and its value. For a description of 
the available operators, see "Numerical Operators" on page 250.
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True or False

This Edit Expression dialog box is used to typically select the true or false 
attribute value for the event attribute being configured, for example, 
Control Transferred is False. 

Select true or false for the event attribute being configured.
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Operators Used in Filter Configuration Dialog Boxes

The Advanced Filter Configuration dialog boxes supports the operators 
listed in the following tables:

➤ "Date Operators" on page 250

➤ "Numerical Operators" on page 250

➤ "Text Operators" on page 251

➤ "True-False Operators" on page 252

Date Operators
The following table lists the operators for use in date expressions.

Numerical Operators
The following table lists the operators for use in numerical expressions.

Operators (A-Z) Description

After When specifying absolute times, selects events that have 
a timestamp more recent than the specified time.

Before When specifying absolute times, selects events that have 
a timestamp older than the specified time.

not older than When specifying relative times, selects events that have a 
timestamp more recent than the selected time point, for 
example, not older than one day.

older than When specifying relative times, selects events that have a 
timestamp less recent than the selected time point, for 
example, older than one day.

Operators Description

= Displays any event that has a value of the selected 
attribute that is identical to the specified value.

< Displays any event that has a value of the selected 
attribute that is less than the specified value.



Chapter 7 • Filtering Events

251

Text Operators
The following table lists the operators for use in text expressions.

<= Displays any event that has a value of the selected 
attribute that is lower than or identical to the specified 
value. For example, selecting the value 33, for CI 
Resolution Quality Measure displays all events with CI 
Resolution Quality Measure below 33% 

> Displays any event that has a value of the selected 
attribute that is greater than the specified value.

>= Displays any event that has a value of the selected 
attribute that is higher than or identical to the specified 
value. For example, selecting the value 50, for CI 
Resolution Quality Measure displays all events with CI 
Resolution Quality Measure values above 50%. 

Operators (A-Z) Description

contains Displays any event that contains a reference to the 
specified string in the selected attribute. For example, 
searching for any string that contains database returns:

➤ database

➤ database status

➤ Oracle Database status

equals Displays any event that has an attribute or attribute value 
that is identical to the specified string. For example, 
searching for events of a category type that equals 
database returns events of the following category:

➤ database

matches Displays any event that matches the specified regular 
expression.

Processing filters containing regular expressions requires 
higher resources than for filters without them and it is 
recommended that regular expressions are used only 
when a simpler alternative is not possible.

Operators Description
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True-False Operators
The following table lists the operators for use in true and false expressions.

not contains Displays any event that does not contain a reference to 
the specified string in the selected attribute. Searching for 
a string that does not contain database returns all strings 
except those containing database, for example:

➤ Blue moon

➤ Almost everything else

not equals Displays any event that has an attribute that is not 
identical to the specified string. For example, searching 
for events of a category that does not equal database 
returns events with categories that are not identical to 
database, returns event attributes such as:

➤ Storage

➤ DB

➤ Network

not matches Displays any event that does not match the specified 
regular expression.

Processing filters containing regular expressions requires 
higher resources than for filters without them and it is 
recommended that regular expressions are used only 
when a simpler alternative is not possible.

Operators (A-Z) Description

False Used to set an attribute not to be matched.

True Used to set an attribute to be matched.

Operators (A-Z) Description
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Troubleshooting and Limitations 

This section provides help for those people who are troubleshooting 
problems relating to Operations Management event filters, including 
creating, modifying, and enabling filters.

➤ "Filters Not Available in Event Filter List" on page 253

➤ "Events Not Visible" on page 253

Filters Not Available in Event Filter List

➤ Filter does not belong to active user.

➤ Filters are only available for the area for which they are created. For 
example, an Event Browser filter is not available in the Closed Events 
Browser.

Events Not Visible

➤ Make sure that the correct filter is enabled.

➤ Make sure that the currently enabled filter is correctly configured.

➤ Make sure that the currently applied CI or View does not filter out events 
that you want to see.
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8
Views for Operations Management

This chapter includes:

Concepts

➤ Views on page 256

➤ View Mapping on page 257

Tasks

➤ How to Select a View on page 258

Reference

➤ Model Explorer Pane on page 259
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Concepts

Views 

This chapter describes the main concepts of views. The ConfigurationItem 
model in the configuration management database can be very large, holding 
thousands of configuration items (CIs). A view enables you to build a subset 
of the overall ConfigurationItem model, containing only those CIs relating 
to a specific area of interest. You can define your own views to display only 
the information that is relevant to your organization's business needs.

Views for Operations Management help you to limit the configuration items 
displayed in the Model Explorer. Operations Management filters the 
contents of the Event Browser in the Event Perspective and the Health 
Perspective according to the selected configuration items. 

To configure and modify views, use the Modeling Studio:

Admin > RTSM Administration > Modeling > Modeling Studio 

Operations Management Content Packs provide views that group 
configuration items into sets that help you to perform your tasks more 
efficiently. You can modify existing (or configure new) views to change, 
increase, or decrease the amount and type of information displayed. You can 
exchange the views between instances of Operations Management using the 
Import and Export features of the Content Packs manager.

Note: You can use views to limit the contents of the CI Tree. Selecting a 
configuration item from the CI Tree restricts the contents of the Event 
Browser to events related to that configuration item only.

To learn how to display a complete list of the Operations Management 
views, see "How to Select a View" on page 258. For more information about 
the CI Tree, see "Model Explorer Pane" on page 259.
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View Mapping 

A view displays a subset of the overall ConfigurationItem model, for 
example, only those CIs that relate to a specific area of interest. Selecting a 
view enables you to refine both the type and the amount of information 
displayed, for example, in the CI Tree or the Health Top View pane.

You can map views to configuration item types. The mapped views appear 
in the Selected Views list displayed in the Health Top View pane of the 
Health Perspective tab. For more information about the contents of the 
Health Top View pane and the Selected Views list, see "Health Top View" on 
page 135.

You can exchange the view mappings that you configure between instances 
of Operations Management using the Import and Export features of the 
Content Packs manager.

Note: Only users with the appropriate access permissions can use the 
Administration features.

To learn how to display a complete list of the Operations Management 
views, see "How to Select a View" on page 258. For more information about 
the CI Tree, see "Model Explorer Pane" on page 259.
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Tasks

How to Select a View

You can use views to configure the Model Explorer to display any 
combination of the available configuration items. The following steps 
explain how to select a view from the drop-down list of views available.

Note: For information about button actions, see "Model Explorer Pane" on 
page 259. 

To display a list of views:

 1 Open the Event Perspective or the Health perspective to display the list of 
known events:

Applications > Operations Management > <select a perspective> 

In the Model Explorer pane, select the Browse Views tab.

 2 Use the View list to display the available views and select the required 
view.

Entering a character in the View field highlights the first matching view 
name.
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Reference

Model Explorer Pane 

The Model Explorer displays an overview of the configuration items (CIs) 
stored in the RTSM. Displaying the CIs in a tree enables you to browse and 
locate them more easily. 

You can use views to configure the Model Explorer to display any 
combination of the available configuration items. You can also highlight 
configuration items that match a specific pattern or search through the 
database to locate individual or groups of configuration items.

The Model Explorer contains tabs that enable you to browse and search 
through views of the RTSM.
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9
Introduction and Overview

The information in this section describes how to configure Operations 
Management.

This chapter includes:

➤ Licensing on page 263

➤ How This Section Is Organized on page 265

➤ Who Should Read This Section on page 268

Licensing

BSM Operations Management is available with an HP Business Service 
Management (BSM) deployment with an active Operations Manager i (OMi) 
license. 

If no OMi license is installed, or if you are using the 60-day evaluation 
license, BSM Operations Management is not enabled. Only the event 
channel features are enabled, for example:

➤ CI Resolution

➤ ETI Resolution by ETI Hint

➤ Event Forwarding

➤ Event Notifications

➤ Health Indicator Updates

➤ Event Reconciliation
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The Operations Manager i (OMi) licensing structure is as follows:

➤ Event Management Foundation license only

The Event Management Foundation license is required for BSM 
Operations Management functionality.

BSM Operations Management functionality includes:

➤ ETI Resolution by ETI Rule

➤ Event Store in the RTSM

➤ User and Group Assignments

➤ Automatic Closing of Events

➤ Duplicate Event Suppression

➤ KPI Calculation

➤ EPI Scripts Management

➤ Topology Discovery

➤ Graphing

➤ Event Synchronization

➤ Event Priorities

➤ ETI Mapping

➤ Downtime Management

➤ Topology-Based Event Correlation License 

The Topology-Based Event Correlation license is required for the 
topology-based event correlation (TBEC) functionality. The TBEC license 
builds on the Event Management Foundation license.

➤ Target Connector License

A Target Connector license is required for each node managed by a 
third-party (non-HP) management solution, where events are 
consolidated in BSM Operations Management. For example, if a Microsoft 
SCOM system is connected to BSM Operations Manager, and manages 20 
nodes, you require 20 target connector licenses.
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Note: For licensed HP management products, such as HP Operations 
Manager (HPOM) for Windows, HPOM agents, or HP SiteScope, no 
additional target connector licenses are required.

A Target Connector license builds on the Event Management Foundation 
license.

How This Section Is Organized

This part of the guide contains the following chapters:

Chapter 9 Introduction and Overview

The information in this chapter introduces you to the topics covered in 
Part 2 of this guide, which describes more advanced use of Operations 
Management, including software configuration and administration.

Chapter 10 Tools

This chapter provides information that helps you understand how to 
configure and manage the User Tools.

Chapter 11 Performance Graphs

This chapter describes the Performance Graphs Manager used to configure 
the mapping of CI types to available graph families.

Chapter 12 Indicator Mapping Rules

This chapter introduces the Indicators manager. You learn how to configure 
event type indicators, health indicators and key performance indicators to 
provide information for Views, which Operations Management operators 
can use to pinpoint problems in the monitored IT environment.
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Chapter 13 View Mappings

This chapter describes the View Mappings manager used to map existing 
Views to one or more configuration item types and manage the mapped 
Views. The information provided aims to help you understand how to use 
the View Mappings manager to configure and manage Operations 
Management Views, and exchange them between management servers.

Chapter 14 Correlation Rules

This chapter introduces the Correlation Rules manager, used for configuring 
topology-based event correlation. You learn how to configure correlation 
rules and apply them to health indicators to help you better understand, 
monitor, and manage the problems that have an affect on the objects in 
your IT environment.

Chapter 15 Connecting Servers

This chapter describes how to specify HP Operations Manager servers, 
external event processing servers, and other Operations Management (BSM) 
servers as event forwarding targets.

Connected servers are used in conjunction with event forwarding rules to 
redirect selected events to specific event managers.

Chapter 16 Event Forwarding to External Servers

This chapter describes how to set up rules to select and forward events to 
external event managers such as another BSM server, HP Operations 
Manager and or a help desk application.

Chapter 17 Time-Based Event Automation

This chapter describes how to configure the rules for automating event 
handling to execute actions on events matching a user-defined set of criteria 
after a specified time.

Chapter 18 Launching Run Books Automatically

This chapter describes how to configure the rules used to automatically run 
a Run Book or a series of Run Books in the context of an event.
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Chapter 19 Event Automation Script Configuration

This chapter describes how to set up scripts that can be used in Time-based 
Event Automation. For example, you can add a text string to certain events 
to make them easier to identify in the Event Browser.

Chapter 20 Notifications

This chapter describes how to set up rules to notify people who are located 
remotely when events with predefined characteristics are received. 
Notifications can take the form of Emails, SMSs and Pager messages

Chapter 21 Downtime Configuration

This chapter describes how to configure Operations Management to manage 
the events received from CIs which were in downtime (configuration of CIs 
specifying periods of unavailability due to predetermined maintenance 
times).

Chapter 22 Custom Actions

This chapter describes how to set up scripts to run custom actions on events. 
For example, you can add a text string to certain events to make them easier 
to identify in the Event Browser.

Chapter 23 Advanced Event Automation

This chapter describes how to automate handling and processing of 
incoming events.

Chapter 24 Event Assignment

This chapter describes how to automatically assign incoming events to 
available user groups. Automatic assigning of events to user groups 
responsible for solving these event significantly improves the efficiency of 
event management. Each events is assigned to an appropriate user group as 
soon as it is received. All operators in a user group are permitted to work on 
those events assigned to that user group.
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Chapter 25 User Management

This chapter introduces the concept of users, user roles, and user views and 
provides information that helps you understand how to create and manage 
users and groups.

Chapter 26 Auditing in Operations Management

This chapter describes how to audit the configurations of Operations 
Management and monitor changes to those configurations.

Chapter 27 Tracing and Logging Operations Management User Interfaces

This chapter describes how to configure and run logging and tracing of the 
Operations Management user interfaces.

Chapter 28 Topology Synchronization

This chapter describes how to configure and run topology synchronization 
from HP Operations Manager servers to Operations Management.

Chapter 29 Infrastructure Settings for Operations Management

This chapter provides an details of the settings required for Operations 
Management including information that helps you understand how to set 
and configure Operations Management within the BSM platform.

Chapter 30 Content Packs

This chapter introduces Content Packs in Operations Management. Details 
of available content packs are documented at the end of this document. 

Who Should Read This Section

This guide is intended for the following users of Operations Management:

➤ Operations Management software administrators

➤ Operations Management subject matter experts (for example, DB and 
Exchange)
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Users of this section should know about both Operations Management and 
Business Service Management. Users should also possess a good 
understanding of the technical areas they are responsible for (for example, 
databases, or Microsoft Exchange) and know about enterprise monitoring 
and management concepts.
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10
Tools 

This chapter includes:

Concepts

➤ Tools Management on page 272

➤ Tool Creation on page 273

➤ Tool Inheritance on page 274

Tasks

➤ How to View Tools on page 275

➤ How to Search and Filter CI Types on page 275

➤ How to Create Tools on page 278

➤ How to Edit Tools on page 279

➤ How to Define Tool Categories on page 280

Reference

➤ Tools User Interface on page 282

Troubleshooting and Limitations on page 298
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Concepts

Tools Management

You can add your own tools to help users and administrators to perform the 
basic tasks they need to carry out their designated roles. The tools you 
configure with the Tools manager are assigned to a particular configuration 
item type, for example, Node, Router, or Database. You can launch tools 
available for an event from the context menus and the Actions pane of a 
perspective. 

Tool categories are used to grant controlled execution access to tools for 
operators. Each tool is assigned a category, and for operators to be able to 
use the tools with a certain category, they must be granted execution 
permissions for this Tool Category. 

If you want to grant a user access to a specific tool category, you grant 
execution permissions explicitly for that Operations Management tool 
category. If you want to grant access to all tool categories for a user, you 
grant execution permissions for all Operations Management tool categories 
(Tool Categories top-level entry). For more information about user 
authorizations, see "User Management" on page 629.

Note: Only users with the appropriate access permissions can use 
Operations Management Administration. For more information about user 
management, see "User Management" on page 629.
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Tool Creation

Operations Management enables you to create tools to help users to perform 
common tasks on configuration items. When you create a tool, it is 
associated with a configuration item type.

Note: Tools created for a CI type are inherited by all child CI types of that CI 
type.

The following are some examples of typical tools:

➤ Command tool to check the status of an Oracle Database instance. The 
tool is assigned to the configuration item type Oracle Database.

If you are managing multiple versions of Oracle Databases, where the tool 
requires different parameters and options to check the status of the Oracle 
Database processes, you can create copies of the most appropriate tool 
and customize them for the different Oracle versions using the duplicate 
feature. Each tool is then dedicated to a specific version of Oracle.

➤ Command tool to check for firmware updates. The tool is assigned to the 
configuration item type Net Device.

➤ URL tool to search for problems with the operating system running on 
the host system. The tool is assigned to the configuration item type 
Windows (ConfigurationItem > InfrastructureElement > Node > Computer > 
Windows) Using known attributes for the configuration item type Node, 
such as ci.host_os and ci.host_osversion, the tool automatically recognizes 
the type and version of the operating system. You need to only add 
keywords to refine the search. The tool runs the command shown in the 
following example:

http://search.technet.microsoft.com/
Default.aspx?Brand=technet&Query=${ci.host_os} ${ci.host_osversion} ${Additional 
Keywords}
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Tool Inheritance 

When you create tools, you associate them with a particular configuration 
item type, for example, Node or Net Device. When you run a tool, you run it 
from an event that must be associated with the CI type for which the tool is 
specified.

If you configure a tool for a configuration item type, for example, Node, all 
configuration item types below Node in the hierarchy inherit the tool and it 
is also available for the configuration item types, Computer, Mainframe, VAX.

The Tools manager indicates the configuration item type with which a tool 
is associated. The name of the configuration item type is displayed in 
parentheses alongside the tool in the Tools pane, for example: Ping (Node).

For more information about UI elements in the Tools manager, see "Tools 
User Interface" on page 282.
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Tasks

How to View Tools

In this task, you learn how to display a list of the tools configured and 
available for use in your environment.

To view a list of tools:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools

 2 In the CI Types pane, select the configuration item type for which you 
want to view tools. 

The Tools pane displays a list of the tools configured for the selected 
configuration item type.

How to Search and Filter CI Types

In this task, you learn how to search for specific CI types and view CI types 
that match specified filter criteria. There are two filters:

➤ Show only CI types with assigned tools

➤ View (Show CI types contained within a specified view)

Note: Join relationships defined in views are ignored.

For information on button actions, see "Tools User Interface" on page 282. 
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Searching for a CI Type
You can use the Search field to locate the first instance of the CI type name 
or part of a name that you specify.

To search for a specified CI type:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools 

 2 In the Search field, enter a string.

Note: The search string must be at least three characters long. Searching is 
automatically started as soon as the third character is entered and the first 
match is highlighted. This prerequisite avoids searches being started too 
often and resources being blocked. Names with less than three characters 
can be found by clicking on the  button.

The first CI type in the CI Types tree to match the specified string is 
highlighted. If that CI is not initially visible, the CI tree is expanded to 
display the CI Type.

 3 Click the  button to find the next occurrence of the CI Type for which 
you are searching.

Finding CI Types with Assigned Tools
You can use the filter to display all CI types that have content assigned to 
them.

To filter the CI tree to show only CI types with assigned tools:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools 

 2 In the Filter pane, select Show only CI types with assigned tools.

The CI Types pane displays only those CI types that have tools assigned.
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Note: You can use the Show only CI types with assigned tools filter and the 
filtering by a selected view together. The result displays only CI types 
contained within the specified view and with assigned tools.

Filtering the CI Types Tree with a View
You can use the filter to display all CI types that are contained within a 
certain view.

Note: Join relationships defined in views are ignored.

To filter the CI Types tree with a view:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools 

 2 In the Search pane, select View.

The View field becomes active.

 3 Select a view from the list or use the Browse Views (...) button to open the 
Views selection dialog box, select the view that you want to use, and 
select OK.

The CI Types tree is updated to display only the CI types that match the 
view selected.

You can use the Expand ( ) and Collapse ( ) buttons to expand or 
collapse the CI tree. The Expand ( ) button expands all CI types which 
are under the selected CI type. The Collapse ( ) button collapses all open 
nodes except for the selected node.

If no item matches the filter, the No CI type found message is displayed.
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Note: You can use the Show only CI types with assigned tools filter and the 
filtering by a selected view together. The result displays only CI types 
contained within the specified view and with assigned tools.

How to Create Tools 

In this task, you learn how to create a tool and make it available for use in 
your environment.

To create a tool:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools

 2 In the CI Types pane, browse to and select the configuration item type for 
which you want to create a tool.

 3 In the Tools pane, click the  button to open the Create New Tool 
wizard.

 4 Enter a unique tool name, display name, and (optional) a description of 
the function of the tool.

 5 Optional: Select a category for the tool. 

 6 Select a category from the list or use the Browse Views (...) button to open 
the Select a Category dialog box, select the category that you want to use, 
and select OK.

Tool categories are used to group tools that are to be accessible for a 
specific group of users. The Default category is the default selection. If a 
suitable category is not available, you can define a new category using the 

 button in the Select a Category window. For details, see "How to 
Define Tool Categories" on page 280.

 7 Select Next.

 8 Select the type of Tool to be created (Executable, Script, or URL), and select 
Next.
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 9 Complete the subsequent panes, for example:

Script: Script and target panes, and select Finish.

Executable: Command and target panes, and select Finish.

URL: URL pane, and select Finish.

For more information about the buttons, icons, labels, and options in the 
Create New Tool wizard, see "Create New Tool and Edit Tool Dialog Boxes" 
on page 288.

Note: For URLs, you can test your configuration before saving the 
settings.

 10 Select Finish to save your new tool configuration.

How to Edit Tools 

In this task, you learn how to modify an existing tool and make it available 
for use in your environment.

Note: To simplify creating a tool that is similar to an existing tool, you can 
create duplicates of any existing tool using the  button.

To edit a tool:

 1 Open the Tools manager from Operations Management Administration:

Admin > Operations Management > Design Operations Content > Tools

 2 In the CI Types pane, browse to and select the configuration item type for 
which you want to modify an existing tool.

 3 In the Tools pane, click the  button to open the Edit Tool dialog box.

The Edit Tool opens and displays the General Tool Information tab.
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Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Tool dialog box.

 4 Modify the entries in any of the available tabs as required, for example:

Script: Script and target panes.

Executable: Command and target panes.

URL: URL pane.

Note: The maximum script and executable command length is limited to 
2500 characters including resolved parameters.

For more information about the buttons, icons, labels, and options in the 
Create New Tool wizard, see "Create New Tool and Edit Tool Dialog Boxes" 
on page 288.

Note: For URLs, you can test your configuration before saving the 
settings.

 5 Select OK to save your new tool configuration.

How to Define Tool Categories 

In this task, you learn how to define a new tool category and make it 
available for assigning to tools. If you need a new tool category, click the 
Manage Tool Categories  button, or select an existing tool and open the 
edit tool dialog box or use the  button in the Select a Category window.

To define a new tool category:

 1 Open the Tools manager from Operations Management Administration:
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Admin > Operations Management > Design Operations Content > Tools

 2 In the CI Types pane, click the Manage Tool Categories  button.

Alternatively, browse to and select the configuration item type for which 
you want to create a tool or edit an existing tool and the appropriate 
button:  or .

Click the Other category radio button.

Click the Browse (...) button. 

The Select a Category window opens.

 3 Click the  button in the Select a Category window. 

The Create New Tool Category dialog box opens.

 4 Enter a unique tool category name, display name, and a description of the 
requirement for the tool category.

 5 Select OK to save your new tool category.

 6 This category can now be assigned to the selected tool from the Browse 
Tool Categories window.

Note: It is not possible to delete an assigned tool category. Before deleting 
an assigned tool category:

➤ Assign the tool using the unwanted tool category to the default category 
and save the tool.

➤ From the Select a Category Tool dialog box, delete the unwanted tool 
category.
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Reference

Tools User Interface 

This section describes the describes the buttons, icons, labels, and menu 
options in the Tools manager that you use to create the tools.

In this section, you can find information about the following topics:

➤ CI Types Pane on page 282

➤ Tools Pane on page 285

➤ Tool Details Pane on page 286

➤ Create New Tool and Edit Tool Dialog Boxes on page 288

➤ Attribute Selection Dialog Boxes on page 294

CI Types Pane 

The CI Types pane in the Tools manager displays an overview of the 
configuration item types that represent the objects in your IT environment. 
The list includes all default items, any items you modified, and any items 
you added, for example, with additional content packs.

To access Select Admin > Operations Management > Design 
Operations Content > Tools

Important 
information

If you want to modify or manage configuration item 
types, use the CI Types Manager:

Admin > RTSM Administration > Modeling > CI Type 
Manager
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The information displayed in the CI Types pane of the Tools manager 
includes the following details:

Relevant tasks To use the CI Types pane, see "How to Search and Filter 
CI Types" on page 275.

See also For more information about tools, see:

➤ "Tools Management" on page 272.

➤ "Tool Creation" on page 273.

➤ "Tool Inheritance" on page 274.

UI Element (A-Z) Description

Refreshes the contents of the configuration item tree. Use 
if new content becomes available while you are working 
or you uploaded new contents (for example, from 
another user or the command-line interface).

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.

Entering a string with more than 2 characters in the 
search field locates the first instance of the string in the 
CI Tree.

Clicking the search button finds the next occurrence of 
the string for which you are searching. For more 
information about searching, see "How to Search and 
Filter CI Types" on page 275.

Collapses the Filter pane.

Expands the Filter pane for use.
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CI Types Hierarchical list representing the configuration item 
types that you want to monitor in your IT environment. 
To display the required CI Type, browse to and select the 
item of interest. The details associated with the CI Type 
are displayed.

If the CI Types list is filtered, (filtered) is displayed next to 
the CI Types title.

When CI types and their children have no objects 
assigned, their entries appear dimmed. 

When objects are directly assigned to a CI type, their 
entries appear bolded.

Filter Used to search for specific CI types and view CI types that 
match specified filter criteria. There are two filters:

➤ Show only CI types with assignments

➤ View (Shows CI types contained within a specified 
view)

➤ ... Opens the Views dialog box from which you can 
select a view with which to filter CI types.

Note: If you apply a view to the filter CI Types tree which 
removes all CI types with assignments, the 
ConfigurationItem entry remains in normal text, 
indicating that assignments exist. Remove the view, or 
select a more appropriate view to display the CI types 
with assignments that you require.

For more information about searching and filtering, see 
"How to Search and Filter CI Types" on page 275.

Show only CI types 
with 

Displays in the CI Tree only CI Types with assignments.

View Displays in the CI Tree only CI Types contained within 
the selected view.

UI Element (A-Z) Description
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Tools Pane

The Tools pane displays in a list all the tools configured for your users.

The Tools pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > Tools

Relevant tasks To create tools, see "How to Create Tools" on page 278.

See also For more information about the tools, see:

➤ "Tools Management" on page 272.

➤ "Tool Creation" on page 273.

➤ "Tool Inheritance" on page 274.

UI Element (A-Z) Description

Refreshes the contents of the tools list. Use if new 
content becomes available while you are working or you 
uploaded new contents (for example, from another user 
or the command-line interface).

New Item: Opens the Create New Tool wizard, which 
enables you to define a new tool. For more information 
about the Create New Tool wizard, see "Create New Tool 
and Edit Tool Dialog Boxes" on page 288.

Duplicate Item: Creates a duplicate of the selected tool in 
the Edit Tool dialog box. For more information about the 
Edit Tool dialog box, see "Create New Tool and Edit Tool 
Dialog Boxes" on page 288.

Edit Item: Opens the Edit Tool dialog box, which enables 
you to modify the tool selected in the Tools pane. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Tool dialog box.

For more information about the Edit Tool dialog box, see 
"Create New Tool and Edit Tool Dialog Boxes" on 
page 288.
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Tool Details Pane

The Tool Details pane displays an overview of the tool that is selected in the 
list of tools in the Tools pane. There are three types of tools: Executables, 
Scripts, and URLs. The details displayed for each type of tool changes, 
depending on the type of tool selected.

The Tool Details pane displays the UI elements listed in the following table.

Delete Item: Deletes the selected tool from the database.

Manage Tool Categories: Opens the Manage Tool 
Categories dialog box.

To access Select Admin > Operations Management > Design 
Operations Content > Tools

Relevant tasks To create tools, see "How to Create Tools" on page 278.

See also For more information about the tools, see:

➤ "Tools Management" on page 272.

➤ "Tool Creation" on page 273.

➤ "Tool Inheritance" on page 274.

UI Element (A-Z) Description

General

Category Used to grant controlled access to tools. Tools are 
assigned a category and users are given execute 
permissions to tool categories appropriate to their roles.

For further details, see "Tools Management" on page 272.

UI Element (A-Z) Description
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Description Brief description of the tool that is selected for viewing or 
modification. If the tool is one instance of the same tool, 
the description can include information about the 
operating system (or application) version it is intended 
for.

Display Name External name for the tool. The external name is the 
name that you want to expose to users.

Name Name you want to assign to the tool for internal use 
only. The name must be unique and is verified when 
saving.

Type Type of tool configured, for example, URL.

Command Details

Command Command statement

Run as Account under which the command must be run.

Run on Target on which the tool (executable or script) can be 
run.

Script Details

Language Language in which the script is written.

Run as Account under which the script must be run.

Run on Target on which the tool (executable or script) can be 
run.

Script Text of the script to be run.

URL Details

URL URL to be run.

UI Element (A-Z) Description
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Create New Tool and Edit Tool Dialog Boxes

The Create New Tool wizard enables you to create new tools. The Edit Tool 
dialog box enables you to modify the selected tool. Both dialog boxes are 
similar and divided into the following sections:

➤ "General" on page 289

➤ "Command" on page 290

➤ "Script" on page 291

➤ "URL" on page 292

➤ "Target" on page 293

To access Select Admin > Operations Management > Design 
Operations Content > Tools

In the CI Types pane, browse to and select the 
configuration item type for which you want to create a 
tool. In the Tools pane, click the  button to open the 
Create New Tool wizard.

Relevant tasks To create tools, see "How to Create Tools" on page 278.

See also For more information about the tools, see:

➤ "Tools Management" on page 272.

➤ "Tool Creation" on page 273.

➤ "Tool Inheritance" on page 274.
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General
The General pane of the Edit Tool dialog box or the Create New Tool wizard 
displays the UI elements listed in the following table.

UI Element (A-Z) Description

Category Used to grant controlled access to tools. Tools are 
assigned a category and users are given execute 
permissions to tool categories appropriate to their roles.

For further details, see "Tools Management" on page 272.

Default category Tool category applied to all tools when an alternative 
category is not selected.

Description Brief description of the tool you are modifying. The 
description typically includes information about the 
operating system (or application) version it is intended 
for.

Display Name External name for the tool. The display name is the name 
you want to display to users. The display name can be 
changed for localization purposes.

ID Unique identification number for internal purposes only 
(Edit only). 

Name Short name for the tool for internal use only. The name 
must be unique. You cannot save a new tool if the name 
you choose is already in use.

Other category Selected custom tool category.

Type Type of tool configured, for example, URL (Edit only).
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Command
The Command pane of the Edit Tool dialog box or the Create New Tool 
wizard displays the UI elements listed in the following table.

UI Element (A-Z) Description

Command Command specification that is executed on tool launch.

Note: The maximum executable command length is 
limited to 2500 characters including resolved parameters.

Insert runtime 
parameters at cursor

If required, insert parameters into the command field. 
These parameters are replaced with values on tool 
launch. Possible parameters are:

➤ CI attributes

➤ Event attributes

➤ Infrastructure settings

➤ Monitoring host name (on the host that the 
monitoring HPOM Agent is running)

➤ Management server name

➤ Hosted on host name (the host on which the CI is 
hosted) 

(xxx/2500) Indicates the number of characters contained in the 
command being specified and the maximum number of 
characters supported. 
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Script
The Script pane of the Edit Tool dialog box or the Create New Tool wizard 
displays the UI elements listed in the following table.

UI Element (A-Z) Description

Insert runtime 
parameters at cursor

If required, insert parameters into the command field. 
These parameters are replaced with values on tool 
launch. Possible parameters are:

➤ CI attributes

➤ Event attributes

➤ Infrastructure settings

➤ Monitoring host name (on the host that the 
monitoring HPOM Agent is running)

➤ Management server name

➤ Hosted on host name (the host on which the CI is 
hosted) 

Note: You can also specify custom parameters using the 
@@<parameter>@@ syntax.

Language Language in which the script is written. Supported scripts 
are Perl, Visual Basic, Batch files, and Microsoft Windows 
Script Host.

Script Text of the script to be run. 

Note: The maximum script length is limited to 2500 
characters including resolved parameters.

(xxx/2500) Indicates the number of characters contained in the 
script being specified and the maximum number of 
characters supported. 
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URL
The URL pane of the Edit Tool dialog box or the Create New Tool wizard 
displays the UI elements listed in the following table.

UI Element (A-Z) Description

Insert runtime 
parameters at cursor

If required, inserts parameters into the command field. 
These parameters are replaced with values on tool 
launch. Possible parameters are:

➤ CI attributes

➤ Event attributes

➤ Infrastructure settings

➤ Monitoring host name (on the host that the 
monitoring HPOM Agent is running)

➤ Management server name

➤ Hosted on host name (the host on which the CI is 
hosted) 

Note: You can also specify custom parameters using the 
${<parameter>} syntax.

Test Tests the URL before saving. When parameters are 
inserted into the URL, you are prompted for values before 
the test launch.

URL URL specification that is executed on tool launch.
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Target
The Target pane of the Edit Tool dialog box or the Create New Tool wizard 
displays the UI elements listed in the following table (not required for URL 
tools).

UI Element (A-Z) Description

Run as Account under which the command or script must be 
run. The possible options are:

➤ Monitoring Agent User: agent account credentials are 
used to execute the command or script.

➤ Operator Specified User: on tool launch, the operator 
is prompted for user credentials. 

Run on Target on which the tool (executable or script) can be 
run.

Possible targets are:

➤ Monitoring Host (for example a system being 
monitored by an HPOM agent)

➤ Management Server (for example, the HPOM 
management server)

➤ Other Host

The Other Host text field is free form with the possibility 
to insert parameters. These parameters are replaced with 
values on tool launch. Possible parameters are:

➤ CI Attributes

➤ Event Attributes

➤ Infrastructure Settings
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Attribute Selection Dialog Boxes

This section includes the following sections:

➤ "Available Attributes Dialog Box" on page 294

➤ "Available Infrastructure Settings Dialog Box" on page 295

➤ "Available Event Attributes Dialog Box" on page 295

➤ "Manage Tool Categories" on page 297

Available Attributes Dialog Box

The Available Attributes dialog box enables you to browse a list of attributes 
that are available for the configuration item type associated with the tool 
you are creating or modifying. You can add these attributes as part of your 
command, script, or URL. 

The Available Attributes dialog box displays the UI elements listed in the 
following table.

UI Element (A-Z) Description

CI Type Configuration item type associated with the tool you are 
creating or modifying, for example: ConfigurationItem, 
Node, or Computer.

Description Brief description of the attribute listed for the associated 
configuration item type.

Display Name Name of the attribute listed for the available 
configuration item type, for example: (System) Language, 
or Codepage.

Type Type of attribute available, for example: BOOLEAN, 
STRING, STRING_LIST, or LONG.
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Available Infrastructure Settings Dialog Box

The Available Infrastructure Settings dialog box enables you to browse a list 
of settings that are available in BSM and added them to the tool you are 
creating or modifying. You can add these settings as part of your command, 
script, or URL. 

The Available Infrastructure settings dialog box displays the UI elements 
listed in the following table.

Available Event Attributes Dialog Box

The Available Event Attributes dialog box enables you to browse a list of 
available event attributes that are available for the configuration item type 
associated with the tool you are creating or modifying. You can add these 
attributes, one at a time, as part of your command, script, or URL. You can 
also specify custom attributes by entering the name of the custom attribute 
in the custom attribute field. 

UI Element (A-Z) Description

Application / 
Foundation / All

Name of the context selected in the Infrastructure 
Settings Manager.

Display Name External name for the infrastructure setting as specified 
in the Infrastructure Settings Manager.

Value Actual value assigned to the infrastructure setting. Values 
include Boolean (true or false), numeric values, system 
names, application names, and symbols.
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The Available Event Attributes dialog box displays the UI elements listed in 
the following table. In the table, unlabeled UI elements are shown in angle 
brackets (<>).

UI Element (A-Z) Description

Attribute Selects the event attribute list from which you can select 
available event attributes.

Custom Attribute Selects the custom attribute field in which you can 
specify a custom attribute. The custom attribute that you 
specify is entered using the syntax:

${event.custom<custom attribute name>}

Display Name Name of the event attribute listed for the available 
configuration item type, for example: Originating Server, 
HI Value, or Custom Attribute.

Key Value Event attribute key used to identify the event attribute.
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Manage Tool Categories

The Select a Category dialog box enables you to browse a list of available 
Tool Categories. Click the Manage Tool Categories  button, or, if you need 
to create a Tool Category or edit an existing one, use the appropriate button 
to open the Create or Edit dialog boxes.

The Select a category dialog box displays the UI elements listed in the 
following table. In the table, unlabeled UI elements are shown in angle 
brackets (<>).

UI Element (A-Z) Description

New Item: Opens the Create New Tool Category dialog 
box, which enables you to define a new tool category. For 
more information about the Create New Tool Category 
dialog box, see "How to Define Tool Categories" on 
page 280.

Edit Item: Opens the Edit Tool Category dialog box, 
which enables you to modify the tool category selected 
in the Select a Category dialog box. For more 
information about the Edit Tool dialog box, see "How to 
Define Tool Categories" on page 280.

Delete Item: Deletes the selected tool category from the 
database.

Description Brief description of the selected tool category.

Display Name Name displayed in the UI for the selected tool category.

Name Internal name of the selected tool category.
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Troubleshooting and Limitations 

This section provides the following help for those people who are 
troubleshooting problems with the tools you use for Operations 
Management administration, including creating, modifying, and enabling 
tools.

➤ "Tools Display Incorrectly" on page 298

➤ "Tools Not Shown For Configuration Item Type" on page 298

➤ "Tools Execution Fails on HPOM Clusters" on page 298

Tools Display Incorrectly
Make sure a tool or a tool instance is configured for the related CI of the 
selected event.

Tools Not Shown For Configuration Item Type

➤ Make sure a tool or a tool instance is configured for the selected 
configuration item type

➤ Contains event parameters

Tools Execution Fails on HPOM Clusters
If the HPOM server is running on a cluster, it is possible that events contain 
the physical address of one of the cluster nodes as the originating node and 
not the virtual cluster node itself. If a tool is executed after the original node 
is no longer active, tool execution fails. 

To avoid this issue, define the physical nodes of the cluster and the virtual 
node as connected servers, and define the virtual node as the execution host 
for the physical nodes.

In this way, when a tool is executed, the physical host is found by the 
originating node of the event, the execution is then forwarded to the virtual 
node, and then finally redirected to the active node.
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11
Performance Graphs 

This chapter includes:

Concepts

➤ Performance Graphs Manager on page 300

Tasks

➤ How to Search and Filter CI Types on page 301

➤ How to Map CI Types to Graph Families on page 305

➤ How to Launch the Performance Graph Designer on page 306

Reference

➤ Performance Graphs User Interface on page 308
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Concepts

Performance Graphs Manager 

This chapter describes the Performance Graphs manager used to map and 
manage performance graphs. Configuration item types must be mapped to 
available graph families so that instance-based graphs can be launched at 
runtime from a configuration item.

An instance identifier is required to launch instance-based graphs at 
runtime from a configuration item. To be able to display graphs for a CI 
type, available graph families must be mapped to the CI type.

The Performance Graphs manager enables users to perform the following 
management-related tasks:

➤ Map graph families to configuration item types.

➤ Launch the Designer dialog box to create a new graph template or edit an 
existing graph template.

➤ Delete graph template.

➤ Configure calculation of instance identifiers based on CI attributes.

Note: Only users with the appropriate access permissions can use 
Operations Management Administration. For more information about user 
management, see "User Management" on page 629.
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Tasks

How to Search and Filter CI Types

In this task, you learn how to search for specific CI types and view CI types 
that match specified filter criteria. There are two filters:

➤ Show only CI types with assigned performance graphs

➤ View (Show CI types contained within a specified view)

Note: Join relationships defined in views are ignored.

For information on button actions, see "Performance Graphs User Interface" 
on page 308.

Searching for a CI Type
You can use the Search field to locate the first instance of the CI type name 
or part of a name that you specify.

To search for a specified CI type:

 1 Open the Performance Graphs manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
Performance Graphs

 2 In the Search field, enter a string.
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Note: The search string must be at least three characters long. Searching is 
automatically started as soon as the third character is entered and the first 
match is highlighted. This prerequisite avoids searches being started too 
often and resources being blocked. Names with less than three characters 
can be found by clicking on the  button.

The first CI type in the CI Types tree to match the specified string is 
highlighted. If that CI is not initially visible, the CI tree is expanded to 
display the CI Type.

 3 Click the  button to find the next occurrence of the CI Type for which 
you are searching.

Finding CI Types with Assigned Performance Graphs
You can use the filter to display all CI types that have content assigned to 
them.

To filter the CI tree to show only CI types with assigned performance 
graphs:

 1 Open the Performance Graphs manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
Performance Graphs 

 2 In the Filter pane, select Show only CI types with assigned performance 
graphs.

The CI Types pane displays only those CI types that have performance 
graphs assigned.
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Note: You can use the Show only CI types with assigned performance graphs 
filter and the filtering by a selected view together. The result displays only CI 
types contained within the specified view and with assigned performance 
graphs.



Chapter 11 • Performance Graphs

304

Filtering the CI Types Tree with a View
You can use the filter to display all CI types that are contained within a 
certain view.

Note: Join relationships defined in views are ignored.

To filter the CI Types tree with a view:

 1 Open the Performance Graphs manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
Performance Graphs 

 2 In the Search pane, select View.

The View field becomes active.

 3 Click the Browse Views (...) button to open the Views selection dialog box. 

 4 Select the view that you want to use, and select OK.

The CI Types tree is updated to display only the CI types that match the 
view selected.

You can use the Expand ( ) and Collapse ( ) buttons to expand or 
collapse the CI tree. The Expand ( ) button expands all CI types which 
are under the selected CI type. The Collapse ( ) button collapses all open 
nodes except for the selected node.

If no item matches the filter, the No CI type found message is displayed.

Note: You can use the Show only CI types with assigned performance graphs 
filter and the filtering by a selected view together. The result displays only CI 
types contained within the specified view and with assigned performance 
graphs.
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How to Map CI Types to Graph Families

This task shows you how to map a configuration item type to a graph 
family.

Note: For information on button actions, see "Performance Graphs User 
Interface" on page 308. 

To map a CI type to a graph family:

 1 Open the Performance Graphs manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
Performance Graphs

 2 In the CI Types pane, select the configuration item that you want to map 
to a graph family.

 3 In the Performance Graphs pane, click the  button to open the Assign 
Performance Graphs dialog box.

 4 In the Graph Instance ID Configuration pane, enter the value for Instance 
ID Definition. You can access the available attributes using the Insert CI 
Attributes button.

 5 Optional: Enter the values for Search Pattern and Replace Occurrences by. 
These values are used to look for the specified pattern in the attribute 
value and replace it with the value of the replacement. The attribute is 
resolved using the new value.

For example, if you want to search for oracle and replace it with ORA, 
specify oracle as the pattern value and ORA as the replacement value.

 6 In the Available Graph Families dialog box, select the graph families that 
you want to map to the selected configuration item type.

Either drag the graph families to the Assigned Graph Families pane or use 
the context sensitive menu item Add to Assigned Graph Families or use 
the  button.
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Adding families to the Assigned Graph Families pane implicitly adds all 
graph categories and templates that belong to the selected family. These 
families are displayed in bold text and the implicitly added categories are 
displayed in italics. Individual categories added to the Assigned Graph 
Families pane are displayed in bold text and are arranged under the 
family to which they belong, displayed in italics.

 7 Select OK to apply your mapping and close the Graph Instance ID 
Configuration dialog box.

How to Launch the Performance Graph Designer

This task shows you how to launch the New Graph Template Launch 
Designer in the context of a selected CI instance to help you to design a new 
graph template. Launch parameters are required to identify the CI instance. 

For more information about creating a graph template, see "How to Design 
Graphs" on page 154.

Note: For information on button actions, see "Performance Graphs User 
Interface" on page 308. 

To launch the Performance Graph Designer for a selected CI:

 1 Open the Performance Graphs manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
Performance Graphs

 2 In the CI Types pane, select the configuration item type from which you 
want to launch the Performance Graph Designer.

 3 Click the  button in the Available Graph Families pane. The Launch 
Performance Graph Designer dialog box opens.

 4 In the CI Instances pane of the Launch Performance Graph Designer 
dialog box, select the CI instance to use as a sample for the creation of a 
graph template for this CI type, and select Next.



Chapter 11 • Performance Graphs

307

The calculated launch parameters for the selected CI are displayed in the 
Launch Parameters pane.

 5 Select Finish.

The Performance Graph Designer wizard opens. For information about 
creating a graph template, see "How to Design Graphs" on page 154.
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Performance Graphs User Interface 

This section lists and describes the layout of the Performance Graphs 
manager.

➤ CI Types Pane on page 308

➤ Performance Graphs Pane on page 311

➤ Assign Performance Graphs Dialog Box on page 314

➤ Launch Performance Graph Designer Dialog Box on page 316

CI Types Pane 

The CI Types pane enables you to choose the configuration item types that 
you want to map to available graph families.

To access Select Admin > Operations Management > Design 
Operations Content > Performance Graphs

Important 
information

If you want to modify or manage configuration item 
types, use the CI Types Manager:

Admin > RTSM Administration > Modeling > CI Type 
Manager

Relevant tasks To use the CI Types pane, see "How to Search and Filter 
CI Types" on page 301.

See also For more information about configuring performance 
graphs, see "Performance Graphs Manager" on page 300.
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The information displayed in the CI Types pane of the Performance Graphs 
manager includes the following details:

UI Element (A-Z) Description

Refreshes the contents of the CI Types pane.

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.

Finds the next occurrence of the CI Type for which you 
are searching. For more information about searching, see 
"How to Search and Filter CI Types" on page 301.

Collapses the Filter pane.

Expands the Filter pane for use.
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CI Types Hierarchical list representing the configuration item 
types that you want to monitor in your IT environment. 
To display the event type indicators, KPIs, and mapping 
rules associated with a configuration item, browse to and 
select the item of interest. The various tabs display the 
details.

If the CI Types list is filtered, (filtered) is displayed next to 
the CI Types title.

When CI types and their children have no objects 
assigned, their entries appear dimmed. 

When objects are directly assigned to a CI type, their 
entries appear bolded.

Filter Used to search for specific CI types and view CI types that 
match specified filter criteria. There are two filters:

➤ Show only CI types with assigned performance graphs

➤ View (Show CI types contained within a specified 
view)

➤ ... Opens the Views dialog box from which you can 
select a view with which to filter CI types.

Note: If you apply a view to the filter CI Types tree which 
removes all CI types with assignments, the 
ConfigurationItem entry remains in normal text, 
indicating that assignments exist. Remove the view, or 
select a more appropriate view to display the CI types 
with assignments that you require.

For more information about searching and filtering, see 
"How to Search and Filter CI Types" on page 301.

UI Element (A-Z) Description
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Performance Graphs Pane 

The Performance Graphs manager enables you to choose the graph families 
you want to map to the selected configuration item.

The Performance Graphs pane displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Design 
Operations Content > Performance Graphs

Important 
information

If you want to modify or manage configuration item 
types, use the CI Types Manager:

Admin > RTSM Administration > Modeling > CI Type 
Manager

Relevant tasks To configure performance graphs, see "How to Map CI 
Types to Graph Families" on page 305 and "How to 
Launch the Performance Graph Designer" on page 306.

See also For more information about configuring performance 
graphs, see "Performance Graphs Manager" on page 300.

UI Element Description

Reloads the performance graphs configuration for the 
selected CI Type. Use if new content becomes available 
while you are working or you uploaded new contents (for 
example, from another user or the command-line 
interface).

Opens the Assign Performance Graphs dialog box to 
create a new performance graphs configuration for the 
selected CI type.

Opens the Assign Performance Graphs dialog box, which 
enables you to modify the mapping for the CI selected in 
the CI Types pane. For more information about the 
Assign Performance Graphs dialog box, see "Assign 
Performance Graphs Dialog Box" on page 314.

Removes the performance graphs configuration from the 
selected CI type.
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Graph Instance ID Pane 

The Graph Instance ID pane displays the attributes and modifiers used to 
identify configuration items for which you want to display graphs. 

The Graph Instance ID Configuration pane displays the UI elements listed 
in the following table.

Available Graph Families

The Available Graph Families pane displays the graphs, graph categories and 
templates available on the system. For more information about creating and 
editing graph templates, see "How to Design Graphs" on page 154 and "How 
to Edit Graphs" on page 154.

The Available Graph Families pane displays the UI elements listed in the 
following table.

UI Element (A-Z) Description

Instance ID 
Definition

String consisting of configuration item attributes and free 
form text. The configuration item attributes are specified 
as variables that refer to attributes of the CI Type. The 
value is resolved at runtime against a configuration item 
instance.

UI Element Description

Reloads the available graph families for the selected CI 
Type. Use if new content becomes available while you are 
working or you uploaded new contents (for example, 
from another user or the command-line interface).

Launches the Launch Performance Graph Designer 
dialog box to help you to launch a new graph template.

For more information about creating a graph template, 
see "How to Design Graphs" on page 154.
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Assigned Graph Families

The Assigned Graph Families pane displays the graph and graph categories 
assigned to the selected CI Type. 

The Assigned Graph Families pane displays the UI elements listed in the 
following table. In the table, unlabeled UI elements are shown in angle 
brackets (<>).

Launches the Launch Performance Graph Designer for 
editing the selected graph template launch details.

For more information about editing a graph template, see 
"How to Edit Graphs" on page 154.

Removes the selected custom graph template from the 
system.

Expands the list to display items belonging to the 
selected group.

Collapses all open branches except for the selected 
branch.

UI Element (A-Z) Description

Categories Sub-groups of graphs that are logically grouped within 
the family.

Families Top-level group that is used to organize graphs.

UI Element Description



Chapter 11 • Performance Graphs

314

Assign Performance Graphs Dialog Box

The Assign Performance Graphs dialog box displays the graph and graph 
categories assigned to the selected CI Type.

The Assign Performance Graphs dialog box displays the UI elements listed 
in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > Performance Graphs

Relevant tasks To configure performance graphs, see "How to Map CI 
Types to Graph Families" on page 305 and "How to 
Launch the Performance Graph Designer" on page 306.

See also For more information about configuring performance 
graphs, see "Performance Graphs Manager" on page 300.

UI Element (A-Z) Description

Add to Assigned Graph Families: Adds the graph family 
(and all associated categories) or category selected in the 
Available Graph Families pane to the list of Assigned 
Graph Families to be included in performance graphs 
configuration.

Unassign: Removes the graph family and all associated 
categories from the Assigned Graph Families pane, which 
excludes it from the performance graphs configuration.

Unassign All: Removes all items from the list of items 
selected for inclusion in the performance graphs 
configuration.

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.
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<bold> Adding families to the Assigned Graph Families pane 
implicitly adds all graph categories that belong to the 
selected family. These families are displayed in bold text. 
Individual categories added to the Assigned Graph 
Families pane are displayed in bold text and are arranged 
under the family to which they belong, displayed in 
italics.

<italics> Categories added implicitly to the Assigned Graph 
Families pane as a result of adding the families to which 
these categories belong are displayed n italics.

Families are displayed in italics if they are added to show 
to which family an individually selected category 
belongs.

Assigned Graph 
Families

Lists the graph families and categories that you selected 
to map to the selected configuration item type.

Adding families to the Assigned Graph Families pane 
implicitly adds all graph categories that belong to the 
selected family. These families are displayed in bold text 
and the implicitly added categories are displayed in 
italics. Individual categories added to the Assigned Graph 
Families pane are displayed in bold text and are arranged 
under the family to which they belong, displayed in 
italics.

Available Graph 
Families

Lists the available graph families and categories that you 
can map to the selected configuration item type.

Either drag the graph families and categories to the 
Assigned Graph Families pane or use the context 
sensitive menu item Add to Assigned Graph Families.

Insert CI Attribute Access the available CI attributes.

Instance ID 
Definition

String consisting of configuration item attributes and free 
form text. The configuration item attributes are specified 
as variables that refer to attributes of the CI Type. The 
value is resolved at runtime against a configuration item 
instance.

UI Element (A-Z) Description
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Launch Performance Graph Designer Dialog Box

The Launch Performance Graph Designer dialog box specifies the CI 
instance and the launch parameters for which you want to create a graph 
template.

The Launch Performance Graph Designer dialog box displays the UI 
elements listed in the following table.

Replace Occurrences 
by

(Optional): String used as the replacement for pattern 
matches within the string resolved by Attribute.

Search Pattern (Optional): Regular expression pattern that is matched 
within the string resolved from the Attribute. Any 
portion of the string that matches the pattern is replaced 
by the Replace Occurrences by string.

For example, if you want to search for oracle and replace 
it with ORA, specify oracle as the pattern value and ORA 
as the replacement value.

To access Select Admin > Operations Management > Design 
Operations Content > Performance Graphs

Relevant tasks To configure performance graphs, see "How to Map CI 
Types to Graph Families" on page 305 and "How to 
Launch the Performance Graph Designer" on page 306.

See also For more information about configuring performance 
graphs, see "Performance Graphs Manager" on page 300.

UI Element (A-Z) Description

CI Instances CI for which the graph designer is to be launched.

CI Type Name of the configuration item type to which the 
selected configuration item belongs.

UI Element (A-Z) Description
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Name Name of the configuration item to which the CI Instance 
is related, for example, DB_Server.example.com.

Type Type of the configuration item to which the CI Instance 
is related, for example, Related Host or Instance ID.

UI Element (A-Z) Description
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12
Indicator Mapping Rules 

Note: To be able to use the health-related functionality of Operations 
Management, the Event Management Foundation and Health licenses are 
required. For detailed information on licensing, see the HP Business Service 
Management Deployment Guide PDF.

This chapter includes:

Concepts

➤ Indicator Mapping Rules Manager Basics on page 320

➤ Mapping Events to Indicators on page 322

Tasks

➤ How to Search and Filter CI Types on page 326

➤ How to Create and Edit Indicator Mapping Rules on page 330

➤ How to Order Indicator Mapping Rules on page 333

Reference

➤ Indicator Mapping Rules User Interface on page 334
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Concepts

Indicator Mapping Rules Manager Basics 

This chapter introduces the features of the Indicator Mapping Rules 
manager, used to help you manage indicator mapping rules.

Indicators are used to represent the different types of events that can occur 
in the monitored environment, for example, System restart, Host state, 
Memory usage, or Print-queue length. Indicators can simply report that an 
event has occurred, for example, System restart:Occurred. They can also be 
used to represent the likely states for the defined events, for example, host 
state:down, memory usage:high, or print-queue length:full. Changes of state 
often indicate the existence of a problem.

Appropriate indicators must be created for each configuration item type, 
and the RTSM database model definition for configuration item types 
includes information about the specific indicator assignments. Assigning 
event type indicators to a specific configuration item type ensures that the 
all instances of that configuration item type can be similarly monitored.

Operations Management uses two types of indicators:

➤ Event Type Indicators (ETI)

Event type indicators indicate that a problem has occurred. They use the 
severity attribute from the event. This severity can be used to set an ETI 
state using the based on severity option. One indicator state is required. 
By default, the state Normal is created when creating an event type 
indicator.

An ETI could read: System Restart: occurred.

ETIs are necessary for topology-based event correlation.
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➤ Health Indicators

Health indicators (HI) are used to indicate the detailed health of CIs by 
setting a severity status. When an HI is defined, an associated event type 
indicator is automatically created. HIs are independent of the event 
lifecycle. You can close events, but the health of the associated CI is still 
available.

For example, you can use the attributes of a critical event reporting a lack 
of storage space on a logical volume to set an HI state Down with the 
severity Critical assigned to the configuration item type Logical Disk.

HIs when assigned to KPIs are intended for use in the calculation of the 
severity status of health-based KPIs. However, HIs provide more fine 
grained information using the Status Snapshot.

When HIs are configured to work in conjunction with KPIs, they show 
the effect of a problem on the CI’s neighborhood in a clear and easy to 
understand way, by propagating the effect of a problem with a low-level 
CI to higher-level CIs using the Health Top View.

An event being sent from a manager such as HPOM to Operations 
Management signifies an occurrence in the managed environment. This 
event includes information about the source of the problem and could 
include health-related attributes. When this event is received by Operations 
Management, indicators are set based on this attribute. If the event attribute 
is not, or cannot be included, indicator mapping rules can be used to set 
indicators.

Operations Management uses HIs to determine and display the health of 
different aspects of a monitored object. An HI is an event-specific monitor 
that uses one or more states to represent the individual states of a monitored 
object, such as Running or Stopped. HIs can be used to show if a hardware 
resource is available and responding or, if the performance of a software 
application changes according to whether the load is normal, high, or 
exceeding specification.

Operations Management creates an HI in conjunction with an event type 
indicator. When creating an HI, the associated event type indicator is 
automatically created.



Chapter 12 • Indicator Mapping Rules

322

HIs monitor and show specific aspects of the health of the configuration 
item type to which they are assigned. A configuration item inherits HI 
assignments from its parent configuration item type. For example, HIs 
assigned to the configuration item type Database also apply to the 
configuration item type Oracle or DB2 and are applied to any Oracle and 
DB2 database configuration items.

HIs provide the data that key performance indicators (KPI) need to calculate 
the health-based severity status for the availability and performance of 
monitored resources. You assign HIs to KPI calculation rules, to collate 
health-related data, determine a configuration item's availability and 
performance, and indicate its overall health, for example, with a severity 
status and color.

Mapping Events to Indicators     

An event can contain the EventTypeIndicator custom message attribute from 
HPOM specifying a severity. If this is available, the Operations Management 
custom attribute ETI Resolution Hint is set and this is used to set the indicator 
state automatically.

For events that do not include this custom attribute, you can define 
indicator mapping rules to set indicator states.

Indicator mapping rules are intended to help in the following situations:

➤ Monitoring events that are not integrated in either Operations 
Management or forwarded from HPOM.

➤ Integrating events from a custom application or a Smart Plug-in that is 
not Operations Management-ready.

The mapping of event attributes to indicator states occurs either through 
the installation and setup of an Operations Management content pack or as 
a result of a manually created indicator mapping rule. 

You can set indicators in one of the following ways:

➤ at a specific event using indicator mapping rules

➤ by setting the indicator with an HPOM message policy
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Note: One event can set only one indicator state. However, you can 
configure multiple message policies to report on different aspects of the 
same event and use the event generated by each policy to set dedicated 
indicators.

Indicator mapping rules exist in the context of a specific type of 
configuration item, for example, Computer, Host, or Router. The indicator 
mapping rules defined for a specific configuration item type can use only 
the indicators assigned to the specified configuration item type.

This section includes:

➤ "Filters for Indicator Mapping Rules" on page 323

➤ "Mapping Rule or CMA" on page 324

➤ "Order of Indicator Mapping Rules" on page 325

➤ "Inheritance of Indicator Mapping Rules" on page 325

Filters for Indicator Mapping Rules
You can define indicator mapping rules that search filtered events for strings 
and values which are then used to set an indicator state. If the mapped 
indicator sets an HI, the corresponding state for the HI is also set. For more 
detailed information about defining filters, see "Filtering Events" on 
page 211.

Using the Manage Event Filters dialog box, you can define filters that target 
the events to be considered in an indicator mapping rule. The filter can use 
any of the available event attributes. For example, you can define an 
indicator mapping rule that considers only those events that have a critical 
or major severity status and are assigned to a particular user or user group. 

Note: You can test new filters while defining or editing an indicator 
mapping rule.
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An indicator mapping rule filter can only be used with indicator mapping 
rules. They are not interchangeable with event filters.

If the EventTypeIndicator custom message attribute is not available from 
HPOM or overriding of automatic settings is enabled, but the event matches 
an indicator mapping rule filter, the rule maps the event to the specified 
indicator. 

The state of the indicator is set by one of the following methods:

➤ Specific Indicator State

The event is mapped to an indicator which is set to the state specified in 
the mapping rule.

For example, you are monitoring databases and Operations Management 
receives an event that matches the mapping rule filter of the Database 
Status indicator. The event sets the indicator state that is specified in the 
mapping rule, for example, Down. 

➤ Based On Severity

Events matching the mapping rule filter are assigned the severity 
associated with the indicator state that matches the severity of the event.

For example, you are monitoring the CPU load and Operations 
Management receives an event that matches the mapping rule filter of the 
CPU Load indicator and has a severity of major. The event automatically 
sets the indicator state that is specified to correspond to this severity, for 
example, Overloaded.

Mapping Rule or CMA
If an event generated by an HPOM Smart Plug-in uses custom attributes to 
set an indicator state automatically, you can configure Operations 
Management to override this automatic setting and set the indicator state in 
accordance with an indicator mapping rule. For further information, see 
"Event Type Indicator Settings" on page 707. 



Chapter 12 • Indicator Mapping Rules

325

Order of Indicator Mapping Rules
You can create many indicator mapping rules for a CI type. Where more 
than one indicator mapping rule is available for a configuration item type, 
the number in the Order column indicates the order in which the indicator 
mapping rules are applied during the mapping process. As soon as one 
indicator mapping rule matches, the mapping process stops and ignores all 
subsequent rules further down the specified order. 

The indicator mapping rules configured for a CI type and inherited from 
higher-level CI types are listed in the Mapping Overview pane. The indicator 
mapping rules configured for each CI type are listed in the Mapping Rules 
list for their respective CI type names. You can change the order of the 
indicator mapping rules only for the selected CI type.

Inheritance of Indicator Mapping Rules
A CI type inherits indicator mapping rules from CI types higher in the 
hierarchy. An indicator mapping rule defined for the Host configuration 
item type is inherited by all configuration items types lower in the 
hierarchy, such as Unix, and Windows.

You can control which configuration items inherit defined indicator 
mapping rules by choosing the level in the configuration item hierarchy at 
which to define them. The higher in the CI type hierarchy the mapping rule 
is specified, the greater the number of CI types that inherit it.

The Mapping Overview pane shows the inheritance of indicator mapping 
rules in the reverse order of the CI types in the CI Types tree.
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Tasks

How to Search and Filter CI Types

In this task, you learn how to search for specific CI types and view CI types 
that match specified filter criteria. There are two filters:

➤ Show only CI types with assigned indicator mapping rules

➤ View (Show CI types contained within a specified view)

Note: Join relationships defined in views are ignored.

For information on button actions, see "Indicator Mapping Rules User 
Interface" on page 334. 

Searching for a CI Type
You can use the Search field to locate the first instance of the CI type name 
or part of a name that you specify.

To search for a specified CI type:

 1 Open the Indicator Mapping Rules manager from Operations 
Management Administration:

Admin > Operations Management > Design Operations Content > 
Indicator Mapping Rules 

 2 In the Search field, enter a string.
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Note: The search string must be at least three characters long. Searching is 
started as soon as the third character is entered and the first match is 
highlighted. Names with less than three characters can be found by 
clicking on the  button.

The first CI type in the CI Types tree to match the specified string is 
highlighted. If that CI is not initially visible, the CI tree is expanded to 
display the CI type.

 3 Click the  button to find the next occurrence of the CI type for which 
you are searching.

Finding CI Types with Assigned Indicators
You can use the filter to display all CI types that have indicators assigned to 
them.

To filter the CI tree to show only CI types with assigned indicator mapping 
rules:

 1 Open the Indicators Mapping Rules manager from Operations 
Management Administration:

Admin > Operations Management > Design Operations Content > 
Indicator Mapping Rules 

 2 In the Filter pane, select Show only CI types with assigned indicator 
mapping rules.

The CI Types pane displays only those CI types that have indicators 
assigned along with the parents of these CI types. If a parent CI type has 
no assigned indicators, they are unavailable in the display.



Chapter 12 • Indicator Mapping Rules

328

Note: You can use the Show only CI types with assigned indicator mapping 
rules filter and the filtering by a selected view together. The result displays 
only CI types contained within the specified view and with assigned 
indicators.

Filtering the CI Types Tree with a View
You can use the filter to display all CI types that are contained within a 
certain view.

Note: Join relationships defined in views are ignored.

To filter the CI Types tree with a view:

 1 Open the Indicator Mapping Rules manager from Operations 
Management Administration:

Admin > Operations Management > Design Operations Content > 
Indicator Mapping Rules 

 2 Expand the Filters pane, select View.

The View field becomes active.

 3 Select a view from the Views list or click the Browse Views (...) button to 
open the Views selection dialog box, select the view that you want to use, 
and select OK.

The CI Types tree is updated to display only the CI types that match the 
view selected.

If no item matches the filter, the No CI type found message is displayed.
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Note: You can use the Show only CI types with assigned indicator mapping 
rules filter and the filtering by a selected view together. The result displays 
only CI types contained within the specified view and with assigned 
indicators.
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How to Create and Edit Indicator Mapping Rules    

In this task, you learn how to set up an indicator mapping rule that searches 
filtered events for attribute values that are then used to set an indicator 
state. If the mapped indicator sets an HI, the corresponding state for the HI 
is also set.

Note: For information on button actions, see "ETI Mapping Rules Pane" on 
page 338. For more information about the window you use to set up and 
test filters, see "Filtering Events" on page 211.

To define an indicator mapping rule:

 1 Open the Indicator Mapping Rules manager from Operations 
Management Administration:

Admin > Operations Management > Design Operations Content > 
Indicator Mapping Rules

 2 Select the CI type for which you want to define an Indicator Mapping 
Rule.

 3 To create or edit indicator mapping rules, in the ETI Mapping Rules pane, 
use the  button to open the Create New Mapping Rule, or use the  
button to open the Edit Mapping Rule dialog box for an existing indicator 
mapping rule.

The Create New Mapping Rule or Edit Mapping Rule dialog box opens.

Note: Use the Duplicate item  button to create a mapping rule that is 
similar to an existing mapping rule.

 4 Enter a Display Name, Name, and a short description for the new 
mapping rule.
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 5 Optional: Select Active to include the current mapping rule in the 
matching process.

Clearing Active, disables an indicator mapping rule. This can be useful if 
you want to exclude an indicator mapping rule from a list of rules for 
testing purposes.

 6 Select an event filter for the mapping rule from the Events Filter list. The 
filter determines which events to consider in the mapping operation.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.

 7 Select an Event Type Indicator.

Note: Only indicators associated with the selected CI are shown in the 
Select Indicator dialog box. Indicators inherited from parent CIs are not 
displayed.

The indicator that you want to select must already be available. If a 
suitable indicator is not available, first create it and then create the ETI 
Mapping Rule. 

The  button in the ETI Mapping Rules menu bar opens the Indicators 
manager.

 8 Select a Map to Indicator State mode. 

An event attribute value must be mapped to an indicator state, using one 
of the following methods:

➤ Based on Severity (information from the event)

➤ Specific Indicator State (can be selected in the mapping rule)
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Note: If no obvious indicator state is available for Based on Severity 
mapping, Operations Management uses the nearest available state. For 
example, if a Critical event is mapped to an event type indicator that only 
has states of Major and Normal severities, Operations Management maps 
critical events to the event type indicator state with severity Major.

If you define multiple states with the same severity, mapping is 
undefined.

 9 Select OK to save your changes.

The new indicator mapping rule is added to the end of the list of 
indicator mapping rules displayed in the ETI Mapping Rules pane.



Chapter 12 • Indicator Mapping Rules

333

How to Order Indicator Mapping Rules    

In this task, you learn how to change the order of indicator mapping rules.

Note: For information on button actions, see "ETI Mapping Rules Pane" on 
page 338. For more information about the window you use to set up and 
test filters, see "Simple Filter Configuration Dialog Box" on page 231.

To change the order of execution of an indicator mapping rule:

 1 Open the Indicator Mapping Rules manager from Operations 
Management Administration:

Admin > Operations Management > Design Operations Content > 
Indicator Mapping Rules

 2 Select the CI type for which you want to change the order of the indicator 
mapping rules, for example:

ConfigurationItem > InfrastructureElement > Node > Computer > 
Windows

 3 Select the mapping rule for which you want to change the order.

 4 Using the Move Up  and Move Down  buttons, rearrange the order 
of the selected mapping rule and repeat for any other indicator mapping 
rules that you want to move.

The order of the indicator mapping rules, including inherited rules, can 
also be seen in the Mapping Overview pane.

Note: Reordering rules has an affect on lower CI type levels. For example, 
if you reorder rules for Computer, this change is made on both the 
Windows and Computer level.
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Indicator Mapping Rules User Interface 

This section describes the information displayed in the Indicator Mapping 
Rules manager. The information in this section describes the buttons, icons, 
labels, and menu options that you use to create, configure, and manage the 
indicator mapping rules that to set indicator states.

In this section, you can find information about the following topics:

➤ CI Types Pane on page 335

➤ ETI Mapping Rules Pane on page 338

➤ Mapping Overview Pane on page 341

➤ Create New and Edit Mapping Rule Dialog Box on page 342

➤ Select Indicator Dialog Box on page 345



Chapter 12 • Indicator Mapping Rules

335

CI Types Pane 

The CI Types pane in the Indicator Mapping Rules manager displays the 
configuration item types that represent the objects in your IT environment. 
You use the Indicator Mapping Rules manager to perform the following 
tasks:

➤ View the indicator mapping rules that are assigned to a selected 
configuration item type

➤ Configure new indicator mapping rules and assign them to individual 
configuration items types

You can use the Expand ( ) and Collapse ( ) buttons to expand or 
collapse the CI tree. The Expand ( ) button expands all CI types which are 
under the selected CI type. The Collapse ( ) button collapses all open 
nodes except for the selected node.

To access Select Admin > Operations Management > Design 
Operations Content > Indicator Mapping Rules

Important 
information

If you want to modify or manage configuration item 
types, use the CI Types Manager:

Admin > RTSM Administration > Modeling > CI Type 
Manager

Relevant tasks To use the CI Types pane, see "How to Search and Filter 
CI Types" on page 326.

See also For more information about configuring indicator 
mapping rules, see "How to Create and Edit Indicator 
Mapping Rules" on page 330 and "How to Order 
Indicator Mapping Rules" on page 333.
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The information displayed in the CI Types pane of the Indicator Mapping 
Rules manager includes the following details.

UI Element (A-Z) Description

Refreshes the contents of the configuration item tree. Use 
if new content becomes available while you are working 
or you uploaded new contents (for example, from 
another user or the command-line interface).

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.

Finds the next occurrence of the CI Type for which you 
are searching. For more information about searching, see 
"How to Search and Filter CI Types" on page 326.

Collapses the Filter pane.

Expands the Filter pane for use.

CI Types Hierarchical list representing the configuration item 
types that you want to monitor in your IT environment.

If the CI Types list is filtered, (filtered) is displayed next to 
the CI Types title.

The font weight is used to show the assignment of 
indicators to CI types:

➤ Normal font weight: No assignment but a child has 
assigned indicators.

➤ Gray font weight: No indicator mapping rule assigned 
for this CI type and its children. 

➤ Bold font weight: Indicator mapping rules assigned 
directly to this CI Type.



Chapter 12 • Indicator Mapping Rules

337

Filter Used to search for specific CI types and view CI types that 
match specified filter criteria. There are two filters:

➤ Show only CI types with assigned indicator mapping 
rules

➤ View (shows CI types contained within a specified 
view)

➤ ... Opens the Views dialog box from which you can 
select a view with which to filter CI types.

Note: If you apply a view to the filter CI Types tree which 
removes all CI types with assignments, the 
ConfigurationItem entry remains in normal text, 
indicating that assignments exist. Remove the view, or 
select a more appropriate view to display the CI types 
with assignments that you require.

For more information about searching and filtering, see 
"How to Search and Filter CI Types" on page 326.

Show only CI Types 
with assigned 
mapping rules

Filters the CI Types tree to display all CI types that have 
indicator mapping rules assigned to them.

View Enables selection of the view that you want to use.

The CI Types tree is updated to display only the CI types 
that match the view selected.

UI Element (A-Z) Description
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ETI Mapping Rules Pane 

The ETI Mapping Rules pane displays a list of the rules that Operations 
Management uses to map the attributes of events to indicator states in 
Operations Management. You can edit and delete existing indicator 
mapping rules, and configure and test filters for them. You can also change 
the order of execution the indicator mapping rules. For more information, 
see "How to Create and Edit Indicator Mapping Rules" on page 330.

The ETI Mapping Rules pane displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Design 
Operations Content > Indicator Mapping Rules

Relevant tasks To configure indicator mapping rules, see:

➤ "How to Create and Edit Indicator Mapping Rules" on 
page 330.

➤ "How to Order Indicator Mapping Rules" on page 333.

See also For more information about configuring indicator 
mapping rules, see "Indicator Mapping Rules Manager 
Basics" on page 320 and "Mapping Events to Indicators" 
on page 322.

UI Element (A-Z) Description

Refreshes the contents of the ETI Mapping Rules pane. 
Use if new indicator mapping rules become available 
while you are working.

New Item: Opens the Create New Mapping Rule dialog 
box, which enables you to define a new indicator 
mapping rule and add it to the list already assigned to the 
selected configuration item type.

Duplicate Item: Opens the Edit Mapping Rule dialog box 
and creates a duplicate of the selected indicator mapping 
rule. The name of an indicator mapping rule is for 
internal use only and must be unique.
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Edit Item: Opens the Edit Mapping Rule dialog box, 
which you can use to modify and save indicator mapping 
rules. 

Delete Item: Removes the selected mapping rule.

Find Matching Events: Finds events that match the 
selected filter specified in the selected indicator mapping 
rule.

Find Matching Events selects all events containing the 
indicator set by the selected indicator mapping rule. 
These events must match the filter configured for the 
selected mapping rule and must be related to the selected 
CI type.

Go to Indicators: Opens the Indicators Repository.

Manage Event Filters: Opens the Manage Event Filters 
dialog box, enabling you to select the event filter that 
you want to apply.

From the Select an Event Filter dialog box, you can also 
open the Filter Configuration dialog box to create an 
event filter, edit or delete an existing event filter.

For information about defining filters, see "Filtering 
Events" on page 211.

Move Down: Moves the selected mapping rule down to a 
lower priority position.

Move Up: Moves the selected mapping rule up to a 
higher priority position.

Active Indicates if the mapping rule is active or not. Only active 
rules are applied during the mapping process.

Display Name Display name of the mapping rule available.

UI Element (A-Z) Description
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Event Filter Name of the event filter that is active in the mapping 
rule. Filters determine which events the mapping rule 
should consider.

Indicator Name of the selected indicator.

Map to Indicator 
State

Indicator state set using one of the following methods:

➤ Based on severity: Indicator state used is governed by 
the severity information from the event.

➤ Specific Indicator State: Specifies an indicator state 
independent of any severity information from the 
event.

Order Where more than one mapping rule is available for a 
configuration item type, the number in the Order 
column indicates the order in which the rules are applied 
during the mapping process. Using the Move Up and 
Move Down buttons, you can change the position of 
rules in the list.

Note: If a rule matches, no further rules are applied.

UI Element (A-Z) Description
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Mapping Overview Pane 

The Mapping Overview pane displays a summary of the rules that 
Operations Management uses to map the attributes of events to indicator 
states in Operations Management for the selected CI type. Inherited rules 
are also displayed and labeled with the CI type for which they are defined.

The Mapping Overview pane displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Design 
Operations Content > Indicator Mapping Rules

Relevant tasks To configure indicator mapping rules, see:

➤ "How to Create and Edit Indicator Mapping Rules" on 
page 330.

➤ "How to Order Indicator Mapping Rules" on page 333.

See also For more information about configuring indicator 
mapping rules, see "Indicator Mapping Rules Manager 
Basics" on page 320 and "Mapping Events to Indicators" 
on page 322.

UI Element (A-Z) Description

Display Name Display name of the mapping rule available.

Event Filter Name of the event filter that is active in the mapping 
rule. Filters determine which events the mapping rule 
should consider.

Indicator Name of the selected indicator.

Map to Indicator 
State

Indicator state set using one of the following methods:

➤ Based on severity: Indicator state used is governed by 
the severity information from the event.

➤ Specific Indicator State: Specifies an indicator state 
independent of any severity information from the 
event.
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Create New and Edit Mapping Rule Dialog Box

The Create New Mapping Rule and Edit Mapping Rule dialog boxes are used 
to create and edit indicator mapping rules. Indicator mapping rules use 
event filters to identify event attributes that are used to set or modify an 
indicator state.

Note: Use the Duplicate Item  button to create a mapping rule that is 
similar to an existing mapping rule.

To access Select Admin > Operations Management > Design 
Operations Content > Indicator Mapping Rules

In the ETI Mapping Rules pane, click the  button to 
open the Create New Mapping Rule dialog box or the  
button to open the Edit Mapping Rule dialog box.

Important 
information

Only indicators associated with the selected CI are shown 
in the Select Indicator dialog box. Indicators inherited 
from parent CIs are not displayed.

Relevant tasks To configure indicator mapping rules, see:

➤ "How to Create and Edit Indicator Mapping Rules" on 
page 330.

➤ "How to Order Indicator Mapping Rules" on page 333.

See also For more information about configuring indicator 
mapping rules, see "Indicator Mapping Rules Manager 
Basics" on page 320 and "Mapping Events to Indicators" 
on page 322.
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The Create New Mapping Rule dialog box and the Edit Mapping Rules 
dialog box display the UI elements listed in the following table.

UI Element (A-Z) Description

Active Indicates if the mapping rule is active or not. Only active 
rules are applied during the mapping process.

Description Brief summary of the rule’s action.

Display Name External name for the mapping rule. The external name 
(label) is the name that is visible to users.

Event Filter Name of the event filter that is active in the mapping 
rule. Filters determine which events the mapping rule 
should consider.

Use the list to select the filter to apply in the rule. The 
filter determines which events to consider in the 
mapping operation. For details about creating filters, see 
"Filtering Events" on page 211.

Note: The filter dialog box displayed for Indicator 
Mapping Rules is customized for this task. For example, 
the Assigned To: pane is not displayed as it is not 
relevant.

Indicator Selects the indicator you want to set with the event 
attribute.
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Map to Indicator 
State

Selects how the indicator state is mapped to the event.

You can select one of the following:

➤ Based on Severity: Indicator state used is governed by 
the severity information from the event.

➤ Specific Indicator State: Specifies an indicator state 
independent of any severity information from the 
event.

Name Internal name of the indicator mapping rule. This is the 
name used in the event received from HPOM to match 
the indicator in Operations Management. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten.

Note: Maybe disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).

UI Element (A-Z) Description
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Select Indicator Dialog Box

The Select Indicator dialog box is used to select an indicator to be mapped to 
events matching the mapping rule. 

The Select Indicator dialog box display the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Design 
Operations Content > Indicator Mapping Rules

In the ETI Mapping Rules pane, click the  button to 
open the Create New Mapping Rule dialog box or the  
button to open the Edit Mapping Rule dialog box. Open 
the Select Indicator (...) dialog box.

Important 
information

Only indicators associated with the selected CI are shown 
in the Select Indicator dialog box. Indicators inherited 
from parent CIs are not displayed.

Relevant tasks To configure indicator mapping rules, see:

➤ "How to Create and Edit Indicator Mapping Rules" on 
page 330.

➤ "How to Order Indicator Mapping Rules" on page 333.

See also For more information about configuring indicator 
mapping rules, see "Indicator Mapping Rules Manager 
Basics" on page 320 and "Mapping Events to Indicators" 
on page 322.

UI Element (A-Z) Description

Refreshes the contents of the Select Indicators list. Use if 
new indicators becomes available while you are working.

Toggle Grouping by Type: Toggles between a flat list of 
all indicators, identified with indicator type icons and a 
list where HIs and event type indicators are grouped in 
separate lists.
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13
View Mappings 

This chapter includes:

Concepts

➤ View Mappings Manager on page 348

➤ Health Top View Management on page 348

➤ Mapping Health Top Views on page 349

Tasks

➤ How to Search and Filter CI Types on page 351

➤ How to Map a View to a Configuration Item Type on page 354

➤ How to Test a View Mapping on page 356

Reference

➤ View Mappings User Interface on page 357

Troubleshooting and Limitations on page 366
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Concepts

View Mappings Manager

This chapter describes the View Mappings manager used to map existing 
Views to one or more configuration item types for the Health Top View in 
the Health Perspective and manage the list of mapped views.

The View Mappings manager enables users to perform the following 
management-related tasks:

➤ Map an existing View to one or more configuration item types

➤ Manage the list of mapped Views

➤ Display the list of mapped Views in the Selected View list located in the 
Health Top View pane of the Health Perspective tab

Note: Only users with the appropriate access permissions can use 
Operations Management Administration. For more information about user 
management, see "User Management" on page 629.

 

Health Top View Management

Health Top Views are the Views that Operations Management uses to display 
configuration items in the Health Top View pane of the Health Perspective 
tab. A view displays a defined subset of the RTSM ConfigurationItem model, 
for example, only configuration items that relate to a specific area of interest 
such as Storage or Databases. 
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Note: Health Top Views and topology views are not the same. Health Top 
Views have one parent and the same element can appear more than once if 
required by the relationships being displayed. Topology views are a flat 
representation of the database elements where elements appear only once.

Generally, views enable you to limit both the type and the amount of 
information displayed. For example, selecting a view in the Event Browser 
CI Tree refines the number and type of configuration item types loaded 
from the RTSM and displayed in the list of available configuration item 
types.

Similarly, you can restrict the amount and type of information presented in 
the Health Top View pane by selecting a view from the Selected View list. 
The contents of the Select View list depend on the configuration items in 
the Health Top View, which are themselves related to the event selected in 
the Event Browser, and the views mapped to them in View Mappings.

You can use the Content Packs manager to import and export the list of 
mapped views displayed in the Selected View list. The Import and Export 
features of the Content Packs manager provide a convenient way for 
software administrators to exchange lists of mapped views between 
instances of Operations Management.

 

Mapping Health Top Views 

You can map Views to configuration item types. The mapped Views appear 
in the Selected Views list displayed in the Health Top View pane of the 
Health Perspective tab.
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Views enable users to refine both the type and the amount of information 
displayed. For example, selecting a view in the Event Perspective CI Tree 
refines the number and type of configuration item types loaded from the 
RTSM and displayed in the list of available configuration item types. 
Similarly, users can restrict the amount and type of information presented 
in the Health Top View pane by selecting a view from Selected View list. The 
views displayed in the Selected View list is determined by the view 
mappings defined in the View Mappings manager.

You can also use the View Mappings manager to filter the views that the user 
sees in the Selected View list according to the category of an event, such as 
DB or Storage. In this way, you refine the available views to those that make 
most sense for a given usage model. For example, if you map the DB2 view 
to the configuration item type DB Tablespace, you can also specify in the 
mapping rule that only views containing configuration item types 
concerning events belonging to event categories DB or Storage (or both) are 
visible. 

For more information about the contents of the Health Top View pane and, 
in particular, the contents of the Selected Views list, see "Health Top View" 
on page 135.
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Tasks

How to Search and Filter CI Types

In this task, you learn how to search for specific CI types and view CI types 
that match specified filter criteria. There are two filters:

➤ Show only CI types with assigned view mappings

➤ View (Show CI types contained within a specified view)

Note: Join relationships defined in views are ignored.

For information on button actions, see "View Mappings User Interface" on 
page 357. 

Searching for a CI Type
You can use the Search field to locate the first instance of the CI type name 
or part of a name that you specify.

To search for a specified CI type:

 1 Open the View Mappings manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > View 
Mappings 

 2 In the Search field, enter a string.
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Note: The search string must be at least three characters long. Searching is 
started automatically as soon as the third character is entered and the first 
match is highlighted. This prerequisite avoids searches being started too 
often and resources being blocked. Names with less than three characters 
can be found by clicking on the  button.

The first CI type in the CI Types tree to match the specified string is 
highlighted. If that CI is not initially visible, the CI tree is expanded to 
display the CI Type.

 3 Click the  button to find the next occurrence of the CI Type for which 
you are searching.

Finding CI Types with Assigned View Mappings
You can use the filter to display all CI types that have content assigned to 
them.

To filter the CI tree to show only CI types with assigned view mappings:

 1 Open the View Mappings manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > View 
Mappings 

 2 In the Filter pane, select Show only CI types with assigned view maps.

The CI Types pane displays only those CI types that have view mappings 
assigned.

Note: You can use the Show only CI types with assigned view maps filter and 
the filtering by a selected view together. The result displays only CI types 
contained within the specified view and with assigned view mappings.
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Filtering the CI Types Tree with a View
You can use the filter to display all CI types that are contained within a 
certain view.

Note: Join relationships defined in views are ignored.

To filter the CI tree with a view:

 1 Open the View Mappings manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > View 
Mappings 

 2 In the Search pane, select View.

The View field becomes active.

 3 Select a view from the list or use the Browse Views (...) button to open the 
Views selection dialog box, select the view that you want to use, and 
select OK.

The CI Types tree is updated to display only the CI types that match the 
view selected.

You can use the Expand ( ) and Collapse ( ) buttons to fully expand or 
collapse the CI tree. If a filter is set, only those items selected by the filter 
are expanded.

If no item matches the filter, the No CI type found message is displayed.

Note: You can use the Show only CI types with assigned view maps and the 
filtering by a selected view together. The result displays only CI types 
contained within the specified view and with assigned view mappings.
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How to Map a View to a Configuration Item Type

This task shows you how to map a view to a configuration item type and 
add the newly created view mapping to the complete list of the Operations 
Management views that are mapped to configuration item types.

Note: For information on button actions, see "View Mappings User 
Interface" on page 357. 

To map an view to a CI type:

 1 Open the View Mappings manager from Operations Management 
Administration:

Admin > Operations Management > Design Operations Content > 
View Mappings

 2 In the Model Explorer pane, select the configuration item that you want 
to map to a view.

 3 In the View Mappings manager, click the  button to open the Create 
New View Mapping dialog box.

 4 In the Create New View Mapping dialog box, select a view that contain a 
reference to the selected configuration item from the list or use the 
Browse Views (...) button to open the Views selection dialog box, select 
the view that you want to use, and select OK.

Make sure that the view you selected in the previous step is now displayed 
in the View field.

 5 Optional: If you want to further restrict the views displayed according to 
event category, select the new view mapping definition and type all or 
part of the name of an event category into the Event Category Pattern 
box using standard regular expression, if desired. If you want to specify 
multiple event categories, use the pipe symbol (|), for example:

Unix | Windows
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Note: It is also possible to define more than one view mappings with the 
same view but different event categories, for example:

CI type: Node, View All Unix Nodes, event category: Unix

CI type: Node, View All Unix Nodes, event category: Windows

 6 Enter a precedence value for the view mapping. 

The view with the highest precedence is shown in the Health Top View as 
default. The precedence of inherited view mappings is also taken into 
account. The valid Precedence range is 0 to 1000.

 7 Select OK to close the Create New View Mapping dialog box.
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How to Test a View Mapping

This task shows you how to check a view mapping.

To test a view mapping:

 1 Open the Health Perspective tab:

Applications > Operations Management > Health Perspective

 2 In the Event Browser pane, select an event related to the view specified in 
the view mapping and, if you set an additional event category filter, one 
that belongs to one of the event categories specified in the filter.

 3 In the Health Top View pane, make sure that the new view mapping 
definition is displayed in the Selected Views list.
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View Mappings User Interface

This section lists and describes the layout of the View Mappings manager.

➤ CI Types Pane on page 358

➤ View Mappings Pane on page 361

➤ New and Edit View Mapping Dialog Boxes on page 363

➤ Select a View Dialog Box on page 365
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CI Types Pane 

The CI Types pane in the View Mappings Manager enables you to choose 
the configuration item types that you want to map to a view.

The CI Types pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > View Mappings

Important 
information

If you want to modify or manage configuration item 
types, use the CI Types Manager:

Admin > RTSM Administration > Modeling > CI Type 
Manager

Relevant tasks To use the CI Types pane, see "How to Search and Filter 
CI Types" on page 351.

See also For more information about configuring view mappings 
rules, see:

➤ "View Mappings Manager" on page 348.

➤ "Health Top View Management" on page 348.

➤ "Mapping Health Top Views" on page 349.

UI Element (A-Z) Description

Refreshes the contents of the configuration item tree. Use 
if new content becomes available while you are working 
or you uploaded new contents (for example, from 
another user or the command-line interface).

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.
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Entering a string with more than 2 characters in the 
search field locates the first instance of the string in the 
CI Tree.

Clicking the search button finds the next occurrence of 
the string for which you are searching. For more 
information about searching, see "How to Search and 
Filter CI Types" on page 351.

Expands the Filter pane.

Collapses the Filter pane.

CI Types Hierarchical list representing the configuration item 
types that you want to monitor in your IT environment. 
To display the required CI Type, browse to and select the 
item of interest. The details associated with the CI Type 
are displayed.

If the CI Types list is filtered, (filtered) is displayed next to 
the CI Types title.

When CI types and their children have no objects 
assigned, their entries appear dimmed. 

When objects are directly assigned to a CI type, their 
entries appear bolded.

UI Element (A-Z) Description
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Filter Used to search for specific CI types and view CI types that 
match specified filter criteria. There are two filters:

➤ Show only CI types with assignments

➤ View (Shows CI types contained within a specified 
view)

➤ ... Opens the Views dialog box from which you can 
select a view with which to filter CI types.

Note: If you apply a view to the filter CI Types tree which 
removes all CI types with assignments, the 
ConfigurationItem entry remains in normal text, 
indicating that assignments exist. Remove the view, or 
select a more appropriate view to display the CI types 
with assignments that you require.

For more information about searching and filtering, see 
"How to Search and Filter CI Types" on page 351.

Show only CI types 
with 

Displays in the CI Tree only CI Types with assignments.

View Displays in the CI Tree only CI Types contained within 
the selected view.

UI Element (A-Z) Description
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View Mappings Pane 

The View Mappings manager enables you to choose the view you want to 
map to the selected configuration item.

The View Mappings pane displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Design 
Operations Content > View Mappings

Relevant tasks To configure view mapping rules, see:

➤ "How to Map a View to a Configuration Item Type" on 
page 354.

➤ "How to Test a View Mapping" on page 356.

See also For more information about configuring view mappings 
rules, see:

➤ "View Mappings Manager" on page 348.

➤ "Health Top View Management" on page 348.

➤ "Mapping Health Top Views" on page 349.

UI Element (A-Z) Description

Refreshes the list of view mappings.

New Item: Opens the Create New View Mapping dialog 
box, to create a view mapping definition. Enter a 
description and select a view.

Edit Item: Displays the Edit View Mapping dialog box, 
which enables you to modify the selected View Mapping.

Delete Item: Removes the selected view mapping 
definition from the list of view mappings displayed.
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Event Category 
Pattern

You can restrict the views displayed in the Selected View 
list of the Health Top View pane in the Health 
Perspective tab based on the event category, for example, 
DB or Storage. Enter a regular expression that matches all 
or part of the event category name that you want to use 
to filter the displayed views. 

Note: Event category pattern can contain a maximum of 
255 characters.

Mapping Description Short description of the mapping listed in the View 
column.

Precedence The view with the highest precedence is shown in the 
Health Top View as default. The precedence of inherited 
view mappings is also taken into account. The valid 
Precedence range is 0 to 1000. 

View Name of the view mapped to the selected configuration 
item type.

UI Element (A-Z) Description
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New and Edit View Mapping Dialog Boxes

The Create New View Mapping dialog box enables you to map a view to the 
selected configuration item. From the and Edit View Mapping dialog box, 
you can edit existing view mappings.

The Create New View Mapping and Edit View Mapping dialog boxes display 
the UI elements listed in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > View Mappings

In the View Mappings manager, click the  button to 
open the Create New View Mapping dialog box.

Relevant tasks To configure view mapping rules, see:

➤ "How to Map a View to a Configuration Item Type" on 
page 354.

➤ "How to Test a View Mapping" on page 356.

See also For more information about configuring view mappings 
rules, see:

➤ "View Mappings Manager" on page 348.

➤ "Health Top View Management" on page 348.

➤ "Mapping Health Top Views" on page 349.

UI Element (A-Z) Description

Event Category 
Pattern

Regular expression that matches all or part of the event 
category name that you want to use to filter the 
displayed views, for example: DBStorage, or Tablespace.

Note: Event category pattern can contain a maximum of 
255 characters.

ID Unique identification number for internal purposes only 
(Edit only). 

Mapping Description A short explanation of the application of the mapping.
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Precedence The view with the highest precedence is shown in the 
Health Top View as default. The precedence of inherited 
view mappings is also taken into account. The valid 
Precedence range is to 1000. 

View Name of the view that you want to map to the CI type 
selected in the CI Types pane, for example: 
ConfigurationItem 

Note: Created view is read-only in the Edit dialog box 
and cannot be changed. Create a new view and delete the 
old one.

UI Element (A-Z) Description
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Select a View Dialog Box

The Select a View dialog box enables you to choose the view you want to 
map to the selected configuration item.

The Select a View dialog box displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Design 
Operations Content > View Mappings

In the View Mappings manager, click the  button to 
open the Create New View Mapping dialog box. Open 
the Select a View (...) dialog box.

Relevant tasks To configure view mapping rules, see:

➤ "How to Map a View to a Configuration Item Type" on 
page 354.

➤ "How to Test a View Mapping" on page 356.

See also For more information about configuring view mappings 
rules, see:

➤ "View Mappings Manager" on page 348.

➤ "Health Top View Management" on page 348.

➤ "Mapping Health Top Views" on page 349.

UI Element (A-Z) Description

Refreshes the list of views.

Go to Modeling Studio: Opens the Modeling Studio.

Collapse Others: Collapses all open branches except for 
the selected branch.

Expand Selection: Expands the list to display items 
belonging to the selected group.
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Troubleshooting and Limitations 

This section provides the following help on troubleshooting problems with 
the View Mappings manager:

➤ "No Content in the View Mappings Pane" on page 366

➤ "Select a View Dialog Box Does not Contain Desired View" on page 366

No Content in the View Mappings Pane
No configuration item type is selected. Select a configuration item type in 
the CI Types pane of the View Mappings manager.

Select a View Dialog Box Does not Contain Desired View

➤ The desired view does not contain a reference to the configuration item 
type to which you want to map a view. Either add the configuration item 
type to the view using RTSM tools, or map a view to another 
configuration item type.

➤ No, or incorrectly defined, event category is specified in the Event 
Category Pattern box. If necessary, modify the string (or regular 
expression) specified in the Event Category Pattern box when configuring 
the view mapping definition. Remember to explicitly save the modified 
definition.
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14
Correlation Rules

Note: To be able to use the event correlation functionality of Operations 
Management, the Event Management Foundation and Correlation licenses 
are required. For detailed information on licensing, see the the HP Business 
Service Management Deployment Guide PDF.

This chapter includes:

Concepts

➤ Correlation Rules Manager Basics on page 369

➤ Topology-Based Event Correlation on page 370

➤ Correlation Rules on page 371

➤ Cross-Domain Event Correlation on page 371

➤ Event Correlation Rule Topology on page 372

➤ Correlation Rule Symptoms and Causes on page 374

Tasks

➤ How to Configure Topology-based Event Correlation Rules on page 376

➤ How to Create Event Correlation Rules on page 378

➤ How to Select Topology Views on page 380

➤ How to Define the Rule Topology on page 381

➤ How to Specify Correlation Rule Symptoms on page 383

➤ How to Specify Correlation Rule Causes on page 384
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➤ How to Set the Correlation Time Limit on page 385

➤ How to Set the Correlation Auto-Extend Time on page 386

Reference

➤ Correlation Rules User Interface on page 387

Troubleshooting and Limitations on page 405
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Concepts

Correlation Rules Manager Basics 

This chapter introduces the concept of topology-based event correlation. 
The information in this chapter explains how to configure correlation rules 
and apply them to the indicators that are assigned to the configuration item 
types you are monitoring with Operations Management. You can use 
topology-based event correlation to help you better understand, monitor, 
and manage the problems that can have an effect on the objects in your IT 
environment.

The Correlation Rules manager enables you to define and deploy rules that 
use indicators to correlate the events occurring in the different domains 
throughout the managed IT environment. You can use the Correlation Rules 
manager to perform the following tasks:

➤ Define and manage correlation rules

➤ Visualize the topology of correlation rules

➤ View cause and symptoms events

➤ Manage indicators and their states

➤ Browse the hierarchy of cross-domain correlation rules

Note: You can use user roles to restrict access to the Correlation Rules 
manager. For more information about user authorization, see "User 
Management" on page 629.

To access the Correlation Rules manager, select the following menu option: 

Admin > Operations Management > Design Operations Content > 
Correlation Rules
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Topology-Based Event Correlation 

You can define rules that use indicators to correlate or link related events 
occurring in the different domains of the managed IT environment. 
Correlating events that are either generated by or related to the same object 
greatly reduces the number of events displayed in the Event Browser. The 
reduced number of events in the Event Browser helps operators to locate the 
cause of the problems more quickly and efficiently.

The correlation process determines the cause of an event. An overview of all 
events affected by the correlation process is available separately in the 
Related Events tab of the Details pane. The overview enables you to drill 
down the correlation history and browse through all correlated events.

The event correlation process uses the topology-based views stored in the 
RTSM to specify which configuration item types can be considered for 
inclusion in a correlation rule. The topology-based views improve the 
correlation process by adding path-related constraints to the correlation 
rule. Topology-based event correlation requires that a relationship exist 
between the configuration items specified in the correlation rule.

Note: The view used to define the configuration item types in a correlation 
rule must also demonstrate that a relationship exists between the 
configuration item types specified in the rule. 

A time limit exists for the processing of the correlation rules you define with 
the Correlation Rules manager. All the events specified in the correlation 
rule must occur within a defined period of time. By default, the time limit is 
set to 960 seconds. If individual symptom or cause events occur outside of 
the defined time limit, they appear in the Event Browser as normal, 
uncorrelated events. For more information about the time setting, see "How 
to Set the Correlation Time Limit" on page 385.
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Correlation Rules 

Use the Correlation Rules manager to view, define, and apply correlation 
rules. Correlation rules associate selected configuration item types with 
defined indicator states to trigger a correlation process. The correlation 
process results in the highlighting of one or more configuration items as 
causes.

Correlation rules require a combination of symptoms and causes. Both 
symptoms and causes are defined by selecting configuration item types. 
Each configuration item type (such as a DB2 database) that you specify as a 
potential symptom requires one or more indicators (for example, Run State, 
or Availability) to be defined for it. Each indicator must have a state (for 
example, up, down, or offline). Configuration item types you choose as causes 
also require an indicator and a state.

For example, the information in the following table defines a simple 
correlation rule for a database instance. Operations Management displays 
cause events in the Event Browser and the symptom events in the Related 
Events tab of the Message Details pane.  

Cross-Domain Event Correlation 

The Correlation Rules manager enables you to set up rules that correlate 
indicators for configuration item types in multiple and different domains, 
for example, database, storage, and web application. Cross-domain 
correlation connects a chain of rules that are defined in different domains. 
The correlation process can use the symptom of one rule as the cause of the 
next rule in the chain, or vice versa.

Rule Type CI Type Event Type Indicator
Event Type 
Indicator State

Symptom DB2 Network Availability Offline

Symptom DB2 Buffer Hit Ratio Low

Symptom Process Run state Down

Cause DB Table Space Buffer Performance Slow
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The link between correlation rules in different domains is the same indicator 
state assigned to the same configuration item type. In one rule, you can 
define an indicator state as a symptom for a specific configuration item 
type. In another rule for a different domain, you can define the same 
indicator state as a cause for the same configuration item type. If all the 
events occur in the different domains as expected and trigger correlation 
rules, the correlation process displays in the Event Browser only the cause 
event from the last rule in the event correlation chain.

Note:  Cross-domain correlation rules must share at least one identical 
combination of configuration item type and indicator state.

For example, if all the necessary correlation rules are defined for the 
database, storage, and web application domains, and the necessary indicator 
states are being monitored for a shared configuration item, the Correlation 
Rules manager can determine that a problem with physical disk utilization 
in the storage domain is the cause of the problem concerning the 
availability of the web server.

The Correlation Rules pane in the Correlation Rules manager incorporates a 
list of correlation rules containing symptoms or states that also feature in 
rules defined for a different domain. In cross-domain rules, indicator states 
configured as a symptom in one rule are also defined as a cause in a rule 
defined in another domain. You can choose whether to view rules that 
determine the symptom or the cause of an event and expand the item to see 
if the rule is part of a chain.

Event Correlation Rule Topology 

It is easier to understand the context in which a correlation rule exists and 
how the rule works if you can see the topology of the configuration item 
types that are included in the rule. Operations Management uses the Rule 
Topology pane in the Correlation Rules manager to graphically represent 
the correlation rule you are designing or modifying. The configuration item 
types that you include in the correlation rule are highlighted in the 
topology of the view to which they belong.
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Labels indicate the type of objects in the correlation rule and the 
relationship between the objects. For example, correlation rules can include 
relationships such as Contains, Depends on, or Member. 

Note: You cannot change or modify the type of relationship displayed in the 
Rule Topology pane. The relationship is defined in the view. Use the 
Modeling Studio to set up new views and new relationships.

You use the Rule Topology pane to specify which parts of the view topology 
to consider for the correlation rule you are configuring. In the Rule 
Topology pane, you select the configuration item types and select the 
relationship between them. These relationships are defined in the RTSM. 
The Correlation Rules manager checks that the rule you define indicates 
both the configuration item types to consider in the event correlation 
process and their relationship. If the rule does not indicate the relationship 
between configuration item types, the Correlation Rules manager does not 
permit you to save it.

The rule topology shows the relationships between all the configuration 
item types in the chosen view. If only one topological path exists between 
the configuration item types in your correlation rule, Operations 
Management automatically highlights the path for you. If more than one 
path exists, you must manually select the path between the configuration 
item types specified as symptoms and cause in the correlation rule.

If you configured multiple correlation rules in a chain, where a cause in one 
rule is a symptom in another, Operations Management displays useful 
information about the indicator states used in the correlation rule and 
enables you to navigate between the rules following the correlation chain.

For more information about the contents of the Rule Topology pane, see 
"Rule Topology Pane" on page 392. For more information about configuring 
rule topology, see "How to Define the Rule Topology" on page 381.
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Correlation Rule Symptoms and Causes 

In Operations Management, a correlation rule defines events as either causes 
or symptoms. If one or more of the events specified as symptoms occurs 
within a defined period of time, the triggered rule highlights the cause event 
in the Event Browser and creates a subgroup containing the symptom 
events.

Note: The Event Browser uses icons to distinguish between events that are 
configured as the cause in a correlation rule and events that are configured 
as symptoms. For more information about icons in the Event Browser, see 
"Event Browser Icons, Buttons, and Context Menus" on page 71.

Every rule that Operations Management uses to correlate events must have 
at least one symptom and one cause. Multiple cause indicators can be 
specified as long as they are specified for the same CI type. In the context of 
Operations Management correlation rules, symptoms and causes are defined 
as follows:

➤ Symptom

Symptoms in a correlation rule are events that occur as a result of another 
event. Symptom events are mapped to individual indicator states used to 
monitor the objects in your IT environment, for example, 
Database:Unavailable or Application response:Slow.

You can map a symptom event to more than one indicator state, for 
example, Database:Down or unavailable. In this way, the event can 
contribute to more than one rule.

➤ Cause

Causes in a correlation rule are the events that are reporting problems and 
are the underlying reasons that other symptom events occur. In a 
correlation rule, cause events are mapped to an indicator state used to 
monitor the objects in your IT environment, for example: 
Network:Unreachable.
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Note: If multiple rules correlate the same symptoms at the same time but 
specify a different event as the cause, the event specified as the cause in the 
first rule triggered takes precedence and subsequent rules are ignored. 

You can configure a chain of rules that correlate events across multiple 
domains. In cross-domain event correlation, an event can be configured as a 
symptom in one rule and as a cause in another rule. Similarly, an event 
configured as a cause in one correlation rule can be configured as a 
symptom in another rule. Rules that correlate events occurring in different 
domains require at least one common configuration item type and one 
indicator state. The common configuration item type and indicator state is 
the link between the rules defined for the different domains.

The contents of the panes are linked both conceptually and graphically. If 
you select a configuration item type in the Rule Topology pane, the 
Indicators Pane displays all indicators that could be assigned as cause or 
symptom for the current configuration item.
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Tasks

How to Configure Topology-based Event Correlation 
Rules

This task describes how to configure a topology-based event correlation rule. 
A correlation rule uses multiple indicator states to determine which events 
are symptoms of a problem and which events are the causes.

This task includes the following steps:

➤ "Prerequisites" on page 376

➤ "Create the Event Correlation Rule" on page 377

➤ "Select a Topology View" on page 377

➤ "Define the Rule Topology" on page 377

➤ "Specify Event Correlation Rule Symptoms" on page 377

➤ "Specify Correlation Rule Cause" on page 377

 1 Prerequisites

To create correlation rules and policies, you need the following:

➤ Access to Operations Management Administration

➤ Good understanding of the principles of event correlation

➤ Detailed knowledge of the objects and events that you want to create 
rules to correlate

➤ Working knowledge of configuration item types, indicators, and 
indicator states

➤ Understanding of how events relate to each other in terms of cause 
and effect. For example, the availability of an email server depends on 
reliable hardware, responsive software, and a functioning network.
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 2 Create the Event Correlation Rule

In this step, you create a correlation rule to help you solve problems more 
quickly by distinguishing between events that are the symptoms of a 
problem and events that are the cause. For more information, see "How to 
Create Event Correlation Rules" on page 378.

 3 Select a Topology View

In this step, you select a view that specifies the configuration item types 
you want to use in a correlation rule. Topology views reduce and refine 
the number of configuration item types that you can use in the 
correlation rule to a more manageable level. For more information, see 
"How to Select Topology Views" on page 380.

 4 Define the Rule Topology

In this step, you define the topology of the correlation rule. Topology is 
the relationships and dependencies between the configuration item types 
in the correlation rule. For more information, see "How to Define the Rule 
Topology" on page 381.

 5 Specify Event Correlation Rule Symptoms

In this step, you specify one or more events as symptoms in a correlation 
rule. You define the symptoms of a correlation rule by specifying one or 
more indicator states used to monitor particular events in your IT 
environment, for example: Database:Unavailable or Service:Slow. For 
more information, see "How to Specify Correlation Rule Symptoms" on 
page 383.

 6 Specify Correlation Rule Cause

In this step, you specify the event that you want to define as the cause in 
a correlation rule. You define the cause of a correlation rule by specifying 
an indicator state used to monitor a particular event in your IT 
environment, for example, Network:Unreachable. For more information, 
see "How to Specify Correlation Rule Causes" on page 384.
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How to Create Event Correlation Rules

In this task, you learn how to create a correlation rule. Correlation rules 
enable you to understand more quickly how to solve problems by 
distinguishing between events that are the symptoms of a problem and 
events that are causes.

Note: You can also can manually relate events, assigning one event as a 
cause event and the other logically-related events as symptom events. For 
further information, see "How to Relate Events Manually" on page 54.

Manually-related events can also be used as the basis for creating new or 
enhancing existing correlation rules. For further information, see "How to 
Create Correlation Rules from Manually-Related Events" on page 56.

To create a correlation rule:

 1 Open the Correlation Rules manager:

Admin > Operations Management > Design Operations Content > 
Correlation Rules 

 2 In the Correlation Rules pane, click the  button. The Create New 
Correlation Rule dialog box opens.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

 3 Type a name, display name, and description for the new correlation rule.

 4 Select a topology view to determine which configuration item types are 
available for inclusion in the new correlation rule. For more information 
about selecting topology views in correlation rules, see "How to Select 
Topology Views" on page 380.

 5 Select Active to enable the rule during runtime. By default it is disabled.
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Inactive rules are identified with diagonal black line through their icons 
in the Correlation Rules pane.

 6 Optional: Specify a configuration time window. Select the check box and 
set the time period for the correlation rule you are creating. The range is 
from 0 to 9999 seconds. By default it is not enabled and the global value 
is used. 0 seconds also mean it is not enabled and the global setting is 
used.

Correlation Time Window sets the period of time in seconds that 
correlation rules wait for all required events to occur before reporting the 
cause event and emptying the correlation rule cache.

Cause and symptom events must arrive within that time frame in the 
correlation engine to be considered for correlation. A time window starts 
when a first cause or symptom event arrives that cannot be correlated 
with any other event.

Default value is 960 seconds (6 minutes). You can change this global 
value. For details, see "Topology-Based Event Correlation Settings" on 
page 717.

 7 Select OK to start creating the correlation rule.

 8 In the Finish Creating Correlation Rule pane, specify a valid the Rule 
Topology with cause and symptoms. For more information about 
selecting topology views in correlation rules, see "How to Define the Rule 
Topology" on page 381.

 9 Click the  button to save the correlation rule.
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How to Select Topology Views 

In this task, you learn how to use a topology view to specify which 
configuration item types you want to use in a correlation rule. Topology 
views reduce and refine the number configuration item types that you can 
use in the correlation rule to a more manageable level.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To select a topology view for a correlation rule:

 1 Open the Correlation Rules manager:

Admin > Operations Management > Design Operations Content > 
Correlation Rules 

 2 In the Rule Topology pane, use the View list to choose a topology view. 
The view you choose specifies the configuration item types that you want 
to use in the new correlation rule as well as the topological relationships 
between the configuration item types.

Note: When you create a rule, the View list displays all known views. 
After you select a view, the View list displays only those views that refer to 
any of the configuration item types present in the selected view. 

 3 If the rule you want to use is not present in the View list, use the 
Modeling Studio to configure the view.

For more information about topology views in correlation rules, see "Event 
Correlation Rule Topology" on page 372 and "Rule Topology Pane" on 
page 392.
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How to Define the Rule Topology 

In this task, you use the Rule Topology pane to specify the configuration 
item types that you want to include in a correlation rule and what 
relationships and dependencies exist between the configuration item types. 
A relationship must exist between the configuration item types in a rule. 
The Correlation Rules manager does not permit you to save an invalid rule.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To define the topology of a correlation rule:

 1 Open the Correlation Rules manager:

Admin > Operations Management > Design Operations Content > 
Correlation Rules

 2 In the Rule Topology pane, use the View list to choose a topology view. 
The view you choose must contain the configuration item types that you 
want to use in the new correlation rule. 

 3 Specify the topology of the correlation rule by highlighting the path 
between the configuration item types that you want to associate in the 
correlation rule. The rule topology shows the relationships between all 
the configuration item types in the chosen view. If there is more than one 
path between the configuration item types specified as symptoms and 
cause in the correlation rule, the shortest path is taken. If you want to use 
an alternative one, you must make the selection manually.

When creating or modifying rules, it may not always be obvious when a rule 
is correctly specified. To guide you through correlation rule creation, short 
explanations are provided at the top of the pane.

Information presented in red indicates that there is an error or omission in 
the correlation rule. Follow the guidance to correct the error. If it proves 
difficult to create an error-free rule, use the Rebind button to create a 
binding between the cause and the symptoms. The rebind automatically 
removes all bindings and adds the shortest path between the cause and the 
symptoms.
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Information presented in blue indicates that the rule is correctly specified 
and serves as a reminder to save the modified rule.

Note: You select a path by clicking the links and objects in the chosen path. 
Active links are colored blue, inactive links are colored grey.

For more information about rule-topology views in correlation rules, see 
"Event Correlation Rule Topology" on page 372 and "Rule Topology Pane" 
on page 392.
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How to Specify Correlation Rule Symptoms 

In this task, you learn how to specify one or more events as symptoms in a 
correlation rule. You define the symptoms of a correlation rule by specifying 
one or more indicator states used to monitor particular events in your IT 
environment, for example, Database:Unavailable or Service:Slow.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To specify symptoms for a correlation rule:

 1 Open the Correlation Rules manager:

Admin > Operations Management > Design Operations Content > 
Correlation Rules 

 2 Create a (or open an existing) correlation rule. For more information 
about creating correlation rules, see "How to Create Event Correlation 
Rules" on page 378.

 3 In the Rule Topology pane, select the configuration item type, the 
indicator state of which you want to use as a symptom in the selected 
correlation rule.

 4 In the Indicators pane, expand the indicator containing the indicator 
state you want to specify as a symptom in the selected correlation rule.

 5 Right-click the indicator state you want to use as a symptom in the 
correlation rule, and select Add as a Symptom from the context menu.

The selected indicator state should appear in the list of symptoms and 
causes in the Symptoms and Causes pane.
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How to Specify Correlation Rule Causes 

In this task, you learn how to specify the event that you want to define as 
the cause in a correlation rule. You define the cause of a correlation rule by 
specifying an indicator state used to monitor a particular event in your IT 
environment, for example: Network:Unreachable.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To specify causes in a correlation rule:

 1 Open the Correlation Rules manager:

Admin > Operations Management > Design Operations Content > 
Correlation Rules 

 2 Create a (or open an existing) correlation rule. For more information 
about creating correlation rules, see "How to Create Event Correlation 
Rules" on page 378.

 3 In the Rule Topology pane, select the configuration item type for which 
you want to select the cause.

 4 In the Indicators pane, right-click the indicator state you want to use as a 
cause in the correlation rule, and select Add as a Cause from the context 
menu.

The selected indicator state should appear in the list of symptoms and 
causes in the Symptoms and Causes pane.
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How to Set the Correlation Time Limit 

In this task, you learn how to set the period of time that correlation rules 
wait for all required events to occur before reporting the cause event and 
emptying the correlation rule cache.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To set the time limit for correlation rules:

 1 Open the Infrastructure Settings manager:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

 2 In the Applications list, set the context to Operations Management.

 3 In the Topology-Based Event Correlation Settings section, click the  
button for the entry: Correlation Time Window.

 4 In the Edit Setting dialog box, enter the time limit (in seconds) you want 
to set in the Value box. The default is 960 seconds.

 5 Select Save to apply the new time setting immediately.
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How to Set the Correlation Auto-Extend Time 

In this task, you learn how to set event correlation to automatically extend 
the correlation time window whenever an additional symptom is correlated 
to the same cause. Each time that an event is correlated with a problem, the 
time period set in the correlation time window is restarted to help enable 
the correlation of a greater proportion of symptoms associated with the 
original event.

Note: For information on button actions, see "Correlation Rules User 
Interface" on page 387. 

To set Auto-Extend for correlation rules:

 1 Open the Infrastructure Settings manager:

Admin > Platform > Setup and Maintenance > Infrastructure Settings 

 2 In the Applications list, set the context to Operations Management.

 3 In the Topology-Based Event Correlation Settings section, click the  
button for the entry: Auto-Extend Time Window Mode.

 4 In the Edit Setting dialog box, set the Value to true.

 5 Select Save to apply the new time setting immediately.
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Reference

Correlation Rules User Interface 

This section describes in detail the information displayed in the Correlation 
Rules manager. The information in this section describes the buttons, icons, 
labels, and menu options that you use to create the correlation rules that 
help users manage the events that occur in your IT environment.

This section also includes:

➤ Correlation Rules Pane on page 388

➤ View Correlation Rule Pane on page 390

➤ Rule Topology Pane on page 392

➤ Correlation Rule Indicators Pane on page 395

➤ Correlation Rule Symptoms and Causes Pane on page 397

➤ Create New Correlation Rule Dialog Box on page 399

➤ Edit Properties for Correlation Rule Dialog Box on page 401

➤ Matching CIs for Correlation Rule Dialog Box on page 403
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Correlation Rules Pane    

The Correlation Rules pane in the Correlation Rules manager displays a list 
of all available correlation rules. The list includes rules from the 
out-of-the-box content packs and any rules that you defined and saved.

In addition, the Correlation Rules pane includes information about 
correlation rules, the symptoms and causes of which overlap to form 
parent-child relationships. Parent-child relationships contain symptoms or 
causes that feature in a chain of rules defined for multiple domains.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.
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The Correlation Rules pane displays the UI elements listed in the following 
table.

UI Element (A-Z) Description

Refreshes the contents of the Correlation Rules list. Use if 
new rules becomes available while you are working.

New Item: Opens the Create New Correlation Rule dialog 
box, which you use to define the details of a new (or 
modify an existing) correlation rule. For more 
information, see "How to Create Event Correlation Rules" 
on page 378.

Duplicate Item: Creates a duplicate of the selected 
correlation rule. The name of a correlation rule is for 
internal use only and must be unique.

Delete Item: Deletes the selected correlation rule from 
the database.

Toggle Display of Cross Rule Relations: Toggles between a 
flat list of correlation rules and a tree that shows how 
each rule is linked to other rules.

Toggle Sorting by Cause CI Type: Toggles between a 
correlation rule list sorted alphabetically and a list sorted 
by the cause CI type name.

Expand: Expands the list to display items belonging to 
the selected group.

Collapse: Collapses all open branches except for the 
selected branch.

Find Matching CIs: Show all CIs that match the topology 
specified in the rule and enables the sending of test 
events to test the correlation rule.

Edit Properties: Opens the basic properties of the selected 
correlation rule in the Edit Properties for Correlation Rule 
dialog box. For more information, see "Edit Properties for 
Correlation Rule Dialog Box" on page 401.
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View Correlation Rule Pane 

The View Correlation Rule pane in the Correlation Rules manager is also 
used during the creation of new Correlation Rules when it is labelled Finish 
Creating Correlation Rule. 

Save Item: Completes the new correlation rule creation 
or saves the modifications you made to an existing 
correlation rule. 

Note: A correlation rule must be made active before it 
can be used.

Cancel Edit or Create: Discards all modifications made 
while creating or editing the rule topology of the selected 
correlation rule. When editing, the saved version of the 
selected correlation rule is reloaded from the database.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.

UI Element (A-Z) Description
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The View Correlation Rule pane in the Correlation Rules manager contains 
the following panes:

➤ "Rule Topology Pane" on page 392

➤ "Correlation Rule Indicators Pane" on page 395

➤ "Correlation Rule Symptoms and Causes Pane" on page 397.

The View Correlation Rules pane displays the UI elements listed in the 
following table.

When creating or modifying rules, it may not always be obvious when a rule 
is correctly specified. To guide you through correlation rule creation, short 
explanations are provided at the top of the pane. 

Information presented in red indicates that there is an error or omission in 
the correlation rule. Follow the guidance to correct the error. If it proves 
difficult to create an error-free rule, delete bindings and use the Rebind 
button to create a binding between the cause and the symptom. The rebind 
automatically uses the shortest path between the cause and the symptom.

Information presented in blue indicates that the rule is correctly specified 
and serves as a reminder to save the modified rule.

UI Element (A-Z) Description

Binds one or more symptoms to the cause by taking the 
shortest path. All other bindings are removed.

Toggle Display of Node Details: Opens the Details 
window for the selected Rule Topology. The Details 
window displays:

➤ Symptoms and Causes

Symptoms or causes mapped to the selected CI type.

➤ Cross Rule Navigation

Shows rules where the selected symptom is a cause or 
the selected cause is a symptom.
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Rule Topology Pane 

The Rule Topology pane in the Correlation Rules manager displays a 
graphical representation of the selected correlation rule, including all the 
configuration item types configured in the rule as well as any relationships 
between the included configuration item types and other correlation rules 
that use the same indicator states. The Correlation Rules manager uses color 
to indicate the role of a configuration item type in a correlation rule, for 
example, to show if a configuration item is configured as a symptom (blue) 
or a cause (orange).

Configuration item types are only displayed in the Rule Topology pane if 
you select a rule or apply a view from the View list. 

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.
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The Rule Topology pane displays the UI elements listed in the following 
table. In the table, unlabeled UI elements are shown in angle brackets (<>).

UI Element (A-Z) Description

Indicates that the configuration item type has an 
indicator state that is configured as a symptom in the 
selected correlation rule. 

Tip: To see which indicator states are configured in the 
correlation rule. Select Toggle Display of Node Details  
button which opens the Details window for the selected 
Rule Topology.

Indicates that the configuration item type has an 
indicator state that is configured as a cause in the 
selected correlation rule.

Indicates that the configuration item type has an 
indicator state that is configured not only as a cause in 
the selected correlation rule, but also as a symptom in 
another rule. The name of the other correlation rule is 
displayed as a hyperlink above the configuration item 
symbol.

Indicates that the configuration item type has an 
indicator state that is configured not only as a symptom 
in the selected correlation rule, but also as a cause in 
another rule. The name of the other correlation rule is 
displayed as a hyperlink below the configuration item 
symbol.

Adds the highlighted link (constraint) to the correlation 
rule. Adding a link enables the path between the linked 
objects in the context of the correlation rule, which is a 
requirement for topology-based event correlation. It does 
not change the View model in any way.

Removes the highlighted link (constraint) from the 
correlation rule you are editing. The link between the 
two objects is no longer recognized in the context of the 
correlation rule, and any rule that relies on this link no 
longer works. Removing a link from a correlation rule 
does not change the View model in any way.
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<Dark blue 
background>

Symptom CI type.

<Light blue 
background>

Not cause or symptom CI type, but CI type is part of rule 
topology.

<Orange 
background>

Cause CI type.

<Pink frame> Selected CI type.

<No background 
color>

CI type is not part of the rule.

Layout Selects alternative ways of viewing the Rule Topology 
diagram. There are three options to chose from: 
Hierarchical, Circular, and Concentric Radial.

Levels Selects the depth of topology levels displayed in the Rule 
Topology diagram.

View Displays the views you can use to define which 
configuration item types are available for inclusion in the 
selected correlation rule. All views are available in the list 
before you select a view. After you select a view, the views 
displayed in the list are restricted to those which contain 
any of the configuration item types in the selected 
correlation rule. If the Rules Topology pane is empty, see 
"Rules Topology Pane is Empty" on page 405.

Visible CI Types States the number of CI types displayed and the total 
number of CI types included in the correlation rule. 
Format: number of CI types displayed/total number of CI 
types in correlation rule, for example, 3/4.

Zoom Controls the size of the displayed Rule Topology diagram.

UI Element (A-Z) Description
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Correlation Rule Indicators Pane 

The Indicators pane in the Correlation Rules manager displays a list of the 
indicators assigned to the configuration item type selected in the Rule 
Topology pane. You can select states from any of the listed indicators for use 
in the correlation rule you are designing.

The Correlation Rule Indicators pane displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Important 
information

If you need to add or modify indicators, you must do this 
in the Indicators manager.

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.

UI Element (A-Z) Description

Refreshes the contents of the Indicators list. Use if new 
indicators becomes available while you are working.

Go to the Indicator Manager: Opens the Indicators 
manager.

Group Indicator by Type: Toggles between a list 
containing all indicators and a list divided into HIs and 
event type indicators.
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Add as a Symptom: Adds the selected indicator state as a 
symptom for the configuration item type selected in the 
Rule Topology pane.

Add as a Cause: Sets the selected indicator state as a cause 
for the configuration item type selected in the Rule 
Topology pane.

UI Element (A-Z) Description



Chapter 14 • Correlation Rules

397

Correlation Rule Symptoms and Causes Pane   

The Symptoms and Causes pane in the Correlation Rules manager displays a 
list of the indicators and states configured for the configuration types of the 
correlation rule. These configuration types are displayed in the Rules 
Topology pane and indicates if the state is a cause or a symptom in the 
selected rule. Selecting a symptom or the cause in Rule Topology pane 
highlights the indicator state in the Indicators pane. 

You can also add new event indicator states to the displayed list.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Important 
information

To add an indicator state to a correlation rule as a 
symptom or a cause, either right-click the state and use 
the options displayed in the popup menu.

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.
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The Correlation Rule Symptoms and Causes pane displays the UI elements 
listed in the following table.

UI Element (A-Z) Description

Delete Item: Deletes the selected indicator from the list 
of indicators included in the correlation rule as either a 
symptom or a cause.

CI Type Name of the configuration item type to which the listed 
indicator is assigned.

Indicator Name of the indicator referenced in the selected 
correlation rule.

Indicator State Name of the indicator state referenced in the selected 
correlation rule.

Type Indicates if the indicator is defined as a symptom or a 
cause in the selected correlation rule.
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Create New Correlation Rule Dialog Box

You use the New Correlation Rule dialog box to define the properties of a 
new correlation rule, for example, name, and description.

The Create New Correlation Rule dialog box displays the UI elements listed 
in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

In the Correlation Rules pane, click the  button.

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.

UI Element (A-Z) Description

Active Used to enable or disable the rule during runtime. By 
default it is disabled.

Base on View Selects the view that you want to use as the basis for the 
correlation rule topology. By selecting a view, the Rule 
Topology pane displays only those configuration item 
types that are included in the view.

Display Name Display name of the selected correlation rule used in the 
graphical user interface.

Description Brief description of the correlation rule.
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Name Internal name of the selected correlation rule. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten.

Note: Maybe disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).

Time Window Specifies a specific time period for the selected 
correlation rule. By default it is not enabled and the 
global value is used. 0 seconds also mean it is not enabled 
and the global setting is used.

The range is from 0 to 9999 seconds.

For information about setting the default, see 
"Operations Management Infrastructure Settings 
Manager" on page 686.

UI Element (A-Z) Description
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Edit Properties for Correlation Rule Dialog Box

You use the Edit Properties for Correlation Rule dialog box to modify the 
properties of an existing correlation rule, for example, name and 
description.

The Edit Properties for Correlation Rule dialog box displays the UI elements 
listed in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

Click the  button to open the Edit Properties for 
Correlation Rule dialog box.

Important 
information

The View Correlation Rule pane in the Correlation Rules 
manager is also used during the creation of new 
Correlation Rules when it is labelled Finish creating 
Correlation Rule.

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.

UI Element (A-Z) Description

Active Used to enable or disable the rule during runtime. By 
default it is disabled.

Description Brief description of the correlation rule.

Display Name Display name of the selected correlation rule used in the 
graphical user interface.
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ID Internal location of Correlation Rule (internal, 
read-only).

Name Internal name of the selected correlation rule. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten.

Note: Maybe disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).

Time Window Specifies a specific time period for the selected correlation 
rule. By default it is not enabled and the global value is 
used. 0 seconds also mean it is not enabled and the global 
setting is used.

The range is from 0 to 9999 seconds.

UI Element (A-Z) Description
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Matching CIs for Correlation Rule Dialog Box

You use the Matching CIs for Correlation Rule dialog box to view all 
configuration items that match the selected correlation rule in the 
Correlation Rules pane.

The Matching CIs for Correlation Rule dialog box displays the UI elements 
listed in the following table.

To access Select Admin > Operations Management > Design 
Operations Content > Correlation Rules

To display the Matching CIs for Correlation Rule dialog 
box for a specific correlation rule, correlation rule and 
click the  button in the Correlation Rules pane of the 
Correlation Rules manager.

Relevant tasks To configure correlation rules, see:

➤ "How to Configure Topology-based Event Correlation 
Rules" on page 376.

➤ "How to Create Event Correlation Rules" on page 378.

See also For more information about configuring correlation 
rules, see:

➤ "Correlation Rules Manager Basics" on page 369.

➤ "Topology-Based Event Correlation" on page 370.

➤ "Correlation Rules" on page 371.

➤ "Event Correlation Rule Topology" on page 372.

➤ "Correlation Rule Symptoms and Causes" on page 374.

UI Element (A-Z) Description

Cause CI Display name of the configuration item, the indicator 
states of which are configured as a cause in the selected 
correlation rule.

CI Type Name of the configuration item type to which the 
indicator referenced in the selected correlation rule is 
assigned.

Configuration Item Name of the configuration item.
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Constraint Type Role that the selected indicator state plays in the 
correlation rule (symptom or cause).

Indicator Display name of the indicator, the state of which is 
referenced in the correlation rule.

Indicator State Display name of the indicator state used in the 
correlation process.

Send Test Event Sends a sample event to Operations Management to test 
the correlation rule.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides the following help for those people who are 
troubleshooting problems relating to event correlation, including creating, 
modifying, and enabling events.

➤ "Rules Topology Pane is Empty" on page 405

➤ "Indicators List is Empty" on page 405

➤ "Rules Topology Pane is Empty" on page 405

Rules Topology Pane is Empty

➤ No rule is selected in the Correlation Rules pane

➤ No view is active in the Rules Topology pane

Indicators List is Empty

➤ No configuration item type is selected in the Rules Topology pane

➤ No indicator is defined for the selected CI type

Cannot Save Correlation Rule
The rule is invalid or incomplete, for example:

➤ The rule does not have at least one symptom event

➤ The rule does not have a cause event

➤ The topology path is invalid

➤ The rule refers to a configuration item that is not resolvable



Chapter 14 • Correlation Rules

406



407

15 
Connecting Servers

This chapter includes:

Concepts

➤ Introduction to Connecting Servers on page 408

Tasks

➤ How to Create a Connection to another OMi Instance on page 411

➤ How to Create a Connection to an HPOM Server on page 413

➤ How to Create a Connection to an External Event Processing Server 
on page 417

➤ How to Create a Connection to an Integration Adapter Server 
on page 420

➤ How to Create and Associate an Alias to a Connected Server on page 422

➤ How to Edit a Server Connection on page 424

➤ How to Delete a Server Connection on page 425

➤ How to Establish a Trust Relationship for a Server Connection 
on page 426

➤ How to Verify the Trusted Relationship on page 429

Reference

➤ Connected Servers User Interface on page 430

➤ Connecting Servers Manager Command-Line Interface on page 449

Troubleshooting and Limitations on page 459
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Concepts

Introduction to Connecting Servers

The Connected Servers manager enables you to specify 
HP Operations Manager servers, external event processing servers, servers 
connected using the Integration Adapter, and other Operations 
Management (BSM) servers as event forwarding targets.

The Connected Servers manager also enables you to specify the web service 
credentials of the HPOM servers that are used for Tool and Action execution 
or to retrieve Instructions.

Connected servers are used in conjunction with event forwarding rules to 
redirect selected events to specific servers. For event forwarding to be 
possible, the following prerequisites must be met:

➤ For OMi and HPOM servers, the two servers need to trust each other. To 
set up a valid certificated trust, follow the steps on "How to Establish a 
Trust Relationship for a Server Connection" on page 426.

➤ A trust relationship also needs to be set up for Integration Adapter 
connections. This is described in the Integration Adapter online help 
section entitled Connect HP BSM Integration Adapter to HP Business Service 
Management.

➤ All target servers must be configured as Connected Servers. To configure 
servers connected to Operations Management, see "How to Create a 
Connection to another OMi Instance" on page 411, "How to Create a 
Connection to an HPOM Server" on page 413, and "How to Create a 
Connection to an External Event Processing Server" on page 417.

You can also create an alias for a connected server, making it easier to create 
content (configurations and customizations), for example, event forwarding 
rules, notifications, and user group assignments, on a development 
installation, and import them to a production installation. As a connected 
server configuration (hostname and logon credentials) on a development 
installation is very unlikely to be relevant to a connected server 
configuration on a different installation, for different users, it is not 
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appropriate to export and import connected server configurations between 
installations. For example, when exporting an event forwarding rule, the 
connected server name is also exported from the sources installation. On 
import to a target installation, if a connected server is found with the same 
name, it is assigned to the rule. If no matching connected server is found, an 
server alias is created for the event forwarding rule. This must be associated 
with an existing connected server on the target installation for the rule to be 
completed.

Manager of Manager Configurations
Operations Management event attributes such as Priority or Lifecycle State 
are synchronized between Operations Management servers using CMAs 
which are then mapped backed to the associated event attribute. Other 
servers, such as HPOM servers, do not send Operations Management event 
attributes and are not generally sent updates for of these Operations 
Management event attributes. The following Operations Management event 
attributes are sent to HPOM servers:

➤ LifecycleState

➤ Priority

➤ Description

➤ Solution

➤ SubCategory

➤ CauseEventId

All other special Operations Management event attributes are just sent if the 
target server is an Operations Management server.

Similarly, special CMAs that are sent from HPOM servers are ignored by 
Operations Management servers.

➤ All servers that are part of the Operations Management Manager of 
Managers setup must be configured as Connected Servers in Operations 
Management.

➤ For HPOM servers, the credentials that are specified in Connected Servers 
are used to execute actions, fetch instructions, and to set the integration 
user as the event owner in HPOM.
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➤ The Connected Server information is used by Operations Management 
servers, to determine if additional event information is sent to the target 
server.

To configure a server alias, see "How to Create and Associate an Alias to a 
Connected Server" on page 422.
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Tasks

How to Create a Connection to another OMi Instance

This task shows you how to create a server connection used to forward 
events to another Operations Manager i instance.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a server connection to another Operations Manager i instance:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 In the Connected Servers pane, click the  button to open the Create 
New Server Connection dialog box.

 3 Enter a display name, a unique internal name, if you want to replace the 
automatically generated name, and (optional) a description of the 
connection being specified.

 4 Select Active, if you want to enable the server connection immediately.

 5 Click Next to open the Server Type page.

 6 Select the Operations Manager i server type.

 7 Click Next to open the Server Properties page.

 8 Enter the fully qualified DNS name of the host system of the Operations 
Manager i instance.
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If there are multiple servers, or if HP Business Service Management is 
deployed in a distributed architecture, specify the load balancer or the 
BSM Gateway Server hosting the Operations Management application, as 
required.

 9 Specify if you want to forward topology information from the Operations 
Manager i instance to which you are logged on, to the Operations 
Manager i instance that you are currently configuring.

 10 Click Test Connection to check that the specified connection attributes 
are correct. If an error link is displayed, check the error message, correct 
the connection information, and re-test the connection.

 11 Select Finish.
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How to Create a Connection to an HPOM Server

This task shows you how to create a server connection to an HPOM server. 
Operations Management can forward events, run actions and tools on, and 
retrieve instructions from an HPOM server. Credentials for the HPOM web 
service are required for this processing.

For Server Pooling environments, configure the virtual interface as the main 
connected server. Specify the integration user and password for the 
Outgoing Connection. For all physical servers in the server pooling 
environment, add them as connected servers and specify the virtual 
interface server as the server to use for the Outgoing Connection.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a server connection to an HPOM server:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 In the Connected Servers pane, click the  button to open the Create 
New Server Connection dialog box.

 3 Enter a display name, a unique internal name, if you want to replace the 
automatically generated name, and (optional) a description of the 
connection being specified.

 4 Select Active, if you want to enable the server connection immediately.

 5 Click Next to open the Server Type page.

 6 Select the HP Operations Manager server type.

 7 Click Next to open the Server Properties page.
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 8 Enter the fully qualified DNS name of the host system of the HPOM 
management server.

If the host system is a high-availability cluster, enter the fully qualified 
DNS name of the cluster package where the HPOM server is installed. 

If HPOM is installed in a server pooling environment, add the virtual 
interface as the first HPOM management server. Add all physical pool 
servers separately as connected servers.

 9 Enter the Integration User name used to log on to the HPOM 
management server.

Note: All messages forwarded from HPOM systems are treated as allowing 
read and write. Any changes made to these events result in a back 
synchronization to the originating HPOM server.

 10 Specify if you want to forward dynamic topology information from the 
Operations Manager i instance to which you are logged on, to the HP 
Operations Manager instance that you are currently configuring.

Note: If you change the status of the Forward Topology Data check box 
for a configured server, you must restart the WDE process on all gateway 
servers.

 11 Select the HPOM product type. The options include:

➤ HP Operations Manager for UNIX

➤ HP Operations Manager for Windows

 12 Click Test Connection to check that the specified connection attributes 
are correct. If an error link is displayed, check the error message, correct 
the connection information, and re-test the connection.

 13 Click Next to open the Outgoing Connection page.
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The outgoing connection is used to receive instructions, and execute tools 
and actions on external nodes. 

 14 If you are using an alternative server, select Use other Server, and select a 
server from the list. For the physical servers in a server pooling 
environment, select the virtual interface connected server.

Alternatively, if using this server that you are configuring for receiving 
instructions, and executing tools and actions on external nodes, enter the 
password for the integration user and the port required to access the 
server for receiving instructions, and executing tools and actions. The 
default port value is automatically inserted and can be restored using Set 
default port.

Note: For HP Operations Manager for Windows, the selected user must 
have at least PowerUser rights and must be a member of HP-OVE-Admins 
group and the local administrators group.

For HP Operations Manager for UNIX, the Integration User must have the 
responsibility for all Events that are forwarded to Operations 
Management and permissions to run the available tools. Topology 
synchronization requires administrator rights.

 15 Optional: If you are using secure communication (default), make sure that 
the Use Secure HTTP option is selected, and apply a certificate using one 
of the following methods.

Note: Secure communication is necessary for Server Pooling 
Environments. However, do not use the Import from file or Retrieve from 
server options. Set up a trusted relationship between all HPOM and BSM 
servers as described in "How to Establish a Trust Relationship for a Server 
Connection" on page 426.
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➤ Import from file — Opens the file browser and enables you to navigate 
to and specify a Base64 Encoded X.509 certificate file for the server 
connection.

➤ Retrieve from server — Retrieve a certificate from the host system 
specified in this server connection.

Alternatively, if you want actions to be run from an alternative server, 
select Use Other Server and select an HPOM server from the list of 
configured servers.

Note: Avoid selecting an alternative action execution server which creates 
a loop and results in specifying the connected server as the action 
execution server. Select an alternative action execution server or use the 
Use this Server option.

 16 Click Test Connection to check that the specified connection attributes 
are correct. If an error link is displayed, check the error message, correct 
the connection information, and re-test the connection.

 17 Select Finish.

Note: In a clustered HP Operations Manager for Windows environment, IIS 
on all cluster nodes must have the same certificate. If different, valid 
certificates are used, problems such as tools execution may be experienced 
after switching to a node with a different certificate.
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How to Create a Connection to an External Event 
Processing Server

This task shows you how to create a server connection to an external event 
processing server.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

Note: HP Service Manager 9.20 does not support Notify and Notify and 
Update as forwarding types.

To create a server connection to an external event processing server:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 In the Connected Servers pane, click the  button to open the Create 
New Server Connection dialog box.

 3 Enter a display name, a unique internal name, if you want to replace the 
automatically generated name, and (optional) a description of the 
connection being specified.

 4 Select Active, if you want to enable the server connection immediately.

 5 Click Next to open the Server Type page.

 6 Select the External Event Processing server type.

 7 Click Next to open the Server Properties page.
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 8 Enter the fully qualified DNS name of the host system of the external 
event processing server.

 9 Select Supports Synchronize and Transfer Control if the external server 
supports transfer control and back synchronization of changes to events.

 10 Click Next to open the Integration Type page.

 11 Select an Integration Type used to establish the connection with the 
external server type and provide the requested information.

The options include:

Call Groovy Script Adapter

Integrating an external server using Groovy scripts requires some steps 
that are described in the Operations Manager i Extensibility Guide PDF.

 a Select an external event processing type.

 b Select the Groovy script required by the selected external event 
processing type.

 c Optional: Specify Groovy script classpaths.

 d Specify a time limit for the execution of the script.

Call External Event Web Service

Enter the URL Path for the external Event web service.

 12 Click Next to open the Outgoing Connection page.

 13 For event forwarding, enter the user credentials (User name and 
Password) and the port number required to access the external server.

Optional: If you are using secure communication (default), make sure that 
the Use Secure HTTP option is selected, and apply a certificate using one 
of the following methods:

➤ Import from file — Opens the file browser and enables you to navigate 
to and specify a Base64 Encoded X.509 certificate file for the server 
connection.

➤ Retrieve from server — Retrieve a certificate from the host system 
specified in this server connection.

 14 To be able to transfer responsibility to the external event processing 
server, select the Supports Synchronize and Transfer Control option.
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 15 Click Test Connection to check that the specified connection attributes 
are correct. If an error link is displayed, check the error message, correct 
the connection information, and re-test the connection.

 16 Click Next to open the Event Drilldown page.

 17 Enter the fully qualified DNS name of the host system of the external 
event processing server and the port number used for drilldown.

 18 Optional: For secure communication, select the Use Secure HTTP option.

 19 Enter the URL Path to complete the URL. 

The combined URL is displayed in the URL field.

 20 Click Next to open the Incoming Connection page.

 21 Specify the credentials for the Operations Management user used to 
access and update events.

 22 Select Finish.
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How to Create a Connection to an Integration Adapter 
Server

This task shows you how to create a server connection to an Integration 
Adapter server.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a server connection to an Integration Adapter server:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 In the Connected Servers pane, click the  button to open the Create 
New Server Connection dialog box.

 3 Enter a display name, a unique internal name, if you want to replace the 
automatically generated name, and (optional) a description of the 
connection being specified.

 4 Select Active, if you want to enable the server connection immediately.

 5 Click Next to open the Server Type page.

 6 Select the Integration Adapter server type.

 7 Click Next to open the Server Properties page.

 8 Enter the fully qualified DNS name of the host system of the Integration 
Adapter server.

 9 Click Test Connection to check that the specified connection attributes 
are correct. If an error link is displayed, check the error message, correct 
the connection information, and re-test the connection.

 10 Click Next to open the Policy Management page.
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 11 Set the port to be used to open Policy Management on the Integration 
Adapter server. The default port value is automatically inserted and can be 
restored using Set default port.

 12 Optional: To open Policy Management, click the Launch Policy 
Management  button.

Using the Policy Editor, make the changes to the associated policies as 
required and save your changes before returning to the Create New Server 
Connection dialog box and continuing with the current configuration.

 13 Click Next to open the Event Drilldown page if required or click Finish.

 14 Optional: If drilldown is required:

 a Enter the fully qualified DNS name of the host system of the source 
manager and the port number used for drilldown.

 b Enter the URL Path to complete the URL. 

The combined URL is displayed in the URL field.

 c For secure communication, select the Use Secure HTTP option.

 15 Select Finish.
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How to Create and Associate an Alias to a Connected 
Server

This task shows you how to use an alias to connect to a configured 
connected server. 

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

Note: When exporting an event forwarding rule, the connected server name 
is also exported from the sources installation. On import to a target 
installation, if a connected server is found with the same name, it is 
assigned to the rule. If no matching connected server is found, an server 
alias is created for the event forwarding rule. This must be associated with 
an existing connected server on the target installation for the rule to be 
completed.

To create a server alias for connected servers:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 In the Connected Servers pane, click the  button to open the Create 
New Server Connection dialog box.

 3 Enter a display name, a unique internal name, if you want to replace the 
automatically generated name, and (optional) a description of the 
connection being specified.

 4 Select Active, if you want to enable the server connection immediately. 
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Note: A server alias can be enabled only if a server is associated with this 
server alias.

 5 Click Next to open the Server Type page.

 6 Select the Alias server type.

 7 Click Next to open the Server Properties page.

 8 Optional: To associate a connected server with this alias, select an existing 
connected server. This association can also be done at a later point in 
time.

 9 Select Finish.
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How to Edit a Server Connection

This task shows you how to edit an existing connection.

To edit an existing server connection:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 Select the server that you want to edit.

 3 In the Connected Servers pane, click the  button to open the Edit 
Server Connection dialog box.

 4 Make the required changes to the selected server.

Navigate between the pages using the tabs.

Note: If you change the status of the Forward Topology Data check box, 
you must restart the WDE process on all gateway servers.

For single system installation: stop and restart the WDE process using the 
following commands:

<HPBSM_Root_Dir>/opr/support/opr-support-utils.bat -stop wde

<HPBSM_Root_Dir>/opr/support/opr-support-utils.bat -start wde

For multi-system installation, stop and restart the WDE process using the 
following commands on the Gateway server:

<HPBSM_Root_Dir>/opr/support/opr-support-utils.bat -stop wde 

<HPBSM_Root_Dir>/opr/support/opr-support-utils.bat -start wde

 5 Select Finish.
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How to Delete a Server Connection

This task shows you how to delete an existing connection.

To delete an existing server connection:

 1 Open the Connected Servers manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Connected Servers

 2 Select the server connection settings that you want to delete.

 3 In the Connected Servers pane, click the  button. 

The selected server connection is deleted from the list of connected 
servers.
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How to Establish a Trust Relationship for a Server 
Connection

For connection and communication between BSM and external servers such 
as HPOM hosts, other BSM hosts where Operations Management is running, 
or a BSM Server with an event channel license, you must establish a trust 
relationship between the systems.

In Server Pooling, the virtual server must have a certificate which is trusted 
by all HPOM hosts in the server pool and by all BSM hosts where Operations 
Management is running.

Certificate exchange between Gateway Servers and Data Processing Servers 
is part of the initial installation and is described in the HP Business Service 
Management Deployment Guide.

Note: Generally, certificates must be exchanged on all nodes (Data 
Processing Servers, Gateway Servers, manager of manager configurations, 
and Load balancers. However, some Load Balancer technologies include a 
by-pass or pass-through functionality for incoming encrypted messages to 
its pool members. When using such technologies, certificate exchange on 
the Load Balancer node is not required.

To establish a trust relationship between the Data Processing Servers and 
external servers:

 1 HPOM servers only: 

 a Locate the following files on the BSM Data Processing Server:

<HPBSM root directory>/opr/lib/cli/opr-cli.jar 

<HPBSM root directory>/opr/bin/BBCTrustServer.bat 

<HPBSM root directory>/opr/bin/BBCTrustServer.sh 

 b HPOM for Windows only: Copy the files to the computer that is running 
the HPOM for Windows management server:

Copy opr-cli.jar to %OvInstallDir%\java\opr-cli.jar.



Chapter 15 • Connecting Servers

427

Copy BBCTrustServer.bat to %OvBinDir%\BBCTrustServer.bat.

Note: Starting with patches OMW_00121 (32-bit) and OMW_00122 
(64-bit), the BBCTrustServer tool is installed to the folder 
%OvInstallDir%\contrib\OVOW on the HPOM for Windows 
management server.

 c HPOM for UNIX or Linux only:  Copy the files to the computer that is 
running the HPOM for UNIX or Linux management server:

Copy opr-cli.jar to /opt/OV/java/opr-cli.jar.

Copy BBCTrustServer.sh to /opt/OV/bin/BBCTrustServer.sh.

Change the permissions of the BBCTrustServer tool by typing the 
following command:

chmod 555 /opt/OV/bin/BBCTrustServer.sh

 2 On the BSM Data Processing Server, execute the following command:

BBCTrustServer[.bat|sh] <external_server>

Replace <external_server> with the DNS name of the external system (for 
example, ommgmtsv).

When asked whether to add the certificate to the trust store, type y. 

The tool informs you if a trusted certificate already exists and asks you 
whether to overwrite the existing certificate. Type y to replace the 
existing certificate with the new one.

 3 On the external server, execute the following command:

BBCTrustServer.[bat|sh] 
<man-in-the-middle_or_single_gateway_server>

When asked whether to add the certificate to the trust store, type y. 

The tool informs you if a trusted certificate already exists and asks you 
whether to overwrite the existing certificate. Type y to replace the 
existing certificate with the new one.
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 4 Update new trusts on the Gateway Servers, with the command:

ovcert -updatetrusted

Note: During deployment, certificates for Gateway Servers are requested 
and granted for each Gateway Server. For details, see the HP Business 
Service Management Deployment Guide PDF.

 5 If you are using a virtual interface for server pooling, where your data 
sources are not communicating directly with the BSM Gateway Server, 
perform the following task.

 a Request server and client certificates from your Certificate Authority 
for the virtual interface.

If you do not have a Certificate Authority, you can issue a certificate 
from the BSM Data Processing server with the following command:

ovcm -issue -file <certificate file> -name <Fully Qualified Domain 
Name of Virtual Interface> [ -pass <passphrase>]

 b Import these certificates to the virtual interface.

 6 Check the connection between the servers. For details, see "How to Verify 
the Trusted Relationship" on page 429.
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How to Verify the Trusted Relationship

After establishing a trust relationship between the BSM Data Processing 
Server and external systems, check the connection between the two systems.

To check the connection between the BSM Data Processing Server and an 
external system:

 1 From the external host, verify that communication to the BSM 
installation is possible (the return value should be eServiceOk) by 
executing the following command on the Gateway Server for single 
Gateway Server deployments or the Load Balancer for multiple Gateway 
Server deployments:

bbcutil -ping https://<HP BSM load_balancer or 
single_gateway_server>

Example of the command result:

https://<HP BSM servername>: status=eServiceOK
coreID=7c66bf42-d06b-752e-0e93-e82d1644cef8 bbcV=06.10.105
appN=ovbbccb appV=06.10.105 conn=1 time=1094 ms

 2 From the HP BSM Data Processing Server host, verify that communication 
with the external server host is possible (the return value should be 
eServiceOk) by executing the following command:

bbcutil -ping https://<external server hostname>

Example of the command result:

https://<HP BSM servername>: status=eServiceOK
coreID=0c43c032-5c94-7535-064a-f7654a86f2d3 bbcV=06.10.070
appN=ovbbccb appV=06.10.070 conn=7 time=140 ms
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Reference

Connected Servers User Interface

The Connected Servers manager enables you to create and manage 
connections to Operations Management, HPOM, external event processing 
servers, Integration Adapter servers, and virtual servers.

This section includes:

➤ Connected Servers Pane on page 431

➤ General Tab on page 433

➤ Server Types on page 435

➤ Server Properties on page 436

➤ Integration Type on page 439

➤ Outgoing Connection on page 441

➤ Certificate Details on page 444

➤ Policy Management on page 445

➤ Event Drilldown on page 446

➤ Incoming Connection on page 448

➤ Connecting Servers Manager Command-Line Interface on page 449
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Connected Servers Pane

The Connected Servers pane displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Reloads the connected servers list.

New Item: Opens the Create New Server Connection 
dialog box to create a server connection. For more 
information about creating server connections, see "How 
to Create a Connection to an HPOM Server" on page 413.

Edit Item: Opens the Edit Server Connection dialog box 
to edit an existing server connection. For more 
information about editing server connections, see "How 
to Edit a Server Connection" on page 424.

Delete Item: Deletes the currently selected server 
connection. For more information about deleting server 
connections, see "How to Delete a Server Connection" on 
page 425.
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Activate/Deactivate Item: Toggles between enabling and 
disabling the selected Connected Server.

Expand All: Expands the list to display details for all the 
specified servers.

Collapse All: Collapses all open server details panes.

Active Indicates whether the associated server connection is 
currently enabled.

Description Brief description of the server connection.

Display Name Display name of the selected server connection.

External Event 
Processing Type

Integration type of external applications.

Forward Dynamic 
Topology

Specifies if the HP Operations Manager server is a target 
for topology synchronization.

Note: If you change the status of the Forward Topology 
Data check box for a configured server, you must restart 
the WDE process on all gateway servers. For details, see 
"How to Edit a Server Connection" on page 424.

Fully Qualified DNS 
Name

The fully qualified Domain Name System name of the 
system hosting the selected server. For example: 
myhost.example.com.

For Operations Manager i installations, if there are 
multiple servers, or if HP Business Service Management is 
deployed in a distributed architecture, specify the load 
balancer or Gateway Server, as required.

Note: It is not possible to specify the Gateway Server for 
Data Collectors as a connected server for the BSM 
installation to which they belong.

Launch Policy Editor: Opens the Policy Management UI 
in a new window.

Name Name of the selected server connection used by the 
database.

UI Element (A-Z) Description
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General Tab

Port The port used to communicate with the selected server.

Note: For information about checking and changing 
ports, see the documentation of your web server product.

(Server) Type Server type of the connected server. The options include:

➤ Operations Manager i

➤ HP Operations Manager for UNIX

➤ HP Operations Manager for Windows

➤ External Event Processing

➤ Integration Adapter

➤ Alias

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
General tab (if necessary). 

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description
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The General tab displays the UI elements listed in the following table.

UI Element (A-Z) Description

Active Indicates whether the associated server connection is 
currently enabled.

Description Brief description of the server connection.

Display Name Display name of the selected server connection.

Name Internal name of the selected server connection. 

Automatically generated from the Display Name value. 
The first character must be a letter (A-Z, a-z) or an 
underscore (_). All other characters can be a letter (A-Z, 
a-z), a number (0-9), or an underscore (_). Can be 
manually overwritten.

Note: Maybe disabled for certain locales (for example 
ja_JP, zh_CN, ko_KR).

Type (Edit only) External Event Processing — Integrations to external 
applications.

Operations Manager — HP Operations Manager for 
Windows or UNIX applications.

Operations Manager i — Integrations into other 
Operations Manager i applications.

Integration Adapter — Integrations to external event 
source managers for forwarding events to Operations 
Manager i.

Alias — Link to a physical system, enabling rules to be 
more easily ported to other systems.
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Server Types

The Server Type tab displays the UI elements for the available applications 
listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Server Types tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Alias Select for specifying an alias which can be linked to 
a physical system, enabling rules to be more easily 
ported to other systems.

The concept of Alias servers provides the 
mechanism to permit you to more easily define, 
import configurations and customizations (for 
example, event forwarding rules, notifications, and 
user group assignments) and transfer them from 
one system to another, for example, from a test 
system to production systems.

External Event Processing Select for integrations to external applications.
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Server Properties

The Server Properties tab displays the UI elements listed in the following 
table.

Integration Adapter Select for integrations to external event source 
managers for forwarding events to Operations 
Manager i.

Operations Manager Select for HPOM for Windows or UNIX 
applications.

Operations Manager i Select for integrations into other Operations 
Manager i applications.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Server Properties tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description
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UI elements displayed on the Server Properties page is dependent upon the 
type of server being configured.

UI Element (A-Z) Description

Forward Dynamic 
Topology

Select if you want to forward dynamic topology 
information from the Operations Manager i instance to 
which you are logged on, to the HP Operations Manager 
instance that you are currently configuring.

Note: If you change the status of the Forward Topology 
Data check box for a configured server, you must restart 
the WDE process on all gateway servers. For details, see 
"How to Edit a Server Connection" on page 424.

Fully Qualified DNS 
Name

The fully qualified Domain Name System name of the 
system hosting the selected server. For example: 
myhost.example.com.
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Integration User The HPOM user used to update event in HPOM with 
information form Operations Manager i. 

For HPOM for Windows servers, specify both the domain 
to which the host system belongs and the user name as 
follows:

<DOMAIN>\<user name>

If the host system is not part of a domain, replace 
<Domain> with the hostname of the system. The user 
name alone is not sufficient to identify the user specified.

NOTE: it is recommended to use a dedicated user so that 
it is clear which events are owned by and being worked 
on in Operations Manager i.

For HP Operations Manager for Windows, the user must 
have at least PowerUser rights and must be a member of 
HP-OVE-Admins group and the local administrators 
group.

For HP Operations Manager for UNIX, the Integration 
User must have the responsibility for all Events that are 
forwarded to Operations Management and permissions 
to run the available tools. Topology synchronization 
requires administrator rights.

NOTE: All messages forwarded from HPOM systems are 
treated as allowing read and write. Any changes made to 
these events result in a back synchronization to the 
originating HPOM server.

Operations Manager 
Type (HPOM only)

Server type of the connected HPOM server. The options 
include:.

➤ HP Operations Manager for UNIX

➤ HP Operations Manager for Windows

Test Connection Checks that the specified connection attributes are 
correct. If an error link is displayed, check the error 
message, correct the connection information, and re-test 
the connection.

Use Server Sets the connected server to be used as the target for the 
server alias in a virtual server.

UI Element (A-Z) Description
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Integration Type

The Integration Type tab displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Integration Types tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Call External Event 
Web Service

Integration Type used to establish the connection with 
the external server type and provide the requested 
information.

Call Groovy Script 
Adapter

Integration Type used to establish the connection with 
the external server type and provide the requested 
information.

Integrating an external server using Groovy scripts 
requires some steps that are described in the the 
Operations Manager i Extensibility Guide PDF.

External Event 
Processing Type

Selects an available external event processing type from 
the list.
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Groovy Script 
Classpath

Optional: Specifies Groovy script classpaths.

Groovy Script File 
Name

Selects the Groovy script required by the selected 
external event processing type from the list.

Maximum 
Transaction Time

Specifies a time limit for the execution of the script.

URL Path Specifies the URL Path for the external event web service.

The server and port used is automatically taken from the 
server properties. Specify only the path of the required 
external event web service call. For example:

/<urlPath>

The URL path can be empty or must start with a slash (/). 
White spaces and a trailing slash (/) are not allowed.

UI Element (A-Z) Description
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Outgoing Connection

The Outgoing Connection tab displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Outgoing Connections tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Event Forwarding Credentials and port used for event forwarding to an 
External Event Processing server.

Import from file Opens the file browser and enables you to navigate to 
and specify a certificate file for the server connection.

Certificates must meet the Base64 Encoded X.509 format.
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Integration User The HPOM user used to update event in HPOM with 
information form Operations Manager i. This user is also 
used to run actions and tool on HPOM nodes and 
retrieve instruction text from HPOM.

NOTE: it is recommended to use a dedicated user so that 
it is clear which events are owned by and being worked 
on in Operations Manager i.

For HP Operations Manager for Windows, the user must 
have at least PowerUser rights and must be a member of 
HP-OVE-Admins group and the local administrators 
group.

For HP Operations Manager for UNIX, the Integration 
User must have the responsibility for all Events that are 
forwarded to Operations Management and permissions 
to run the available tools. Topology synchronization 
requires administrator rights.

NOTE: All messages forwarded from HPOM systems are 
treated as allowing read and write. Any changes made to 
these events result in a back synchronization to the 
originating HPOM server.

Manage certificate Opens the Certificate Details dialog box, which displays 
details about the current certificate, and contains links to 
replace the certificate from the host or from a file.

Password Password for the user account on the external server.

For an HPOM server, used for receiving instructions, and 
executing tools and actions.

For an External Event Processing server, used for event 
forwarding.

UI Element (A-Z) Description
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Port Communication port on the external server.

For an HPOM server, used for receiving instructions, and 
executing tools and actions.

For an External Event Processing server, used for event 
forwarding.

Set default port specifies the default port used by HPOM.

Note: For information about checking and changing 
ports, see the documentation of your web server product.

Remove certificate Removes the installed certificate.

Retrieve from server Retrieve a certificate from the host system specified in 
this server connection.

Server ID Enables the selection of an alternative, configured HPOM 
server for receiving instructions, and executing tools and 
actions.

Supports 
Synchronize and 
Transfer Control

Selects the Supports Synchronize and Transfer Control 
option to enables the transfer responsibility to the 
external event processing server.

Use Other Server Specifies that an alternative, configured HPOM server is 
to be used for receiving instructions, and executing tools 
and actions.

Use this Server Use the currently enabled server HPOM for receiving 
instructions, and executing tools and actions.

User Name Name of the user account on the external server.

For an HPOM server, used for receiving instructions, and 
executing tools and actions.

For an External Event Processing server, used for event 
forwarding.

Use Secure HTTP Selects the Use Secure HTTP option for secure 
communication.

UI Element (A-Z) Description
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Certificate Details

The Certificate Details dialog box displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Certificate Details tab.

Relevant tasks To configure certificates for connected servers, see:

➤ "How to Establish a Trust Relationship for a Server 
Connection" on page 426.

➤ "How to Verify the Trusted Relationship" on page 429.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Common Name (CN) Name or identifier of the certificate authority issuing the 
certificate or of the recipient of the certificate.

Import from file Opens the file browser and enables you to navigate to 
and specify a certificate file for the server connection.

Certificates must meet the Base64 Encoded X.509 format.

Issued by Details about the issuer of the certificate.

Issued to Details about the recipient of the certificate.

Location (L) Name of the resource location in the digital certificate 
hierarchy to which the certificate belongs or from which 
it was issued.

Organization (O) Name of the organization in the digital certificate 
hierarchy to which the certificate belongs or from which 
it was issued.

Organization Unit 
(OU)

Name of the organizational unit in the digital certificate 
hierarchy to which the certificate belongs or from which 
it was issued.
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Policy Management

The Policy Management tab displays the UI elements listed in the following 
table.

Retrieve from server Retrieve a certificate from the host for a server 
connection.

Valid from Earliest date from which the current certificate is valid.

Valid to Last date on which the current certificate is valid.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Policy Management tab.

Relevant tasks To configure an Integration Adapter connected server, see 
"How to Create a Connection to an Integration Adapter 
Server" on page 420.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Launch Policy Editor: Opens the Policy Management UI 
in a new window.

Port Port used to open Policy Management on the Integration 
Adapter server.

Set default port Default port value is automatically inserted into the Port 
field.

UI Element (A-Z) Description
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Event Drilldown

The Event Drilldown tab displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Event Drilldown tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Fully Qualified DNS 
Name

Fully qualified Domain Name System name of the system 
hosting the External Event Processing server. For 
example: myhost.example.com.

Port Communication port on the External Event Processing 
server, used for event drilldown.

Set default port Default port value is automatically inserted into the Port 
field.
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URL The complete URL used for drilldown to a source 
manager. It is a combination of the Fully qualified 
Domain Name System name, the Port, and the URL Path.

For example:

Server.example.com/80/
opr-policy-management?${sourcedFrom.externalId}

URL Path Relative URL Path used for drilldown to a source 
manager. 

Tip: Variable to access the event on the source manager 
is:

${sourcedFrom.externalId}

This variable is replaced at runtime using the context of 
an event to get the External ID.

Use Secure HTTP Selects the Use Secure HTTP option for secure 
communication.

UI Element (A-Z) Description
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Incoming Connection

The Incoming Connection tab displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Connected Servers

Double-click the selected connected server and select the 
Incoming Connection tab.

Relevant tasks To configure connected servers, see:

➤ "How to Create a Connection to another OMi 
Instance" on page 411.

➤ "How to Create a Connection to an HPOM Server" on 
page 413.

➤ "How to Create a Connection to an External Event 
Processing Server" on page 417.

➤ "How to Create a Connection to an Integration 
Adapter Server" on page 420.

➤ "How to Create and Associate an Alias to a Connected 
Server" on page 422.

See also For more information about connected servers, see 
"Introduction to Connecting Servers" on page 408.

UI Element (A-Z) Description

Event Backsync Credentials of the Operations Management user used by 
the External Event Processing server to update events on 
the BSM server from which the event was forwarded.

Password Password for the automatically-generated user account 
used to receive updates from the external server.

User Name Automatically-generated user account used by the 
External Event Processing server to update events on the 
server from which the event was forwarded.
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Connecting Servers Manager Command-Line Interface 

This section describes the options and parameters available in the 
ConnectedServers command-line interface.

The ConnectedServers command-line interface is located in:

<BSM_Root_Directory>/opr/bin

The ConnectedServers command requires the following syntax:

ConnectedServer <<BSMOPTS>> <<ACTION>>

Where:

<<BSMOPTS>>:-username <login name> -password <password>
[[-port <port>]
[-server <server>] [-ssl] | [-url <url>]]

<<ACTION>>:    -add <<OPTIONS>> | -delete <identifier> | -list |
-show <identifier> |
-update <identifier> <<OPTIONS>>

The valid arguments for <<OPTIONS>> are: 

-name <name> -label <label> -dns <DNS name> -type <type> -active <yes/no>
-issl <yes/no> [-certificatefile <file> | -certificate] [-fwdtopo <yes/no>]
[-integrationuser <user>] [-integrationpw <pw>] [-integrationport <port>]
[-oserver <id>] 
[-scripttype <type>] [-scriptfile <file>] [-scriptcp <cp>] |
[-wsrooturl <url>]] [-maxtimeout <time>]
[-drilldns <DNS name> -drillport <port> [-drillssl <yes/no>]]
[-toc yes -backsyncpw <pw> | -toc no]
[-backsync yes -backsyncpw <pw> | -backsync no] |
[-help | -version]

Note: <<BSMOPTS>> is required for all commands except for the options 
-help and -version.
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The following table gives more information about the arguments recognized 
by the ConnectedServers command:

Option Description

-a,-add Adds a new server. Any unspecified optional options 
are set to their default values.

-active <yes/no> Enables or disables the server. Default value isyes, 
except for Alias servers for which the associated server 
is not set.

-bs,-backsync <yes/no> Enables or disables backsync. Default value is: no. If 
enabled, requires the -backsyncpw option.

-bspw,-backsyncpw 
<pw>

Sets the Backsync password.

-certificate Certificate of the HPOM system will be saved.

-certificatefile <file> Loads the certificate from the specified file.

-d,-delete <identifier> Deletes the server specified by the ID or the name of 
the server.

-ddns,-drilldns <dns 
name>

Sets the DNS name of event drilldown system.

-desc <description> Description of the server.

-dns <dns name> Sets the DNS name of the connected server being 
specified.

-dport,-drillport <port> Sets the port of event drilldown system. 

-dssl,-drillssl <yes/no> Enables or disables HTTPS for event drilldown. Default 
value is: no.

-ft,-fwdtopo <yes/no> Enables or disables forward dynamic topology. Default 
value is: no.

-h,-help Displays a summary of the command options and 
exits.
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-iport,-integrationport 
<port>

Sets the integration port. Default values for the 
supported server types are:

➤ External Process: 80
➤ HPOM for Windows: 443
➤ HPOM for UNIX: 8444
➤ Integration Adapter: 8443 (secure) or 8081 

(insecure)

-ipw,-integrationpw 
<pw>

Sets the integration user password.

Note: When updating a server that already has the 
integration user password set, you must enter 
-ipw <your_password> as a parameter, for example:

If you created a server and set the integration user 
password and want to update the label of the server, 
enter the command:

ConnectedServer <<BSMOPTS>> -label <label text> 
-ipw <password>

-issl <yes/no> Enables or disables HTTPS for integration. Default 
value is: yes.

-iuser,-integrationuser 
<user>

Sets the integration user.

-l,-list Lists the key properties of all configured connected 
servers.

-label <label> Sets the label of the server.

-mto,-maxtimeout 
<max timeout>

Sets the maximum timeout. Default value is: 60 
seconds.

-name <name> Sets the name of the server.

-os,-oserver <id> Sets an alternative server to execute action, tools, and 
instructions.

-p,-port <port> Sets the port of the BSM server. Default value is: 80 
(HTTP) or 443 (HTTPS).

-pw,-password <pw> Sets the password of the BSM user.

Option Description
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-s,-show <identifier> Shows the properties of the server specified by the ID 
or the name of the server.

-scp,-scriptcp 
<classpath>

Sets the script class path. Default is empty.

-server <server> Sets the hostname or IP address of the BSM server. 
Default value is: mambo3.mambo.net.

-sfile,-scriptfile <file> Specifies a script file.

-ssl Specifies the networking protocol (HTTP or HTTPS) 
used to connect to the BSM server. Default value is: 
HTTP.

-stype,-scripttype 
<type>

Sets the script type.

-toc <yes/no> Enables or disables transfer control to external server. 
Default value is: no. If enabled, requires the 
-backsyncpw option.

-type <type> Sets the type of server. The supported types are:

➤ OMI

➤ OMW (HPOM for Windows)

➤ OMU (HPOM for UNIX)

➤ EXTERNAL_PROCESS

➤ INTEGRATION_ADAPTER

➤ ALIAS

-u,-update <identifier> Updates the properties of the server specified by the 
ID or the name of the server.

-url <URL> Sets the URL of the BSM server. Default value is: 

http://mambo3.mambo.net:80/opr-admin-server

Do not use in conjunction with the options -ssl, 
-server, or -port.

-user,-username <login 
name>

Sets the name of the BSM user.

-version Shows the version of the Connected Server CLI.

Option Description
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The ConnectedServer command displays the following values to indicate 
the exit status of the requested operation:

The exit status numbers (300-599) reflect a standard HTTP-status category 
(and number), for example: Redirection (300-399). For more information 
about a specific HTTP error status, for example: 307, which signifies a 
temporary HTTP re-direct, see the publicly available HTTP documentation.

General example command syntax and command option and arguments for 
adding and updating specific server types are summarized in the following 
sections:

➤ "Example Commands for All Server Types" on page 454

➤ "OMI Server Configuration" on page 454

➤ "HPOM Configuration" on page 454

➤ "External Process Configuration" on page 455

➤ "Integration Adapter Configuration" on page 455

➤ "Alias Server Configuration" on page 456

-wsrooturl <url> Sets the root URL of the web service. Default value is 
empty.

Exit Status Description

0 Successful completion

1 Failure of requested operation

300-399 HTTP Redirection (300-399)

400-499 HTTP Client Error (400-499)

500-599 HTTP Internal Server Error (500-599)

Option Description
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Example Commands for All Server Types
List servers: 

ConnectedServer <<BSMOPTS>> -list

Delete server: 

ConnectedServer <<BSMOPTS>> -delete <identifier>

Show server: 

ConnectedServer <<BSMOPTS>> -show <identifier>

OMI Server Configuration
Adding a server of type OMI:

ConnectedServer <<BSMOPTS>> -add -label <label> -name <name> 
-dns <dnsname> -type OMI [-active <yes/no>] [-fwdtopo <yes/no>] 

Updating a server of type OMI:

ConnectedServer <<BSMOPTS>> -update [-label <label>] [-name <name>] 
[-dns <dnsname>] [-active <yes/no>] [-fwdtopo <yes/no>]

HPOM Configuration
Adding a server of type HPOM for Windows or HPOM for UNIX:

ConnectedServer <<BSMOPTS>> -add -label <label> -name <name> 
-dns <dnsname> -type <OMW/OMU> [-active <yes/no>] -iuser <user>                             
[-fwdtopo <yes/no>] [[-integrationpw <pw>] [-integrationport <port>] 
[-issl <yes/no>] > [-certificatefile <file> | -certificate]] | [-oserver <id>]]

Updating a server of type HPOM for Windows or HPOM for UNIX:

ConnectedServer <<BSMOPTS>> -update <identifier> [-label <label>] [-name 
<name>] [-dns <dnsname>] [-active <yes/no>] [-iuser <user>] 
[-fwdtopo <yes/no>] [[-integrationpw <pw>] [-integrationport <port>] [-issl <yes/
no>] [-certificatefile <file> | -certificate]] | [-oserver <id>]]
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External Process Configuration
Adding a server of type External Processing:

ConnectedServer <<BSMOPTS>> -add -label <label> -name <name> 
-dns <dnsname> -type EXTERNAL_PROCESS [-active <yes/no>] 
(-scripttype <type> -scriptfile <file> [-scriptcp <classpath>] | [-wsrooturl <url>]) 
[-maxtimeout <max timeout>] [-iuser <user>] [-integrationpw <pw>] 
[-integrationport <port>] [-issl <yes/no>] [-drilldns <dnsname> -drillport <port> 
[-drillssl <yes/no>]] [-toc no] [[-backsync no] | -backsync yes -backsyncpw <pw>] 
| -toc yes [-backsync yes] -backsyncpw <pw>] 

Updating a server of type External Processing:

ConnectedServer <<BSMOPTS>> -update <identifier> [-label <label>] 
[-name <name>] [-dns <dnsname>] [-active <yes/no>] 
(-scripttype <type> -scriptfile <file> [-scriptcp <classpath>] | [-wsrooturl <url>]) 
[-maxtimeout <max timeout>] [-iuser <user>] [-integrationpw <pw>] 
[-integrationport <port>] [-issl <yes/no>] [-drilldns <dnsname> -drillport <port> 
[-drillssl <yes/no>]] [[-toc no] [[-backsync no] | -backsync yes -backsyncpw <pw>] 
| -toc yes [-backsync yes] -backsyncpw <pw>]

Integration Adapter Configuration
Adding a server of type Integration Adapter:

ConnectedServer <<BSMOPTS>> -add -label <label> -name <name> 
-dns <dnsname> -type INTEGRATION_ADAPTER [-active <yes/no>] 
[-integrationport <port>] [-issl <yes/no>] [-drilldns <dnsname> -drillport <port> 
[-drillssl <yes/no>] [-wsrooturl <url>]] 

Updating a server of type Integration Adapter:

ConnectedServer <<BSMOPTS>> -update <identifier> [-label <label>] 
[-name <name>] [-dns <dnsname>] [-active <yes/no>] [-integrationport <port>] 
[-issl <yes/no>] [-drilldns <dnsname> -drillport <port> [-drillssl <yes/no>] 
[-wsrooturl <url>]]
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Alias Server Configuration
Adding a server of type Alias:

ConnectedServer <<BSMOPTS>> -add -label <label> -name <name> 
-type ALIAS [-active <yes/no>] [-oserver <id>] 

Updating a server of type Alias:

ConnectedServer <<BSMOPTS>> -update <identifier> [-label <label>] 
[-name <name>] [-active <yes/no>] [-oserver <id>]
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BBC Trust Server  Command-Line Interface 

This section describes the options and parameters available in the 
BBCTrustServer command-line interface.

The BBCTrustServer command-line interface is located in:

<BSM_Root_Directory>/opr/bin

The BBCTrustServer command requires the following syntax:

BBCTrustServer ([-h | -help]  | -version) |
(<server> [-i | -import] [-o | -overwrite] [-p | -proxy])

The following table gives more information about the arguments recognized 
by the BBCTrustServer command:

Option Description

<server> DNS name of the external server with the CA 
certificate to be trusted. 

-h,-help Displays a summary of the command options and 
exits.

-i, -import Imports the trusted certificate to the certificate store 
without prompting for user confirmation.

-o, -overwrite Overwrites existing trusted certificate with the same 
common name without prompting for user 
confirmation.

-p, -proxy Specifies an HTTP proxy. 

Format: <hostname>:<port>

Default port: 8080

-version Shows the version of the BBCTrustserver CLI.
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The BBCTrustServer command displays the following values to indicate the 
exit status of the requested operation:

Exit Status Description

0 Successful completion

1 Failure of requested operation
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Troubleshooting and Limitations 

This section provides help for those people who are troubleshooting 
problems relating to connected servers.

➤ "Events Indicating that a Server is not Reachable" on page 459

Events Indicating that a Server is not Reachable
If a forwarding request fails, it is put back into the queue to be retried, and a 
corresponding events is generated. The frequency that these events are 
created for a particular request can be control via the infrastructure setting 
Retry Notify Interval (see "Event Forwarding Settings" on page 702).

For example, if an Event Forwarding Gateway server gateway.example.com is 
unable to reach an external server called external_server, and the following 
event is displayed:

Event Forwarding Gateway server gateway.example.com is unable to reach 
server external_server due to the following error:

'java.net.UnknownHostException: external_server.example.com'

The event '<event name>' (6c632780-aeb7-4407-af43-724b73a49f9c) cannot be 
delivered at this time. The request will be retried continuously until the forward 
request expires. According to the current Operations Management Event 
Forwarding Expiration infrastructure setting of 12 hour(s), this request is 
currently estimated to expire in 10 hour(s) and 6 minute(s). Currently the queue 
this request is on has 40 request(s) in the backlog.

The Operations Management Event Forwarding Expiration infrastructure 
setting value and the time remaining before event forwarding is to be 
terminated is specified. In addition, the number of events that are in the 
queue to be forwarded to the unreachable server is also specified.
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16 
Event Forwarding to External Servers

This chapter includes:

Concepts

➤ Introduction to Event Forwarding Rules on page 462

Tasks

➤ How to Create an Event Forwarding Rule on page 465

➤ How to Edit an Event Forwarding Rule on page 468

➤ How to Duplicate an Event Forwarding Rule on page 469

➤ How to Delete an Event Forwarding Rule on page 470

Reference

➤ Event Forwarding User Interface on page 471

Troubleshooting and Limitations on page 474
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Concepts

Introduction to Event Forwarding Rules

The Event Forwarding manager enables you to set up rules to select and 
forward events to external event managers such as another Operations 
Manager i instance, HP Operations Manager and or a Help desk application. 
These external managers are also referred to as event forwarding targets.

Event forwarding rules are used in conjunction with server connections to 
redirect selected events to specific event managers. Events can be forwarded 
for information or as a result of an escalation where the ownership of the 
problem is transferred to a more specialized group of experts.

Note: Policies configured in HP Operations Manager can set trouble ticket 
and notification flags. If these flags are set, the following custom attributes 
in Operations Management are generated:

➤ ForwardToTroubleTicket (value= true)

➤ NotifyUser (value= true)

Using appropriately configured event filters, events including these custom 
attributes with value of true can be automatically forwarded to an external 
manager using Forwarding Rules or notifications sent using Notification 
Rules.
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Note: Forwarding rules are not re-scheduled if a matching event still 
matches the rule condition after that rule was executed. 

To schedule another rule execution, an event must first change in such a 
way that it no longer matches the rule condition and later change so that it 
matches again. 

Only the transition from not-matching or new, to matching a rule condition 
triggers scheduling a rule execution.

Events to be forwarded are held in a queue. A server is selected and an 
attempt is made to send the first request to this server. If the server is 
available, all other pending requests for this server are also sent in series. 
This procedure is repeated for all other forwarding requests and servers. If a 
server is not available, the next server is selected and the events destined for 
this server are sent. After all possible events are sent, servers that could not 
be reached are retried until forwarding of events in the queue is complete or 
queued events are older than time period set in the Event Forwarding 
Expiration setting, at which time they are deleted from the queue. For 
details about this setting, see "Event Forwarding Settings" on page 702.

The following forwarding rule is provided with Operations Management. 
This rule is disabled by default.

Automatically Forward to Trouble Ticket System — Forwards all events for 
which the custom attribute ForwardToTroubleTicket value is true to the 
trouble ticket system. 

The ForwardToTroubleTicket flag is set in HP Operations Manager policies, 
which creates the ForwardToTroubleTicket (value= true) custom attribute in 
Operations Management.
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Note:  The system is specified as an alias server. Configure the Trouble Ticket 
Server alias server to connect to the physical trouble ticket server system. For 
details, see "How to Create and Associate an Alias to a Connected Server" on 
page 422.
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Tasks

How to Create an Event Forwarding Rule

This task shows you how to create an event forwarding rule.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create an event forwarding rule:

 1 Open the Event Forwarding manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Forwarding Rules

 2 In the Event Forwarding Rules pane, click the  button to open the 
Create New Event Forwarding Rules dialog box.

 3 Enter a display name, and (optional) a description of the event 
forwarding rule being specified.

 4 Select Active, if you want to make the event forwarding rule active 
immediately.

 5 Select an event filter for the event forwarding rule from the Events Filter 
list. The filter determines which events to consider for forwarding.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.
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 6 Select one or more target servers to which the events selected by this rule 
should be forwarded. For each target server, add it to the rule using the  
button.

If no target servers are configured, configure the required target servers 
first. For details, see "How to Create a Connection to an HPOM Server" on 
page 413.

Note: An actual connected server configuration cannot be exported, as 
these configurations are installation-specific. Importing an event 
forwarding rule creates a virtual server for each specified target server. 
These virtual servers must be associated with physical connected servers 
to enable the rule.

 7 If you have an Operations Management license, for each target server that 
you added to the event forwarding rule, specify a forwarding type. 

The options include:

➤ Notify

➤ Notify and Update

➤ Synchronize

➤ Synchronize and Transfer Control (External Event Processing Server 
only)

If you do not have such a license and are using the BSM Event Channel, 
the forwarding type is set to Notify and no notification options are shown.



Chapter 16 • Event Forwarding to External Servers

467

Note: An Automatic forwarding rule that is configured to transfer control 
of an event to a Connected Server may fail if the event has already been 
transferred to another server. In this case the following is done:

➤ The event is forwarded to the specified connected server as Notify and 
Update and not as Synchronize and Transfer Control.

➤ A log file entry is made to the log/opr-backend/opr-backend.log file.

➤ An annotation is made to the event with the log message. The author 
of the annotation is System:Forwarding.

 8 Select OK.
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How to Edit an Event Forwarding Rule

This task shows you how to edit an existing event forwarding rule.

To edit an existing event forwarding rule:

 1 Open the Event Forwarding manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Forwarding Rules

 2 Select the event forwarding rule that you want to edit.

 3 In the Event Forwarding Rules pane, click the  button to open the Edit 
Event Forwarding Rule dialog box.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Event Forwarding Rule dialog box.

 4 Make the required changes to the selected event forwarding rule.

 5 Select OK.
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How to Duplicate an Event Forwarding Rule

This task shows you how to duplicate an existing event forwarding rule to 
use as the basis for a new event forwarding rule.

To duplicate an existing event forwarding rule:

 1 Open the Event Forwarding manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Forwarding Rules

 2 Select the event forwarding rule that you want to duplicate.

 3 In the event forwarding rules pane, click the  button. 

The Create New Event Forwarding Rule dialog box opens with a duplicate 
of the selected rule.

 4 Edit the duplicate event forwarding rule to suit the new event forwarding 
rule. 

For details about editing, see "How to Edit an Event Forwarding Rule" on 
page 468.
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How to Delete an Event Forwarding Rule

This task shows you how to delete an existing event forwarding rule.

To delete an existing event forwarding rule:

 1 Open the Event Forwarding manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Forwarding Rules

 2 Select the event forwarding rule that you want to delete.

 3 In the Event Forwarding Rules pane, click the  button. 

The selected event forwarding rule is deleted from the list of event 
forwarding rules.
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Reference

Event Forwarding User Interface

The Event Forwarding manager enables you to create and manage rules to 
forward events to Operations Management, HPOM and external event 
processing servers.

The Event Forwarding pane displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Forwarding Rules

Relevant tasks To configure event forwarding rules, see "How to Create 
an Event Forwarding Rule" on page 465.

See also For more information about event forwarding rules, see 
"Introduction to Event Forwarding Rules" on page 462.

UI Element (A-Z) Description

Reloads the event forwarding rules list.

New Item: Opens the Create New Event Forwarding Rule 
dialog box to create an event forwarding rule. For more 
information about creating event forwarding rules, see 
"How to Create an Event Forwarding Rule" on page 465.

Duplicate Item: Creates a copy of the selected event 
forwarding rule. For more information about duplicating 
event forwarding rules, see "How to Duplicate an Event 
Forwarding Rule" on page 469.
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Edit Item: Opens the Edit Event Forwarding Rule dialog 
box to edit an existing event forwarding rule. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Event Forwarding 
Rule dialog box.

For more information about editing event forwarding 
rules, see "How to Edit an Event Forwarding Rule" on 
page 468.

Delete Item: Deletes the selected event forwarding rule. 
For more information about deleting event forwarding 
rules, see "How to Delete an Event Forwarding Rule" on 
page 470.

Activate/Deactivate Item: Toggles between enabling and 
disabling the selected Event Forwarding Rules.

Disabled rules appear dimmed in the list of rules.

Opens the Connected Servers manager.

Opens the Manage Event Filters dialog box, enabling you 
to select the event filter that you want to apply.

From the Select an Event Filter dialog box, you can also 
open the Filter Configuration dialog box to create an 
event filter, edit or delete an existing event filter.

For information about defining filters, see "Filtering 
Events" on page 211.

Active Indicates whether the associated event forwarding rule is 
active.

Description Brief description of the event forwarding rule.

Display Name Display name of the selected event forwarding rule.

Event Filter Filter used to select events to forward.

UI Element (A-Z) Description
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Forwarding Type Specifies how an event forwarded to a certain server is 
handled. The options include:

➤ Notify — Target server receives original events but no 
further updates

➤ Notify and Update — Target server receives original 
events and all further updates

➤ Synchronize — Target server receives original events 
and all further updates and sends back all updates

➤ Synchronize and Transfer Control — Target server 
receives original events and updates and sends back all 
updates. Ownership of the event is transferred to the 
other server.

Note: If you do not have an Operations Management 
license and are using the BSM Event Channel, the 
forwarding type is set to Notify and no notification 
options are shown.

Target Servers Servers selected as event forwarding targets for the 
selected event forwarding rule.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides the following help in troubleshooting problems 
relating to forwarding events:

➤ "Events are Being Forwarded to a Disabled Target System" on page 474

➤ "Event Forward Request to a Connected Server Fails" on page 474

Events are Being Forwarded to a Disabled Target System
A target server is disabled by clearing the Active flag in the associated 
connected server list entry event forwarding continues.

Instead of disabling the server, disable the forwarding rule for this server:

From the Forwarding Rules manager, select all rules using this connected 
server and disable these rule. Disabling a rule also disables forwarding to 
other targets using this rule.

Event Forward Request to a Connected Server Fails
If the request to forward an event to a particular connected server fails, the 
request is deleted from the forwarding queue and the event makes an 
internal note that the delivery to the target server has failed. The event 
maintains information about the failed request to the specified connected 
server. Any further forwarding rule matches on this event for this connected 
server is ignored. If the forwarding type was set to Synchronize and Transfer 
Control, a standard event annotation is also added to the event, otherwise 
no event annotation is made.

Failure to deliver can occur for retry timeouts, or a catastrophic delivery 
error. A catastrophic delivery error is a situation where it does not make 
sense to retry the request, for example, a mis-configuration (authentication 
fails), or a programming error is encountered in an External Process groovy 
adapter (NullPointerException). These cases require manual intervention 
before retrying.

To manually retry failed requests to a particular connected server, from the 
Event Browser, manually transfer control of an event that has previously 
failed delivery to a particular server.



475

17 
Time-Based Event Automation

This chapter includes:

Concepts

➤ Introduction to Time-Based Event Automation on page 476

Tasks

➤ How to Create a Time-Based Event Automation Rule on page 478

➤ How to Specify Actions for Time-Based Event Automation Rules 
on page 480

➤ How to Enable and Disable Time-Based Event Automation Rule 
on page 484

➤ How to Edit a Time-Based Event Automation Rule on page 485

➤ How to Duplicate a Time-Based Event Automation Rule on page 486

➤ How to Delete a Time-Based Event Automation Rule on page 487

Reference

➤ Time-Based Event Automation User Interface on page 488

Troubleshooting and Limitations on page 502
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Concepts

Introduction to Time-Based Event Automation

Time-based event automation rules enable administrators to configure 
actions to be executed on events matching a user-defined set of criteria after 
a specified time.

Time-based event automation rules can be very helpful in the following 
situations:

➤ If an automatic action for a message fails, you can configure a restart of 
the automatic action after a short delay. If it repeatedly fails, after a 
predefined number of retries, further retries are stopped and the event is 
escalated.

➤ If an event is not being worked on after a predefined period in time, you 
can configure a change to give it higher priority, for example by 
increasing its severity, or be assigned to a more expert group.

➤ You can configure the closing of an event that is older than a predefined 
period of time.

➤ You can configure transferring control for events based on time. For 
example, escalate if an event remains in browser for longer than 2 days, 
close if message remains for longer than 7 days (despite the escalation 
after 2 days).

Each time-based event automation rule consists of three main elements:

➤ Filter defining the events to which time-based event automation rules are 
to be applied.

➤ Time period defining the duration an event has to continuously match 
the rule’s filter to execute the rule’s actions on that event.

➤ List of actions to be executed on matching events. Available actions are 
re-running automatic actions on events, modifying event attributes, 
forwarding events to external servers, assigning events to users and 
groups, executing scripts, and executing Run Books.
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Automating the execution of actions on events results in increased operator 
efficiency and usability. With time-based event automation, many recurring 
tasks can be automated, leaving operators more time to work on the 
important task.

Note: Time-based automation rules, are not re-scheduled if a matching 
event still matches the rule condition after that rule had been executed.

To schedule another time-based automation rule execution, an event must 
first change in such a way that it no longer matches the rule condition and 
later change so that it matches again.

Only the transition from not-matching or new, to matching a rule condition 
triggers a rule re-execution.

The following time-based automation rules are provided with Operations 
Management. These are disabled by default.

➤ Close Old Events — Sets lifecycle state of all not closed events older than 
one week to closed.

➤ Forward To Trouble Ticket System — Forwards all unresolved events older 
than one day to the trouble ticket system.

Note:  The system is specified as an alias server. Configure the Trouble 
Ticket Server alias server to connect to the physical trouble ticket server 
system. For details, see "How to Create and Associate an Alias to a 
Connected Server" on page 422.

➤ Increase Severity And Priority — Increments the severity and priority by 
one of all events that have been in lifecycle state open for longer than one 
hour.

➤ Restart Failed Automatic Action — Restarts any failed automatic actions 
after a delay of 1 minute, with a maximum of 3 retries.
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Tasks

How to Create a Time-Based Event Automation Rule

This task shows you how to create a time-based event automation rule.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a time-based event automation rule:

 1 Open the Time-Based Event Automation Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Event Automation

 2 In the Time-Based Event Automation Rules pane, click the  button to 
open the Create New Time-Based Event Automation Rule dialog box.

 3 Enter a Display Name and description for the rule being specified.

 4 Select an event filter for the rule from the Events Filter list. The filter 
determines which events to consider in the rule.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.

 5 Set the match time period for the rule. The specified actions are executed 
on the event if the rule remains matched for the specified time period 
after the event started matching the rule’s filter.



Chapter 17 • Time-Based Event Automation

479

 6 Optional: Set the number of execution attempts to limit the number of 
executions of this rule on the same event, if that event matches the filter 
repeatedly for the configured time period.

 7 Select Activate rule after creation, if you want to make the rule active 
immediately.

 8 Click Next to open the Actions page.

 9 Specify the actions that you want to include in this rule as follows:

 a Click the  button and select an action. 

 b Enter the required information in the associated dialog box. For 
further information on specifying actions, see "How to Specify Actions 
for Time-Based Event Automation Rules" on page 480.

 c Repeat for all other actions that you want to specify.

 10 If necessary, change the order of action execution for the rule using the 
up  and down  buttons.

 11 Select Finish.
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How to Specify Actions for Time-Based Event 
Automation Rules

This section shows you how to specify the actions for a time-based event 
automation rule.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To specify actions for a time-based event automation rule:

 1 Open the Actions page of the Time-Based Event Automation Rules 
manager. For detailed instructions, see "How to Create a Time-Based Event 
Automation Rule" on page 478.

 2 Click the  button and select an action. 

The associated dialog box opens.

 3 Enter the required information in the associated dialog box. The 
following sections provide further information on specifying the available 
actions.

➤ "Re-running Automatic Actions" on page 481

➤ "Modifying Events and Custom Attributes" on page 481

➤ "Forwarding Events" on page 482

➤ "Assigning Events to Users and Groups" on page 482

➤ "Running Scripts" on page 483

➤ "Running Run Books" on page 483



Chapter 17 • Time-Based Event Automation

481

Re-running Automatic Actions
If you want the automatic action associated with a matching event to run as 
part of the time-based event automation rule being configured, click the  
button and select Re-run Automatic Action to include Re-run automatic 
action in the Actions list.

Modifying Events and Custom Attributes
If you want to modify event attributes and custom attributes for matching 
events, click  and select Modify Event to open the Modify Event 
Attributes dialog box and specify attributes and custom attributes as 
described in the following procedure.

If you want to modify event attributes for matching events, complete steps 
1 to 3. Otherwise, go to step 4.

 1 To modify an event attribute, click  from the Attributes table menu and 
select an attribute from the list.

The Create New Event Attribute Modification dialog box opens 
appropriate for the selected attribute.

 2 Specify how the attribute is to be changed when the time-based event 
automation rule is executed and click OK.

 3 Repeat steps 1 and 2 for all other attributes that should be modified by 
this rule.

If you want to modify custom attributes for matching events, complete 
steps 5 to 7. Otherwise, go to step 8.

 4 To modify a custom attribute, click  from the Custom Attributes table 
menu.

The Create New Event Attribute Modification dialog box opens.

 5 Enter the name of the custom attribute.

 6 Enter the value that the custom attribute should take when the 
time-based event automation rule is executed and click OK.

 7 Repeat steps 5 and 6 for all other custom attributes that should be 
modified by this rule.

 8 In the Modify Event Attributes dialog box, click OK.
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Forwarding Events
If you want to forward matching events, click  and select Forward Event 
to open the Forward Event dialog box. Specify the forwarding rule as 
follows:

 1 Select the Target Server to which you want to forward the event.

 2 Select the forwarding type and click OK.

Note: For a TBEA rule that was created with the understanding that the 
associated connected server has the Synchronize and Transfer Control 
forwarding type enabled, and the connected server configuration is later 
changed to disable Synchronize and Transfer Control, the Synchronize 
forwarding type is used.

TBEA rules are not automatically modified when connected server 
configurations are changed.

Assigning Events to Users and Groups
If you want to assign events to users or groups on matching events, click 

 and select Assign Event to open the Assignment dialog box and specify 
how events are to be assigned to users or groups as follows:

 1 Select a User group.

 2 Select a User.

Note: Leaving user or group empty clears that assignment. <unknown> is 
displayed if the user or group is not available. If <unknown> is displayed, 
select an available user or group.
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Running Scripts
If you want to run scripts defined using the Managing Scripts dialog box on 
matching events, click  and select Run Script to open the Run Script 
dialog box and specify the Event Processing Script that should be run from 
the list and click OK.

To create and edit scripts, open the Event Automation Configuration dialog 
box, using the Manage Scripts link. For information about defining scripts, 
see "Event Automation Script Configuration" on page 519.

Running Run Books
If you want to run Run Books on matching events, click  and select 
Launch Run Books to open the Run Books dialog box.

Specify the Run Books that should be run for the selected CI types as 
follows:

 1 Click  from the Run Books dialog box. 

The Select Run Books dialog box opens.

 2 Select a CI type from the Select a CI Type pane.

 3 Select a Run Book mapping for the selected CI type and click OK.

The new Run Book automation mapping is added to the list of selected 
Run Books.

 4 Repeat steps 2 and 3 for all other Run Books that you want to configure.

 5 In the Run Books dialog box, click OK.
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How to Enable and Disable Time-Based Event 
Automation Rule 

This task shows you how to enable and disable time-based event automation 
rules.

To enable or disable time-based event automation rules:

 1 Open the Time-Based Event Automation Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Event Automation

 2 Select the time-based event automation rules that you want to enable or 
disable.

 3 In the Time-Based Event Automation Rules pane, click the  button to 
enable the selected rules or the  button to disable the selected rules.
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How to Edit a Time-Based Event Automation Rule 

This task shows you how to edit a time-based event automation rule.

To edit a time-based event automation rule:

 1 Open the Time-Based Event Automation Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Event Automation

 2 Select the time-based event automation rule that you want to edit.

 3 In the Time-Based Event Automation Rules pane, click the  button to 
open the Edit Time-Based Event Automation dialog box.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Time-Based Event Automation dialog box.

 4 Make the required changes to the selected time-based event automation 
rule.

 5 Select OK.
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How to Duplicate a Time-Based Event Automation Rule 

This task shows you how to duplicate a time-based event automation rule.

To duplicate a time-based event automation rule:

 1 Open the Time-Based Event Automation Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Event Automation

 2 Select the time-based event automation rule that you want to duplicate.

 3 In the Time-Based Event Automation Rules pane, click the  button.

A copy of the selected event automation rule is created and is available for 
selection from the Time-Based Event Automation Rules pane.

 4 Select the copy event automation rule and click the  button to open the 
Edit Time-Based Event Automation dialog box.

 5 Make the required changes to the selected event automation rule.

 6 Select OK.
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How to Delete a Time-Based Event Automation Rule 

This task shows you how to delete a time-based event automation rule.

To delete a time-based event automation rule:

 1 Open the Time-Based Event Automation Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Event Automation

 2 Select the time-based event automation rule that you want to delete.

 3 In the Time-Based Event Automation Rules pane, click the  button. 

 4 Confirm the deletion by clicking Yes.

The selected event automation rule is deleted from the list of time-based 
event automation rules.
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Reference

Time-Based Event Automation User Interface

The Time-Based Event Automation manager enables you to create and 
manage rules to automatically run available actions on the related CI of 
events. You can specify any number of actions to be executed if the event 
remains matched for the specified time period.

This section includes:

 ➤ Time-Based Event Automation Rules User Interface on page 489

 ➤ Time-Based Event Automation Rules Details User Interface on page 491

 ➤ General Tab — Create New and Edit Time-Based Event Automation Rule 
Dialog Box on page 492

 ➤ Actions Tab — Create New and Edit Time-Based Event Automation Rule 
Dialog Box on page 494

 ➤ Modify Event Attributes Dialog Box on page 495

 ➤ Forward Event Dialog Box on page 496

 ➤ Assignment Dialog Box on page 498

 ➤ Run Script Dialog Box on page 499

 ➤ Run Books Dialog Box on page 500

 ➤ Select Run Books Dialog Box on page 501
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Time-Based Event Automation Rules User Interface

The Time-Based Event Automation Rules pane lists the specified rules. The 
Time-Based Event Automation Rules pane enables you to create and manage 
time-based event automation rules.

The Time-Based Event Automation Rules pane displays the UI elements 
listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

Reloads the time-based event automation rule list.

New Item: Opens the Create New Time-Based Event 
Automation Rule dialog box to create a new rule. 

For more information about creating time-based event 
automation rules, see "How to Create a Time-Based Event 
Automation Rule" on page 478.

Duplicate Item: Creates a duplicate of the selected 
automation rule.
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Edit Item: Opens the Edit Time-Based Event Automation 
Rule dialog box to edit an existing rule. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Time-Based Event 
Automation dialog box.

For more information about creating time-based event 
automation rules, see "How to Create a Time-Based Event 
Automation Rule" on page 478.

Delete Item: Deletes the selected Time-Based Event 
Automation Rule.

Activate/Deactivate item: Toggles between enabling and 
disabling the selected Time-Based Event Automation 
rules.

Disabled rules appear dimmed in the list of rules.

Manage Scripts: Opens the Event Automation 
Configuration interface in a new window.

For details managing event automation scripts, see 
"Event Automation Script Configuration" on page 519.

Manage Event Filters: Opens the Manage Named Filters 
dialog box for adding, editing, and managing filters.

For information about defining filters, see "Filtering 
Events" on page 211.

UI Element (A-Z) Description
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Time-Based Event Automation Rules Details User 
Interface

The Time-Based Event Automation Rules Details pane displays a summary of 
the selected time-based event automation rule.

The Time-Based Event Automation Rules Details page displays the UI 
elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

Actions Lists, in order of execution, the specified actions in the 
time-based event automation rule.

Active Indicates whether the associated time-based event 
automation rule is active.

Description Description of the time-based event automation rule.

Display Name Name of the time-based event automation rule.

Event Filter Filter specified to select events to be processed by this 
time-based event automation rule.
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General Tab — Create New and Edit Time-Based Event 
Automation Rule Dialog Box

Execute, if filter 
matches for 

Set the match time period for the rule. The specified 
actions are executed on the event if the rule remains 
matched for the specified time period after the event was 
received.

Limit number of 
executions per event 
to

Set the number of execution attempts to limit the 
number of executions of this rule on the same event, if 
that event matches the filter repeatedly for the 
configured time period.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

Double-click a time-based automation rule and select the 
General tab (if necessary).

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description
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The General Tab displays the UI elements listed in the following table.

UI Element (A-Z) Description

Activate Rule after 
creation (Create New 
wizard only)

Indicates whether the associated time-based event 
automation rule is active.

Description Description of the time-based event automation rule.

Display Name Name of the time-based event automation rule.

Event Filter Filter specified to select events to be processed by this 
time-based event automation rule.

Execute, if filter 
matches for 

Sets the execution time period for the rule. The specified 
actions are executed on the related CI of the event if the 
rule remains matched for the specified time period after 
the event was received.

Limit number of 
executions per event 
to

Sets the number of execution attempts for the actions 
specified in the rule. If an action fails, it is retried 
indefinitely unless a value is specified for the total 
number of executions.
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Actions Tab — Create New and Edit Time-Based Event 
Automation Rule Dialog Box

The Actions Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

Double-click a time-based automation rule and select the 
Actions tab (if necessary).

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

New Item: Opens the lists of automatic actions.

Edit Item: Opens the dialog box for editing the selected 
time-based automation rule.

Delete Item: Delete the selected time-based automation 
rule.

Moves the selected time-based event automation rules 
down to a later execution position.

Moves the selected time-based event automation rules up 
to an earlier execution position.

Expands the list to display details for all the specified 
actions.

Collapses all open action details panes.
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Modify Event Attributes Dialog Box

The Modify Event Attributes Dialog Box displays the UI elements listed in 
the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, and select 
Modify Event.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

New Item: Opens the Modify Custom Attribute dialog 
box for the selected attribute.

Edit Item: Opens the dialog box for editing the selected 
attribute modification configuration.

Delete Item: Delete the selected attribute modification 
configuration.

Attribute Attribute to be modified by the selected rule.

Custom Attribute Custom attribute to be modified by the selected rule.

Decrease value Increases the severity of the event by one level when an 
event is modified.
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Forward Event Dialog Box

Increase value Decreases the severity of the event by one level when an 
event is modified.

Name Name of the attribute or custom attribute.

Set value to Severity or lifecycle state value selected from list to be 
used to modify event.

Value Value of the associated attribute or custom attribute.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, and select 
Forward Event.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description
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The Forward Event Dialog Box displays the UI elements listed in the 
following table.

UI Element (A-Z) Description

Forwarding Type Specifies how an event forwarded to a certain server is 
handled. The options include:

➤ Notify — Target server receives original events but no 
further updates

➤ Notify and Update — Target server receives original 
events and all further updates

➤ Synchronize — Target server receives original events 
and all further updates and sends back all updates

➤ Synchronize and Transfer Control — Target server 
receives original events and updates and sends back all 
updates. Ownership of the event is transferred to the 
other server.

This option is available only if Supports Synchronize 
and Transfer Control is enabled on the selected 
connected server.

Note: For a TBEA rule that was created with the 
understanding that the associated connected server has 
the Synchronize and Transfer Control forwarding type 
enabled, and the connected server configuration is later 
changed to disable Synchronize and Transfer Control, the 
Synchronize forwarding type is used.

TBEA rules are not automatically modified when 
connected server configurations are changed.

Target Server Name of connected server name to which events are 
forwarded.
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Assignment Dialog Box

The Assignment Dialog Box displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, and select 
Assign Event.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

Select Group Specifies the User Group to which events are assigned.

Note: Leaving Group empty clears that assignment. 
<unknown> is displayed if the Group is not available. If 
<unknown> is displayed, select an available Group.

Select User Specifies the User to which events are assigned.

Note: Leaving User empty clears that assignment. 
<unknown> is displayed if the User is not available. If 
<unknown> is displayed, select an available User.
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Run Script Dialog Box

The Run Script Dialog Box displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, and select 
Run Script.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

Manage Script Opens the Event Automation Configuration interface in 
a new window.

For details managing event automation scripts, see 
"Event Automation Script Configuration" on page 519.

Script Specifies the Event Processing Script that is run.

Note: Time-based event automation scripts can only be 
deleted if they are not referenced in any time-based event 
automation rule.
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Run Books Dialog Box

The Run Books Dialog Box displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, and select 
Launch Run Books.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

New Item: Opens the Select Run Books dialog box for 
configuring Run Book automation mapping.

Delete Item: Delete the selected Run Book automation 
mapping.

CI Type CI type associated with the corresponding Run Book in 
the Run Book automation rule.

Run Book Name Run Book mapped to the corresponding CI Type.
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Select Run Books Dialog Box

The Select Run Books dialog box displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Event 
Automation

In the Time-Based Event Automation Rules pane, click 
the  button to open the Create New Time-Based Event 
Automation Rule dialog box.

Go to the Actions page, click the  button, select 
Launch Run Books, and click the  button from the Run 
Books page.

Relevant tasks To configure time-based event automation rules, see:

➤ "How to Create a Time-Based Event Automation Rule" 
on page 478.

➤ "How to Specify Actions for Time-Based Event 
Automation Rules" on page 480.

See also For more information about time-based event 
automation, see "Introduction to Time-Based Event 
Automation" on page 476.

UI Element (A-Z) Description

Reloads the Run Books list.

Select a CI Type CI type to be mapped to a Run Book in the Run Book 
automation rule.

Select Run Books Run Book to be mapped to the corresponding CI Type.
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Troubleshooting and Limitations 

This section provides help in troubleshooting problems relating to 
time-based event automation.

➤ Synchronize Forwarding Type is used if Server does not Support 
Transfer Control on page 502

Synchronize Forwarding Type is used if Server does not Support 
Transfer Control

For a TBEA rule that was created with the understanding that the associated 
connected server has the Synchronize and Transfer Control forwarding type 
enabled, and the connected server configuration is later changed to disable 
Synchronize and Transfer Control, the Synchronize forwarding type is used.

Note: TBEA rules are not automatically modified when connected server 
configurations are changed.
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18 
Launching Run Books Automatically

This chapter includes:

Concepts

➤ Introduction to Run Book Automation on page 504

Tasks

➤ How to Create a Run Book Automation Rule on page 505

➤ How to Edit a Run Book Automation Rule on page 507

➤ How to Duplicate a Run Book Automation Rule on page 508

➤ How to Delete a Run Book Automation Rule on page 509

Reference

➤ Run Book Rules User Interface on page 510

Troubleshooting and Limitations on page 517
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Concepts

Introduction to Run Book Automation

In addition to manually launching Run Books in HP Operations 
Orchestration in the context of an event (from the Action Panel, or directly 
from the context menu of an event), it is also possible to configure rules to 
automatically run a Run Book or a series of Run Books in the context of an 
event.

Run Books are related to CI types in BSM. As events are received or changed, 
those matching a filter used in a Run Book automation rule, trigger the 
associated Run Books on the CI related to the event. The Run Book 
Automation manager is used to configure Run Book automation rules that 
include an event filter, a CI type and a list of Run Books.

Note: Permissions to use the Run Book Automation manager must be 
configured for appropriate users under:

Admin > Platform > Users and Permissions > User Management
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Tasks

How to Create a Run Book Automation Rule

This task shows you how to create a Run Book automation rule.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a Run Book automation rule:

 1 Open the Automatic Run Book Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Automatic Run Book Rules

 2 In the Run Book Rules pane, click the  button to open the Create New 
Run Book Automation Rule dialog box.

 3 Enter a Display Name and description for the rule being specified.

 4 Select an event filter for the automation rule from the Events Filter list. 
The filter determines which events to consider in the rule.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.

 5 Select Activate rule after creation, if you want to make the rule active 
immediately.

 6 Click Next to open the Run Books page.

 7 In the Run Books pane, click the  button to open the Select Run Books 
dialog box.
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 8 Select a CI type from the Select a CI Type pane.

 9 Select a Run Book to be mapped to the selected CI type and click OK.

The new Run Book automation mapping is added to the list of selected 
Run Books.

 10 Repeat steps 7 and 8 for all other Run Books that you want to configure.

 11 Select Next to display the Summary page.

 12 Select Finish.
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How to Edit a Run Book Automation Rule

This task shows you how to edit a Run Book automation rule.

To edit a Run Book automation rule:

 1 Open the Automatic Run Book Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Automatic Run Book Rules

 2 Select the Run Book automation rule that you want to edit.

 3 In the Run Book Rules pane, click the  button to open the Edit Time 
Based Automation dialog box.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Time Based Automation dialog box.

 4 Make the required changes to the selected Run Book automation rule.

 5 Select OK.
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How to Duplicate a Run Book Automation Rule

This task shows you how to duplicate a Run Book automation rule.

To duplicate a Run Book automation rule:

 1 Open the Automatic Run Book Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Automatic Run Book Rules

 2 Select the Run Book automation rule that you want to duplicate.

 3 In the Run Book Rules pane, click the  button.

A copy of the selected Run Book automation rule is created and is 
available for selection from the Run Book Rules pane.

 4 Select the copy of the Run Book automation rule and click the  button 
to open the Edit Time Based Automation dialog box.

 5 Make the required changes to the selected Run Book automation rule.

 6 Select OK.
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How to Delete a Run Book Automation Rule

This task shows you how to delete a Run Book automation rule.

To delete a Run Book automation rule:

 1 Open the Automatic Run Book Rules manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Automatic Run Book Rules

 2 Select the Run Book automation rule that you want to delete.

 3 In the Run Book Rules pane, click the  button. 

 4 Confirm the deletion by clicking Yes.

The selected Run Book automation rule is deleted from the list of Run 
Book Rules.
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Reference

Run Book Rules User Interface

The Automatic Run Book Rules manager enables you to create and manage 
rules to automatically launch Run Books on the related CI of events. You 
can specify any number of Run Books.

This section includes:

➤ Run Book Rules Pane on page 510

➤ Run Book Automation Rules Details User Interface on page 512

➤ General Tab — Create New and Edit Automatic Run Book Launch Rule 
Dialog Box on page 513

➤ Run Books Tab — Create New and Edit Run Book Automation Rule Dialog 
Box on page 514

➤ Select Run Books Dialog Box on page 515

Run Book Rules Pane

The Run Book Rules pane lists the specified rules and enables you to create 
and manage Run Book Rules.

To access Select Admin > Operations Management > Tune 
Operations Management > Automatic Run Book Rules

Relevant tasks To configure automatic Run Book rules, see "How to 
Create a Run Book Automation Rule" on page 505.

See also For more information about Run Book rules, see 
"Introduction to Run Book Automation" on page 504.
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The Run Book Rules pane displays the UI elements listed in the following 
table.

UI Element (A-Z) Description

Reloads the Run Book Rule list.

New Item: Opens the Create New Run Book Automation 
Rule dialog box to create a new rule. 

For more information about creating Run Book 
automation rules, see "How to Create a Run Book 
Automation Rule" on page 505.

Duplicate Item: Creates a duplicate of the selected Run 
Book automation rule.

Edit Item: Opens the Edit Run Book Automation Rule 
dialog box to edit an existing rule.

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Time Based 
Automation dialog box.

For more information about creating Run Book 
automation rules, see "How to Create a Run Book 
Automation Rule" on page 505.

Delete Item: Deletes the selected Run Book Automation 
Rule.

Activate/Deactivate Item: Toggles between enabling and 
disabling the selected rules.

Disabled rules appear dimmed in the list of rules.

Manage Event Filters: Opens the Manage Named Filters 
dialog box for adding, editing, and managing filters.

For information about defining filters, see "Filtering 
Events" on page 211.
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Run Book Automation Rules Details User Interface

The Run Book Automation Rules Details pane displays a summary of the 
selected Run Book Automation Rule.

The Run Book Automation Rules Details page displays the UI elements listed 
in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Automatic Run Book Rules

Relevant tasks To configure automatic Run Book rules, see "How to 
Create a Run Book Automation Rule" on page 505.

See also For more information about Run Book rules, see 
"Introduction to Run Book Automation" on page 504.

UI Element (A-Z) Description

Active Indicates whether the associated Run Book Automation 
Rule is active.

CI Type CI type associated with a Run Book in the Run Book 
automation rule.

Description Description of the Run Book Automation Rule.

Display Name Name of the Run Book Automation Rule.

Event Filter Filter specified to select events to be processed by this 
Run Book Automation Rule.

Run Book Name Run Book specified in the Run Book automation rule and 
associated with the corresponding CI type.

For more information about creating Run Book 
automation rules, see "How to Create a Run Book 
Automation Rule" on page 505.
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General Tab — Create New and Edit Automatic Run Book 
Launch Rule Dialog Box

The General Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Automatic Run Book Rules

Relevant tasks To configure automatic Run Book rules, see "How to 
Create a Run Book Automation Rule" on page 505.

See also For more information about Run Book rules, see 
"Introduction to Run Book Automation" on page 504.

UI Element (A-Z) Description

Activate rule after 
creation

Indicates whether the associated Run Book automation 
rule is enabled.

Description Description of the Run Book automation rule.

Display Name Name of the Run Book automation rule.

Event Filter Filter specified to select events to be processed by this 
Run Book automation rule.
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Run Books Tab — Create New and Edit Run Book 
Automation Rule Dialog Box

The Advanced Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Automatic Run Book Rules

Relevant tasks To configure automatic Run Book rules, see "How to 
Create a Run Book Automation Rule" on page 505.

See also For more information about Run Book rules, see 
"Introduction to Run Book Automation" on page 504.

UI Element (A-Z) Description

New Item: Opens the Select Run Books dialog box for 
configuring Run Book automation mapping.

For more information about creating Run Book 
automation rules, see "How to Create a Run Book 
Automation Rule" on page 505.

For more information about creating time-based event 
automation rules, see "How to Create a Time-Based Event 
Automation Rule" on page 478.

Delete Item: Delete the selected Run Book automation 
mapping.

CI Type CI type associated with the corresponding Run Book in 
the Run Book automation rule.

Run Book Name Run Book mapped to the corresponding CI Type.
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Select Run Books Dialog Box

The Select Run Books dialog box displays the UI elements listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Automatic Run Book Rules

Relevant tasks To configure automatic Run Book rules, see "How to 
Create a Run Book Automation Rule" on page 505.

See also For more information about Run Book rules, see 
"Introduction to Run Book Automation" on page 504.

UI Element (A-Z) Description

Reloads the Run Books list.

Expand Selection: Expands the list to display items 
belonging to the selected group.

Collapse Others: Collapses all open branches except for 
the selected branch.

Entering a string with more than 2 characters in the 
search field locates the first instance of the string in the 
CI Tree.

Clicking the search button finds the next occurrence of 
the string for which you are searching. For more 
information about searching, see "How to Search and 
Filter CI Types" on page 275.

Collapses the Filter pane.

Expands the Filter pane for use.
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CI Types CI type to be mapped to a Run Book in the Run Book 
automation rule.

Hierarchical list representing the configuration item 
types in your IT environment. To display the required CI 
Type, browse to and select the item of interest. The Run 
Books associated with the CI Type are displayed.

If the CI Types list is filtered, (filtered) is displayed next to 
the CI Types title.

When CI types and their children have no Run Books 
assigned, their entries appear dimmed.

When CI types have children with assigned Run Books, 
their entries appear in normal text.

When Run Books are directly assigned to a CI type, their 
entries appear bold.

Filter Used to search for CI types with assigned Run Books.

For more information about searching and filtering, see 
"How to Search and Filter CI Types" on page 275.

Select Run Books Run Book to be mapped to the corresponding CI Type.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides help for those people who are troubleshooting 
problems relating to Operations Management Automatic Run Book Rules.

➤ "Importing Runbook Rules" on page 517

➤ "Automatic Runbook Rules Manager" on page 518

Importing Runbook Rules
When you import a Run Book rule with the Content Manager, a check is 
made to assess whether it is possible to execute the Run Book. If the check 
fails, the Run Book rule is disabled and a waring is displayed.

If a warning is displayed during the import of a content pack that contains 
Automatic Run Book rules, check the following:

➤ The connection to an Operations Orchestration system set up correctly. 
For details, see "HP Operations Orchestration Integration".

➤ The expected Run Book Mappings are available in the BSM Operations 
Orchestration integration interface (Admin > Integrations > Operations 
Orchestration).

➤ After ensuring that all required configurations are correct, activate the 
rule in the Automatic Run Book Rules manager (Admin > Operations 
Management > Tune Operations Management > Automatic Run Book 
Rules)
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Automatic Runbook Rules Manager
When you enter the Automatic Runbook Rules Manager (Admin > 
Operations Management > Tune Operations Management > Automatic Run 
Book Rules) and select a defined Runbook Rule, it can happen that instead 
of the name, the following is displayed:

<Run Book Mapping unknown or incomplete>

In this case check the following:

➤ The connection to an Operations Orchestration system set up correctly. 
For details, see "HP Operations Orchestration Integration".

➤ The expected Run Book Mappings are available in the BSM Operations 
Orchestration integration interface (Admin > Integrations > Operations 
Orchestration).
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19 
Event Automation Script Configuration 

This chapter includes:

Concepts

➤ Introduction to Scripts for Event Automation on page 520

Tasks

➤ How to Create an Event Automation Script on page 521

➤ How to Edit an Event Automation Script on page 523

➤ How to Duplicate an Event Automation Script on page 524

➤ How to Delete an Event Automation Script on page 525

Reference

➤ Event Automation Scripts User Interface on page 526
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Concepts

Introduction to Scripts for Event Automation

The Event Automation Configuration dialog box enables you to set up 
scripts that can be used in Time-based Event Automation. For example, you 
can add a text string to certain events to make them easier to identify in the 
Event Browser.

Event automation scripts must be specified in Groovy scripts. For 
information about writing scripts, see the Operations Manager i Extensibility 
Guide.

Event automation scripts are listed in alphabetical order. The selected event 
automation script is launched in the context of the CI associated with the 
selected event. A history entry is added for the automation rule launched 
within Time-based Event Automation.

Permissions to launch event automation script can be set for each user. For 
information on configuring access to event automation scripts, see "How to 
Set Operations Management User or Group Permissions" on page 637.

Event automation scripts can be defined in content packs, which are then 
used to distribute the event automation scripts to additional Operations 
Management installations.
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Tasks

How to Create an Event Automation Script

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

This task shows you how to create an event automation script.

To create an event automation script:

 1 Open the Event Automation Configuration dialog box from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Automation Rules

 2 In the Time-Based Automation Rules pane, click the  button to open 
the Create New Time-Based Automation Rule dialog box.

 3 In the General page, enter a display name, and (optional) a description of 
the script being specified.

 4 Click Next to open the Actions page.

 5 In the Actions pane, click the  button and select Run Script to open the 
Run Script dialog box.

 6 Select Manage Scripts to open the Event Automation Configuration 
dialog box.

 7 In the Scripts pane, click the  button to open the Create New Script 
dialog box.

 8 In the General tab, enter a display name, and (optional) a description of 
the script being specified.
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 9 In the Script field, add the script text.

 10 Click Next to open the Advanced tab.

 11 In the Classpath pane, add and order any JAR files required by the script.

The ordering of the JAR files is used by the classpath during execution. 
For example:

Jar file A contains a class x.y.z.

Jar file B contains a class x.y.z.

The ordering of the JAR files A and B dictates which class of which JAR file 
is loaded.

 12 Specify a timeout value for the script. If the script execution has not 
completed within the specified time, the result of the script is ignored.

 13 Select Read-Only for scripts that must not alter the event. 

Note: If a script that is labelled as read-only attempts to alter the event, 
the script is not executed and an error message is written to the ctxm 
logfile.

 14 Select Finish.
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How to Edit an Event Automation Script

This task shows you how to edit an existing event automation script.

To edit an existing event automation script:

 1 Open the Event Automation Configuration dialog box from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Automation Rules

 2 In the Time-Based Automation Rules pane, click the  button to open 
the Create New Time-Based Automation Rule dialog box.

 3 In the General page, enter a display name, and (optional) a description of 
the script being specified.

 4 Click Next to open the Actions page.

 5 In the Actions pane, click the  button and select Run Script to open the 
Run Script dialog box.

 6 Select Manage Scripts to open the Event Automation Configuration 
dialog box.

 7 In the Scripts pane, select the event automation script that you want to 
edit and click the  button.

The Edit Script dialog box opens.

 8 Make the required changes to the selected event automation script.

 9 Select OK.
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How to Duplicate an Event Automation Script

This task shows you how to duplicate an existing event automation script to 
use as the basis for a new event automation script.

To duplicate an existing event automation script:

 1 Open the Event Automation Configuration dialog box from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Automation Rules

 2 In the Time-Based Automation Rules pane, click the  button to open 
the Create New Time-Based Automation Rule dialog box.

 3 In the General page, enter a display name, and (optional) a description of 
the script being specified.

 4 Click Next to open the Actions page.

 5 In the Actions pane, click the  button and select Run Script to open the 
Run Script dialog box.

 6 Select Manage Scripts to open the Event Automation Configuration 
dialog box.

 7 Select the event automation script that you want to duplicate.

 8 In the Scripts pane, click the  button.

The selected event automation script is duplicated and added to the list of 
event automation scripts.

 9 Edit the duplicate event automation script to suit the new event 
automation script.

For details about editing, see "How to Edit an Event Automation Script" 
on page 523.
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How to Delete an Event Automation Script

This task shows you how to delete an existing event automation script.

To delete an existing event automation script:

 1 Open the Event Automation Configuration dialog box from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Time-Based Automation Rules

 2 In the Time-Based Automation Rules pane, click the  button to open 
the Create New Time-Based Automation Rule dialog box.

 3 In the General page, enter a display name, and (optional) a description of 
the script being specified.

 4 Click Next to open the Actions page.

 5 In the Actions pane, click the  button and select Run Script to open the 
Run Script dialog box.

 6 Select Manage Scripts to open the Event Automation Configuration 
dialog box.

 7 In the Scripts pane, select the event automation script that you want to 
delete.

 8 In the Scripts pane, click the  button. 

The selected event automation script is deleted from the list of event 
automation scripts.

Note: Time-based event automation scripts can only be deleted if they are 
not referenced in any time-based event automation rule.
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Event Automation Scripts User Interface

The Event Automation Scripts user interface enables you to create and 
manage event automation scripts to modify events.

This section includes:

 ➤ Event Automation Configuration Dialog Box on page 526

 ➤ Event Automation Scripts Details User Interface on page 528

 ➤ General Tab — Add New and Edit Script Dialog Box on page 529

 ➤ Advanced Tab — Add New and Edit Script Dialog Box on page 530

Event Automation Configuration Dialog Box

The Scripts pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Automation 
Rules

Relevant tasks For more information about configuring the Event 
Automation Scripts, see "How to Create an Event 
Automation Script" on page 521.

See also For more information about the Event Automation, see:

➤ "Event Automation Scripts Details User Interface" on 
page 528.

➤ "General Tab — Add New and Edit Script Dialog Box" 
on page 529.

➤ "Advanced Tab — Add New and Edit Script Dialog Box" 
on page 530.
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UI Element (A-Z) Description

Refresh: Reloads the scripts list.

New Item: Opens the Add New Script dialog box to create 
an event automation script. For more information about 
creating event automation scripts, see "How to Create an 
Event Automation Script" on page 521.

Duplicate Item: Creates a copy of the selected event 
automation script. For more information about 
duplicating event automation scripts, see "How to 
Duplicate an Event Automation Script" on page 524.

Edit Item: Opens the Edit Script dialog box to edit an 
existing event automation script. For more information 
about editing event automation scripts, see "How to Edit 
an Event Automation Script" on page 523.

Delete Item: Deletes the selected event automation 
script. For more information about deleting event 
automation scripts, see "How to Delete an Event 
Automation Script" on page 525.
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Event Automation Scripts Details User Interface

The Event Automation Configuration dialog box enables you to create and 
manage event automation scripts to modify events and take actions as a 
result of executing Time-based Event Automation rules.

The Details pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Automation 
Rules

Relevant tasks For more information about configuring the Event 
Automation Scripts, see "How to Create an Event 
Automation Script" on page 521.

See also For more information about the Event Automation, see:

➤ "Event Automation Scripts User Interface" on 
page 526.

➤ "General Tab — Add New and Edit Script Dialog Box" 
on page 529.

➤ "Advanced Tab — Add New and Edit Script Dialog Box" 
on page 530.

UI Element (A-Z) Description

Classpath List of JAR files required by the script.

Description Brief description of the event automation script.

Name Display name of the selected event automation script.

Read-Only Select Read-Only for a script that must not alter the 
event. 

If a script that is labelled as read-only attempts to alter 
the eventuate script is not executed and an error message 
is written to the ctxm logfile.
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General Tab — Add New and Edit Script Dialog Box

The General Tab displays the UI elements listed in the following table.

Script Groovy script used to specify the event automation 
script.

Timeout Timeout value for the script. If the script execution has 
not completed within the specified time, the result of the 
script is ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Automation 
Rules

Relevant tasks For more information about configuring the Event 
Automation Scripts, see "How to Create an Event 
Automation Script" on page 521.

See also For more information about the Event Automation, see:

➤ "Event Automation Scripts User Interface" on 
page 526.

➤ "Event Automation Scripts Details User Interface" on 
page 528.

➤ "Advanced Tab — Add New and Edit Script Dialog Box" 
on page 530.

UI Element (A-Z) Description

Description Brief description of the event automation script.

Name Name of the event automation script.

Script Text of the event automation script.

UI Element (A-Z) Description
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Advanced Tab — Add New and Edit Script Dialog Box

The Advanced Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Time-Based Automation 
Rules

Relevant tasks For more information about configuring the Event 
Automation Scripts, see "How to Create an Event 
Automation Script" on page 521.

See also For more information about the Event Automation, see:

➤ "Event Automation Scripts User Interface" on 
page 526.

➤ "Event Automation Scripts Details User Interface" on 
page 528.

➤ "General Tab — Add New and Edit Script Dialog Box" 
on page 529.

UI Element (A-Z) Description

Opens the Select Files browser dialog box to locate and 
add JAR files to the script configuration.

Deletes the selected JAR file from the classpath.

Moves the selected JAR file later in the order of 
execution.

Moves the selected JAR file early in the order of 
execution.

Class Path Specifies the names and locations of user-defined 
supporting libraries (JAR files).
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Read-Only Select Read-Only for a script that must not alter the 
event. 

If a script that is labelled as read-only attempts to alter 
the eventuate script is not executed and an error message 
is written to the ctxm logfile.

Timeout Specifies the timeout value for the event automation 
script. If the script execution has not completed within 
the specified time, the script is ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.

UI Element (A-Z) Description
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20 
Notifications 

This chapter includes:

Concepts

➤ Introduction to Notifications on page 534

Tasks

➤ How to Create a Notification Rule on page 535

➤ How to Create and Edit Notification Templates on page 537

➤ How to Edit a Notification Rule on page 539

➤ How to Duplicate a Notification Rule on page 540

➤ How to Delete a Notification Rule on page 541

Reference

➤ Notifications User Interface on page 542
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Concepts

Introduction to Notifications

You use the Notifications manager to set up rules to notify remotely-located 
people when events with predefined characteristics are received. 
Notifications can take the form of Emails, SMSs and Pager messages. 
Notifications must be sent to recipients set up in the Recipients manager.

Admin > Platform > Recipients > Recipients Management

Note: Policies configured in HP Operations Manager can set trouble ticket 
and notification flags. If these flags are set, the following custom attributes 
in Operations Management are generated:

ForwardToTroubleTicket (value= true)

NotifyUser (value= true)

Using appropriately configured event filters, events including these custom 
attributes with value of true can be automatically forwarded to an external 
manager using Forwarding Rules or notifications sent using Notification 
Rules.

Note: Forwarding rules can only be executed once per event.
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Tasks

How to Create a Notification Rule

This task shows you how to create a notification.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a notification:

 1 Open the Notification manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Notifications

 2 In the Notification Rules pane, click the  button to open the Create 
New Notification Rule dialog box.

 3 In the General page, enter a display name, and (optional) a description of 
the notification being specified.

 4 Select an event filter for the notifications from the Events Filter list. The 
filter determines which events to consider for forwarding.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.

 5 Select Activate Rule after creation, if you want to make the notification 
active immediately.

 6 Select Next. The Recipients page opens.
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 7 In the Recipients page, select the people to whom you want to send 
notifications. One recipient must be selected.

If no recipients are already configured, first click the  button to open 
the Recipients manager and specify the data for the required people 
before creating the Notification Rule.

 8 Select Next. The Templates page opens.

 9 In the Templates page, specify an email, SMS and a pager message 
templates that you want to use as the notification information. 
Alternatively, select Default to apply the default template for the 
associated message type.

Note: You can open a default template for modifying by selecting Default. 

You can reset the default template values using Reset to default template. 
The default template is the last saved template.

If no appropriate templates are available, select Manage Templates and 
modify an existing one or a create new one. Specify a template for all 
types of notifications.

For information about creating notification templates, see "How to Create 
and Edit Notification Templates" on page 537.

 10 Select Finish.



Chapter 20 • Notifications

537

How to Create and Edit Notification Templates

This task shows you how to create a notification template.

To create or edit a notification template:

 1 Open the Notification manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Notifications

 2 In the Notification Rules pane, click the  button to open the Manage 
Templates dialog box.

Alternatively, if you are creating or editing a notification rule, in the 
Templates page or tab, select Manage Templates.

The Mange Templates dialog box opens.

 3 Click the  button to open the Create New Notification Template dialog 
box or select an existing notification template and click the  button to 
open the Edit Notification Template dialog box.

 4 For new templates, enter a Display Name.

 5 Select the type of message template that you want to configure; Email, 
SMS, or Pager.

 6 For an email message, modify the default subject or enter a new subject as 
required.

 7 Modify the default message content or create new content for the selected 
Template.

You can specify event attributes in your message text to help make the 
notification more informative. For example, you can create a message 
that informs the recipient which system has a problem and what the 
severity is with the following string:

<<event.node.id>> is showing severity <<event.severity>>. 
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To specify event attributes:

 a Click Insert to open the Available Event Attributes dialog box.

 b Select an event attribute to be used in your message and click Insert.

 c Repeat for further event attributes as required.

 8 Select OK.
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How to Edit a Notification Rule

This task shows you how to edit an existing notification.

To edit an existing notification:

 1 Open the Notification manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Notifications

 2 Select the notification that you want to edit.

 3 In the Notification Rules pane, click the  button to open the Edit 
Notifications dialog box.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Notifications dialog box.

 4 Make the required changes to the selected notification.

Note: You can reset the template to the last saved values using Reset to 
default template.

 5 Select OK.
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How to Duplicate a Notification Rule

This task shows you how to duplicate an existing notification to use as the 
basis for a new notification.

To duplicate an existing notification:

 1 Open the Notification manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Notifications

 2 Select the notification that you want to duplicate.

 3 In the Notification Rules pane, click the  button. 

The selected notification is duplicated and displayed in the Create New 
Notification wizard.

 4 Edit the duplicate notification to suit the new notification. 

For details about editing, see "How to Edit a Notification Rule" on 
page 539.
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How to Delete a Notification Rule

This task shows you how to delete an existing notification rule.

To delete an existing notification:

 1 Open the Notification manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Notifications

 2 Select the notification that you want to delete.

 3 In the Notification Rules pane, click the  button. 

The selected notification is deleted from the list of notifications.
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Reference

Notifications User Interface

The Notifications manager enables you to create and manage forwarding 
notifications to individuals using email, SMS, and pager messaging.

This section includes:

➤ Notification Rules and Details Panes on page 542

➤ General Page and Tab on page 546

➤ Recipients Page and Tab on page 547

➤ Templates Page and Tab on page 548

➤ Manage Templates User Interface on page 550

➤ Available Event Attributes Dialog Box on page 552

Notification Rules and Details Panes

The Notification Rules and Details panes of the Notifications manager 
displays the configured notifications.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.
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The Notification Rules and Details panes display the UI elements in the 
listed in the following table.

UI Element (A-Z) Description

Reloads the Notification Rules list.

New Item: Opens the Create New Notifications dialog 
box to create a notification. For more information about 
creating notifications, see "How to Create a Notification 
Rule" on page 535.

Duplicate Item: Creates a copy of the selected 
notification. For more information about duplicating 
notifications, see "How to Duplicate a Notification Rule" 
on page 540.

Edit Item: Opens the Edit Notifications dialog box to edit 
an existing notification. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Notifications 
dialog box.

For more information about editing notifications, see 
"How to Edit a Notification Rule" on page 539.

Delete Item: Deletes the selected notification. For more 
information about deleting notifications, see "How to 
Delete a Notification Rule" on page 541.

Activate/Deactivate Item: Toggles between enabling and 
disabling the selected Notification rules.

Disabled rules appear dimmed in the list of rules.

Go to Recipient Management: Opens the Recipients 
manager from where you can specify an individual’s 
contact data used to forward notifications.

Manage Templates: Opens the Manage Templates dialog 
box, enabling you to create, edit and delete templates. 
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Manage Event Filters: Opens the Manage Event Filters 
dialog box, enabling you to select the event filter that 
you want to apply.

From the Select an Event Filter dialog box, you can also 
open the Filter Configuration dialog box to create an 
event filter, edit or delete an existing event filter.

For information about defining filters, see "Filtering 
Events" on page 211.

Active Indicates whether the associated notification is active.

Content Body text of the email, SMS or Pager template

Description Brief description of the notification.

Display Name Display name of the selected notification or the display 
name of a template of the notification.

Event Filter Filter used to select events to forward.

Recipients Specifies to which of the configured recipients an event is 
forwarded. The following information and status about 
the recipient is displayed:

➤ Name — Name of the target recipient for the 
notification 

➤ Email — Email address of the target recipient 
configured

➤ SMS — Mobile phone number of the target recipient 
configured

➤ Pager — Pager number of the target recipient 
configured

Reset to default 
template

Resets the template to the last saved values.

UI Element (A-Z) Description
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Subject Text entry field to specify the title of the email 
notification template.

Templates Text entry pages to specify the content and structure of 
the notification. The notification types are:

➤ Email 

➤ SMS 

➤ Pager 

UI Element (A-Z) Description
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General Page and Tab

The General page or tab of the Notifications manager enables you to create, 
view, and edit notifications.

The General page or tab displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.

UI Element (A-Z) Description

Activate Rule after 
creation

Select to make the notification active on rule creation 
(Create New Notification Rule only).

Description Brief description of the notification.

Display Name Display name of the notification.

Event Filter Filter used to select events to forward.
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Recipients Page and Tab

The Recipients page or tab of the Notifications manager enables you to 
select recipients for notifications.

The Recipients page or tab displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.

UI Element (A-Z) Description

Select the Recipients Specifies using check boxes to which of the configured 
recipients an event is forwarded. The following 
information and status about the recipient is displayed:

➤ Name — Name of the target recipient for the 
notification 

➤ Email — Email address of the target recipient 
configured

➤ SMS — Mobile phone number of the target recipient 
configured

➤ Pager — Pager number of the target recipient 
configured
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Templates Page and Tab

The Templates page or tab of the Notifications manager enables you to 
choose between the default template and any other defined templates. 
Templates are defined using the Template Manager. For detail about creating 
and editing templates, see "How to Create and Edit Notification Templates" 
on page 537.

The Templates page or tab displays the UI elements in the listed in the 
following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.

UI Element (A-Z) Description

<Template lists> Lists of defined templates available for use with 
notification rules.

The dedicated notification templates are required for the 
following notification types:

➤ Email 

➤ SMS 

➤ Pager 
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Default Opens the associated default template for viewing and 
editing.

Note: Default templates are not listed in the Template 
Manager. This is the only way to view and edit them.

Manage Templates Opens the Manage Templates dialog box. For detail about 
creating and editing templates, see "How to Create and 
Edit Notification Templates" on page 537.

UI Element (A-Z) Description
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Manage Templates User Interface

The Manage Templates manager enables you to create and manage email, 
SMS, and pager message templates for use with notifications.

Note: Changes are visible to all users and rules using the default template.

The Manage Templates page displays the UI elements listed in the following 
table.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.

UI Element (A-Z) Description

Reloads the templates list.

New Item: Opens the Create New Notification Template 
dialog box to create a notification template. For more 
information about creating notifications, see "How to 
Create and Edit Notification Templates" on page 537.

Duplicate Item: Creates a copy of the selected 
notification template.

Edit Item: Opens the Edit Notification Template dialog 
box to edit an existing notification template.
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Delete Item: Deletes the selected notification template. 

Body Text entry pane to specify the content and structure of 
the email notification template.

Content Text entry page to specify the content and structure of 
the notification template.

Note: The email content is divided into Subject and 
Body.

Display Name Display name of the selected notification template.

Insert Opens the Available Event Attributes dialog box, from 
which you can select event attributes to include in your 
message text.

Reset to default 
template

Resets the template to the last saved values for the 
selected default type.

Subject Text entry field to specify the title of the email 
notification template.

Type Notification template types:

➤ Email 

➤ SMS 

➤ Pager

UI Element (A-Z) Description
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Available Event Attributes Dialog Box

The Available Event Attributes dialog box enables you to browse a list of 
available event attributes that are available for the configuration item type 
associated with the notification template you are creating or modifying. You 
can add these attributes, one at a time, as part of your message.

The Available Event Attributes dialog box displays the UI elements listed in 
the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Notifications

Relevant tasks For more information about configuring notifications, 
see:

➤ "How to Create a Notification Rule" on page 535.

➤ "How to Create and Edit Notification Templates" on 
page 537.

See also For more information about notifications, see 
"Introduction to Notifications" on page 534.

UI Element (A-Z) Description

Display Name Name of the event attribute listed for the available 
configuration item type, for example: Originating Server, 
HI Value, or Custom Attribute.

Key Event attribute key used to identify the event attribute. 
There are two types of attributes:

➤ Attribute

The attribute that you specify is entered using the 
syntax:

<<event.<attribute name>>>

➤ Custom Attribute

The custom attribute that you specify is entered using 
the syntax:

<<event.custom.<custom attribute name>>>
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21 
Downtime Configuration

This chapter includes:

Concepts

➤ Introduction to Downtime Configuration on page 554

Tasks

➤ How to Create a Downtime Category on page 557

➤ How to Edit a Downtime Category on page 559

➤ How to Delete a Downtime Category on page 560

Reference

➤ Downtime Behavior User Interface on page 561
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Concepts

Introduction to Downtime Configuration

You can define and manage the downtime of CIs (configuration of CIs 
specifying periods of unavailability due to predetermined maintenance 
times) using the Downtime Management manager of the BSM platform.

You can access the Downtime Management manager as follows:

Admin > Platform > Downtime Management

A downtime configuration for a CI or a group of CIs primarily specifies the 
downtime period and the platform behavior (Action) for these CIs during 
this downtime period. If any other action is selected, for example Suppress 
events, the downtime behavior configured in Operations Management is 
applied.

For details about configuring downtime, see "Downtime Management" in 
Platform Administration.

For a CI with configured downtime periods, you must consider how to 
manage events that are related to this CI while it is unavailable. A category 
is assigned to the downtime configuration for a CI. In Operations 
Management, downtime strategies for event management are configured 
using Downtime Categories which define how events related to a CI are 
handle when received while that CI was in downtime. By default, events for 
which the related CI is in downtime are closed automatically.

For example, a category may specify that:

➤ Lifecycle of the event is set to resolved

➤ Steps in the event pipeline are enabled or disabled

In this example, for all CIs that are associated with this category, events 
received during downtime are set to Resolved and are visible in the Event 
Browser. All events that are related to these events are automatically set to 
closed and can be viewed from within the History Browser.
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The platform provides a predefined list of categories and you can create 
additional categories using the Infrastructure Settings. Categories are 
selected and modified using the Categories list in the Downtime 
Management manager.

Downtime configurations that do not have a corresponding configuration 
in the Operations Management Downtime Manager use the category 
Default.

The following Operations Management Infrastructure Setting relate to 
downtime behavior:

➤ Downtime History Range — Time period within which past downtime 
configurations are considered. All downtime periods which have an end 
time that is before the beginning of the configured downtime history 
range period are ignored. Events created during such downtimes are 
treated as events not created during a downtime.

➤ Future Downtime Range — Time period within which future downtime 
configurations are considered. All downtime periods which have a start 
time that is after the end of the configured future downtime range period 
are ignored. Events created during such downtimes are treated as events 
not created during a downtime.

➤ Refresh Time Interval — Maximum time after changes in the 
maintenance windows configuration are taking effect.
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Note: For events that are received from CIs specified in two or more 
overlapping downtime configurations with different categories, the category 
configurations are merged, which means:

➤ For setting lifecycle states, the most progressed state is selected. No 
Change overrides Closed, which in turn overrides Resolved.

➤ For active pipeline steps, the more restrictive setting for each option is 
selected. For example, if Close Related Events is not selected for one of 
the categories, it overrides the setting in the other category. 

➤ The confirmation dialog is displayed before launching tools and actions 
only if it is configured for all categories in the overlapping downtime 
configurations.
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Tasks

How to Create a Downtime Category

This task shows you how to create a downtime category.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a downtime category:

 1 Open the Downtime Behavior manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Downtime Behavior

 2 In the Categories pane, click the  button to open the Add New 
Downtime Category dialog box.

 3 Select a category from the Category Name list. 

A category is associated with each downtime configuration. When an 
event is received from a CI while in downtime, depending on the 
category of the CI downtime configuration, the appropriate downtime 
category is applied. If no suitable downtime category is available, the 
Default downtime category is applied.

 4 In the Set Lifecycle State section, select an action from the following 
choices:

➤ No change — retains the original state of the event

➤ Closed — changes the state to Closed for events that are related to CIs 
which are in downtime of the specified category (default)
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➤ Resolved — changes the state to Resolved for events that are related to 
CIs which are in downtime of the specified category

 5 In the Active Pipeline Steps section, select the pipeline step that you want 
active for this downtime category.

 6 Select Show Confirmation Dialog, if you want a confirmation dialog box 
to be displayed before launching tools and actions.

 7 Select OK.
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How to Edit a Downtime Category

This task shows you how to edit an existing downtime category.

To edit an existing downtime category:

 1 Open the Downtime Behavior manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Downtime Behavior

 2 Select the downtime category that you want to edit.

 3 In the Categories pane, click the  button to open the Edit Downtime 
Categories dialog box.

Alternatively, double-click a section in the Details pane to open the Edit 
Downtime Categories dialog box.

 4 Make the required changes to the selected downtime category.

 5 Select OK.
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How to Delete a Downtime Category

This task shows you how to delete an existing downtime category.

To delete an existing downtime category:

 1 Open the Downtime Behavior manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Downtime Behavior

 2 Select the downtime category that you want to delete.

 3 In the Categories pane, click the  button. 

 4 Confirm the deletion by clicking Yes.

The selected downtime category is deleted from the list of downtime 
categories.

Note: The Default category cannot be deleted.
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Reference

Downtime Behavior User Interface

The Downtime Behavior manager enables you to configure how Operations 
Management reacts on events that are related to CIs in downtime.

This section includes:

➤ Categories Pane on page 561

➤ Downtime Category Details Pane on page 563

Categories Pane

The Downtime Behavior manager enables you to configure how Operations 
Management reacts on events that are related to CIs in downtime.

To access Select Admin > Operations Management > Tune 
Operations Management > Downtime Behavior

Relevant tasks For more information about configuring the downtime 
behavior, see "How to Create a Downtime Category" on 
page 557.

See also For more information about the downtime behavior, see 
"Introduction to Downtime Configuration" on page 554.
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The Categories pane displays the UI elements listed in the following table.

UI Element (A-Z) Description

Refresh: Reloads the Categories list.

New Item: Opens the Add New Downtime Category 
dialog box to create a downtime category. For more 
information about creating downtime categories, see 
"How to Create a Downtime Category" on page 557.

Edit Item: Opens the Edit Downtime Category dialog box 
to edit an existing downtime category. 

Alternatively, double-click a section in the Details pane 
to open the Edit Downtime Categories dialog box.

For more information about editing downtime 
categories, see "How to Edit a Downtime Category" on 
page 559.

Delete Item: Deletes the selected downtime category. For 
more information about deleting downtime categories, 
see "How to Delete a Downtime Category" on page 560.
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Downtime Category Details Pane

The Downtime Details pane displays the configuration details of the 
downtime configuration selected in the Categories pane.

To access Select Admin > Operations Management > Tune 
Operations Management > Downtime Behavior

Relevant tasks For more information about configuring the downtime 
behavior, see "How to Create a Downtime Category" on 
page 557.

See also For more information about the downtime behavior, see 
"Introduction to Downtime Configuration" on page 554.
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The Details page displays the UI elements listed in the following table.

UI Element (A-Z) Description

Active Indicates whether the associated event pipeline step 
active. Inactive is displayed for step that are not active.

Active Pipeline Steps Lists the possible event pipeline processing steps. All 
steps that are set to active are executed on the events 
when received.

The processing steps that can be enabled are:

➤ EPI after CI/ETI Resolution — Apply event processing 
after the CI and ETI resolution steps.

➤ Close Related Events — Close all events related to the 
event received during downtime of CI.

➤ Duplicate Event Suppression — Apply the Duplicate 
Event Suppression settings to events received during 
downtime of CI.

➤ Automatic User Group Assignment of Events — Apply 
the automatic assignment of user or group to events 
received during downtime of the CI.

➤ EPI before Storing Events — Apply event processing at 
the end of the event processing stage.

➤ Topology-Based Event Correlation — Apply Topology 
Based Correlation Rules to events received during 
downtime of the CI. 

➤ Automatic Run Books — Apply Run Book Automation 
to events received during downtime of CI.

Set Lifecycle State Sets the lifecycle state for events received during a 
downtime period. The possible options are:

➤ No change — retains the original state of the event

➤ Closed — changes the state to Closed for all events 
received during a downtime period.

➤ Resolved — changes the state to Resolved for all 
events received during a downtime period

Show Confirmation 
Dialog

Select to display a confirmation dialog box before 
launching tools and actions.
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22 
Custom Actions 

This chapter includes:

Concepts

➤ Introduction to Custom Actions on page 566

Tasks

➤ How to Create a Custom Action Script on page 567

➤ How to Edit a Custom Action Script on page 569

➤ How to Duplicate a Custom Action Script on page 570

➤ How to Delete a Custom Action Script on page 571

Reference

➤ Custom Actions User Interface on page 572
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Concepts

Introduction to Custom Actions

The Custom Actions manager enables you to set up scripts to run custom 
actions on events. For example, you can add a text string to certain events to 
make them easier to identify in the Event Browser.

Custom actions must be specified in Groovy scripts. For information about 
writing custom actions, see the Operations Manager i Extensibility Guide.

After a custom action is configured in Operations Management, it can be 
triggered from an event from the context menu:

Right-click event > Launch > Custom Actions > custom action Scripts list

Custom actions are listed in alphabetical order. The selected custom action 
is launched in the context of the CI associated with the selected event. If a 
custom action is run from a non-assigned event, that event is automatically 
assigned to the user that executed the custom action, and a corresponding 
entry is made in the Event History.

Permissions to launch custom actions can be set for each user, for 
information on configuring access to custom actions, see "How to Set 
Operations Management User or Group Permissions" on page 637.

Custom actions can be defined in content packs, which are then used to 
distribute the custom actions to additional Operations Management 
installations.
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Tasks

How to Create a Custom Action Script

This task shows you how to create a custom action.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create a custom action:

 1 Open the Custom Actions manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Custom Actions

 2 In the Scripts pane, click the  button to open the Add New Script dialog 
box.

 3 In the General tab, enter a display name, and (optional) a description of 
the script being specified.

 4 In the Script field, add the script text.

 5 Select Active, if you want to make the custom action active immediately.

 6 Select the Advanced tab.

 7 In the Classpath pane, add and order any JAR files required by the script.

The ordering of the JAR files is used by the classpath during execution. 
For example:

Jar file A contains a class x.y.z.

Jar file B contains a class x.y.z.
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The ordering of the JAR files A and B dictates which class of which JAR file 
is loaded.

 8 Specify a timeout value for the script. If the script execution has not 
completed within the specified time, the result of the script is ignored.

 9 Select Read-Only for scripts that must not alter the event. 

Note: If a script that is labelled as read-only attempts to alter the event, 
the script is not executed and an error message is written to the ctxm 
logfile.

 10 Select OK.



Chapter 22 • Custom Actions

569

How to Edit a Custom Action Script

This task shows you how to edit an existing custom action.

To edit an existing custom action:

 1 Open the Custom Actions manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Custom Actions

 2 In the Scripts pane, select the custom action that you want to edit and 
click the  button.

The Edit Script dialog box opens.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Script dialog box.

 3 Make the required changes to the selected custom action.

 4 Select OK.
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How to Duplicate a Custom Action Script

This task shows you how to duplicate an existing custom action to use as the 
basis for a new custom action.

To duplicate an existing custom action:

 1 Open the Custom Action manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Custom Actions

 2 Select the custom action that you want to duplicate.

 3 In the Scripts pane, click the  button.

The selected custom action is duplicated and added to the list of custom 
action.

 4 Edit the duplicate custom action to suit the new custom action.

For details about editing, see "How to Edit a Custom Action Script" on 
page 569.
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How to Delete a Custom Action Script

This task shows you how to delete an existing custom action rule.

To delete an existing custom action:

 1 Open the Custom Action manager from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Custom Actions

 2 Select the custom action that you want to delete.

 3 In the Scripts pane, click the  button. 

The selected custom action is deleted from the list of custom actions.
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Reference

Custom Actions User Interface

The Custom Action manager enables you to create and manage custom 
actions to modify events.

This section includes:

➤ Custom Actions Scripts User Interface on page 572

➤ Custom Actions Details User Interface on page 574

➤ General Tab — Add New and Edit Script Dialog Boxes on page 575

➤ Advanced Tab — Add New and Edit Script Dialog Boxes on page 575

Custom Actions Scripts User Interface

The custom action scripts can be accessed and managed from the Scripts 
pane.

To access Select Admin > Operations Management > Tune 
Operations Management > Custom Actions

Relevant tasks For more information about configuring the custom 
actions, see "How to Create a Custom Action Script" on 
page 567.

See also For more information about the custom actions, see 
"Introduction to Custom Actions" on page 566.
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The Scripts pane displays the UI elements listed in the following table.

UI Element (A-Z) Description

Refresh: Reloads the scripts list.

New Item: Opens the Add New Script dialog box to create 
a custom action. For more information about creating 
custom actions, see "How to Create a Custom Action 
Script" on page 567.

Duplicate Item: Creates a copy of the selected custom 
action. For more information about duplicating custom 
action, see "How to Duplicate a Custom Action Script" on 
page 570.

Edit Item: Opens the Edit Script dialog box to edit an 
existing custom action. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Script dialog box.

For more information about editing custom action, see 
"How to Edit a Custom Action Script" on page 569.

Delete Item: Deletes the selected custom action. For more 
information about deleting custom action, see "How to 
Delete a Custom Action Script" on page 571.

Activate/Deactivate Item: Toggles between enabling and 
disabling the selected custom actions.

Disabled rules appear dimmed in the list of rules.
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Custom Actions Details User Interface

The Custom Action manager enables you to create and manage custom 
actions to modify events and take actions as a result of receiving particular 
events.

The Details pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Custom Actions

Relevant tasks For more information about configuring the custom 
actions, see "How to Create a Custom Action Script" on 
page 567.

See also For more information about the custom actions, see 
"Introduction to Custom Actions" on page 566.

UI Element (A-Z) Description

Active Indicates whether the associated custom action is active.

Classpath List of JAR files required by the script.

Description Brief description of the custom action.

Name Display name of the selected custom action.

Read-Only Select Read-Only for a script that must not alter the 
event. 

If a script that is labelled as read-only attempts to alter 
the eventuate script is not executed and an error message 
is written to the ctxm logfile.

Script Groovy script used to specify the custom action.

Timeout Timeout value for the script. If the script execution has 
not completed within the specified time, the result of the 
script is ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.
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General Tab — Add New and Edit Script Dialog Boxes

The General Tab displays the UI elements listed in the following table.

Advanced Tab — Add New and Edit Script Dialog Boxes

To access Select Admin > Operations Management > Tune 
Operations Management > Custom Actions

Relevant tasks For more information about configuring the custom 
actions, see "How to Create a Custom Action Script" on 
page 567.

See also For more information about the custom actions, see 
"Introduction to Custom Actions" on page 566.

UI Element (A-Z) Description

Active Specifies whether the associated custom action script is 
active.

Description Brief description of the custom action script.

Name Name of the custom action script.

Script Text of the custom action script.

To access Select Admin > Operations Management > Tune 
Operations Management > Custom Actions

Relevant tasks For more information about configuring the custom 
actions, see "How to Create a Custom Action Script" on 
page 567.

See also For more information about the custom actions, see 
"Introduction to Custom Actions" on page 566.
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The Advanced Tab displays the UI elements listed in the following table.

UI Element (A-Z) Description

Opens the Select Files browser dialog box to locate and 
add JAR files to the script configuration.

Deletes the selected JAR file from the classpath.

Moves the selected JAR file later in the order of 
execution.

Moves the selected JAR file early in the order of 
execution.

Class Path Specifies the names and locations of user-defined 
supporting libraries (JAR files).

Event Filter Specifies the filter to select events to be processed by this 
custom action script.

Read-Only Select Read-Only for a script that must not alter the 
event. 

If a script that is labelled as read-only attempts to alter 
the eventuate script is not executed and an error message 
is written to the ctxm logfile.

Timeout Specifies the timeout value for the custom action script. 
If the script execution has not completed within the 
specified time, the script is ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.
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➤ Close Related Events Automatically on page 594

➤ Duplicate Event Suppression on page 596

➤ Event Processing Interface on page 597

Tasks

➤ How to Configure CI Resolution Cache Usage on page 599

➤ How to Limit the Number of CIs Used by CI Resolution on page 602

➤ How to Modify TQLs Used by CI Resolution on page 603

➤ How to Create an Event Processing Script on page 606

➤ How to Edit an Event Processing Script on page 608

➤ How to Duplicate an Event Processing Script on page 609

➤ How to Delete an Event Processing Script on page 610

Reference

➤ EPI User Interface on page 611

Troubleshooting and Limitations on page 619
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Concepts

Introduction to Advanced Event Automation

Events are processed using event processing rules before being stored in the 
database, enabling you to change or enrich an incoming event or remove a 
new event if it is a duplicate of an existing event.

There are dedicated pipeline steps for specific tasks, for example:

➤ CI, ETI, and user and group resolution

➤ Update of event using new state information and closing of related events

➤ Removal of duplicate events

➤ Event correlation

➤ EPI Script Execution

 

CI/ETI Resolution Further Processing 
(duplicate suppression, 
close related events)

Event Store

Pipeline Entry

Resolution Completed
Pipeline Exit

Post-store
(Events are read-only, 
asynchronous)

EPI Connector

Post-store Operations 
(HI updater, TBEC)

Event Pipeline Steps
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CI Resolution

It is necessary to identify the CI in the RTSM to which an event is associated. 
Many data sources do not use RTSM IDs but provide other data that can be 
used by the CI Resolver to identify the associated CI.

An event may include the following information:

disk:C:databasesystem.example.com

This uniquely identifies the CI as the disc C on the system 
databassystem.example.com.

CI resolution is used to resolve CI-related information or CI hints to CIs for 
the following purposes:

➤ Node Resolution 

The CI Resolver is used to identify the host system in the RTSM associated 
with the selected event. If a Node Hint is included in the event, it is used 
to identify the node.

If the Node Hint is not available, the hints HostInfo, CiInfo, and Service ID 
are examined in this order to identify a related Node CI.

➤ Source CI Resolution 

Source CI resolution is used to identify the event source CI and uses the 
SourceHint attribute of an event. If the SourceHint attribute of an event is 
also not available, the CI Resolver separates the natural keys contained 
within the event and attempts to identify the related CI.
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➤ Related CI Resolution 

Related CI resolution first looks for a value for CiHint information. If this 
is not available, the Service ID from HPOM topology synchronization is 
used. If information from topology synchronization is also not available, 
the CI Resolver separates the natural keys contained within the event and 
attempts to identify the related CI.

ETI Hint Resolution: The ETI hint field is also used by Related CI 
resolution for matching of a CI. For example, if an event matches several 
CIs when considering the CiHint, the ETI resolution attempts to identify 
the ETI for each CI. If ETI Resolution is successful, the ETI is assumed to 
be assigned to the CI, and this CI is given a higher match rating.

The hints used to identify the related CI, node, source CI and ETI of an 
event are displayed in the Resolver Hints tab of the Event browser. For 
details, see "Resolver Hints Tab" on page 99.

CI resolution details is divided into the following areas:

➤ "CI Resolution Strategy" on page 580

➤ "CI Resolution Hint Types and Prefixes" on page 582

➤ "Advanced CI Resolution Hint Types and Prefixes" on page 584

➤ "Strict CI Resolution" on page 585

➤ "Information Used to Identify CIs" on page 586

➤ "Node Resolution" on page 587

➤ "Source CI Resolution" on page 587

➤ "ETI Hint Resolution" on page 585

➤ "CI Resolution Cache and its TQL" on page 588

➤ "Limiting Types of CIs" on page 589

➤ "CI Enrichment" on page 591

CI Resolution Strategy
The CI Resolver uses the following strategy to identify the CI that matches 
an event. The first match from this list of possible matches is used by the CI 
Resolver to identify the CI to which the event should be paired.



Chapter 23 • Advanced Event Automation

581

 1 Event contains a CI reference. The CI is identified directly from this 
information and no resolution is necessary. Few events, except for some 
internal Operations Management events, include a direct reference to the 
matching CI.

 2 CiInfo custom attribute of the event contains a valid RTSM ID, RTSM 
Global ID, SiteScope monitor ID, or an HPOM Agent ID which identifies 
the related CI.

 3 Event Service ID matches a service name that can be mapped by Topology 
Synchronization into a valid RTSM ID or RTSM Global ID. This match is 
common for events from HPOM SPIs.

Topology Synchronization provides a mapping table that enables the CI 
Resolver to map Service IDs directly to RTSM IDs if the service was 
synchronized by Topology Synchronization.

 4 Split CiInfo custom attribute into keywords and hostedOn information, 
and identify the best-fit CI. This match is common for events from HPOM 
SPIs

 5 Split Service ID into keywords and hostedOn information, and identify 
the best-fit CI.

 6 Use application and object fields and host info and identify best-fit CI

In this context, Service ID is the HPOM message Service ID.
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CI Resolution Hint Types and Prefixes
CI hints can be provided in a number of forms. The CiHint custom attribute 
and Service IDs are used to identify the CI related to an incoming event. The 
custom attribute is evaluated before the Service ID, ensuring that the Service 
IDs is overridden by the custom attribute values when available.

RTSM IDs

Format: UCMDB:<id>

Example: UCMDB:3bcbb67a6233cfdd0e400e7c1e637db5

RTSM Global IDs

Format: GUCMDB:<id>

Example: GUCMDB:4acdd67a5433cfaa0b600e7c1e667db9

If a UUID prefixed by the string UCMDB: or GUCMDB: is found, it is 
assumed to be a native RTSM ID or RTSM Global ID. If the CI Resolver can 
match the ID to a CI in the RTSM, the CI reference is set to this ID. This is 
the fastest and most accurate method.

SiteScope Monitor IDs

Format: SiteScope:<session_id>:<monitor_id>

SiteScope:12:2

If a SiteScope ID (SiteScope:<session_id>:<monitor_id>) is found, and if the 
CI Resolver can match the ID to a CI in the RTSM, the CI reference is set to 
the CI that is monitored by the SiteScope monitor.

Note: The following IDs are also resolved in the same way as for SiteScope

SiSMeasurement:<session_id>:<measurement_id> 

For SiteScope and SiS Measurements, the monitored object is resolved (not 
the monitor or the measurement).
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HPOM Agent IDs

OmCoreId:<omagentid> 

If an HPOM Agent Core ID is found, and if the CI Resolver can match the ID 
to a CI in the RTSM, the CI reference is set to the agent CI.

Service IDs 

OSSPI:svc:fs:/dev/hda@@dbsystem.example.com 

A traditional service name as used by HPOM Smart Plug-ins. If this service 
was synchronized by Topology Synchronization and a corresponding CI was 
created in the RTSM, the CI Resolver can use this information to directly 
map the event to the CI. If not, then the service ID is split into keywords.

Natural keys:

CiHint:oracle:database:CMDBDB@@dbsystem.example.com 

or

oracle:database:CMDBDB@@dbsystem.example.com

If there is no exact knowledge about the target CI, a list of keywords (usually 
separated by colons in the message) is extracted from the message. The node 
name that contains the expected CI is specified after the @@ separator.

In our example, we are trying to find an Oracle Database instance called 
CMDBDB that is running on the node called dbsystem. The node 
information is important since there may be many occurrences of the Oracle 
Database instance called CMDBDB installed on different nodes. This 
information is used by the CI Resolver to find the best match by comparing 
these keys with the attribute information of the CIs in the RTSM.

Note: This format is very similar to the HPOM Service ID format. This 
enables the CI Resolver to use the Service ID for resolving a CI when there is 
no direct resolution.
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As for a set of natural keys but for an unhosted CI:

mailservice:northamerica

For CIs that are not related to a node, like the email service provided for the 
northamerica region. To indicate that there is no hosted on information, the 
@@ separator must be omitted. 

Note: @@ separator without a node is not permitted (HPOM compatibility).

If the CI Resolver receives a hint with one or more keywords containing the 
separation character (default :), the keyword is not assessed as desired 
because it is divided into two or more incomplete keywords. The separation 
character is not considered part of the keyword.

Important: If you need to provide keywords containing the separator 
character, enclose the keyword within quotation marks ("keyword part 
1:keyword part 2").

Advanced CI Resolution Hint Types and Prefixes
Some data sources can provide the RTSM ID as a CI hint. However, when 
forwarding events to another BSM system, this ID might not be known to 
the second RTSM instance. For such cases, multiple CI hints, including the 
RTSM Global ID can be sent. If the first hint does not provide a match, the 
next hint is examined.

When an event is forwarded by Operations Management, the RTSM Global 
ID is added automatically as an additional hint.

Multiple CI hints are specified using the following format:

<CiHint1>|<CiHint2>|...

where <CiHintX> can be one of the following:
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➤ UCMDB:<RTSM_ID> 

➤ GUCMDB:<RTSM_Global_ID>

➤ SiteScope:<session_id>:<monitor_id> 

➤ OmCoreId:<omagentid>

➤ CiHint:<hint1>:<hint2>:...@@<node> 

Example:

GUCMDB:4acdd67a5433cfaa0b600e7c1e667db9|c@@dbsystem.example.com

The CI Resolver first checks whether there is a CI with the given RTSM 
Global ID. This ID usually provides a match as the Global ID should be 
synchronized across all RTSM instances. If the Global ID cannot be used, 
and a natural hint is also included (c@@dbsystem.example.com in the 
example above), it is used.

ETI Hint Resolution

The ETI hint field is also used for the matching of a CI by CI Resolution. For 
example, if an event matches several CIs when considering the CiHint, the 
ETI resolution attempts to identify the ETI for each CI. If ETI Resolution is 
successful, the ETI is assumed to be assigned to the CI, and this CI is given a 
higher match rating.

For example, if the CI hints of an event containing the ETI Memory 
Load:Critical, matches some CPU CIs and some node CIs, the node CI 
which has the Memory Load ETI defined is selected. Without the ETI, it 
would not be possible to resolve a match to this node.

Strict CI Resolution
The host CI can usually be identified as long as the host information is 
available as a normal hint. Ideally, the @@node notation (an @@ separator 
with a specified node) is used to identify the node on which the CI is 
hosted. However, it can be difficult to uniquely match a dedicated CI if a 
hosted and a non-hosted CI have very similar attributes. If the @@node 
notation is not used, the first match found is accepted and this may not be 
the correct CI.
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For example, only the hint CiHint:sendmail is received. If a sendmail service 
and a sendmail process exist, the CI Resolver is not able to differentiate 
between them because it does not differentiate between the hosted-on and 
not hosted CIs.

To differentiate between them, use:

CiHint:sendmail@@mailserver.example.com — to identify the sendmail 
process running on the mailserver.example.com node.

StrictCiHint:sendmail — to identify the sendmail service. To match, the 
sendmail CI must not have a hosted-on CI.

Information Used to Identify CIs
The hostedOn information is very important for correctly identifying a CI, 
and an attempt is made to resolve the node for each CI from the RTSM. The 
hostedOn information is derived by traversing all parent compositions of a 
CI until a node CI is found. The hostname of this node is used as the 
hostedOn information. When an event is received by Operations 
Management, the node info value of the CI is compared to the hostedOn 
information of a CI. If they match, the CI is used as a matching candidate.

Note: The combination of the node name and CI name is usually sufficient 
information to differentiate between CIs on computers. If this information 
is still not sufficient, check the information that you have for these CIs in 
the RTSM and select a further attribute that can be used to differentiate the 
CIs. If identifying CIs is proving difficult because CI names are not unique, 
the CI type can be used as an identifier. The combination of node name and 
CI type is very often enough information to identify the CI associated with 
an event.
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Node Resolution
The CI Resolver is used to update the node reference of an event. 

The hints used to identify the related CI, node, source CI and ETI of an 
event are displayed in the Resolver Hints tab of the Event browser. For 
details, see "Resolver Hints Tab" on page 99.

The following hints are examined in this order to identify a related Node CI:

➤ HostInfo event attribute

HostInfo is an attribute from the HPOM agent to identify a target host. It 
usually contains the fully qualified domain name or the IP address of a 
host.

➤ CiInfo custom attribute

CiInfo contains node information after the @@ separator in the event 
text.

➤ Service ID event attribute

Service ID contains node information after the @@ separator in the event 
text.

The node reference is retrieved from the RTSM as follows:

 1 Fully qualified domain name (primary_dnsname) 

 2 IP address taken from the related ip_address in the RTSM 

 a ip_address.authoritative_dns_name attribute

 b ip_address.ip_address attribute

 3 HPOM core ID. A name attribute taken from the related 
hp_operationsagent CI in the RTSM.

Source CI Resolution
Source CI resolution is used to identify the event source CI and uses the 
SourceHint attribute of an event. The format of the SourceHint must be the 
same as that of the normal CI resolution.
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CI Resolution Cache and its TQL
The CI Resolver extracts information about potential candidate CIs from the 
RTSM using a TQL query and maintains this information in a cache. You can 
either provide a custom TQL query or use the OMiAutoView feature to 
automatically generate a suitable TQL.

The OMiAutoView feature selects all CIs and all Service Level Agreements, 
and queries almost all attributes that are potentially useful for resolving 
CIs.The attributes that are not queried are excluded using the Cache 
Modification Configuration. 

If you are using the TQL query generated by OMiAutoView, to maximize 
performance, it is also possible to restrict the total number of CIs held in the 
cache, and restrict the CI types to those most helpful for CI resolution. 
Configuring the restriction of CIs and CI types is achieved using the 
following CI Resolver Settings:

➤ CI Limit — used to limit the number of CIs loaded into the cache.

➤ Cache Modification Configuration — used to specify which CI types and 
attribute types to exclude from the cache, and, if there are too many CIs 
being loaded into the cache, which CI types to use for CI resolution.

For detailed information, see "CI Resolver Settings" on page 689. 

There are two cache types, enabling you to decide whether the cache is kept 
on disk or in main memory:

➤ Database — It is recommended to select the Database cache type when 
your monitored environment is very large (when the number of CIs being 
monitored is larger than in the CI Limit setting. CI resolution maintains 
only the most often-used CIs in RAM. All other required CIs are 
maintained in a cache file. This option results in a lower memory 
footprint but may have an impact on CI resolution performance.

➤ In Memory — It is recommended to select the In Memory cache type 
when the total number of CIs in the monitored environment is smaller 
than the default value in the CI Limit setting. CI resolution maintains all 
CIs in RAM. Use this setting for larger environment only when there is 
sufficient RAM available.
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For information about all the CI Resolver Settings, see "CI Resolver Settings" 
on page 689.

Limiting Types of CIs
Maintaining very large numbers of CIs in cache requires large amounts of 
RAM and also has an affect on performance. Controlling the maximum 
number of CIs held in cache reduces this load and is achieved by ignoring 
less relevant attributes and CI types normally selected using the 
OMiAutoView-generated TQL query. The CI types to be ignored are set in 
the Cache Modification Configuration setting. You can also specify which 
CI type should be permitted to be used for CI resolution and in which order 
they are to be evaluated.

The CI Resolver Cache Modification Configuration settings specify three 
types of information:

➤ <IgnoreCiType> — Contains a list of CI types to always be ignored. 

If a CI type is specified to be ignored, it is always ignored by the CI 
Resolver. For example, if you know that you don’t receive SAP events, but 
you have SAP CIs in your RTSM, then you can ignore the SAP CI types, 
reducing the size of the CI Resolver cache.

➤ <WhiteListCiType> — Contains a list of CI types that are always required. 

If there are too many CI Types to be included in the available cache 
capacity, the CI types specified in the whitelist are included in the order 
that they are listed. As soon as it is no longer possible to include the CIs of 
the next CI type in the list, that CI type and all subsequent CI types in the 
whitelist are also ignored.

➤ <IgnoreAttribute> — Contains a list of attributes that are always ignored. 

If an attribute is specified to be ignored, it is always ignored by the CI 
Resolver. You should ignore attributes that not suitable for identifying 
CIs.
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The following is an example of the structure of the CI Resolver Cache 
Modification Configuration settings 

<?xml version="1.0" encoding="UTF-8" ?> 
<CiResolver>

<IgnoreCiTypes>
<IgnoreCiType>service_address</IgnoreCiType>
<IgnoreCiType>installedsoftware</IgnoreCiType>
...

</IgnoreCiTypes>

WhiteListTypes>
<WhiteListCiType>node</WhiteListCiType>
<WhiteListCiType>ip_address</WhiteListCiType>
<WhiteListCiType>business_element</WhiteListCiType>
...

  </WhiteListTypes>

<IgnoreAttributes>
<IgnoreAttribute>ip_probename</IgnoreAttribute>
<IgnoreAttribute>ip_isbroadcast</IgnoreAttribute>
...

</IgnoreAttributes>

</CiResolver>

To configure CI resolution to minimize the type and number of CI and 
attributes held in the cache, see "How to Configure CI Resolution Cache 
Usage" on page 599.
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Custom TQLs
If the OMiAutoView TQL does not meet your requirements, you can 
implement a custom TQL query, ensuring that it meets the following 
requirements:

➤ CIs that are contained within a node must have a direct or transitive 
Composition relationship to the node. For the IpAddress CI type, the 
relationship type must be Composition. 

➤ In the TQL, the node must have one of the following attributes:

➤ Primary Node DNS name

➤ Association with one or more IP addresses (IpAddress with a 
Containment relationship)

➤ At least CI type and data name of the CI must be visible. 

➤ HPOM Agents must have Core ID value.

➤ Site Scope Monitors or performance measures must have a monitored_by 
relationship to the monitored CI. The monitor_id and session_id must be 
visible.

CI Enrichment
You can configure CI resolution enrichment rules to enrich the CI 
resolution cache with additional keywords for a specific CI. These keywords 
are provided by another CI in their neighborhood. To enrich a CI, you can 
use the tuneCache setting in the Settings Manager by adding an XML item 
<Enrichment> for an enrichment rule.

Rule Syntax

Enrichment is used to mark a CI with keywords that differentiates the CI 
from other CIs. This enables the use of the enriched keyword as a hint in an 
event.

An enrichment rule follows the syntax:

[<source ci type>].(from|to:<relationship type>.[<intermediate ci 
type>].)+[<target ci>].<attribute name> 
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the direction identifier before each reference indicates the direction of that 
reference (from = incoming or to = outgoing).

Supported Types & Operators

[Operators] and [Types] are combined to form a valid CI resolution 
enrichment rule.

Examples of supported operators: 

➤ containment 

➤ composition 

➤ monitored_by 

➤ dependency 

Supported relation directions:

➤ to 

➤ from 

Supported types:

➤ [<CITypeName>] 

Supported types are any CI types contained in the RTSM, specified within 
squared brackets. The CI Type’s name attribute is the value to put into the 
squared brackets, for example, [host] or [sitescope_monitor]. 

Keyword Description Example

from|to:<reference> Follow the relationship of a CI 
to its neighbor CI by a given 
direction. 

from = incoming

to = outgoing

from:monitored_by

[<Ci type name>] Set the CI type. [dbtable]

<CI type property name> Property of the CI type. [dbtable].name
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Example Rule:

Assume that you have two Oracle databases, DB1 and DB2, on one system. 
Both databases have a dbtable CI with the name USER. CI resolution cannot 
identify from which CI the event originated using the information available 
within the hint because the two dbtable CIs can only be differentiated by 
their parent CI relationship (DB1 and DB2). This information must be added 
by enrichment. Typically, a related CI hint would look like the following:

USER@@dbsystem.example.com

However, this does not work because the database name is not known.

However, if CI resolution is enriched with the database instance name using 
a CI resolution enrichment rule, it is possible to run a CI resolution 
successfully when the event also provides the DB instance name.

Enrichment rule:

To enrich a dbtable CI type with additional information about the CI type 
host name attribute, you can use the following rule.

[dbtable].from:composition.[oracle].name

A CI resolution enrichment rule can be specified to enrich the keywords 
cache to also include keywords from the parent CI. In this way, it is possible 
to resolve the correct dbtable CI if the event also provides the database 
instance name.

USER:DB1@@dbsystem.example.com

For information about CI resolution configurations, see "CI Resolver 
Settings" on page 689.
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 Close Related Events Automatically

Basic event correlation can close existing events. A new event is considered 
as being related to an existing event, when it provides specific information 
like a close key pattern that matches the key of the existing event, or when 
it contains an updated value of a health-contributing ETI for a specific CI, 
which out-dates a value of that specific ETI that is contained in an existing 
event. Both conditions result in closing the existing event. In HPOM, this 
form of correlation is also known as good/bad message correlation.

Note: Existing events must have same CI and ETI as the new event, but a 
different ETI value. The ETI must contributes to health. Default value of the 
Operations Management Infrastructure Setting Detected Related Events by 
ETI is set to true. 

Closing related events can be controlled using the settings available under 
Closed Related Events Settings in the Operations Management 
Infrastructure Settings. There are two ways of detecting related events:

➤ Existing events must have the same CI and the same ETI contributing 
to health as the new event, but a different ETI value.

Example:

➤ Event A for a certain CI has ETI SQL Query Performance: Low

➤ Event B for same CI has ETI SQL Query Performance: High

➤ ETI SQL Query Performance is an HI

Event B closes event A. Automatic close is tracked in the event history.

➤ Key of existing events must match the closeKeyPattern value of the 
new event.

Example:

➤ Event A has key value om-db.server.net_VP_SM_DB_Backup:start

➤ Event B has key value om-db.server.net_VP_SM_DB_Backup:pending
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➤ Event C contains the closeKeyPattern value 
om-db.server.net_VP_SM_DB_Backup<*>

Events A and B are closed. Automatic close is tracked in the event history.

For detailed information on the available setting, see "Close Related Event 
Settings" on page 692.

Close Key Pattern Syntax
Dynamic parts of event text can be extracted and used as parameters to 
identify and close related events already received. The pattern-matching 
language enables you to very accurately specify the character string that you 
want to identify.

Note: Operations Management uses a subset of the pattern matching 
functionality supported by HPOM.

The following characters are supported:

➤ ^ — identifies the beginning of the pattern.

➤ $ — identifies the end of the pattern.

➤ <*> — represents any string of zero or more characters (including 
separators). <*> can be used in a close-key pattern as many times as 
required.

The following table illustrates how the event keys are identified:

closeKeyPattern Syntax Usage

abc Any occurrence of the text abc in the event key.

a<*>b<*>c Any occurrence of the pattern a*b*c in the event key 
where a can be separated from the b by any number of 
characters and the b can be separated from the c by 
any number of characters.

^abc$ Pattern abc is the complete event key.
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Duplicate Event Suppression

A new event may be a duplicate of an existing event. As new events are 
received, they are checked against existing events. If duplicates are found, 
new information is used to update the existing event and the new event is 
ignored.

Suppressing duplicate events is controlled using the Duplicate Events 
Suppression Settings in the Operations Management Infrastructure Settings 
and must be enabled before any settings become active. For detailed 
information, see "Duplicate Events Suppression Settings" on page 695.

If duplicate event suppression is enabled, new events that are duplicates of 
an existing event are not retained and the original event is updated. If the 
new event includes a key, such as Select CI, a search is made for an existing, 
active event that has the same key value, in this case the same CI, as the new 
event. Events must usually be received relatively soon after the original 
event to be regarded as a possible duplicate. This time period is also a 
configurable setting.

If the new event does not include a key, a search is made for an existing, 
active event where a set of configurable attributes have the same values as 
the new event.

If no original event is found yet, and the new event has a value for an HI, a 
search is made for an existing, active event that has the same ETI value and 
the same CI.

Suppressing duplicate events can result in additional correlations of the 
original event (both as cause or as symptom). When a duplicate is identified, 
the timestamp for the original event is updated to the time when the 
duplicate was received. The event is then correlated again and may now be 
related to other events which were not available for correlation when the 
original event was received.

^abc Pattern abc is found at the beginning of the event key.

abc$ Pattern abc is found at the end of the event key.

closeKeyPattern Syntax Usage
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Event Processing Interface

You can specify any number of user defined scripts to be executed during 
event processing. The Event Processing Interface (EPI) is used to enrich 
events with additional information from external data sources using Groovy 
scripts. For example, it is possible to add data to an event from a Microsoft 
Excel file or an SQL database. If Groovy scripts are specified in the Event 
Pipeline Script and Step Settings, the event undergoes the associated further 
processing.

➤ EPI scripts must be implemented using the Groovy script language.

➤ Scripts are stored directly in the database with JAR files.

➤ For each pipeline step, you can set up one or more scripts. There is no 
limit on the number of scripts that can be executed.

➤ EPI scripts can be defined in content packs and can be imported/exported 
using the Content Manager.

➤ Maximum supported script length is 250,000 characters.

Note: You should design and execute scripts in the context of overall event 
processing. In other words, be aware of the interaction of the scripts with 
other event processing settings in the Settings Manager, for example for 
duplicate events suppression and closing related events.

The event pipeline represents the different steps within event processing. 
There are four points within the event pipeline at which EPI scripts can be 
executed:

Before CI/ETI Resolution

Scripts can be executed directly before the event enters the event pipeline, 
so before the resolution of CIs and ETIs takes place.

For example, you may want to execute a script at this point that sets further 
hints that affect the resolution of CIs and ETIs. An entry point further along 
the event pipeline would be too late to influence the resolution of CIs and 
ETIs.
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After CI/ETI Resolution

Scripts can be executed directly after CI/ETI resolution, but before further 
processing, such as duplicate events suppression and closing related events 
automatically.

For example, you may want to execute a script at this entry point in the 
event pipeline if you want to influence how duplicate events are handled. It 
could be that you have duplicate events suppression enabled in general, but 
you are interested in changing the duplicate events suppression setting for a 
particular type of event, while leaving it unchanged for all other event 
types. So you could execute a script at this entry point that disables 
duplicate events suppression for the specified event type. Any entry point 
further along the event pipeline would be too late to influence duplicate 
events suppression behavior.

Before Storing Events in the Database

Scripts can be executed after all event processing has taken place, but before 
the event is stored in the database.

For example, at this entry point to the event pipeline, you could execute a 
script that makes changes to some text, or inserts a link to a knowledge base, 
and so on, before the event gets stored in the database.

After Storing Events in the Database

Scripts can be executed after the event is stored in the database. In this case, 
the scripts are all read-only scripts, since as soon as an event is stored in the 
database, it can no longer be modified.

For example, you may want to execute a script at this entry point in the 
event pipeline to forward events of a particular type, that are already stored 
in the database, to another application. Or you could execute a script that 
writes specified events stored in the database to an audit log.
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Tasks

How to Configure CI Resolution Cache Usage

This task shows you how to configure CI resolution to minimize the type 
and number of CI and attributes held in the cache.

Maintaining very large numbers of CIs in cache requires large amounts of 
RAM and also has an affect on performance. Therefore, controlling the 
maximum number of CIs held in cache is recommended and this is 
achieved by ignoring less relevant attributes and CI types. The CI types to be 
ignored are set in the Cache Modification Configuration. You can also 
specify which CI type should be permitted to be used for CI resolution and 
in which order they are to be evaluated.

To optimize the CI resolution cache usage, configure the CI Resolution 
Cache Modification Configuration settings as follows:

 1 Open Infrastructure Settings from the Platform Administration:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

 2 Select Applications and use the list to set the administration context to 
Operations Management.

 3 Go to the CI Resolver Settings section.

 4 Open the Cache Modification Configuration (click the associated  
button to open the Edit Settings dialog box).

The Edit Setting dialog box displays the CI Resolver Cache Modification 
Configuration settings. This information uses XML syntax to specify three 
types of information:

➤ <IgnoreCiType> — CI Types to always be ignored. If a CI type is 
specified to be ignored, it is always ignored by the CI Resolver.
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➤ <WhiteListCiType> — If there are too many CI Types to be included in 
the available cache capacity, the CI types specified in the whitelist are 
included in the order that they are listed. As soon as it is no longer 
possible to include the CIs of the next CI type in the list, that CI type 
and all subsequent CI types in the whitelist are also ignored.

➤ <IgnoreAttribute> — Attributes to always be ignored. If an attribute is 
specified to be ignored, it is always ignored by the CI Resolver:

The following is an example of the structure of the CI Resolver Cache 
Modification Configuration settings:

<?xml version="1.0" encoding="UTF-8" ?> 
<CiResolver>

<IgnoreCiTypes>
<IgnoreCiType>service_address</IgnoreCiType>
<IgnoreCiType>installedsoftware</IgnoreCiType>
...

</IgnoreCiTypes>

WhiteListTypes>
<WhiteListCiType>node</WhiteListCiType>
<WhiteListCiType>ip_address</WhiteListCiType>
<WhiteListCiType>business_element</WhiteListCiType>
...

  </WhiteListTypes>

<IgnoreAttributes>
<IgnoreAttribute>ip_probename</IgnoreAttribute>
<IgnoreAttribute>ip_isbroadcast</IgnoreAttribute>
...

</IgnoreAttributes>

</CiResolver>

 5 Specify the CI types and the attributes to always be excluded from CI 
resolution using the <IgnoreCiTypes> and the <IgnoreAttributes> sections.
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 6 Specify the CI types to be included if the available cache is not sufficient 
to load all available CIs. The order of the CI types in the list represent the 
order in which these CIs are included. As soon as the CIs belonging to a 
CI type cannot be accommodated in the cache, these CIs are excluded 
and no further CI Types are assessed.

 7 Select Save.

Note: Alternatively, you can replace the automatically generated TQL query 
with a TQL query customized for your environment.
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How to Limit the Number of CIs Used by CI Resolution

This task shows you how to configure CI resolution to limit the number of 
CI and attributes held in the cache.

Note: If you have more CIs than is recommended to use for CI resolution, 
limit the CI types and attributes, and optimize the order in which the 
preferred CI types are assessed. For details, see "How to Configure CI 
Resolution Cache Usage" on page 599.

To limit the maximum possible number of CIs used for CI resolution, 
configure the CI Limit setting as follows:

 1 Open Infrastructure Settings from the Platform Administration:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

 2 Select Applications and use the list to set the administration context to 
Operations Management.

 3 Go to the CI Resolver Settings section.

 4 Open the CI Limit (click the associated  button to open the Edit Settings 
dialog box).

The Edit Setting dialog box displays the CI Limit value. 

 5 Specify a new CI limit.

Note: Maintaining very large numbers of CIs in cache requires large 
amounts of RAM and also has an affect on performance. Increasing the 
total number of CI loaded into cache, increase memory usage, which can 
result in an unstable system. If you need to increase the number of CI 
permitted for CI resolution, make these increases using small increments 
and make sure that your installation remains stable.

 6 Select Save.
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How to Modify TQLs Used by CI Resolution

BSM uses TQL queries to select CIs from the RTSM and maintains them in 
the CI Resolver Cache. The CI Resolver compares attributes of discovered CIs 
held in the CI Resolver Cache with event attributes and event resolver hints 
to relate each event that BSM receives to a CI in the RTSM.

The out-of-the-box query that BSM uses to query the RTSM is probably 
broader than you require. You can improve performance by narrowing the 
scope of the out-of-the-box query so that it loads into your CI Resolver 
Cache only the CIs that are relevant to your managed environment and to 
which you expect to map events. If you do not expect to match certain CI 
types, there is no need to include these CI type in the CI Resolver TQL. For 
example, if you are only managing Oracle databases, you should exclude 
databases of other types.

You modify TQL queries using the RTSM Modeling Studio, which provides a 
graphical representation of the query. You can add or remove information 
from the query so that it selects only those CIs from the RTSM that you 
decide are important for your managed environment.

Generally, the procedure for modifying a query is as follows: 

To modify a TQL query:

 1 Start the Modeling Studio: Administration > RTSM Administration > 
Modeling > Modeling Studio.

Note: If necessary, see the RTSM online help to familiarize yourself with 
the features of the Modeling Studio.

 2 Select the resource type Queries from the drop-down list in the Resources 
pane.

 3 Click the Import from XML button in the left view browsing pane.

 4 Select the TQL query file:
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<HPBSM_Root_Directory>/opr/examples/ciresolver/
OprSample_CIResoluton_tql.xml

Click Import.

 5 Select the resource type Views from the drop-down list in the Resources 
pane.

 6 Click the Import from XML button in the left view browsing pane.

 7 Select the View file: 

<HPBSM_Root_Directory>/opr/examples/ciresolver/
OprSample_CIResoluton_view.xml

Click Import.

 8 Modify the query to select only the CIs that you need.

 9 Use the count button, which shows the CIs and CI types per node, to 
evaluate if your changes reduce the number of CIs.

Rules for Modification 
The modification process is not difficult, but it takes some time to 
understand what to modify to get the results that you expect. To get a 
general introduction to TQL concepts, see the Topology Query Language 
chapter of the HP RTSM Modeling Guide. Especially important are the 
concepts of cardinality, attributes, and relationships. In addition, read the 
rules below to help you get an understanding of the factors that may have 
an influence on how to modify queries.

➤ When selecting a DNS name, use the attribute Primary DNS Name in 
BSM.

➤ Every CI that is part of a host must have a composition to its host. In 
other words, the composition to a host is required to differentiate 
between multiple instances of a CI type that may be named identically, or 
have other identical attributes (for example, "disk drive C:"), but are 
associated with different parent CIs ("Computers": "C: drive on server1" as 
opposed to "C: drive on server2").
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➤ Every host in your TQL query must have the host Primary DNS Name 
attribute enabled. To ensure that the attribute is enabled:

 a Go to your TQL query and select Node Properties from the host 
context menu.

 b Click Advanced layout settings and enable the Primary DNS Name 
attribute again.

➤ Every host in your TQL query must have one or more IpAddress CIs that 
are related to the host by a composition. Here, enable IpAddress and 
authoritative_dns_name attributes in your TQL query as follows:

 a Select Node Properties from the context menu of IpAddress. 

 b Select Advanced layout settings and enable both attributes. 

➤ All the CI attributes in your TQL query that are needed for CI resolution 
must be visible (for example, the labels "C:", "Company Portal", and so 
on). Usually, the name attribute is enough, but sometimes another 
attribute (such as an ID) is required. Experiment until you get the results 
you want.

➤ Business Services usually are not hosted on a system, so there is no need 
for a composition. It is sufficient for the services to be a part of the TQL.

➤ The "hosted on" information is crucial for CI resolution. Make sure that 
Primary DNS Name and authoritative_dns_name are visible either for the 
host or for the IpAddress. Without these attributes, the CI Resolver 
cannot work reliably.
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How to Create an Event Processing Script

This task shows you how to create an event processing script.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To create an event processing script:

 1 Open the Event Processing Customizations manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Event Processing Customizations

 2 In the EPI Steps pane, select the entry point to the event processing 
pipeline for the script to be defined. The options are:

➤ Before CI/ETI Resolution

➤ After CI/ETI Resolution

➤ Before Storing Events

➤ After Storing Events

 3 In the Scripts pane, click the  button to open the Add New Script dialog 
box.

 4 Enter a script name and description for the script being specified.

 5 Enter the script text in the Script field.

For information about creating scripts, see the HP Operations Manager i 
Extensibility Guide PDF.

Note: Maximum supported script length is 250,000 characters.
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 6 Select Active, if you want to make the script active immediately.

 7 Click Next to open the Advanced page.

 8 Optional: Specify Groovy script classpaths.

 9 Select an event filter for the mapping rule from the Events Filter list. The 
filter determines which events to consider in the mapping operation.

If no appropriate filter is already configured, click the Browse (...) button, 
which opens the Select an Event Filter dialog box. Create a filter or edit an 
existing one. For information about filters, see "How to Define Simple 
Event Filters" on page 221.

 10 Specify a timeout value for the script. If the script execution has not 
completed within the specified time, the script is ignored.

Note: If the EPI Server Timeout setting is shorter than the timeout 
specified for a script, the execution of the script is stopped after the global 
timeout period is reached. The dedicated timeout cannot be reached. It is 
recommended to select a shorter dedicated timeout value for individual 
scripts and set a longer global timeout. For details, see "EPI (Event 
Processing Interface) Server Settings" on page 699.

 11 Select Read-Only for scripts that must not alter the event. An error 
message is displayed if a script that is labelled as read-only attempts to 
alter the event.

 12 Select Finish.
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How to Edit an Event Processing Script

This task shows you how to edit an event processing script.

To edit an event processing script:

 1 Open the Event Processing Customizations manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Event Processing Customizations

 2 Select the script that you want to edit.

 3 In the Scripts pane, click the  button to open the Edit Script dialog box.

Alternatively, double-click a section in the Details pane to open the 
appropriate tab in the Edit Script dialog box.

 4 Make the required changes to the selected script.

 5 Select OK.
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How to Duplicate an Event Processing Script

This task shows you how to duplicate an event processing script.

To duplicate an event processing script:

 1 Open the Event Processing Customizations manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Event Processing Customizations

 2 Select the script that you want to duplicate.

 3 In the Scripts pane, click the  button.

A copy of the selected script is created and is available for selection from 
the Scripts pane.

 4 Select the copy script and click the  button to open the Edit Script 
dialog box.

 5 Make the required changes to the selected script.

 6 Select OK.
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How to Delete an Event Processing Script

This task shows you how to delete an event processing script.

To delete an event processing script:

 1 Open the Event Processing Customizations manager from Operations 
Management Administration:

Admin > Operations Management > Tune Operations Management > 
Event Processing Customizations

 2 Select the script that you want to delete.

 3 In the Scripts pane, click the  button. 

 4 Confirm the deletion by clicking Yes.

The selected script is deleted from the list of scripts.
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Reference

EPI User Interface

The Event Processing Customizations manager enables you to create and 
manage Event Processing scripts. You can specify any number of user 
defined scripts to be executed during event processing. The Event Processing 
Interface (EPI) is used to enrich events with additional information from 
external sources data using Groovy scripts.

This section includes:

➤ Event Processing Scripts Steps Pane on page 612

➤ Event Processing Scripts User Interface on page 613

➤ Event Processing Scripts Details User Interface on page 614

➤ General Tab — Add New and Edit Script Dialog Box on page 616

➤ Advanced Tab — Add New and Edit Script Dialog Box on page 617
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Event Processing Scripts Steps Pane 

The EPI Steps pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Processing 
Customizations

Relevant tasks For more information about configuring event 
processing scripts, see "How to Create an Event 
Processing Script" on page 606.

See also For more information about event processing, see:

➤ "Close Related Events Automatically" on page 594.

➤ "Duplicate Event Suppression" on page 596.

➤ "Event Processing Interface" on page 597.

UI Element (A-Z) Description

Refresh: Reloads the EPI Steps list.

Shows the latest status of each step, including whether 
scripts exist for each step and if they are enabled.

After CI/ETI 
Resolution

Selects scripts that are executed directly after CI/ETI 
resolution, but before further processing, such as 
duplicate events suppression and closing related events 
automatically.

After Storing Events Selects scripts that are executed after the event is stored 
in the database. In this case, the scripts are all read-only 
scripts, since as soon as an event is stored on the 
database, it can no longer be modified by further EPI 
scripts.

Before CI/ETI 
Resolution

Selects scripts that are executed directly before the event 
enters the event pipeline (before the resolution of CIs 
and ETIs takes place).

Before Storing 
Events

Selects scripts that are executed after all event processing 
has taken place, but before the event is stored in the 
database.
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Event Processing Scripts User Interface

The Scripts pane lists the specified scripts for the selected EPI step. The 
Scripts pane enables you to create and manage EPI scripts.

The Scripts pane displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Processing 
Customizations

Relevant tasks For more information about configuring event 
processing scripts, see "How to Create an Event 
Processing Script" on page 606.

See also For more information about event processing, see:

➤ "Close Related Events Automatically" on page 594.

➤ "Duplicate Event Suppression" on page 596.

➤ "Event Processing Interface" on page 597.

UI Element (A-Z) Description

Refresh: Reloads the Scripts list.

New Item: Opens the Add New Script dialog box to create 
an EPI script. For more information about creating EPI 
scripts, see "How to Configure CI Resolution Cache 
Usage" on page 599.

Duplicate Item: Creates a duplicate of the selected EPI 
script.

Edit Item: Opens the Edit Script dialog box to edit an 
existing script. 

Alternatively, double-click a section in the Details pane 
to open the appropriate tab in the Edit Script dialog box.

For more information about editing EPI scripts, see "How 
to Edit an Event Processing Script" on page 608.
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Event Processing Scripts Details User Interface

The Event Processing Customizations Details pane displays a summary of 
the selected EPI script.

Delete Item: Deletes the selected EPI script. For more 
information about deleting EPI Steps, see "How to Delete 
an Event Processing Script" on page 610.

Move Down: Moves the selected EPI script down to a 
lower priority position.

Move Up: Moves the selected EPI script up to a higher 
priority position.

Activate/Deactivate Item: Toggles between enabling and 
disabling the selected pipeline scripts.

Disabled rules appear dimmed in the list of rules.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Processing 
Customizations

Relevant tasks For more information about configuring event 
processing scripts, see "How to Create an Event 
Processing Script" on page 606.

See also For more information about event processing, see:

➤ "Close Related Events Automatically" on page 594.

➤ "Duplicate Event Suppression" on page 596.

➤ "Event Processing Interface" on page 597.

UI Element (A-Z) Description
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The Details page displays the UI elements listed in the following table.

UI Element (A-Z) Description

Active Indicates whether the associated event pipeline step is 
active.

Class Path Specifies the names and locations of user-defined 
supporting libraries (Jar files).

Description Description of the EPI script.

Event Filter Filter specified to select events to be processed by this EPI 
script.

Name Name of the EPI script.

Read-Only Indicates whether the EPI script is read-only. 

These scripts must not alter the event. An error message 
is displayed if a script that is labelled as read-only 
attempts to alter the event

Script Text of the EPI script.

Timeout Timeout value for the EPI script. If the script execution 
has not completed within the specified time, the script is 
ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.

Note: If the EPI Server Timeout setting is shorter than the 
timeout specified for a script, the execution of the script 
is stopped after the global timeout period is reached. The 
dedicated timeout cannot be reached. It is recommended 
to select a shorter dedicated timeout value for individual 
scripts and set a longer global timeout. For details, see 
"EPI (Event Processing Interface) Server Settings" on 
page 699.
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General Tab — Add New and Edit Script Dialog Box

The General Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Processing 
Customizations

Relevant tasks For more information about configuring event 
processing scripts, see "How to Create an Event 
Processing Script" on page 606.

See also For more information about event processing, see:

➤ "Close Related Events Automatically" on page 594.

➤ "Duplicate Event Suppression" on page 596.

➤ "Event Processing Interface" on page 597.

UI Element (A-Z) Description

Active Specifies whether the associated event pipeline step is 
active.

Description Brief description of the EPI script.

Name Name of the EPI script.

Script Text of the EPI script.
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Advanced Tab — Add New and Edit Script Dialog Box

The Advanced Tab displays the UI elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Processing 
Customizations

Relevant tasks For more information about configuring event 
processing scripts, see "How to Create an Event 
Processing Script" on page 606.

See also For more information about event processing, see:

➤ "Close Related Events Automatically" on page 594.

➤ "Duplicate Event Suppression" on page 596.

➤ "Event Processing Interface" on page 597.

UI Element (A-Z) Description

Class Path Specifies the names and locations of user-defined 
supporting libraries (Jar files).

Event Filter Specifies the filter to select events to be processed by this 
EPI script.
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Read-Only Specifies whether the EPI script is read-only. 

These scripts must not alter the event. An error message 
is displayed if a script that is labelled as read-only 
attempts to alter the event

Timeout Specifies the timeout value for the EPI script. If the script 
execution has not completed within the specified time, 
the script is ignored.

The default timeout value is 0 and the maximum timeout 
value is 10000 ms.

Note: If the EPI Server Timeout setting is shorter than the 
timeout specified for a script, the execution of the script 
is stopped after the global timeout period is reached. The 
dedicated timeout cannot be reached. It is recommended 
to select a shorter dedicated timeout value for individual 
scripts and set a longer global timeout. For details, see 
"EPI (Event Processing Interface) Server Settings" on 
page 699.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides help in troubleshooting problems relating to event 
automation.

➤ CI Resolution Does not Resolve Expected CIs on page 619

CI Resolution Does not Resolve Expected CIs 

If expected CIs are not being resolved and you receive the following 
message:

OMi CI Resolver could not load all expected CIs.

The CI Resolver is unable to load the specified CI types and attributes into 
the cache.

More detailed information about the problem is available in the CI Resolver 
log file at the following location:

<HPBSM_Root_Directory>/log/opr-backend/opr-ciresolver.log

In debug mode, the handling of each CI type is documented in the log file. 
In normal mode, only the total number of CIs is reported.

The following steps should be taken to reduce the number of CIs being used 
for CI resolution:

➤ Restrict the types of CI used for CI resolution by using the Cache 
Modification Configuration. For details, see "How to Configure CI 
Resolution Cache Usage" on page 599.

➤ If it is not possible to load the required CIs into the cache, increase the CI 
limit in small increments, for example 10,000 CIs, until all essential CIs 
are available for CI resolution.
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Note: Maintaining very large numbers of CIs in cache requires large 
amounts of RAM and also has an affect on performance. Increasing the 
total number of CI loaded into cache, increase memory usage, which can 
result in an unstable system.

➤ Replace the automatically generated TQL query with a TQL query 
customized for your environment.
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24 
Event Assignment 

This chapter includes:

Concepts

➤ Assign User Groups to Incoming Events on page 622

Tasks

➤ How to Map Events to User Groups on page 623

Reference

➤ User Group Assignments User Interface on page 625
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Concepts

Assign User Groups to Incoming Events 

This chapter describes how to automatically assign incoming events to 
available user groups. Automatic assigning of events to user groups 
responsible for solving these events significantly improves the efficiency of 
event management. Each event is assigned to an appropriate user group as 
soon as it is received. All operators in a user group are permitted to work on 
those events assigned to that user group. 

The information provided aims to help you understand how to configure 
automatic event assignment to user groups.

User groups are mapped to incoming events in accordance with the Event 
User Group Mapping Rules. The user group of the first rule with a matching 
filter is applied to an event. The following rules are ignored.

These user groups are created and managed from User Management in 
Operations Management Administration:

Admin > Platform> Users and Permissions > User Management

For information on managing user permissions, see "User Management 
Basics" on page 630.

Note: Only users with the appropriate access permissions can use 
Operations Management Administration. For more information about user 
management, see "User Management" on page 629.
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Tasks

How to Map Events to User Groups

This task shows you how to map an incoming event to a user group.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

Note: For information on button actions, see "User Group Assignments User 
Interface" on page 625. 

To map an event to a user group

 1 Open the Event Assignments pane from Operations Management 
Administration:

Admin > Operations Management > Tune Operations Management > 
Event Assignments

 2 In the Event Assignments pane, click the  button to open the Create 
New Event Assignment Rule dialog box or the  button to open the Edit 
Event Assignment Rule dialog box.

User groups are mapped to incoming events in accordance with the Event 
User Group Mapping Rules. The user group of the first rule with a 
matching filter is applied to an event. All following rules are ignored.

 3 Select an existing filter from the Filter list or create an event filter to 
identify the events that are to be assigned to the user group specified by 
this event user group mapping rule. For details about creating filters, see 
"Filtering Events" on page 211.
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 4 Select an existing user group from the User Group list to assign incoming 
events to.

Note: It can take up to one minute before newly created users are visible.

 5 Optional: Add a description for this event user group mapping rule.

 6 Select OK to apply your mapping and close the Event User Group 
Mapping Rules dialog box.
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Reference

User Group Assignments User Interface

The User Group Assignments manager enables you to view and arrange 
event user group mapping rules to automatically assign incoming events to 
existing user groups.

This section includes:

➤ Event Assignments User Interface on page 625

➤ Create New and Edit Event Assignment Rule Dialog Boxes on page 628

Event Assignments User Interface 

The Event Assignments pane enables you to view and arrange event user 
group mapping rules to automatically assign incoming events to existing 
user groups.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Assignments

Relevant tasks For more information about automatically assigning 
events, see "Assign User Groups to Incoming Events" on 
page 622.

See also For more information about mapping events to user 
groups, see "How to Map Events to User Groups" on 
page 623.
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The Event Assignments pane displays the UI elements listed in the following 
table.

UI Element (A-Z) Description

Reloads the list of event user group mapping rules.

New Item: Opens the Event User Group Mapping Rules 
dialog box to create an event user group mapping rule. 
Enter the events filter and user group for the rule. You 
can select an existing filter or user group or use the 
Browse (...) button to create a filter or edit an existing 
filter.

Edit Item: Opens the Event User Group Mapping Rules 
dialog box to edit the selected event user group mapping 
rule. Enter the events filter and user group for the rule. 
You can select an existing filter or user group or use the 
Browse (...) button to create a filter or edit an existing 
filter.

Delete Item: Removes the selected event assignment 
from the list of event assignments.

Go to Users and Groups: Opens the User Management 
user interface for creating and modifying users and user 
groups.

Manage Event Filters: Opens the Manage Named Filters 
dialog box for adding, editing, and managing filters.

For information about defining filters, see "Filtering 
Events" on page 211.

Move Up: Moves the selected event assignment up to a 
higher priority position.

Move Down: Moves the selected event assignment down 
to a lower priority position.

Description Description of the event user group mapping rule 
(optional).

Filter The filter applied in the rule. The filter determines which 
events are mapped to the user group.
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Order Where more than one user group assignment mapping 
rule filter matches, the number in the Order column 
indicates the order in which the rules are applied during 
the mapping process. Using the  (Up) and  (Down) 
buttons, you can change the position of rules in the list.

Note: If a rule matches, no further rules are applied.

User Group Name of the group to which the filtered events are 
assigned by the selected event user group mapping rule.

UI Element (A-Z) Description
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Create New and Edit Event Assignment Rule Dialog Boxes 

The Create New and Edit Event Assignment dialog boxes enables you to 
create and edit event user group mapping rules to automatically assign 
incoming events to existing user groups.

The Create New and Edit Event Assignment dialog boxes displays the UI 
elements listed in the following table.

To access Select Admin > Operations Management > Tune 
Operations Management > Event Assignments

Relevant tasks For more information about automatically assigning 
events, see "Assign User Groups to Incoming Events" on 
page 622.

See also For more information about mapping events to user 
groups, see "How to Map Events to User Groups" on 
page 623.

UI Element (A-Z) Description

Description Description of the event user group mapping rule 
(optional).

Filter Use the lists to select the filter to apply in the rule. The 
filter determines which events to consider in the 
mapping operation.

You can select an existing filter or user group or use the 
Browse (...) button to create a filter or edit an existing 
filter. For details about creating filters, see "Filtering 
Events" on page 211.

Note: The filter dialog box displayed for Event 
Assignments is customized for this task. For example, 
Assigned To: pane is not displayed as it is not relevant.

User Group Name of the group to which the filtered events are 
assigned by the selected event user group mapping rule.
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User Management

This chapter includes:

Concepts

➤ User Management Basics on page 630

➤ Operations Management Users on page 630

➤ Operations Management User Views on page 632

Tasks

➤ How to Define Operations Management Users on page 633

➤ How to Create Operations Management User Groups on page 635

➤ How to Create Operations Management Users on page 636

➤ How to Set Operations Management User or Group Permissions 
on page 637

➤ How to Assign Views to a User on page 640

➤ How to Import and Export Users and Groups on page 641

Reference

➤ User Management for Operations Management on page 643

Troubleshooting and Limitations on page 649
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Concepts

User Management Basics

This chapter introduces how to configure users, and user roles for 
Operations Management.

The user configuration depends on the role the user fulfills as well as the 
tasks that the user is likely to perform, for example: 

➤ Event management

➤ Operations Management administration

You can create an Operations Management user or group configuration to 
provide access to the features for specialist operators, for example, email 
application experts.

User groups enable you to restrict the scope of a user’s responsibility to 
predefined areas. You can specify what features are available, either by 
configuring a user group (and all members of this group can access the same 
features) or more specifically by configuring the user directly.

For more information about the default configurations available for 
Operations Management users, see "Operations Management Users" on 
page 630. For more information about the user views, see "Operations 
Management User Views" on page 632.

 

Operations Management Users

You can define users and user groups for a specific area of responsibility. 
Configuring a new user or user group involves granting the appropriate level 
of access to events, health indicators, administrative user interfaces, tools, 
and custom actions. For example, it is essential for domain experts to be 
able to see events relating to the domains that they are responsible for 
configuring and maintaining. 
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You can grant users different levels of access to events based on whether:

➤ Events are assigned to the user or to one of the groups that the user is a 
member of.

➤ Events are not assigned to the user, nor any of the groups that the user is 
a member of (includes not assigned at all).

For example, you can permit users full access to any event that is assigned to 
them and only limited access to any event that is not assigned. Full access to 
assigned events enables the user to open or close the assigned event, change 
or work on it, or assign it to another user. Limited access to events that are 
not assigned to a user either hides the events completely or permits 
read-only access. You can also choose to grant a user the same access levels 
both assigned and unassigned events.

You can also define the actions that users or user groups can perform on 
events and their related CIs.

Permissions can be granted either directly or by a user group. Only users 
who log on with the appropriate credentials can view the requested object 
or start the desired Administration manager.

For example, Operations Management enables you to restrict access to the 
following elements according to individual user or user group:

➤ Events assigned to user

➤ Events not assigned to user

➤ Resetting health indicators

➤ Administration manager user interfaces (for example, Correlation Rules 
manager, and Tools manager)

➤ Tool categories

➤ Custom actions

➤ Configuration item types that are included in specific views
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To reduce the effort and complexity involved in configuring authorization 
for individual users, you can grant authorization at the user-group level. 
Configuring assignment-based authorization at the user-group level makes 
sure that all users in a group have the same access to any event that is 
assigned to the group.

For example, you can make sure that all database users can access 
database-related events by setting up a group of database users, authorizing 
full access to assigned events for all users in the database user group, and 
making sure that all database-related events are assigned to the database user 
group.

Note: Sub groups inherit any authorizations granted to the parent group. 

The assignment of events to Operations Management user groups is 
essential in larger environments. It is possible to automate this assignment 
to particular user groups, for example, by using event categories. Where no 
event category exists or an event is not assigned to any event category, 
Operations Management can automatically assign the event to a default 
category, which is immediately visible to all users or user groups.

For more information about automatically assigning events, see "Event 
Assignment" on page 621.

 

Operations Management User Views 

Views enable you to select a specific group of configuration item types with 
which you can filter events. You can create views to reduce the amount of 
information presented to regular operators or target the needs of users with 
experts knowledge in particular fields, for example, database administration, 
or Microsoft Exchange.

For more information about Operations Management users, see "Operations 
Management Users" on page 630.
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Tasks

How to Define Operations Management Users 

This task explains how to set up a new user for Operations Management.

This task includes the following steps:

➤ "Prerequisites" on page 633

➤ "Create a User Group" on page 633

➤ "Create a User" on page 634

➤ "Define User Access and Permissions" on page 634

➤ "Assign Views" on page 634

 1 Prerequisites

To create and configure new users and user groups, make sure that you 
can access Operations Management Administration and possess a good 
understanding of the following areas:

➤ Types of users that require access to Operations Management, for 
example, operators, subject matter experts, and administrators.

➤ Views.

➤ Events and event categories.

➤ Stages of the event workflow, for example, Open, In Progress, Resolved, 
or Closed.

➤ Concepts of event type indicators and their values.

 2 Create a User Group

In this step, you create the group that a particular type of user with 
specific tasks and objectives belongs to. For more information, see "How 
to Create Operations Management User Groups" on page 635.



Chapter 25 • User Management

634

 3 Create a User

In this step, you create the users that you want to add to the work group 
you defined in the previous step. For more information, see "How to 
Create Operations Management Users" on page 636.

 4 Define User Access and Permissions

In this step, you configure the scope of the new user’s role by defining the 
actions the new users can perform on events that are assigned to them or 
to other users, specifying if the user can reset an HI, and permitting access 
to Administration features. For more information, see "How to Set 
Operations Management User or Group Permissions" on page 637.

Note: Administrators usually need access to user-related objects such as 
events to test the features they are configuring. For example, an event 
correlation expert needs to see the events that are referenced in the test 
correlation rules.

 5 Assign Views

In this step, you define the objects that the new user is permitted to see 
and work with. For more information, see "How to Assign Views to a User" 
on page 640.
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How to Create Operations Management User Groups 

This task explains how to set up a user group. The group can contain any 
type of user.

Note: For information on button actions, see "User Operations Tab" on 
page 646. 

To define a user group:

 1 Open User Management from Platform Administration:

Admin > Platform > Users and Permissions > User Management

 2 If you want to add a group to an existing user group, select the existing 
group, click the  button and select Create Group.

 3 In the Create Group dialog box, type the required details, such as: group 
name, a short description, and select OK.



Chapter 25 • User Management

636

How to Create Operations Management Users 

This task explains how to set up a user for Operations Management.

Note: For information on button actions, see "User Operations Tab" on 
page 646. 

To create a user:

 1 Open User Management from Platform Administration:

Admin > Platform > Users and Permissions > User Management

 2 If you want to add a user to an existing group, select the group and then 
click the  button and select Create User.

Note: You can create a user by cloning and renaming an existing user. 

 3 In the Create User dialog box, type the required details, such as: user 
name, log-on name, and password, and select OK.

The newly created user can now log on to the BSM console.
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How to Set Operations Management User or Group 
Permissions 

In this task, you set or modify the permissions granted to Operations 
Management users. Regular users require permission to perform operations 
on Operations Management objects such as, events, event categories, and 
indicators. Administrative users require access to Administration features 
and objects.

Note: For information on button actions, see "User Operations Tab" on 
page 646. 

To set the Operations Management user permissions:

 1 Open User Management from Platform Administration:

Admin > Platform > Users and Permissions > User Management

 2 In the Groups/Users pane, select the user or group who you want to 
configure.

 3 Select the Permissions tab.

 4 In the Context pane, select the context: Operations Management.

 5 In the Context pane, select Events assigned to user and, in the 
Operations tab, specify the actions users can perform on events that are 
assigned to them, for example: Change, Work On /Resolve, and Close. 
Select Apply Permissions to save the changes you make.

 6 In the Context pane, select Events not assigned to user and, in the 
Operations tab, specify the actions users can perform on events that are 
assigned to other users, for example: View, or Close. Select Apply 
Permissions to save the changes you make. This setting is useful for 
administrators who need to see events but do not usually have events 
assigned to them.
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Note: To grant access to events at a more detailed level, for example, per 
event category, expand the Events not assigned to user item and select 
the event category that you want to grant permission to work with. The 
event categories displayed in the context list are defined in the 
Operations Management settings page. For more information, see 
"Operations Management Infrastructure Settings Manager" on page 686.

 7 In the context pane, select Health Indicators and, in the Operations tab, 
specify the action a user can perform (Reset). Select Apply Permissions to 
save the changes you make.

Note: Resetting an HI manually returns an HI’s severity status to a defined 
default value such as Normal. For more information, see "How to Reset 
Health Indicators" on page 132.

 8 Administrators and subject matter experts need access to administrative 
functions. If you want to grant access to all administrator areas, select 
Administrative UIs and, in the Operations tab, select Grant for View.

To grant access to Operations Management Administration areas at a 
more detailed level, for example, per manager, expand the Administrative 
UIs item and select the manager that you want to grant permission to 
work with, for example, Indicator Mappings manager and Correlation 
Rules manager. Select Apply Permissions to save the changes you make.

 9 You can control access to tools using tool categories. If you want to grant 
access to all tool categories, select Tool Categories and, in the Operations 
tab, select Grant for Execute.
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Tool categories can be used to grant access to tools at a more detailed 
level. Each tool is assigned a category, and for users to be able to use the 
tools with a certain category, they must be granted execution permissions 
for this Tool Category. To grant execution permissions, expand the Tool 
Categories item and select the tool that you want to grant permission to 
work with. Select Apply Permissions to save the changes you make.

 10 You can also control access to custom actions. If you want to grant access 
to all custom actions, select Custom Actions and, in the Operations tab, 
select Grant for Execute.

Alternatively grant execution permissions for the custom actions that you 
want this user to use. To grant execution permissions, expand the Custom 
Actions item and select the custom action that you want to grant 
permission to and, in the Operations tab, select Grant for Execute. Repeat 
for other custom actions that this user requires. Select Apply Permissions 
to save the changes you make.

Note: Changes to a user account are only fully available after the user whose 
account was changed logs on again to the BSM console. BSM reloads user 
permissions every 0 minutes by default. However, events already loaded into 
the browser remain unaffected.
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How to Assign Views to a User 

In this task, you specify the views that are available to users and the type of 
access the user has to the view. Views define which RTSM objects users can 
see. Access type defines what users can do with the associated view, for 
example, View, Change, Delete or Full Control.

Note: For information on button actions, see "User Operations Tab" on 
page 646. 

To assign a view to a user:

 1 Open User Management from Platform Administration:

Admin > Platform > Users and Permissions > User Management

 2 In the Groups/Users pane, select the user or user group you want to 
configure. If no user or group yet exists, create it now.

 3 In the Context pane, select RTSM, and expand the Views item.

 4 Scroll down the list of views and select those that you want to assign to 
the new user or user group. Multiple selections are possible using the Shift 
and Ctrl keys.

 5 In the Operations tab, use the check boxes in the Grant column to 
indicate the type of access you want to assign to the new user, for 
example, View, Change, or Delete. Select Full Control if you want to grant 
the new user global rights to the objects referenced in the selected view.

 6 Select Apply Permissions to save the changes.

Note: Changes to a user account are only fully available after a new logon to 
Operations Management. Operations Management reloads user permissions 
every 0 minutes by default. However, events already loaded into the browser 
remain unaffected.
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How to Import and Export Users and Groups   

In this task, you learn how to import user and group configurations 
exported from one BSM installation to another BSM installation.

Categories are not exported. However, the permissions for categories that do 
not exist on an installation are imported and stored. If a category is added 
on the target installation that matches a previously imported category, these 
existing permissions are applied accordingly.

Note: If users or groups already exist on the target installation, importing 
new configurations appends additional permissions. If the imported 
configuration is more restrictive, existing permissions on the target 
installation are not reduced. Descriptive information on the target 
installation remains unchanged.

To export user and group configurations:

 1 Open the JBoss JMX Management Console on the BSM system from 
which you want to export the user and group configurations:

http://<Source BSM Hostname>:8080/jmx-console 

 2 Enter a user and password for the JBoss JMX Management Console.

 3 Under the TOPAZ section, select:

service=Authorization Service Data Import Export 

 4 In the exportAllTasEntities() section, enter the name of the ZIP archive file 
(complete path) in the toFilePath field, and select Invoke.

All users and group data is exported to this ZIP archive file.

To import user and group configurations:

 1 Copy the ZIP archive file containing the user and group configurations to 
the BSM system where you want to import the data.

 2 Open the JBoss JMX Management Console on the BSM system to which 
you want to import the user and group configurations:

http://<Target BSM Hostname>:8080/jmx-console 
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 3 Enter a user and password for the JBoss JMX Management Console 
(default: admin/admin).

 4 Under the TOPAZ section, select:

service=Authorization Service Data Import Export 

 5 In the importAllTasEntities() section, enter the name of the zip archive 
file (complete path) in the fromFilePath field, and select Invoke.

All users and group data is imported to the BSM system.

 6 Make sure that the new users and groups are available in User 
Management:

Admin > Platform > Users and Permissions > User Management
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Reference

User Management for Operations Management

If you select the Operations Management context from the Context list, you 
can select the Operations Management areas and define the permissions to 
these areas.

Note: Granting access permissions to a user group automatically assigns the 
same access permissions to any users in the group.

This section includes the descriptions for the Operations Management areas:

➤ User Context Pane on page 644

➤ User Operations Tab on page 646
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User Context Pane

If you select the Operations Management context from the Context list, you 
can select the Operations Management areas and define the permissions to 
these areas.

To access Select Admin > Platform > Users and Permissions > User 
Management

Relevant tasks For more information about managing Operations 
Management users, see:

➤ "How to Define Operations Management Users" on 
page 633.

➤ "How to Create Operations Management User Groups" 
on page 635.

➤ "How to Create Operations Management Users" on 
page 636.

See also For more information about Operations Management 
users, see:

➤ "User Management Basics" on page 630.

➤ "Operations Management Users" on page 630.

➤ "Operations Management User Views" on page 632.
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The Operations Management context displays the UI elements listed in the 
following table.

UI Element (A-Z) Description

Administrative UIs Grants access to the Administration features in the 
Operations Management Administration, for example:

➤ Correlation Rules manager

➤ Content Packs manager

➤ Performance Graphs manager

➤ View Mappings manager

➤ Event Processing Customization

➤ Custom Actions

Users who do not have view permissions to Operations 
Management Administration are not be able to see the 
Operations Management Administration features or see 
an error message when they try to start an 
Administration manager.

Custom Actions Grants access to custom actions. Any custom actions to 
which a user has access can be executed by the user.

Events assigned to 
users

Specifies the type of access a user or user group should 
have to events that are assigned to them. You can select 
one or more of the available operations, for example: 
Work On / Resolve, Close, Reopen, or Assign to.

Events not assigned 
to users

Specifies the type of access a user or user group should 
have to events that are not assigned to them. You can 
select one or more of the available operations, for 
example: Work On / Resolve, Close, Reopen, or Assign to.

Health Indicators Indicates if the user or user group has access to the 
feature that enables the resetting of HIs. For more 
information about resetting HIs, see "How to Reset 
Health Indicators" on page 132.

Tool Categories Grants access to tool categories. Any tools belonging to a 
tools category to which a user has access can be executed 
by the user.
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User Operations Tab

The Operations tab in the Users and Permissions settings displays the 
permissions granted to users for access to specified objects.

The User Operations tab displays the UI elements listed in the following 
table.

To access Select Admin > Platform > Users and Permissions > User 
Management

Relevant tasks For more information about managing Operations 
Management users, see:

➤ "How to Define Operations Management Users" on 
page 633.

➤ "How to Create Operations Management User Groups" 
on page 635.

➤ "How to Create Operations Management Users" on 
page 636.

See also For more information about Operations Management 
users, see:

➤ "User Management Basics" on page 630.

➤ "Operations Management Users" on page 630.

➤ "Operations Management User Views" on page 632.

UI Element (A-Z) Description

Add/Delete/Update 
Annotations

Enables the user to create, modify and delete annotations 
for an event.

Add/Delete/Update 
Custom Attributes

Enables the user to create, modify and delete custom 
attributes.

Add/Remove Event 
Relations

Enables the user to add and remove relations between 
events in the Event Browser.

Assign To Enables the user to assign the selected events to a specific 
user or user group.

Change Enables the user to change events attributes of events.
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Close Enables the user to set the lifecycle state for the selected 
events to Closed.

Close Transferred Enables the user to close events in the Event Browser for 
which control was transferred to an external manager.

Execute Enables the user to execute tools belonging to the 
selected category or execute the selected or custom 
action.

Grant Select one or more of the available operations to enable 
access to the object selected in the Context pane, for 
example: Work On / Resolve, Close, Reopen, or Assign to.

Granted from Indicates with a check if access is already granted 
through inheritance from another object, such as a user 
group, a user role, or a parent object.

Inherit Indicates if the permission can be passed on.

Launch Enables the user to run HP Operations Manager actions 
for an event containing event-related actions. There are 
two types of HP Operations Manager:

➤ Operator actions

➤ Automatic actions

Operation Type of operation to be performed, for example: View, 
Open, or Delete. The list of available operations depends 
on the context selected.

Reset Enables the user to clear the current status of an HI and 
reset the HI to the status specified in the default HI value.

Reopen Enables the user to set the lifecycle state for the selected 
Closed events to Open. The events can now be reassigned 
to users for further investigation and resolution.

Note: Reopening symptom events with a closed cause is 
not possible.

Transfer Control Enables the user to transfer control of events in the Event 
Browser to an external manager.

UI Element (A-Z) Description
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View Enables the user to access and use the selected 
Administrative user interface (for example, the ETI 
Mapping manager, or Correlation Rules manager).

Work On / Resolve Enables the user to set the lifecycle state for the selected 
events to In Progress. This indicates that the underlying 
problems of the events are under investigation by the 
user setting the status to In Progress or by another user 
assigned to the event.

Enables the user to set the lifecycle status for the selected 
events to Resolved when the underlying problems are 
solved.

UI Element (A-Z) Description
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Troubleshooting and Limitations 

This section provides the following help for those people who are 
troubleshooting problems with users and user groups in Operations 
Management administration:

➤ Users Not Available on page 649

➤ Users Has Incorrect Home Page on page 649

➤ Users Sees Incorrect Features on Log On on page 649

➤ Users Denied Access to Tools on page 649

Users Not Available

➤ User not configured

➤ Incorrect user or group configuration

Users Has Incorrect Home Page
Incorrect user settings

Users Sees Incorrect Features on Log On
Incorrect user settings

Users Denied Access to Tools

➤ Browser session started by user who does not have the authorization to 
launch a tool

➤ Tool definitions not imported into Operations Management
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26 
Auditing in Operations Management

This chapter includes:

Concepts

➤ Introduction to Auditing on page 652

Tasks

➤ How to Enable Auditing on page 653

➤ How to View Audit Information on page 654

Reference

➤ Audited Operations Management Areas on page 655
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Concepts

Introduction to Auditing

Auditing the changes to configurations of Operations Management, changes 
to events, and execution of tools and actions is critical to reducing security 
risk and achieving compliance.

You can configure Operations Management to generate and record audit 
events when a user changes an Operations Management configuration or an 
event. For example, if a user executes an action on a node, a corresponding 
entry is made in the Operations Management Audit Log, recording the date 
and time of execution, the user who started the action, and a description of 
the action run.

There are two audit categories to configure which type of changes are 
logged:

➤ Configuration

The default value is Configuration. When you set this category, only 
configuration changes are written to the Audit Log.

➤ All

When you set this category, both event and configuration changes are 
written to the Audit Log.

Areas Not Audited
The Operations Management areas that are not audited are listed in the 
following list.

➤ Changes to displayed columns in the Event Browser 

➤ Change to column sizes 

➤ Information about which column was used for ordering

➤ Active filter applied
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Tasks

How to Enable Auditing

This task shows you how to enable auditing of Operations Management.

Note: To use Operations Management Administration areas, you must be 
granted permission to work with these or a subset of these. For details, see 
"How to Set Operations Management User or Group Permissions" on 
page 637.

To enable auditing:

 1 Open the Infrastructure Settings manager:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

 2 In the Applications list, set the context to Operations Management.

 3 In the Auditing Settings section, click the  button for the entry: 
Audit Category.

 4 In the Edit Setting dialog box, select the auditing level:

Configuration: Record only changes made to Operations Management 
configurations. Default setting.

All: Records all changes to Operations Management 
configurations and events.

 5 Select Save.

 6 In the Auditing Settings section, click the  button for the entry: Enable 
Auditing.

 7 In the Edit Setting dialog box, select True.

 8 Select Save.

Auditing is enabled immediately.
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How to View Audit Information

This task shows you how to view the audit logging information for 
Operations Management.

To view the audit information for Operations Management:

 1 Open the Audit Log manager:

Admin > Platform > Setup and Maintenance > Audit Log

 2 In the Context list, set the context to Operations Management.

The contents of the audit log are displayed.

 3 Optional: Set the Auditing Filters to display only the audit information 
that you are interested in:

User: Specifies user associated with the audit information 
that you want to view.

Containing text: Specifies the text string that you want to search for.

Start after: Specifies the start time for the time period for which 
you want to search the audit log.

End before: Specifies the end time for the time period for which 
you want to search the audit log.

 4 Select Apply.

The filtered results are displayed.
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Audited Operations Management Areas

The following sections list of the Operations Management areas that can be 
audited, and include the specific changes that generate an entry in the Audit 
Log.

Event Changes in the User Interface
The following is a list the event changes that are audited. For event-related 
changes to be recorded, the Audit Category must be set to All.

When a change is made, only the new value is written to the Audit log.

➤ Action launches.

➤ Add Custom Attributes — creating, editing, and deleting.

➤ Annotations — creating, editing, and deleting.

➤ Assign Event to User or Group changes.

➤ Event Title edits.

➤ Forwarding Actions.

➤ Lifecycle State of event changes.

➤ opr-archive-events.bat and opr-close-events.bat maintenance tools 
launches.

➤ Priority of event changes.

➤ Re-run Automatic or Operator Action.

➤ Severity of event changes.

➤ Tool launches.
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Configuration Changes
The following is a list of the configuration changes that are audited. For 
configuration-related changes to be recorded, the Audit Category can be set 
to Configuration or All.

➤ Audit Configuration — changing, enabling, and disabling.

➤ CI Resolver Mapping — creating, editing, and deleting.

➤ Connected Server — creating, editing, and deleting.

➤ Content Packs — creating, editing, deleting, importing and exporting.

➤ Custom Action Configurations — creating, editing, and deleting.

➤ Downtime Configuration — creating, editing, and deleting.

➤ EPI Configuration — creating, editing, and deleting.

➤ ETI Mapping Rules — creating, editing, and deleting.

➤ Event Assignment Rules — creating, editing, and deleting.

➤ Event Forwarding — WS-triggered actions using the console API.

➤ Filters — creating, editing, and deleting.

Only changes about filters created and used in the Operations 
Management Admin user interface, for example, ETI Mapping Rules, User 
Group Assignment, Forwarding Rules are written to the Audit log. Filters 
defined by operators in the Operations Management Application user 
interface are not audited.

➤ Forwarding Rules — creating, editing, and deleting.

➤ TBEC Rules — creating, editing, and deleting.

➤ Tools for CI Type — creating, editing, and deleting.

➤ View Mapping for CI Type — creating, editing, and deleting.
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27 
Tracing and Logging Operations 
Management User Interfaces

This chapter includes:

Concepts

➤ Introduction to Tracing and Logging on page 658

Tasks

➤ How to Enable Logging on page 659

➤ How to Save Log Information on page 660

Reference

➤ Logging Settings User Interface on page 661
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Concepts

Introduction to Tracing and Logging

The Operations Management logging and tracing capabilities help simplify 
on-site troubleshooting.

Logging is designed to be run on the client system and uses JavaScript to 
send logging and tracing output to a browser window. You can enable 
logging and tracing on demand and save the output to aid troubleshooting.

Note: Due to sandbox restrictions in the Adobe Flash Player and the 
browser, it is not possible to write logs to the clients local file system.
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Tasks

How to Enable Logging

This task shows you how to enable logging of the user interface client.

To enable logging:

 1 Log on to BSM:

http://<BSM_host>/bsm

 2 Open the following URL to open the logging configuration application. 

http://<hostname>/opr-admin-server/logging/logging.html

The Logging Settings dialog box opens.

 3 To enable logging, select the Enable logging for this session check box.

 4 Select the required logging level. Each log level includes the higher levels:

Critical: Shows only problems of level Critical.

Error: Shows problems of level Error and Critical.

Warning: Shows problems of level Warning, Error, and Critical.

Info: Shows problems of level Info, Warning, Error, and Critical. 
The resulting information provides a brief overview over the 
flow of the executed steps.

Debug: Shows problems of level Info, Warning, Error, and Critical. 
The resulting information provides a detailed, verbose view 
over the flow of the executed steps.

 5 Optional: Set a filter value to find instances of the specified text strings. By 
default, all messages that have a category starting with com.hp. are logged. 
You can restrict this to certain categories to filter the output or extend it, 
for example, to show messages from the Flex framework.

 6 Click Apply.

The settings become effective for the current browser session.
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 7 Restart the user interface that you want to trace.

As soon as the first log output is sent, a browser window opens that shows 
the log messages.

Note: Each time you change the logging settings you must restart the user 
interface that you want to trace.

The settings are for applications that are served from the same domain as 
that of the current browsing session. If you restart the web browser, you 
must reapply the logging settings

How to Save Log Information

This task shows you how to save the logging information of the user 
interface client.

To save the current logging information from the browser window:

 1 Select the following menu options:

File > Save As 

The Save Web Page dialog box opens.

 2 Select a destination directory, specify a file name, select the file type and 
encoding for the logging information to be saved.

 3 Click Save.
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Logging Settings User Interface 

The Logging Settings page enables you to enable or disable logging of 
Operations Management Flex-based user interfaces, such as the Operations 
Management administration components.

The Logging Settings page UI elements are listed in the following table.

To access 1  Select Log on to BSM:

http://<BSM_host>/bsm

2  Open the following URL to open the logging 
configuration application. 

http://<hostname>/opr-admin-server/logging/
logging.html

Relevant tasks For more information about configuring the logging, see:

➤ "How to Enable Logging" on page 659.

➤ "How to Save Log Information" on page 660.

See also For more information about logging, see "Introduction to 
Tracing and Logging" on page 658.

UI Element (A-Z) Description

Add Adds the filter category specified in the Filter field to the 
list of filters to be applied.

Apply Applies the logging settings for use as soon as the 
application being logged is reloaded.

Enable logging for 
this browser setting

Enables logging of the current browser session.

Filter Field used to specify a filter category. You can the * 
symbol as a wildcard character to limit the output to 
certain categories.
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Log Level Sets the detail level to be logged. The available levels are 
listed below:

Critical: Shows only problems of level Critical.

Error: Shows problems of level Error and Critical.

Warning: Shows problems of level Warning, Error, and 
Critical.

Info: Shows problems of level Info, Warning, Error, and 
Critical. The resulting information provides a 
brief overview over the flow of the executed 
steps.

Debug: Shows problems of level Info, Warning, Error, 
and Critical. The resulting information 
provides a detailed, verbose view over the flow 
of the executed steps.

Remove Removes the selected filter category from the list of filters 
to be applied.

UI Element (A-Z) Description
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28
Topology Synchronization

This chapter includes:

Concepts

➤ Dynamic Topology Synchronization on page 664

➤ Basic Topology Synchronization on page 666

Tasks

➤ How to Run Dynamic Topology Synchronization on page 667

➤ How to Run Basic Topology Synchronization on page 671

Reference

➤ Basic Topology Synchronization Command-Line Interface on page 672

Troubleshooting and Limitations on page 674
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Concepts

Dynamic Topology Synchronization 

Discovery is the process of populating the Run-time Service Model database 
(RTSM) with CI and service data. Accurate CI topology information 
provided by discovery of the system infrastructure is essential for the health 
system and Topology-based Event Correlation.

Discovery ensures that topology data in the RTSM is accurate, current, and 
almost instantly updated whenever something changes in the environment. 
The discovered data can be made available to both BSM and HP Operations 
Manager.

Service discovery uses policies consisting of the following components:

➤ Discovery schedule.

➤ Type model.

➤ Parameters, for example, credentials.

➤ Script or instrumentation to execute the discovery. 

The agent functionality incorporates delta detection, deletion detection, 
and communication with the HPOM server. The scripts provide the data in a 
form that the HPOM server can handle.

Exchange Node and Service Configurations Automatically
In an environment with multiple servers (HP Operations Manager and 
Operations Management), you can automatically synchronize node and 
service data with other servers by forwarding the information from one 
server to one or more other servers. The synchronized data includes nodes, 
external nodes, node groups, services, and service types.

The data synchronization by default uses both of the following 
synchronization methods in combination:
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➤ Scheduled (time-based) Synchronization

Service auto-discovery policies on the source server regularly download 
the node and service data. The agent on the HPOM management server 
processes the data to detect any changes and reports the changed 
elements to the HPOM management server. The HPOM management 
server then establishes an HTTPS connection to one or more target servers 
and forwards the changed elements only.

➤ Event-driven synchronization

A WMI event listener continuously listens on the source server for 
changes to the node and service data. When a change occurs, the HPOM 
management server immediately forwards the changed elements. This 
ensures that the node and service configuration on all servers is always 
accurate and up to date because it is updated at runtime each time the 
environment changes.

Note: Instead of using the policy-based synchronization method you can 
use the startInitialSync tool on the HPOM management server to download 
and forward all the topology data that already exists on HPOM management 
servers manually. For more informatio about migrating from scheduled 
synchronization, see the Operations Manager i Extensibility Guide.
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Basic Topology Synchronization 

Operations Management provides the command-line tool 
opr-startTopologySync that enables you to synchronize topology data, 
such as services and managed nodes, from HPOM to the RTSM.

On startup, the opr-startTopologySync tool uses parameters defined and 
stored in the settings manager. The topology synchronization process 
requires the following prerequisites:

➤ Connection between Operations Management and the HPOM 
management servers

➤ HPOM management server configured to forward events to Operations 
Management

➤ Access to both the Operations Management installation and the RTSM

You can run the opr-startTopologySync tool manually from the 
command-line or according to a defined schedule, for example, with the 
Windows task scheduler. 

Note: For multi-system, distributed installations, the 
opr-startTopologySync tool must be run on the Data Processing Server 
system.

For more information about the settings for the topology synchronization 
tool, see "Topology-Based Event Correlation Settings" on page 717. For more 
information about the opr-startTopologySync command, see "Basic 
Topology Synchronization Command-Line Interface" on page 672.

Note: Some features are only available to users who are logged on with the 
appropriate authorization. If you are logged on to Operations Management 
without administrative authorization, you may be required to supply a user 
name and password to start Content Packs tools. 
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Tasks

How to Run Dynamic Topology Synchronization

Before configuring forwarding of topology (node and service) data to 
Operations Management from HP Operations Manager management 
servers, complete the following configuration steps in Operations 
Management:

➤ Add the HP Operations Manager management server as a connected 
server in Operations Management. For details, see "How to Create a 
Connection to an HPOM Server" on page 413.

➤ Establish a trust relationship between the Data Processing Server and the 
HP Operations Manager management server. For details, see "How to 
Establish a Trust Relationship for a Server Connection" on page 426.

➤ Optional: Use the opr-sd-tool.bat command-line tool to upload new or 
changed synchronization packages from the file system to the database. 
For details, see the Operations Manager i Extensibility Guide.

After ensuring that the HP Operations Manager management server is added 
in Operations Management as a connected server, configure the forwarding 
of topology (node and service) data on the HP Operations Manager 
management server as described in the following section.

The following sections describe how to configure topology synchronization:

➤ "How to Configure Dynamic Topology Synchronization on HPOM for 
Windows Systems" on page 668

➤ "How to Configure Dynamic Topology Synchronization on HPOM for 
UNIX Systems" on page 669
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How to Configure Dynamic Topology Synchronization on 
HPOM for Windows Systems
This section describes how to configure Dynamic Topology Synchronization 
on HPOM for Windows management servers. For further details, see the 
HPOM for Windows documentation.

To forward topology data to Operations Management, complete the 
following steps on the HP Operations Manager for Windows management 
server from which you want to receive topology information:

 1 Configure trusted certificates for multiple servers.

In an environment with multiple servers, you must configure each server 
to trust certificates that the other servers issued. For details, see "How to 
Establish a Trust Relationship for a Server Connection" on page 426.

 2 Configure the list of target servers:

 a In the console tree, right-click Operations Manager, and select 
Configure Server. 

The Server Configuration dialog box opens.

 b Click Namespaces, and select Discovery Server. 

A list of values appears.

 c Add the hostname of the Gateway Server to List of target servers to 
forward discovery data. 

If there is more than one target server, separate the hostnames with 
semicolons, for example:

server1.example.com;server2.example.com

 d Optional: If the target server uses a port other than port 383, append 
the port number to the hostname, for example:

server1.example.com:65530;server2.example.com:65531

 e Optional: Set the value of Enable discovery WMI listener to false if you 
do not want to immediately synchronize changes with other servers. 
The other servers are updated again the next time discovery runs.

 f Click OK to save your changes and close the Server Configuration 
dialog box.
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 g Restart the OvAutoDiscovery Server process for your changes to take 
effect using the following commands:

net stop “OvAutoDiscovery Server“

net start “OvAutoDiscovery Server”

Note: If you exchange certificates after configuring dynamic topology 
synchronization, restart the OvAutoDiscovery server process.

 3 Deploy the following policy group to the source management server 
agent:

Policy Management > Policy Groups > Samples > en > HPOM Discovery

The policy group contains the following service auto-discovery policies:

➤ DiscoverOM — Discovers and downloads nodes, external nodes, node 
groups, and services.

➤ DiscoverOMTypes — Discovers and downloads service types.

How to Configure Dynamic Topology Synchronization on 
HPOM for UNIX Systems
This section describes how to configure Dynamic Topology Synchronization 
on HPOM for UNIX management servers. For further details, see the HPOM 
for UNIX documentation.

To forward topology data to Operations Management, complete the 
following steps on the HP Operations Manager for UNIX management 
server from which you want to receive topology information:

 1 Prerequisite: Make sure that the minimum patch level for the HPOM 9.10 
for UNIX management server is installed:

➤ HP-UX: Patch PHSS_41692 or superseding patch.

➤ Linux: Patch OML_00034 or superseding patch.

➤ Solaris: Patch ITOSOL_00748 or superseding patch.
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 2 Prerequisite: Make sure that the HPOM for UNIX Agent version on the 
HPOM for UNIX management server is 8.60.500 or higher (Older agents 
require the Agent hotfix QCCR1A100254 and Agtrep must be configured 
to send complete instance data.

 3 Prerequisite: Configure trusted certificates for multiple servers.

In an environment with multiple servers, you must configure each server 
to trust certificates that the other servers issued.

 4 Prerequisite: Type the following command to upload the HPOM Discovery 
policy group to the HPOM management server:

/opt/OV/contrib/OpC/enableToposync.sh -upload -online 
-sched -target <BSM_Gateway_Server_DNS_Name>

The policy group contains the following service auto-discovery policies:

➤ DiscoverOM: Discovers and downloads nodes, external nodes, node 
groups, and services.

➤ DiscoverOMTypes: Discovers and downloads service types.
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How to Run Basic Topology Synchronization

How to Use the Topology Synchronization Tool

You start the Topology Synchronization command-line tool as follows:

 1 Make sure the BSM platform is running.

 2 On the Data Processing Server, execute the following command:

<HPBSM_Root_Directory>/bin/opr-startTopologySync.bat

Note: You can also start this tool as a scheduled task in Windows. The tool 
reads its required parameters from the BSM platform Settings Manager.

For configuration details, see "HPOM Topology Synchronization 
Connection Settings" on page 710 and "HPOM Topology Synchronization 
Settings" on page 712.
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Basic Topology Synchronization Command-Line Interface   

This section describes the options and parameters available in the 
Operations Management topology synchronization command-line 
interface.

Note: For multi-system, distributed installations, the 
opr-startTopologySync tool must be run on the Data Processing Server 
system.

The opr-startTopologySync command without any options loads the 
complete service model and synchronizes all configured data from HPOM to 
the RTSM. The normal mode also performs delta detection and deletes 
elements from the RTSM that have been deleted in HPOM.

To run the opr-startTopologySync.bat tool in normal mode, run the 
following command:

<HPBSM_Root_Directory>/bin/opr-startTopologySync.bat

The opr-startTopologySync command accepts the following option:

opr-startTopologySync -touch

The ContentManager command has one option:

-touch

Does not perform the full synchronization. Reads the data saved from the 
last synchronization from the file system. This data is the same as that used 
for delta detection. The touch options touches every configuration item to 
reset configuration item aging and prevent them being deleted during the 
synchronization process as a result of being too old.
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For more details about RTSM aging, see the HP Business Availability Center 
Model Management guide.
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Troubleshooting and Limitations 

This section provides the following help on troubleshooting problems about 
topology synchronization:

➤ "Event Synchronization Does Not Work" on page 674

➤ "Security Certificates are Missing or Incorrect" on page 675

➤ "Topology Synchronization Fails to Work" on page 677

➤ "Topology Synchronization Troubleshooting, Common Issues, and Tips" 
on page 677

Event Synchronization Does Not Work
The exchange and synchronization of events between Operations 
Management and either HPOM is not working correctly:

➤ Make sure that the name of the HPOM management server is configured 
in Operations Management. For details, see "HPOM Topology 
Synchronization Connection Settings" on page 710.

➤ Make sure that the names of the systems hosting the BSM Gateway 
Servers are configured as managed nodes in HPOM. 
HP Operations Manager for Windows only accepts messages containing 
nodeinfo referring to known nodes.

➤ Make sure that the server-based flexible management policy is configured 
correctly and deployed on the HPOM management server. Flexible 
management is also known as Manager of Manager (MoM).

➤ Make sure that the local time and date is the same on all BSM servers and 
the HPOM server. Otherwise, the certificate generated for the trust 
relationship between the servers fails and no communication can take 
place.

➤ Verify that the installation and configuration of BSM created a Sonic 
queue named opr_gateway_queue:

➤ Start the Sonic Management Console: 
Start > Programs > Progress > Sonic <version> > Sonic Management 
Console
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➤ Select the Configure tab, browse to the Queues element (Managed 
Objects > Containers > <HPOM Management Server> > Queues), and 
make sure that the queue named opr_gateway_queue exists.

➤ Make sure that both the Control daemon and bbc (used for 
communication between HPOM and BSM) are running on both the BSM 
host system and the HPOM management server system:

If the ovc -status command indicates that ovc is not running, start ovc with 
the -start parameter, for example: ovc -start.

Security Certificates are Missing or Incorrect
If security certificates are missing or incorrect, verify security certificates on 
BSM and HPOM.

Solution

Make sure that BSM and HPOM exchanged security certificates and a trust 
relationship exists between the servers, as indicated in the following steps.

To verify security certificates and trust relationships:

 1 On the BSM system, make sure that the correct security certificate is 
installed:

ovc -status
ovcd OV Control CORE (8452) Running
ovbbccb OV Communication Broker CORE (2032) Running

ovcert -check

OvCoreId set : OK
Private key installed : OK
Certificate installed : OK
Certificate valid : OK
Trusted certificates installed : OK
Trusted certificates valid : OK
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 2 List the contents of the certificate

 3 Make sure that communication is possible between BSM and HPOM. Run 
the following command on both the BSM host system and the HPOM 
management server system:

 4 Make sure that communication is possible between BSM and the HPOM 
Message Receiver. Run the following command on both the BSM host 
system and the HPOM management server system:

ovcert -list

(Sample output)
+---------------------------------------------------------+
| Keystore Content----------------------------------------|
+---------------------------------------------------------+
| Certificates |
| 6073fd42-9326-7531-1b2d-cdab6fa099d4 (*) |
+---------------------------------------------------------+
| Trusted Certificates: |
| CA_14d14502-1671-7531-13d6-a06656d31bf3 |
+---------------------------------------------------------+

bbcutil -ping https://<hpom server name>
https://<hpom server name>: status=eServiceOK

coreID=14d14502-1671-7531-13d6-a06656d31bf3
bbcV=06.10.070 appN=ovbbccb appV=06.10.070 conn=7
time=453 ms

bbcutil -ping https://<hpom server name>/com.hp.ov.opc.msgr
https://<hpom server name>: status=eServiceOK

coreID=14d14502-1671-7531-13d6-a06656d31bf3
bbcV=06.10.070 appN=ovbbccb appV=06.10.070 conn=7
time=453 ms
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Topology Synchronization Fails to Work
Make sure that the following settings are correctly specified:

➤ Database Settings: required to write the ID mapping into the database for 
resolution of configuration items.

➤ HPOM Connection Settings: required to read the topology data from the 
HPOM web service during synchronization.

➤ RTSM Connection Settings: required to write the configuration item 
information to the RTSM during the synchronization.

Topology Synchronization Troubleshooting, Common 
Issues, and Tips
The following Dynamic Topology Synchronization log files are a good 
starting point for troubleshooting.

Log Files:

<HPBSM root directory>/log/wde/opr-svcdiscserver.log

➤ Default on Windows: 

C:\HPBSM\log\wde\opr-svcdiscserver.log

➤ Default on Linux:

/opt/HP/BSM/log/wde/opr-svcdiscserver.log

<OvDataDir>/log/OvSvcDiscServer.log

➤ Default on Windows: 

%OvDataDir%\log\OvSvcDiscServer.log

➤ Windows 2003:

C:\Documents and Settings\All Users\Application Data\HP\
HP BTO Software\log\OvSvcDiscServer.log

➤ Windows 2008: 

C:\Program Data\HP\HPBSM\log\OvSvcDiscServer.log
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➤ Default on Linux:

/var/opt/OV/log/OvSvcDiscServer.log

Log File Configuration Files:

<HPBSM root directory>/conf/core/Tools/log4j/wde/
oprsvcdiscserver.properties

➤ Default on Windows:

C:\HPBSM\conf\core\Tools\log4j\wde\oprsvcdiscserver.properties

➤ Default on Linux:

/opt/HP/BSM/conf/core/Tools/log4j/wde/oprsvcdiscserver.properties

See the Operations Manager i Extensibility Guide for further details.

The most common issues are listed in the following table. The issues apply 
to topology synchronization generally, unless otherwise specified.

Symptom Cause Solution

Topology 
synchronization fails

Operations Manager i 
Enablement Patches are not 
installed.

See the BSM 9.10 Readme 
for details, including 
information about any 
required agent hotfixes or 
patches.

Operations Manager for Windows:
Install Patch OMW_00090 or 
superseding and OMW_00092 for 
HPOM 8.1x for Windows.

HPOM 9.00 for Windows does not 
require any patches.

Operations Manager for UNIX or 
Linux:

Install Patch PHSS_41692 or 
superseding for HPOM 9.10 for 
HP-UX.

Install Patch OML_00034 or 
superseding for HPOM 9.10 for 
Linux.

Install Patch ITOSOL_00748 or 
superseding for HPOM 9.10 for 
Solaris.
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Basic topology 
synchronization fails.

Port for the web service is 
not configured correctly.

Make sure the port for the web 
service is correctly configured.

User name / password are 
wrong.

Format for HPOM for Windows: 

DOMAIN\Username
User must have at least PowerUser 
rights and must be a member of 
HP-OVE-Admins group.

Dynamic topology 
synchronization fails.

Synchronization package 
was changed on disk, but 
not uploaded to the 
database.

Run the opr-sd-tool.bat 
command-line tool to upload 
changes to synchronization 
packages to the database (see 
Operations Manager i Extensibility 
Guide for further details).

Result of dynamic 
topology 
synchronization is 
incomplete or empty.

Discovery policies 
(DiscoverOMTypes and 
DiscoverOM) are deployed 
prior to configuring the 
Operations Management 
instance as a target server 
in HPOM.

On the HPOM management server, 
run the command:

ovagtrep –publish

This command resends all topology 
data to the HPOM or Operations 
Management instances.

All of a sudden, no 
more node CIs are 
created and the 
synchronization fails.

The default synchronization 
package is missing from the 
Topology Synchronization 
settings.

Check if the default synchronization 
package was removed from the 
Topology Synchronization settings. 
The default package must always be 
present in the semicolon-separated 
list.

Warnings in the log 
file.

Model-related issues. No immediate action required, 
however topology synchronization 
performance can be affected.

You created your own 
synchronization 
package but you only 
get a cryptic RTSM 
(Run-time Service 
Model) exception in 
the log file.

Mapping-related issues. Enable the data dump option and 
check if the file in the directory:

<HPBSM root directory>/opr/tmp/
datadump/postenrichment 

contains all expected attributes for 
the CIs of your synchronization 
package.

Symptom Cause Solution
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29
Infrastructure Settings for Operations 
Management

This chapter includes:

Concepts

➤ Settings Management Basics on page 682

Tasks

➤ How to Display and Edit Operations Management Settings on page 685

Reference

➤ Operations Management Infrastructure Settings Manager on page 686
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Concepts

Settings Management Basics 

This chapter provides an overview of the settings required for Operations 
Management including information that helps to configure the Operations 
Management settings.

The Infrastructure Settings Manager page for Operations Management page 
enables you to view and modify the default configuration for Operations 
Management. The settings displayed on this page determine how 
Operations Management behaves and performs. Changing settings can 
affect the performance of both the application itself and the underlying 
platform. Only users with both the required background knowledge and 
access permission should attempt to change these settings.

To access the Infrastructure Settings Manager page for Operations 
Management page, see "How to Display and Edit Operations Management 
Settings" on page 685.

Note: Modified values are displayed in bold text. In some cases, the changes 
you make are not effective immediately. You might have to restart the 
browser session or a server process.

The Infrastructure Settings Manager page for Operations Management 
displays details of the following settings: 

UI Element (A-Z) Description

Audit Settings Defines whether auditing is enabled and whether just 
configuration changes are recorded or also changes to 
events.

CI Resolver Settings Defines how and when configuration items should be 
resolved.
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Certificate Server 
Settings 

Configures the Certificate Server that issues certificates 
for secure communication.

Close Related Events 
Settings

Defines how and when new events are used to close one 
or more existing, related events.

Closed Events 
Browser Settings

Sets the maximum number of closed events to be 
displayed in the Closed Events Browser.

Custom Attribute 
Settings

List of the attributes that can be added to the HPOM 
Event Browser as columns.

Downtime Settings List of the attributes that are used for controlling the 
handling of events that were received while the CI was 
not available due to a scheduled downtime.

Duplicate Events 
Suppression Settings 

List of the attributes that are used for matching new 
events with existing events used to suppress duplicates.

EPI Server Settings Sets the Server Timeout value used for the Event Pipeline.

Event Cache Settings Maximum limit for the number of active top level events 
that are cached on a gateway server.

This mechanism is required to prevent the gateway 
servers from running out of memory, for example, in case 
of event storms that cause lots of active events.

Event Forwarding 
Settings 

Controls whether events are forwarded to connected 
servers, the forwarding mode, and the expiration time of 
forward requests.

Event History 
Settings 

Sets the maximum limit for the history text length.

Event Lifecycle State 
and Assignment 
Propagation

Controls the propagation of assignment and lifecycle 
state operations to symptom events.

Event Type Indicator 
Settings

Controls whether to globally enable mapping rules to 
override the CMA-driven Event Type Indicator 
assignment.

UI Element (A-Z) Description



Chapter 29 • Infrastructure Settings for Operations Management

684

For more information about the individual sections on the Infrastructure 
Settings Manager page for Operations Management, see "Operations 
Management Infrastructure Settings Manager" on page 686.

 

Graphing Settings Defines graph characteristics, including how graphs and 
charts look, when they are generated, and how often 
they are refreshed with data.

HPOM Topology 
Synchronization 
Connection Settings

Specifies the connection to the 
HP Operations Manager for UNIX or 
HP Operations Manager for Windows management 
server (including log-on credentials).

HPOM Topology 
Synchronization 
Settings

Specifies the base settings to use when synchronizing the 
topology of the environment monitored by HPOM.

License Reporting 
Settings

Specifies the address of the License Reporting Server.

Reconciliation 
Settings

Specifies the polling time to the RTSM for reconciliation 
of changes.

Relative Filter 
Re-evaluation 
Settings 

Specifies the time in seconds after which relative date 
filters are re-evaluated.

Topaz Authorization 
Service Settings

Defines the event categories recognized by Operations 
Management, for example: Exchange, WebApp, System, 
or Operating Systems. 

Topology View 
Settings

Defines the distance (in hops) from a selected 
configuration item (that does not have a defined view) 
before Operations Management stops displaying any 
more related configuration items.

Topology-Based 
Event Correlation 
Settings

Defines how long Operations Management waits when 
gathering events before starting the correlation process.

User Interface 
Settings

Specifies the interval of user interface updates and 
enables sound settings.

UI Element (A-Z) Description
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Tasks

How to Display and Edit Operations Management 
Settings 

This task shows you how to display a complete list of the current 
infrastructure settings for Operations Management. You can configure all 
settings using the Edit Setting dialog box.

Note: For information on button actions, see "Operations Management 
Infrastructure Settings Manager" on page 686. 

To display and edit Operations Management settings:

 1 Open Infrastructure Settings from the Platform Administration:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

 2 Select Applications and use the list to set the administration context to 
Operations Management.

 3 For any settings that you want to change, click the associated  button 
to open the Edit Settings dialog box.

 4 Modify the existing settings as required and select Save. Alternatively, 
select Restore Default and Save, to reset the Operations Management 
defaults values.
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Reference

Operations Management Infrastructure Settings 
Manager

This section lists and briefly describes the Operations Management settings 
that the software administrator needs to configure after installation.

Note: To change existing or default settings, click the  button.

This sections includes:

➤ "Auditing Settings" on page 688

➤ "CI Resolver Settings" on page 689

➤ "Certificate Server Settings" on page 692

➤ "Close Related Event Settings" on page 692

➤ "Closed Events Browser Settings" on page 693

➤ "Custom Attribute Settings" on page 694

➤ "Downtime Settings" on page 694

➤ "Duplicate Events Suppression Settings" on page 695

➤ "EPI (Event Processing Interface) Server Settings" on page 699

To access Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings

Select Applications and use the list to set the 
administration context to Operations Management

Relevant tasks "How to Display and Edit Operations Management 
Settings" on page 685.

See also "Settings Management Basics" on page 682.
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➤ "Event Cache Settings" on page 700

➤ "Event Correlation Cache Settings" on page 701

➤ "Event Forwarding Settings" on page 702

➤ "Events History Settings" on page 704

➤ "Event Lifecycle State and Assignment Propagation" on page 706

➤ "Event Type Indicator Settings" on page 707

➤ "Graphing Settings" on page 708

➤ "HPOM Topology Synchronization Connection Settings" on page 710

➤ "HPOM Topology Synchronization Settings" on page 712

➤ "License Reporting Settings" on page 714

➤ "Reconciliation Settings" on page 714

➤ "Relative Filter Re-evaluation Settings" on page 715

➤ "Topaz Authorization Service Settings" on page 715

➤ "Topology View Settings" on page 716

➤ "Topology-Based Event Correlation Settings" on page 717

➤ "User Interface Settings" on page 720

➤ "Web Service Settings" on page 721
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Auditing Settings 
The Auditing Settings contains the available configurations used to 
customize how audit information is recorded. The Audit Logs can be viewed 
from:

Admin > Platform > Setup and Maintenance Audit Log > Locations/
Operations Manager 

The following elements are included in the Audit Settings pane.

UI Element (A-Z) Description

Audit Category Configure which audit categories are logged. The default 
value is Configuration, which only writes configuration 
changes to the Audit Log. When you set the audit 
category to All, event and configuration changes are 
written to the Audit Log.

Enable Auditing If enabled, Operations Management actions are written 
to the Audit Log.
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CI Resolver Settings 
The CI Resolver Settings contains the configurations used to control how 
the CI Resolver manages incoming CI-related information and uses it to 
identify the best matching CI for a particular event. All attributes of the 
compared CIs are taken to calculate a similarity using a scoring function. 
The output of the scoring function indicates how similar two CIs are to each 
other. The CI with the highest score is selected as the best matching CI.

The following elements are included in the CI Resolver Settings pane.

UI Element (A-Z) Description

Cache Modification 
Configuration

Sets, using XML format, the attributes and CI types that 
should be used and those that should be ignored during 
CI resolution. 

Some CI attributes do not provide useful information. 
For example, an attribute value may apply to many CIs 
but does not help to identify matching CI. These types 
are specified in the <IgnoreAttributes> and the   
<IgnoreCiTypes> entries.

Any CI types and attributes included in the ignore lists 
are always ignore by CI resolution.

Some types of information are essential for successful CI 
resolution. These types are specified in the 
<WhiteListType> entries. Should it not be possible to load 
all CIs, the CI types specified in the whitelist are used. 
The order of the CI types in the list represent the order in 
which these CIs are included. As soon as the CIs 
belonging to a CI type cannot be accommodated in the 
cache, these CIs are excluded and no further CI Types are 
assessed.

Entries in the ignore lists override entries in the whitelist. 
Entries in the whitelist are handled in their order of 
appearance.

Cache Refresh Rate Specifies the frequency with which the CI cache is 
refreshed (minutes). 
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Cache Type Sets the Cache Type for CI Resolution. 

In Memory — It is recommended to select the In Memory 
cache type when CI resolution performance is more 
important than minimizing the memory footprint on the 
Data Processing Server. In smaller managed 
environments, where the total number of CIs in the 
monitored environment is smaller than the default value 
in the CI Limit setting, using the In Memory cache type 
is preferable. CI Resolution maintains all CIs in RAM. Use 
this setting for larger environment only when there is 
sufficient RAM available.

Database — It is recommended to select the Database 
cache type when your monitored environment is very 
large (when the number of CIs being monitored is larger 
than in the CI Limit setting). CI Resolution maintains 
only the most often-used CIs in RAM. This is typically 
20% of the CI Limit setting. All other required CIs are 
maintained in a cache file. This option results in a lower 
memory footprint but may have an impact on CI 
resolution performance.

Cache Type File Path Sets the file path to the specified folder for the Persistent 
cache type, which maintains cache entries in a file in the 
file system. You can use either an absolute path or a 
relative path to the BSM home directory.

CI Limit Sets the maximum number of CIs that are loaded into 
cache by the CI Resolver.

CI Limit Fully 
Qualified Domain 
Name

Sets the source attribute of the event sent to the Event 
Browser when the CI Limit is reached.

CI Limit Event 
Severity

Sets the severity of the event sent to the Event Browser 
when the CI Limit is reached.

CI Resolver Attribute 
Splitting Rules

Semicolon separated list of attribute/pattern pairs:

<CI Type name>.<attribute name>=<regular 
expression>;<CI Type name>.<attribute name>=<regular 
expression>;... 

UI Element (A-Z) Description
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CiInfo Host 
Separation Character

Character used to divide the host name from the CiInfo 
text string, for example: @@ 

Note: If you need to provide keywords containing the 
separator character, enclose the keyword within 
quotation marks ("keyword").

CiInfo Key 
Separation Character

Character used to divide the CiInfo text string into 
keywords used to find CIs in the RTSM, for example, a 
colon (:) 

Ignore Resolution 
Hints Text Case

CI Resolver ignores the case of the CI type information 
when set to true.

TQL Queries Defines the TQL queries to run for resolving a CI. 

Note: You can replace the automatically generated TQL 
query with a TQL query customized for your 
environment.

Use Topology Sync 
Shortcut

CI Resolver can use service ID information from 
Topology Sync to map service IDs directly to CIs.

UI Element (A-Z) Description
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Certificate Server Settings 
The Certificate Server is a component used to issue the certificates required 
for secure communication. It runs on each of the Data Processing Servers. 
This setting can be used to route all incoming certificate requests from the 
multiple Gateway Servers to a single Data Processing Server. On this Data 
Processing Server incoming certificate request can be granted with the ovcm 
command-line tool.

The following elements are included in the Certificate Server Settings pane.

Close Related Event Settings
A new event can be used to automatically close one or more existing, related 
events. When a new event is received, a search for existing, related events is 
made. If any related events are found, these are closed and replaced by the 
new event.

There are two ways in which events can be related:

➤ closeKeyPattern attribute

If an event comes in and its closeKeyPattern matches the key attribute of 
an existing event, the older event is closed.

➤ ETIs Contributing to Health

Events can be related when they all contain an ETI contributing to health. 
The value of the ETI of the new event must be different from the value of 
the existing, active events, but must be associated with the same CI.

If Enable Closing Related Events is set to true, on receiving a new event, a 
search is made for related events and any found related event is closed.

UI Element (A-Z) Description

Certificate Server IP 
Address

Specifies the IP Address of Data Processing Server to 
which certificate requests are forwarded.
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The following elements are included in the Close Related Events Settings 
pane.

Closed Events Browser Settings 
The Closed Events Browser Settings contains the available configurations 
used to customize how closed events are displayed in the Closed Events 
Browser.

The following elements are included in the Closed Events Browser Settings 
pane.

UI Element (A-Z) Description

Detected Related 
Events by ETI

Existing events must have same CI and ETI as new event, 
but a different ETI value. Only if ETI contributes to 
health. Default value is true.

Detected Related 
Events by Key 
Matching Pattern

Key of existing events must match closeKeyPattern of 
new event. Default value is true.

Enable Closing 
Related Events

For each newly received event, the existing events are 
inspected to find events related to the new event. Any 
events that are related to the new event are closed. 
Default value is true.

UI Element (A-Z) Description

Maximum Closed 
Events

Sets the maximum number of closed events to be 
displayed in the Closed Events Browser. Default is 1000.
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Custom Attribute Settings 
The Custom Attribute Settings contains the available configurations used to 
customize how custom attributes are used.

The following elements are included in the Custom Attributes Setting pane.

Note: Each custom attribute can then be selected as a column in the Event 
Browser.

Downtime Settings 
The Downtime Settings contains the following attributes that are used for 
controlling the handling of events that were received while CIs were not 
available due to scheduled downtimes.

The following elements are included in the Downtime Setting pane.

UI Element (A-Z) Description

Available Custom 
Attributes

List of custom attributes separated by semicolons (;) that 
you can add to the Event Browser as columns, for 
example: “Customer;Region;Manager;Company”.

UI Element (A-Z) Description

Downtime History 
Range

Time period in minutes within which past downtime 
configurations are considered. All downtime periods are 
ignored which have an end time that is before the 
beginning of the configured history time period.

Future Downtime 
Range

Ignore all maintenance windows which starts after 
current time plus the future downtime range in minutes.

Refresh Time Interval Maximum time in minutes after changes in the 
maintenance windows configuration are taking effect.
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Duplicate Events Suppression Settings
A new event can be a duplicate of an existing event. For each new event that 
is received by Operations Management, a check is made to establish whether 
it is a duplicate of an existing (original) event. If the original event is found, 
the new event is excluded from any further processing and not added to the 
Event Browser. The original event is updated with information from the new 
event. The updates include the following information:

➤ Duplicate count is increased by 1

➤ Received time is changed to that of the new event

Note:  Original received time remains available in event history lines.

Optionally, the following updates can also be made:

➤ Change title to that of new event

➤ Change severity to one of the following states:

➤ Value contained in the new event

➤ Most critical value from the new and original severity

Duplicate matching operates as follows:

➤ If the new event has the No Duplicate Suppression flag set, no search for 
an original event is made.

➤ If the new event includes a key, a search is made for an existing, active 
event that has the same key as the new event, and that are separated by 
less than the time period specified in the Maximum Age of Duplicate Events 
setting.

➤ If the new event does not include a key, a search is made for an existing, 
active event where a set of configurable attributes have the same values as 
the new event, and that are separated by less than the time period 
specified in the Maximum Age of Duplicate Events setting.
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➤ If no original event is found yet, and the new event has an ETI value for a 
health-contributing ETI, a search is made for an existing, active event that 
has the same ETI value and the same CI, and that are separated by less 
than the time period specified in the Maximum Age of Duplicate Events 
setting.

The number of duplicates received for an event is available in the Event 
Browser. The Time Received value reflects the time that the latest duplicate 
arrived. The first received time is maintained in the Event History. 

The following elements are included in the Duplicate Events Suppression 
Setting pane.

UI Element (A-Z) Description

Detect Duplicate 
Events by ETI

Use ETIs to find original event. Duplicate events must 
have same CI, ETI, and ETI value, and the ETI must 
contribute to health. Default value is true.

Detect Duplicate 
Events by Identical 
Attributes

Use selected attributes (for example Select Application or 
Select CI) to find the original event. All selected 
attributes must be identical. Default value is false.

Detect Duplicate 
Events by Key

Use key attribute to find original event. Duplicate events 
must have identical key. Default value is true.

Enable Duplicate 
Events Suppression

If enabled, duplicate events are dropped and the related 
original event is updated instead. Default value is true.

Maximum Age of 
Duplicate Events

Maximum number of seconds difference between 
received times of original and new event (0 = infinite). 
Default value is 0.

Select Application Duplicate events must have identical application. Default 
value is true.

Select Category Duplicate events must have identical category. Default 
value is true.

Select CI Duplicate events must have identical CI. Default value is 
true.

Select CI Hint Duplicate events must have identical CI hint. Default 
value is true.
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Select ETI Hint Duplicate events must have identical ETI hint. Default 
value is true.

Select ETI Value Duplicate events must have identical ETI and ETI value. 
Default value is true.

Select HPOM Service 
ID

Duplicate events must have identical HPOM service ID. 
Default value is true.

Select Node Duplicate events must have identical node. Default value 
is true.

Select Node Hints Duplicate events must have identical node hints. Default 
value is true.

Select Object Duplicate events must have identical object. Default 
value is true.

Select Policy 
Condition ID

Duplicate events must have identical policy condition 
ID. Default value is true.

Select Severity Duplicate events must have identical severity. Default 
value is true.

Select Subcategory Duplicate events must have identical subcategory. 
Default value is true.

Select 
SubComponent ID

Duplicate events must have the same SubComponent ID.

Select Title Duplicate events must have identical title. Default value 
is true.

Select Type Duplicate events must have identical type. Default value 
is true.

UI Element (A-Z) Description
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Note: Wrong keys can suppress events that are not duplicates of existing 
events. To avoid suppressing non-duplicate events, 

➤ Include enough information within the key to make the key specific 
enough to achieve a reliable match.

➤ Include all necessary attributes in the identity check.

Dropping duplicates also results in the inability to update health because 
the following differences between the original event and duplicate event 
may exist:

➤ Original event had no ETIs.

➤ Original event and the new event had different ETIs.

Update Severity of 
Original Event

Update severity of original event based on selected mode. 
The mode values are:

➤ Use new (severity value)

➤ Most critical (severity value)

➤ No (do not change severity of event)

Default value is No.

Update Title of 
Original Event

Update title of original event with title of last duplicate 
event. Default value is false.

UI Element (A-Z) Description
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EPI (Event Processing Interface) Server Settings
The Event Processing Interface Server Settings contains the available 
configurations for the Event Pipeline Server.

The Event Processing Interface (EPI) is used to enrich events with additional 
information from sources accessible using Groovy scripts. For example, it is 
possible to add data to an event from a Microsoft Excel file or an SQL 
database. If Groovy scripts are specified in the Event Pipeline Script and Step 
Settings, the event is forwarded to the EPI Server. 

The following elements are included in the Event Cache Settings pane.

UI Element (A-Z) Description

EPI Server Timeout Configures the maximum time period (in msec) for event 
processing in the EPI Server. The value zero (0) disables 
the timeout which means that a problem during 
processing in the EPI server may block further event 
processing indefinitely.

Note: If the EPI Server Timeout setting is shorter than the 
timeout specified for a script, the execution of the script 
is stopped after the global timeout period is reached. The 
dedicated timeout cannot be reached. It is recommended 
to select a shorter dedicated timeout value for individual 
scripts and set a longer global timeout.
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Event Cache Settings
The Event Cache Settings contains the available configurations used to 
customize how event information is managed.

The following elements are included in the Event Cache Settings pane.

UI Element (A-Z) Description

Max Cache Level Maximal number of active, top-level events to be kept in 
Event Cache. 

The value is automatically set during deployment and is 
dependent on the selected deployment option:

Small - 1000

Med. - 5000

Large - 10000

Extra large - 20000

Note: The more events that are stored in cache, the greater 
the memory demands from MercuryAS. If you significantly 
increase the Max Cache Level setting, check for 
out-of-memory errors in the log files or increase the 
memory settings for MercuryAS in:

<HPBSM root directory>/bin/mercuryAS_vm_params.ini

If you change the deployement in ServerDeployer, you will 
have to change the memory settings again. 

If the configured maximum is reached the oldest 10% of 
the top level events are removed from the cache.

When the number of active, top-level events is less than 
80% of the maximum value, the purged events are 
reloaded.

For example, if the default Event Cache Max Level of 
20000 is reached, the 2000 oldest events are removed from 
the cache. As the number of events in the Event Browser 
drops to 16000, the purged events are reloaded.

The settings are per deployment. The same setting is 
applied to all gateway servers within the same deployment.
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Event Correlation Cache Settings
The Event Correlation Cache Settings contains the available configurations 
used to customize how duplicate events suppression and close related event 
information is cached.

The following elements are included in the Event Correlation Cache 
Settings pane.

UI Element (A-Z) Description

Cache Clean-Up 
Interval

Time interval in seconds after which the cache is cleaned 
up.

Maximum Event Age Maximum age of cached events in minutes. Older 

events are removed from the cache during clean-up.

Maximum Event 
Count

Maximum number of events held in the cache. If 

the current cache size is greater than this number, the 
oldest events are removed from the cache during 
clean-up.
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Event Forwarding Settings
The Event Forwarding Settings contains the available configurations used to 
specify whether events are forwarded to connected servers, the forwarding 
mode, and the expiration time of forward requests.

The following elements are included in the Event Forwarding Settings pane.

UI Element (A-Z) Description

Event Forwarding 
Batch Count

Maximum number of events or updates send 
simultaneously for each synchronization request to 
HPOM and Integration Adapter servers.

The default value is 100. Minimum value is 1. Maximum 
value is 500.

Note: If less than the configured maximum number of 
events or updates are available in the queue, all are sent 
in one request. Only if more than the configured number 
are waiting in the queue, are multiple requests created.

For example, if 120 events are in the queue and the 
default is set to 100, the first 100 events are sent, 
followed by the remaining 20 events. If only 1 event is in 
the queue at that moment, that one event is sent.
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Event Forwarding 
Expiration

Number of hours an event forward request or event 
update synchronization request is held in the queue. If 
the request cannot be delivered to the target server before 
this expiration time, it is automatically deleted from the 
queue.

Default value is 12 hours. Minimum value is 1 hour. 
Maximum value is 720 hours (30 days).

Note: If the request to forward an event to a particular 
connected server fails, the request is deleted from the 
forwarding queue and the event makes an internal note 
that the delivery to the target server has failed. The event 
maintains information about the failed request to the 
specified connected server. Any further forwarding rule 
matches on this event for this connected server is 
ignored. If the forwarding type was set to Synchronize 
and Transfer Control, a standard event annotation is also 
added to the event, otherwise no event annotation is 
made.

Failure to deliver can occur for retry timeouts, or a 
catastrophic delivery error. A catastrophic delivery error 
is a situation where it does not make sense to retry the 
request, for example, a mis-configuration (authentication 
fails), or a programming error is encountered in an 
External Process groovy adapter (NullPointerException). 
These cases require manual intervention before retrying. 

To manually retry failed requests to a particular 
connected server, from the Event Browser, manually 
transfer control of an event that has previously failed 
delivery to a particular server.

Forward Event 
Properties as CMAs 

If disabled (false), event attributes that are unknown in 
HPOM for Windows or HPOM for UNIX are not 
forwarded as Custom Message Attributes. This affects the 
following Event properties: Priority, Description, State, 
Subcategory, Cause Event Id, Solution, Related CI, 
Related CI Hint, Node Hint, Source CI, Source CI Hint, 
ETI, ETI Hint, Skip Duplicate Suppression, Controlled 
Transferred. 

UI Element (A-Z) Description
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Events History Settings 
The Event History Settings contains the available configurations used to 
customize how event history information is handled.

Forward Events Specifies whether forwarding of events to connected 
servers is enabled.

One-line Event 
Forwarding 

Every forwarded event includes a list of servers that have 
a copy of this event. By default, when the event is 
modified on one server, it notifies all servers in the list of 
the change. 

When enabled (true), for each event change (for 
example, close, annotation, or add), the server only 
informs the server from which the event was received 
and to which the event was forwarded. 

This can be useful in simplifying connections in firewall 
environments.

Retry Notify Interval Event Forwarding automatically retries delivery of event 
forward requests once a minute. Whenever a target server 
is unavailable, an internal event is generated indicating 
the failure to deliver. This setting defines the minimum 
number of minutes to elapse before generating another 
event for the failing request.

Default: 60 minutes. Range: Minimum of 1 minute and a 
maximum of 1440 minutes (1 day).

Note: This setting does not affect the retry interval of one 
minute.

UI Element (A-Z) Description
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The following elements are included in the Event History Settings pane.

UI Element (A-Z) Description

Maximum Property 
Length

History of properties of type string or text which are 
longer than the configured value are ignored. Values with 
a fixed length like UUID cannot be limited.

The default value is 0 which retains all information 
regardless of length.

If an attribute modification where the new or old value 
exceeds the maximum length, the following text appears 
in place of the value in the event history:

Value exceeds the maximum permitted length of ‘configured 
length’ characters.
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Event Lifecycle State and Assignment Propagation 
The Event Lifecycle State and Assignment Propagation settings contains the 
available configurations used to customize how correlated events are 
handled when closing cause events.

The following elements are included in the Event Lifecycle State and 
Assignment Propagation settings pane.

UI Element (A-Z) Description

Propagation of 
Assignment 
operation to 
symptom events

Enables the propagation of user and group assignments 
to symptom events. 

When enabled (True), changing the user or group 
assignment of a cause event also applies the change to all 
symptom events. 

Note: If Enabled (True), assignments cannot be changed 
for symptom events.

Propagation of 
Lifecycle State 
operations to 
symptom events 

Enables the propagation of lifecycle state changes to 
symptom events.

➤ Disabled but close operation is propagated to 
symptom events — Lifecycle state changes are not 
propagated to symptom events except for closing of 
events.

➤ Enabled — Lifecycle state changes are propagated to 
symptom events.

➤ Disabled but close operation unrelates symptom 
events — Lifecycle state changes are not propagated to 
symptom events. Closing the cause event unrelates 
symptom events.

Note: If Enabled (True), lifecycle states cannot be 
changed for symptom events.
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Event Type Indicator Settings 
The Event Type Indicator Settings contain the configuration setting that you 
enables you to let ETI mapping rules override indicators specified in custom 
attributes.

The following elements are included in the Event Type Indicator Settings 
pane.

UI Element (A-Z) Description

Allow Rule Overwrite Permits ETI Mapping Rules to overwrite indicators 
specified in custom attributes (CAs).

Default: False 

If set to false, and CMA-matched event type indicators 
are recognized, mapping rules are ignored.

If set to true, the CMAs are still evaluated but mapping 
rules are used to process events.

For example, migrating from customized, 
non-Operations Management-ready SPIs to Operations 
Management-ready SPIs can result in errors in event 
processing as new content packs no longer work as 
expected with the existing handling. 

Permitting mapping rules to override the CMA-driven 
event assignment leaves the Operations Management 
administrator in control.
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Graphing Settings 
The Graphing Settings contain the configuration settings that are used to 
determine how performance graphs are generated and displayed.

The following elements are included in the Graphing Settings pane.

UI Element (A-Z) Description

Daily Maintenance 
Time

Schedules the time at which regular maintenance tasks 
occur. The value is specified in HH:MM format, for 
example: 04:30.

Graph Auto-Refresh 
Rate

Specifies the interval (in seconds) used to automatically 
refreshes the displayed graphs.

JVM Minimum 
Memory

Prevents accepting of new performance graphs requests 
when there is insufficient memory available in the Java 
Virtual Machine (JVM). The default minimum value is 0 
(zero).

Max Data Points Specifies the maximum number of data points used to 
draw graphs.

Maximum Instances Maximum number of Instances that can be launched in a 
Graph. If a CI has more instances than the value specified 
here, graphing cannot display those instances.

Metrics Per Graph Specifies the number of metrics you want to see in a 
graph. The default value is 8. If you specify a value for 
this parameter in the graph template, Graphing chooses 
the highest value between the two values while drawing 
the graph.

Real Time View 
Unsubscription 
Interval 

Specifies the interval at which RTV (Diagnostic View of 
Performance Manager) unsubscribes data gathering from 
RTM (Real-Time Measurement agent). The default 
interval period is 60 seconds. RTV unsubscribes data 
gathering for any metric class that is not chosen for 
graphing. You can configure the interval at which RTV 
checks for metric classes that are being used for graphing. 
If the metric class is not being used for duration longer 
than the value specified for this parameter, then RTV 
unsubscribes data gathering from the agent. 
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Report Template Modifies the properties of the report template. The 
settings you configure here appear in the Print view of the 
graph. 

Show Mouse Hover If enabled (true), hovering the mouse on the graph area 
of a drawn graph opens a pop-up window displaying the 
actual value of the data point and the time interval of the 
selected data.

If disabled (false), no pop-up window is opened.

The default value is true.

Note: The value selected from the user interface menu 
option overrides the setting specified for this parameter.

Sort by Maximum 
Graph Count

Limits the number of graphs drawn for an 
instance-comparison graph when Metric Data Display 
Order is specified as average value or reverse average 
value in the Performance Graphs, for example: 20.

System Performance 
Classes 

Lists the available system performance classes. A graph 
template that contains any of these system performance 
classes is a System Performance graph. A system 
performance graph must be associated with a host CI. 

Table Row Count Configure the default value for the number of rows in a 
chart (graph in tabular form), for example: 100.

Trace Level Enable (1) or disable (0) tracing.

UI Element (A-Z) Description
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HPOM Topology Synchronization Connection Settings 
The HPOM Topology Synchronization Connection Settings pane contains 
the Operations Management settings that can be used to specify connection 
information used to communicate with one 
HP Operations Manager for UNIX or HP Operations Manager for Windows 
management server. These connection settings are used for synchronization 
of events and basic topology synchronization between Operations 
Management and the specified HP Operations Manager management server.

Note: The recommended method of synchronizing topology information is 
by using Dynamic Topology Synchronization. For details, see "Dynamic 
Topology Synchronization" on page 664.

The following elements are included in the HPOM Connection Settings 
pane.

UI Element (A-Z) Description

Forward All Events Enables (true) forwarding of all events to this HPOM 
system. Use for testing only. For production systems, set 
up servers using the Connected Servers manager and 
create appropriate Event Forwarding Rules. 

HPOM Host Name of the system hosting the HPOM management 
server that is forwarding events. This setting is used for 
the bi-directional synchronization of events between 
Operations Management and one HPOM management 
server.

It is recommended to specify connections to external 
servers, including HPOM management servers, using the 
Connected Servers manager. For details, see "How to 
Create a Connection to an HPOM Server" on page 413.

HPOM Password Password for the user that Operations Management uses 
to connect to the configured HPOM management server.

HPOM Port Port number to use when establishing a connection to 
the HPOM management server.
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HPOM Type Specify the platform of the HPOM installation.

For HP Operations Manager for Windows, the user must 
have at least PowerUser rights and must be a member of 
HP-OVE-Admins group and the local administrators 
group.

HPOM User User name that Operations Management uses to connect 
to the configured HPOM management server.

HTTPS HPOM Web 
Service Connection

Set to true to use HTTPS to connect to the HPOM web 
service.

UI Element (A-Z) Description
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HPOM Topology Synchronization Settings 
The HPOM Topology Synchronization contains the settings used by 
Operations Management to synchronize its topology with HPOM. 

These settings are used for basic and dynamic synchronization of the object 
topology in the environments monitored by Operations Management and 
HPOM. The recommended method of synchronizing topology information 
is by using Dynamic Topology Synchronization. For details, see Chapter 28, 
"Dynamic Topology Synchronization".

Note: For more information about the opr-startTopologySync.bat 
command, see "Basic Topology Synchronization Command-Line Interface" 
on page 672.

For the basic synchronization of Operations Management and HPOM 
topologies, make sure that the following settings are correctly configured:

HPOM Connection Settings

The topology synchronization process needs to read the topology data from 
the HPOM Web Service (WS) during synchronization. For more information, 
see "HPOM Topology Synchronization Connection Settings" on page 710.

The following elements are included in the HPOM Topology 
Synchronization pane.

UI Element (A-Z) Description

Dump Data Saves all data from the topology synchronization to the 
hard disk. This setting is not recommended for 
production systems because it can have a significant 
negative effect on performance. The default setting is 
False.

Groovy Scripts Enables Groovy scripts used to manipulate the 
synchronization data during the synchronization 
process.
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Packages for 
Topology Sync

Lists the packages used for the topology 
synchronizations.

Resolve IPs During 
Synchronization 

Enable IP resolution for nodes without IP address 
information in HPOM. Enable IP resolution (true) has a 
negative effect on the synchronization performance.

UI Element (A-Z) Description
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License Reporting Settings
The License Reporting Settings contains the available configurations used to 
specify the License Reporting Server.

The following elements are included in the License Reporting pane.

Reconciliation Settings
The Reconciliation Settings contains the available configurations used to 
poll the RTSM for reconciling changes.

The following elements are included in the Reconciliation Settings pane.

UI Element (A-Z) Description

Server Name Specifies the fully qualified domain name of the License 
Reporting Server.

If no server is specified, no reports are generated.

UI Element (A-Z) Description

Polling Interval Specifies the interval used to poll RTSM for reconciliation 
changes (in seconds). 

Use 0 to disable polling. 
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Relative Filter Re-evaluation Settings
The Relative Filter Re-evaluation Settings contains the available 
configurations used to specify the time after which relative date filters are 
re-evaluated.

The following elements are included in the Relative Filter Re-evaluation 
Settings pane.

Topaz Authorization Service Settings 
The Topaz Authorization Service Settings contains the configurations that 
Operations Management uses in conjunction with user management. 

Note: The list of event categories defined here is also available in the user 
configuration dialog box, where you can grant users or user groups access to 
work with events and event categories.

UI Element (A-Z) Description

Relative Filter 
Re-evaluation 
Settings

Specifies the time after which relative date filters are 
re-evaluated (in seconds). 

Valid range is 30 seconds to 86400 seconds (24 hours).
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The following elements are included in the Topaz Authorization Service 
Settings pane.

Topology View Settings 
The Topology View Settings contain the configuration setting that you can 
use to change how information is displayed in the Health Top View pane 
either in the Health Perspectives tab or the Dashboard.

The following elements are included in the Topology View Settings pane.

UI Element (A-Z) Description

Categories List indicating event categories recognized by Operations 
Management separated by semicolons (;), for example: 
Exchange;WebApp;System. 

Event categories are logical groups of events (for 
example: database, OpenVMS, or hardware) which can be 
assigned to Operations Management users.

Refresh Interval Refresh interval in minutes for reloading user 
permissions from the database. Operations Management 
reloads user permissions every 10 minutes by default. 
However, events already loaded into the browser remain 
unaffected. Changes to a user account are only fully 
available after a new logon to Operations Management.

UI Element (A-Z) Description

CI Centering Mode Enables updating of the view selector in the Top View 
when a CI is selected in the view.
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Topology-Based Event Correlation Settings 
The Event Correlation Settings contain the configuration settings that 
correlation rules are managed.

The following elements are included in the Topology-Based Event 
Correlation Settings pane.

UI Element (A-Z) Description

Auto-Extend Time 
Window Mode

Enables the automatic extension of the correlation time 
period whenever an additional symptom is correlated to 
the same cause.

Each time that an event is correlated with a problem, the 
time period set in the correlation time window is 
restarted to help enable the correlation of a greater 
proportion of symptoms associated with the original 
event.

The correlation time window is only automatically 
extended when an a new symptom is added to a cause 
AND the cause is not yet closed.

If the cause is already closed, the time window is not 
extend anymore so that after the last time window 
elapses, future repetitions of symptoms are no longer   
correlated to the closed cause.

This avoids ignoring new similar symptoms. Just because 
a cause is closed, it is not necessarily true that the 
problem is solved. If the same symptoms continue to 
occur, they were most likely not caused by the closed 
cause event and should become visible in the Event 
Browser.
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Correlate Closed 
Cause Events

Controls whether symptoms are correlated to closed 
causes or not. Default is true. If set to false, no correlation 
is done with newly occurring symptom events after a 
cause is closed. This prevents any auto-closing of new 
events.

Correlation takes place regardless of the lifecycle state of 
cause event, as long as events occur within the 
correlation time window. Correlating a symptom to a 
closed cause closes the symptom as it is not possible to 
have open symptoms with a closed cause.

Correlation Time 
Window

Sets the period of time in seconds that correlation rules 
wait for all required events to occur before reporting the 
cause event and emptying the correlation rule cache.

Cause and symptom events must arrive within that time 
frame in the correlation engine to be considered for 
correlation. A time window starts when a first cause or 
symptom event arrives that cannot be correlated with 
any other event.

Default value is 960 seconds (16 minutes).

Max Query Result 
Cache Time 

Sets the maximum time in seconds that a query result for 
a cause-symptom relationship between CIs for a given 
correlation rule is cached. After this time period elapses, 
the RTSM is queried again.

Valid range is 0 seconds to 86400 seconds (24 hours). 
Default value is 300 seconds (5 mins).

For very high numbers of possible cause-symptom 
relationships, event correlation can take a long time. The 
result of the correlation query for possible symptom CIs 
is stored in a cache and this cache is used for further 
checks. When the configured Max Query Result Cache 
Time period has elapsed, the query is rerun. This 
minimizes the number of times that queries are run for 
multiple open causes/symptoms relationships.

UI Element (A-Z) Description
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Max Waiting Queue 
Size

Maximum number of events waiting to be processed by 
the correlation engine. If this limit is exceeded, the oldest 
event is removed from the queue and no longer 
considered for correlation.

Default value: 5000

Valid range of Values: 100-20000 

Changes are enabled immediately.

UI Element (A-Z) Description
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User Interface Settings 
The User Interface Settings contains the time interval used to update the 
Operations Management user interface with new event-related data.

The following elements are included in the User Interface Settings pane.

UI Element (A-Z) Description

Sound Notification 
for New Events 

Enables sound notification for new events. When loading 
an event browser, this setting is used unless the user has 
defined alternative behavior in the browser options. 

User Interface 
Update Interval

The interval of user interface updates (in milliseconds). 
The default value is 5000 ms (5 seconds).
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Web Service Settings 
The Web Service Settings contains the time interval used to update the 
Operations Management user interface with new event-related data.

The following elements are included in the User Interface Settings pane.

UI Element (A-Z) Description

Error Response 
Verbosity

Controls the verbosity of responses from the Operations 
Management Web Service. The option Standard returns 
to the caller of the web service the appropriate HTTP 
error code, as listed in the HTTP 1.1 standard, along with 
a standard error text message describing the error. The 
option Verbose is recommended for development 
environments and returns a detailed message describing 
the reason for the error. The option Brief returns only 
error codes 400 (Bad Request) or 503 (Service 
Unavailable), depending on the type of the error, and an 
error identifier. A detailed error message may be obtained 
by locating the identifier and detailed error message in 
the error logs.

Secure Modify Operations Management Web service modify operations 
are secured by setting the X-Secure-Modify-Token HTTP 
header on Web service modify requests (PUT, POST and 
DELETE). For details on how to set this header, see the 
Operations Manager i Extensibility Guide. This header 
provides enhanced security protection against malicious 
exploits of web applications. Secure Modify is enabled by 
default.

Note: Secure Modify is not backwards compatible with 
Operations Management 9.0 Web services and may cause 
some Web service clients designed to communicate with 
these Web services to fail when this feature is enabled. 
For backwards compatibility, this feature may be 
disabled. See the Operations Manager i Extensibility Guide 
for additional measures that may be taken to reduce the 
impact of disabling Secure Modify.
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30
Content Packs

This chapter includes:

Concepts

➤ Content Management on page 726

Tasks

➤ How to Upload OO Flows on page 731
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Concepts

Content Management

Content is information that Operations Management uses to describe the 
configuration items that you are monitoring.

Content can include the following types of information:

➤ Configuration item types

➤ Mapping rules for topology synchronization

➤ Discovery sources

➤ Correlation rules

➤ Rules for HI-based key performance indicators

➤ Event type indicators

➤ Health indicators

➤ Graph family definitions

➤ Tool definitions

Content for a specific management area is typically contained in dedicated 
content packs. The BSM Content Packs manager helps you manage this 
data.

You use Content Packs to install or update items in an Operations 
Management instance. You can also take content from one Operations 
Management instance and upload it to other Operations Management 
instances, using the Import and Export features.

The Content Packs manager enables you to create a content pack that 
contains a snapshot of the rules and tools that you defined with Operations 
Management and save the snapshot information in a file. The snapshot file 
you create includes all (or any selection of) the event type indicators, health 
indicators, key performance indicators, mapping rules, KPI calculation and 
business rules, tool definitions, view mappings, and graphing assignments 
that you defined specifically for Operations Management. 
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The following table gives an overview of the items you can include in a 
content pack:

You can use the Content Packs manager to perform the following tasks:

➤ Define the contents of a content pack and save the definition in the 
Operations Management database.

➤ Export a content pack definition and the data it references to a file called 
a content pack.

➤ Import a content pack definition and the data it references. 

➤ Exchange content packs between installed instances of Operations 
Management.

Content Type Description

Key Performance 
Indicators

Configuration and calculation of key performance indicators 
(KPI).

Event Indicator Configuration and calculation of event type indicators.

Event Type 
Mapping Rules

Rules that map the attributes of HPOM messages to 
Operations Management events.

Event correlation Rules that correlate similar or related events. For more 
information, see "Correlation Rules" on page 371.

Performance 
graphs

Information about the graph family templates used to 
generate performance graphs.

Tools Definitions for customized tools that the Operations 
Management software administrators or subject matter 
experts configure for users.

View Mappings Contents of the list of views displayed in the Selected View 
list in the Health Top View pane in the Health Perspective 
tab.

Context Menus Operations Management extensions to context menus, for   
example, to launch Operations Management configuration 
tools, start custom tools for specific CI types, and display 
Operations Management graphs.
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Content Manager Interfaces
The Content Packs manager has two interfaces:

➤ BSM Content Packs graphical user interface

You can also start the BSM Content Pack manager using the following 
menu option:

Admin > Operations Management > Manage Content > Content Packs

➤ ContentManager command-line interface (CLI)

The features and functionality of the Content Pack manager are also 
accessible using the ContentManager command-line interface. You can 
access the ContentManager command-line interface directly, in a shell, 
or remotely, for example, in a script.

Note: You cannot use the ContentManager command-line interface to 
create a content pack definition.

Operations Management Content Packs
Content Packs are for first-time installation. The installation setup copies 
files to the local file system on the management server system. 

Content Packs include CI types, their relationships and dependencies, TQLs, 
enrichment rules, KPI assignments, health indicators, event indicators, view 
mappings, tool definitions, correlation rules, graph definitions, graphing 
family definitions, menu extensions, and details of the underlying 
architectural model. The Content Packs are stored on the Data Processing 
server in a two system deployment. 

At every Gateway Server startup, the contents of the following directory is 
checked:

<BSM_Install_Dir>/conf/opr/content/${locale_of_server} 

Any package that has not already been loaded, and which does not have 
unresolved package dependencies (references to packages, which are neither 
already loaded nor in the same folder), is loaded during this startup. 



Chapter 30 • Content Packs

729

The following directory is checked next:

<BSM_Install_Dir>/conf/opr/content/en_US 

Any content packs that were not uploaded from the first location are 
uploaded. This can result in mixed-language content. 

The packages are loaded with the standard import mode, already existing 
artifacts are not changed. Only new artifacts are added. 

Note: Progress can be followed in the admin backend log file. The operation 
is done in the background and may still be in progress when a user logs in. 
The system prevents that multiple content packages are loaded at the same 
time. An error message is returned.

Installation packages are available for a variety of different application areas 
and are installed using patches after the setup. The installation packages 
include content packs that extend the functionality of Operations 
Management, for example: so that Operations Management can use events 
reported by Smart Plug-ins (SPIs) on the HP Operations Manager 
management server. 

The content packs provide a collection of preconfigured rules, tools, HIs, 
ETIs, graphs, and views to help you monitor events reported to the HP 
Operations Manager management server by the SPIs. If a SPI is installed on 
an HP Operations Manager management server and this server is configured 
to forward messages to Operations Management, you can make use of the 
tools, rules, and definitions listed in the respective installation package.

Note: If you change any HI/ETI name, you must change the custom message 
attribute (CMA) value of the underlying policies to ensure proper 
functioning of the Content Pack. 
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The following table lists the available Content Packs:

Note: For more detailed information about the contents of a Content Pack, 
start the Content Packs manager and browse to the respective Content Pack. 

The following packages are either installed by default or available separately:

➤ "Oracle Content Pack" on page 734

➤ "Microsoft SQL Server Content Pack" on page 762

➤ "J2EE Application Server Content Pack" on page 848

➤ "Infrastructure Content Pack" on page 782

➤ "Microsoft Active Directory Server Content Pack" on page 918

➤ "Microsoft Exchange Server Content Pack" on page 960

➤ "Microsoft Lync Server 2010 Content Pack" on page 1016

➤ "BlackBerry Enterprise Server Software" Content Pack

A separate document titled "BlackBerry SPI Content Pack" is located at:

<HPBSM_Root_Directory>/AppServer/webapps/site.war/amdocs/eng/
pdfs/BlackBerrySPI_OMicontentpack.pdf

Content Pack Application Monitored

HPOprOra Oracle Database Server

HPOprMss Microsoft SQL Server

HPOprJee J2EE Server (WebSphere Application Server and WebLogic 
Application Server)

HPOprAds Microsoft Active Directory Server

HPOprExc Microsoft Exchange Server

HPOprInf Infrastructure which includes UNIX and Windows operating 
systems, Virtualization Systems, and Cluster Systems

HPOprLys Microsoft Lync Server 2010
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Tasks

How to Upload OO Flows

This task shows you how to upload OO Flows included in Operations 
Management content packs.

To upload OO Flows form Operations Management content packs:

 1 On the HP Business Service Management system where the content packs 
are installed, go to the directory:

<HPBSM_Root_Directory>/conf/opr/oo

 2 Copy the required OO JAR file to a temporary location on a system where 
HP OO Studio (version 07.51.02 or greater) is installed.

The file names take the following form:

HPOprOO<content_name>.jar

For HP OO Studio version 09.00:

➤ HPOprOOADS90.jar for Microsoft Active Directory

➤ HPOprOOEXC90.jar for Microsoft Exchange

➤ HPOprOOInf90.jar for Infrastructure

➤ HPOprOOJEE90.jar for J2EE

➤ HPOprOOMss90.jar for Microsoft SQL Server 

➤ HPOprOOOra90.jar for Oracle

For HP OO Studio version 07.51.02 to 07.60:

➤ HPOprOOADS.jar for Microsoft Active Directory

➤ HPOprOOEXC.jar for Microsoft Exchange

➤ HPOprOOInf.jar for Infrastructure

➤ HPOprOOJEE.jar for J2EE

➤ HPOprOOMss.jar for Microsoft SQL Server 

➤ HPOprOOOra.jar for Oracle
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 3 To install and upload the OO flows, for each required content pack, run 
the command:

java -jar -Xmx1024m “<temp>/HPOprOO<content_name>” 
-centralPassword <centralpassword>

For example:

java -jar -Xmx1024m “<temp>/HPOprOOMss90” -centralPassword 
<centralpassword> 

Note: If the admin user in HP OO is not the default user, another 
parameter is required. For further details about installing content and the 
options available, see the HP Operations Orchestration Software Development 
Kit Guide.

Using HP OO Studio, the uploaded OO flows are accessed under:

../Library/Operations Management/..

 4 From BSM, complete the mapping of OO flows to CIs in:

Admin > Integration > Operations Orchestration

and map the OO flow input variables to CI attributes.

To automatically launch Run Books, see "How to Create a Run Book 
Automation Rule" on page 505.
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31
Databases Content Packs

This chapter includes:

Reference

➤ Oracle Content Pack on page 734

➤ Microsoft SQL Server Content Pack on page 762
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Reference

Oracle Content Pack 

The Oracle Content Pack contains the following artifacts:

➤ Views on page 735

➤ Health Indicators on page 736

➤ Event Type Indicators on page 740

➤ Correlation Rules on page 742

➤ Tool Definitions on page 748

➤ Graph Templates on page 749

➤ Policies Setting ETIs on page 753

➤ Operations Orchestration Flow on page 760



Chapter 31: Databases Content Packs

735

Views
The RTSM package in the Oracle Content Pack includes the following views:

➤ ORA_Deployment: This view refers to the Oracle, Oracle RAC, Computer, 
and File System CI types. The following image shows the relationship 
among the CI types.
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➤ ORA_Network_Deployment: This view refers to the Oracle, Oracle RAC, 
Node, Interface, and File System CI types. The following image shows the 
relationship among the CI types.

Health Indicators
The content pack includes the following Health Indicators (HIs) to monitor 
the Oracle-related events:

CI Type HI Description Value

Database CPU Usage by 
SQL 

Indicates SQL statements with 
high CPU time per execution.

High
Normal

Oracle Database Object 
Status

Indicates database object status. Invalid
Valid
Enabled
Disabled

Oracle Database Segment 
Status

Indicates the status of segments 
in a Oracle Database Instance.

Normal
Inextensible
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Oracle Database Segment 
Usage Level

Indicates the usage of segments 
in a Oracle Database Instance.

High
Normal

Database Database Server 
Status

Indicates database server 
availability.

Up
Down

Oracle Datafiles Status Indicates oracle datafiles status. Online
Offline

Oracle Default 
Bufferpool Busy 
Ratio

Indicates the ratio of buffered 
data requests of the Oracle 
Default Bufferpool.

High
Low

Oracle Default 
Bufferpool Hit 
Ratio

Indicates the ratio of buffered 
data requests of the Oracle 
Default Bufferpool.

High
Normal
Low

Oracle Dictionary Cache 
Miss Ratio

Indicates the effectiveness of the 
Oracle Dictionary Cache.

High
Normal
Low

Oracle Dispatcher Busy 
Ratio by Network

Indicates the workload of the 
Oracle Dispatcher.

High
Normal
Low

Oracle Dispatcher 
Process Queue 
Response Time

Indicates the average time an 
item in the Oracle Dispatcher 
queue waits before being 
processed.

High
Low

Oracle Flash Recovery 
Area Usage Level

Indicates the availability of an 
Oracle Instance as affected by the 
percentage of space used by Flash 
Recovery Area.

High
Medium
Normal

Oracle Library Cache 
Functioning

Indicates the performance of a 
Oracle Database Instance as 
affected by:

 1 - library cache misses to 
executions

 2 -  library cache get hits to gets

 3 -  library cache pin hits to pins

HighReload
LowGetHits
LowPinHits
Normal

CI Type HI Description Value
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Oracle Logical Read Rate Indicates the performance of an 
Oracle Instance as affected by the 
number of logical reads per min.

High
Normal

Oracle Long Table Scans 
Percentage

Indicates the percentage of Long 
Table Scans performed.

High
Normal
Low

Oracle Oracle 
Background 
Dump Device 
Usage Level

Indicates Oracle background 
dump device space usage.

High
Normal

Oracle Oracle Core 
Dump Device 
Usage Level

Indicates Oracle core dump 
device space usage.

High
Normal

Oracle Oracle Opened 
Cursor Current

Indicates the oracle current 
opened cursor.

High
Normal

Oracle Oracle Parse 
Count (Hard) 

Indicates the hard parses during 
this sample period.

High
Normal

Oracle Oracle Parse 
Count (Failures)

Indicates the oracle parse 
failures.

High
Normal

Oracle Oracle Session 
Connect Time

Indicates the connect time for 
the Oracle session.

High
Normal

Oracle Oracle User 
Dump Device 
Usage Level

Indicates Oracle user dump 
device space usage.

High
Normal

Oracle Oracle Users Call 
Rate

Indicates rate of recursive calls to 
user calls and rate of recursive 
calls to cumulative opened 
cursors.

High
Normal

Oracle Physical Read 
Rate

Indicates the performance of an 
Oracle Instance as affected by the 
number of physical reads per 
min.

High
Normal

CI Type HI Description Value



Chapter 31: Databases Content Packs

739

Oracle Row Cache Hit 
Ratio

Indicates the ratio of which row 
data requests could be served 
from the cache.

High
Low

Database Replication Status Indicates database server 
replication status.

Broken
Failed
Up

Database Server Transaction 
Rate

Indicates the rate of transactions 
for the entire database server.

High
Normal

Oracle Shared Pool 
Memory

Indicates the performance of a 
Oracle Database Instance as 
affected by the free space in 
shared pool memory.

Low
Normal

Oracle SQL Disk 
ReadWrite Rate

Indicates SQL statement with 
high disk read-write per 
execution.

High
Normal

Database SQL Query 
Performance 

Indicates SQL statements with 
high elapsed time per execution.

Low
Normal

Oracle Streams Apply 
Status

Indicates the performance of an 
Oracle Instance as affected by 
apply processes having errors in 
an oracle streams environment.

Disabled
Aborted
Normal

Oracle Streams Capture 
Status

Indicates the performance of an 
Oracle Instance as affected by 
capture processes having errors 
in an oracle streams 
environment.

Disabled
Aborted
Normal

Oracle Streams 
Propagation 
Status

Indicates the performance of an 
Oracle Instance as affected by 
propagation processes having 
errors in an oracle streams 
environment.

Disabled
Aborted
Normal

CI Type HI Description Value
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Event Type Indicators
The content pack includes the following Event Type Indicators (ETIs) to 
monitor Oracle-related events:

Oracle Tablespace Temp 
Segment Usage

Indicates the high use of temp 
segments to allocated of 
tablespaces in a Oracle Database 
Instance.

High
Normal

Oracle Tablespaces 
Availability

Indicates the availability of DB 
Tablespaces in a Oracle Database 
Instance.

Online
Offline

Oracle Tablespace 
Physical Read 
Ratio

Indicates the ratio of block to 
physical reads of tablespaces in a 
Oracle Database Instance.

High
Normal

Oracle Tablespace Usage 
Level

Indicates the usage of tablespaces 
in a Oracle Database Instance.

High
Moderate
Normal

Oracle Wait Locked 
Sessions

Indicates the performance of a 
Oracle Database Instance as 
affected by the number of 
sessions held by locks.

High
Normal

Oracle Waits On Redo 
Log Space

Indicates the performance of a 
Oracle Database Instance as 
affected by the number of waits 
for redo log space.

High
Normal

CI Type ETI Description Value

Oracle Archive Status Indicates the status of an 
Oracle Archive Log.

Normal

Oracle Checkpoint Rate Indicates high checkpoint 
rate.

Normal

Oracle Control File 
ReadWrite Status

Indicates oracle control file 
read/write error.

Normal

CI Type HI Description Value
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Oracle Flash Recovery Errors Indicates the errors related to 
flash recovery in an Oracle 
Instance.

Normal

Oracle Heavy SQL 
Statements

Indicates the number of 
heavy SQL statements in an 
Oracle Instance.

Normal

Oracle Latch Contention 
Ratio

Indicates possible latching 
problems.

Normal

Oracle Latch Hit Ratio Indicates possible latching 
problems.

Normal, 
High

Oracle Locks Usage Level Indicates the ratio of locks 
used in an Oracle Database 
Instance.

Normal, 
High

Oracle Materialized View 
Errors

Indicates the errors related to 
materialized views in an 
Oracle Instance.

Normal

Oracle Memory Sort Rate Indicates the ratio of which 
sorts have been performed 
solely on memory. A low 
memory sort ratio implies a 
high disk sort ratio.

Normal

Oracle Oracle Database 
Process Status

Indicates Oracle database 
service/process status.

Running

Oracle Oracle Disk 
ReadWrite Errors 

Indicates oracle disk read 
write errors.

Normal

Oracle Oracle Session Count Indicates oracle session count 
to configured.

Normal

Oracle Streams Errors Indicates the errors in an 
oracle streams environment.

Normal

Database SQL Query Tuning Indicates SQL statements with 
low query tuning.

Normal

CI Type ETI Description Value
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Correlation Rules
The content pack in the Oracle Content Pack includes the following rules to 
correlate Oracle-related events:

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

Database::FileSystem:Disk Usage Level >> Oracle Device Usage Level HIs

Oracle Tablespaces Free 
Space Fragmentation 
Index

Indicates the worse 
fragmented tablespaces in a 
Oracle Database Instance.

Normal, 
Moderate, 
High

Oracle Total Sort Rate Indicates the total sorts on 
disk and in memory in an 
Oracle Database Instance.

Normal

Description: Filesystem usage level impacts Oracle Space Usage (Background, User 
and Core dump device free space)

Cause

CIT: File system ETI: Disk Usage Level Value: Near Capacity

Symptom 1

CIT: Oracle ETI: Oracle Background Dump 
Device Usage Level

Value: High

Symptom 2

CIT: Oracle ETI: Oracle Core Dump Device 
Usage Level

Value: High

Symptom 3

CIT: Oracle ETI: Oracle User Dump Device 
Usage Level

Value: High

CI Type ETI Description Value
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Database::Computer:Memory Usage Level >> Oracle Performance HIs

Database::FileSystem: Oracle Tablespace Usage Level >> Disk Usage 
Level

Description: Memory Usage Impacts Oracle Performance

Cause

CIT: Computer ETI: Memory Usage Level Value: Near Capacity/
Much Higher Than 
Normal

Symptom 1

CIT: Oracle ETI: Dictionary Cache Miss Ratio Value: High

Symptom 2

CIT: Oracle ETI: Library Cache Functioning Value: HighReload, 
LowGetHits,
LowPinHits

Symptom 3

CIT: Oracle ETI: Memory Sort Rate Value: Low

Symptom 4

CIT: Oracle ETI: SQL Query Performance Value: Low

Description: Correlates High Disk Space Usage by Db Tablespace to Near Capacity 
Disk Usage Level of FileSystem

Cause 

CIT: Oracle ETI: Tablespace Usage Level Value: High

Symptom 

CIT: File System ETI: Disk Usage Level Value: Near Capacity
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Database::FileSystem:Oracle Tablespace Temp Segment Usage Level >> 
Disk Usage Level

Database::Computer:Oracle CPU Usage by SQL >> CPU Load

Database::Computer:Oracle Heavy SQL Statement >> CPU Load

Description: Correlates High Disk Space Usage by Db Tablespace Temp Usage to 
Near Capacity Disk Usage Level of FileSystem

Cause 

CIT: Oracle ETI: Tablespace Temp Segment Usage Value: High

Symptom 

CIT: File System ETI: Disk Usage Level Value: Near Capacity

Description: CPU usage by Oracle SQL query and Heavy SQL statements increase 
CPU Load on Computer

Cause 

CIT: Oracle ETI: CPU Usage by SQL Value: High

Symptom 

CIT: Computer ETI: CPU Load Value: Bottlenecked,
Constrained,
Busy,
Overloaded 

Description: Oracle Heavy SQL statements increase CPU Load on Computer

Cause

CIT: Oracle ETI: Heavy SQL Statements Value: High

Symptom 

CIT: Computer ETI: CPU Load Value: Bottlenecked,
Constrained,
Busy,
Overloaded 



Chapter 31: Databases Content Packs

745

Database::Computer: Node Status >> Oracle Database Server Status

Database::Computer: Ping Availability >> Oracle Database Server Status

Database::Interface: InterfaceCommunicationStatus >> Oracle Database 
Broken Jobs

Description: Correlates Unavailability of node to that of Database

Cause 

CIT: Computer ETI: Node Status Value: Down,
Unknown,
Suspended,
Hang

Symptom 

CIT: Oracle ETI: Database Server Status Value: Down

Description: Correlates Unavailability of node to that of Database

Cause 

CIT: Computer ETI: Ping Availability Value: Unavailable

Symptom 

CIT: Oracle ETI: Database Server Status Value: Down

Description: Correlates Interface Communication Status of node to Oracle 
Database Broken Jobs

Cause

CIT: Interface ETI: Interface Communication Status Value: Unavailable

Symptom 

CIT: Oracle ETI: Replication Status Value: Broken
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Database::Interface: InterfaceCommunicationStatus >> Oracle Database 
Failed Jobs

Database::Interface: InterfaceCommunicationStatus >> Oracle Database 
Stream Propagation Error

Database::Interface: InterfaceUtilization >> Oracle Database Replication 
Status

Description: Correlates Interface Communication Status of node to Oracle 
Database Failed Jobs

Cause

CIT: Interface ETI: Interface Communication Status Value: Unavailable

Symptom 

CIT: Oracle ETI: Replication Status Value: Failed

Description: Correlates Interface Communication Status of node to Oracle 
Database Stream Propagation Error

Cause

CIT: Interface ETI: Interface Communication Status Value: Unavailable

Symptom 1

CIT: Oracle ETI: Streams Propagation Status Value: Aborted

Symptom 2

CIT: Oracle ETI: Streams Propagation Status Value: Disabled

Description: Correlates Interface Utilization of node to Oracle Database 
Replication and SQL Query Performance Health

Cause

CIT: Interface ETI: Network IQ Value: High,
Higher Than Normal,
Much Higher Than 
Normal
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Database::Interface: InterfaceUtilization >> Oracle Database SQL Query 
Performance

Symptom 1

CIT: Oracle ETI: Replication Status Value: Broken,
Failed

Symptom 2

CIT: Oracle ETI: Dispatcher Busy Ratio by Network Value: High

Symptom 3

CIT: Oracle ETI: SQL Query Performance Value: Low

Description: Correlates Interface Utilization of node to Oracle Database SQL Query 
Performance

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 

CIT: Oracle ETI: SQL Query Performance Value: Low

Description: Correlates Interface Utilization of node to Oracle Database 
Replication and SQL Query Performance Health
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Tool Definitions
The content pack contains the following tools mapped to the Oracle CI type 
and the Database Operational Tools category.

CI Type Tool

Oracle Archive Device Free Space

Archive Log Write Rate

Background Dump Device Usage Level

Cached Tables

Core Dump Device Usage Level

Database Object Status

Datafiles Status

Disabled Constraints

Disabled Triggers

Flash Recovery Area Usage Level

Global Cache Block Status

Global Cache Blocks Timed Out Count

Oracle Database Connection Check
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Graph Templates
The content pack includes the SPI for Databases - Oracle graph family, 
which is mapped to the Oracle CI type.

Oracle Oracle Product Manuals, starts a web browser and connects 
to the Oracle product manuals web site.

Oracle Segments Near Max Extents

Oracle Segments Not Extendable

Oracle Sessions Waiting For Lock

Shared Pool Memory

Shared Servers Waiting For Requests

SQL Statements CPU Time

SQL Statements Performing Full Table Scans

SQL Statements With High Buffer Gets Per Execution

SQL Statements With High Disk Reads

SQL Statements With High Elapsed Time Per Execution

SQL Statements With High Execution Rate

SQL Statements With High Fetches

SQL Statements With Long Table Scans

Tables And Indexes Unanalyzed

Tablespace Free Space

Tablespaces Fragmented

Tablespaces With High Read

User Dump Device Usage Level

Users Logons

CI Type Tool
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The following table lists the graph templates present in the SPI for Databases 
- Oracle graph family and the mapped policies:

Graph Templates Metric Name Policy Description

Archive Device DBSPI-0058 Percentage of free space on archive device.

Archive Logs DBSPI-0056 Number of archive logs in archive device.

DBSPI-0057 Average time of archive log writes.

Calls DBSPI-0050 Ratio of recursive calls to user calls.

DBSPI-0075 Ratio of recursive calls to cumulative opened 
cursors.

Checkpoints DBSPI-0035 Rate of background checkpoints completed.

DBSPI-0083 Rate of DBWR checkpoints.

Dump Devices DBSPI-0062 Percentage of space used on background 
dump device.

DBSPI-0064 Percentage of space used on user dump 
device.

DBSPI-0065 Percentage of space used on core dump 
device.

DBSPI-0066 Size in MB of alert log.

Initialization 
Limits 

DBSPI-0028 Percentage of DML locks used to total 
configured.

DBSPI-0031 Number of users with percentage of open 
cursors to maximum configured.

DBSPI-0085 Percentage of current transactions to 
configured.

DBSPI-0087 Percentage of current processes to configured.

DBSPI-0089 Percentage of enqueues to configured.



Chapter 31: Databases Content Packs

751

Multi-threaded 
Server

DBSPI-0090 Percentage of busy (average) for all 
dispatchers.

DBSPI-0091 Number of clients currently connected to all 
dispatchers.

DBSPI-0092 Percentage of shared servers waiting for 
requests.

DBSPI-0093 Percentage of busy to max shared server 
processes.

DBSPI-0094 Current percentage of shared pool allocated 
to UGA.

DBSPI-0095 Maximum percentage of shared pool 
allocated to UGA.

DBSPI-0096 Percentage of highwater to max shared server 
processes.

Parallel Query 
Option

DBSPI-0070 Percentage of parallel query servers busy.

DBSPI-0071 Percentage of parallel query servers busy 
highwatermark.

DBSPI-0074 Rate of parallel queries initiated.

DBSPI-0076 Percentage of full table scans using rowid 
range scans compared to total full table scans.

Rollbacks DBSPI-0068 Number of rollback segment shrinks.

DBSPI-0069 Percentage of rollback segment wait.

RollBacks 
Generated

DBSPI-0054 Rate of generated rollbacks.

Redo DBSPI-0032 Number of waits for redo log space.

DBSPI-0033 Percentage of redo allocation latch misses.

DBSPI-0034 Percentage of redo copy latch misses.

Sessions DBSPI-0082 Maximum number of sessions from startup.

Graph Templates Metric Name Policy Description
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Sharedpool DBSPI-0022 Total buffer cache hit percentage.

DBSPI-0023 Current buffer cache hit percentage.

DBSPI-0026 Percentage of cache get misses to gets in 
dictionary cache.

DBSPI-0027 Percentage of library cache misses to 
executions.

DBSPI-0039 Percentage of gethits to gets in dictionary 
cache.

DBSPI-0040 Percentage of pinhits to pins in dictionary 
cache.

DBSPI-0045 Percentage of free pool memory.

DBSPI-0059 Percentage of cursors in cache parameter.

Sorts DBSPI-0019 Disk sort rate.

DBSPI-0052 Rate of total sorts on disk and in memory.

Sorts Memory/
Rows

DBSPI-0020 Percentage of memory sorts.

Tablespace DBSPI-0006 Number of tablespaces with low free space 
percentage.

DBSPI-0007 Number of tablespaces not ONLINE.

DBSPI-0008 Number of tblspaces with high ratio of block 
to physical reads.

DBSPI-0009 Number of tablespaces with high use of temp 
segments to total.

DBSPI-0011 Number of fragmented tablespaces.

DBSPI-0016 Number of segments that cannot extend.

DBSPI-0017 Number of segments approaching max 
extent.

DBSPI-0018 Number of segments adding extents rapidly.

Graph Templates Metric Name Policy Description
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Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

Table Scan DBSPI-0030 Rate at which full table scans (long tables) 
occur.

Tables and 
Indexes

DBSPI-0042 Percentage of the tables and indexes which 
were never analyzed.

DBSPI-0046 Percentage of the rows fetched by index.

DBSPI-0048 Percentage of chained rows fetched.

Waits DBSPI-0021 Percentage of buffer busy waits to logical 
reads.

DBSPI-0024 Percentage of enqueue waits to enqueue 
requests.

DBSPI-0038 Number of latches with high contention ratio 
greater than threshold.

DBSPI-0043 Percentage of enqueue timeouts to enqueue 
requests.

DBSPI-0029 Number of sessions waiting for release of a 
lock.

Graph Templates Metric Name Policy Description
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Note: For more information on the measurement threshold policies and 
events, refer to the HP Operations Smart Plug-in for Databases documents.

ETI/HI Policy Name Policy Description

Archive Status ORA-00270 Error creating archive log.

ORA-00272 Error writing archive log.

ORA-00290 Operating system archiving error.

ORA-00255 Error archiving log.

Background Dump 
Device Usage Level

DBSPI_0062 Background dump device free space is 
low.

Checkpoint Rate DBSPI_0035 Rate of background checkpoints 
completed.

DBSPI_0083 Rate of DBWR checkpoints.

Control File 
ReadWrite Status

ORA-00204 Error reading control file.

ORA-00206 Error writing control file.

ORA-00210 Cannot open control file.

ORA-00221 Error on write to control file.

Oracle Core Dump 
Device Usage Level

DBSPI_0065 Core dump device free space is low.

CPU Usage by SQL DBSPI_0107 Number of seconds used by SQL server to 
total amount of elapsed time since last 
probing:

1. SQL server has excessive load 

2. Thread is in an endless CPU loop

Database Object 
Status

DBSPI_0077 SYS.DUAL status, row status invalid.

DBSPI_0078 Database Objects invalid.
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Oracle Database 
Process Status

DBSPI_0002 The critical Oracle process indicated 
either aborted or was killed.

ORA-00348 Single process redo failure.

ORA-00443 Background process did not start.

ORA-00444 Background process failed while starting.

ORA-00445 Background process did not start after n 
seconds.

ORA-00447 Fatal error in background process.

ORA-00470 LGWR process terminated with error.

ORA-00471 DBWR process terminated with error.

ORA-00472 PMON process terminated with error.

ORA-00473 ARCH process terminated with error.

ORA-00474 SMON process terminated with error.

ORA-00475 TRWR process terminated with error.

ORA-00476 RECO process terminated with error.

ORA-00477 SNPx process terminated with error.

ORA-00480 LCKx process terminated with error.

ORA-00483 During shutdown a process abnormally 
terminated.

Database Segment 
Status

DBSPI_0016 Number of segments that cannot extend.

Database Segment 
Usage Level

DBSPI_0017 Number of segments approaching max 
extent.

Database Server 
Status

DBSPI_0001 Database status check.

Datafiles Status DBSPI_0014 Number of data files not online.

Default Buffer Pool 
Hit Ratio

DBSPI_0022 Total buffer cache hit percentage.

ETI/HI Policy Name Policy Description
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Dictionary Cache 
Miss Ratio

DBSPI_0026 Percentage of cache get misses to gets in 
dictionary cache.

Dispatcher Busy 
Ratio by Network

DBSPI_0090 Average percentage busy for all 
Dispatchers.

Flash Recovery Area 
Usage Level

DBSPI_0136 Percentage of space used by Flash 
Recovery Area.

Flash Recovery Errors ORA-38767 Flashback retention target parameter 
mismatch.

ORA-38776 Cannot begin flashback generation - 
flash recovery area is disabled.

ORA-38786 Recovery area is not enabled.

ORA-38791 Flashback did not start because file string 
was not in a valid incarnation.

ORA-38861 Flashback recovery stopped before 
reaching recovery target.

Heavy SQL 
Statements

DBSPI_0119 Number of heavy SQL statements.

SQL Disk ReadWrite 
Rate

DBSPI_0101 Number of SQL statement with high disk 
reads per execution.

Oracle User Dump 
Device Usage Level

DBSPI_0064 Percentage of space used on user dump 
device.

Latch Contention 
Ratio

DBSPI_0038 Number of latches with high contention 
ratio threshold.

Latch Hit Ratio DBSPI_0033 Percentage of redo allocation latch 
misses.

DBSPI_0034 Percentage of redo copy latch misses.

ETI/HI Policy Name Policy Description
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Library Cache 
Functioning

DBSPI_0027 Percentage of library cache misses to 
executions.

DBSPI_0039 Percentage of gethits to gets in dictionary 
cache.

DBSPI_0040 Percentage of pinhits to pins in 
dictionary cache.

Locks Usage Level DBSPI_0028 Percentage of DML locks used to total 
configured.

Long Table Scan 
Percentage

DBSPI_0103 SQL statements with long table scans.

Logical Read Rate DBSPI_0088 Number of logical reads per minute.

Materialized View 
Errors

ORA-12008 Error in materialized view refresh path.

ORA-12057 Materialized view "string"."string" is 
invalid and must complete refresh.

ORA-12096 Error in materialized view log on 
"string"."string".

ORA-12097 Changes in the master tables during 
refresh. Try refresh again.

ORA-19809 Limit exceeded for recovery files.

ORA-19816 WARNING: Files may exist in location 
that are not known to database.

Memory Sort Rate DBSPI_0020 Percentage of memory sorts.

Oracle Disk Read 
Write Errors

ORA-01114 IO error writing block to file.

ORA-01115 IO error reading block from file.

ORA-01116 Error in opening datafile.

ORA-01242 Data file suffered media failure.

ORA-01243 System tablespace file suffered media 
failure.

ETI/HI Policy Name Policy Description
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Oracle Session Count ORA-00018 Maximum number of sessions exceeded.

ORA-00019 Maximum number of sessions licenses 
exceeded.

ORA-00020 Maximum number of processes 
exceeded.

Oracle Users Call 
Rate

DBSPI_0050 Ratio of recursive calls to user calls.

DBSPI_0075 Ratio of recursive calls to cumulative 
opened cursors.

Physical Read Rate DBSPI_0086 Number of physical reads per minute.

Replication Status DBSPI_0113 Number of broken DBMS jobs.

DBSPI_0114 Number of failed DBMA jobs.

Server Transaction 
Rate

DBSPI_0085 Percentage of current transactions to 
configured.

Shared Pool Memory DBSPI_0045 Percentage of shared pool memory.

SQL Query 
Performance

DBSPI_0106 SQL statement with high elapsed time 
per execution.

SQL Query Tuning DBSPI_0030 Rate at which full table scans (long 
tables) occur.

DBSPI_0042 Percentage of never analyzed tables and 
indexes.

DBSPI_0046 Percentage of rows retrieved by index.

DBSPI_0048 Percentage of chained rows retrieved.

DBSPI_0070 Percentage of busy parallel query servers.

DBSPI_0071 Percentage of busy highwater to 
maximum parallel query servers.

DBSPI_0074 Rate of parallel queries initiated.

DBSPI_0076 Percentage of full table scans using rowid 
range scans compared to total full table 
scans.

ETI/HI Policy Name Policy Description
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Streams Apply Status DBSPI-0143 Monitors the apply processes having 
errors in an oracle streams environment.

Streams Capture 
Status

DBSPI-0141 Monitors the capture processes having 
errors in an oracle streams environment.

Streams Propagation 
Status

DBSPI-0142 Monitors propagation errors in an oracle 
streams environment.

Streams Errors ORA-24093 AQ agent string is not granted privileges 
of database user string.

ORA-26662 Unable to process STREAMS Data 
Dictionary information for object.

ORA-26666 Cannot alter STREAMS process string.

ORA-26671 Maximum number of STREAMS 
processes exceeded.

ORA-26672 Timeout occurred while stopping 
STREAMS process string.

ORA-26713 Remote object does not exist or is 
inaccessible

ORA-26715 Time limit reached.

ORA-26745 Cursors (string) are not sufficient.

ORA-26786 A row with key string exists but has 
conflicting column(s) string in table 
string.

ORA-26816 STREAMS apply process "string" (OS id 
string) is exiting due to ORA-number.

ORA-26819 STREAMS capture server for apply 
"string" and capture "string"encounters 
disabled or aborted propagation "string".

ORA-26826 STREAMS apply coordinator and apply 
slave are unable to communicate.

E144_StrmsA
pplyErrs

Monitors general apply errors in an 
oracle streams environment.

ETI/HI Policy Name Policy Description
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Operations Orchestration Flow 
The following table lists the Oracle Operations Orchestration (OO) Flows: 

Tablespaces 
Availability

DBSPI_0007 Number of tablespaces not ONLINE.

Tablespaces Free 
Space Fragmentation 
Index

DBSPI_0011 Number of fragmented tablespaces.

Tablespace Physical 
Read Ratio

DBSPI_0008 Number of table spaces with high ratio of 
block to physical reads.

Tablespace Temp 
Segment Usage

DBSPI_0009 Number of tablespaces with high use of 
temp segments to total.

Tablespace Usage 
Level

DBSPI_0206 Number of tablespaces with low free 
space percentage.

Total Sort Rate DBSPI_0052 Drill down data for # of segments 
approaching max extent.

Wait Locked Sessions DBSPI_0029 Number of sessions waiting for release of 
a lock

Waits On Redo Log 
Space

DBSPI_0032 Number of waits for redo log space.

OO Flows Flow input CI Type CI attribute Event Attribute

Oracle database 
performance 
check

instance 
omServer

oracle database_dbsid Originating 
Server

Oracle database 
health check

ETI/HI Policy Name Policy Description
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When creating the mapping defined in the preceding table, you can set 
default values for the attributes listed in the following table.

For more information about creating the mapping and a Run Book 
automation rule, see "How to Create a Run Book Automation Rule" on 
page 505.

The user input when executing OO flows is as follows:

omNode: The DNS name of the Oracle node. 

Attribute Description

omServerPort Port number of the HPOM Tool WS.

omServerUser User name for the HPOM Server that will use used in 
the HPOM Tool WS.

omServerPassword Password for the HPOM Server that will use used in the 
HPOM Tool WS.
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Microsoft SQL Server Content Pack

The Microsoft SQL Server Content Pack contains the following artifacts:

➤ Views on page 763

➤ Health Indicators on page 764

➤ Event Type Indicators on page 768

➤ Correlation Rules on page 769

➤ Tool Definitions on page 773

➤ Graph Templates on page 774

➤ Policies Setting ETIs on page 777

➤ Operations Orchestration Flow on page 779
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Views
The RTSM package in the Microsoft SQL Server Content Pack includes the 
following views.

➤ MSSQL_Deployment: This view refers to the SQL Server, File System, and 
Computer CI type. The following image shows the relationship among 
the CI types.
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➤ MSSQL_Network_Deployment: This view refers to the SQL Server, File 
System, Node, and Interface CI type. The following image shows the 
relationship among the CI types.

Health Indicators
The content pack includes the following Health Indicators (HIs) to monitor 
Microsoft SQL Server-related events:

CI Type HI Description Value

SQL Server Cache 
Performance

Indicates cache hit percentage. Low
Normal

Database CPU Usage by 
SQL 

Indicates SQL statements with 
high CPU time per execution.

High
Normal

SQL Server Database 
Deadlock Rate

Indicates the performance of a 
SQL Server instance based on 
the rate of deadlocks in the 
database.

High
Normal
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SQL Server Database 
FileGroup Space 
Usage Level

Indicates availability of a 
Database in the SQL Server 
Instance as the percentage of 
space used per filegroup per 
database and the percentage of 
space available per filegroup 
per database.

High
Medium
Normal

SQL Server Database Latch 
Wait Rate

Indicates the performance of a 
SQL Server instance based on 
number of latch waits.

High
Normal

SQL Server Database Lock 
Timeout Rate

Indicates the performance of a 
SQL Server instance based on 
the rate of deadlocks in the 
database.

High
Normal

SQL Server Database 
Mirroring 
Transaction 
Delay

Indicates the delay in waiting 
for unterminated commit 
acknowledgement.

High
Normal

SQL Server Database Reads 
Outstanding

Indicates the performance of a 
SQL Server instance wrt the 
number of outstanding read 
requests to the host operating 
system.

High
Normal

Database Database Server 
Status 

Indicates database server 
availability.

Down
Up

SQL Server Database Status Indicates the availability of a 
Database in an SQL Server 
Instance.

Down
Up

SQL Server Database Space 
Usage Level

Indicates availability of 
Database in the SQL Server 
Instance as the percentage of 
database space used.

High
Normal

CI Type HI Description Value
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SQL Server Database Writes 
Outstanding

Indicates the performance of a 
SQL Server instance wrt the 
number of outstanding write 
requests to the host operating 
system.

High
Normal

SQL Server Lock Memory 
Used Pct

Indicates percentage of used 
lock memory.

High
Normal

SQL Server Lock Wait Rate Indicates number of lock 
requests per second that could 
not be satisfied immediately 
and required the caller to wait, 
for all object types combined: 
Extent, Key, Page, Table, RID, 
Database. Also indicates 
number of lock requests per 
second that resulted in a 
deadlock.

High
Normal

SQL Server Locks in Use 
Percentage

Indicates percentage total locks 
currently held to the total 
number of locks configured for 
SQL Server.

High
Normal

Database Replication 
Status 

Indicates database server 
replication status.

Broken
Failed
Up

SQL Server Runnable 
Workers Ratio

Indicates the ratio between SQL 
Server workers currently 
running and workers 
potentially runnable. A ratio 
above 100.00 means more 
workers are currently running 
than runnable.

Full Capacity
High
Normal

Database SQL Query 
Performance 

Indicates SQL statements with 
high elapsed time per 
execution.

Long
Normal

CI Type HI Description Value
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SQL Server SQL Server 
Active Cursor

Indicates Microsoft SQL Server 
active cursors.

High
Normal

SQL Server SQL Server 
Cursor Memory 
Usage

Indicates amount of memory 
consumed by cursors.

High
Normal

SQL Server SQL Server 
Database Active 
Transactions

Indicates the number of active 
transactions with the database.

High
Normal

SQL Server SQL Server 
Databases Data 
File Size

Indicates the cumulative size of 
all the data files in the database 
including any automatic 
growth.

High
Normal

SQL Server SQLServer 
Databases 
Transaction Rate

Indicates Number transactions 
started for the database per 
second.

High
Normal

SQL Server SQL Server 
Service Status

Indicates the availability of a 
SQL Server Service that 
corresponds to a given SQL 
Server Instance.

Down
Up

Database Server 
Transaction Rate 

Indicates the rate of 
transactions for the entire 
database server.

High
Normal

SQL Server Transaction Log 
Usage Level

Indicates the availability of an 
SQL Server instance as affected 
by the percentage of 
transaction log space used.

High
Normal

SQL Server Users 
Connected 
Percentage

Indicates percentage of the 
current user connections to the 
total number of user 
connections configured for SQL 
Server.

High
Medium
Normal

SQL Server Virtual Device 
Space Usage 
Level

Indicates percentage of space 
used on a virtual device.

High
Medium
Normal

CI Type HI Description Value
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Event Type Indicators
The content pack includes the following Event Type Indicators (ETIs) to 
monitor Microsoft SQL Server-related events:

CI Type ETI Description Value

SQL Server Database 
Mirroring Status

Indicates mirroring state of 
the SQL Server.

Normal

SQL Server Inactive Database 
Connections

Indicates the number of 
total active and sleeping 
connections in a SQL Server 
instance.

Normal

SQL Server Merge Conflicts Indicates the number of 
conflicts per second during 
Publisher or Subscriber 
upload and download in a 
SQL Server instance.

Normal

Database SQL Query Tuning  Indicates SQL statements 
with low query tuning.

Normal

SQL Server SQL Server Disk 
Read/Write Errors

Indicates SQL Server disk 
read/write errors.

Normal
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Correlation Rules
The content pack includes the following rules to correlate Microsoft SQL 
Server-related events.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

Database::FileSystem:SQLServer Space Usage Level HIs >> Disk Usage 
Level

Database::FileSystem:SQLServer Transaction Log Usage Level HIs >> 
Disk Usage Level

Description: Correlates the High Usage of Virtual Device Space by SQL Server to 
Near Capacity Disk Usage Level of FileSystem

Cause 

CIT: SQL server ETI: Database Space Usage 
Level

Value: High

Symptom

CIT: File System ETI: Disk Usage Level Value: Near Capacity

Description: Correlates the High Usage of Virtual Device Space by SQL Server to 
Near Capacity Disk Usage Level of FileSystem

Cause 

CIT: SQL server ETI: Transaction Log Usage 
Level

Value: High

Symptom

CIT: File System ETI: Disk Usage Level Value: Near Capacity
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Database::FileSystem:SQLServer Virtual Device Space Usage Level HIs >> 
Disk Usage Level

Database::FileSystem:SQLServer FileGroup Space Usage Level HIs >> 
Disk Usage Level

Database::Computer: Node Status >> SQL Server Status

Description: Correlates the High Usage of Virtual Device Space by SQL Server to 
Near Capacity Disk Usage Level of FileSystem

Cause 

CIT: SQL server ETI: Virtual Device Space 
Usage Level

Value: High

Symptom

CIT: File System ETI: Disk Usage Level Value: Near Capacity

Description: Correlates the High Usage of Virtual Device Space by SQL Server to 
Near Capacity Disk Usage Level of FileSystem

Cause 

CIT: SQL server ETI: Database FileGroup Space 
Usage Level

Value: High

Symptom

CIT: File System ETI: Disk Usage Level Value: Near Capacity

Description: Correlates Unavailability of node to that of Database

Cause

CIT: Computer ETI: Node Status Value: Down,
Unknown,
Hang

Symptom

CIT: SQL Server ETI: Database Server Status Value: Down
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Database::Computer:Ping Availability >> SQL Server Status

Database::Computer:SQL Server CPU Usage by SQL >> CPU Load

Database::Computer:Memory Usage Level >> SQL Server SQL 
Performance HIs

Description: Correlates Unavailability of node to that of Database

Cause 

CIT: Computer ETI: Ping Availability Value: Unavailable

Symptom

CIT: SQL Server ETI: Database Server Status Value: Down

Description: CPU usage by MSSQL SQL query increases CPU load on Computer

Cause

CIT: SQL Server ETI: CPU Usage by SQL Value: High

Symptom

CIT: Computer ETI: CPU Load Value: Bottlenecked,
Busy,
Constrained,
Overloaded

Description: Memory Usage Level on host impacts SQL Server Performance

Cause

CIT: Computer ETI: Memory Usage Level Value: Near 
Capacity,
Much Higher Than 
Normal

Symptom 1

CIT: SQL Server ETI: Cache Performance Value: Low

Symptom 2

CIT: SQL Server ETI: SQL Query Performance Value: Low
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Database::Interface: InterfaceCommunicationStatus >> SQLServer 
Database Packet Error

Database::Interface: InterfaceUtilization >> SQLServer Database 
Replication Status

Description: Correlates Interface Communication Status of node to SQL Server 
Database Packet Error

Cause 1

CIT: Interface ETI: Interface Communication 
Status

Value: Unavailable

Cause 2

CIT: Interface ETI: Interface Discard Rate Value: High

Cause 3

CIT: Interface ETI: Interface Error Rate Value: High

Symptom

CIT: SQL Server ETI: SQL Server Disk 
ReadWrite Errors

Value: High

Description: Correlates Interface Utilization of node to SQL Server Database 
Replication and SQL Query Performance Health

Cause 

CIT: Interface ETI: Network IQ Value: High,
Much Higher Than 
Normal

Symptom 1

CIT: SQL Server ETI: Replication Status Value: Broken,
Failed

Symptom 2

CIT: SQL Server ETI: SQL Query Performance Value: Low
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Tool Definitions
The content pack contains the following tools mapped to the SQL Server CI 
type and the Database Operational Tools category.

CI Type Tool

SQL Server Active Connections

Databases Status

Filegroup Space Usage

Locks Wait Rate

Microsoft SQL Server Connection Check, checks the 
connection of the all Microsoft SQL Servers configured to 
the Smart Plug-in for Microsoft SQL Server.

Microsoft SQL Server Documents, starts a web browser and 
connects to the Microsoft SQL Server product manuals web 
site.

Mirroring Status

Network Statistics

Processes Blocked

Replication Agents Status

Replication Latency

Server Statistics

Server Status

Transaction Log Space Usage

Transactions Active

Users Connected

Virtual Device Space Usage
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Graph Templates
The content pack includes the SPI for Databases - Microsoft SQL Server 
graph family, which is mapped to the SQL Server CI type.

The following table lists the graph templates present in the SPI for Databases 
- Microsoft SQL graph family and the mapped policies. 

Graph Templates Metric Name Policy Description

Cache DBSPI_3022 Buffer chain average length

Data Access DBSPI_3051 Full Scans Rate

DBSPI_3052 Index searches rate

DBSPI_3053 Pages allocated rate

DBSPI_3054 Extents allocated rate

DBSPI_3055 Page splits rates

DBSPI_3056 Table lock escalation rate

Errors DBSPI_3023 Number of SQL Server read/write errors 
since the last probing.

DBSPI_3024 Number of packet errors while reading or 
writing packets.

DBSPI_3028 Number of databases marked as suspect.

IO Utilization DBSPI_3007 Number of read requests issued to OS 
that are not completed.

DBSPI_3008 Number of write requests issued to the 
OS not completed.
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Latches DBSPI_3068 Number of latch requests that was not 
immediately granted and had to wait 
before being granted.

DBSPI_3069 Average latch wait time for latch requests 
that had to wait from the time server 
started.

DBSPI_3076 Average latch wait time for latch requests 
that had to wait during the current 
collection interval.

Locks and its 
Memory Utilization 

DBSPI_3013 Percentage of locks in use.

DBSPI_3075 Percentage of lock memory in use.

Lock Requests DBSPI_3070 Lock timeout rate

DBSPI_3071 Deadlocks rate

DBSPI_3072 Locks wait rate

DBSPI_3073 Average lock wait time

Least Recently Used DBSPI_3001 Percentage of times a data page was 
found in the cache.

Server Status DBSPI_3017 Percentage of the command queue 
length used.

DBSPI_3025 Percentage of the CPU time used by SQL 
server.

DBSPI_3074 Batch requests rate

Transactions DBSPI_3009 Server transaction rate

DBSPI_3066 Number of the log expansions for the 
server.

Server Status for 
processes and 
transactions

DBSPI_3014 Number of blocked processes.

DBSPI_3064 Number of active transactions for the 
entire server.

Graph Templates Metric Name Policy Description
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Users DBSPI_3011 Percentage of the current users 
connected.

DBSPI_3026 Percentage of the total connections that 
are active and sleeping.

Graph Templates Metric Name Policy Description
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Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

Note: For more information on the measurement threshold policies and 
events, refer to the HP Operations Smart Plug-in for Databases documents.

ETI/HI Policy Name Policy Description

Cache Performance DBSPI_3001 Percentage of times a data page was 
found in the cache.

CPU Usage by SQL DBSPI_3025 CPU time percentage used by SQL 
Server.

Database Mirroring 
Status

DBSPI_3084 Mirroring state of the Server 
instance.

DBSPI_3085 Unsent log on the principle.

DBSPI_3086 Unrestored log on the mirror.

Database Space Usage 
Level

DBSPI_3218 Percentage of database space used.

Database Status DBSPI_3230 Number of databases marked as 
suspect.

Database Server Status DBSPI_3030 Ability to connect to a database.

SQL Server Disk 
ReadWrite Errors

DBSPI_3023 Number of SQL Server read/write 
errors since the last probing.

DBSPI_3024 Number of packet errors while 
reading or writing packets.

Locks in Use Percentage DBSPI_3013 Percentage total locks currently held 
to the total number of locks 
configured for SQL Server.

Lock Memory Used 
Percentage

DBSPI_3075 Percentage of lock memory in use.
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Database Lock Timeout 
Rate

DBSPI_3070 Lock timeout rate.

Lock Wait Rate DBSPI_3072 Locks wait rate.

Replication Status DBSPI_3081 Replication agents status.

SQL Server Service 
Status

DBSPI_3031 Number of users.

DBSPI_3057 Checks the status of SQL Server 
service.

DBSPI_3058 Checks the status of the SQL Agent 
service.

SQL Query Performance DBSPI_3035 Long running transaction.

SQL Query Tuning DBSPI_3051 Full scans rate.

DBSPI_3052 Index searches rate.

DBSPI_3053 Pages allocation rate.

DBSPI_3054 Extents allocation rate.

DBSPI_3055 Page splits rate.

Users Connected 
Percentage

DBSPI_3011 Percentage of current users 
connected.

Virtual Device Space 
Used

DBSPI_3215 Percentage of space used on a 
specific virtual device.

ETI/HI Policy Name Policy Description



Chapter 31: Databases Content Packs

779

Operations Orchestration Flow 
The following table lists the Microsoft SQL Server Operations Orchestration 
(OO) Flows: 

When creating the mapping defined in the preceding table, you can set 
default values for the attributes listed in the following table.

For more information about creating the mapping and a Run Book 
automation rule, see "How to Create a Run Book Automation Rule" on 
page 505.

The user input when executing OO flows is as follows:

omNode: The DNS name of the Microsoft SQL Server node.

OO Flows Flow input CI Type CI attribute Event Attribute

Microsoft SQL 
Server 
Performance 
check

sqlServerName 
omServer

sqlserver database_dbsid Originating 
Server

Oracle database 
health check

Attribute Description

omServerPort Port number of the HPOM Tool WS.

omServerUser User name for the HPOM Server that will use used in 
the HPOM Tool WS.

omServerPassword Password for the HPOM Server that will use used in the 
HPOM Tool WS.
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32
Infrastructure Content Pack

This chapter includes:

Reference

➤ Infrastructure Content Pack on page 782
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Reference

Infrastructure Content Pack 

Note: You can use the Infrastructure Content Pack with Smart Plug-ins for 
Infrastructure 2.00 suite that includes: Smart Plug-ins for Virtualization 
Infrastructure 2.00, Smart Plug-ins for Systems Infrastructure 2.00, and 
Smart Plug-ins for Cluster Infrastructure 2.00. 

The Infrastructure Content Pack contains the following artifacts:

➤ Views on page 783

➤ Health Indicators on page 790

➤ Event Type Indicators on page 802

➤ Correlation Rules on page 803

➤ Mapping Rules on page 809

➤ Tool Definitions on page 812

➤ Graph Templates on page 817

➤ Systems Infrastructure Graph Templates on page 818

➤ Policies Setting HIs/ETIs on page 832

➤ Operations Orchestration Flow on page 844
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Views
The Infrastructure Content Pack contains the following views:

➤ CPU_Infrastructure: This view refers to the CPU and Computer CI types.

➤ Filesystem_Infrastructure: This view refers to the File System and 
Computer CI types.
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➤ HACluster_Infrastructure: This view refers to the Computer (Windows 
or UNIX), Cluster Software, Clustered Server, Failover Cluster, Software 
Element, and IP Address CI types.
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➤ Infrastructure_Common: This view represents a combined view for the 
HACluster_Infrastructure, Systems_Infrastructure, and 
Virtualization_Infrastructure views.

Note: CPUs and disc devices are shown only for virtualization servers. 
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➤ NetworkInterface_Infrastructure: This view refers to the Network 
Interface and Computer CI types.

➤ Systems_Infrastructure: This view refers to the Computer (Windows or 
UNIX), CPU, File System, Network Interface, and IP Address CI types. The 
following image shows the relationship between the CI types.
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➤  Virtualization_Infrastructure: This view refers to the Computer and 
Hypervisor CI types. The following image shows the relationship between 
the CI types. 



Chapter 32 • Infrastructure Content Pack

788

➤ vMA_Infrastructure: 

➤ NNMi_Layer2: This view displays layer 2 connectivity between servers 
and the switches or routers to which they are connected. The view also 
shows connectivity between the network switches and routers.
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➤ NNMi_Layer3: This view displays layer 3 (IP Subnet) connectivity 
between servers and the switches or routers in the same subnet as the 
servers. The view also shows layer 3 (IP Subnet) connectivity between the 
network switches and routers.

➤ Sol_Zones_Infrastructure: This view refers to the Solaris global and 
non-global zones. The following images shows the relationship between 
the CI types.
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Health Indicators
The content pack includes the following Health Indicators (HIs) to monitor 
Infrastructure-related events:

CI Type HI Description Value

Layer2
Connection

L2Connection
Status 

This incident 
indicates that both (or 
all) ends of a 
connection are not 
responding to SNMP 
queries.

Unavailable, 
Available (default)

VMware 
Cluster 

DRSStatus Enabled (default), 
Disabled 

Node Ping
Availability 

Indicates the 
Processing System is 
reachable through 
ping.

Available (default),

Unavailable

Node NodeStatus Indicates the current 
state of the managed 
node. The states 
Unknown, Hang, and 
Suspended apply only 
to virtual machines.

Up (default), 

Down,

Hang, 

Maintenance, 

Suspended,

Unknown

Computer CPU
Entitlement
UsageLevel

Indicates the 
percentage of 
entitlement (CPU 
cycles allotted) used 
by a virtual machine. 
May exceed 100%.

Much Lower Than 
Normal

Higher Than Normal

Normal (default)

Lower Than Normal

Much Higher Than 
Normal
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Computer CPULoad Indicates if the system 
is undergoing heavy 
processing load.

Normal (default), 

Bottlenecked, 

Overloaded, 

Busy, 

Constrained,

Critical,

Warning

Computer CPURunQueue Indicates the load on 
the processor job 
queue.

Normal (default), 

Overloaded, 

Much Lower Than 
Normal

Higher Than Normal

Lower Than Normal

Much Higher Than 
Normal

Computer HostDisk
Utilization

Indicates the 
utilization level for 
disks.

Normal (default), 

Much Lower Than 
Normal,

Higher Than Normal,

Lower Than Normal,

Much Higher Than 
Normal,

Critical,

Warning

Computer InterfaceError
Rate

Indicates the input 
error rate based on the 
reported change in 
the number of input 
packets and the 
packet error count on 
the interface.

High, 

Normal (default)

CI Type HI Description Value
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Computer Interface
Utilization 

Indicates the network 
utilization based on 
interface speed, and 
the change in number 
of output bytes on the 
interface. The queried 
MIB (Management 
Information Bases) 
values can vary 
depending on the 
speed of the interface 
and whether the 
system supports high 
speed counters for the 
interface.

Normal (default),

Higher Than Normal,

Much Higher Than
Normal,

Much Lower Than 
Normal, 

Lower Than Normal, 

High, 

Low, 

Critical,

Warning

none

Computer Interface
DiscardRate

Indicates the output 
discard rate based on 
the change in the 
number of output 
packets on the 
interface and the 
discarded packet 
count. Packets may be 
discarded due to issues 
like buffer overflows, 
congestion, or system 
specific issues.

Normal (default),

High

CI Type HI Description Value
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Computer MemoryLoad Indicates the memory 
pressure on a 
computer - high 
memory utilization 
and pressure to obtain 
more memory 
through paging. If left 
unattended the 
system may reach 
point of excessive 
paging and an 
unstable state.

Normal (default),

Paging,

Starving for Memory,

Bottleneck, 

Critical,

Warning

Computer MemoryUsage
Level 

Indicates the memory 
usage level for the 
system.

Normal (default), 

Much Lower Than 
Normal,

Much Higher Than 
Normal,

Lower Than Normal,

Higher Than Normal,

NearCapacity,

Low, 

Critical,

Warning

Computer NetworkFile
ShareUsage
Level

Indicates the usage 
level for network file 
shares - MS Windows 
Network Drives 
(mounts) and NFS, 
CIFS mounts.

Normal (default),

Near Capacity

Computer PageFile_Usage
WIN

Indicates how much 
of the paging file 
capacity is used on a 
Window.

Normal (default),

High,

Near Capacity

CI Type HI Description Value
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Computer Virtualization
Overhead 

Indicates the 
additional memory 
used by the VMware 
ESX/ ESXi server to 
store the runtime 
information for 
virtual machines. 
Typically there is little 
variation in the value. 
The variation depends 
on size of the memory 
and the operating 
system running on 
the virtual machine. 

Normal (default), 

Much Lower Than 
Normal,

Much Higher Than 
Normal, 

Lower Than Normal, 

Higher Than Normal 

Computer ResourceUsage Indicates the system 
resource (CPU and 
memory) used by the 
processes and services 
running on the 
system.

Normal (default), 

High

Computer Root_disk_
Usage_level

Indicates the disk 
usage on primary 
(root) disk on system. 
This would refer to 
space utilization on 
root (/) filesystem on 
UNIX and Linux 
systems. This would 
refer to C: or whatever 
is defined using 
SystemDrive setting 
on Windows systems.

Normal (default),

High

CI Type HI Description Value
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Computer SwapUsage
Level

Indicates the swap 
space usage level on 
the system.

Normal (default), 

NearCapacity, 

Much Higher Than 
Normal, 

Much Lower Than 
Normal, 

Higher Than Normal, 

Lower Than Normal 

Computer KernelHandles
Usage

Indicates capacity 
utilization by the 
kernel handles such as 
file handles, process 
handles, semaphores, 
and message queues.

Normal (default),

NearCapacity

Computer BatchJobService Indicates the 
availability of the 
batch job services on 
the system such as 
Schedule Task Service 
on MS Windows, and 
Cron services on 
UNIX/ Linux.

Available (default), 

Unavailable 

Computer EventLogging
Service 

Indicates the 
availability of event 
logging services on 
the system such as 
event log service on 
MS Windows, and 
syslog services on 
UNIX/ Linux.

Available (default), 

Unavailable

CI Type HI Description Value
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Computer PrintService Indicates the status of 
print services on the 
system such as the 
print spooler service 
on MS Windows, 
print server role 
services on windows 
2008, and lp and 
cupsd services on 
UNIX/Linux.

Available (default), 

Unavailable

Computer FileServer
Service 

Indicates the status of 
the file server services 
on the system such as 
FileServer role services 
on MS Windows, and 
NFS server and CIFS 
server services on 
UNIX/ Linux.

Available (default), 

Unavailable

Computer EmailService Indicates the status of 
E-Mail service on the 
system such as SMTP 
service on MS 
Windows, and 
sendmail, delivermail 
services on UNIX/ 
Linux.

Available (default), 

Unavailable

Computer WebServer
Service 

Indicates the status of 
web server services on 
system such as IIS 
services on MS 
Windows, and Apache 
service on Linux/ 
UNIX.

Available (default), 

Unavailable

Computer RPCService Indicates the 
availability of the RPC 
service on the system.

Available (default), 

Unavailable

CI Type HI Description Value
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Computer FirewallService Indicates the status of 
firewall service on the 
system such as 
Windows Firewall 
service on MS 
Windows and iptables 
service on Linux.

Available (default), 

Unavailable

Computer DNSService Indicates the status of 
DNS (Domain 
Nameserver) service 
on the system.

Available (default), 

Unavailable

Computer FTPService Indicates the state of 
FTP services on the 
system. FTP protocol 
is used for transferring 
files between systems.

Available (default), 

Unavailable

Computer DHCPServer
Service 

Indicates the status of 
DHCP Server Service 
on the DHCP server 
system.

Available (default), 

Unavailable

Computer SecureLogin
Service 

Indicates the 
availability of SSH 
(Secure Shell) service 
on the system.

Available (default), 

Unavailable

Unix Filesystem
Usage 

Indicates the file 
system usage on the 
UNIX system.

Normal (default), 

High 

Unix SwapSpace
Available 

Indicates the swap 
space available on the 
system.

Normal (default), 

Depleted,

Near Capacity

Windows LogicalDisk
FreeSpaceWIN 

Indicates the degree of 
logical free disk space 
on the system.

Normal (default),

Near Capacity 

CI Type HI Description Value
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Windows TerminalServer
Service 

Indicates the status of 
services for Windows 
Terminal Server on 
the MS Windows 
system.

Available (default), 

Unavailable

Cluster
Resource
Group

Cluster Resource 
Group Status

Indicates the status of 
the resource group in 
a failover cluster.

Online (default)

Failed, 

Offline,

Reached SPOF 
condition

CPU CPUUsage
Level

Indicates the CPU 
usage level.

Normal (default),

Idle,

Busy,

Spike,

Much Higher Than 
Normal,

Much Lower Than 
Normal,

Higher Than Normal, 

Lower Than Normal,

High 

File System DiskUsage
Level 

Indicates the disk 
usage level.

Normal (default),

NearCapacity, 

Low

Disk Device DiskUtilization Indicates the disk 
utilization level.

Normal (default),

Much Higher Than 
Normal,

Much Lower Than 
Normal,

Higher Than Normal,

Lower Than Normal 

CI Type HI Description Value
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Disk Device DiskService
Time

Indicates the average 
of disk I/O service 
time.

Normal (default),

Much Higher Than 
Normal,

Much Lower Than 
Normal,

Higher Than Normal,

Lower Than Normal

Interface InterfaceError
Rate 

Indicates the input 
error rate based on the 
change in the number 
of input packets on 
the interface and the 
packet error count. 

Normal (default),

High

Interface Interface
Utilization 

Indicates the network 
utilization based on 
the interface speed, 
and the change in the 
number of output 
bytes on the interface. 
The queried MIB 
(Management 
Information Base) 
values vary based on 
the speed of the 
interface and whether 
the system supports 
high speed counters 
for interface.

Normal (default),

Lower Than Normal, 

Much Lower Than 
Normal,

High, 

Higher Than Normal, 

Much Higher Than 
Normal,

Low,

None 

CI Type HI Description Value
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Interface Interface
DiscardRate 

Indicates the output 
discard rate based on 
the change in the 
number of output 
packets on the 
interface and the 
discarded packet 
count. Packets may be 
discarded due to 
reasons such as 
receive buffer 
overflows, congestion, 
or system specific 
issues.

Normal (default),

High

Interface Interface
Communication
Status 

Indicates the 
availability status of 
the interface.

Available (default), 

Unavailable

IpAddress AddressStatus Indicates the 
availability status of 
the IpAddress.

Available (default), 

Unavailable 

Cluster 
Software 

Cluster
Software
Service 

Indicates the 
availability status of 
the Cluster Service.

Available (default), 

Unavailable

Failover 
Cluster

Cluster
Strength 

Indicates the cluster 
availability status 
based on node 
strength.

QuorumMet (default),

NotAllNodesDown,

RedundantOkay,

QuorumNotMet,

SPOF,

AllNodesDown

CI Type HI Description Value
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VMware 
ESX Server

VMFSUsage
Level 

Indicates the usage 
level of the VMFS 
(Virtual Machine File 
System). VMFS is a 
clustered file system 
that is used by the 
VMware host systems 
to store virtual 
machines and virtual 
disk files.

Normal (default),

NearCapacity

VMware 
ESX Server

VMwareHost
NetworkUsage

Data on all network 
interfaces, received at 
or dispatched from 
the VMware ESX/ESXi 
Host (in MBs).

Normal (default),

Much Higher Than 
Normal,

Much Lower Than 
Normal,

Higher Than Normal,

Lower Than Normal

Hypervisor Virtualization
Service 

Indicates the status of 
virtualization service 
running on Host such 
as Hyper-V service 
running on MS 
Windows 2008 Server. 
The service is essential 
for running of virtual 
machines.

Available (default), 

Unavailable 

CI Type HI Description Value
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Event Type Indicators
The Content Pack includes the following Event Type Indicators (ETIs) to 
monitor Infrastructure-related events. The CI Type is Computer: 

ETI Description Value

Batch Jobs Indicates when one or more scheduled tasks/
cron jobs fail on the system.

Failed

VMCreation Indicates when a VM is created. Occurred 

VMMigration Indicates when a VM is migrated. Occurred

VMRemoval Indicates when a VM is removed. Occurred

VMRename Indicates when a VM is renamed. Occurred

BatchJobService Indicates availability of the Batch Job Service 
(UNIX/Linux Cron, Windows Schedule Task 
Services)

Available

Unavailabl
e

DHCPServerService Indicates status of the DHCP Server Service 
on the DHCP server system. This can be a 
very crucial service for many mobile users

Available

Unavailabl
e

DNSService Indicates status of the DNS (Domain 
Nameserver) service. Multiple network 
dependent services could potentially fail if 
this service undergoes unplanned downtime

Available

Unavailabl
e

EventLoggingServi
ce

Indicates availability of the Even Logging 
service (UNIX/Linux syslog, Windows Event 
Logger services)

Available

Unavailabl
e

SecureLoginService Indicates availability of the SSH (Secure 
Shell) service on the host

Available

Unavailabl
e

WebServerService Indicates status of the Web Server service on 
the system. Associated services are IIS on 
Windows and Apache on Linux/UNIX

Available

Unavailabl
e
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Correlation Rules
The content pack includes the following rules to correlate Infrastructure- 
related events.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

System:Computer:CPU Load >> CPU Usage Level

System::Computer:Memory Load >> CPU Load

System::Computer:Memory Load >> Memory Usage Level

Description: CPU usage of one or more CPUs on the system is high as the system is 
in a CPU bottleneck.

Cause

CIT: Computer ETI: CPU Load Value: Bottlenecked

Symptom

CIT: CPU ETI: CPU Usage Level Value: High/ Much 
Higher Than 
Normal/ Spike

Description: CPU bottleneck caused by paging

Cause

CIT: Computer ETI: Memory Load Value: Paging

Symptom

CIT: Computer ETI: CPU Load Value: Bottlenecked

Description: Memory usage on system is high as the system is in a memory 
bottleneck

Cause

CIT: Computer ETI: Memory Load Value: Paging
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System::Computer:Memory Usage Level >> Swap Usage Level

System Down >> System Applications Down

Symptom 

CIT: Computer ETI: Memory Usage Level Value: Much Higher 
Than Normal/ Near 
Capacity

Description: High memory usage results in swapping

Cause

CIT: Computer ETI: Memory Usage Level Value: Near Capacity

Symptom

CI: Computer ETI: Swap Usage Level Value: Much Higher 
Than Normal/ Near 
Capacity

Description: Services or applications are unavailable as the system is down

Cause

CIT: Computer ETI: Node Status Value: Down/ 
Suspended

Symptom

CI: Computer ETI: Value: 

Batch Jobs Job Failed

E-Mail Service Unavailable

Event Logging Service Unavailable

Firewall Service Unavailable

Ping Availability Unavailable

Print Services Unavailable

Description: Memory usage on system is high as the system is in a memory 
bottleneck
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System::Computer:Resource Usage >> CPU Usage Level

System::Computer:Resource Usage >> Memory Usage Level

System::File System:Disk Usage Level >> Swap Usage Level

Description: Process using high amount of cpu on system causing system cpu 
usage high

Cause

CIT: Computer ETI: Resource Usage Value: High

Symptom

CIT: CPU ETI: CPU Usage Level Value: High/ Much 
Higher Than 
Normal/ Spike

Description: Process using high amount of memory on system causing system 
memory usage high

Cause

CIT: Computer ETI: Resource Usage Value: High

Symptom

CIT: Computer ETI: Memory Usage Level Value: Higher Than 
Normal/ Much 
Higher Than 
Normal/ Near 
Capacity

Description: Swap usage caused by system drive full

Cause

CIT: FileSystem ETI: Disk Usage Level Value: Near Capacity
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System::Node:PingAvailability >> NodeStatusl

System::File System:PingAvailability >> InterfaceCommunicationStatus

Virtual::Computer:Memory Usage Level >> Hypervisor Memory Usage Level

Symptom

CIT: Computer ETI: Swap Usage Level Value: Higher Than 
Normal/ Much 
Higher Than 
Normal/ Near 
Capacity

Description: Ping availability of node failed because node is down

Cause

CIT: Computer ETI: Ping Availability Value: Down

Symptom

CIT: Computer ETI: Ping Availability Value: Unavailable

Description: Node can not be pinged because interface communication status is 
unavailable

Cause

CIT: Interface ETI: Interface Communication 
Status

Value: Unavailable

Symptom

CIT: Interface ETI: Ping Availability Value: Unavailable

Description: Hypervisor is constrained by high memory usage done by VM

Cause

CIT: Computer ETI: Memory Usage Level Value: Much Higher 
Than Normal

Description: Swap usage caused by system drive full
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Virtual::Computer::CPU Usage >> Hypervisor System CPU Load

Hypervisor::Ping Availability >> VM::Ping Availability

Cluster Software Service Unavailable >> Clustered Server Offline

Symptom

CIT: Computer ETI: Memory Usage Level Value: Much Higher 
Than Normal/ Near 
Capacity

Description: A VM using high amount of physical CPU cycles on the hypervisor can 
cause bottleneck in Hypervisor.

Cause

CIT: Computer ETI: CPU Load Value: Bottlenecked/ 
Busy/ Overloaded

Symptom

CIT: Computer ETI: CPU Load Value: Bottlenecked/ 
Busy/ Overloaded

Description: VMs are unavailable as the hypervisor host running the VMs is down

Cause

CIT: Computer ETI: Ping Availability Value: Unavailable

Symptom

CIT: Computer ETI: Ping Availability Value: Unavailable

Description: Cluster software Services on cluster systems failing to run causes clustered 
servers (resource groups) to be inactive

Cause

CIT: ClusterSoftware ETI: Cluster Software Service Value: Unavailable

Description: Hypervisor is constrained by high memory usage done by VM
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Cluster Nodes Down >> Cluster Resource Group Impacted

Cluster Members Down >> FailoverCluster Impacted (many symptoms)

Symptom

CIT: 
ClusterResourceGroup

ETI: Cluster Resource Group 
Status

Value: Offline

Description: When 1 or more cluster nodes are down, clustered servers (resource 
groups) running in failover mode on these nodes are impacted

Cause

CIT: Computer ETI: Node Status Value: Down/ Hang/ 
Suspended/ 
Unknown

Symptom

CIT: 
ClusterResourceGroup

ETI: Cluster Resource Group 
Status

Value: Offline

Description: When a few cluster members are unavailable, the cluster is down.

Cause

CIT: Computer ETI: Node Status Value: Down/ Hang/ 
Suspended/ 
Unknown

Symptom

CIT: FailoverCluster ETI: Cluster Strength Value: All Nodes 
Down/ Quorum Not 
met/ SPOF

Description: Cluster software Services on cluster systems failing to run causes clustered 
servers (resource groups) to be inactive
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Cluster Member Down >> Cluster Software Service Down

Mapping Rules
The content pack contains the following mapping rules:

Description: When the cluster member is down, the cluster software service on the 
node is down.

Cause

CIT: Computer ETI: Node Status Value: Down/ 
Suspended

Symptom

CIT: ClusterSoftware ETI: Cluster Software Service Value: Unavailable

CI Type: ClusterSoftware

Name Description Event Filter Indicator
Map to 
Indicato
r Value

hadUnAvailability VCS cluster 
process 
monitor

HADMajor Cluster 
Software 
Service

Based 
on 
Severity

hadAvailability VCS cluster 
process 
Availability

HADNormal Cluster 
Software 
Service

Based 
on 
Severity

hashadow
Unavailability

VCS cluster 
process 
Unavailability

Hashadow
Major

Cluster 
Software 
Service

Based 
on 
Severity

hashadow
Availability

VCS cluster 
process 
availability

Hashadow
Normal

Cluster 
Software 
Service

Based 
on 
Severity

HadUnavailability
Windows

VCS cluster 
Windows Had 
process 
Unavailability

HadWindows
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity
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HadAvailability
WindowsFilter

VCS windows 
cluster service 
"Had" 
availability

HadWindows
AvailableFilter

Cluster 
Software 
Service

Based 
on 
Severity

VCSComm
UnAvailability

VCS cluster 
process 
"VCSComm" 
UnAvailability

VCSComm
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

VCSCommAvailable VCS Cluster 
Windows 
process 
availability

VCSComm
AvailableFilter

Cluster 
Software 
Service

Based 
on 
Severity

CmdServer
UnAvailable

VCS Windows 
Cluster service 
"CmdServer" 
Unavailable

CmdServer
UnAvailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

 CmdServerAvailable VCS Windows 
cluster service 
"CmdServer" 
availability

CmdServer
Availability
Filter

Cluster 
Software 
Service

Based 
on 
Severity

clusterUnavailability Sun cluster 
process 
Unavailability

Cluster
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

clusterAvailability Sun cluster 
process 
availability

Cluster
Available
Filter

Cluster 
Software 
Service

Based 
on 
Severity

clurgmgrd
Unavailability

Red Hat cluster 
process 
"clurgmgrd" 
unavailability

clurgmgrd
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

clurgmgrd
Availability

Red Hat cluster 
process 
"clurgmgrd" 
availability

clurgmgrd
AvailableFilter

Cluster 
Software 
Service

Based 
on 
Severity

CI Type: ClusterSoftware
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ccsdUnavailability Red Hat cluster 
process /sbin/
ccsd process 
unavailability

ccsd
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

ccsdAvailable Red Hat cluster 
process /sbin/
ccsd process 
availability

ccsdAvailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

ClusSvcUnavailabilit
y

Microsoft 
cluster service 
"ClusSvc" 
unavailability

ClusSvc
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

ClusSvcAvailability Microsoft 
cluster service 
"ClusSvc" 
availability

ClusSvc
Available
Filter

Cluster 
Software 
Service

Based 
on 
Severity

cmcldUnavailability MCSG cluster 
process "cmcld" 
unavailability

cmcld
Unavailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

cmcldAvailability MCSH cluster 
process 
“cmcld” 
availability

cmcldAvailable
Filter

Cluster 
Software 
Service

Based 
on 
Severity

CI Type: ClusterSoftware
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Tool Definitions
The content pack contains the following tools of CI Type UNIX:

CI Type: Node

Name Description Event Filter Indicator
Map to 
Indicator 
Value

Ping
Unavailability

Indicates failure 
to contact node 
using ping

Ping
UnAvailibilty
Filter

Ping 
Availability

Based on 
Severity

PingAvailability Indicates node 
can be 
contacted using 
ping.

Ping
UnAvailibilty
Filter

Ping 
Availability

Based on 
Severity

CI Type Tool Name Tool Description

Node Ping node from 
NNMi server

Shows the output of a ping from the NNMi 
server to a selected node in a web browser.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Ping node from 
NNMi server (https)

Shows the output of a ping from the NNMi 
server to a selected node in a web browser, 
using https connection.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.
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Node Show Layer 2 
Neighbors to 
related NNMi node

Shows the Layer 2 Neighbors of the node from 
which the corresponding NNMi incident 
originated.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Show Layer 2 
Neighbors to 
related NNMi node 
(https)

Shows the Layer 2 Neighbors of the node from 
which the corresponding NNMi incident 
originated, using https connection.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Show Layer 3 
Neighbors to 
related NNMi node

Shows the Layer 3 Neighbors of the node from 
which the corresponding NNMi incident 
originated.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Show Layer 3 
Neighbors to 
related NNMi node 
(https)

Shows the Layer 3 Neighbors of the node from 
which the corresponding NNMi incident 
originated, using https connection.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

CI Type Tool Name Tool Description
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Node Show NNMi 
console

Shows the main console of the NNMi server in 
a web browser.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Show NNMi 
console (https)

Shows the main console of the NNMi server in 
a web browser, using https connection.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Show NNMi server 
status

Shows the status of the NNMi server processes 
and services in a web browser.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Show NNMi server 
status (https)

Shows the status of the NNMi server processes 
and services in a web browser, using https 
connection.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Show node 
information in 
NNMi

Shows the setup information of a selected 
node in a web browser.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

CI Type Tool Name Tool Description
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Node Show node 
information in 
NNMi (https)

Shows the setup information of a selected 
node in a web browser, using https 
connection.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Show related NNMi 
incident

Shows the corresponding NNMi incident to a 
selected message in a web browser.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Show related NNMi 
incident (https)

Shows the corresponding NNMi incident to a 
selected message in a web browser, using https 
connection.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Show related NNMi 
node

Shows the NNMi setup information for the 
node from which the corresponding NNMi 
incident originated.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

CI Type Tool Name Tool Description
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Node Show related NNMi 
node (https)

Shows the NNMi setup information for the 
node from which the corresponding NNMi 
incident originated, using https connection.

Note: This tool requires that it is started in the 
context of a forwarded NNMi incident, so that 
the message contains custom message 
attributes about the NNMi incident UUID, 
NNMi server name and the NNMi server port.

Node Traceroute to node 
from NNMi server

Shows the output of a traceroute from the 
NNMi server to a selected node in a web 
browser.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

Node Traceroute to node 
from NNMi server 
(https)

Shows the output of a traceroute from the 
NNMi server to a selected node in a web 
browser, using https connection.

Note: This tool requires that the NNMi server 
name and port are correctly configured in the 
"HP NNMi adapter" section of the general 
server configuration GUI.

UNIX VMware List VMs Lists the Virtual Machines configured on ESX/
ESXi servers managed by vMA.

UNIX VMware Host Info Lists information of the ESX/ESXi servers 
managed by vMA.

UNIX VMware Resource 
Pool Info 

Lists information of the Resource Pools 
associated with ESX/ESXi servers managed by 
vMA.

UNIX VMware List 
Suspended VMs 

Lists suspended and powered off Virtual 
Machines of ESX/ESXi servers managed by 
vMA

CI Type Tool Name Tool Description
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Graph Templates
The content pack includes the Systems Infrastructure and Virtualization 
Infrastructure graph family, which is mapped to the Computer CI type. 

Note: The Virtualization Infrastructure graph family is visible for all nodes 
under the CI type Computer, however you can launch graphs only for 
virtual machines.
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Systems Infrastructure Graph Templates
The following table lists the graph templates for System Infrastructure.

Graph Templates for 
Systems Infrastructure Metric Name

Configuration Details GBL_SYSTEM_ID

GBL_OSNAME

GBL_OSRELEASE

GBL_MACHINE_MODEL

GBL_COLLECTOR

GBL_NUM_CPU

GBL_NUM_DISK

GBL_NUM_NETWORK

GBL_MEM_PHYS

GBL_SWAP_SPACE_AVAIL_KB

TBL_PROC_TABLE_AVAIL

GBL_LOGGING_TYPES

GBL_THRESHOLD_CPU

GBL_THRESHOLD_PROCMEM

GBL_THRESHOLD_DISK

GBL_LOGFILE_VERSION

GBL_MACHINE

GBL_OSKERNELTYPE_INT

GBL_MEM_AVAIL

TBL_BUFFER_CACHE_AVAIL

GBL_OSVERSION

MEMORY_MEMFREE

MEMORY_AVAILABLE__MBYTES



Chapter 32 • Infrastructure Content Pack

819

Configuration Details MEMORY_MEMTOTAL

MEMORY_SWAP_AVAIL

MEMORY_SWAP_FREE

Free swap space available

Process Details PROC_PROC_NAME

PROC_PROC_CMD

PROC_PROC_ID

PROC_CPU_TOTAL_UTIL

PROC_DISK_PHYS_IO_RATE

PROC_INTEREST

PROC_STOP_REASON

PROC_APP_ID

PROC_PRI

PROC_MEM_RES

PROC_MEM_VIRT

PROC_CPU_USER_UTIL

PROC_CPU_SYS_MODE_UTIL

PROC_PARENT_PROC_ID

PROC_USER_NAME

PROC_RUN_TIME

PROC_INTERVAL_ALIVE

PROCESS_PID

PROCESS

PROCESS_CPU0D37

PROCESS_MEMSIZE

Graph Templates for 
Systems Infrastructure

Metric Name
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Process Details PROCESS_USER

PROCESS_PPID

PROCESS_0D37__PROCESSOR__TIME

PROCESS_IO__DATA__OPERATIONS_SEC

PROCESS_PRIORITY__BASE

PROCESS_PRIVATE__BYTES

PROCESS_VIRTUAL__BYTES

PROCESS_0D37__USER__TIME

PROCESS_CREATING__PROCESS__ID

PROCESS_ELAPSED__TIME

CPU Gauges GBL_CPU_TOTAL_UTIL

CPU Utilization Baseline GBL_CPU_TOTAL_UTIL

CPU Summary GBL_CPU_INTERRUPT_UTIL

GBL_CPU_SYS_MODE_UTIL

GBL_CPU_USER_MODE_UTIL

CPU__UTILIZATION_0D37SYS

CPU__UTILIZATION_0D37USER

PROCESSOR_0D37__INTERRUPT__TIME

Graph Templates for 
Systems Infrastructure

Metric Name
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Disk Summary GBL_DISK_UTIL_PEAK

GBL_FS_SPACE_UTIL_PEAK

GBL_DISK_PHYS_BYTE_RATE

GBL_DISK_PHYS_IO_RATE

GBL_DISK_LOGL_READ_RATE

BLOCK__DEVICE__ACTIVITY_R0D43W_S

PHYSICALDISK_DISK__BYTES_SEC

LOGICALDISK__READS_SEC

Global CPU Forecast GBL_CPU_TOTAL_UTIL

Global Details GBL_CPU_TOTAL_UTIL

GBL_ACTIVE_PROC

GBL_PRI_QUEUE

GBL_RUN_QUEUE

GBL_DISK_UTIL_PEAK

GBL_DISK_PHYS_IO_RATE

GBL_DISK_PHYS_BYTE_RATE

GBL_DISK_LOGL_IO_RATE

GBL_MEM_CACHE_HIT_PCT

GBL_MEM_PAGEOUT_RATE

GBL_MEM_SWAPOUT_RATE

GBL_MEM_UTIL

GBL_MEM_USER_UTIL

GBL_MEM_SYS_AND_CACHE_UTIL

GBL_SWAP_SPACE_UTIL

Graph Templates for 
Systems Infrastructure

Metric Name
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 Global Details GBL_FS_SPACE_UTIL_PEAK

GBL_NET_PACKET_RATE

GBL_NET_IN_PACKET_RATE

GBL_NET_OUT_PACKET_RATE

GBL_NFS_CALL_RATE

GBL_NET_COLLISION_1_MIN_RATE

GBL_NET_ERROR_1_MIN_RATE

GBL_SYSCALL_RATE

GBL_CPU_SYS_MODE_UTIL

GBL_CPU_USER_MODE_UTIL

GBL_NUM_USER

GBL_ALIVE_PROC

GBL_STARTED_PROC_RATE

CPU__UTILIZATION_0D37USR

CPU__UTILIZATION_0D37SYS

SYSTEM__SWAPPING__AND__SWITCHING
__ACTIVITY_SWPOT_S

SYSTEM__SWAPPING__AND__SWITCHING
__ACTIVITY_SWPIN_S

PAGING__ACTIVITY_PGIN_S

PAGE0D45OUT__AND__MEMORY__FREEING
__ACTIVITIES_PGOUT_S

5MINAVG

MEMORY_FREEMEM

MEMORY_PERCENT__USED

BLOCK__DEVICE__ACTIVITY_R0D43W_S

Graph Templates for 
Systems Infrastructure

Metric Name
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 Global Details CACHE_COPY__READ__HITS__0D37

SYSTEM_SYSTEM__CALLS_SEC

SYSTEM_PROCESSOR__QUEUE__LENGTH

Global History GBL_CPU_TOTAL_UTIL

GBL_DISK_UTIL_PEAK

GBL_SWAP_SPACE_UTIL

GBL_MEM_UTIL

GBL_ACTIVE_PROC

Global Run Queue 
Baseline

GBL_RUN_QUEUE

SCALLS_S

5MINAVG

SYSTEM_PROCESSOR__QUEUE__LENGTH

Memory Summary GBL_MEM_UTIL

GBL_MEM_USER_UTIL

GBL_MEM_SYS_AND_CACHE_UTIL

GBL_MEM_CACHE_HIT_PCT

GBL_MEM_QUEUE

GBL_MEM_SWAPOUT_RATE

GBL_MEM_PAGEOUT_RATE

GBL_MEM_PG_SCAN_RATE

MEMORY_SWAP_FREE

MEMORY_MEMFREE

MEMORY_PERCENT__USED

SYSTEM__SWAPPING__AND__SWITCHING
__ACTIVITY_SWPOT_S

Graph Templates for 
Systems Infrastructure

Metric Name
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Memory Summary CACHE_COPY__READ__HITS__0D37

Multiple Global Forecasts GBL_CPU_TOTAL_UTIL

GBL_DISK_UTIL_PEAK

GBL_SWAP_SPACE_UTIL

GBL_RUN_QUEUE

GBL_MEM_PAGEOUT_RATE

GBL_NET_IN_PACKET_RATE

GBL_NET_OUT_PACKET_RATE

GBL_ACTIVE_PROC

5MINAVG

SYSTEM_PROCESSOR__QUEUE__LENGTH

Network Summary GBL_NET_OUT_PACKET_RATE

GBL_NET_IN_PACKET_RATE

GBL_NET_ERROR_RATE

Seasonal CPU Forecast GBL_CPU_TOTAL_UTIL

System Configuration GBL_SYSTEM_ID

GBL_MACHINE

GBL_MACHINE_MODEL

GBL_CPU_CLOCK

GBL_OSNAME

GBL_OSVERSION

GBL_OSRELEASE

GBL_MEM_PHYS

GBL_ACTIVE_CPU

Graph Templates for 
Systems Infrastructure

Metric Name
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System Configuration GBL_NUM_CPU

GBL_NUM_DISK

GBL_NUM_NETWORK

GBL_COLLECTOR

GBL_SWAP_SPACE_AVAIL

GBL_LOGGING_TYPES

GBL_THRESHOLD_CPU

GBL_GMTOFFSET

MEMORY_SWAP_FREE

MEMORY_MEMTOTAL

CPU Comparison GBL_CPU_TOTAL_UTIL

Disk Throughput BYDSK_PHYS_BYTE_RATE

LOGICALDISK_DISK__BYTES_SEC

Individual Networks BYNETIF_IN_BYTE_RATE

BYNETIF_OUT_BYTE_RATE

BYNETIF_IN_PACKET_RATE

BYNETIF_OUT_PACKET_RATE

NETWORK__INTERFACE_IPKTS

NETWORK__INTERFACE_OPKTS

NETWORK__INTERFACE_IPACKETS

NETWORK__INTERFACE_OPACKETS

Individual CPUs BYCPU_CPU_TOTAL_UTIL

Disk Space FS_SPACE_UTIL

Graph Templates for 
Systems Infrastructure

Metric Name
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Disk Details BYDSK_DEVNAME

BYDSK_PHYS_READ_BYTE_RATE

BYDSK_PHYS_READ_RATE

BYDSK_PHYS_WRITE_BYTE_RATE

BYDSK_PHYS_WRITE_RATE

BYDSK_UTIL

BYDSK_REQUEST_QUEUE

BYDSK_AVG_SERVICE_TIME

BYDSK_LOGL_READ_RATE

BYDSK_LOGL_WRITE_RATE

BYDSK_DIRNAME

BYDSK_ID

PHYSICALDISK_DISK__READS_SEC

PHYSICALDISK_DISK__WRITES_SEC

Filesystem Details FS_DIRNAME

FS_SPACE_UTIL

FS_MAX_SIZE

FS_SPACE_USED

FS_SPACE_RESERVED

FS_TYPE

FS_DEVNAME

FS_DEVNO

FS_INODE_UTIL

FS_MAX_INODES

Graph Templates for 
Systems Infrastructure

Metric Name
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Filesystem Details FS_BLOCK_SIZE

FS_FRAG_SIZE

FS_BLOCK_SIZE

FS_FRAG_SIZE

FILESYSTEMS_KBYTES

FILESYSTEMS_10240D45BLOCKS

FILESYSTEMS_USED

FILESYSTEMS_AVAIL

FILESYSTEMS_FILESYSTEM

CPU Details BYCPU_ID

BYCPU_CPU_SYS_MODE_UTIL

BYCPU_CPU_USER_MODE_UTIL

BYCPU_CSWITCH_RATE

BYCPU_INTERRUPT_RATE

BYCPU_STATE

BYCPU_CPU_CLOCK

BYCPU_CPU_TOTAL_UTIL

PROCESSOR_SYSTEM

PROCESSOR_USER

PROCESSOR_SYSEXEC

PROCESSOR__INFO_CPU__MHZ

CPU__UTILIZATION_0D37SYS

CPU__UTILIZATION_0D37USR

Graph Templates for 
Systems Infrastructure

Metric Name
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Network Interface Details BYNETIF_NAME

BYNETIF_IN_BYTE_RATE

BYNETIF_IN_PACKET_RATE

BYNETIF_OUT_BYTE_RATE

BYNETIF_OUT_PACKET_RATE

BYNETIF_QUEUE

BYNETIF_COLLISION_RATE

BYNETIF_ERROR_RATE

NETWORK__INTERFACE

NETWORK__INTERFACE_RECEIVEBYTES

NETWORK__INTERFACE_RBYTES

NETWORK__INTERFACE_IPACKETS

NETWORK__INTERFACE_PACKETS__RECEIVE
D_SEC

NETWORK__INTERFACE_TRANSMITBYTES

NETWORK__INTERFACE_RBYTES

NETWORK__INTERFACE_OPACKETS

NETWORK__INTERFACE_PACKETS__SENT_SEC

NETWORK__INTERFACE_COLLS

NETWORK__INTERFACE_COLLISIONS

NETWORK__INTERFACE_ERRS

NETWORK__STATS

NETWORK__STATS_IPKTS

NETWORK__STATS_OPKTS

NETWORK__STATS_COLL

Graph Templates for 
Systems Infrastructure

Metric Name
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Virtualization Infrastructure Graph Templates
The following table lists the graph templates for Virtualization 
Infrastructure:

Graph Templates for 
Virtualization Infrastructure

Metric Name

Virtualization Configurations GBL_SYSTEM_ID

GBL_OSNAME

GBL_OSVERSION

GBL_OSRELEASE

GBL_LS_TYPE

GBL_LS_ROLE

GBL_NUM_LS

GBL_NUM_CPU

GBL_SYSTEM_ID

GBL_OSNAME

GBL_OSVERSION

GBL_OSRELEASE

GBL_LS_TYPE

GBL_LS_ROLE

GBL_NUM_LS

GBL_NUM_CPU

BYLS_LS_ID

BYLS_LS_NAME

BYLS_NUM_CPU

BYLS_NUM_NETIF

BYLS_NUM_DISK

BYLS_LS_OSTYPE



Chapter 32 • Infrastructure Content Pack

830

Virtualization Configurations BYLS_CPU_ENTL_MIN

BYLS_CPU_ENTL_MAX

BYLS_MEM_ENTL_MIN

BYLS_MEM_ENTL_MAX

CPU Entitlement by Logical 
Systems

BYLS_CPU_ENTL_MIN

BYLS_CPU_ENTL_MAX

VMWARE
_GUARANTEED0D46SUMMATION0D910D93

Percentage Utilization of CPU 
Entitlement by Logical 
Systems

BYLS_CPU_ENTL_UTIL

Percentage Utilization of Total 
Physical CPU by Logical 
Systems

BYLS_CPU_PHYS_TOTAL_UTIL

VMWARE_USAGE0D46AVERAGE0D910D93

CPU Details of Logical System GBL_CPU_ENTL_UTIL

GBL_CPU_PHYS_USER_MODE_UTIL

GBL_CPU_PHYS_SYS_MODE_UTIL

GBL_CPU_PHYS_TOTAL_UTIL

GBL_CPU_SHARES_PRIO

GBL_CPU_ENTL_UTIL

GBL_CPU_PHYS_USER_MODE_UTIL

GBL_CPU_PHYS_SYS_MODE_UTIL

GBL_CPU_PHYS_TOTAL_UTIL

GBL_CPU_SHARES_PRIO

CPU__UTILIZATION_0D37SYS

CPU__UTILIZATION_0D37USR

Graph Templates for 
Virtualization Infrastructure

Metric Name
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CPU Summary by Logical 
Systems

BYLS_LS_ID

BYLS_CPU_ENTL_UTIL

BYLS_CPU_USER_MODE_UTIL

BYLS_CPU_SYS_MODE_UTIL

BYLS_CPU_PHYS_TOTAL_UTIL

BYLS_CPU_SHARES_PRIO

VMWARE_USAGE0D46AVERAGE0D910D93

VMWARE_READY0D46SUMMATION0D910D93

VMWARE_EXTRA0D46SUMMATION0D910D93

Percentage Utilization of 
Memory Entitlement by 
Logical Systems

BYLS_MEM_ENTL_UTIL

Memory Summary by Logical 
Systems

BYLS_LS_ID

BYLS_MEM_ENTL_UTIL

BYLS_MEM_PHYS_UTIL

BYLS_MEM_SWAPPED

BYLS_MEM_OVERHEAD

BYLS_MEM_SHARES_PRIO

VMWARE_ACTIVE0D46AVERAGE0D910D93

VMWARE_USAGE0D46AVERAGE0D910D93

VMWARE_SWAPPED0D46AVERAGE0D910D93

VMWARE_OVERHEAD0D46AVERAGE0D910D93

CPU Entitlement Utilization 
Baseline

BYLS_CPU_ENTL_UTIL

VMware ESX/ESXi Host 
Memory Utilization

BYLS_MEM_PHYS_UTIL

VMWARE_USAGE0D46AVERAGE0D910D93

Graph Templates for 
Virtualization Infrastructure

Metric Name
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Policies Setting HIs/ETIs
The following table lists the content pack HIs/ETIs and SPI policies that set 
the HIs/ETIs.

VMware ESX/ESXi Host 
Memory Utilization Baseline

BYLS_MEM_PHYS_UTIL

VMWARE_USAGE0D46AVERAGE0D910D93

VMware ESX/ESXi Host Disk 
Utilization

BYLS_DISK_UTIL

VMWARE_USAGE0D46AVERAGE0D910D93

VMWARE_READ0D46AVERAGE0D910D93

VMWARE_WRITE0D46AVERAGE0D910D93

VMware ESX/ESXi Host - 
Network MB

BYLS_NET_IN_BYTE

BYLS_NET_OUT_BYTE

VMWARE_USAGE0D46AVERAGE0D910D93

VMware ESX/ESXi - CPU 
Utilization across Resource 
Pools

BYLS_CPU_PHYS_TOTAL_UTIL

VMWARE_USAGE0D46AVERAGE0D910D93

HI/ETI Policy Name Policy Description

L2Connection
Status 

- -

DRSStatus VI-VMwareDRSEvent The policy monitors the log file /
var/opt/OV/tmp/vispi/

vmeventlist.log and alerts in 
case of any occurrence of DRS 
related events.  

PingAvailability - -

Graph Templates for 
Virtualization Infrastructure

Metric Name
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NodeStatus VI-StateMonitor The policy monitors and reports 
the state of the host servers and the 
guest virtual machines configured 
on them. 

VI-VMwareDRSEvent The policy monitors the log file /
var/opt/OV/tmp/vispi/

vmeventlist.log and alerts in 
case of any occurrence of DRS 
related events.

VI-VMwareVM
PoweredOnOffEvent

The policy monitors the log file /
var/opt/OV/tmp/vispi/

vmeventlist.log and alerts 
whenever a VM is powered on or 
powered off.  

CPULoad SI-CPUBottleneck
Diagnosis

The policy detects CPU bottlenecks 
like exceeding the thresholds for 
CPU utilization percentage, 
processor queue length, total 
number of CPU on the system, and 
operating systems.

VI-HostCPU
UtilizationMonitor

The policy monitors CPU 
utilization along with ready 
utilization on the host machine 
and sends an alert in case of any 
violation.

VI-VMCpuEntitlement
UtilizationMonitor-AT 

The policy calculates (as a 
percentage) the current CPU 
utilization and compares it to the 
minimum CPU entitlement 
utilization of virtual machines. 

HI/ETI Policy Name Policy Description
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CPUUsageLevel SI-CPUSpikeCheck The policy monitors CPU spikes 
per CPU busy time in system 
mode, per CPU busy time in user 
mode, and total busy time per 
CPU. 

SI-PerCPU
Utilization-AT 

The policy monitors the utilization 
for each CPU on the managed 
node. This policy processes each 
CPU instance separately for every 
interval. 

CPU Entitlement 
Usage Level

VI-OracleSolarisHost
CPUUtilization
Monitor

The policy monitors  the host 
system's CPU utilization. 

VI-OracleSolarisZone
CPUEntlUtil
Monitor-AT

This policy monitors the logical 
system’s CPU utilization against 
the minimum entitled CPU. 
Entitled CPU is the number of 
guaranteed processing units 
allocated to a logical system.

DiskUsageLevel SI-DiskCapacity
Monitor 

The policy monitors capacity 
parameters of the disks on the 
managed node. For each disk, the 
policy checks for space utilization 
and free space available. It also 
checks for inode utilization on the 
Linux nodes. 

InterfaceError
Rate

SI-NetworkUsage
AndPerformance 

The policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks. 

HI/ETI Policy Name Policy Description
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Interface
Utilization 

SI-NetworkUsage
AndPerformance 

The policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks. 

SI-PerNetifInbyte
Baseline-AT 

The policy monitors the incoming 
bytes on each network interface on 
the managed node individually for 
every interval. 

SI-PerNetifOutbyte
Baseline-AT

The policy monitors the network 
interface outbyte rate each network 
interface on the managed node 
individually for every interval. 

InterfaceDiscard
Rate 

SI-NetworkUsage
AndPerformance

This policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks. 

MemoryUsage
Level 

SI-Memory

Utilization-AT

The policy monitors the overall 
memory usage by operating 
systems. 

VI-VMwareHost
MemoryHealth

Monitor 

The policy monitors the health of 
the host machines on VMware 
vMA in terms of memory 
utilization. It can be used to 
monitor the availability or 
utilization of the memory on the 
host machine.

VI-VMwareVM
MemoryUsage-AT

The policy monitors how much 
memory is being used by the guest 
virtual machines and resource 
pools in MBs. The policy uses a 
multi-instance baseline for 
monitoring the memory usage for 
virtual machines and resource 
pools. 

HI/ETI Policy Name Policy Description
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Virtualization
Overhead 

VI-VMMemory
OverheadMonitor-AT

The policy monitors the memory 
overhead on the VM.

ResourceUsage SI-JavaProcessCPU
UsageTracker

The policy monitors the CPU usage 
for the Java process running on 
your system.

SI-JavaProcess
MemoryUsageTracker

The policy monitors memory usage 
for Java process running on your 
system. 

SI-MSWindowsSvchost
CPUUsageTracker

The policy monitors the CPU usage 
for the svchost processes running 
on your system.

SI-MSWindowsSvchost
MemoryUsageTracker

The policy monitors the memory 
usage for the svchost processes 
running on your system. 

HI/ETI Policy Name Policy Description
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MemoryLoad SI-MemoryBottleneck
Diagnosis

The policy monitors the physical 
memory utilization and the 
bottlenecks. The policy first checks 
for memory bottleneck threshold 
violations, if the condition is not 
met it checks for memory usage 
threshold violations. If both 
conditions for memory bottleneck 
and memory usage, are not met, 
the policy checks for free page 
table condition. 

By default the free page table 
thresholds contain Microsoft 
recommended values on the 
Windows systems. In case of 
violation of multiple threshold 
values indicating a high 
utilization, the policy sends a 
message to the HPOM console with 
appropriate message attributes. The 
message also displays a list of top 
10 memory intensive processes. 

VI-VMwareVM
MemoryPerformance
Monitor 

The policy monitors the memory 
performance of the virtual 
machines. It compares the memory 
used by the virtual machine 
against the amount of virtual 
memory entitled to it. 

MemoryEntitlem
entUsageLevel

VI-OracleSolarisMemor
yEntlUtilMonitor-AT

The policy monitors the Solaris 
zone’s memory utilization (for a 
given time period) against the 
minimum entitled memory. It 
monitors system memory 
(occupied by the kernel), buffer 
cache, and user memory.

VI-OracleSolarisHost
MemoryUtilMonitor

This policy monitors the memory 
utilization of host systems.

HI/ETI Policy Name Policy Description
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SwapUsageLevel SI-SwapCapacity
Monitor

The policy monitors the swap 
space utilization of the system

SI-SwapUtilization-AT The policy monitors the overall 
swap space used by the systems on 
the managed node. 

KernelHandles
Usage 

SI-KernelTableUsage
Monitor 

BatchJobService SI-LinuxAtdProcess
Monitor

The policy monitors availability of 
the Linux Atd process. 

SI-RHELCronProcess
Monitor 

The policy monitors availability of 
the RHEL cron process. 

SI-SLESCronProcess
Monitor

The policy monitors availability of 
the SLES cron process.

EventLogging
Service 

SI-SLESSyslogProcess
Monitor 

The policy monitors availability of 
the SLES Syslog process. 

SI-RHELSyslog
ProcessMonitor 

The policy monitors availability of 
the RHEL Syslog process. 

PrintService SI-LinuxCups  
ProcessMonitor 

The policy monitors availability of 
the Linux Cups process. 

SI-MSWindows
PrintServiceRole
Monitor

The policy monitors availability of 
the Microsoft Windows Print 
service. 

FileServer
Service 

SI-MSWindowsFile
ServerRoleMonitor

The policy monitors availability of 
the Microsoft Windows 
FileServerRole process. 

SI-LinuxSmbServer
ProcessMonitor

The policy monitors availability of 
the Linux Smb process.

SI-LinuxNfsServer
ProcessMonitor

The policy monitors availability of 
the Linux NTFS Server process. 

EmailService SI-LinuxSendmail
ProcessMonitor 

The policy monitors availability of 
the Linux Sendmail process. 

HI/ETI Policy Name Policy Description
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WebServer
Service 

SI-MSWindows
WebServerRoleMonitor

The policy monitors availability of 
the Microsoft Windows 
WebServerRole process. 

RPCService - -

FirewallService - -

DNSService - -

FTPService - -

DHCPServer
Service 

- -

SecureLogin
Service 

- -

BatchJobs (ETI) - -

VMRename (ETI) VI-VMwareRename
Event

This policy monitors the log file /
var/opt/OV/tmp/vispi/

vmeventlist.log and alerts 
whenever a VM is renamed.

VMCreation 
(ETI) 

VI-VMwareVM
CreationRemovalEvent 

This policy monitors the log file /
var/opt/OV/tmp/vispi/

vmeventlist.log and alerts 
whenever a VM is created.

VMRemoval 
(ETI) 

VI-VMwareVM
CreationRemovalEvent

This policy monitors the log file /
var/opt/OV/tmp/vispi/
vmeventlist.log and alerts 
whenever a VM is removed.

VMMigration 
(ETI) 

VI-VMwareDRSEvent The policy monitors the log file /
var/opt/OV/tmp/vispi/
vmeventlist.log and alerts in 
case of any occurrence of DRS 
related events.

FilesystemUsage - -

SwapSpace
Available

- -

HI/ETI Policy Name Policy Description
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LogicalDisk
FreeSpaceWIN 

- -

TerminalServer
Service 

- -

ClusterResource
GroupStatus 

CI-ClusterResGroup
Monitor

The policy monitors the state and 
availability of resource groups in a 
cluster. Before deploying this 
policy, make sure you have 
deployed the 
CI-ClusterDataCollector policy for 
cluster data collection.

CPUUsageLevel SI-CPUSpikeCheck The policy monitors CPU spikes 
per CPU busy time in system 
mode, per CPU busy time in user 
mode, and total busy time per 
CPU. A system experiences CPU 
spike when there is a sharp rise in 
the CPU usage immediately 
followed by a decrease in usage. 

SI-PerCPU
Utilization-AT 

The policy monitors the utilization 
for each CPU instance separately 
for every interval.

DiskUsageLevel SI-DiskCapacity
Monitor 

The policy monitors capacity 
parameters of the disks on the 
managed node. For each disk, the 
policy checks for space utilization 
and free space available. It also 
checks for inode utilization on the 
Linux nodes. In case the free space 
availability, space utilization, or 
inode utilization exceeds the 
threshold values specified, the 
policy sends out an alert to the 
HPOM console.

HI/ETI Policy Name Policy Description
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DiskUtilization SI-PerDisk
Utilization-AT 

The policy monitors utilization for 
each disk on the managed node. 
This policy processes each disk 
instance separately for every 
interval. This policy requires HP 
Performance Agent to be running 
on the managed node.

VI-VMwareHost
DiskUtilization-AT

The policy monitors the duration 
for which the physical disks are 
used for input/output. The policy 
uses a multi-instance baseline for 
monitoring the disk input/output 
utilization. 

InterfaceError
Rate 

SI-NetworkUsage
AndPerformance 

The policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks.

Interface
Utilization 

SI-NetworkUsage
AndPerformance

This policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks.

SI-PerNetifInbyte
Baseline-AT

This policy monitors the incoming 
bytes on each network interface 
separately for every interval. 

SI-PerNetifOutbyte
Baseline-AT 

This policy monitors the network 
interface outgoing bytes on each 
network interface separately for 
every interval.

InterfaceDiscard
Rate 

SI-NetworkUsage
AndPerformance 

This policy monitors the system's 
network usage and shows error 
rates and collisions to identify 
potential network bottlenecks.

Interface
Communication
Status 

- -

HI/ETI Policy Name Policy Description
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AddressStatus - -

ClusterSoftware
Service 

CI-LinuxVCS_Process
Monitor_data

The policy monitors the state and 
availability of the Veritas cluster 
server process on RHEL and SUSE 
operating systems.  

CI-MCSGCluster
ProcessMonitor_data

The policy monitors the state and 
availability of HP MC/
ServiceGuard Cluster process on 
Linux, RHEL and SLES systems. It 
monitors the process cmcld. The 
cmcld process runs on every cluster 
node and helps to initialize and 
monitor the health of the cluster. 

CI-MSWindowsCluster
ServiceMonitor_data

The policy checks for the state and 
availability of Microsoft Windows 
services. It monitors the Microsoft 
Windows services on the managed 
cluster nodes. 

CI-MSWindowsVCS_
ProcessMonitor_data

The policy monitors the state and 
availability of the Veritas cluster 
server process or service on 
Microsoft Windows systems 

CI-RHClusterCCSD
ProcessMonitor_data

The policy monitors the state and 
availability of the Red Hat Cluster 
process on Linux, for RHEL 
systems. It monitors the process 
ccsd (Cluster Configuration System 
Daemon).

CI-RHClusterRG
Manager
ProcessMonitor_data

The policy monitors the state and 
availability of the Red Hat Cluster 
process on Linux, for RHEL 
systems. It monitors the process 
clurgmgrd (Cluster Resource Group 
Manager). 

HI/ETI Policy Name Policy Description
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ClusterStrength CI-ClusterMonitor The CI-ClusterMonitor policy 
monitors the availability and 
strength of a cluster group. This is 
helpful to ensure high availability 
of services running on the cluster 
servers.

Before deploying this policy, make 
sure you have deployed the 
CI-ClusterDataCollector policy for 
cluster data collection. 

VMFSUsageLevel VI-VMwareVMFS
UtilizationMonitor 

This policy monitors the disk space 
utilization on the Virtual Machine 
File System (VMFS) on the vMA 
system. VMFS represents the data 
storage volumes on which the 
VMware guest disk files are stored.

Virtualization
Service 

VI-MSHyperVHost
ServiceMonitor 

This policy monitors the 
availability of services on the host 
operating system of the Microsoft 
Hyper-V server.

HI/ETI Policy Name Policy Description
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Operations Orchestration Flow
The following table list the Operations Orchestration (OO) flows for 
Infrastructure Content Pack:

When creating the mapping defined in the previous table, you can set the 
default values for the attributes listed in the following table:

OO 
Flows

Description Flow input CI Type 
CI 
attribute

Event 
Attribute

ESX 
Server 
health 
check

Checks the 
health of 
memory and 
performance of 
CPU for 
VMware ESX 
server

omServer 
ESX Name

vmware_e
sx_server

name Originating 
Server

VM 
health 
check

Checks the 
health of 
memory and 
performance of 
CPU for guest 
machines 
(VMs)

omServer 
VM Name

host_node

Sanity 
check 
for VISPI

Checks the 
correctness of 
VISPI 
installation 
(VISPI 1.5 or 
later)

omServer 
VM Name

unix/nt

Flow input Description

omServerPort Port number of the HPOM Tool WS 

omServerUser The user name for the HPOM Server that will use used in 
the HPOM Tool WS

omServerPassword The password for the HPOM Server that will use used in the 
HPOM Tool WS
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For more information about creating the mapping and Run Book 
automation rules, see "How to Create a Run Book Automation Rule" on 
page 505.

When running OO flows, the user input to provide is:

omNode: The target node with an HPOM agent.
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33
J2EE Content Pack

This chapter includes:

Reference

➤ J2EE Application Server Content Pack on page 848
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Reference

J2EE Application Server Content Pack

Note: To display the impact of the database instance on J2EE Application 
Server, you must specify the appropriate Application IP and database 
instance name in the JDBC URL. These properties are used to create the link 
between the J2EE Application Server and database instance.

The J2EE Application Server Content Pack contains the following artifacts:

➤ Views on page 849

➤ Health Indicators on page 851

➤ Event Type Indicators on page 859

➤ Correlation Rules on page 861

➤ HI Assignment on page 900

➤ KPI Assignment on page 901

➤ Dependent Content Packs on page 902

➤ Tool Definitions on page 904

➤ Graph Templates for SPI for WebSphere Server on page 905

➤ Graph Templates for SPI for WebLogic Server on page 908

➤ Policies Setting ETIs on page 910

➤ Operations Orchestration Flow on page 914
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Views
The RTSM package in the J2EE Application Server Content Pack contains the 
following views:

➤ J2EE_Deployment: This view refers to the J2EE Cluster, J2EE Domain, 
JDBC Data Source, J2EE Application, Database, and Computer CI types. 
The following image shows the relationship among the CI types.
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➤ J2EE_Network_Deployment_View: This view refers to the J2EE Cluster, 
J2EE Domain, J2EE Server, JDBC Data Source, J2EE Application, Database, 
and File System CI types. The following image shows the relationship 
among the CI types.
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Health Indicators
The content pack includes the following Health Indicators (HIs) to monitor 
J2EE related events.

CI Type HI Description Value

J2EE Server Active Sockets 
Count

Number of HTTP socket 
connections opened to the 
server.

High,
Normal

Application 
Server Load

Load on the application 
server.

High,
Normal

Deferred Thread 
Requests

The number of requests that 
were denied a thread for 
execution because of the 
max-threads-constraint.

High, 
Normal

Http Request 
Average Service 
Time

Average time required to 
service an HTTP request.

High, 
Normal

Http Request 
Total Service 
Time

Total time required to service 
HTTP requests.

High, 
Normal

Http Server 
Active 
Connections

Number of connections 
currently open.

High, 
Normal

Http Server 
Active Request

Child servers currently in the 
request processing phase.

High, 
Normal

Http Server 
Connection 
Time

Total time spent servicing 
HTTP connections.

High, 
Normal

JMS Active 
Connection 
Count

Number of active JMS 
connections.

High, 
Normal

JMS Server 
Utilization

JMS Server queue utilization. High, 
Normal
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J2EE Server Oracle Web 
Cache Average 
Latency Current 
Interval

Average latency for 10 second 
intervals to process requests 
for Oracle Web Cache.

High, 
Normal

Oracle Web 
Cache Latency 
Since Start

Average number of seconds to 
process requests for Oracle 
Web Cache since the 
application Web server 
started.

High, 
Normal

Server Sessions Number of sessions opened to 
this server.

High, 
Normal

Server Status Shows the server status in 
terms of availability.

Unavailable, 
Available

Servlets Loaded Number of servlets currently 
loaded for a web application 
(cumulative value per server).

High, 
Normal

Thread Hung 
Rate

Rate at which the threads are 
declared hung.

High, 
Normal

Thread Pool 
Availability

The availability of the threads 
in the Thread Pool.

Low, 
Normal

Thread Pool 
Utilization

The number of threads used 
in the server to execute tasks.

High, 
Normal

Thread Request 
Service Time

Time a request had to wait for 
a thread.

High, 
Normal

Thread Request 
Wait Time

The time (in milliseconds) a 
request had to wait for a 
thread.

High, 
Normal

Threads Request 
Pending

Requests that are pending 
because they are waiting for 
an available thread.

High, 
Normal

Transaction 
Application 
Errors

Transaction errors due to 
application errors.

High, 
Normal

CI Type HI Description Value
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J2EE Server Transaction 
Capacity 
Utilization

The number of simultaneous 
in-progress transactions.

High, 
Normal

Transaction 
Commit Rate

The number of transactions 
that were committed per 
second.

High, 
Normal

Transaction 
Resource Errors

Transaction errors caused due 
to system resource errors.

High, 
Normal

Transaction 
Rollback Rate

The number of transactions 
rolled back due to system, 
resource, or others.

High, 
Normal

Transaction Start 
Rate

The number of transactions 
that were begun per second.

High, 
Normal

Transaction 
System Errors

Transaction errors caused due 
to system errors.

High, 
Normal

Transaction 
Time

Time taken to complete a 
transaction.

High, 
Normal

Transaction 
Timeout Errors

Transaction errors caused due 
to transaction timeout.

High, 
Normal

Transaction 
Timeout Rate

The number of transactions 
that timed out per second.

High, 
Normal

Transactions 
Rolled Back

Number/Percentage of 
Transactions rolled back due 
to system, resource, or other 
errors.

High, 
Normal

EJB Concurrent 
Lives

The average number of bean 
objects in the pool.

High, 
Normal

EJB Utilization The utilization of the EJB 
pool.

High, 
Normal

Execute Queue 
Wait Count

The number of client requests 
waiting to be serviced by the 
execute queue.

High, 
Normal

CI Type HI Description Value
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J2EE Server HTTP Sessions Number of open HTTP 
sessions.

High, 
Normal

EJB Missed 
Count Rate

Total number of times a failed 
attempt was made to get an 
instance from the free pool.

High, 
Normal

EJB Free Pool 
Wait Rate

The number of times per 
minute no EJBs were available 
from the free pool.

High, 
Normal

EJB Performance The performance statistics 
such as cache utilization.

Low, 
Normal

EJB Timeout 
Rate

The number of times per 
minute a client timed out 
waiting for an EJB.

High, 
Normal

EJB Transaction 
Rollback Rate

Number of EJB Transaction 
Rolled back in unit time.

High, 
Normal

Servlet 
Performance

Performance statistics such as 
execution time.

Low, 
Normal

Servlet Requests Number of incoming requests 
to the servlet.

High, 
Normal

Connections in 
Use

Number of currently used 
JDBC connections.

High,
Normal

JDBC 
Connection Pool 
Wait Count

Number of clients waiting for 
a JDBC connection.

High, 
Normal

Data Source 
Connection Pool 
Availability

Availability of JDBC 
connections in the 
connection pool.

Low, 
Normal

Data Source 
Connection Pool 
Failures

Number of failed attempts to 
refresh a connection in the 
connection pool.

Critical, 
Normal

Data Source 
Connection Pool 
Utilization

DataSource Connection Pool 
Utilization

High, 
Normal

CI Type HI Description Value
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J2EE Server Data Source 
Connection Pool 
Performance

DataSource Connection Pool 
Performance

Low, 
Normal

Data Source 
Connection 
Waiters

The average number of 
threads waiting for a 
connection from the 
connection pool.

High, 
Normal

JDBC Active 
Connection 
Count

Active JDBC connections High, 
Normal

Total Number of 
Threads

Total number of threads for 
garbage collection.

High, 
Normal

Total Garbage 
Collection 
Count

Number of times garbage 
collector has run.

High, 
Normal

Total Garbage 
Collection Time

Total time taken for garbage 
collection.

High, 
Normal

JVM Memory 
Utilization

The percentage of heap size 
used.

High, 
Normal

Heap Free 
Current

Amount of free heap 
available.

Low, 
Normal

Heap Size 
Current

Amount of heap in use. High, 
Normal

All Processors 
Average Load

Average load on all the 
processors on the system.

High,
Normal

CI Type HI Description Value
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J2EE Cluster Cluster Health Cluster health in terms of 
performance.

Poor,
Normal

Cluster 
Incoming 
Message Failure 
Rate

The number of multicast 
messages that were lost from 
the cluster.

High,
Normal

Cluster 
Outgoing 
Message Failure 
Rate

The number of multicast 
messages that were send to 
the cluster.

High,
Normal

Cluster Status Cluster Status in terms of 
availability.

Started, 
Partial 
Stopped, 
Stopped

CI Type HI Description Value
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JDBC Data 
Source

Connections in 
Use

Number of currently used 
JDBC connections.

High,
Normal

Data Source 
Connection 
Waiters

The average number of 
threads waiting for a 
connection from the 
connection pool.

High, 
Normal

Data Source 
Connection Pool 
Availability

Availability of JDBC 
connections in the 
connection pool.

Low, 
Normal

Data Source 
Connection Pool 
Failures

The number of failed 
attempts to refresh a 
connection in the connection 
pool.

Normal, 
Critical

Data Source 
Connection Pool 
Performance

Data source connection pool 
performance.

Low, 
Normal

Data Source 
Connection Pool 
Utilization

Data source connection pool 
utilization.

High, 
Normal

Data Source 
Leaked 
Connections 
Rate

The rate of new leaked JDBC 
connections.

High, 
Normal

JDBC Active 
Connections 
Count

Active JDBC connections High, 
Normal

JDBC 
Connection Pool 
Wait Count

The number of clients waiting 
for a JDBC connection.

High, 
Normal

CI Type HI Description Value
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J2EE 
Application

EJB Concurrent 
Lives

The average number of bean 
objects in the pool.

High, 
Normal

EJB Free Pool 
Wait Rate

The number of times per 
minute no EJBs were available 
from the free pool.

High, 
Normal

EJB Missed 
Count Rate

The total number of times a 
failed attempt was made to 
get an instance from the free 
pool.

High, 
Normal

EJB Performance The performance statistics 
such as cache utilization.

Low, 
Normal

EJB Timeout 
Rate

The number of times per 
minute a client timed out 
waiting for an EJB.

High, 
Normal

EJB Transaction 
Rollback Rate

Number of EJB Transaction 
Rolled back in unit time.

High, 
Normal

EJB Transaction 
Throughput Rate

Number of EJBs Transactions 
completed in unit time.

High, 
Normal

EJB Utilization The utilization of the EJB 
pool.

High, 
Normal

HTTP Sessions Number of open HTTP 
sessions.

High, 
Normal

Servlet 
Performance

The performance statistics 
such as execution time.

Low, 
Normal

Servlet Requests Number of incoming requests 
to the servlet.

High, 
Normal

CI Type HI Description Value
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Event Type Indicators
The content pack includes the following Event Type Indicators (ETIs) that 
do not contribute to health to monitor the J2EE related events:

JVM All Processors 
Average Load

Average load on all the 
processors on the system.

High,
Normal

Heap Free 
Current

Amount of free heap 
available.

Low, 
Normal

Heap Size 
Current

Amount of heap in use. High, 
Normal

JVM Memory 
Utilization

The percentage of heap size 
used.

High, 
Normal

Total Garbage 
Collection 
Count

Number of times garbage 
collector has run.

High, 
Normal

Total Garbage 
Collection Time

Total time taken for garbage 
collection.

High, 
Normal

Total Number of 
Threads

Total number of threads for 
garbage collection.

High, 
Normal

J2EE Domain Domain Status The status of domain. Normal, 
Poor

CI Type ETI Description Value

J2EE 
Server

Active Sockets 
Count

Number of HTTP socket connections 
opened to the server.

High, 
Normal

Execute Queue 
Wait Count

The number of client requests waiting 
to be serviced by the execute queue.

High, 
Normal

Threads 
Request 
Pending

Requests that are pending because 
they are waiting for an available 
thread.

High, 
Normal

Server Sessions Number of sessions opened to this 
server.

High, 
Normal

CI Type HI Description Value
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JVM Total Garbage 
Collection 
Count

Number of times garbage collector 
has run.

High, 
Normal

Total Garbage 
Collection 
Time

Total time taken for garbage 
collection.

High, 
Normal

Total Number 
of Threads

Total number of threads used for 
garbage collection.

High, 
Normal

J2EE 
Applicatio
n

Servlet 
Requests

Number of incoming requests to the 
servlet.

High, 
Normal

HTTP Sessions Number of open servlet sessions. High, 
Normal

EJB Concurrent 
Lives

The average number of bean objects 
in the pool.

High, 
Normal

JDBC Datasource 
Connection 
Waiters

The average number of threads 
waiting for a connection from the 
connection pool.

High, 
Normal

CI Type ETI Description Value
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Correlation Rules
The content pack in the J2EE Content Pack contains the following 
correlation rules.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

J2EE::Computer:CPU Load >> JVM Memory Utilization & JMS Server 
Utilization & Transaction System Errors & EJB Performance 

Description: Computer CPU Load Impacts JVM Memory Utilization and JMS 
Server Utilization and Transaction System Errors and EJB Performance

Cause

CIT: Computer ETI: CPU Load Value: 
Overloaded

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 3

CIT: J2EE Server ETI: JMS Server Utilization Value: High

Symptom 3

CIT: J2EE Server ETI: Transaction System Errors Value: High

Symptom 4

CIT: JVM ETI: JVM Memory Utilization Value: High
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J2EE::Computer:CPU Load >> Real User Transaction Performance & Real 
User Sessions Performance 

J2EE::Computer:CPU Load >> Synthetic User Transaction Performance 

Description: Computer CPU Load Impacts Real User Transaction Performance and 
Real User Sessions Performance

Cause

CIT: Computer ETI: CPU Load Value: 
Overloaded

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Transaction

ETI: Real User Transaction 
Performance event

Value: Critical

Description: Computer CPU Load Impacts Synthetic User Transaction 
Performance 

Cause

CIT: Computer ETI: CPU Load Value: 
Overloaded

Symptom 1

CIT: Business 
Transaction

ETI: Synthetic User Transaction 
Performance event

Value: Critical
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J2EE::Computer:Memory Usage Level >> Server Status & Transaction 
System Errors & Thread Hung Rage

J2EE::Database:CPU Usage By SQL >> Transaction Timeout Errors & 
Transactions Rolled Back & EJB Performance & DataSource 
ConnectionPool Performance

Description: Computer Memory Usage Level Impacts Server Status and 
Transaction System Errors and Thread Hung Rate

Cause

CIT: Computer ETI: Memory Usage Level Value: Much 
Higher Than 
Normal

Symptom 1

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Symptom 2

CIT: J2EE Server ETI: Thread Hung Rate Value: High

Symptom 3

CIT: J2EE Server ETI: Transaction System Errors Value: High

Description: Database CPU Usage By SQL Impacts Transaction Timeout Errors and 
Transactions Rolled Back and EJB Performance and DataSource ConnectionPool 
Performance

Cause

CIT: Database ETI: CPU Usage by SQL Value: High

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2
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J2EE::Database:Database Server Status >> DataSource ConnectionPool 
Availability

CIT: J2EE Server ETI: DataSource Connection Pool 
Performance

Value: Low

Symptom 3

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 4

CIT: J2EE Server ETI: Transaction Timeout Errors Value: High

Symptom 5

CIT: J2EE Server ETI: Transactions Rolled Back Value: High

Symptom 6

CIT: JDBC Data ETI: Datasource Connection Pool 
Performance

Value: Low

Description: Database Server Status Impacts DataSource ConnectionPool 
Availability

Cause

CIT: Database ETI: Database Server Status Value: Down

Symptom 1

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 2

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Availability

Value: Low

Description: Database CPU Usage By SQL Impacts Transaction Timeout Errors and 
Transactions Rolled Back and EJB Performance and DataSource ConnectionPool 
Performance
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J2EE::Database:Database Server Status >> Real User Transaction 
Availability & Real User Sessions Availability 

J2EE::Database:Database Server Status >> Synthetic User Transaction 
Availability 

Description: Database Server Status Impacts Real User Transaction Availability and 
Real User Sessions Availability

Cause

CIT: Database ETI: Database Server Status Value: Down

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions Availability Value: Critical

Symptom 2

CIT: Business 
Transaction

ETI: Real User Transaction 
Availability event

Value: Critical

Description: Database Server Status Impacts Synthetic User Transaction 
Availability 

Cause

CIT: Database ETI: Database Server Status Value: Down

Symptom 1

CIT: Business 
Transaction

ETI: Synthetic User Transaction 
Availability event

Value: Critical
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J2EE::Database:SQL Query Performance >> Transaction Timeout Errors 
& Transactions Rolled Back & EJB Performance & DataSource 
ConnectionPool Performance

Description: Database SQL Query Performance Impacts Transaction Timeout 
Errors and Transactions Rolled Back and EJB Performance and DataSource 
ConnectionPool Performance

Cause

CIT: Database ETI: SQL Query Performance Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Datasource Connection Pool 
Performance 

Value: Low

Symptom 3

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 4

CIT: J2EE Server ETI: Transaction Timeout Errors Value: High

Symptom 5

CIT: J2EE Server ETI: Transactions Rolled Back Value: High

Symptom 4

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Performance

Value: Low
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J2EE::File System:Disk Usage Level >> Server Status & Transaction 
Resource Errors & Transaction System Errors

J2EE::J2EE Application:EJB Concurrent Lives >> EJB Utilization

Description: File System Disk Usage Level Impacts Server Status and Transaction 
Resource Errors and Transaction System Errors

Cause

CIT: FileSystem ETI: Disk Usage Level Value: Near 
Capacity

Symptom 1

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Symptom 2

CIT: J2EE Server ETI: Transaction Resource Errors Value: High

Symptom 3

CIT: J2EE Server ETI: Transactions System Errors Value: High

Description: EJB Concurrent Lives Impacts EJB Utilization

Cause

CIT: J2EE Application ETI: EJB Concurrent Lives Value: High

Symptom 1

CIT: J2EE Application ETI: EJB Utilization Value: High

Symptom 2

CIT: J2EE Server ETI: EJB Utilization Value: High
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J2EE::J2EE Application:EJB Free Pool Wait Rate >> Servlet Performance

J2EE::J2EE Application:EJB Performance >> EJB Free Pool Wait Rate & 
EJB Missed Count Rate & Servlet Performance

Description: EJB Free Pool Wait Rate Impacts Servlet Performance

Cause

CIT: J2EE Application ETI: EJB Free Pool Wait Rate Value: High

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: EJB Performance Impacts EJB Free Pool Wait Rate and EJB Missed 
Count Rate and Servlet Performance

Cause

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Free Pool Wait Rate Value: High

Symptom 2

CIT: J2EE Application ETI: EJB Missed Count Rate Value: High

Symptom 3

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 4

CIT: J2EE Server ETI: EJB Free Pool Wait Rate Value: High

Symptom 5

CIT: J2EE Server ETI: EJB Missed Count Rate Value: High

Symptom 6

CIT: J2EE Server ETI: Servlet Performance Value: Low
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J2EE::J2EE Application:EJB Timeout Rate >> Servlet Performance & EJB 
Transaction Throughput Rate & EJB Transaction Rollback Rate

J2EE::J2EE Application:EJB Utilization >> DataSource Connection 
Waiters & DataSource Connection Pool Utilization

Description: EJB Timeout Rate Impacts Servlet Performance and EJB Transaction 
Throughput Rate and EJB Transaction Rollback Rate

Cause

CIT: J2EE Application ETI: EJB Timeout Rate Value: High

Symptom 1

CIT: J2EE Application ETI: EJB Transaction Rollback Rate Value: High

Symptom 2

CIT: J2EE Application ETI: EJB Transaction Throughput 
Rate

Value: High

Symptom 3

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 4

CIT: J2EE Server ETI: EJB Transaction Rollback Rate Value: High

Symptom 5

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: EJB Utilization Impacts DataSource Connection Waiters and 
DataSource Connection Pool Utilization

Cause

CIT: J2EE Application ETI: EJB Utilization Value: High

Symptom 1

CIT: J2EE Server Data Source Connection Pool 
Utilization

Value: High
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J2EE::J2EE Application:HTTP Sessions >> JVM Memory Utilization

J2EE::J2EE Application:Servlet Requests >> InterfaceUtilization

Symptom 2

CIT: J2EE Server ETI: Data Source Connection 
Waiters

Value: High

Symptom 3

CIT: JDBC Data Source ETI: Data Source Connection 
Waiters

Value: High

Symptom 4

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Utilization

Value: High

Description: J2EE Application HTTP Sessions Impacts JVM Memory Utilization

Cause

CIT: J2EE Application ETI: HTTP Sessions Value: High

Symptom 1

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 2

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Application Servlet Requests Impacts Interface Utilization

Cause

CIT: J2EE Application ETI: Servlet Requests Value: High

Symptom

CIT: Interface ETI: InterfaceUtilization Value: Much 
Higher Than 
Normal

Description: EJB Utilization Impacts DataSource Connection Waiters and 
DataSource Connection Pool Utilization
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J2EE::J2EE Application:Servlet Requests >> Real User Transaction 
Performance & Real User Sessions Performance

J2EE::J2EE Application:Servlet Requests >> Synthetic User Transaction 
Performance 

Description: J2EE Application Servlet Requests Impacts Real User Transaction 
Performance and Real User Sessions Performance

Cause

CIT: J2EE Application ETI: Servlet Requests Value: High

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Transaction

ETI: Real User Transaction 
Performance event

Value: Critical

Description: J2EE Application Servlet Requests Impacts Synthetic User Transaction 
Performance

Cause

CIT: J2EE Application ETI: Servlet Requests Value: High

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance event

Value: Critical
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J2EE::J2EE Application:Servlet Requests >> Thread Pool Utilization & 
Active Sockets Count & JVM Memory Utilization & HTTP Sessions & 
Thread Requests Pending & Servlets Loaded & Interface Discard Rate & 
Interface Utilization

Description: J2EE Application Servlet Requests Impacts Thread Pool Utilization 
and Active Sockets Count and JVM Memory Utilization and HTTP Sessions and 
Thread Requests Pending and Servlets Loaded and Interface Discard Rate and 
Interface Utilization

Cause

CIT: J2EE Application ETI: Servlet Requests Value: High

Symptom 1

CIT: Interface ETI: Interface Discard Rate Value: High

Symptom 2

CIT: Interface ETI: Interface Utilization Value: High

Symptom 3

CIT: Interface ETI: Interface Utilization Value: Higher 
Than Normal

Symptom 4

CIT: J2EE Application ETI: HTTP Sessions Value: High

Symptom 5

CIT: J2EE Server ETI: Active Sockets Count Value: High

Symptom 6

CIT: J2EE Server ETI: HTTP Sessions Value: High

Symptom 7

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 8

CIT: J2EE Server ETI: Servlets Loaded Value: High

Symptom 9

CIT: J2EE Server ETI: Thread Pool Utilization Value: High
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J2EE::J2EE Cluster:Cluster Health >> Domain Status

J2EE::J2EE Cluster:Cluster Health >> Real User Transaction Performance 
& Real User Sessions Performance 

Symptom 10

CIT: J2EE Server ETI: Thread Requests Pending Value: High

Symptom 11

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Cluster Health Impacts Domain Status

Cause

CIT: J2EE Cluster ETI: Cluster Health Value: Poor

Symptom 1

CIT: J2EE Domain ETI: Domain Status Value: Poor

Description: J2EE Cluster Health Impacts Real User Transaction Performance and 
Real User Sessions Performance

Cause

CIT: J2EE Cluster ETI: Cluster Health Value: Poor

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Performance event

Value: Critical

Description: J2EE Application Servlet Requests Impacts Thread Pool Utilization 
and Active Sockets Count and JVM Memory Utilization and HTTP Sessions and 
Thread Requests Pending and Servlets Loaded and Interface Discard Rate and 
Interface Utilization
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J2EE::J2EE Cluster:Cluster Health >> Synthetic User Transaction 
Performance 

J2EE::J2EE Cluster:Cluster Status >> Domain Status

J2EE::J2EE Cluster:Cluster Status >> Real User Transaction Availability & 
Real User Sessions Availability 

Description: J2EE Cluster Health Impacts Synthetic User Transaction Performance 

Cause

CIT: J2EE Cluster ETI: Cluster Health Value: Poor

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance event

Value: Critical

Description: J2EE Cluster Status Impacts Domain Status

Cause

CIT: J2EE Cluster ETI: Cluster Status Value: Stopped

Symptom 1

CIT: J2EE Domain ETI: Domain Status Value: Poor

Description: J2EE Cluster Status Impacts Real User Transaction Availability and 
Real User Sessions Availability

Cause

CIT: J2EE Cluster ETI: Cluster Status Value: Stopped

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions Availability Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Availability event

Value: Critical
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J2EE::J2EE Cluster:Cluster Status >> Synthetic User Transaction 
Availability 

J2EE::J2EE Server:DataSource Connection Pool Availability >> 
EJBPerformance & Transaction Timeout Rate & Transaction Commit 
Rate

Description: J2EE Cluster Status Impacts Synthetic User Transaction Availability

Cause

CIT: J2EE Cluster ETI: Cluster Status Value: Stopped

Symptom 1

CIT: Business 
Transaction

ETI: Synthetic User Transaction 
Availability event

Value: Critical

Description: J2EE Server DataSource Connection Pool Availability Impacts 
EJBPerformance and Transaction Timeout Rate and Transaction Commit Rate

Cause

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 3

CIT: J2EE Server ETI: Transaction Commit Rate Value: High

Symptom 4

CIT: J2EE Server ETI: Transaction Timeout Rate Value: High
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J2EE::J2EE Server:DataSource Connection Pool Performance >> EJB 
Performance

J2EE::J2EE Server:DataSource Connection Waiters >> DataSource 
Connection Pool Availability

Description: J2EE Server DataSource Connection Pool Performance Impacts EJB 
Performance

Cause

CIT: J2EE Server ETI: Data Source Connection Pool 
Performance

Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: EJB Performance Value: Low

Description: J2EE Server DataSource Connection Waiters Impacts DataSource 
Connection Pool Availability

Cause

CIT: J2EE Server ETI: Data Source Connection 
Waiters

Value: High

Symptom 1

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 2

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Availability

Value: Low
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J2EE::J2EE Server:DataSource ConnectionPool Utilization >> 
Transaction Capacity Utilization & JDBC Connection Pool Wait Count & 
Transaction Time & Transaction Commit Rate & Transaction Start Rate 
& DataSource Connection Pool Availability

Description: J2EE Server DataSource ConnectionPool Utilization Impacts 
Transaction Capacity Utilization and JDBC Connection Pool Wait Count and 
Transaction Time and Transaction Commit Rate and Transaction Start Rate and 
DataSource Connection Pool Availability

Cause

CIT: J2EE Server ETI: Data Source Connection Pool 
Utilization

Value: High

Symptom 1

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 2

CIT: J2EE Server ETI: JDBC Connection Pool Wait 
Count

Value: High

Symptom 3

CIT: J2EE Server ETI: Transaction Capacity 
Utilization

Value: High

Symptom 4

CIT: J2EE Server ETI: Transaction Commit Rate Value: High

Symptom 5

CIT: J2EE Server ETI: Transaction Start Date Value: High

Symptom 6

CIT: J2EE Server ETI: Transaction Time Value: High

Symptom 7

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Availability 

Value: Low
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J2EE::J2EE Server:EJB Concurrent Lives >> EJB Utilization

J2EE::J2EE Server:EJB Free Pool Wait Rate >> Servlet Performance

Symptom 8

CIT: JDBC Data Source ETI: JDBC Connection Pool Wait 
Count

Value: High

Description: EJB Concurrent Lives Impacts EJB Utilization

Cause

CIT: J2EE Server ETI: EJB Concurrent Lives Value: High

Symptom 1

CIT: J2EE Application ETI: EJB Utilization Value: High

Symptom 2

CIT: J2EE Server ETI: EJB Utilization Value: High

Description: EJB Free Pool Wait Rate Impacts Servlet Performance

Cause

CIT: J2EE Server ETI: EJB Free Pool Wait Rate Value: High

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: J2EE Server DataSource ConnectionPool Utilization Impacts 
Transaction Capacity Utilization and JDBC Connection Pool Wait Count and 
Transaction Time and Transaction Commit Rate and Transaction Start Rate and 
DataSource Connection Pool Availability
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J2EE::J2EE Server:EJB Performance >> EJB Free Pool Wait Rate & EJB 
Missed Count Rate & Servlet Performance

J2EE::J2EE Server:EJB Timeout Rate >> Servlet Performance & EJB 
Transaction Throughput Rate & EJB Transaction Rollback Rate

Description: EJB Performance Impacts EJB Free Pool Wait Rate and EJB Missed 
Count Rate and Servlet Performance

Cause

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Free Pool Wait Rate Value: High

Symptom 2

CIT: J2EE Application ETI: EJB Missed Count Rate Value: High

Symptom 3

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 4

CIT: J2EE Server ETI: EJB Free Pool Wait Rate Value: High

Symptom 5

CIT: J2EE Server ETI: EJB Missed Count Rate Value: High

Symptom 6

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: EJB Timeout Rate Impacts Servlet Performance and EJB Transaction 
Throughput Rate and EJB Transaction Rollback Rate

Cause

CIT: J2EE Server ETI: EJB Timeout Rate Value: High

Symptom 1

CIT: J2EE Application ETI: EJB Transaction Rollback Rate Value: High
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J2EE::J2EE Server:EJB Utilization >> DataSource Connection Waiters & 
DataSource Connection Pool Utilization

Symptom 2

CIT: J2EE Application ETI: EJB Transaction Throughput 
Rate

Value: High

Symptom 3

CIT: J2EE Application ETI: EJB Transaction Rollback Rate Value: High

Symptom 4

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: EJB Utilization Impacts DataSource Connection Waiters and 
DataSource Connection Pool Utilization

Cause

CIT: J2EE Server ETI: EJB Utilization Value: High

Symptom 1

CIT: J2EE Server ETI: DataSource Connection Pool 
Utilization

Value: High

Symptom 2

CIT: J2EE Server ETI: DataSource Connection 
Waiters

Value: High

Symptom 3

CIT: JDBC Data Source ETI: DataSource Connection 
Waiters

Value: High

Symptom 4

CIT: JDBC Data Source ETI: DataSource Connection Pool 
Utilization

Value: High

Description: EJB Timeout Rate Impacts Servlet Performance and EJB Transaction 
Throughput Rate and EJB Transaction Rollback Rate
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J2EE::J2EE Server:HTTP Sessions >> JVM Memory Utilization

J2EE::J2EE Server:JVM Memory Utilization >> Real User Transaction 
Performance & Real User Sessions Performance

Description: J2EE Server HTTP Sessions Impacts JVM Memory Utilization

Cause

CIT: J2EE Server ETI: HTTP Sessions Value: High

Symptom 1

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 2

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Server Memory Utilization Impacts Real User Transaction 
Performance and Real User Sessions Performance

Cause

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Performance event

Value: Critical

Symptom 3

CIT: J2EE Application ETI: EJB Transaction Rollback Rate Value: High

Symptom 4

CIT: J2EE Server ETI: Servlet Performance Value: Low
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J2EE::J2EE Server:JVM Memory Utilization >> Synthetic User 
Transaction Performance

J2EE::J2EE Server:JVM Memory Utilization >> Transaction Time & 
Transaction System Errors & Servlet Performance

Description: J2EE Server Memory Utilization Impacts Synthetic User Transaction 
Performance

Cause

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance event

Value: Critical

Description: J2EE Server JVMMemoryUtilization Impacts Transaction Time and 
Transaction System Errors and Servlet Performance

Cause

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Servlet Performance Value: Low

Symptom 3

CIT: J2EE Server ETI: Transaction System Errors Value: High

Symptom 4

CIT: J2EE Server ETI: Transaction Time Value: High
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J2EE::J2EE Server:Server Sessions >> JVM Memory Utilization 

J2EE::J2EE Server:Server Status >> Domain Status & Cluster Health & 
Cluster Status 

Description: J2EE Cluster Status Impacts Real User Transaction Availability and 
Synthetic User Transaction Availability and Real User Sessions Availability

Cause

CIT: J2EE Server ETI: Server Sessions Value: High

Symptom 1

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 2

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Server Status Impacts Domain Status and Cluster Health and 
Cluster Status

Cause

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Symptom 1

CIT: J2EE Cluster ETI: Cluster Health Value: Poor

Symptom 2

CIT: J2EE Cluster ETI: Cluster Status Value: Partial 
Stop

Symptom 3

CIT: J2EE Cluster ETI: Cluster Status Value: Stopped
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J2EE::J2EE Server:Server Status >> Real User Transaction Availability & 
Real User Sessions Availability 

Description: J2EE Server Status Impacts Real User Transaction Availability and Real 
User Sessions Availability

Cause

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions Availability Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Availability event

Value: Critical
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J2EE::J2EE Server:Server Status >> Synthetic User Transaction 
Availability 

J2EE::J2EE Server:Servlet Requests >> Real User Transaction Performance 
& Real User Sessions Performance

Description: J2EE Server Status Impacts Synthetic User Transaction Availability 

Cause

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Availability event

Value: Critical

Description: J2EE Server Servlet Requests Impacts Real User Transaction 
Performance and Real User Sessions Performance

Cause

CIT: J2EE Server ETI: Servlet Requests Value: High

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Performance event

Value: Critical
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J2EE::J2EE Server:Servlet Requests >> Synthetic User Transaction 
Performance

J2EE::J2EE Server:Servlet Requests >> Thread Pool Utilization & Active 
Sockets Count & JVM Memory Utilization & HTTP Sessions & Thread 
Requests Pending & Servlets Loaded & Interface Discard Rate & Interface 
Utilization

Description: J2EE Server Servlet Requests Impacts Synthetic User Transaction 
Performance

Cause

CIT: J2EE Server ETI: Servlet Requests Value: High

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance event

Value: Critical

Description: J2EE Server Servlet Requests Impacts Thread Pool Utilization and 
Active Sockets Count and JVM Memory Utilization and HTTP Sessions and Thread 
Requests Pending and Servlets Loaded and Interface Discard Rate and Interface 
Utilization

Cause

CIT: J2EE Server ETI: Servlet Requests Value: High

Symptom 1

CIT: Interface ETI: Interface Discard Rate Value: High

Symptom 2

CIT: Interface ETI: Interface Utilization Value: Higher 
Than Normal

Symptom 3

CIT: J2EE Server ETI: Active Sockets Count Value: High

Symptom 4 

CIT: J2EE Server ETI: Active Sockets Count Value: High
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J2EE::J2EE Server:Servlets Loaded >> JVM Memory Utilization

Symptom 5

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 6

CIT: J2EE Server ETI: Servlets Loaded Value: High

Symptom 7

CIT: J2EE Server ETI: Thread Pool Utilization Value: High

Symptom 8

CIT: J2EE Server ETI: Thread Requests Pending Value: High

Symptom 9

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Server Status Impacts Real User Transaction Availability and 
Synthetic User Transaction Availability and Real User Sessions Availability

Cause

CIT: J2EE Server ETI: Servlets Loaded Value: High

Symptom 1

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Server Servlet Requests Impacts Thread Pool Utilization and 
Active Sockets Count and JVM Memory Utilization and HTTP Sessions and Thread 
Requests Pending and Servlets Loaded and Interface Discard Rate and Interface 
Utilization
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J2EE::J2EE Server:ThreadPoolUtilization >> ExecuteQueueWaitCount & 
ActiveSocketsCount & ServletPerformance & DeferredThreadRequests & 
ThreadRequestWaitTime & ThreadRequestsPending & 
ThreadRequestServiceTime & ThreadPoolAvailability & 
JVMMemoryUtilization

Description: J2EE Server Thread Pool Utilization Impacts Execute Queue Wait 
Count and Active Sockets Count and Servlet Performance and Deferred Thread 
Requests and Thread Request Wait Time and Thread Requests Pending and Thread 
Request Service Time and Thread Pool Availability and JVM Memory Utilization

Cause

CIT: J2EE Server ETI: Thread Pool Utilization Value: High

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Active Sockets Count Value: High

Symptom 3

CIT: J2EE Server ETI: Deferred Thread Requests Value: High

Symptom 4

CIT: J2EE Server ETI: Execute Queue Wait Count Value: High

Symptom 5

CIT: J2EE Server ETI: JVM Memory Utilization Value: High

Symptom 6

CIT: J2EE Server ETI: Servlet Performance Value: Low

Symptom 7

CIT: J2EE Server ETI: Thread Pool Availability Value: Low

Symptom 8

CIT: J2EE Server ETI: Thread Request Service Time Value: High

Symptom 9

CIT: J2EE Server ETI: Thread Request Wait Time Value: High
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J2EE::J2EE Server:Total Garbage Collection Count >> CPU Load

J2EE::J2EE Server:Total Garbage Collection Time >> CPU Load

Symptom 10

CIT: J2EE Server ETI: Thread Requests Pending Value: High

Symptom 11

CIT: JVM ETI: JVM Memory Utilization Value: High

Description: J2EE Server Total Garbage Collection Count Impacts CPU Load

Cause

CIT: J2EE Server ETI: Total Garbage Collection 
Count

Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Description: J2EE Server Total Garbage Collection Time Impacts CPU Load

Cause

CIT: J2EE Server ETI: Total Garbage Collection 
Time

Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Description: J2EE Server Thread Pool Utilization Impacts Execute Queue Wait 
Count and Active Sockets Count and Servlet Performance and Deferred Thread 
Requests and Thread Request Wait Time and Thread Requests Pending and Thread 
Request Service Time and Thread Pool Availability and JVM Memory Utilization
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J2EE::J2EE Server:Total Number of Threads >> CPU Load & Memory 
Usage Level

J2EE::J2EE Server:Transaction Application Errors >> Transactions Rolled 
Back

Description: J2EE Server Total Number Of Threads Impacts CPU Load and Memory 
Usage Level

Cause

CIT: J2EE Server ETI: Total Number Of Threads Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Symptom 2

CIT: Computer ETI: Memory Usage Level Value: Higher 
Than Normal

Symptom 3

CIT: Computer ETI: Memory Usage Level Value: Much 
Higher Than 
Normal

Description: J2EE Server Transaction Application Errors Impacts Transactions 
Rolled Back

Cause

CIT: J2EE Server ETI: Transaction Application 
Errors

Value: High

Symptom 1

CIT: J2EE Server ETI: Transactions Rolled Back Value: High
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J2EE::J2EE Server:Transaction Resource Errors >> Transactions Rolled 
Back

J2EE::J2EE Server:Transaction System Errors >> Transactions Rolled Back

J2EE::J2EE Server:Transaction Time >> JDBC Connection Pool Wait 
Count

Description: J2EE Server Transaction Resource Errors Impacts Transactions Rolled 
Back

Cause

CIT: J2EE Server ETI: Transaction Resource Errors Value: High

Symptom 1

CIT: J2EE Server ETI: Transactions Rolled Back Value: High

Description: J2EE Server Transaction System Errors Impacts Transactions Rolled 
Back

Cause

CIT: J2EE Server ETI: Transaction System Errors Value: High

Symptom 1

CIT: J2EE Server ETI: Transactions Rolled Back Value: High

Description: J2EE Server Transaction System Errors Impacts Transactions Rolled 
Back

Cause

CIT: J2EE Server ETI: Transaction Time Value: High

Symptom 1

CIT: J2EE Server ETI: JDBC Connection Pool Wait 
Count

Value: High

Symptom 2

CIT: JDBC Data Source ETI: JDBC Connection Pool Wait 
Count

Value: High
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J2EE::J2EE Server:Transaction Timeout Errors >> Transactions Rolled 
Back

J2EE::JDBC Data Source:DataSource Connection Pool Availability >> 
EJBPerformance & Transaction Timeout Rate & Transaction Commit 
Rate

Description: J2EE Server Transaction Timeout Errors Impacts Transactions Rolled 
Back

Cause

CIT: J2EE Server ETI: Transaction Timeout Errors Value: High

Symptom 1

CIT: J2EE Server ETI: Transactions Rolled Back Value: High

Description: JDBC DataSource Connection Pool Availability Impacts 
EJBPerformance and Transaction Timeout Rate and Transaction Commit Rate

Cause

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: EJB Performance Value: Low

Symptom 3

CIT: J2EE Server ETI: Transaction Commit Rate Value: High

Symptom 4

CIT: J2EE Server ETI: Transaction Timeout Rate Value: High
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J2EE::JDBC Data Source:DataSource Connection Pool Performance >> 
EJB Performance

J2EE::JDBC Data Source:DataSource Connection Waiters >> DataSource 
Connection Pool Availability

Description: JDBC DataSource Connection Pool Performance Impacts EJB 
Performance

Cause

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Performance

Value: Low

Symptom 1

CIT: J2EE Application ETI: EJB Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: EJB Performance Value: Low

Description: JDBC DataSource Connection Waiters Impacts DataSource 
Connection Pool Availability

Cause

CIT: JDBC Data Source ETI: Data Source Connection 
Waiters

Value: High

Symptom 1

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 2

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Availability

Value: Low
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J2EE::JDBC Data Source:DataSource ConnectionPool Utilization >> 
Transaction Capacity Utilization & JDBC Connection Pool Wait Count & 
Transaction Time & Transaction Commit Rate & Transaction Start Rate 
& DataSource Connection Pool Availability

Description: JDBC DataSource ConnectionPool Utilization Impacts Transaction 
Capacity Utilization and JDBC Connection Pool Wait Count and Transaction 
Time and Transaction Commit Rate and Transaction Start Rate and DataSource 
Connection Pool Availability

Cause

CIT: JDBC Data Source ETI: Data Source Connection Pool 
Utilization

Value: High

Symptom 1

CIT: J2EE Server ETI: Data Source Connection Pool 
Availability

Value: Low

Symptom 2

CIT: J2EE Server ETI: JDBC Connection Pool Wait 
Count

Value: High

Symptom 3

CIT: J2EE Server ETI: Transaction Capacity 
Utilization

Value: High

Symptom 4

CIT: J2EE Server ETI: Transaction Commit Rate Value: High

Symptom 5

CIT: J2EE Server ETI: Transaction Start Rate Value: High

Symptom 6

CIT: J2EE Server ETI: Transaction Time Value: High

Symptom 7

CIT: JDBC Data Source ETI: DataSource Connection Pool 
Availability

Value: Low



Chapter 33: J2EE Content Pack

895

J2EE::JDBC Data Source:DataSource Leaked Connections Rate >> 
DataSource ConnectionPool Utilization

J2EE::JVM:All Processors Average Load >> CPU Load

Symptom 8

CIT: JDBC Data Source ETI: JDBC Connection Pool Wait 
Count

Value: High

Description: JDBC DataSource Leaked Connections Rate Impacts DataSource 
ConnectionPool Utilization

Cause

CIT: JDBC Data Source ETI: DataSource Leaked 
Connections Rate

Value: High

Symptom 1

CIT: J2EE Server ETI: DataSource ConnectionPool 
Utilization

Value: High

Symptom 2

CIT: JDBC Data Source ETI: DataSource ConnectionPool 
Utilization

Value: High

Description: JVM All Processors Average Load Impacts CPU Load

Cause

CIT: JVM ETI: All Processors Average Load Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Description: JDBC DataSource ConnectionPool Utilization Impacts Transaction 
Capacity Utilization and JDBC Connection Pool Wait Count and Transaction 
Time and Transaction Commit Rate and Transaction Start Rate and DataSource 
Connection Pool Availability
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J2EE::JVM:JVM Memory Utilization >> Real User Transaction 
Performance & Real User Sessions Performance 

J2EE::JVM:JVM Memory Utilization >> Synthetic User Transaction 
Performance 

J2EE::JVM:JVM Memory Utilization >> Transaction Time & Transaction 
System Errors & Servlet Performance

Description: JVM Memory Utilization Impacts Real User Transaction Performance 
and Synthetic User Transaction Performance and Real User Sessions Performance 

Cause

CIT: JVM ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Application

ETI: Real User Transaction 
Performance event

Value: Critical

Description: JVM Memory Utilization Impacts Synthetic User Transaction 
Performance 

Cause

CIT: JVM ETI: JVM Memory Utilization Value: High

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance event

Value: Critical

Description: JVMMemoryUtilization Impacts Transaction Time and Transaction 
System Errors and Servlet Performance 

Cause

CIT: JVM ETI: JVM Memory Utilization Value: High
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J2EE::JVM:Total Garbage Collection Count >> CPU Load

J2EE::JVM:Total Garbage Collection Time >> CPU Load

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Transaction System Errors Value: High

Symptom 3

CIT: J2EE Server ETI: Transaction Time Value: High

Description: JVM Total Garbage Collection Count Impacts CPU Load 

Cause

CIT: JVM ETI: Total Garbage Collection 
Count

Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Description: JVM Total Garbage Collection Time Impacts CPU Load 

Cause

CIT: JVM ETI: Total Garbage Collection 
Time

Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Overloaded

Description: JVMMemoryUtilization Impacts Transaction Time and Transaction 
System Errors and Servlet Performance 
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J2EE::JVM:Total Number Of Threads >> CPU Load & Memory Usage 
Level

J2EE::Network Interface:Interface Communication Status >> Server 
Status 

J2EE::Network Interface:Interface Utilization >> Real User Transaction 
Performance & Real User Sessions Performance 

Description: JVM Total Number Of Threads Impacts CPU Load and Memory Usage 
Level 

Cause

CIT: JVM ETI: Total Number Of Threads Value: High

Symptom 1

CIT: Computer ETI: CPU Load Value: 
Constrained

Symptom 2

CIT: Computer ETI: Memory Usage Level Value: Higher 
Than Normal

Description: Network Interface Communication Status Impacts Server Status 

Cause

CIT: Interface ETI: Interface Communication 
Status

Value: 
Unavailable

Symptom 

CIT: J2EE Server ETI: Server Status Value: 
Unavailable

Description: Network Interface Utilization Impacts Real User Transaction 
Performance and Real User Sessions Performance 

Cause

CIT: Interface ETI: Interface Utilization Value: Higher 
Than Normal
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J2EE::Network Interface:Interface Utilization >> Servlet Performance

J2EE::Network Interface:Interface Utilization >> Synthetic User 
Transaction Performance 

Symptom 1

CIT: Business 
Application

ETI: Real User Sessions 
Performance

Value: Critical

Symptom 2

CIT: Business 
Transaction

ETI: Real User Transaction 
Performance event

Value: Critical

Description: Network Interface Utilization Impacts Servlet Performance 

Cause

CIT: Interface ETI: Interface Utilization Value: Higher 
Than Normal

Symptom 1

CIT: J2EE Application ETI: Servlet Performance Value: Low

Symptom 2

CIT: J2EE Server ETI: Servlet Performance Value: Low

Description: Network Interface Utilization Impacts Synthetic User Transaction 
Performance

Cause

CIT: Interface ETI: Interface Utilization Value: Higher 
Than Normal

Symptom 1

CIT: Business 
Application

ETI: Synthetic User Transaction 
Performance

Value: Critical

Description: Network Interface Utilization Impacts Real User Transaction 
Performance and Real User Sessions Performance 
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HI Assignment
The following table lists the HI assignments for J2EE Content Pack.

HI Mapping HI Assignment

J2EE Application J2EE Application Mapping for HIs assignment 

J2EE Application Mapping for HIs assignment with 
empty monitor

J2EE Cluster J2EE Cluster for HIs assignment 

J2EE Cluster for HIs assignment with empty monitor

J2EE Domain J2EE Domain Mapping for HIs assignment 

J2EE Domain Mapping for HIs assignment with empty 
monitor

J2EE Server J2EE Server Mapping for HIs assignment 

J2EE Server Mapping for HIs assignment with empty 
monitor

JDBC Data Source JDBC Data Source Mapping for HIs assignment

JDBC Data Source Mapping for HIs assignment with 
empty monitor

JVM JVM Mapping for HIs assignment 

JVM Mapping for HIs assignment with empty monitor
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KPI Assignment
The following table lists the KPI assignments for J2EE Content Pack. 

CI Type KPI Assignment

J2EE Application J2EE Application Mapping for Service Health

J2EE Application Mapping for SLM

J2EE Cluster J2EE Cluster Mapping for Service Health

J2EE Cluster Mapping for SLM

J2EE Domain J2EE Domain Mapping for Service Health

J2EE Domain Mapping for SLM

J2EE Server J2EE Server Mapping for Service Health

J2EE Server Mapping for SLM

JDBC Data Source JDBC Data Source Mapping for Service Health

JDBC Data Source Mapping for SLM

JVM JVM Mapping for Service Health

JVM Mapping for SLM
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Dependent Content Packs
The J2EE Content Pack is dependent on the following Content Packs:

➤ HPOprInf

➤ HPOprOra

➤ HPOprMss

➤ EUM_BPM 

➤ EUM_RUM

➤ OOTB KPIs

The J2EE Content Pack depends on EUM Content Pack for its deployment. 
You must deploy the EUM Content Pack in CREATE mode.

Referenced Content from other Content Packs

Indicator CI Type
Dependent 
Content Pack

Content Pack 
Version

Real User Transaction 
Availability event

Business 
Application

EUM_RUM 1.00

Real User Transaction 
Performance event

Business 
Application

EUM_RUM 1.00

Synthetic User Transaction 
Availability event

Business 
Application

EUM_BPM 1.00

Synthetic User Transaction 
Performance event

Business 
Application

EUM_BPM 1.00

CPU Load Computer HPOprInf 9.10

Memory Usage Level Computer HPOprInf 9.10

Disk Usage Level FileSystem HPOprInf 9.10

Interface Communication 
Status

Interface HPOprInf 9.10

Interface Discard Rate Interface HPOprInf 9.10

Interface Utilization Interface HPOprInf 9.10
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CPU Usage by SQL Database HPOprOra 9.10

Database Server Status Database HPOprMss 9.10

SQL Query Performance Database HPOprMss 9.10

KPI
Dependent Content 
Pack

Content Pack 
Version

Software Availability (Service 
Health)

OOTB KPIs 1.00

Software Availability (SLM) OOTB KPIs 1.00

Software Performance (Service 
Health)

OOTB KPIs 1.00

Software Performance (SLM) OOTB KPIs 1.00

Indicator CI Type
Dependent 
Content Pack

Content Pack 
Version
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Tool Definitions
The content pack contains the following tools mapped to various CI types 
and Tool Category.

CI Type Tool Tool Category

J2EE Server J2EE Standards, starts a web 
browser and connects to the J2EE 
Management Specifications site.

J2EE Information Tools

Weblogic AS Get Invalid Login Attempts Count J2EE Admin Tools

Number of Socket Connections 
Opened

J2EE Operational Tools

Percentage of Heap Space Used J2EE Operational Tools

View Application Activation 
Status

J2EE Operational Tools

View Weblogic Domain Contents J2EE Operational Tools

View Weblogic Server Application 
Timeout

J2EE Operational Tools

View Weblogic Server Status J2EE Admin Tools

Websphere AS Number of Sessions Currently 
Accessed

J2EE Operational Tools

Percentage of Heap Space Used J2EE Operational Tools

Percentage of Time Thread Pool 
Used is Maximum.

J2EE Operational Tools

View Collection Status, displays 
the collection status for the 
servers.

J2EE Admin Tools
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Graph Templates for SPI for WebSphere Server
The content pack contains the SPI for WebSphere graph family mapped to 
the WebSphere CI type.

The following table lists the graph templates present in the SPI for 
WebSphere graph family and the mapped policies. 

Graph 
Templates Metric Name Metric Description

ThreadPool I013_THREADPOOLPCTMAX Percentage of time the 
number of threads in pool 
reached the configured 
maximum size.

I014_THRDPOOLCRTRT Number of threads created 
per minute (used only for 
graphing).

I812_THRDPOOLHUNGRT Number of threads hung per 
minute.

I813_CCRTTHDPLHNGCT Number of concurrent hung 
threads.

EJB Pool I020_EJBPOOLUTIL Percentage of beans in the 
pool.

I025_EJBPOOLMISSPCT Average percentage of time a 
call to retrieve an EJB from 
the pool failed.

EJB Activity I022_EJBMETHCALLSRT Number of EJB method calls 
per minute.

I024_EJBENTDATALDSTRT Number of times an EJB was 
written to or loaded from the 
database per minute.

I810_MSGBACKOUTRATE Message backout rate.

I811_RETURNDISCRDRT Returns discard rate.

EJB Pool Size I026_EJBCONCLIVES Average percentage of bean 
objects in the pool.
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Servlet Session 
Activity

I040_SERVSESSAVERAGELIFE Average lifetime for a servlet 
session.

I041_SERVSESSACTSESS Active servlet sessions.

Servlet Session 
Invalidations

I042_SERVINVSESSRT Servlet invalidated session 
rate.

I045_WEBAPPSERVREQRT Number of request for a 
servlet per second

I047_WEBAPPSERVERRRT Number of errors in a servlet 
per second.

Web 
Application

I048_WEBAPPSERVLOAD Web application servlet load

I049_WEBAPPSERVRELRT Number of servlets reloaded 
for a web application per 
minute.

JDBC Pool Waits I061_JDBCCONPOOLWAIT Average percentage of 
threads waiting for a 
connection from connection 
pools.

I062_JDBCONPOOLWTTIM Average time that a client 
waited for a connection in 
msecs.

JDBC Pool 
Performance

I065_JDBCONPOOLTIMRT Number of times a client 
timed out waiting for a 
connection from the pool 
per minute.

I066_JDBCONPOOLTHRU Number of connections 
allocated and returned by 
applications per second.

JDBC SQL 
Statistics

I814_PRDSTCCHDSRDRT Prepared statement discard 
rate.

Graph 
Templates

Metric Name Metric Description
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Transaction 
Duration Times

I070_TRANGLOBDUR Transaction global duration

I071_TRANLOCDUR Transaction local duration

I072_TRANGLOBCOMMDUR Transaction global commit 
duration

I073_TRANLOCCOMMDUR Transaction local commit 
duration

Transaction 
Activity

I074_TRANROLLBACKRT Transaction rollback rate

I075_TRANTIMEOUTRT Transaction timeout rate

I076_TRANCOMMITRT Transaction commit rate

I077_TRANTHRUPUT Number of global and local 
transactions that were 
completed per second.

I078_TRANSTARTRT Transaction start rate

JVM Utilization I005_JVMMEMUTILPCT JVM memory utilization 
percent

I807_JVMMEMFREEPCT JVM memory free percent

I808_JVMCPUUSAGEPCT JVM memory CPU usage 
percent

I809_GCINTERVALTIME Garbage collection value

Graph 
Templates

Metric Name Metric Description
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Graph Templates for SPI for WebLogic Server
The following table lists the graph templates present in the SPI for WebLogic 
graph family and the mapped policies.

Graph 
Templates

Metric Name Metric Description

Transaction 
Performance

B070_TRANAVETIME Transaction average time

B076_TRANTHRURATE Number of transactions 
processed per second.

B077_TRANHEURCNT Transaction heuristic count

B079_TRANCAPUTIL Transaction capacity utilization

JDBC Pool 
Waits

B061_JDBCCONPLWTCNT JDBC connection pool wait 
count

B063_JDBCCONLKRTSUM Number of connections which 
are not closed.

ThreadPool B010_EXQUETHRURATE Requests services by execute 
queue

B011_EXQTHRDUTILPCT Execute queue thread 
utilization percent

B012_EXQUEWAITCNT Execute queue wait count

B283_DEFERREDREQSCNT Number of deferred requests

B284_REQWAITTIMTHRD Thread request wait time

B285_PENDINGREQCOUNT Number of pending request

B286_PENDINGREQPCT Percentage of requests pending

B287_REQMAXWAITTIME Maximum time a request had 
to wait for a thread.

B288_STANDBYTHRDCNT Number of threads in a 
standby pool
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EJB 
Performance

B025_EJBPOOLWTRTSUM Aggregate EJB free pool wait 
rate

B026_EJBTIMEOUTRTSUM EJB timeout rate

B035_EJBTRANTHRURT EJB transaction throughput 
rate

B036_EJBTRANRBRT EJB transaction rollback rate

EJB Pool 
Statistics

B822_DSTROYDTLCNT Destroyed total count

B823_EJBMSSDCNTRTSUM Aggregate miss total count rate

Cluster B080_CLSOUTMESFAILRT Cluster Outgoing Message 
Failure Rate

B081_CLSINMESFAILRT Cluster Incoming Message 
Failure Rate

Server Statistics B013_SOCKETTRAFFICRT Socket Traffic Rate

B014_ACTIVESOCKETCNT Active Socket Count

B015_SRVRRESTARTSPCT Server Restarts Percentage

B078_CNCTRLEAKRTSUM Connector Connections Pool 
Leakage

JVM Utilization B005_JVMMEMUTILPCT JVM Memory Utilization 
Percent

JVM Free 
Memory

B819_JVMHEAPFREEMEM JVM Heap Free Memory

Transaction 
Rollback 
Analysis

B072_TRANRESERRRBPCT Transaction Resource Error 
Rollback Percent

B073_TRANAPPERRRBPCT Transaction Application Error 
Rollback Percent

B074_TRANTIMERRRBPCT Transaction Time Error 
Rollback Percent

B075_TRANSYSERRRBPCT Transaction System Error 
Rollback Percent

Graph 
Templates

Metric Name Metric Description



Chapter 33: J2EE Content Pack

910

Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

Transaction 
Rollback 
Percent

B071_TRANROLLBACKPCT Transaction Rollback Percent

Security B085_INVLOGINATTCNT Invalid Login Attempts Count

ETI/HI Policy Name Policy Description

Server Status WLSSPI_0001 The server status in terms of 
availability.

WBSSPI_0001

Thread Pool Utilization WLSSPI_0011 The number of threads used in 
the server to execute tasks.

WLSSPI_0016

Active Sockets Count WLSSPI_0014 The number of HTTP socket 
connection opened to the server.

Server Sessions WBSSPI_0041 The number of sessions opened 
to the server.

Servlets Loaded WBSSPI_0048 The number of servlets currently 
loaded for a web application.

Thread Pool Availability WLSSPI_0288 The availability of threads in the 
thread pool.

Thread Pool Utilization WBSSPI_0212 The number of threads used in 
the server to execute the tasks.

Thread Hung Rate WBSSPI_0812 The rate at which the threads are 
declared hung.

Transaction Time WLSSPI_0070 Time taken to complete a 
transaction.

Graph 
Templates

Metric Name Metric Description
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Transactions Rolled Back WLSSPI_0071 Number/Percentage of 
transactions rolled back due to 
system, resource or other errors.

Transactions Rolled Back 
Rate 

WBSSPI_0074 Number/Percentage of 
transactions rolled back due to 
system, resource or other errors.

Transaction Timeout Rate WBSSPI_0075 The number of transactions that 
timed out per second.

Transaction Commit Rate WBSSPI_0076 The number of transactions that 
were committed per second.

Transaction Start Date WBSSPI_0078 The number of transactions that 
were begun per second.

Transaction Capacity 
Utilization

WLSSPI_0079 The number of simultaneous in 
progress transactions.

JMS Server Utilization WLSSPI_0251 The JMS server queue 
utilization.

WLSSPI_0252

Execute Queue Wait Count WLSSPI_0012 The number of client requests 
waiting to be serviced by the 
execute queue.

Transaction Resource Errors WLSSPI_0072 Transaction errors caused due to 
system resource errors.

Transaction Application 
Errors

WLSSPI_0073 Transaction errors caused due to 
application errors.

Transaction Timeout Errors WLSSPI_0074 Transaction errors caused due to 
timeout errors.

Transaction System Errors WLSSPI_0075 Transaction errors caused due to 
system errors.

Deferred Thread Requests WLSSPI_0283 Number of threads that were 
denied a thread for execution 
because of the maximum thread 
constraint.

ETI/HI Policy Name Policy Description
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Thread Request Wait Time WLSSPI_0284 The time a request had to wait 
for a thread.

Threads Request Pending WLSSPI_0286 The requests that are pending 
because of available threads.

Thread Request Service 
Time

WLSSPI_0287 The time a request had to wait 
for a thread.

JVM Memory Utilization WLSSPI_0005 The percentage of heap size 
used.

WBSSPI_0005

Total Garbage Collection 
Count

WLSSPI_0006 The number of times garbage 
collector has run.

WBSSPI_0804

Total Garbage Collection 
Time

WLSSPI_0007 Total time taken for garbage 
collection.

WBSSPI_0805

Total Number of Threads WLSSPI_0008 Total number of threads 
spawned for garbage collection.

WBSSPI_0803

All Processors Average Load WLSSPI_0009 Average load on all the 
processors on the system.

WBSSPI_0801

Cluster Outgoing Message 
Failure Rate

WLSSPI_0080 The number of multicast 
messages to the cluster that were 
resent.

Cluster Incoming Message 
Failure Rate

WLSSPI_0081 The number of multicast 
messages from the cluster that 
were lost.

Cluster Health WLSSPI_0082 Cluster Health in terms of 
performance.

Cluster Status WBSSPI_0006 Cluster Status in terms of 
availability.

EJB Transaction Throughput 
Rate

WLSSPI_0235 Number of EJBs Transactions 
completed in unit time.

ETI/HI Policy Name Policy Description
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EJB Transaction Rollback 
Rate

WLSSPI_0236 Number of EJB Transaction 
rolled back in unit time.

EJB FreePool Wait Rate WLSSPI_0225 The number of times per minute 
no EJBs were available from the 
free pool.

EJB Concurrent Lives WBSSPI_0226 The average number of bean 
objects in the pool.

EJB Timeout Rate WLSSPI_0226 The number of times per minute 
a client timed out waiting for an 
EJB.

EJB Performance WLSSPI_0238 The performance statistics 
namely cache utilization.

WBSSPI_0221

EJB Missed Count Rate WLSSPI_0824 The total number of times a 
failed attempt was made to get 
an instance from the free pool.

EJB Utilization WBSSPI_0220 The utilization of the EJB pool.

Servlet Performance WLSSPI_0240 The performance statistics such 
as execution time.

WBSSPI_0246

Servlet Requests WLSSPI_0242 Number of incoming requests to 
the servlet.

WBSSPI_0245

HTTP Sessions WLSSPI_0245 Number of open servlet sessions.

JDBC Connection Pool Wait 
Count

WLSSPI_0061 The number of clients waiting 
for a JDBC connection.

Data Source Connection 
Waiters

WBSSPI_0261 The average number of threads 
waiting for a connection from 
the connection pool.

Data Source Connection 
Pool Utilization

WLSSPI_0260 DataSource connection pool 
utilization.

WBSSPI_0263

Data Source Leaked 
Connections Rate

WLSSPI_0263 The rate of new leaked JDBC 
connections.

ETI/HI Policy Name Policy Description
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Operations Orchestration Flow
The following table lists the Operations Orchestration (OO) flows for J2EE 
Content Pack.

Application Server Health Check and Application Server Performance 
Check

When creating the mapping defined in the preceding table, you can set 
default values for the attributes listed in the following table.

Data Source Connection 
Pool Availability

WLSSPI_0264 Availability of JDBC connections 
in the connection pool.

WLSSPI_0265

WBSSPI_0262

WBSSPI_0265

Data Source Connection 
Pool Performance

WBSSPI_0266 DataSource connection pool 
performance.

OO Flow Flow Input CI Type CI Attribute
Event 
Attribute

Application 
Server 
Health 
Check

omServer 
jeeserverName

J2EEServer J2eeserver_fullname Originating 
Server

Application 
Server 
Performance 
Check

Attribute Description

omServerPort Port number of the HPOM Tool WS.

omServerUser User name for the HPOM Server.

omServerPassword Password for the HPOM Server.

ETI/HI Policy Name Policy Description
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For more information about creating the mapping and a Run Book 
automation rule, see "How to Create a Run Book Automation Rule" on 
page 505.

The following are the user input values when you execute OO flow for 
Application Server Health Check and Application Server Performance 
Check. 

JDBC Health Check

When creating the mapping defined in the preceding table, you can set 
default values for the attributes listed in the following table.

User Input Value

omNode Target node with an HPOM Agent (DNS name of the 
HPOM managed node).

jeeserver Valid values are wls and wbs.

OO Flow
Flow 
Input CI Type CI Attribute Event Attribute

JDBC 
Health 
Check

omServer 
instance

jdbcdatasource name Originating 
Server

Attribute Description

omServerPort Port number of the HPOM Tool WS

omServerUser User name for the HPOM Server

omServerPassword Password for the HPOM Server 
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The following are the user input values when you execute OO Flow for JDBC 
Health Check.

User Input Value

omNode Target node with an HPOM Agent (DNS name of the 
HPOM managed node).

jeeserver Valid values are wls and wbs.

jeeservername J2EE server name (full name).



917

34
Microsoft Content Packs

This chapter includes:

Reference

➤ Microsoft Active Directory Server Content Pack on page 918

➤ Microsoft Exchange Server Content Pack on page 960

➤ Microsoft Lync Server 2010 Content Pack on page 1016
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Reference

Microsoft Active Directory Server Content Pack

The Microsoft Active Directory Server Content Pack contains the following 
artifacts:

➤ Views on page 919

➤ Enrichment Rules on page 922

➤ Health Indicators on page 922

➤ Correlation Rules on page 928

➤ Tool Definitions on page 944

➤ Graph Templates on page 944

➤ Policies Setting ETIs on page 946

➤ Operations Orchestration Flow on page 955
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Views
The RTSM package in the Microsoft Active Directory Server Content Pack 
contains the following views:

➤ AD_Physical_View: This view refers to the Active Directory System, Active 
Directory Site, Domain Controller, DomainNamingMaster, and Computer 
(Windows) CI types.
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➤ AD_Logical_view: This view refers to the Active Directory System, Active 
Directory Forest, Active Directory Domain, Domain Controller, 
SchemaMaster, DomainNamingMaster, PrimaryDomainControllerMaster, 
RelativeIDMaster, InfrastructureMaster, BridgeHeadServer, 
GlobalCatalogServer, and Computer CI types.
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➤ AD_Network_Deployment_View: This view refers to the Active Directory 
System, Active Directory Forest, Active Directory Domain, Domain Controller, 
SchemaMaster, DomainNamingMaster, PrimaryDomainControllerMaster, 
RelativeIDMaster, InfrastructureMaster, BridgeHeadServer, 
GlobalCatalogServer, and Node CI types.
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Enrichment Rules
The Microsoft Active Directory Server Content Pack contains the following 
Enrichment Rules:

➤ DomainController_Uses_DnsServer

➤ DomainController_Uses_Log_FileSystem

➤ DomainController_Uses_NTDS_FileSystem

➤ DomainController_Uses_SysVol_FileSystem

Health Indicators
The content pack includes the following health indicators (HIs) to monitor 
Active Directory-related events:

CI Type HI Description Value

Domain 
Controller
Role

Response Time Indicates the ping response 
time of FSMO roles.

Normal, 
High, 
Very High

Domain 
Controller

Access Permissions 
Errors

Indicates the number of 
Access Permission Errors on 
the Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

CName Records 
Availability

Indicates the availability of 
CName Records on the DNS 
Server of the Domain 
Controller.

Found, 
Not Found

Domain 
Controller

DC LDAP Bind 
Response Time

Indicates the response time to 
bind to LDAP on domain 
controller.

Normal, 
High, 
Very High

Domain 
Controller

DC LDAP Query 
Response Time

Indicates the response time of 
a sample LDAP query on 
domain controller.

Normal, 
High, 
Very High

Domain 
Controller

DFRS Service State Indicates the status of DFSR 
Service on the Domain 
Controller.

Up, 
Down
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Domain 
Controller

DIT Disk Queue 
Length

Indicates the queue length of 
DIT disk.

Normal, 
High, 
Very High

Domain 
Controller

DIT Disk Space 
Availability

Indicates the availability of 
free space on DIT disk.

Normal, 
Low, 
Near Capacity

Domain 
Controller

DIT Log Files Disk 
Queue Length

Indicates the queue length of 
DIT Log Files disk.

Normal, 
High, 
Very High

Domain 
Controller

DIT Log Files Disk 
Space Availability

Indicates the availability of 
free space on DIT Log Files 
Disk.

Normal, 
Low, 
Near Capacity

Domain 
Controller

DNS Query 
Response

Indicates the response time of 
a sample DNS Query on 
domain controller.

Normal, 
High,
Very high

Domain 
Controller

FRS Status Indicates the status of File 
Replication Service.

Up, 
Down

Domain 
Controller

Host Records 
Availability

Indicates the availability of 
Host Records on the DNS 
Server of the Domain 
Controller.

Found, 
Not found

Domain 
Controller

Inbound Object 
Updates 
Remaining

Indicates the number of 
Inbound Object Updates 
remaining.

Normal, 
High, 
Very High

Domain 
Controller

Inter site 
Replication 
Latency

Indicates the replication 
latency of the Domain 
Controller across AD Sites.

Normal, 
High, 
Very High

Domain 
Controller

Intra site 
Replication 
Latency

Indicates the Replication 
Latency of the Domain 
Controller within the AD 
Site.

Normal, 
High, 
Very High

Domain 
Controller

ISM Service Status Indicates the status of 
Intersite Messaging Service.

Up, 
Down

CI Type HI Description Value
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Domain 
Controller

KDC Service Status Indicates the status of 
Kerberos Distribution Centre 
Service.

Up, 
Down

Domain 
Controller

Kerberos 
Authentication 
Rate

Indicates the rate of Kerberos 
Authentication on the 
Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

Kerberos 
SrvRecords 
Availability

Indicates the availability of 
Kerberos Server Records on 
the DNS Server.

Found, 
Not Found

Domain 
Controller

LDAP Active 
Threads

Indicates the number of 
LDAP threads which are 
active on the Domain 
Controller.

Normal, 
High, 
Very High

Domain 
Controller

LDAP Client 
Sessions

Indicates the number LDAP 
Client Sessions on the 
Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

LDAP SrvRecords 
Availability

Indicates the availability of 
LDAP Server Records on the 
DNS Server of the 
DomainController.

Found, 
Not Found

Domain 
Controller

Logon Errors Indicates the number of 
Logon Errors on the Domain 
Controller.

Normal, 
High, 
Very High

Domain 
Controller

LSASS Page Faults 
Rate

Indicates rate of Page Faults 
for Local Security Authority 
Subsystem Service.

Normal, 
High, 
Very High

Domain 
Controller

LSASS Private 
Bytes

Indicates the Private Bytes 
used by Local Security 
Authority Subsystem Service 
on the Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

LSASS Processor 
Time

Indicates the Processor Time 
used by Local Security 
Authority Subsystem Service 
on the Domain Controller.

Normal, 
High, 
Very High

CI Type HI Description Value
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Domain 
Controller

LSASS Working Set Indicates the Working Set of 
the Local Security Authority 
Subsystem Service.

Normal, 
High, 
Very High

Domain 
Controller

Net Logon Service 
State

Indicates the status of Net 
Logon Service on the Domain 
Controller.

Up, 
Down

Domain 
Controller

Non Transitive 
Membership 
Evaluations

Indicates the number of non 
transitive membership 
evaluations performed.

Normal, 
High, 
Very High

Domain 
Controller

Notify Queue Size Indicates the size of notify 
queue.

Normal, 
High, 
Very High

Domain 
Controller

NTDS Service State Indicates the status of NTDS 
Services on the Domain 
Controller.

Up, 
Down

Domain 
Controller

NTFRS Page Faults 
Rate

Indicates rate of Page Faults 
for NTFRS process.

Normal, 
High, 
Very High

Domain 
Controller

NTFRS Private 
Bytes

Indicates the Private Bytes 
used by the File Replication 
Service.

Normal, 
High, 
Very High

Domain 
Controller

NTFRS Processor 
Time

Indicates the processor time 
used by the File Replication 
Service on the Domain 
Controller.

Normal, 
High, 
Very High

Domain 
Controller

NTFRS Working 
Set

Indicates the Working Set of 
the File Replication Service 
on the Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

NTLM 
Authentication 
Rate

Indicates the rate of NTLM 
Authentication on the 
Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

Pending 
Replication 
Synchronizations

Indicates the number of 
pending replication 
synchronizations.

Normal, 
High, 
Very High

CI Type HI Description Value
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Domain 
Controller

SamSs Service 
State

Indicates the state of Security 
Accounts Manager Service on 
the Domain Controller.

Up, 
Down

Domain 
Controller

Security Descriptor 
Propagator Queue

Indicates the length of 
Security Descriptor 
Propagator Queue on the 
Domain Controller.

Normal, 
High, 
Very High

Domain 
Controller

Sysvol 
Connectivity

Indicates the connectivity to 
Sysvol folder.

Up, 
Down

Domain 
Controller

Sysvol Disk Space 
Availability

Indicates the availability of 
free space on Sysvol disk.

Normal, 
Low, 
Near Capacity

Domain 
Controller

Transitive 
Membership 
Evaluations

Indicates the number of 
Transitive Membership 
Evaluations performed on the 
Domain Controller.

Normal, 
High, 
Very High

Global 
Catalog

GC LDAP Bind 
Response Time

Indicates the response time to 
bind to LDAP on global 
catalog.

Normal, 
High, 
Very High

Global 
Catalog

GC LDAP Query 
Response Time

Indicates the response time of 
a sample LDAP Query on 
Global Catalog.

Normal, 
High, 
Very High

Global 
Catalog

GC Replication 
Latency

Indicates the replication 
latency on global catalog.

Normal, 
High,
Very High

Domain 
Controller

Directory Read 
Rate 

Indicates the rate of Directory 
Read.

Normal, 
High, 
Very High

Domain 
Controller

Directory Search 
Rate 

Indicates the rate of Directory 
Search.

Normal, 
High, 
Very High

Domain 
Controller

Directory Write 
Rate 

Indicates the rate of Directory 
Write.

Normal, 
High, 
Very High

CI Type HI Description Value
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Domain 
Controller

Inbound 
Replication Object 
Rate

Indicates the rate of Inbound 
Replication Objects.

Normal, 
High, 
Very High

Domain 
Controller

LDAP 
Connectivity 

Indicates the LDAP 
Connectivity.

Up, 
Down

Domain 
Controller

GC Connectivity Indicates the GC 
Connectivity.

Up, 
Down

Domain 
Controller

Outbound 
Replication Object 
Rate 

Indicates the rate of 
Outbound Replication 
Objects.

Normal, 
High, 
Very High

Domain 
Controller

Synchronization 
Failure Rate

Indicates the rate of 
synchronization failures.

Normal, 
High, 
Very High

Domain 
Controller

Sysvol Disk Queue 
Length 

Indicates the length of Sysvol 
Disk Queue.

Normal, 
High, 
Very High

CI Type HI Description Value
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Correlation Rules
The content pack includes the following rules to correlate Active 
Directory-related events.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

AD::DomainController:CNameRecordsAvailability >> 
InterSiteReplicationLatency & IntraSiteReplicationLatency

AD::DomainController:DIT Disk Queue Length >> DomainController 
Performance

Description: CName Records Availability on the DNS Server of the Domain Controller 
Impacts Inter and Intra Site Replication Latency

Cause

CIT: Domain Controller ETI: CName Records 
Availability

Value: Not Found

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Description: DIT Disk Queue Length Impacts DC Performance

Cause

CIT: Domain Controller ETI: DIT Disk Queue Length Value: Very High

Symptom 1

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time

Value: Very High
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AD::DomainController:DIT Disk Queue Length >> GlobalCatalog 
Performance

Symptom 2

CIT: Domain Controller ETI: DC LDAP Query Response 
Time

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining

Value: Very High

Symptom 4

CIT: Domain Controller ETI: Pending Replication 
Synchronizations

Value: Very High

Description: DIT Disk Queue Length Impacts GC Performance

Cause

CIT: Domain Controller ETI: DIT Disk Queue Length Value: Very High

Symptom 1

CIT: Global Catalog 
Server

ETI: GC LDAP Bind Response 
Time

Value: Very High

Symptom 2

CIT: Global Catalog 
Server

ETI: GC LDAP Query Response 
Time

Value: Very High

Description: DIT Disk Queue Length Impacts DC Performance
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AD::DomainController:DIT Disk Space Availability >> DIT Disk Queue 
Length & Inbound Object Updates Remaining

AD::DomainController:DIT Log Files Disk Space Availability >> DIT Log 
Files Disk Queue Length

Description: Available DIT Disk Space Impacts DIT Disk Queue Length and Inbound 
Object Updates Remaining

Cause

CIT: Domain Controller ETI: DIT Disk Space Availability Value: Near Capacity

Symptom 1

CIT: Domain Controller ETI: DIT Disk Queue Length Value: Very High

Symptom 2

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining

Value: Very High

Description: Available Disk Space for DIT Log Files Impact DIT Log Files Disk Queue 
Length

Cause

CIT: Domain Controller ETI: DIT Log Files Disk Space 
Availability

Value: Near Capacity

Symptom

CIT: Domain Controller ETI: DIT Log Files Disk Queue 
Length

Value: Very High
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AD::DomainController:FRS Status >> InterSiteReplicationLatency & 
IntraSiteReplicationLatency

AD::DomainController:HostRecordsAvailability >> 
InterSiteReplicationLatency & IntraSiteReplicationLatency

Description: File Replication Service Status Impacts DC Replication Latency

Cause

CIT: Domain Controller ETI: FRS Status Value: Down

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Description: Host Records Availability on the DNS Server of the Domain Controller 
Impacts Inter and Intra Site Replication Latency

Cause

CIT: Domain Controller ETI: Host Records Availability Value: Not Found

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High
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AD::DomainController:ISMServiceStatus >> InterSiteReplicationLatency 
& IntraSiteReplicationLatency

AD::DomainController:KDCServiceStatus >> 
InterSiteReplicationLatency & IntraSiteReplicationLatency

Description: ISM Service Status Impacts Inter and Intra Site Replication Latency on the 
Domain Controller

Cause

CIT: Domain Controller ETI: ISM Service Status Value: Down

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Description: KDC Service Status Impacts Inter and Intra Site Replication Latency on the 
Domain Controller

Cause

CIT: Domain Controller ETI: KDC Service Status Value: Down

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High



Chapter 34: Microsoft Content Packs

933

AD::DomainController:KerberosSrvRecordsAvailability >> 
InterSiteReplicationLatency & IntraSiteReplicationLatency

AD::DomainController:LDAPSrvRecordsAvailability >> 
InterSiteReplicationLatency & IntraSiteReplicationLatency

Description: Kerberos Server Records Availability on the DNS Server of the Domain 
Controller Impacts Inter and Intra Site Replication Latency

Cause

CIT: Domain Controller ETI: Kerberos Server Records 
Availability

Value: Not Found

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Description: LDAP Server Records Availability on the DNS Server of the Domain 
Controller Impacts Inter and Intra Site Replication Latency

Cause

CIT: Domain Controller ETI: LDAP Server Records 
Availability

Value: Not Found

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High
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AD::DomainController:LSASS Page Faults Rate >> DomainController 
Performance

AD::DomainController:LSASS Page Faults Rate >> GlobalCatalog 
Performance

Description: LSASS Page Faults Rate Impacts DC Performance

Cause

CIT: Domain Controller ETI: LSASS Page Faults Rate Value: Very High

Symptom 1

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time

Value: Very High

Symptom 2

CIT: Domain Controller ETI: DC LDAP Query Response 
Time

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining

Value: Very High

Symptom 4

CIT: Domain Controller ETI: Pending Replication 
Synchronizations

Value: Very High

Description: LSASS Page Faults Rate Impacts GC Performance

Cause

CIT: Domain Controller ETI: LSASS Page Faults Rate Value: Very High

Symptom 1

CIT: Global Catalog 
Server

ETI: GC LDAP Bind Response 
Time

Value: Very High

Symptom 2

CIT: Global Catalog 
Server

ETI: GC LDAP Query Response 
Time

Value: Very High
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AD::DomainController:Sysvol Connectivity >> Notify Queue Size

AD::DomainController:Sysvol Disk Space Availability >> DC Replication 
Latency & Inbound Replication Object Rate

Description: Sysvol Connectivity Impacts Notify Queue Size

Cause

CIT: Domain Controller ETI: Sysvol Connectivity Value: Down

Symptom

CIT: Domain Controller ETI: Notify Queue Size Value: Very High

Description: Available Disk Space for Sysvol Impacts DC Replication Latency and 
Inbound Replication Object Rate

Cause 

CIT: Domain Controller ETI: Sysvol Disk Space 
Availability

Value: Near Capacity

Symptom 1

CIT: Domain Controller ETI: Inbound Replication 
Object Rate

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High



Chapter 34: Microsoft Content Packs

936

AD::DomainController:Sysvol Disk Queue Length >> DC Replication 
Latency & Inbound Replication Object Rate

AD::FileSystem:Disk Usage Level >> DomainController Performance

Description: Sysvol Disk Queue Length Impacts REplication Latency

Cause 

CIT: Domain Controller ETI: Sysvol Disk Queue Length Value: Very High

Symptom 1

CIT: Domain Controller ETI: Inbound Replication 
Object Rate

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Description: DIT Disk Queue Length Impacts DC Performance

Cause

CIT: File System ETI: Disk Usage Level Value: Near Capacity

Symptom 1

CIT: Domain Controller ETI: DITDiskQueueLength Value: Very High

Symptom 2

CIT: Domain Controller ETI: DIT LogFiles DiskQueue 
Length 

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Sysvol Disk Queue Length Value: Very High
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AD::Network Interface:Interface Utilization >> Sysvol Connectivity

AD::Network Interface:Interface Communication Status >> Sysvol 
Connectivity

Symptom 4

CIT: Domain Controller ETI: Pending Replication 
Synchronizations 

Value: Very High

Symptom 5

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining 

Value: Very High

Description: Network Interface Utilization impacts Sysvol Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Domain Controller ETI: SysvolConnectivity Value: Down

Description: Network Interface Communication Status impacts Sysvol Connectivity

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: Critical

Symptom 1

CIT: Domain Controller ETI: SysvolConnectivity Value: Down

Description: DIT Disk Queue Length Impacts DC Performance
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AD::Network Interface:Network IO >> Domain Naming Master 
Connectivity

AD::Network Interface:Network IO >> DomainController Connectivity

Description: Network IO Impacts Domain naming master connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Domain Naming 
Master

ETI: Response Time Value: Very High

Description: Network IO Impacts DomainController Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Notify Queue Size Value: Very High



Chapter 34: Microsoft Content Packs

939

AD::Network Interface:Network IO >> DomainController Performance

AD::Network Interface:Network IO >> Global Catalog Performance

Description: Network IO Impacts DomainController Performance

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Domain Controller ETI: DC LDAP Query Response 
Time 

Value: Very High

Symptom 2

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time 

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Pending Replication 
Synchronizations 

Value: Very High

Symptom 4

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining 

Value: Very High

Description: Network IO Impacts Global Catalog Performance

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Global Catalog ETI: GC LDAP Query Response 
Time 

Value: Very High

Symptom 2

CIT: Global Catalog ETI: GC LDAP Bind Response 
Time 

Value: Very High
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AD::Network Interface:Network IO >> Infrastructure Master 
Connectivity

AD::Network Interface:Network IO >> PDC Master Connectivity

AD::Network Interface:Network IO >> RID Master Connectivity

Description: Network IO Impacts Infrastructure master Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Infrastructure 
Master

ETI: Response Time Value: Very High

Description: Network IO Impacts PDC master Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Primary Domain 
Controller Master

ETI: Response Time Value: Very High

Description: Network IO Impacts RID master Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Relative ID Master ETI: Response Time Value: Very High
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AD::Network Interface:Network IO >> Schema Master Connectivity

AD::Windows:CPU Load >> DomainController Performance

Description: Network IO Impacts Schema master Connectivity

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Schema Master ETI: Response Time Value: Very High

Description: CPU Load Impacts DomainController Performance

Cause

CIT: Windows ETI: CPU Load Value: Bottlenecked

Symptom 1

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time

Value: Very High

Symptom 2

CIT: Domain Controller ETI: DC LDAP Query Response 
Time

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining

Value: Very High

Symptom 4

CIT: Domain Controller ETI: Pending Replication 
Synchronizations

Value: Very High



Chapter 34: Microsoft Content Packs

942

AD::Windows:CPU Load >> GlobalCatalog Performance

AD::Windows:Logical Disk Free Space >> DomainController 
Performance

Description: CPU Load Impacts Global Catalog Performance

Cause

CIT: Windows ETI: CPU Load Value: Bottlenecked

Symptom 1

CIT: Global Catalog 
Server

ETI: GC LDAP Bind Response 
Time

Value: Very High

Symptom 2

CIT: Global Catalog 
Server

ETI: GC LDAP Query Response 
Time

Value: Very High

Description: Available Logical Disk Free Space Impacts DC Performance

Cause

CIT: Windows ETI: Logical Disk Free Space Value: Near Capacity

Symptom 1

CIT: Domain Controller ETI: DIT Disk Queue Length Value: Very High

Symptom 2

CIT: Domain Controller ETI: DIT Log Files Disk Queue 
Length

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Inbound Object Updates 
Remaining

Value: Very High

Symptom 4

CIT: Domain Controller ETI: Pending Replication 
Synchronizations

Value: Very High
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AD::Windows:RPC Service >> DomainController Replication & Notify 
Queue Size

Description: RPC Service Status impacts DC Replication Latency and Notify Queue Size

Cause

CIT: Windows ETI: RPC Service Value: Unavailable

Symptom 1

CIT: Domain Controller ETI: Inter Site Replication 
Latency

Value: Very High

Symptom 2

CIT: Domain Controller ETI: Intra Site Replication 
Latency

Value: Very High

Symptom 3

CIT: Domain Controller ETI: Notify Queue Size Value: Very High
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Tool Definitions
Start File Replication Service: Starts the File Replication service on the 
Domain Controller.

Graph Templates
The following table lists the graph templates present in the content pack 
and mapped policies.

Graph Templates Policy Name Policy Description

Active Directory DNS 
Query Response Time 
Graph

ADSPI-DNS_Server_
Response / 
ADSPI-DNS_Server_
Response_2K8+

Monitors the response time 
given by the DNS server.

Active Directory 
SYSVOL Disk Queue 
Length Graph

ADSPI-SYSVOL_Disk
QueueLength / 
ADSPI-SYSVOL_Disk
QueueLength_2K8+

Monitors the queue length 
on the SYSVOL disk drive.

Active Directory 
SYSVOL Disk 
Utilization Graph

ADSPI-Sysvol_Percent
Full / 
ADSPI-Sysvol_Percent
Full_2K8+

Monitors the amount of 
free space on the Sysvol 
disk drive in terms of 
percentage used.

Active Directory DIT 
Log File Disk Queue 
Length Graph

ADSPI-DIT_LogFiles
QueueLength / 
ADSPI-DIT_LogFiles
QueueLength_2K8+

Monitors the queue length 
on the DIT log files disk 
drive.

Active Directory DIT 
Log File Disk 
Utilization Graph

ADSPI-DIT_LogFiles
PercentFull / 
ADSPI-DIT_LogFiles
PercentFull_2K8+

Monitors the amount of 
free space on the DIT log 
files disk drive.

Active Directory DIT 
File Growth Graph

ADSPI-DIT_TotalDit
Size/ ADSPI-DIT_TotalDit
Size_2K8+

Monitors the total amount 
of free space on the DIT 
disk drive in MB.

Active Directory DIT 
Disk Queue Length 
Graph

ADSPI-DIT_DITQueue
Length / 
ADSPI-DIT_DITQueue
Length_2K8+

Monitors the queue length 
on the DIT disk drive.
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Active Directory DIT 
Disk Utilization 
Graph

ADSPI-DIT_DITPercent
Full / 
ADSPI-DIT_DITPercent
Full_2K8+

Monitors the amount of 
free space on the DIT disk 
drive.

Active Directory Bind 
Response Time

ADSPI-Response_
Logging / 
ADSPI-Response_
Logging _2K8+

Logs active directory 
response times.

Active Directory 
Query Response Time

ADSPI-Response_Logging / 
ADSPI-Response_
Logging _2K8+

Logs active directory 
response times.

Active Directory 
Replication Time by 
Global Catalog

ADSPI-Rep_GC_Check_an
d_Threshold / 
ADSPI-Rep_GC_Check_an
d_Threshold_2K8+

Calculate, store and 
threshold Global Catalog 
Replication Latency in 
hours.

Active Directory GC 
Availability

ADSPI-Response_Logging / 
ADSPI-Response_
Logging _2K8+

Logs active directory 
response times.

Active Directory 
Replication Latency 
Graph

ADSPI-Rep_Monitor
InterSiteReplication / 
ADSPI-Rep_Monitor
InterSiteReplication_2K8+

Monitor InterSite 
Replication in Active 
Directory.

ADSPI-Rep_MonitorIntraSi
teReplication / 
ADSPI-Rep_Monitor
IntraSiteReplication_2K8+

Monitor IntraSite 
Replication in Active 
Directory.

Graph Templates Policy Name Policy Description
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Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

Note: For more information on the measurement threshold policies and 
events, refer to the HP Operations Smart Plug-in for Microsoft Active 
Directory documentation.

ETI/HI Policy Name Policy Description

Access Permissions 
Errors

ADSPI_ SecErr Access 
Permissions

Checks the errors access 
permissions.

 ADSPI_ SecErr Access 
Permissions_2k8+

CName Records 
Availability

ADSPI- DNS_DC_
 CNAME_Chk

Ensures that DNS contains the 
expected CNAME resource 
records for the LDAP service.

ADSPI- DNS_DC_
CNAME_Chk _2k8+

DC LDAP Query 
Response Time

ADSPI- Response Time_ 
Query

Monitors the response time of 
queries made to the domain 
controller in seconds.

ADSPI- Response Time_ 
Query _2k8+

DC LDAP Bind 
Response Time

ADSPI- Response Time_ 
Bind

Monitors the bind response 
time of the domain controller 
in seconds.

ADSPI- Response Time_ 
Bind _2k8+

DFSR Service State ADSPI_DFSR_2K8+ Checks the distributed file 
service replication service.



Chapter 34: Microsoft Content Packs

947

Directory Read 
Rate

ADSPI_DSReads Number of reads every second 
in the Directory Service.

ADSPI_DSReads_2K8+

ADSPI_GlobalCatalog
Reads

Number of reads from the GC.

ADSPI_GlobalCatalog
Reads_2K8+ 

Directory Search 
Rate 

ADSPI_DSSearches Number of searches every 
second in the Directory Service.

ADSPI_DSSearches_2K8+ Number of searches every 
second in the Directory Service.

ADSPI_GlobalCatalog
Searches

Number of searches of the 
Global Catalog.

ADSPI_GlobalCatalog
Searches_2K8+ 

Directory Write 
Rate 

ADSPI_DSWrites Number of writes every second 
in the Directory Service.

ADSPI_DSWrites_2K8+

ADSPI_GlobalCatalog
Writes

Number of writes to the GC.

ADSPI_GlobalCatalog
Writes_2K8+ 

DIT Disk Space 
Availability

ADSPI- DIT_DIT Percent 
Full

Monitors the amount of free 
space on the DIT disk drive.

ADSPI- DIT_DIT Percent 
Full _2k8+

DIT Disk Queue 
Length

ADSPI- DIT_ DITQueue 
Length

Monitors the length on the DIT 
disk drive.

ADSPI- DIT_ DITQueue 
Length _2k8+

ETI/HI Policy Name Policy Description
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DIT LogFiles Disk 
Space Availability

ADSPI- DIT_LogFiles 
Percent Full

Monitors the amount of free 
space on the DIT log files disk 
drive.

ADSPI- DIT_LogFiles 
Percent Full _2k8+

DIT LogFiles Disk 
Queue Length

ADSPI- DIT_LogFiles 
Queue Length

Monitors the queue length on 
the DIT log files disk drive.

ADSPI- DIT_LogFiles 
Queue Length _2k8+

DNS Query 
Response

ADSPI- DNS_DC_ 
Response

Monitors the response time of 
DNS queries made by the 
domain controller in 
milliseconds.ADSPI- DNS_DC_ 

Response _2k8+

FRS Status ADSPI_ NTFRS Checks the File replication 
service.

ADSPI_ NTFRS _2k8+

GC Connectivity ADSPI-GC_CheckStatus Executes a GC Query and 
checks the status of the GC 
query.ADSPI-GC_CheckStatus_

2K8+ 

GC LDAP Bind 
Response Time

ADSPI- Response Time_ 
GCBind 

Monitors the bind response 
time of the global catalog on 
the domain controller in 
seconds.ADSPI- Response Time_ 

GCBind _2k8+

GC LDAP Query 
Response Time

ADSPI- Response Time_ 
GCQuery

Monitors the response time of 
queries made to the global 
catalog domain controller in 
seconds.ADSPI- Response Time_ 

GCQuery _2k8+

GC Replication 
Latency

ADSPI- Rep_GC_ Check_ 
and_ Threshold

Calculates, stores, and 
threshold global Catalog 
replication latency in hours.

ADSPI- Rep_GC_ Check_ 
and_ Threshold _2k8+

ETI/HI Policy Name Policy Description
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Host Records 
Availability

ADSPI-DNS_DC_A_Chk Ensures that DNS contains the 
expected host resource records 
for the LDAP service.ADSPI-DNS_DC_A_Chk 

_2k8+

Inbound Object 
Updates 
Remaining

ADSPI_ ADSRep InBound 
Object Updates 
Remaining_ 2K8+

Checks the inbound object 
updates remaining in packet.

ADSPI_ ADSRepIn Bound 
Object Updates 
Remaining

Inbound 
Replication Object 
Rate

ADSPI- Rep_Inbound 
Objs

Monitors the number of 
inbound replication objects.

ADSPI- Rep_Inbound 
Objs_ 2k8+

Inter Site 
Replication 
Latency

ADSPI- Rep_Monitor 
InterSite Replication

Monitors intersite replication 
in active directory.

ADSPI- Rep_Monitor 
InterSite Replication 
_2k8+

Intra Site 
Replication 
Latency

ADSPI- Rep_Monitor 
IntraSite Replication

Monitors intrasite replication 
in active directory.

ADSPI- Rep_Monitor 
IntraSite Replication 
_2k8+

ISM Service Status ADSPI- Rep_ISM_ Chk Checks the intersite messaging 
service.

ADSPI- Rep_ISM_ Chk 
_2k8+

KDC Service Status ADSPI_KDC Checks the kerberos key 
distribution center service.

ADSPI_KDC _2k8+

ETI/HI Policy Name Policy Description
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Kerberos 
Authentication 
Rate

ADSPI_ IQKerberos 
Authentications _2K8+

Checks the kerberos 
authentications.

ADSPI_ IQKerberos 
Authentications

Kerberos Srv 
Records 
Availability

ADSPI- DNS_ Kerberos_ 
SRV_Chk

Checks for expected DNS SRV 
resource records registered for 
the kerberos service.

ADSPI- DNS_ Kerberos_ 
SRV_Chk _2k8+

LDAP Active 
Threads

ADSPI_ IQLDAP Active 
Threads _2K8+

Checks the LDAP active 
threads.

ADSPI_ IQLDAP Active 
Threads

LDAP Client 
Sessions

ADSPI_ IQLDAP Client 
Sessions _2K8+

Checks the LDAP client 
sessions.

ADSPI_ IQLDAP Client 
Sessions

LDAP 
Connectivity 

ADSPI-LDAP_Check
Status

Executes a LDAP Query and 
checks the status of the LDAP 
query.

ADSPI-LDAP_Check
Status_2K8+ 

LDAP Srv Records 
Availability

ADSPI- DNS_ LDAP_SRV 
_Chk

Ensures that DNS contains the 
expected SRV resource records 
for the LDAP service.

ADSPI- DNS_ LDAP_SRV 
_Chk _2k8+

Logon Errors ADSPI_ SecErrors Logon Checks the errors logon.

ADSPI_ SecErrors Logon 
_2k8+

LSASS Page Faults 
Rate

ADSPI_ HMLSASS 
PageFaults

Checks the LSASS page faults 
per second.

ADSPI_ HMLSASS 
PageFaults _2k8+

ETI/HI Policy Name Policy Description
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LSASS Private Bytes ADSPI_ HMLSASS Private 
Bytes

Checks the LSASS Private Bytes.

ADSPI_ HMLSASS Private 
Bytes _2k8+

LSASS Processor 
Time

ADSPI_ HMLSASS 
Processor Time

Checks the LSASS processor 
time.

ADSPI_ HMLSASS 
Processor Time _2k8+

LSASS Working Set ADSPI_ HMLSASS 
Working Set

Checks the LSASS working set.

ADSPI_ HMLSASS 
Working Set _2k8+

Net Logon Service 
State

ADSPI_ Net Logon Checks the Net Logon service.

ADSPI_ Net Logon _2k8+

Non Transitive 
Membership 
Evaluations

ADSPI_ Sec NonTrans 
Memb Eval_ 2K8+

Checks the Non-Transitive 
Membership Evaluations/sec.

ADSPI_ Sec NonTrans 
Memb Eval

Notify Queue Size ADSPI_ ADSRep Notify 
QueueSize_ 2K8+

Checks the notify queue size.

ADSPI_ ADSRep Notify 
QueueSize

NTDS Service State ADSPI_ NTDS _2k8+ Checks the active directory 
domain service.

NTFRS Page Faults 
Rate

ADSPI_ HM NTFRS 
PageFaults

Checks the NTFRS page faults.

ADSPI_ HM NTFRS 
PageFaults _2k8+

ETI/HI Policy Name Policy Description
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NTFRS Private 
Bytes

ADSPI_ HM NTFRS 
Private Bytes

Checks the NTFRS private 
bytes.

ADSPI_ HM NTFRS 
Private Bytes _2k8+

NTFRS Processor 
Time

ADSPI_ HM NTFRS 
Processor Time

Checks the NTFRS processor 
time.

ADSPI_ HM NTFRS 
Processor Time _2k8+

NTFRS Working Set ADSPI_ HM NTFRS 
Working Set

Checks the NTFRS working set.

ADSPI_ HM NTFRS 
Working Set

NTLM 
Authentication 
Rate

ADSPI_ IQNTLM 
Authentications _2K8+

Checks the NTLM 
Authentications.

ADSPI_ IQNTLM 
Authentications

Outbound 
Replication Object 
Rate 

ADSPI-Rep_Outbound
Objs

Monitors the number of 
outbound replication objects.

ADSPI-Rep_Outbound
Objs_2K8+ 

Pending 
Replication 
Synchronizations

ADSPI_ ADSPending 
Synchronizations_ 2K8+

Checks the pending replication 
synchronizations.

ADSPI_ ADSPending 
Synchronizations

ETI/HI Policy Name Policy Description
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Response Time ADSPI- FSMO_ 
INFRA_Ping

Monitors the ping response 
time of the infrastructure 
FSMO in seconds.

ADSPI- FSMO_ 
INFRA_Ping _2k8+

ADSPI-F SMO_ NAMING_ 
Ping

Monitors the ping response 
time of the domain naming 
FSMO in seconds.

ADSPI-F SMO_ NAMING_ 
Ping _2k8+

ADSPI- FSMO_ PDC_Ping Monitors the ping response 
time of the PDC FSMO in 
seconds.ADSPI- FSMO_ PDC_Ping 

_2k8+

ADSPI- FSMO_ RID_Ping Monitors the ping response 
time of the RID FSMO in 
seconds.ADSPI- FSMO_ RID_Ping 

_2k8+

ADSPI- FSMO_ 
Schema_Ping

Monitors the ping response 
time of the schema FSMO in 
seconds.

ADSPI- FSMO_ 
Schema_Ping _2k8+

SamSs Service State ADSPI_ SamSs Checks the security account 
manager service.

ADSPI_ SamSs _2k8+

Security Descriptor 
Propagator Queue

ADSPI_ Sec SDPropagator 
Queue _2K8+

Checks the Security Descriptor 
Propagator Queue.

ADSPI_ SecSD Propagator 
Queue

Synchronization 
Failure Rate

ADSPI_ SyncSchema 
MissMatch

Checks the sync failures on 
schema mismatch.

ADSPI_ SyncSchema 
MissMatch _2K8+

ETI/HI Policy Name Policy Description
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Sysvol Disk Queue 
Length 

ADSPI-SYSVOL_Disk
QueueLength

Monitors the queue length on 
the SYSVOL disk drive.

ADSPI-SYSVOL_Disk
QueueLength_2K8+ 

Sysvol 
Connectivity

ADSPI- Sysvol_ 
Connectivity

Connects to each replication 
partner’s sysvol to validate 
connectivity.

ADSPI- Sysvol_ 
Connectivity _2k8+

Sysvol Disk Space 
Availability

ADSPI- Sysvol_ 
PercentFull

Monitors the amount of free 
space on the sysvol disk drive 
in terms of MB.

ADSPI- Sysvol_ 
PercentFull _2k8+

Transitive 
Membership 
Evaluations

ADSPI_ SecTrans 
MembEval _2K8+

Checks the Transitive Member 
Evaluations/sec.

ADSPI_ SecTrans Memb 
Eval

ETI/HI Policy Name Policy Description
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Operations Orchestration Flow 
When creating the mapping, you can set default values for the attributes 
listed in the following table.

For more information about creating the mapping and a Run Book 
automation rule, see "How to Create a Run Book Automation Rule" on 
page 505.

Attribute Description

omServerPort Port number of the HPOM Tool WS.

omServerUser User name for the HPOM Server that will use used in the 
HPOM Tool WS.

omServerPassword Password for the HPOM Server that will use used in the 
HPOM Tool WS.
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The following table lists the Microsoft Active Directory Operations 
Orchestration (OO) Flows:

OO Flow: Check DIT Disk Space Availability 

User input when executing OO flow: Check DIT Disk Space Availability  

OO Flow: Check DomainController Health 

User input when executing OO flow: Check DomainController Health  

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

threshold The threshold value for the minimum disk space (in MB) that 
should be free (available) on the DIT disks. Default is set to 
2048 MB (2 GM).

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

diskthreshold The threshold value for the minimum disk space in MB that 
should be free (available) on the DIT disks. Default is set to 
2048 MB (2 GB).

ldapthreshold The threshold value for LDAP latency.
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OO Flow: Check if DomainController 

User input when executing OO flow: Check if DomainController  

OO Flow: Check Replication Health 

User input when executing OO flow: Check Replication Health  

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

diskthreshold The threshold value for the minimum disk space in MB that 
should be free (available) on the DIT disks. Default is set to 
2048 MB (2 GB).

ldapthreshold The threshold value for LDAP latency.

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

replicationlatency
threshold

The threshold for maximum time since last replication 
happened from a source in milliseconds.
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OO Flow: GC Query Response Time 

User input when executing OO flow: GC Query Response Time  

OO Flow: LDAP Query Response Time 

User input when executing OO flow: LDAP Query Response Time  

OO Flow: Get Replication Latency 

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

Flow input Mapping CI Event Attribute

omServer domaincontroller Originating Server
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User input when executing OO flow: Get Replication Latency  

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

omReplication
Source

The node from which is the source of the replication for the 
time is calculated.
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Microsoft Exchange Server Content Pack 

The Microsoft Exchange Server Content Pack contains the following 
artifacts:

➤ Views on page 961

➤ Enrichment Rules on page 966

➤ Health Indicators on page 966

➤ Event Type Indicators on page 973

➤ Correlation Rules on page 974

➤ Tool Definitions on page 1002

➤ Graph Templates on page 1002

➤ Policies Setting ETIs on page 1004

➤ Operations Orchestration Flow on page 1014
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Views
The RTSM package in the Microsoft Exchange Server Content Pack contains 
the following views:

➤ Exchange_Org_View: This view refers to the Exchange System, Exchange 
Unified Messaging Server, Exchange Client Access Server, Exchange Edge 
Server, Exchange Hub Server, Microsoft Exchange Server, Active Directory 
Application Mode, and Computer CI types.
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➤ Exchange_Mail_View: This view refers to the Exchange System, Exchange 
Mail Server, Domain Controller, Microsoft Exchange Server, Clustered Server, 
Active Directory Site, and Computer (Windows) CI types.
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➤ Exchange_Site_View: This view refers to the Exchange System, Exchange 
Mail Server, Exchange Hub Server, Exchange Edge Server, Active Directory 
Site, and Exchange Unified Messaging Server types.
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➤ Exchange_Network_Deployment_View: This view refers to the 
Exchange System, Exchange Mail Server, Exchange Hub Server, Exchange 
Edge Server, Active Directory Site, Exchange Unified Messaging Server, and  
Node CI types.
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➤ Exchange_DAG_View: This view refers to the Exchange Organization, 
Exchange Database Availability Groups, Exchange Servers (which are 
members of the Exchange DAG), Exchange Mailbox Databases and Computer 
CI types.

Note: The content pack contains the CI type, Database Availability Group 
(DAG), to support the Exchange Server 2010. DAG is a set of up to 16 
Microsoft Exchange Server 2010 Mailbox servers. These 16 servers monitor 
each other for failures and provide automatic database-level recovery from 
database, server, or network failures.
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Enrichment Rules
The Microsoft Exchange Server Content Pack contains the following 
Enrichment Rules:

➤ ADAM_Depends_DomainController

➤ ExchangeServer_Uses_GlobalCatalog

➤ ExchangeServer_IsMemberOf_ActiveDirectorySite

➤ ExchangeServer_Uses_DomainController

Health Indicators
The content pack includes the following Health Indicators (HIs) to monitor 
Exchange Server-related events.  

CI Type HI Description Value

Exchange 
Client Access 
Server

Active Sync 
Connectivity

Indicates the availability of 
Active Sync Connections on the 
Exchange Client Access Server.

Up, 
Down

Exchange 
Client Access 
Server

Active Sync 
Latency

Indicates the latency in accessing 
a user mailbox using Active Sync.

Normal, 
High, 
Very high

Exchange 
Client Access 
Server

IMAP4 Latency Indicates the latency in IMAP4 
Connections on the Client 
Access Server.

Normal, 
High, 
Very high

Exchange 
Client Access 
Server

Exchange 
Service Host 
Status

Indicates the status of Microsoft 
Exchange Service Host.

Up, 
Down

Exchange 
Client Access 
Server 

File 
Distribution 
Service Status

Indicates the status of Microsoft 
Exchange File Distribution 
Service.

Up, 
Down

Exchange 
Client Access 
Server

POP3 Latency Indicates the latency in POP3 
Connections on the Client 
Access Server.

Normal, 
High, 
Very high
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Exchange 
Client Access 
Server

IMAP4 
Connectivity

Indicates the availability of 
IMAP4 connections on the 
Exchange Client.

Up, 
Down

Exchange 
Client Access 
Server

IMAP4 Service 
Status

Indicates the status of Microsoft 
Exchange IMAP4 Service.

Up, 
Down

Exchange 
Client Access 
Server

IMAP4 Status Indicates the status of IMAP4 
operations on the Exchange 
Client Access Server.

Critical, 
Normal

Exchange 
Client Access 
Server

OWA 
Connectivity

Indicates the availability of OWA 
Connections on the Exchange 
Client Access Server.

Up, 
Down

Exchange 
Client Access 
Server

OWA Latency Indicates the latency in 
performing OWA operations on 
the Exchange Client Access 
Server.

Normal, 
High, 
Very high

Exchange 
Client Access 
Server

POP3 
Connectivity

Indicates the availability of POP3 
Connections on the Exchange 
Client Access Server.

Up, 
Down

Exchange 
Client Access 
Server

POP3 Service 
Status

Indicates the status of Microsoft 
Exchange POP3 Service.

Up, 
Down

Exchange 
Client Access 
Server

POP3 Status Indicates the status of POP3 
Operations on the Exchange 
Client Access Server.

Critical, 
Normal

Exchange 
Mail Server

Exchange 
Service Host 
Status

Indicates the status of Microsoft 
Exchange Service Host.

Up, 
Down

Exchange 
Unified 
Messaging 
Server 

File 
Distribution 
Service Status

Indicates the status of Microsoft 
Exchange File Distribution 
Service.

Up, 
Down

Exchange 
Edge Server

ADAM Service 
Status

Indicates the status of Microsoft 
Exchange ADAM Service.

Up, 
Down

CI Type HI Description Value
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Exchange 
Edge Server

Edge 
Credential 
Service Status

Indicates the status of credential 
service status for Exchange Edge 
Server.

Up, 
Down

Exchange 
Email Server

Active 
Directory 
Access

Indicates the status of Active 
Directory Accessibility from 
Exchange Mail Server.

Up, 
Down

Exchange 
Email Server

Average Mail 
Delivery Time

Indicates the Average Mail 
Delivery Time on the Exchange 
Mail Server.

Normal, 
High, 
Very high

Exchange 
Email Server

Average Time 
for PF Delivery

Indicates the average time taken 
for Public Folder Posts or 
messages to be delivered to 
recipients on the Exchange Mail 
Server.

Normal, 
High, 
Very high

Exchange 
Email Server

Database 
Instance Status

Indicates the status of Exchange 
Database Instance.

Critical, 
Normal

Exchange 
Email Server

Exchange 
Service Host 
Status

Indicates the status of Microsoft 
Exchange Service Host.

Up, 
Down

Exchange 
Email Server

Exchange 
Memory Status

Indicates the status of memory 
used and available for Microsoft 
Exchange Process.

Normal, 
Critical

Exchange 
Email Server

Information 
Store Service 
Status

Indicates the status of Microsoft 
Exchange Information Store 
Service.

Up, 
Down

Exchange 
Email Server

Mailbox 
Assistant 
Service Status

Indicates the status of Microsoft 
Exchange Mailbox Assistants 
Service.

Up, 
Down

Exchange 
Email Server

Mailbox 
Receive Queue 
Length

Indicates the number of 
messages in the Mailbox Store's 
Receive Queue.

Normal, 
High, 
Very high

Exchange 
Email Server

MailFlow 
Latency

Indicates the latency in Mail 
Flow from the given Exchange 
Mail Server.

Normal, 
High, 
Very high

CI Type HI Description Value
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Exchange 
Email Server

MailFlow 
Status

Indicates the status of Mail Flow 
on the Exchange Mail Server.

Up, 
Down

Exchange 
Email Server

Mail 
Submission 
Service Status

Indicates the status of Microsoft 
Exchange Mail Submission 
Service.

Up, 
Down

Exchange 
Email Server

Mapi 
Connectivity

Indicates the status of MAPI 
Connectivity on the Exchange 
Mail Server.

Up, 
Down

Exchange 
Email Server

Mapi Latency Indicates the latency in MAPI 
Connectivity on the Exchange 
Mail Server.

Normal, 
High, 
Very high

Exchange 
Email Server

Public Receive 
Queue Length

Indicates the number of 
messages in Public Store's 
Receive Queue.

Normal, 
High, 
Very high

Exchange 
Email Server

Public 
Replication 
Queue Length

Indicates the number of 
Replication messages waiting to 
be processed.

Normal, 
High, 
Very high

Exchange 
Email Server

Replication 
Service Status

Indicates the status of Microsoft 
Exchange Replication Service.

Up, 
Down

Exchange 
Email Server

Search Status Indicates the status of Search 
Operation.

Up, 
Down

Exchange 
Email Server

Search Latency Indicates the latency in 
performing an Exchange Search.

Normal, 
High, 
Very high

Exchange 
Email Server

System 
Attendant 
Status

Indicates the status of Microsoft 
Exchange System Attendant 
Service.

Up, 
Down

Exchange 
Hub Server

Edge Sync 
Service Status

Indicates the status of 
Synchronization service status 
for Exchange Hub Server.

Up, 
Down

CI Type HI Description Value
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Exchange 
Mailbox 
Database 

Available 
Transaction 
Log Disk Space 

Indicates the degree of Available 
Free Disk Space for Exchange 
Transaction Logs on the 
Exchange Mail Server.

Near 
Capacity,
Low, 
Normal

Exchange 
Mailbox 
Database 

Available 
Database Disk 
Space 

Indicates the space available in 
the Disk containing the 
Database.

Near 
Capacity,
Low, 
Normal

MicrosoftExc
hangeServer

AD Topology 
Service Status

Indicates the status of Microsoft 
Exchange Active Directory 
Topology Service.

Up, 
Down

MicrosoftExc
hangeServer

Active 
Directory 
Access

Indicates whether the Exchange 
Server can access the Active 
Directory.

Up, 
Down

Exchange 
Server

Create Item 
Status 

Indicates the status of Create 
Item operation performed using 
Exchange Web Services.

Up, 
Down

Exchange 
Server

Create Item 
Latency 

Indicates the latency in 
performing the operation Create 
Item using Exchange Web 
Services.

Normal, 
High, 
Very high

Exchange 
Server

Delete Item 
Status 

Indicates the status of Delete 
Item operation performed using 
Exchange Web Services.

Up, 
Down

Exchange  
Server

Delete Item 
Latency 

Indicates the latency in 
performing the operation Delete 
Item using Exchange Web 
Services.

Normal, 
High, 
Very high

Exchange  
Server

GC Bind Time Indicates the time taken to bind 
with the GC.

Normal, 
High, 
Very high

Exchange  
Server

GC Search 
Time 

Indicates the time taken to 
perform GC Search.

Normal, 
High, 
Very high

CI Type HI Description Value
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Exchange  
Server

Get Folder 
Status 

Indicates the status of Get Folder 
operation performed using 
Exchange Web Services.

Up, 
Down

Exchange  
Server

Get Folder 
Latency 

Indicates the latency in 
performing the operation Get 
Folder using Exchange Web 
Services.

Normal, 
High, 
Very high

Exchange  
Server

Sync Folder 
Status

Indicates the status of Sync 
Folder operation performed 
using Exchange Web Services.

Up, 
Down

Exchange  
Server

Sync Folder 
Latency

Indicates the latency in 
performing the operation Sync 
Folder using Exchange Web 
Services.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Active Mailbox 
Delivery 
Queue Length

Indicates the number of 
messages in the Active Mailbox 
Queues.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Aggregate 
Delivery 
Queue Length

Indicates the number of 
messages queued for delivery in 
all queues.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Delayed DSN 
Count

Indicates the number of Delayed 
Delivery Status Notifications 
which were generated on the 
Exchange Transport Server. Very 
High Values can indicate 
overload.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Failed DSN 
Count

Indicates the number of Failure 
Delivery Status Notifications 
generated.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Largest 
Delivery 
Queue Length

Indicates the number of 
messages in the largest delivery 
queue.

Normal, 
High, 
Very high

CI Type HI Description Value
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Exchange 
Transport 
Server

Poison Queue 
Length

Indicates the length of Poison 
Queue on the Exchange 
Transport Server.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Remote 
Delivery 
Queue Length

Indicates the length of Remote 
Delivery Queues on the 
Exchange Transport Server.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Retry Non 
Smtp Delivery 
Queue Length

Indicates the number of 
messages in retry in the 
non-SMTP gateway delivery 
queues.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Submission 
Queue Length

Indicates the length of 
Submission Queue on the 
Exchange Transport Server.

Normal, 
High, 
Very high

Exchange 
Transport 
Server

Transport 
Service Status

Indicates the status of Microsoft 
Exchange Transport Service.

Up, 
Down

Exchange 
Transport 
Server

Unreachable 
Queue Length

Indicates the length of the 
Unreachable Queue on the 
Exchange Transport Server.

Normal, 
High, 
Very high

Exchange 
Unified 
Messaging 
Server

Speech Engine 
Status

Indicates the status of Microsoft 
Exchange Speech Engine Service.

Up, 
Down

Unified 
Messaging 
Connectivity

Indicates the availability of 
Unified Messaging Connections 
on the Microsoft Exchange 
Unified Messaging Server.

Up, 
Down

Unified 
Messaging 
Status

Indicates the status of Microsoft 
Exchange Unified Messaging 
Service.

Up, 
Down

CI Type HI Description Value
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Event Type Indicators
The Content Pack includes the following Event Type Indicators (ETIs) to 
monitor Exchange Server-related events:

CI Type ETI Description Value

Exchange 
Hub Server

Edge 
Synchronization 
Status

Indicates the status of Edge 
Synchronization.

Up

Load Exchange 
Topology

Indicates if Exchange Topology 
Information could be read or 
loaded from Active Directory.

Down

Submission
ThreadCount

Indicates the percentage of 
Submission Threads currently 
running on the Exchange Hub 
Server. If the value is Very High 
then no new threads will be 
created and mail submission 
will fail.

Normal, 
High,
Very High

Exchange 
Mail Server

Hub Server 
Reachability

Indicates if Exchange Hub 
Servers are reachable from the 
Exchange Mail Server.

Up, 
Down

Mail Submission 
Status

Indicates the status of Mail 
Submission on the Exchange 
Mail Server.

Up, 
Down
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Correlation Rules
The content pack includes the following rules to correlate Exchange 
Server-related events.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

Exchange::Clustered Server:Memory Load >> Exchange Memory Status

Exchange::Clustered Server:Memory Load >> Exchange Memory Status

Description: Memory Load Impacts Memory Available for Exchange

Cause

CIT: Cluster Resource 
Group

ETI: Memory Load Value: Paging

Symptom 

CIT: Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical

Description: Memory Usage Level Impacts Memory Available for Exchange

Cause

CIT: Cluster Resource 
Group

ETI: Memory Usage Level Value: Near Capacity

Symptom 

CIT: Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical



Chapter 34: Microsoft Content Packs

975

Exchange::Clustered Server:PageFile Usage >> Exchange Memory Status

Exchange::Clustered Server:Ping Availability >> Hub Server Reachability 
& Mail Submission Status

Description: Page File Usage on the Computer which hosts Exchange Mail Server 
Impacts Exchange Memory Status

Cause

CIT: Cluster Resource 
Group

ETI: Page File Usage Value: Near Capacity

Symptom 

CIT: Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical

Description: Ping Availability of Exchange Mail Server Impacts Mail Submission and 
Hub Server Reachability

Cause

CIT: Cluster Resource 
Group

ETI: Ping Availability Value: Unavailable

Symptom 1

CIT: Exchange Mail 
Server

ETI: Hub Server Reachability Value: Down

Symptom 2

CIT: Exchange Mail 
Server

ETI: Mail Submission Status Value: Down



Chapter 34: Microsoft Content Packs

976

Exchange::DomainController:DC LDAP Bind Response Time >> Client 
Accessibility

Exchange::DomainController:DC LDAP Bind Response Time >> 
MailFlow Latency

Description: LDAP Bind Response Time Impacts Client Accessibility

Cause

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time

Value: Very High

Symptom 1

CIT: Exchange Client 
Access Server

ETI: OWA Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: Active Sync Latency Value: Very High

Description: LDAP Bind Response Time Impacts Mail flow Latency

Cause

CIT: Domain Controller ETI: DC LDAP Bind Response 
Time

Value: Very High

Symptom 

CIT: Exchange Client 
Access Server

ETI: Mail Flow Latency Value: Very High
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Exchange::DomainController:DC LDAP Bind Response Time >> 
Transport Queue Length

Description: LDAP Bind Response Time Impacts Transport Queue Length

Cause

CIT: Domain Controller ETI: 
DCLDAPBindResponseTime

Value: Very High

Symptom 1

CIT: Exchange Hub 
Server

ETI: Active Mailbox Delivery 
Queue Length

Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: Remote Delivery Queue 
Length

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: Delayed DSN Count Value: Very High

Symptom 4

CIT: Exchange Hub 
Server

ETI: Submission Queue Length Value: Very High
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Exchange::DomainController:DC LDAP Query Response Time >> Client 
Accessibility

Exchange::DomainController:DC LDAP Query Response Time >> 
MailFlow Latency

Description: LDAP Query Response Time Impacts Client Accessibility

Cause

CIT: Domain Controller ETI: DC LDAP Query Response 
Time

Value: Very High

Symptom 1

CIT: Exchange Client 
Access Server

ETI: OWA Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: Active Sync Latency Value: Very High

Description: LDAP Query Response Time Impacts Mail flow Latency

Cause

CIT: Domain Controller ETI: DC Query Response Time Value: Very High

Symptom 

CIT: Exchange Mail 
Server

ETI: Mail Flow Latency Value: Very High
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Exchange::DomainController:DC LDAP Query Response Time >> 
Transport Queue Length

Exchange::Exchange Client Access Server:IMAP4 Service Status >> 
IMAP4 Connectivity

Description: LDAP Query Response Time Impacts Transport Queue Length

Cause

CIT: Domain Controller ETI: DC LDAP Query Response 
Time

Value: Very High

Symptom 1

CIT: Exchange Hub 
Server

ETI: Active Mailbox Delivery 
Queue Length

Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: Remote Delivery Queue 
Length

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: Delayed DSN Count Value: Very High

Symptom 4

CIT: Exchange Hub 
Server

ETI: Submission Queue Length Value: Very High

Description: IMAP4 Service impacts IMAP4 Connectivity

Cause

CIT: Exchange Client 
Access Server

ETI: IMAP4 Service Status Value: Down

Symptom 

CIT: Exchange Client 
Access Server

ETI: IMAP4 Connectivity Value: Down
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Exchange::Exchange Client Access Server:POP3 Service Status >> POP3 
Connectivity

Exchange::Exchange Hub Server:Active Mailbox Delivery Queue Length 
>> Mail Flow Latency 

Exchange::Exchange Hub Server:Submission Queue Length >> MailFlow 
Latency

Description: POP3 Service impacts POP3 Connectivity

Cause

CIT: Exchange Client 
Access Server

ETI: POP3 Service Status Value: Down

Symptom 

CIT: Exchange Client 
Access Server

ETI: POP3 Connectivity Value: Down

Description: Active Mailbox Delivery Queue Length Impacts Mail Flow Latency

Cause

CIT: Exchange Hub 
Server

ETI: Active Mailbox Delivery 
Queue Length

Value: Very High

Symptom 

CIT: Exchange Mail 
Server

ETI: Mail Flow Latency Value: Very High

Description: Submission Queue Length Impacts Mail Flow Latency

Cause

CIT: Exchange Hub 
Server

ETI: Submission Queue Length Value: Very High

Symptom 

CIT: Exchange Mail 
Server

ETI: Mail Flow Latency Value: Very High
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Exchange::Exchange Hub Server:Submission Thread Count >> Mail 
Submission Status

Exchange::Exchange Hub Server:Transport Service Status >> Mail 
Submission Status & Mail Flow Status

Description: Submission Thread Count Impacts Mail Submission on Exchange Mail 
Server

Cause

CIT: Exchange Hub 
Server

ETI: Submission Thread Count Value: Very High

Symptom 

CIT: Exchange Mail 
Server

ETI: Mail Submission Status Value: Down

Description: Transport Service Impacts Mail Submission and Mail Flow

Cause

CIT: Exchange Hub 
Server

ETI: Transport Service Status Value: Down

Symptom 1

CIT: Exchange Mail 
Server

ETI: Mail Flow Status Value: Down

Symptom 2

CIT: Exchange Mail 
Server

ETI: Mail Submission Status Value: Down
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Exchange::Exchange Mailbox Database:Available Database Log Disk 
Space >> Information Store Service Status

Exchange::Exchange Mailbox Database:Available Database Disk Space 
>> Information Store Service Status

Exchange::Exchange Mail Server:Hub Server Reachability >> Mail 
Submission Status

Description: Available Database Log Disk Space Impacts Information Store Service

Cause

CIT: Exchange   
Mailbox Database

ETI: Available Database Disk 
Space 

Value: Near Capacity

Symptom

CIT: Exchange Mail 
Server

ETI: Information Store Service 
Status

Value: Down 

Description: Available Database Disk Space Impacts Information Store Service

Cause

CIT: Exchange   
Mailbox Database

ETI: Available Transaction Log 
Disk Space 

Value: Down

Symptom

CIT: Exchange Mail 
Server

ETI:   Information Store Service 
Status

Value: Down

Description: Hub Server Reachability Impacts Mail Submission

Cause

CIT: Exchange Mail 
Server

ETI: Hub Server Reachability Value: Down

Symptom

CIT: Exchange Mail 
Server

ETI: Mail Submission Status Value: Down
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Exchange::Exchange Mail Server:Information Store Service Status >> 
Client Accessibility

Description: Information Store Service Impacts Client Accessibility

Cause

CIT: Exchange Mail 
Server

ETI: Information Store Service 
Status

Value: Down

Symptom 1

CIT: Exchange Client 
Access Server

ETI: Active Sync Connectivity Value: Down

Symptom 2

CIT: Exchange Client 
Access Server

ETI: IMAP4 Connectivity Value: Down

Symptom 3

CIT: Exchange Client 
Access Server

ETI: OWA Connectivity Value: Down

Symptom 4

CIT: Exchange Client 
Access Server

ETI: POP3 Connectivity Value: Down
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Exchange::Exchange Mail Server:Information Store Service Status >> 
Mail Flow Status & Mapi Connectivity

Exchange::Exchange Mail Server:Mail Submission Service Status >> Mail 
Flow Status

Description: Information Store Service Impacts Mail Flow and Mapi Connectivity

Cause

CIT: Exchange Mail 
Server

ETI: Information Store Service 
Status

Value: Down

Symptom 1

CIT: Exchange Mail 
Server

ETI: Mail Flow Status Value: Down

Symptom 2

CIT: Exchange Mail 
Server

ETI: Mapi Connectivity Value: Down

Description: Mail Submission Service Impacts Mail Flow

Cause

CIT: Exchange Mail 
Server

ETI: Mail Submission Service 
Status

Value: Down

Symptom 

CIT: Exchange Mail 
Server

ETI: Mail Flow Status Value: Down
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Exchange::Exchange Unified Messaging Server:Speech Engine Status >> 
Unified Messaging Status

Exchange::File System:Disk Usage Level >> Available Database Disk 
Space

Description: Speech Engine Service Impacts Unified Messaging Service

Cause

CIT: Exchange Unified 
Messaging Server

ETI: Speech Engine Status Value: Down

Symptom 

CIT: Exchange Unified 
Messaging Server

ETI: Unified Messaging Status Value: Down

Description: Disk Usage Level Impacts Available Database Disk space

Cause

CIT: FileSystem ETI: Disk Usage Level Value: Near Capacity

Symptom 1

CIT: Exchange Mailbox 
Database 

ETI: Available Database Disk 
Space 

Value: Near Capacity

Symptom 2

CIT: Exchange Mailbox 
Database 

ETI: Available Transaction Log 
Disk Space s

Value: Near Capacity
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Exchange::GlobalCatalog:GC Query Response Time >> Exchange GC 
Search Time

Exchange::Microsoft Exchange Server:AD Topology Service Status >> 
Client Access Services

Description: GC Query Response Time Impacts Exchange GC Search

Cause

CIT: Global Catalog ETI: GC LDAP Query Response 
Time 

Value: Very High

Symptom 

CIT: 
MicrosoftExchangeServer

ETI: GC Search Time Value: Very High

Description: Active Directory Topology Service Impacts Client Access Services

Cause

CIT: 
MicrosoftExchangeServer

ETI: AD Topology Service 
Status

Value: Down

Symptom 1

CIT: Exchange Client 
Access Server

ETI: File Distribution Service 
Status

Value: Down

Symptom 2

CIT: Exchange Client 
Access Server

ETI: Exchange Service Host 
Status

Value: Down

Symptom 3

CIT: Exchange Client 
Access Server

ETI: IMAP4 Service Status Value: Down

Symptom 4

CIT: Exchange Client 
Access Server

ETI: POP3 Service Status Value: Down
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Exchange::Microsoft Exchange Server:AD Topology Service Status >> 
Hub Transport Services

Exchange::Microsoft Exchange Server:AD Topology Service Status >> 
Mail Server Services

Description: Active Directory Topology Service Impacts Hub Transport Services

Cause

CIT: 
MicrosoftExchangeServe
r

ETI: AD Topology Service 
Status

Value: Down

Symptom 1

CIT: Exchange Hub 
Server

ETI: Transport Service Status Value: Down

Symptom 2

CIT: Exchange Hub 
Server

ETI: Edge Sync Service Status Value: Down

Description: Active Directory Topology Service Impacts Mail Server Services

Cause

CIT: ExchangeServer ETI: AD Topology Service 
Status

Value: Down

Symptom 1

CIT: Exchange Mail 
Server

ETI: Mail Submission Service 
Status

Value: Down

Symptom 2

CIT: Exchange Mail 
Server

ETI: Mailbox Assistant Service 
Status

Value: Down

Symptom 3

CIT: Exchange Mail 
Server

ETI: Replication Service Status Value: Down
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Exchange::Microsoft Exchange Server:AD Topology Service Status >> 
Unified Messaging Services

Symptom 4

CIT: Exchange Mail 
Server

ETI: Exchange Service Host 
Status

Value: Down

Symptom 5

CIT: Exchange Mail 
Server

ETI: Active Directory Access Value: Down

Symptom 6

CIT: Exchange Mail 
Server

ETI: Mapi Connectivity Value: Down

Symptom 7

CIT: Exchange Mail 
Server

ETI: Mail Flow Status Value: Down

Description: Active Directory Topology Service Impacts Unified Messaging Services

Cause

CIT: ExchangeServer ETI: AD Topology Service 
Status

Value: Down

Symptom 1

CIT: Exchange Unified 
Messaging Server

ETI: File Distribution Service 
Status

Value: Down

Symptom 2

CIT: Exchange Unified 
Messaging Server

ETI: Unified Messaging Status Value: Down

Description: Active Directory Topology Service Impacts Mail Server Services
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Exchange::Microsoft Exchange Server:GC Search Time >> Client 
Accessibility

Exchange::Microsoft Exchange Server:GC Search Time >> Mail Flow 
Latency

Exchange::Microsoft Exchange Server:GC Search Time >> Transport 
Queue Length

Description: GC Search Time Impacts Client Accessibility

Cause

CIT: 
MicrosoftExchangeServer

ETI: GC Search Time Value: Very High

Symptom 1

CIT: Exchange Client 
Access Server

ETI: OWA Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: Active Sync Latency Value: Very High

Description: GC Search Time Impacts Mail Flow Latency

Cause

CIT: 
MicrosoftExchangeServer

ETI: GC Search Time Value: Very High

Symptom 

CIT: Exchange Mail 
Server 

ETI: Mapi Flow Latency Value: Very High

Description: GC Search Time Impacts Transport Queue

Cause

CIT: 
MicrosoftExchangeServer

ETI: GC Search Time Value: Very High
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Exchange::Network Interface:Interface Communication Status >> Client 
Accessibility

Symptom 1

CIT: Exchange Hub Server ETI: Active Mailbox Delivery 
Queue Length  

Value: Very High

Symptom 2

CIT: Exchange Hub Server ETI: Remote Delivery Queue 
Length   

Value: Very High

Symptom 3

CIT: Exchange Hub Server ETI: Delayed DSN Count Value: Very High

Symptom 2

CIT: Exchange Hub Server ETI: Submission Queue Length Value: Very High

Description: Network Interface Communication status impacts Client Accessibility

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: Unavailable

Symptom 1

CIT: Exchange Client 
Access Server

ETI: IMAP4Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: POP3Latency Value: Very High

Symptom 3

CIT: Exchange Client 
Access Server

ETI: IMAP4Connectivity Value: Down

Description: GC Search Time Impacts Transport Queue
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Exchange::Network Interface:Interface Communication Status >> Hub 
Server Reachability

Symptom 4

CIT: Exchange Client 
Access Server

ETI: POP3Connectivity Value: Down

Symptom 5

CIT: Exchange Client 
Access Server

ETI: OWAConnectivity Value: Down

Symptom 6

CIT: Exchange Client 
Access Server

ETI: ActiveSyncConnectivity Value: Down

Description: Network Interface Communication status impacts Hub Server 
Reachability

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: Unavailable

Symptom 1

CIT: Exchange Mail 
Server

ETI: HubServerReachability Value: Down

Description: Network Interface Communication status impacts Client Accessibility
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Exchange::Network Interface:Interface Communication Status >> 
Mailbox Queue Lengths

Description: Network Interface Communication status impacts Mailbox Queue 
Lengths

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: Unavailable

Symptom 1

CIT: Exchange Mail 
Server

ETI: 
MailboxReceiveQueueLength

Value: Very High

Symptom 2

CIT: Exchange Mail 
Server

ETI: 
PublicReplicationQueueLength

Value: Very High

Symptom 3

CIT: Exchange Mail 
Server

ETI: 
PublicReceiveQueueLength

Value: Very High

Symptom 4

CIT: Exchange Mail 
Server

ETI: AverageMailDeliveryTime Value: Very High

Symptom 5

CIT: Exchange Mail 
Server

ETI: AverageTimeforPFDelivery Value: Very High
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Exchange::Network Interface:Interface Communication Status >> 
Transport Queue Lengths

Description: Network Interface Communication status impacts Transport Queue 
Lengths

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: 
Unavailable

Symptom 1

CIT: Exchange Hub 
Server

ETI: UnreachableQueueLength Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: 
LargestDeliveryQueueLength

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: RetryNonSmtpDelivery

Queue Length

Value: Very High

Symptom 4

CIT: Exchange Hub 
Server

ETI: 
AggregateDeliveryQueueLength

Value: Very High

Symptom 5

CIT: Exchange Edge 
Server

ETI: UnreachableQueueLength Value: Very High

Symptom 6

CIT: Exchange Edge 
Server

ETI: 
LargestDeliveryQueueLength

Value: Very High

Symptom 7

CIT: Exchange Edge 
Server

ETI: RetryNonSmtpDelivery
QueueLength

Value: Very High
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Exchange::Network Interface:Interface Utilization >> Client 
Accessibility

Symptom 8

CIT: Exchange Edge 
Server

ETI: 
AggregateDeliveryQueueLength

Value: Very High

Description: Network Interface Utilization impacts Client Accessibility

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Exchange Client 
Access Server

ETI: IMAP4Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: POP3Latency Value: Very High

Symptom 3

CIT: Exchange Client 
Access Server

ETI: IMAP4Connectivity Value: Down

Symptom 4

CIT: Exchange Client 
Access Server

ETI: POP3Connectivity Value: Down

Symptom 5

CIT: Exchange Client 
Access Server

ETI: OWAConnectivity Value: Down

Symptom 6

CIT: Exchange Client 
Access Server

ETI: ActiveSyncConnectivity Value: Down

Description: Network Interface Communication status impacts Transport Queue 
Lengths
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Exchange::Network Interface:Interface Utilization >> Hub Server 
Reachability

Exchange::Network Interface:Interface Utilization >> Mailbox Queue 
Lengths

Description: Network Interface Utilization impacts Hub Server Reachability

Cause

CIT: Network Interface ETI: Interface Communication 
Status

Value: High

Symptom 1

CIT: Exchange Mail 
Server

ETI: HubServerReachability Value: Down

Description: Network Interface Utilization impacts Mailbox Queue Lengths

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Exchange Mail 
Server

ETI: 
MailboxReceiveQueueLength

Value: Very High

Symptom 2

CIT: Exchange Mail 
Server

ETI: 
PublicReplicationQueueLength

Value: Very High

Symptom 3

CIT: Exchange Mail 
Server

ETI: 
PublicReceiveQueueLength

Value: Very High

Symptom 4

CIT: Exchange Mail 
Server

ETI: AverageMailDeliveryTime Value: Very High
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Exchange::Network Interface:Interface Utilization >> Transport Queue 
Lengths

Symptom 5

CIT: Exchange Mail 
Server

ETI: AverageTimeforPFDelivery Value: Very High

Description: Network Interface Utilization impacts Transport Queue Lengths

Cause

CIT: Network Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Exchange Hub 
Server

ETI: UnreachableQueueLength Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: 
LargestDeliveryQueueLength

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: 
RetryNonSmtpDeliveryQueueLe
ngth

Value: Very High

Symptom 4

CIT: Exchange Hub 
Server

ETI: 
AggregateDeliveryQueueLength

Value: Very High

Symptom 5

CIT: Exchange Edge 
Server

ETI: UnreachableQueueLength Value: Very High

Symptom 6

CIT: Exchange Edge 
Server

ETI: 
LargestDeliveryQueueLength

Value: Very High

Description: Network Interface Utilization impacts Mailbox Queue Lengths
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Exchange::Network Interface:Network IO >> Client Accessibility

Exchange::Network Interface:Network IO >> Mail Flow Latency

Symptom 7

CIT: Exchange Edge 
Server

ETI: 
RetryNonSmtpDeliveryQueueLe
ngth

Value: Very High

Symptom 8

CIT: Exchange Edge 
Server

ETI: 
AggregateDeliveryQueueLength

Value: Very High

Description: Network IO Impacts Client Accessibility

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Exchange Client 
Access Server

ETI: Active Sync Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: OWA Latency Value: Very High

Description: Network IO Impacts Mail Flow Latency

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom

CIT: Exchange Mail 
Server

ETI: MailFlowLatency Value: Very High

Description: Network Interface Utilization impacts Transport Queue Lengths
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Exchange::Network Interface:Network IO >> Transport Queue Length

Exchange::Windows:CPU Load >> Edge TransportQueueLength

Description: Network IO Impacts Transport Queue Length

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Exchange Hub 
Server

ETI: Active Mailbox Delivery 
Queue Length

Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: Remote Delivery Queue 
Length

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: Delayed DSN Count Value: Very High

Symptom 4

CIT: Exchange Hub 
Server

ETI: Submission Queue Length Value: Very High

Description: CPU Load Impacts Edge Transport Queue Length

Cause

CIT: Windows ETI: CPU Load Value: Bottlenecked

Symptom 1

CIT: Exchange Edge 
Server

ETI: Submission Queue Length Value: Very High

Symptom 2

CIT: Exchange Edge 
Server

ETI: Active Mailbox Delivery 
Length

Value: Very High
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Exchange::Windows:CPU Load >> Hub TransportQueueLength

Exchange::Windows:CPU Load >> OWA Latency & Active Sync Latency

Symptom 3

CIT: Exchange Edge 
Server

ETI: Aggregate Delivery Queue 
Length

Value: Very High

Description: CPU Load Impacts Hub Transport Queue Length

Cause

CIT: Windows ETI: CPU Load Value: Bottlenecked

Symptom 1

CIT: Exchange Hub 
Server

ETI: Submission Queue Length Value: Very High

Symptom 2

CIT: Exchange Hub 
Server

ETI: Active Mailbox Delivery 
Length

Value: Very High

Symptom 3

CIT: Exchange Hub 
Server

ETI: Aggregate Delivery Queue 
Length

Value: Very High

Description: CPU Load Impacts OWA and Active Sync Latency

Cause

CIT: Windows ETI: CPU Load Value: Bottlenecked

Symptom 1

CIT: Exchange Client 
Access Server

ETI: OWA Latency Value: Very High

Symptom 2

CIT: Exchange Client 
Access Server

ETI: Active Sync Latency Value: Very High

Description: CPU Load Impacts Edge Transport Queue Length
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Exchange::Windows:Logical Disk Free Space >> Exchange Database

Exchange::Windows:Memory Load >> Exchange Memory Status

Exchange::Windows:Memory Usage Level >> Exchange Memory Status

Description: Available Disk Space on Logical Disk Impacts Exchange Database

Cause

CIT: Windows ETI: LogicalDisk Free Space Value: Near Capacity

Symptom 

CIT: Exchange Mail 
Server

ETI: Database Instance Status Value: Critical

Description: Memory Load Impacts Memory Available for Exchange

Cause

CIT: Windows ETI: Memory Load Value: Paging

Symptom

CIT:Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical

Description: Memory Usage Level Impacts Memory Available for Exchange

Cause

CIT: Windows ETI: Memory Usage Level Value: Near Capacity

Symptom 

CIT: Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical
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Exchange::Windows:PageFile Usage >> Exchange Memory Status

Exchange::Windows:Ping Availability >> Hub Server Reachability & 
Mail Submission Status

Description: Page File Usage on the Computer which hosts Exchange Mail Server 
Impacts Exchange Memory Status

Cause

CIT: Windows ETI: Page File Usage Value: Near Capacity

Symptom 

CIT: Exchange Mail 
Server

ETI: Exchange Memory Status Value: Critical

Description: Ping Availability of Hub Server Impacts Mail Submission and Hub Server 
Reachability

Cause

CIT: Windows ETI: Ping Availability Value: Unavailable

Symptom 1

CIT: Exchange Mail 
Server

ETI: Mail Submission Status Value: Down

Symptom 2

CIT: Exchange Mail 
Server

ETI: Hub Server Reachability Value: Down
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Tool Definitions
Start MS Exchange Information Store Service: Starts the Microsoft 
Exchange Information service on a Microsoft Exchange Mailbox server.

Start MS Exchange Transport Service: Starts the Microsoft Exchange 
Transport Service on a Microsoft Exchange Transport server.

Graph Templates
The following table lists the graph templates present in the content pack 
and mapped policies. 

Graph Templates Policy Name Policy Description

Virtual Memory Largest 
Block Size

EXSPI-8X 
Dc-Information Store 
Performance

EXSPI-14X 
Dc-Information Store 
Performance

Collect Performance 
Data on MSExchangeIS 
Object

Virtual Memory Large Free 
Block Megabytes Usage

Collect Performance 
Data on MSExchangeIS 
Object

Virtual Memory 16MB Free 
Block Trend

Collect Performance 
Data on MSExchangeIS 
Object

Information Store Users 
and Connections

Collect Performance 
Data on MSExchangeIS 
Object

MAPI RPC Performance Collect Performance 
Data on MSExchangeIS 
Object

MAPI RPC Latency Levels EXSPI-8X Dc-Outlook 
Client

EXSPI-14X Dc-Outlook 
Client

Log Outlook Client 
Metrics

Outlook Client RPC 
Performance

Log Outlook Client 
Metrics

Outlook Client Failures Log Outlook Client 
Metrics
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Exchange Public Folder 
Store EDB Database 
Statistics

EXSPI-8X Get Public IS 
Sum Data

Gets Public Folder 
Database Details

EXSPI-14X Get Public IS 
Sum Data

Exchange Mailbox Store 
EDB Database Statistics

EXSPI-8X Get Mailbox 
IS Sum Data

Gets Mailbox Database 
Details

EXSPI-14X Get Mailbox 
IS Sum Data

Transport Server Queues EXSPI-8X Dc Transport 
Queues

This policy logs 
performance data of 
Transport Queues.

EXSPI-14X Dc Transport 
Queues

Graph Templates Policy Name Policy Description
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Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

Note: For more information on the measurement threshold policies and 
events, refer to the HP Operations Smart Plug-in for Microsoft Exchange 
Server documentation.

ETI/HI Policy Name Policy Description

Active Mailbox 
Delivery Queue 
Length

EXSPI-8X Edge Th-Active 
Mailbox Delivery Queue 
Length

Active Mailbox Delivery 
Queue Length is the number 
of messages in the active 
mailbox queues.

EXSPI-14X Edge Th-Active 
Mailbox Delivery Queue 
Length

EXSPI-8X Hub Th-Active 
Mailbox Delivery_ 
QLength

Alarm on Active Mailbox 
Delivery Queue Length 
perfmon counter.

EXSPI-14X Hub Th-Active 
Mailbox Delivery_ 
QLength

ADAM Service 
Status

EXSPI-8X_ Check_ 
ADAMServiceStatus

Checks the status of Microsoft 
Exchange ADAM Service.

EXSPI-14X_ Check_ 
ADAMServiceStatus

AD Topology 
Service Status

EXSPI-8X_ Check_AD 
Topology Service Status

Checks the status of Microsoft 
Exchange Active Directory 
Topology Service.

EXSPI-14X_ Check_AD 
Topology Service Status
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Aggregate 
Delivery Queue 
Length

EXSPI-8X Edge Th-Agg 
Delivery QLength 
-All_Queues

Aggregate Delivery Queue 
Length -All_Queues is the 
number of messages queued 
for delivery in all queues.

EXSPI-14X Edge Th-Agg 
Delivery QLength 
-All_Queues

EXSPI-8X Hub Th-Agg Del_ 
QLength -All_ Queues

Alarm on Aggregate Delivery 
Queue Length -All_Queues 
perfmon counter.

EXSPI-14X Hub Th-Agg 
Del_ QLength -All_ Queues

ActiveSycn
Connectivity

EXSPI-8X-Async
Connectivity_Latency

Monitors the ActiveSync 
Latency on the Server.

EXSPI-14X-Async
Connectivity_Latency

ActiveSync
Latency

EXSPI-8X-Async
Connectivity_Result

Monitors the status of 
ActiveSync Connectivity.

EXSPI-14X-Async
Connectivity_Result

Average Mail 
Delivery Time

EXSPI-8X IS Mailbox 
Average Delivery Time

Information Store mailbox 
average delivery time.

EXSPI-14X IS Mailbox 
Average Delivery Time

Average Time for 
PF Delivery

EXSPI-8X IS Public Average 
Delivery Time

Information store public 
average delivery time.

EXSPI-14X IS Public 
Average Delivery Time

Database Instance 
Status

EXSPI-8X Information 
Store Db Log Threads 
Waiting

Alarm on information store 
threads waiting to write to 
transaction log.

EXSPI-14X Information 
Store Db Log Threads 
Waiting

ETI/HI Policy Name Policy Description
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Delayed DSN 
Count

EXSPI-8X Edge Th-Delay 
DSNs

Delay DSNs is the number of 
delivery status notification 
(DSNs) messages that have 
been generated.EXSPI-14X Edge Th-Delay 

DSNs

EXSPI-8X Hub Th-Delay 
DSNs

Alarm on delay DSNs 
perfmon counter.

EXSPI-14X Hub Th-Delay 
DSNs

Edge Credential 
Service Status

EXSPI-8X_ 
Check_EdgeCredential
ServiceStatus

Checks the status of Microsoft 
Exchange Credential Service.

EXSPI-14X_ Check_ 
EdgeCredentialService
Status

Edge Sync Service 
Status

EXSPI-8X_ 
Check_HUBExchangeEdge
SyncService Status

Checks the status of Microsoft 
Exchange EdgeSync Service.

EXSPI-14X_ 
Check_HUBExchangeEdge
SyncServiceStatus

Exchange Memory 
Status

EXSPI-8X Information 
Store Memory Errors

Alarm on the number of 
Microsoft Exchange memory 
errors.

EXSPI-14X Information 
Store Memory Errors

Exchange Service 
Host Status

EXSPI-8X_Check_CAS
ExchangeServiceHostStatus 

Checks the status of Microsoft 
Exchange Mailbox Service 
Host.

EXSPI-14X_Check_CAS
ExchangeServiceHostStatus

EXSPI-8X_Check_MB
ExchangeServiceHostStatus

Checks the status of Microsoft 
Exchange Mailbox Service 
Host.

EXSPI-14X_Check_MB
ExchangeServiceHostStatus

ETI/HI Policy Name Policy Description
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Failed DSN Count EXSPI-8X Edge Th-Failure  
DSNs Total

Failure DNSs is the number of 
failure delivery status 
notifications (DSNs) messages 
that have been generated.EXSPI-14X Edge Th-Failure  

DSNs Total

EXSPI-8X Hub 
Th-FailureDSNsTotal

Alarm on failure DSNs total 
perfmon counter.

EXSPI-14X Hub 
Th-FailureDSNsTotal

File Distribution 
Service Status

EXSPI-8X_ 
Check_CASFileDistribution
ServiceStatus

Checks the status of Microsoft 
Exchange File Distribution 
Service.

EXSPI-14X_ 
Check_CASFileDistribution
ServiceStatus

EXSPI-8X_Check_UMFile
DistributionServiceStatus

Checks the status of Microsoft 
Exchange File Distribution 
Service.

EXSPI-14X_Check_UMFile
DistributionServiceStatus

Hub Server 
Reachability

EXSPI-8X MSExchangeMail
Submission Events

Reports Microsoft Exchange 
mail submission events.

EXSPI-14X 
MSExchangeMail
Submission Events

IMPA4 
Connectivity

EXSPI-8X Test Mapi 
Connectivity

Monitors the status of Imap 
Connectivity.

EXSPI-14X Test Mapi 
Connectivity

IMAP4 Latency EXSPI-8X-IMap
Connectivity_Latency

Monitors the IMAP4 Latency 
on the Server.

EXSPI-14X-IMap
Connectivity_Latency

ETI/HI Policy Name Policy Description
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IMAP4 Service 
Status

EXSPI-8X_Check_IMAP4
ServiceStatus

Checks the status of Microsoft 
Exchange IMPA4 Service.

EXSPI-14X_Check_IMAP4
ServiceStatus

IMAP4 Status EXSPI-8X IMAP4 Failed 
Connection Rate

IMAP4 failed connections 
percentage.

EXSPI-14X IMAP4 Failed 
Connection Rate

Information Store 
Service Status

EXSPI-8X_ Check_ 
InformationStoreService
Status

Checks the status of Microsoft 
Exchange Information Store 
Service.

EXSPI-14X_ Check_ 
InformationStoreService
Status

Largest Delivery 
Queue Length

EXSPI-8X Edge Th-Largest 
Delivery Queue Length

Largest Delivery Queue 
Length is the number of 
messages in the largest 
delivery queue.EXSPI-14X Edge Th-Largest 

Delivery Queue Length

EXSPI-8X Hub 
Th-LargestDelivery_Q
Length

Alarm on Largest Delivery 
Queue Length perfmon 
counter.

EXSPI-14X Hub 
Th-LargestDelivery_Q
Length

Load Exchange 
Topology

EXSPI-8X MsExchange 
EdgeSync Events

Reports Microsoft Exchange 
edgesync events.

EXSPI-14X MsExchange 
EdgeSync Events

ETI/HI Policy Name Policy Description
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Mailbox Assistant 
Service Status

EXSPI-8X_ Check_ 
MailboxAssistantService
Status

Checks the status of Microsoft 
Exchange Mailbox Assistants 
Service.

EXSPI-14X_ Check_ 
MailboxAssistantService
Status

Mailbox Receive 
Queue Length

EXSPI-8X IS Mailbox 
Receive Queue Length

Checks the information store 
mailbox receive queue length.

Mail Submission 
Service Status

EXSPI-8X_ Check_ 
MailSubmissionService
Status

Checks the status of Microsoft 
Exchange Mail Submission 
Service.

EXSPI-14X_ Check_ 
MailSubmissionService
Status

Mail Submission 
Status

EXSPI-8X- 
MSExchangeMail
Submission Events

Reports Microsoft Exchange 
mail submission events.

EXSPI-14X- 
MSExchangeMail
Submission Events

Mapi
Connectivity

EXSPI-8X-Mapi
Connectivity_Result

Monitors the status of MAPI 
Connectivity.

EXSPI-14X-Mapi
Connectivity_Result

MapiLatency EXSPI-8X-Mapi
Connectivity_Latency

Monitors the MAPI Latency 
on the Server.

EXSPI-14X-Mapi
Connectivity_Latency

MailFlowLatency EXSPI-8X-MailFlowStatus_
Latency

Monitors the 
MailFlowLatency on the 
Server.

ETI/HI Policy Name Policy Description
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MailFlowStatus EXSPI-8X-MailFlowStatus_
Result

Monitors the status of Mail 
Flow.

EXSPI-14X-MailFlowStatus
_Result

OWAConnectivity EXSPI-8X-Owa
Connectivity_Result

Monitors the status of OWA 
Connectivity.

EXSPI-14X-Owa
Connectivity_Result

OWALatency EXSPI-8X-OwaConnectivit
y_Latency

Monitors the OWA Latency 
on the Server.

EXSPI-14X-OwaConnectivi
ty_Latency

Poison Queue 
Length

EXSPI-8X Hub 
Th-Poison_QLength

Alarm on poison queue 
length perfmon counter.

EXSPI-14X Hub 
Th-Poison_QLength

EXSPI-8X Edge Th-Poison 
Queue Length

Poison message queue length 
is the number of messages in 
the poison message queue.

EXSPI-14X Edge Th-Poison 
Queue Length

POP3Connectivity EXSPI-8X-Pop
Connectivity_Result

Monitors the status of Pop3 
Connectivity.

EXSPI-14X-Pop
Connectivity_Result

POP3 Latency EXSPI-8X-Pop
Connectivity_Latency

Monitors the status of Pop3 
Latency

EXSPI-14X-Pop
Connectivity_Latency

ETI/HI Policy Name Policy Description
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POP3 Service 
Status

EXSPI-8X_ 
Check_POP3Service Status

Checks the status of Microsoft 
Exchange POP3 Service.

EXSPI-14X_ 
Check_POP3Service Status

POP3 Status EXSPI-8X POP3 Failed 
Connection Rate

POP3 failed connections 
percentage.

EXSPI-14X POP3 Failed 
Connection Rate

Public Receive 
Queue Length

EXSPI-8X IS Public Receive 
Queue Length

Checks the information store 
public receive queue length.

Public Replication 
Queue Length

EXSPI-8X IS Public 
Replication Queue Length

Checks the information store 
replication queue length.

EXSPI-14X IS Public 
Replication Queue Length

Remote Delivery 
Queue Length

EXSPI-8X Edge Th-Active 
Remote Delivery Queue 
Length

Reports the number of 
messages in the active remote 
delivery queues.

EXSPI-14X Edge Th-Active 
Remote Delivery Queue 
Length

EXSPI-8X Hub 
Th-ActiveRemoteDelivery_
QLength

Alarm on active remote 
delivery queue length 
perfmon counter.

EXSPI-14X Hub 
Th-ActiveRemoteDelivery_
QLength

Replication 
Service Status

EXSPI-8X_Check_Replicati
onServiceStatus

Checks the status of Microsoft 
Exchange Mailbox 
Replication Service.

EXSPI-14X_Check_
ReplicationServiceStatus

ETI/HI Policy Name Policy Description
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Retry Non Smtp 
Delivery Queue 
Length

EXSPI-8X Edge Th-Retry 
Non-SMTP Delivery Queue 
Length

Retry Non-SMTP Delivery 
Queue Length is the number 
of messages in retry in the 
non-SMTP gateway delivery 
queues.EXSPI-14X Edge Th-Retry 

Non-SMTP Delivery Queue 
Length

EXSPI-8X Hub 
Th-RetryNon-SmtpDelivery
_QLength

Alarm on Retry Non-Smtp 
Delivery Queue Length 
perfmon counter.

EXSPI-14X Hub 
Th-RetryNon-SmtpDelivery
_QLength

Speech Engine 
Status

EXSPI-8X_Check_Speech
EngineStatus

Checks the status of Microsoft 
Exchange Speech Engine 
Service.

EXSPI-14X_Check_Speech
EngineStatus

Submission 
Thread Count

EXSPI-8X MSExchange 
Store Driver Events

Reports the events generated 
for the source Microsoft 
Exchange store driver.

EXSPI-14X MSExchange 
Store Driver Events

Submission Queue 
Length

EXSPI-8X Edge 
Th-Submission Queue 
Length

Number of messages in the 
submission queue.

EXSPI-14X Edge 
Th-Submission Queue 
Length

EXSPI-8X Hub 
Th-Submission_QLength

Alarm on submission queue 
length perfmon counter.

EXSPI-14X Hub 
Th-Submission_QLength

System Attendant 
Status

EXSPI-8X_Check_System
AttendantStatus

Checks the status of Microsoft 
Exchange Mailbox System 
Attendant Service.

ETI/HI Policy Name Policy Description
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Transport Service 
Status

EXSPI-8X_Check_HUB
ExchangeTransportService
Status

Checks the status of Microsoft 
Exchange Transport Service.

EXSPI-14X_Check_HUB
ExchangeTransportService
Status

EXSPI-8X_Check_EDGE
ExchangeTransportService
Status

Checks the status of Microsoft 
Exchange Transport Service.

EXSPI-14X_Check_EDGE
ExchangeTransportService
Status

Unified Messaging 
Status

EXSPI-8X_Check_Unified
MessagingStatus

Checks Unified Messaging 
service status.

EXSPI-14X_Check_Unified
MessagingStatus

Unreachable 
Queue Length

EXSPI-8X Hub 
Th-Unreachable_QLength

Alarm on unreachable queue 
length perfmon counter.

EXSPI-14X Hub 
Th-Unreachable_QLength

EXSPI-8X Edge 
Th-Unreachable Queue 
Length

Unreachable queue length is 
the number of messages in 
the unreachable queue.

EXSPI-14X Edge 
Th-Unreachable Queue 
Length

ETI/HI Policy Name Policy Description
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Operations Orchestration Flow
When creating the mapping, you can set default values for the attributes 
listed in the following table.

For more information about creating the mapping and a Run Book 
automation rule, see "How to Create a Run Book Automation Rule" on 
page 505.

The following table lists the Microsoft Exchange Server Operations 
Orchestration (OO) Flows:

OO Flow: Check Client Access Server Health 

User input when executing OO flow: Check Client Access Server Health  

Attribute Description

omServerPort Port number of the HPOM Tool WS.

omServerUser User name for the HPOM Server that will use used in 
the HPOM Tool WS.

omServerPassword Password for the HPOM Server that will use used in the 
HPOM Tool WS.

Flow input Mapping CI Event Attribute

omServer exchangeclientaccessser
ver

Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

threshold The threshold for GC Query Latency in milliseconds.
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OO Flow: Check Mailbox Server Health 

User input when executing OO flow: Check Mailbox Server Health  

OO Flow: Check Replication Health 

User input when executing OO flow: Check Replication Health  

Flow input Mapping CI Event Attribute

omServer exchangemailserver Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

threshold The threshold for GC Query Latency in milliseconds.

maillatency The threshold for MailFlow Latency in milliseconds.

Flow input Mapping CI Event Attribute

omServer exchangemailserver Originating Server

Flow input CI Type 

omNode Target node with an HPOM Agent.

omCmdTimeout The timeout value to be used when running the remote 
command on the node. By default set to 100000.

threshold The threshold for GC Query Latency in milliseconds.
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Microsoft Lync Server 2010 Content Pack

The Microsoft Lync Server 2010 Content Pack contains the following 
artifacts:

➤ Configuration Item Types on page 1017

➤ Views on page 1021

➤ Enrichment Rules on page 1026

➤ Health Indicators on page 1026

➤ Event Type Indicators on page 1033

➤ Correlation Rules on page 1035

➤ Graph Templates on page 1049

➤ Policies Setting ETIs on page 1053
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Configuration Item Types
The Microsoft Lync Server 2010 includes the following Configuration Item 
Types (CITs):

CIT Description CIT Name
Parent CIT 
Name

Active 
Directory 
Forest 
(Existing CIT 
in RTSM)

Active Directory Forest is a 
group of one or more 
Active Directory domains 
sharing a logical structure.

activedirectory
forest

Active
directory 
(abstract)

Lync Site 
(New CIT)

A Lync Site is a set of 
connected computers that 
contain Microsoft Lync 
Server 2010 components. 
Each Lync Site can have 
one or more Lync Pools, 
and every pool can 
contain one or more 
Microsoft Lync Server 
2010 components. The 
Lync Site can either be a 
central site or a branch 
site.

lyncsite Lync (Abstract 
class inherited 
from 
Application 
System)

Lync Pool 
(New CIT)

A Lync Pool is a group of 
Lync Servers. The Lync 
Pool has identical services 
running on every Lync 
Server in the group in 
order to keep the pool 
stabilized even if one 
server in the pool goes 
down.

lyncpool Lync (Abstract 
class inherited 
from 
Application 
System)
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Lync Server 
(New CIT)

Microsoft Lync Server 
2010 is an enterprise 
real-time communications 
server providing features 
such as instant messaging, 
peer-to-peer and 
multiparty voice and 
video calling, structured 
conferences (audio, video 
and web), file transfer, and 
PSTN connectivity.

lyncserver Communication 
Server (Abstract 
class inherited 
from Running 
Software)

Lync Server 
Role (New 
CIT)

A server role is a logical 
group of features and 
components required to 
perform a specific 
function in your 
messaging environment. 
Microsoft Lync Server 
2010 allows you deploy 
server roles that you 
require for your 
organization.

lyncserverrole 
(abstract)

lyncresource 
(Abstract class 
inherited from 
Application 
Resource CIT)

Front End 
Server (New 
CIT)

The Front End Server is 
the main server role 
running many basic 
Microsoft Lync Server 
2010 functions. The Back 
End Servers provide the 
database. In any Lync 
Server Enterprise 
Edition,deploy the Front 
End Server along with the 
Back End Server.

frontendserver lyncserverrole

CIT Description CIT Name
Parent CIT 
Name
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AV 
Conferencing 
Server (New 
CIT)

The AV Conferencing 
Server provides the audio/
video conferencing 
functionality. This server 
can be placed with the 
Front End Server or can be 
deployed separately.

avconferencing
server

lyncserverrole

Edge Server 
(New CIT)

The Edge Server allows 
you to communicate with 
external users outside the 
organization’s firewalls.

edgeserver lyncserverrole

Mediation 
Server (New 
CIT)

The Mediation Server is an 
essential component 
required to execute 
Enterprise Voice and 
dial-in conferencing. It 
mediates signaling and 
media between Enterprise 
Voice and a 
mediagateway.

mediation
server

lyncserverrole

Monitoring 
Server (New 
CIT)

The Monitoring Server 
collects data, both in 
Enterprise Voice call and 
A/V conferences), 
regarding the quality of 
network media, call error 
records (CERs) and call 
detail records (CDRs).

monitoring
server

lyncserverrole

Archiving 
Server (New 
CIT)

Archiving Server archives 
meeting and instant 
messaging (IM) content 
required for compliance 
reasons. Do not deploy 
the Archiving Server if you 
do not have any legal 
compliance reasons.

archiving
server

lyncserverrole

CIT Description CIT Name
Parent CIT 
Name
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Director 
Server (New 
CIT)

Directors authenticate 
Lync Server user requests 
connecting from outside 
the organization’s firewall 
and route these users to 
their respective home 
pools. All unauthenticated 
traffic is stopped and 
dropped before it reaches 
the internal servers.

directorserver lyncserverrole

Registrar 
Server (New 
CIT)

The Registrar Server 
accepts register requests 
from the Session Initiation 
Protocol (SIP) endpoints 
and save the registration 
information into a 
location database. This 
information saved is used 
to route signaling 
information to the 
endpoint.

registrarserver lyncserverrole

Central 
Management 
Server (New 
CIT)

The Central Management 
store is a central database 
that stores configuration 
database for the entire 
Lync Server deployment. 
It directs replication of 
configuration data to the 
respective replica 
databases running on 
every machine and 
provides access to the 
master copy.

central
management
server

lyncserverrole

CIT Description CIT Name
Parent CIT 
Name
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Views
The RTSM package in the Microsoft Lync Server 2010 Content Pack contains 
the following views:

➤ Lync_NetworkIP_View: This view shows the Microsoft Lync Server, its 
Next Hop node, along with the IP address and the IP Subnet to which the 
node belongs to, and other nodes across the IP Subnet.

➤ Lync_NetworkL2_View: This view shows the Microsoft Lync Server 
along with its roles, the node on which the Lync Server is running, the 
node interface, by which it is connected to the network, and the Next 
Hop node in the Layer 2 Connection.
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➤ Lync_Org_View: This view shows the Microsoft Lync Server organization 
and its components. It shows the AD forest where the Lync Servers are 
deployed along with the Lync Sites, the Lync Pools, and the Lync Servers 
and its roles. It also shows the Domain Controllers, SQL Servers and 
Exchange Servers on which the Lync Server has a dependency.
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➤ Lync_Pool_View: This view shows the Lync Pools and the member Lync 
Server along with the server roles and the SQL Server instances used by 
the server.

➤ Lync_Server_View: This view shows all the Lync Servers and their roles.
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➤ Lync_Site_View: This view shows all the Lync Pools, Lync Servers, Lync 
Server roles, Lync Server nodes, along with the interface used by the 
nodes, and the Layer 2 Connection to which the interfaces are connected 
to in a given Lync Site.
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➤ Lync_Role_Site: This view shows all the Lync Servers along with their 
roles in a given Lync Site.
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Enrichment Rules
The Microsoft Lync Server 2010 Content Pack contains the following 
Enrichment Rules:

➤ CentralSite_Parent_BranchSite

➤ FrontEndServer_Uses_ExchangeUMServer

➤ LyncServer_Uses_DomainController

➤ LyncServerRole_Depends_SqlServer

Health Indicators
The Content Pack includes the following Health Indicators (HIs) to monitor 
Microsoft Lync Server 2010-related events:

CI Type HI Description Value

Archiving 
Server

Archiving DB 
Latency

Indicates the DB queue 
latency in the Archiving 
Server.

Normal
High
Very High

Archiving 
Server 

Archiving Service 
Status

Indicates the status of the 
Archiving Service.

Up 
Down 

Archiving 
Server 

Archiving DB Queue Indicates the depth of DB 
Queue in Archiving Server.

Normal 
High 
Very High 

Archiving 
Server

Archiving Server 
Load

Indicates the load on the 
Archiving Server.

Bottlenecked
Overloaded
Constrained
Busy
Normal

AV 
Conferencing 
Server

AV Conf Service 
Status

Indicates the status of AV 
Conference Service.

Up
Down

AV 
Conferencing 
Server

AV Conf Server 
Load

Indicates the current load 
on the AV Conferencing 
Server.

Bottlenecked
Overloaded
Constrained
Busy
Normal
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AV 
Conferencing 
Server

AV Conferencing 
Health

Indicates the health of AV 
Conferencing Server.

Normal
Overloaded

AV 
Conferencing 
Server

Bandwidth 
Availability

Indicates the bandwidth 
available for AV 
conference.

Normal
Low
Very Low

AV 
Conferencing 
Server

Number Of Failed 
Conferences

Indicates the number of 
failed conferences.

Very High
High
Normal

AV 
Conferencing 
Server

AV Connectivity Indicates connectivity of 
AV conference.

Up
Down

AV 
Conferencing 
Server

Concurrent 
Conferences

Indicates the number of 
concurrent conferences 
occurring.

Very High
High
Normal

AV 
Conferencing 
Server

AV Latency Indicates the latency of AV 
Conference.

Very High
High
Normal

AV 
Conferencing 
Server

Conference Login 
Latency

Indicates the latency in 
logging in to a conference.

Very High
High
Normal

Director 
Server

Federation Logon 
Failures

Indicates the logon failure 
rate of federated users.

Very High
High
Normal

Director 
Server

Director Service 
Status

Indicates the status of the 
Director Service.

Up
Down

Director 
Server

Sproc Latency Indicates the latency of 
processing a request in the 
Director Server.

Very High
High
Normal

Edge Server EdgeConnectivity Indicates the connectivity 
of Edge Server with the 
FrontEnd Server or 
Director Server.

Up
Down

CI Type HI Description Value
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Edge Server Authentication 
Failures

Indicates the rate of user 
authentication failures in 
Edge Server.

Very High
High
Normal

Edge Server Edge AVAuth 
Service Status

Indicates the status of AV 
Authentication Service in 
the Edge Server.

Up
Down

Edge Server DOS Attack Indicates whether the Edge 
Server is under 
Denial-of-Service attack.

Normal
Attacked

Edge Server Edge AV Service 
Status

Indicates the status of AV 
service in the Edge Server.

Up
Down

Edge Server Edge Access 
Service Status

Indicates the status of the 
Edge Access Service.

Up
Down

Edge Server Edge Web Conf 
Service Status

Indicates the status of Web 
Conference Service in Edge 
Server.

Up
Down

FrontEnd 
Server

Outbound Tasks 
Queued

Indicates the number of 
outbound requests and 
responses queued.

Very High
High
Normal

FrontEnd 
Server

Response Grp 
Service Status

Indicates the status of 
Response Group Service.

Up
Down

FrontEnd 
Server

Web 
Conferencing 
Service Status

Indicates the status of Web 
Conferencing Service.

Up
Down

FrontEnd 
Server

FrontEnd Service 
Status

Indicates the status of the 
Front End Service.

Up
Down

FrontEnd 
Server

IM Conferencing 
Latency

Indicates latency in 
creating a conference.

Very High
High
Normal

FrontEnd 
Server

Exchange 
UMConnectivity

Indicates the status of 
connectivity to the 
Exchange Unified 
Messaging Server.

Up
Down

CI Type HI Description Value
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FrontEnd 
Server

Mediation Service 
Status

Indicates the status of 
Mediation Service.

Up
Down

FrontEnd 
Server

IM Conferencing 
Status

Indicates the status of IM 
Conferencing Availability.

Up
Down

FrontEnd 
Server

IM Conferencing 
Service Status

Indicates the status of IM 
Conferencing Service.

Up
Down

FrontEnd 
Server

Conf Attendant 
Service Status

Indicates the status of 
Conference Attendant 
Service.

Up
Down

FrontEnd 
Server

Application 
Sharing Service 
Status

Indicates the status of 
Application Sharing 
Service.

Up
Down

FrontEnd 
Server

Request 
Processing 
Latency

Indicates the average 
processing time taken by 
the server for one request.

Very High
High
Normal

FrontEnd 
Server

Conf 
Announcement 
Service Status

Indicates the status of 
Conference 
Announcement Service.

Up
Down

FrontEnd 
Server

CallPark Service 
Status

Indicates the status of Call 
Park Service.

Up
Down

Lync Server Server Load Indicates if the Lync Server 
is undergoing heavy 
processing load.

Bottlenecked
Overloaded
Constrained
Busy
Normal

Lync Server SIP Load Indicates the load on the 
server due to SIP 
transactions.

Very High
High
Normal

Lync Server Replication 
Service Status

Indicates the status of the 
Replication Service.

Up
Down

Lync Server Central Mgmt 
Service Status

Indicates the status of the 
Central Management 
Service.

Up
Down

CI Type HI Description Value
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Lync Server 
Role

Queue Depth Indicates the Queue Depth 
specific to particular role.

Very High
High
Normal

Lync Server 
Role

Backend 
Connectivity

Indicates the status of 
connectivity between the 
Lync Server and the back 
end SQL Server.

Up
Down

Lync Server 
Role

Resource Usage Indicates the resource 
usage of the a Lync Server.

Very High
High
Normal

Lync Server 
Role

Queue Latency Indicates the Queue 
Length specific to 
particular role.

Very High
High
Normal

Lync Server 
Role

AD Connectivity Indicates the status of AD 
Connectivity.

Up
Down

Lync Server 
Role

LDAP Latency Indicates the latency in 
LDAP queries.

Very High
High
Normal

Mediation 
Server

Mediation Server 
Health

Indicates the Health of the 
Mediation Server.

Normal
Loaded
Overloaded

Mediation 
Server

Exchange UM 
Calls Failure Rate

Indicates the rate of failure 
of UM Calls.

Very High
High
Normal

Mediation 
Server

Outbound Call 
Connectivity

Indicates the connectivity 
status of outbound calls.

Up
Down

Mediation 
Server

Inbound Call 
Connectivity

Indicates the connectivity 
status for inbound calls.

Up
Down

Mediation 
Server

Mediation Server 
Load

Indicates the current load 
on the Server.

Bottlenecked
Overloaded
Constrained
Busy
Normal

CI Type HI Description Value
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Mediation 
Server

Mediation Service 
Status

Indicates the service status 
of Mediation Service.

Up
Down

Mediation 
Server

Voice Quality Indicates the quality of 
voice in the Mediation 
Server.

Normal
Low
Very Low

Mediation 
Server

PSTN 
Connectivity

Indicates the status of 
connectivity with PSTN 
gateway.

Up
Down

Monitoring 
Server

CDR Monitoring 
Service Status

Indicates the status of CDR 
Monitoring Service.

Up
Down

Monitoring 
Server

Monitoring Server 
Load

Indicates the load on the 
Monitoring Server.

Bottlenecked
Overloaded
Constrained
Busy
Normal

Monitoring 
Server

QoE Monitoring 
Service Status

Indicates the status of QOE 
Monitoring Service.

Up
Down

Registrar 
Server

Throttling Rate Indicates the rate at which 
the Registrar Server is 
throttling requests.

Very High
High
Normal

Registrar 
Server

AD Connectivity 
Failure Rate

Indicates the rate of 
failures in AD 
Connectivity.

Very High
High
Normal

Registrar 
Server

User Registration 
Latency

Indicates the latency in 
user registration.

Very High
High
Normal

Registrar 
Server

DataCenter 
Resilency 

Indicates the data center 
resiliency status.

Up
Down

Registrar 
Server

User 
Authentication 
Failure Rate 

Indicates the rate of user 
authentication failures in 
the Registrar Server.

Very High
High
Normal

CI Type HI Description Value
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Registrar 
Server

Registrar Server 
Load

Indicates the load on the 
Registrar Server.

Bottlenecked
Overloaded
Constrained
Busy
Normal

Registrar 
Server

User Registration 
Status

Indicates the status of user 
registration.

Success
Failure

CI Type HI Description Value
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Event Type Indicators
The Content Pack includes the following Event Type Indicators (ETIs) that 
monitor Microsoft Lync Server 2010-related events:

CI Type ETI Description Value

FrontEnd 
Server

AudioTest 
Service Status

Indicates status of the Audio 
Test Service.

Up
Down

BandWidth 
Policy Service 
Core Status

Indicates the status of the 
BandWidth Policy Service 
Core.

Up
Down

BandWidth 
Policy 
ServiceAuth 
Status

Indicates the status of 
BandWidth Policy Service 
Authentication.

Up
Down

WebConf 
Compatibility 
Service Status

Indicates the status of the Web 
Conferencing Compatibility 
Service.

Up
Down

File Transfer 
Agent Service 
Status

Indicates the status of the File 
Transfer Agent Service.

Up
Down

AD Requests 
Pending

The number of requests 
waiting currently for Active 
Directory responses.

Very High
High
Normal

AV 
Conferencing 
Server

Concurrent 
Conferences

Indicates the number of 
concurrently occurring 
conferences.

Very High
High
Normal

Bandwidth 
Availability

Indicates the bandwidth 
available for an AV conference.

Low
Normal
High
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Registrar User 
Authentication 
Failure Rate

Indicates the rate of user 
authentication failures in the 
Registrar Server.

Very High
High
Normal

User 
Registration 
Latency

Indicates latency in user 
registration.

Very High
High
Normal

Data Center 
Resilency

Indicates the data center 
resilency status.

Up
Down

CI Type ETI Description Value
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Correlation Rules
The content pack includes the following rules to correlate Microsoft Lync 
Server 2010-related events.

For more information on how the correlation rules work, see the Operations 
Manager i Concepts Guide.

Lync::Regsitrar::ADConnectivity >> UserRegistration 

Lync::Avconferencingserver::AVConferencingServiceStatus >> 
AVConfAvailability 

Description: Active Directory Connectivity issues in Registrar impacts User 
Registration 

Cause

CIT: Registrar Server ETI: AD Connectivity Value: Down

Symptom 

CIT: Registrar Server ETI: User Registration Status Value: Failure

Description: Status of AV Conference Service impacts availability of AV 
conferences on the AV Conferencing Server 

Cause

CIT: AV Conferencing 
Server

ETI: AV Conf Service Status Value: Down 

Symptom 1

CIT: AV Conferencing 
Server 

ETI: AV Conferencing Health Value: Overloaded

Symptom 2

CIT: AV Conferencing 
Server 

ETI: AV Connectivity Value: Down

Symptom 3

CIT: AV Conferencing 
Server

ETI: Number of failed 
conference

Value: Very High
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Lync::LyncRole::Back End Connectivity >> Queue Depth 

Lync::FrontEndServer::Band Width Policy Service Core >> Band Width 
Policy Service Auth 

Lync::SQLServer::Database Status >> Back End Connectivity  

Description: Connectivity to the back end database impacts the various queues on 
a Microsoft Lync Server 2010

Cause

CIT: Lync Server Role ETI: Backend Connectivity Value: Down  

Symptom 

CIT: Lync Server Role ETI: Queue Depth Value: Very High 

Description: Status of Bandwidth Policy Service Core in frontend server impacts 
Bandwidth Policy Service Auth 

Cause

CIT: Front End Server ETI: BandWidth Policy Service 
Core Status 

Value: Down 

Symptom 

CIT: Front End Server ETI: BandWidth Policy Service 
Auth Status 

Value: Down

Description: The status of the back end database impacts the status of back end 
connectivity on the Microsoft Lync Server 2010

Cause

CIT: SQL Server ETI: Database Status Value: Down

Symptom 

CIT: Lync Server Role ETI: Backend Connectivity Value: Down 
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Lync::SQLServer::DatabaseStatus >> FrontEndPerformance  

Lync::DomainController::DCLDAPBindResponseTime >> LDAPLatency  

Description: Database status on a the BackEnd Server impacts the performance of 
the FrontEnd server.

Cause

CIT: SQL Server ETI: Database Status Value: Down

Symptom 1

CIT: FrontEnd Server ETI: Queue Depth Value: Very High

Symptom 2

CIT: Front End Server ETI: Outbound Tasks Queued Value: Very High

Symptom 3

CIT: Front End Server ETI: Request Processing 
Latency

Value: Very High

Symptom 4

CIT: Front End Server ETI: Queue Latency Value: Very High

Description: DC LDAP Bind Response Time in the Active Directory impacts LDAP 
Latency on the Lync Server Roles

Cause

CIT: DomainController ETI: DC LDAP Bind Response 
Time

Value: Very High

Symptom 

CIT: Front End Server ETI: LDAP Latency Value: Very High
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Lync::FrontEndServer::Front End Server Load >> Performance 

Lync::FrontEndServer::Front End Service Status >> User Connectivity 

Description: Load on the FrontEnd Server impacts performance 

Cause

CIT: Lync Server ETI: Server Load Value: Bottlenecked 

Symptom 1

CIT: Front End Server ETI: Resource Usage Value: Very High

Symptom 2

CIT: Front End Server ETI: Outbound Tasks Queued Value: Very High

Symptom 3

CIT: Front End Server ETI: Request Processing 
Latency

Value: Very High

Description: The status of the Front End Service on the Front End Server will 
impact user connectivity

Cause

CIT: Front End Server ETI: Front End Service Status Value: Down

Symptom 1

CIT: Registrar Server ETI: User Authentication 
Failure Rate

Value: Very High

Symptom 2

CIT: Registrar Server ETI: User Registration Status Value: Failure
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Lync::FrontEndServer::IM Conferencing Service Status >> IM Availability 

Lync::FrontEndServer::IM Conferencing Service Status >> SIP Load 

Lync::Interface::Interface Utilization >> AD Connectivity 

Description: The status of the Instant Messaging Conference service impacts 
ability to host instant messaging by the Microsoft Lync Server 2010

Cause

CIT: Front End Server ETI: IM Conferencing Service 
Status  

Value: Down

Symptom 1

CIT: Front End Server ETI: IM Conferencing Status Value: Down

Symptom 2

CIT: Front End Server ETI: IM Conferencing Latency Value: Very High

Description: The status of the IM Conferencing Service in the Front End Server 
impacts SIP load

Cause

CIT: FrontEnd Server ETI: IM Conferencing Status Value: Down

Symptom 

CIT: Lync Server ETI: SIPLoad Value: Very High

Description: High interface utilization in the computer hosting the Microsoft 
Lync Server 2010 impacts the server's connectivity to the Active Directory

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Mediation Server ETI: LDAP Latency Value: Very High

Symptom 2

CIT: Archiving Server ETI: AD Connectivity Value: Down
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Symptom 3

CIT: Registrar Server ETI: AD Connectivity Value: Down

Symptom 4

CIT: Front End Server ETI: LDAP Latency Value: Very High 

Symptom 5

CIT: Archiving Server ETI: LDAP Latency Value: Very High 

Symptom 6

CIT: Central 
Management Server 

ETI: AD Connectivity Value: Down

Symptom 7

CIT: Monitoring Server ETI: LDAP Latency Value: Very High 

Symptom 8

CIT: Mediation Server ETI: AD Connectivity Value: Down 

Symptom 9

CIT: Monitoring Server ETI: AD Connectivity Value: Down

Symptom 10

CIT: AV Conferencing 
Server

ETI: AD Connectivity Value: Down

Symptom 11

CIT: AV Conferencing 
Server

ETI: LDAP Latency Value: Very High 

Symptom 12

CIT: Registrar Server ETI: LDAP Latency Value: Very High 

Symptom 13

CIT: Front End Server ETI: AD Connectivity Value: Down

Description: High interface utilization in the computer hosting the Microsoft 
Lync Server 2010 impacts the server's connectivity to the Active Directory
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Lync::Interface::Interface Utilization >> Back End Connectivity 

Symptom 14

CIT: Director Server ETI: LDAP Latency Value: Very High 

Symptom 15

CIT: Director Server ETI: AD Connectivity Value: Down 

Symptom 16

CIT: Central 
Management Server 

ETI: LDAP Latency Value: Very High 

Description: High network interface utilization on the computer hosting the 
Microsoft Lync Server 2010 impacts the back end connectivity of the server

Cause

CIT:Interface ETI: Interface Utilization Value: High 

Symptom 1

CIT: Registrar Server ETI:BackEnd Connectivity Value: Down 

Symptom 2

CIT: Mediation Server ETI: Backend Connectivity Value: Down

Symptom 3

CIT: Archiving Server ETI: Backend Connectivity Value: Down

Symptom 4

CIT: Front End Server ETI: Backend Connectivity Value: Down 
Symptom 5

CIT: AV Conferencing 
Server 

ETI: Backend Connectivity Value: Down 

Description: High interface utilization in the computer hosting the Microsoft 
Lync Server 2010 impacts the server's connectivity to the Active Directory
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Lync::Interface::Interface Utilization >> Director Performance 

Symptom 6

CIT: Central 
Management Server

ETI: Backend Connectivity Value: Down

Symptom 7

CIT: Monitoring Server ETI: Backend Connectivity Value: Down 

Symptom 8

CIT: Director Server ETI: Backend Connectivity Value: Down 

Symptom 9

CIT: Edge Server ETI: Backend Connectivity Value: Down

Description: Network interface utilization on the computer hosting the Director 
role of the Lync Server impacts the performance of the Director Server

Cause

CIT:Interface ETI: Interface Utilization Value: High 

Symptom 1

CIT: Director Server ETI: Sproc Latency Value: Very High 

Symptom 2

CIT: Director Server ETI: Queue Depth Value: Very High  

Symptom 3

CIT: Director Server ETI: Queue Latency Value: Very High

Description: High network interface utilization on the computer hosting the 
Microsoft Lync Server 2010 impacts the back end connectivity of the server
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Lync::Interface::Interface Utilization >> Front End Performance 

Lync::DomainController::LDAP Connectivity >> AD Connectivity 

Description: High network interface utilization on the computer hosting the Front 
End role of the Lync Server impacts the performance of the Front End Server 
performance

Cause

CIT: Interface ETI: Interface Utilization Value: High 

Symptom 1

CIT: Front End Server  ETI: Outbound Tasks Queued Value: Very High 

Symptom 2

CIT: Front End Server ETI: Request Processing 
Latency

Value: Very High  

Symptom 3

CIT: Front End Server  ETI: Queue Depth Value: Very High 

Symptom 4

CIT: Front End Server   ETI: Queue Latency Value: Very High 

Description: Status of LDAP Connectivity on the domain controllers impacts 
Active Directory connectivity in the Front End Server

Cause

CIT: DomainController ETI: DC LDAP Bind Response 
Time 

Value: Very High 

Symptom 

CIT: Front End Server ETI: AD Connectivity Value: Down 
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Lync::DomainController::Logon Errors >> User Authentication Failures

Lync::Windows::Memory Load >> Front End Queue

Lync::Interface::Interface Utilization Next Hop >> AD Connectivity 

Description: Logon errors in the Active Directory increases the rate of user 
authentication failures in the Front End Server

Cause

CIT: DomainController ETI: Logon Errors Value: Very High  

Symptom 

CIT: Registrar Server ETI: User Authentication 
Failure Rate

Value: Very High 

Description: Memory load on the computer hosting the Lync Front End Server 
impacts the Front End Queue

Cause

CIT: Windows ETI: Memory Load Value: Bottleneck

Symptom 1

CIT: Front End Server ETI: Queue Depth Value: Very High

Symptom 2

CIT: Front End Server ETI: Queue Latency Value: Very High

Description: Interface utilization on the next hop from the Lync Server can impact 
the AD Connectivity 

Cause

CIT: Interface ETI: Interface Utilization Value: High 

Symptom 1

CIT: Director Server ETI: AD Connectivity Value: Down

Symptom 2

CIT: Edge Server ETI: AD Connectivity Value: Down
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Lync::Interface::Interface Utilization Next Hop >> Back End Connectivity 

Symptom 3

CIT: Registrar Server ETI: AD Connectivity Value: Down

Symptom 4

CIT: Mediation Server ETI: AD Connectivity Value: Down

Symptom 5

CIT: Monitoring Server ETI: AD Connectivity Value: Down

Symptom 6

CIT: Archiving Server ETI: AD Connectivity Value: Down

Symptom 7

CIT: Front End Server ETI: AD Connectivity Value: Down

Symptom 8

CIT: AV Conferencing 
Server 

ETI: AD Connectivity Value: Down

Symptom 9

CIT: Central 
Management Server 

ETI: AD Connectivity Value: Down

Description: Network interface utilization on the next hop from the computer 
hosting the Microsoft Lync Server 2010 impacts ability to connect to the Back End 
Server

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Director Server ETI: Backend Connectivity Value: Down

Symptom 2

Description: Interface utilization on the next hop from the Lync Server can impact 
the AD Connectivity 
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Lync::Interface::Interface Utilization Next Hop >> Director Performance 

CIT: Registrar Server ETI: Backend Connectivity Value: Down 

Symptom 3

CIT: Central 
Management Server

ETI: Backend Connectivity Value: Down 

Symptom 4

CIT: Mediation Server ETI: Backend Connectivity Value: Down 

Symptom 5

CIT: Edge Server ETI: Backend Connectivity Value: Down

Symptom 6

CIT: Monitoring Server ETI: Backend Connectivity Value: Down

Symptom 7

CIT: Archiving Server ETI: Backend Connectivity Value: Down 

Symptom 8

CIT: AV Conferencing 
Server 

ETI: Backend Connectivity Value: Down

Symptom 9

CIT: Front End Server ETI: Backend Connectivity Value: Down

Description: Network interface utilization on the next hop from the computer 
hosting the Director role of the Microsoft Lync Server 2010 impacts the 
performance of the Director Server

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Director Server ETI: Queue Depth Value: Very High

Description: Network interface utilization on the next hop from the computer 
hosting the Microsoft Lync Server 2010 impacts ability to connect to the Back End 
Server
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Lync::Interface::Interface Utilization Next Hop >> Server Performance 

Symptom 2

CIT: Director Server ETI: Sproc Latency  Value: Very High 

Symptom 3

CIT: Director Server ETI: Queue Latency Value: Very High 

Description: Network interface utilization on the next hop from the computer 
hosting the Front End role of the Microsoft Lync Server 2010 impacts the 
performance of the Front End Server

Cause

CIT: Interface ETI: Interface Utilization Value: High

Symptom 1

CIT: Front End Server ETI: Outbound Tasks Queued Value: Very High

Symptom 2

CIT: Front End Server ETI: Queue Latency  Value: Very High 

Symptom 3

CIT: Front End Server ETI: Request Processing 
Latency 

Value: Very High  

Symptom 4

CIT: Front End Server  ETI: Queue Depth Value: Very High 

Description: Network interface utilization on the next hop from the computer 
hosting the Director role of the Microsoft Lync Server 2010 impacts the 
performance of the Director Server
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Lync::SQLServer::SQL Query Performance >> Front End Queue 

Lync::ExchangeUnifiedMessagingServer::Unified Messaging Status >> 
ExchangeUMCallsFailureRate 

Description: Performance of SQL Query in the SQL Server impacts Front End 
Queue in the Front End Server 

Cause

CIT: SQL Server  ETI: SQL Query Performance Value: Low

Symptom 1

CIT: Front End Server  ETI: Queue Latency Value: Very High 

Symptom 2

CIT: Front End Server  ETI: Queue Depth  Value: Very High  

Description: Unified Messaging Service status in the Unified Messaging role of 
the Exchange Server impacts UM Call Failure Rate in the Mediation Server role of 
the Lync Server 

Cause

CIT: Exchange Unified 
Messaging Server

ETI: Unified Messaging Status Value: Down

Symptom 1

CIT: Front End Server   ETI: Exchange UM 
Connectivity

Value: Down 

Symptom 2

CIT: Mediation Server   ETI: Exchange UM Calls Failure 
rate  

Value: Very High 
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Graph Templates
The following table lists the graph templates present in the content pack 
and mapped policies. 

Graph Templates Policy Name Policy Description

Front End Service CPU 
Statistics

LS_FrontEnd_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the instances RTCSrv or 
_Total.

Web Conferencing Service 
CPU Statistics

LS_WebConf_Logging The policy collects data 
for the Web 
Conferencing Service.

IM Conferencing Service 
CPU Statistics

LS_IMConf_Logging The policy collects data 
for the LS IM 
Conferencing Service.

Audio/Video Conferencing 
Service CPU Statistics

LS_AVConf_Logging The policy collects data 
for the Audio/Video 
Conferencing Service. 

Access Edge Service CPU 
Statistics

LS_AccessEdge_Logging The policy collects data 
for the Access Edge 
Service.

Audio/Video Edge Service 
CPU Statistics

LS_AVEdge_Logging The policy collects data 
for the LS A/V Edge 
Server.

Audio/Video 
Authentication Service 
CPU Statistics

LS_AVAuth_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the instances MRASSvc 
or _Total.

Web Conferencing Edge 
Service CPU Statistics

LS_WebEdge_Logging The policy collects data 
for the LS Web 
Conferencing Edge 
Service.
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Archiving and CDR Service 
CPU Statistics

LS_Archiving_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the counters RTCArch 
or _Total.

Mediation Service CPU 
Statistics

LS_Mediation_Logging The policy collects data 
for the ls Mediation 
Service.

Front End Service Memory 
Statistics

LS_FrontEnd_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the instances RTCSrv or 
_Total.

Web Conferencing Service 
Memory Statistics

LS_WebConf_Logging The policy collects data 
for the Web 
Conferencing Service.

IM Conferencing Service 
Memory Statistics

LS_IMConf_Logging The policy collects data 
for the LS IM 
Conferencing Service.

Audio/Video Conferencing 
Service Memory Statistics

LS_AVConf_Logging The policy collects data 
for the Audio/Video 
Conferencing Service.

Access Edge Service 
Memory Statistics

LS_AccessEdge_Logging The policy collects data 
for the Access Edge 
Service.

Audio/Video Edge Service 
Memory Statistics

LS_AVEdge_Logging The policy collects data 
for the LS A/V Edge 
Server.

Graph Templates Policy Name Policy Description
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Audio/Video 
Authentication Service 
Memory Statistics

LS_AVAuth_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the instances MRASSvc 
or _Total.

Web Conferencing Edge 
Service Memory Statistics

LS_WebEdge_Logging The policy collects data 
for the LS Web 
Conferencing Edge 
Service.

Archiving and CDR Service 
Memory Statistics

LS_Archiving_Logging The policy logs the 
metrics into the data 
store (CODA or HP 
Performance Agent) for 
the counters RTCArch 
or _Total.

Mediation Service Memory 
Statistics

LS_Mediation_Logging The policy collects data 
for the ls Mediation 
Service.

SQL Back End Latency 
Experienced by Front End 
Server

LS_FrontEnd_Data
Logging

The policy collects data 
for the LS Front End 
Server.

Average Holding Time for 
Incoming Messages on 
Front End Server

LS_FrontEnd_Data
Logging

Front End Server 
Availability and 
Connectivity

LS_FrontEnd_Data
Logging

Sends Outstanding on 
Front End Server

LS_FrontEnd_Data
Logging

Average Incoming Message 
Processing Time on Access 
Edge Server

LS_AccessEdge_
DataLogging

The policy collects data 
for the Access Edge 
Server.

Graph Templates Policy Name Policy Description
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Client Request Errors and 
Timed Out Sessions over 
UDP on Audio/Video Edge 
Server

LS_AVEdge_Data
Logging

The policy collects data 
for the LS A/V Edge 
Server.

Client Request Errors and 
Timed Out Sessions over 
TCP on Audio/Video Edge 
Server

LS_AVEdge_Data
Logging

Authentication failures/sec 
on Audio/Video Edge 
Server

LS_AVEdge_Data
Logging

Graph Templates Policy Name Policy Description
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Policies Setting ETIs
The following table lists the content pack ETIs and SPI policies that set the 
ETIs.

For more information on the measurement threshold policies and events, 
refer to the HP Operations Smart Plug-in for Microsoft Lync Server 2010 
documentation.

ETI/HI Policy Name Policy Description

Archiving Service 
Status

LS_Check_ArchivingService
Status

Indicates the status of 
Archiving Service.

ArchivingDB
Latency

LS_Archiving_AvgNoOf
BlkedClientThreads

Indicates the queue latency 
in Archiving Server.

ArchivingDB
queue

LS_Archiving_AvgTime
RequestHeldInDB

Indicates the depth of DB 
Queue in Archiving Server.

AVConfService
Status

LS_Check_AVConfService
Status

Indicates the status of AV 
conference Service.

AVConferencing
Health

LS_AVConf_MCUHealth
State

Indicates the health of AV 
Conferencing Server.

Concurrent
Conferences

LS_AVConf_NumberOf
ActiveConferences

Indicates the number of 
Concurrent Conference 
occurring.

NumberofFailed
conference

LS_AVConf_NoOfAddConf
Failed

Indicates the number of 
failed conference.

DIrectorService
Status

LS_Check_DirectorService
Status

Indicates the status of 
Director Service.

SprocLatency LS_Director_SprocLatency Indicates latency in request 
processing.

EdgeAccessServiceS
tatus

LS_Check_AccessEdge
ServiceStatus

Indicates the status of Edge 
Access Service.

EdgeAVService
Status

LS_Check_AVEdgeService
Status

Indicates the status of AV 
service in Edge Server.
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EdgeAVAuth
ServiceStatus

LS_Check_AVAuthService
Status

Indicates the status of AV 
Authentication Service in 
Edge Server.

EdgeWebConf
ServiceStatus

LS_Check_WebEdgeService
Status

Indicates the status of Web 
Conference Service in Edge 
Server.

Authentication
Failures

LS_AVEdge_TCP
AuthenticationFailures
PerSec

Indicates the rate of User 
Authentication Failures in 
Edge Server.

LS_AVEdge_UDP

AuthenticationFailures
PerSec

DOSAttack LS_AccessEdge_RateOfCnx
RefusedDueToSrvOverload

Indicates whether the Edge 
Server is under Denial of 
Service Attack.

LS_AccessEdge_AboveLimit
ConnectionsDropped

LS_AccessEdge_NoOfSrvCnx
DisDueToThrottling

IMConferencing
Latency

Synthetic transaction Latency in creating a 
Conference.

IMConferencing
Status

LS_Check_IMConfService
Status

Status of IM Conferencing 
Availability.

FrontEndService
Status

LS_Check_FrontEndService
Status

Indicates the status of the 
Front End Service.

IMConferencing
ServiceStatus

LS_Check_IMConfService
Status

Indicates the status of IM 
Conferencing Service.

AudioTestService
Status

LS_Check_AudioTestService
Status

Indicates the status Of 
Audio Test Service.

BandWidthPolicyS
erviceCoreStatus

LS_Check_BandwidthCore
ServiceStatus

Indicates the status of 
BandWidth Policy Service 
Core.

ETI/HI Policy Name Policy Description
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BandWidthPolicyS
erviceAuthStatus

LS_Check_BandwidthAuth
ServiceStatus

Indicates the status of 
BandWidth Policy Service 
Authentication.

ApplicationSharing
ServiceStatus

LS_Check_AppSharing
ServiceStatus

Indicates the status of 
Application Sharing Service.

WebConferencingS
erviceStatus

LS_Check_WebConfService
Status

Indicates the status of Web 
Conferencing Service.

WebConf
Compatibility
ServiceStatus

LS_Check_WebConf
CompatibilityServiceStatus

Indicates the status of Web 
Conferencing 
Compatibility Service.

FileTransferAgent
ServiceStatus

LS_Check_FileTransferAgent
ServiceStatus

Indicates the status of File 
Transfer Agent Service.

ConfAttendant
ServiceStatus

LS_Check_ConfAttendant
ServiceStatus

Indicates the status of 
Conference Attendant 
Service.

ConfAnnounceme
nt
ServiceStatus

LS_Check_Conf
AnnouncementServiceStatus

Indicates the status of 
Conference Announcement 
Service.

QueueLatency LS_Registrar_QueueLatency Indicates the Queue Length 
specific to particular role.

LS_FrontEnd_QueueLatency

LS_CallDetailRecording_
QueueLatency

LS_AccessEdge_EventsQueue
Length

QueueDepth LS_Registrar_QueueDepth Indicates the Queue Depth 
specific to particular role.

ReplicationService
Status

LS_Check_ReplicaService
Status

Indicates the status of the 
Replication Service.

CentralMgmt
ServiceStatus

LS_Check_MasterReplicator
AgentServiceStatus

Indicates the status of the 
Central Management 
Service.

ETI/HI Policy Name Policy Description
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SIPLoad S_AccessEdge_AvgIncoming
MsgProcessingTime

Indicates the load on the 
server due to SIP 
transactions.

MediationService
Status

LS_Check_MediationService
Status

Indicates the service status 
of Mediation Service.

MediationServer
Health

LS_Mediation_LoadCall
FailureIndex

Indicates the Health of 
Mediation Server.

NumberofCall
Failures

LS_Mediation_NoOfMedia
CnxCheckFailures

Indicates the rate of call 
failures in Mediation Server.

LS_Mediation_NoOfCalls
FailedFromProxy

QoEMonitoring
ServiceStatus

LS_Check_Quality
MonitoringServiceStatus

Indicates the status of QOE 
Monitoring Service.

CDRMonitoring
ServiceStatus

LS_Check_CallDetail
RecordingServiceStatus

Indicates the status of CDR 
monitoring Service.

ThrottlingRate LS_Registrar_Throttled
Requests

Indicates the rate at which 
the registrar server is 
throttling requests.

ResponseGrp
ServiceStatus

LS_Check_ResponseGroup
ServiceStatus

Indicates the status of 
Response Group Service.

CallParkService
Status

LS_Check_CallParkService
Status

Indicates the status of Call 
Park Service.

MediationService
Status

LS_Check_MediationService
Status

Indicates the status of 
Mediation Service.

ADRequests
Pending

LS_FrontEnd_NoOfRequests
WaitingOnAD

The number of request 
waiting currently for Active 
Directory responses.

RequestProcessing
Latency

LS_FrontEnd_HoldingTime
ForIncMsgs

The average processing time 
taken by the server for one 
request.

ETI/HI Policy Name Policy Description



Chapter 34: Microsoft Content Packs

1057

OutboundTasks
Queued

LS_FrontEnd_Sends
Outstanding

This policy monitors the 
number of outbound 
requests and responses 
queued.

ADConnectivity LS_Check_Monitor_AD
Status 

Indicates if any of the 
Domain Controllers are 
reachable from the given 
Lync Server Role.LS_Check_Arch_ADStatus

LS_Check_Director_AD
Status

LS_Check_AVConf_AD
Status

LS_Check_FrontEnd_AD
Status

LS_Check_Mediation_AD
Status

LDAPLatency LS_Director_SearchLatency 
LS_FrontEnd_SearchLatency

Indicates the time taken to 
execute an LDAP query 
from the Lync Server Role.

ETI/HI Policy Name Policy Description
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A

action automation
creating rules 478
deleting rules 487
disabling rules 484
duplicating rules 486
editing rules 485
enabling rules 484
reference 488, 489, 491, 492, 494, 495, 496, 

498, 499, 500
specifying actions 480

action automation concepts 475
action handling concepts 475
actions

automation
creating rules 478
deleting rules 487
disabling rules 484
duplicating rules 486
editing rules 485
enabling rules 484
reference 488, 489, 491, 492, 494, 495,
496, 498, 499, 500
specifying actions 480

custom 32
events 30
on HPOM 49
pane 198
running 199
running on events 62

Actions Pane
basics 197
reference 201

Additional Event Properties tab (filter 
configuration) 235, 241, 242

additional info, events 29
advanced filters 238, 245

annotations
adding to events 60
events 30

applying filters 220
Archive Events CLI tool 117
assigning

events
concepts 30
to users 61, 623

views to users 640
Assignment Propagation infrastructure settings 

706
attributes

adding to event 60
custom 32

Audit Settings (reference) 655
auditing

concepts 651, 652
enable 653
infrastructure settings 688
view 654

auto-extend event correlation time 386
automatic Run Book rules

creating 505
deleting 509
duplicating 508
editing 507
reference 501, 510, 512, 513, 514, 515

automation
actions

reference 488, 489, 491, 492, 494, 495,
496, 498, 499, 500

Run Book rules
reference 501, 510, 512, 513, 514, 515

Index
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B

basic topology synchronization
concepts 666
running 671

BBCTrustServer 457
business rules (HI-based KPI) viewing 134

C

calculation rules (KPI) HI state details 133
categories

downtime
deleting 560
editing 559
reference 561, 563

events 32
causes

concepts 374
specifying 384

Certificate Server infrastructure settings 692
CI resolution

configuring 599
limiting CIs 602
modifying TQLs 603

CI Resolver infrastructure settings 689
CI types

filtering
events 219
with strings 275, 301, 326, 351

indicator mapping rules 335
mapping

selected views 349
views 257

Performance Graph manager 308
searching 275, 301, 326, 351
Tools manager 282
View Mappings manager 358

Close Events CLI tool 119
Closed Events Browser

events 31
infrastructure settings 693
viewing closed events 65, 66

columns 104
command-line interface

Archive Events tool 117
Close Events tool 119

Content Packs Manager 449
Topology Synchronization tool 672

configuration item in Model Explorer 26
configuring downtime 553
connecting servers

concepts 407
creating connections

external event processing server 417
HPOM 413
Intergration Adapter server 420
OMi 411
virtual server 422

deleting connections 425
editing connections 424
establishing trust relationships 426
Operations Manager infrastructure settings 

710
reference 430

Certificate Details 444
Event Drilldown 446
General tab 433
Incoming Connection 448
Integration Type 439
Outgoing Connections 441
Policy Management 445
Server Properties 436
Server Type tab 435

verifying trust relationships 429
content

concepts 725, 781, 847, 917
management 726
packs 725, 781, 847, 917

content packs
concepts 725, 726, 917
Infrastructure 781
Infrastructure Content Pack 782
J2EE 847
Microsoft Active Directory Content Pack 918
Microsoft Exchange Server Content Pack 960
Microsoft Lync Server 2010 Content Pack 

1016
Microsoft SQL Server Content Pack 762
Oracle Content Pack 734

Content Packs Manager
command-line interface 449

ContentManager CLI 449



Index

1061

context
export 641
import 641

context menus 79
correlation

configuring TBEC rules 376
Correlation Rule Event Type Indicators pane 

395
Correlation Rules Manager 387
Correlation Rules pane 388
Create New Correlation Rule dialog box 399
creating rules 378
cross-domain 371
defining rule topology 381
Edit Properties for Correlation Rules dialog 

box 401
events

concepts 45
specifying causes 384
specifying symptoms 383

Matching CIs for Correlation Rule dialog box 
403

rule topology 372
Rule Topology pane 392
rules 371

create from manually related events 56
troubleshooting 405

selecting topology views 380
symptoms and causes 374
Symptoms and Causes pane 397
topology-based event correlation 370
View Rule pane 390

creating
correlation rules automatically 45
custom action scripts 567
event automation configuration scripts 521
groups 635
notification templates 537
notifications 535
tools 273, 278
users 636

cross-domain
event correlation 371
key performance indicators 133

custom action scripts
reference 575

custom actions
concepts 565
creating script 567
deleting scripts 571
details 574
duplicating scripts 570
editing scripts 569
events 32
launching 63
reference 572

custom attributes
events 32
infrastructure settings 694

D

Date tab (filter configuration) 234, 240
defining

filters 221
filters advanced 224
tool categories 280
users 633

downtime
category

deleting 560
editing 559

configuring 553
infrastructure settings 694
reference 561, 563

dynamic topology synchronization
concepts 664
running 667

E

editing tools 279
editor

Event Type Indicator Mapping Rule 342
Indicators (Mapping Rules) 345

enable
auditing 653
logging 659

EUM, displaying events 64
event

performance graphs 42
select filter 228
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event assignment
concepts 621
mapping users to events 623
reference 625, 628

event automation concepts 577
event automation configuration

concepts 519
creating script 521
deleting scripts 525
details 528
duplicating scripts 524
editing scripts 523
reference 526

event automation configuration scripts
reference 529

event browser
Actions tab 91
adding

annotations 60
custom attributes 60

Additional Info tab 88
Annotations tab 92
assigning events to user 61
basics 26
column options 104
configuring events 51
context menus 79
Custom Attributes tab 93
details 27
export options 115
exporting events 53
External Info tab 103
General tab 84
History tab 98, 99
Instructions tab 102
Model Explorer 26, 69
overview 69
reference 68
Related Events tab 96
relating events manually 54
Source Info tab 89

Event Cache infrastructure settings 700, 701
event correlation

concepts 45
configuring 367, 376
Correlation Rules manager

basics 369
reference 387

creating 378
cross-domain 371
defining rule topology 381
infrastructure settings 717
rule topology 372
selecting topology views 380
specifying

auto-extend time 386
causes 384
symptoms 383
time limit 385

symptoms and causes 374
topology-based 370

Event Forwarding infrastructure settings 702
event forwarding rules

creating 465
deleting 470
duplicating 469
editing 468
reference 471

event handling concepts 577
Event History infrastructure settings 704
Event Lifecycle State infrastructure settings 706
event management

archiving tool 47
basics 25
correlation 45
creating correlation rules automatically 45
Event Browser 26
event closing tool 47
export event data 47
filters 42
Health Indicator View 41
Health Perspective 40
Health Top View 41
HPOM actions 49
introduction 23
OO Run Books 50
performance graphs 42
priority 43
relating events 45
sources 44
tools 47
troubleshooting 121, 474, 502, 619
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event mapping 322
Event Pipeline Server infrastructure settings 699
event processing scripts

creating 606
deleting 610
duplicating 609
editing 608
reference 612, 613, 614, 616

Event Type Indicator infrastructure settings 707
event type indicators

correlation rules 395
Correlation Rules manager 395
defining ETI mapping rules 330
Health Perspective 127
mapping 338
mapping rules 341

events
actions 30
adding

annotations 60
custom attributes 60

additional info 29
annotations 30
archiving tool 47
assigning to users 30, 61
categories 32
closed event history 31, 33
configuring

browser 51
correlation 376

creating
correlation rules 378
correlation rules automatically 45
correlation rules manually 56

custom actions 32
custom attributes 32
event closing tool 47
export 47
exporting browser contents 53
filtering

by CI type 219
by view 218
concepts 35, 42

forwarding 461
from EUM 64
General details 29

HPOM actions 49
instructions 36
KPI for unassigned 137
KPI for unresolved 137
launching custom actions 63
launching OO Run Books 63
lifecycle 37
OO Run Books 50
priority 43
recalculate priorities 55
related 38
relating manually 45, 54
resolver hints 38
running HPOM actions 62
set priorities manually 55
severity 39
sources 44
specifying

correlation auto-extend time 386
correlation causes 384
correlation symptoms 383
correlation time limit 385

synchronization 39
tools 47
transfer control 58
viewing closed 66
viewing closed events 65

export events 115
External Info tab 103
external server, transfer control of event 58

F

filtering
CI types 275, 301, 326, 351
events

by CI type 219
by view 218

filters
Advanced Filter Configuration dialog box 

237, 244, 250
applying 220
concepts 211, 212
configuring

Additional Event Properties tab 235,
241, 242
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advanced 238, 245
buttons and icons 232
Dates tab 234, 240
General tab 232, 239

defining 221
defining advanced 224
events 35, 42
Filter Configuration dialog box 231
selecting 228
troubleshooting 253, 459, 517
viewing 220

forwarding event 461

G

General tab
Event Details 29
Filter Configuration 232, 239

Graph Instance ID Configuration pane 312
graphing

Assigned Graph Families 313
Available Graph Families pane 312
CI Types pane 308
concepts 299
Configure Graphing for CI Type dialog box 

314
Graph Instance ID Configuration 312
Launch Performance Graph Designer dialog 

box 316
launching performance graph designer 306
mapping CI type to graph families 305
mapping concepts 299
performance graphs 42
Performance Graphs pane 311
reference 308
settings 300

Graphing infrastructure settings 708

H

health
ETIs 127
HI state details 133
key performance indicators

business rules 134
health-based 129

status 124
topology views 125
troubleshooting 140
viewing

HI state details 133
KPI business rules 134

Health Indicator View 138
health indicators

basics 123, 128
resetting 132
viewing 132

Health Perspective
basics 40
event management 40
Health Indicators pane 41
reference 135
topology view 41

health status
indicators 128
troubleshooting 140

Health Top View browser 135
Health Top Views 125
History tab 98, 99
history, events 33
home page, setting 637
HP Software Support Web site 17
HP Software Web site 18

I

indicator mapping rules
administration 319
basics 320
CI Types browser 335
configuring 319
reference 334

indicators
defining mapping rules 330
event mapping 322
health

resetting 132
troubleshooting 140
viewing 132

KPIs 129
mapping

editor 342
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from events 322
selecting 345

mapping rules 338, 341
ordering mapping rules 333
viewing KPIs 133

Infrastructure Content Pack 782
infrastructure settings

Assignment Propagation 706
Auditing 688
Certificate Server 692
CI Resolver 689
Closed Events Browser 693
concepts 682
Custom Attributes 694
displaying 685
Downtime 694
editing 685
Event Cache 700, 701
Event Correlation 717
Event Forwarding 702
Event History 704
Event Lifecyle State 706
Event Pipeline Server 699
Event Type Indicator 707
Graphing 708
HPOM Connections 710
HPOM Topology Synchronization 712
License Reporting Server 714
managing 682
overview 681
Reconciliation 714
reference 686
Topaz Authorization Service 715
Topology Synchronization 712
Topology View 716
Topology-Based Event Correlation 717
User Interface 720, 721

Infrastructure Settings Manager 682
inheritance of tools 274
Instructions tab 102
instructions, events 36

J

J2EE Application Server Content Pack 848

K

key performance indicators
concepts 129
HI state details 133
viewing business rules 134
viewing details 133

Knowledge Base 17
KPIs

unassigned events 137
unresolved events 137

L

License Reporting Server infrastructure settings 
714

lifecycle of events 37
logging

concepts 657, 658
enable 659
save 660
settings (reference) 661

M

manager
CI Tree View in View Manager 259
Correlation Rules 367
Indicator Mapping Rules 320, 334
Tools 271
View Mappings 357

manually relating events 45
mappings

defining for ETIs 330
ETI Mapping Rule Editor 342
ETI Mapping Rules by CI dialog box 338
ETI mapping rules overview 341
events to event type indicators 322
events to indicators 322
ordering 333
Performance Graphs pane 311
select indicators 345
selected views to CI types 349
View Mappings pane 361
views to CI types 257

menus (context) 79
Microsoft Active Directory Content Pack 918
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Microsoft Exchange Server Content Pack 960
Microsoft SQL Server Content Pack 762
Model Explorer

basics 26
introducing 69

N

notification rules
concepts 533
creating 535
creating templates 537
deleting 541
duplicating 540
editing 539
Event Attribute dialog box 552
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